Tutorials for Origin 2024b
# Table of Contents

1. Getting Started ........................................................................................................................................... 1
  1.1 Getting Started ........................................................................................................................................ 1
  1.2 My First Graph ....................................................................................................................................... 1
  1.3 Graph Templates and Batch Plotting ....................................................................................................... 5
  1.4 Data Selection ......................................................................................................................................... 11
  1.5 Merge and Arrange Graphs .................................................................................................................... 15
  1.6 Publishing Graphs ................................................................................................................................. 20
  1.7 3D and Contour ................................................................................................................................... 23
  1.8 Gadgets .................................................................................................................................................. 26
  1.9 Curve Fitting .......................................................................................................................................... 28
  1.10 Peak Analysis ....................................................................................................................................... 32
  1.11 Statistics .............................................................................................................................................. 35
  1.12 Analysis Template ............................................................................................................................... 38
  1.13 Apps in Origin ....................................................................................................................................... 40

2. Video Tutorials ........................................................................................................................................... 45

3. User Interface ............................................................................................................................................. 47
  3.1 User Interface ......................................................................................................................................... 47
  3.2 Origin GUI ............................................................................................................................................. 47

4. Data Analysis .............................................................................................................................................. 53
  4.1 Data Analysis ......................................................................................................................................... 65
  4.2 Gadgets .................................................................................................................................................. 68
  4.3 Curve Fitting ......................................................................................................................................... 153
  4.4 Signal Processing ................................................................................................................................. 366
  4.5 Peak Analysis ....................................................................................................................................... 457
  4.6 Data Manipulation ................................................................................................................................. 510
  4.7 Analysis Templates ............................................................................................................................... 578
  4.8 Analysis Themes ................................................................................................................................. 591
  4.9 Batch Processing .................................................................................................................................. 595

5. Statistics ..................................................................................................................................................... 617
  5.1 Statistics .............................................................................................................................................. 617
  5.2 Descriptive Statistics ............................................................................................................................. 618
  5.3 Hypothesis Tests ................................................................................................................................... 653
  5.4 ANOVA .................................................................................................................................................. 663
  5.5 Nonparametric Tests ............................................................................................................................. 699
5.6 Survival Analysis ................................................................. 711
5.7 Multivariate Analysis ............................................................ 727
5.8 Power and Sample Size .......................................................... 764
5.9 ROC curve ........................................................................... 769
6 Graphing ................................................................................. 773
6.1 Graphing .............................................................................. 773
6.2 Plotting ................................................................................ 777
6.3 Axis .................................................................................... 881
6.4 Layers ................................................................................ 905
6.5 Graph Template and Theme ................................................... 941
6.6 Line and Symbol ................................................................. 942
6.7 Column, Bar and Pie ........................................................... 1034
6.8 Multi-Axis and Multi-Panel .................................................... 1098
6.9 Contour ................................................................................ 1161
6.10 Map Overlays ...................................................................... 1236
6.11 Statistics ............................................................................ 1245
6.12 Polar ................................................................................... 1332
6.13 3D Graphs ........................................................................... 1414
6.14 Plot Functions with Parameters Defined in a Worksheet .......... 1574
6.15 Windrose Graph ................................................................... 1579
6.16 2D Vector Graph .................................................................. 1590
6.17 Piper Diagram ..................................................................... 1593
6.18 Waterfall ............................................................................ 1598
6.19 Open-High-Low-Close-Volume Stock Chart ......................... 1619
7 Data Management .................................................................... 1629
7.1 Data Management ............................................................... 1629
7.2 Working with Multi-Sheet Workbooks .................................. 1629
7.3 Adding Objects to Worksheet ................................................ 1636
8 Data Exploration ..................................................................... 1643
8.1 Data Exploration .................................................................. 1643
8.2 Data Reader Tool ............................................................... 1643
8.3 Use Data Cursor to Show the Difference between the Data .... 1651
9 Importing Data ........................................................................ 1657
9.1 Importing Data ................................................................... 1657
9.2 Data Connector ................................................................. 1657
9.3 ASCII ................................................................................ 1663
9.4 Database ............................................................................ 1680
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.5</td>
<td>Digitizer</td>
<td>1724</td>
</tr>
<tr>
<td>10</td>
<td>Exporting and Presentation</td>
<td>1753</td>
</tr>
<tr>
<td>10.1</td>
<td>Exporting and Presentation</td>
<td>1753</td>
</tr>
<tr>
<td>10.2</td>
<td>Exporting</td>
<td>1753</td>
</tr>
<tr>
<td>10.3</td>
<td>Presentation</td>
<td>1761</td>
</tr>
<tr>
<td>11</td>
<td>Programming</td>
<td>1771</td>
</tr>
<tr>
<td>11.1</td>
<td>Programming</td>
<td>1771</td>
</tr>
<tr>
<td>11.2</td>
<td>LabTalk</td>
<td>1772</td>
</tr>
<tr>
<td>11.3</td>
<td>Origin C</td>
<td>1776</td>
</tr>
<tr>
<td>11.4</td>
<td>X-Functions</td>
<td>1821</td>
</tr>
<tr>
<td>Index</td>
<td></td>
<td>1871</td>
</tr>
</tbody>
</table>
1 Getting Started

1.1 Getting Started

If you are new to Origin, or have used a much older version in the past, it is highly recommended that you start with these tutorials. Once you have familiarized yourself with the interface and key concepts of graphing and analysis introduced in these lessons, you can then move on to other chapters that cover Origin features in more detail.

At the end of each lesson, we ask you to save the project. Please work through the tutorials sequentially as some build on previous lessons.

- My First Graph
- Graph Templates and Batch Plotting
- Data Selection
- Merge and Arrange Graphs
- Publishing Graphs
- 3D and Contour
- Gadgets
- Curve Fitting
- Peak Analysis
- Statistics
- Analysis Template
- Apps in Origin

We hope this set of **Getting Started** tutorials has been helpful in providing you with a broad overview and introduction to key features in Origin. We recommend that you continue with more advanced tutorials in the categories in this book that are most relevant to your work.

1.2 My First Graph

In this first lesson, we will generate some data, create a graph, do some simple customization of the graph, and save the data and graph as an Origin project.

1.2.1.1 Import data and graph

1. Launch Origin. You will see an empty workbook with one worksheet containing two columns.
2. Click **Help: Open Folder: Samples Folder** and browse to \Curve Fitting\Sensor01.dat. Drag the file to the Origin workbook.
3. Now let us create a graph. Click on the header of column B to select the entire column. Then click the **Line** button in the **2D Graphs** toolbar docked at the bottom left of the interface. A graph window will open, with the data plotted as a line.

1.2.1.2 Customise the graph

1. We will now do some simple customization of the graph. Click on the X axis, and in the pop-up Mini Toolbar, click the **Show Gridlines** button to select **Both** in the drop-down list. This will add major and minor grid lines for the X axis. Do the same for Y axis.
2. Click on the line plot. In the pop-up Mini Toolbar, click the **Line Color** button to change the line color to **Blue**.

3. Change the width to **3** by using the **Line Thickness** drop-down list in the Mini Toolbar.

4. Single-click inside the layer, but not on the grid lines or plot. You may need to click once to deselect your plot and then again to select the layer. The graph layer will be selected, and this will be indicated by selection handles. Change the layer background color to **LT Yellow** by using the **Layer Background Color** button on the Mini Toolbar. Your graph should look like below:
1.2.1.3 Explore data graphically

1. Let us now explore the data graphically. Make sure the graph window is active by clicking on the title bar.
   - Hold the Z key down and use the mouse wheel to zoom in and out on the X axis.
   - Hold the X key down, and use mouse wheel to pan across the x axis.
   - Hold the Shift key down along with Z/X keys to zoom/pan in Y direction.
   - Bring the plot back to full scale by clicking the yellow background, then clicking the Rescale button on the Mini Toolbar.
   - Use shortcut CTRL+R to rescale plots in the graph layer.

2. Hover your cursor on a point of the curve and a Data Point tooltip will show.
1.2.1.4  **Save the Project**

We will now save this Origin project for later use.

1. Move mouse over to the Project Explorer bar on the left side of the work space to expand it.
2. Right click on the **Folder1** in the upper folders panel and choose **Rename** from the context menu. Type **My First Graph** to rename the folder.
3. Choose menu **File: Save Project** to save the project. Give the project a name such as **Getting Started Tutorials**.

Files created by the user such as projects, graph templates, fitting functions etc are by default saved in the **User Files Folder (UFF)**. You can access the **UFF** and other useful folder locations with the main menu **Help: Open Folder**.

1.3  **Graph Templates and Batch Plotting**

In this lesson we will learn about graph templates, and also how to perform batch plotting.

1.3.1  **Graph Templates**

Let’s start with the project file we saved in **lesson one: My First Graph**. Click to select the graph window.

You can quickly open recently-saved project files from the **File: Recent Projects** list.
1. Click on the X axis, in the pop-up mini toolbar, click the **Show Opposite Axis** button to show the Top X axis. Do the same for Y axis to show the Right Y axis.

2. Now let's save the graph as a template. Right-click on the graph title bar, and choose **Save Template As...** from the context menu.

3. In the dialog, set the **Template Name** as **My Line** and click **OK** to save the template.

4. We will now generate a new column of data. Activate the worksheet, click the **Add New Column** button on the **Standard** toolbar to add a new column to the rightmost.

5. Click inside the **Fx** cell of this new column, then enter the following:

   \[ = \text{Movavg}(B, 2) \]

6. Note that when you enter "=" and then an expression, the possible expressions will be listed allowing you to choose to auto-complete the expression. And a message box will pop-up to show the simple description of the expression.

You can fill a column with an expression also by right-clicking the **Fx** cell of this column and selecting **Open Dialog...** from the context menu.
In this dialog, use the **Formula: Load Samples** menu to view various examples on setting column values. And, the **Function** menu offers a large selection of functions. You can also search for suitable functions using the search button.

7. Press **Enter** key to return a dataset of modified moving averages using column B data, starting at row 2. Type **MMovAvg** into the **Long Name** cell of the column.

8. Click on the header of column C to select the entire column. From the menu, choose **Plot: User Templates** and select the **My Line** template we created before. A new graph will be created using data from column C.

1.3.2 Batch Plotting

In this section, we will perform batch plotting by first creating one graph and then cloning that graph using other data.
Tutorials for Origin 2024b

1. Go to **Project Explorer**. In the upper panel, right-click on the root level and choose **New Folder**.
2. Name the folder **Batch Plotting**. Click on the empty folder to open it.
3. Select **Help: Open Folder: Program Folder** to open the Origin program folder, find and open the \Samples\Import and Export subfolder. Press the **Shift** key and choose the following three files:

   o S15-125-03.dat
   o S21-235-07.dat
   o S32-014-04.dat

4. Drag and drop the selected files onto the Origin workspace. The selected files are imported into three new workbooks.

![Imported Data Files]

**Note:** To import data files by drag-and-drop, **you must not be running Origin as an administrator**.

5. Select one of the workbooks, then click on the header of column B and drag the mouse to column D, selecting all three columns. Then select the menu: **Plot > Multi-Panel/Axis: 3Ys Y-YY**.

💡 Origin will look to the left of the selection to find the X column and plot the selected data against the 1st column in the worksheet.

6. Click on one plot, in the pop-up mini toolbar, change the plot type of selected plot to **Line** by using the **Change Plot to** drop-down list.

Change Plot to ▼
Click on the plot, in the pop-up mini toolbar, change the width to 3 by using the *Line Thickness* drop-down list.
Then, do the same for other two plots to get the following line graph.

![Graph Image]

7. Now we will clone this graph using data in the other workbooks. Right-click on the title bar of the graph and select **Batch Plotting...**, and then the **Select Workbook** dialog will be opened.

8. In the dialog, set according to the image below. Make sure you highlight the books.

You can set the **Match Plot Columns by** drop-down appropriately to find worksheets in the project that match the data configuration of the current graph.
9. Click **OK**. If prompted to rescale the axes to show all data, answer Yes and click OK. Two similar graphs will be created with data from the other two books.

10. From the menu, click **Save Project** button on **Standard** toolbar to save your modified project.

### 1.4 Data Selection

In this lesson we will learn about flexible ways of selecting data for plotting.

#### 1.4.1 Plotting Data from Multiple Worksheets

1. Let’s start with the project we saved in **lesson two: Graph Templates and Batch Plotting**. Select any workbook, and make sure no data columns are selected. You can click in the gray area outside of columns to remove selection.
2. Select menu **Plot > Basic 2D: Line**. The **Plot Setup** dialog will open.
3. Click the **button on the right side to expand the upper panel if it is not already open.
4. Set the **Available Data:** drop-down list in the left panel to **Worksheets in Folder**.

   ![Graph.png](https://via.placeholder.com/150)

   To pick up worksheets from anywhere in your project, set the drop down to **Worksheets in Project**.

5. Hold down shift key and select all three data sheets named **Trial Run 1**, **Trial Run 2** and **Trial Run 3**.
6. Using the check boxes in the middle panel, assign **Time** as X and **Position** as Y. Click **OK** button to create the graph.

   ![Graph.png](https://via.placeholder.com/150)

   This dialog has a third bottom panel which can be used to assign data to different layers in a multi-layer graph. If that panel is open, you can simply collapse it and then click **OK** to create the graph.
7. We will now customize the legend for this graph. Right click on the legend and select **Legend: Update Legend**...

8. In the dialog that opens, set **Auto Legend Transition Mode** as **Custom**. Clear the **Legend Custom Format** edit box and then click the button on the right of this edit box, and in the fly-out menu select **@WS: Sheet Display Name**.

9. In the edit box, type a hyphen - after the string @WS, and again click the right arrow button. This time select **@LD"Sample": Sample**, which corresponds to column header row **Sample** in the worksheet. Click the **OK** button. The legend will now display the sheet name and the sample name.

10. **1.4.1.2 Using another Column to Set Color of a Plot**

    1. Go to **Project Explorer**. In the upper panel, right-click on the root level and choose **New Folder**.
    2. Right-click on newly created folder, select **Rename**, and assign the name **Data Selection**. Click on the empty folder and open it.
    3. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Graphing** subfolder and find the file **US Mean Temperature.dat**. Drag-and-drop this file into Origin workspace to import it into a new worksheet.
    4. We want to plot the positions of US major cities (columns **Longitude** and **Latitude**) as a scatter plot and then colormap the data points with the annual mean temperature (column **Annual**). Click on the header of column named **January** and drag and expand the selection all the way to the column named **December**. Then right click to choose **Hide/Unhide Columns: Hide**.
5. Select the *Longitude* columns, in the pop-up mini toolbar, select **Set As: X** button.

6. Select the *Latitude* and click **Scatter** button on the bottom left toolbar to create the plot of longitude vs. latitude.

7. Click on the plot, in the pop-up mini toolbar, click the **Symbol Edge Color** button to expand the color chooser, switch to the *By Points* tab. In this tab, click the **Color Mapping** drop-down and select **Col(P): “Annual”** in the list. The symbol color will be mapped to the column *Annual*.

8. Let us now set the axes lengths to scale with the range of X and Y values represented in the graph. Click on the white space of the layer to select the layer, in the pop-up mini toolbar, click **Isometric** button. You also can double-click on the white space of the layer to open the **Plot Details** dialog with the *Layer1* node been selected on the left panel. Then go to the **Size** tab on the right side. Check the **Link Axis Length to Scale with X:Y Ratio** box and keep the ratio as *1*.

9. Now, let us select another color palette to apply it to the symbol color as colormap. Click on any data point in the graph, and then click on the **Palette** toolbar button in the **Style** toolbar. Select the *Temperature* palette to better reflect the data. Click anywhere on the graph to deselect the plot.

   ![Latitude vs. Longitude Plot](image)

   You can add a map to a graph using the **Maps Online** App. This blog post is a good place to start.
11. From the menu, choose **File: Save Project** and save your modified project.

### 1.4.1.3 Selecting Multiple Non-adjacent Columns for Plotting

1. Open a new workbook window by clicking on the **New Workbook** button in the **Standard** toolbar.
2. Select menu **Data: Connect to File: Excel**. In the file dialog that opens, browse to `<Origin EXE Path>\Samples\Import and Export folder` and select the file `United States Energy (1980-2013).xls`. Press **Open**.
3. In the Excel Import Options dialog that opens, make sure Auto checkbox to the right of **Main header lines** is checked and **Long Names** is set to 1 and **Units** to 2.
4. Press **OK** to import the file. Then go to the first sheet named *Oil*. Hold the **Ctrl** key to select *Crude Oil Production*, *Oil Consumption* and *Total Oil Production* columns.

![Image of spreadsheet](image)

5. Then go to menu **Plot > Multi-Panel/Axis: Stack...** and accept default settings in the dialog, to create a stacked plot.

6. Click **Save Project** button on the **Standard** toolbar to save your project file.

### 1.5 Merge and Arrange Graphs

In this lesson we will create some graphs, merge them, and then arrange layers in the merged graph. We will also save the graph as a cloneable template to quickly re-create the graph from similar data.

#### 1.5.1.1 Import data and create graphs

1. Open the project file we saved in **lesson three: Data Selection**. In **Project Explorer**, create a new folder under the root folder and rename it as **Merging Graphs**. Click on the empty folder to open it.

2. Click the **New Workbook** button on the Standard toolbar to new a workbook. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Statistics** subfolder and find the file **automobile.dat**. Drag-and-drop this file into the empty worksheet to import it.

3. Click on the header of column C to select the entire column. Click the **Scatter** button on the **2D Graphs** toolbar to create a scatter graph.

4. Click on the scatter plot to select it, then right-click on the plot and select **Change X:** *[automobile]automobile!G(Y):EnginDisplacement* from the context menu to change the X data. A reminder message pops up asking if you would like to rescale the graph. Select **Yes** and press **OK**.

Reminder messages have multiple options. If you select **Yes, and do the same in the future, no need to ask again**, the dialog will not show again. You can reactivate all reminder messages from the menu **Help: Reactivate Reminder Messages**.
5. Select the legend and press the **Delete** key to delete it.

6. We will now make copies of this graph and change the data in the copies. First go back to the worksheet, and press the **X** button on the top right of the title bar, and in the dialog that pops up, select **Hide**. This simply hides the window from the interface.

   Hidden windows are displayed with a dimmed icon in the lower panel of Project Explorer. You can double-click on the entry to re-open the window.

8. Right-click on the graph window title bar and select **Duplicate** to create a copy. Do this two more times, so you end up with four graph windows.

9. Select the menu **Window: Tile Vertically** to arrange the 4 graphs without overlap.

10. Use the **Change X/Change Y** menu described before, to change X/Y designations for the copy graphs as below, and rescale when promoted:
    - Copy 1: Change Y to `[automobile]automobile!D(Y):0~60 mph`
    - Copy 2: Change X to `[automobile]automobile!E(Y):Weight`
    - Copy 3: Change X to `[automobile]automobile!F(Y):Gas Mileage`

11. Activate the graph of "Power" vs. "Weight". Let's do some customization. Click on the data plot, in the pop-up mini toolbar, change the plot properties as follows:
    - Change **Symbol Color** to Olive.
    - Change **Plot Symbol** to Circle.
12. Double-click on the Y axis to open the Axis dialog. Change the axis properties as follows:
   - Activate the Tick Labels tab. Press the Ctrl key on the keyboard and click Bottom and Left in the left table to select both axes.
   - In the Display sub-tab, select Engineering:1k for Display.
   - Check the Set Decimal Places check box and set Decimal Number to 0. Press OK to close the dialog.

13. Now we can copy the customized formats from this graph to the other three graphs. Right-click on a blank area of the graph such as outside the axes, and select Copy Format: All Style Formats from the context menu.

14. Select Edit: Paste Format (Advanced)... from the main menu. In the Apply Formats dialog that opens, uncheck All under Formats to Apply group, and check All Style Formats checkbox. Change Apply Scope drop-down at the bottom to All Graphs in this Folder. Click the Apply button to paste the format.
to the other graph, and then click **Close**.

![Image](image-url)

**1.5.1.2** **Merge and arrange graphs**

1. We will now merge these 4 graphs windows. Select **Graph: Merge Graph Windows** from the main menu.
2. The **Merge Graph Windows** dialog opens. Accept the default settings and click **OK**. A new graph window with 4 layers is generated.
3. Now we will re-arrange the 4 layers in the merged graph. Select **Graph: Layer Management** from the main menu. The **Layer Management** dialog will open.
4. Activate the **Arrange** tab, then expand the **Spacing (in % of Page Dimensions)** branch. Set as follows:
   - Horizontal Gap = 15
   - Vertical Gap = 15
   - Left Margin = 10
   - Right Margin = 5
   - Top Margin = 5
   - Bottom Margin = 15
   - Click the **Apply** button.
5. Activate the **Display** tab. Press the **Ctrl** key on the keyboard and select all 4 layers in the **Layer Selection** table on the left. Then select the **Scale Elements** checkbox under the **Option** branch. Set **Scale Mode** to **Fixed Factor** and set the **Fixed Factor** to 1.

![Image](image-url)

By default, if you drag and resize a graph layer, or the layer gets resized when merging, text fonts and other graph objects get rescaled. Setting **Scale Mode** to **Fixed Factor** can prevent scaling of font size/line thickness when layer is resized. (This behavior can also be controlled in the **Size** tab of **Plot Details** dialog (layer level))
6. Click the **Apply** button. Click OK to close the dialog.

The merged graph should now appear as below:

![Graph Diagram](image)

7. Activate the **automobile** workbook by double-clicking on the icon in the lower panel of Project Explorer.

Select column B, click the **Add or Remove Data Filter** toolbar button to add a filter.

8. Click on the filter icon at the top-left corner of the column header. In the context menu that appears, click **Select All** once to de-select all items, and then select the **Honda** checkbox and click OK, to only show rows where Make is **Honda**. All other rows will be hidden, and all graphs will update to reflect the change in the data.

![Graph Diagram](image)
1.5.1.3 Cloneable Template and Smart Plotting

1. Let us now save the final merged graph as a template. Right click on its window title bar and select **Save Template As**. This will open the **template_saveas** dialog.

2. Make sure **Mark as Cloneable Template** is selected and **Match Plot Columns by** is set to **Long Name**. Enter **MyMergeGraph** for **Template Name** and click **OK**. A message is dumped to the Message Log telling you the template is saved.

   Cloneable Templates save the column positions or column names along with all other graph properties. This allows for duplication of complex graph arrangements from other data with same arrangement of column positions or names.

3. Activate the *automobile* workbook. Select the filter on column B and select both **Honda** and **Lexus** and click OK to show both makes.

4. With the book still active, select **Plot > User Templates: MyMergeGraph** from the main menu. A new graph is created, with the same data assignments and formats as present in the previous merged graph.

   Save your project file.

### 1.6 Publishing Graphs

In this lesson we will learn about some of the options available for publishing graphs.

1.6.1.1 Pasting Graphs in Other Applications

1. Open the project file saved from *lesson four: Merge and Arrange Graphs*. Click to select the last graph window that you created.

2. Use the menu **Edit:Copy Page**, or the shortcut **CTRL+J**, to copy the graph page.

3. Launch Microsoft® WORD, then press **Ctrl+V**. The graph will be pasted as an embedded object in Word.

4. Double-click on the graph in Word. A new instance of Origin will be launched. Note that in this instance, only the graph and data related to the graph are available in the project.

5. Use menu **Format: Page** to open the **Plot Details** dialog in the page level. Then in the right panel, change the background color by choosing the **Display** tab and setting **Color** as **LT Gray**. Click OK.

6. From the menu, choose **File: Exit & Return to Document**. This will close the instance of Origin, and the graph image in the document will be updated.

7. Repeat step 1. This time we will copy the graph page as an EMF image. Press shortcut keys **CTRL+C** to copy the graph page as an EMF image.

   There is another tool **Copy Page as Image** that provides more options. Move mouse to the edge of graph page, the page level mini toolbar will pop up. Select **Copy Page as Image** button.

   In the dialog that opens, you can select EMF or other formats from **Image Format** drop-down list.
8. Then go back to the Word document, de-select the graph and press **Enter** to move to a new line in the document. Press **Ctrl + V** to paste the Origin graph as a picture object. To edit the picture, you can select **Format** tab, or right click the picture and select **Format Picture** menu to open the Format Picture panel.

When the Origin graph is placed as an embedded object in applications such as Word or PowerPoint, all the data associated with the graph are also saved with the Word document. This provides the flexibility of double-clicking and editing the graph in a new instance of Origin. However, if many graphs are placed as objects in a document, the document file size will become large if there is a lot of data associated with the graphs.

1.6.1.2 **Sending Graphs to PowerPoint**

1. With the graph window active in Origin, press the **Send Graphs to PowerPoint** button.
2. Accept all default settings in the opened dialog and click **Send**. The graph will be pasted as a new slide in the PowerPoint file.
3. Right-click on the graph title bar (in Origin) and select **Add Shortcut to Favorites**. This will add a **Favorites** folder to the project, visible in **Project Explorer**.

4. In **Project Explorer**, select the **My First Graph** folder. Then select the graph window, right-click on the title, and **Add Shortcut to Favorites** folder. Add shortcuts from other graph windows in the project as desired.
5. Go to **Project Explorer** and activate the **Favorites** folder. In the bottom panel, without selecting any item, right-click on the white area and choose **View:Extra Large Icons** from the context menu. This will show the graphs as extra large icons.
Double-click on the icons in **Favorites** folder to open the graph for viewing or editing. Right-click on the icon or the graph window title bar for a context menu command to go to the original folder for that graph.

6. Right-click on the **Favorites** folder in the upper panel of **Project Explorer** and choose **Send Graphs to PowerPoint**. Accept defaults in the dialog that opens. All graphs in the folder will be sent to PowerPoint. Note that you can do this operation in any folder, and not just the Favorites folder.

The dialog for sending graphs to PowerPoint has options for selecting all graphs in the project, specifying graphs by name, and placing the graphs on duplicate copies of a specific PowerPoint file slide that you can prepare prior to the operation.

### 1.6.1.3 Slide Show in Origin

1. Right-click on the **Favorites** folder in the upper panel of **Project Explorer** and choose **Slide Show of Graphs** from the context menu.
2. Accept defaults in the dialog. The slide show will start. Use arrow keys to view the next or previous graph in the sequence.

In the bottom panel of Project Explorer, switch to **Details** view (right-click in an empty location and choose **View: Details**). Right-click on the lower panel title bar and enable **Slide**. Note that you can drag to reorder the columns. Use the added **Slide** column to arrange the order of the graphs. Click on the slide column header once, and then you can drag and rearrange the graph entries to set the order. This order will be followed for operations such as slide show, pushing graphs to PowerPoint, and exporting.

### 1.6.1.4 Exporting Graphs

1. Go back to Project Explorer and select the **Merging Graph** folder in the upper panel.
2. Activate the graph and choose **File: Export Graphs (Advanced)** and change the following dialog box settings.
   - Select **Portable Document Format (*.pdf)** from the **Image Type** drop-down list.
   - Change the **Select Graph(s)** drop-down to **All in Active Folder**.
   - Expand the **Image Size** branch and enter **5** in the **Fit Width** text box.
3. Click the **OK** button to close the dialog.

4. Click on the **Messages Log** tab on the left side of the interface. The export file path dumped here is displayed as a hyperlink. By default, it will be your User Files Folder (UFF) path. Clicking the path link will open the exported PDF file in Origin built-in viewer. You can also copy the path, paste to Windows Explorer to open the folder, then view and edit the PDF files.

Save your project file.

### 1.7 3D and Contour

In this lesson we will learn how to plot 3D, contour, and profile plots. Data for such plots can be organized as XYZ columns or an array of cells in a worksheet, or in a matrix window.

#### 1.7.1.1 3D Surface

1. Start with the project saved from the previous lesson and add a new folder named **3D and Contour**. Click to open the empty folder.

2. Click the **New Workbook** button on the Standard toolbar.

3. Select menu **Data: Connect to File: Text/CSV**. Browse to select the file `<Origin EXE Path>\Samples\Matrix Conversion and Gridding\XYZ Random Gaussian.dat`. Import it with default settings.

4. Click on the header of column C and select **Set as: Z** button from the pop-up mini toolbar.

5. Keep column C highlighted. Then select the menu **Plot > 3D: 3D Color Map Surface** to create a surface plot.

6. Double-click on the layer icon on the upper left corner of the graph page, indicated by 1, to open the **Layer Contents** dialog box.
7. In the left-hand panel, select C(Z). In the middle section, click the drop-down arrow next to the A button. From the drop-down, select 3D Scatter/Trajectory/Vector. Click the Add Plot button to add the plot to the right-hand panel.

8. Click OK to close the dialog. The graph will now display the individual data points on the surface.

9. Hold the R key and use the mouse to freely rotate the surface plot.

1.7.1.2 Image Profile

1. Click on the New Matrix button in the Standard toolbar to open a new matrix window.
2. Select the menu Data: Import from File: Image to Matrix, then browse to <Origin EXE Path>\Samples\Image Processing and Analysis folder and select cell.jpg file and import it into the matrix.
3. With the matrix active, select the menu Plot > Contour: Image Profiles. Click Yes in the prompted message dialog. An image profile graph will be created, and the Image/Contour Profile dialog will open.
4. In the dialog, select the HLine tab then make the horizontal line thicker by expanding the Width branch and changing Pixels to 50.

![Image Profile](image.png)

You can add multiple horizontal, vertical, or arbitrary lines using the buttons in the dialog. The graph layers will display overlaid curves for the profiles in the appropriate layers. Profile plots can also be made from data in a matrix or worksheet.

1.7.1.3 Contour and Surface Plots from Virtual Matrix

1. Click on the New Workbook button to create a new workbook.
2. Click on the Import Wizard button . In the dialog that opens, choose the ... button next to File box, browse to <Origin EXE Path>\Samples\Graphing folder, choose waterfall.dat file. Click Finish to import the file.

![Import Wizard](import_wizard.png)

The Import Wizard can be used to parse an ASCII file to extract variables from header lines. The file you chose already has a predefined filter which is applied when you click the Finish.
3. Move the cursor to the upper left corner of the workbook until the shape of the pointer changes as in the following image, and click to select all columns of the worksheet.

![Select all columns](image)

4. Select menu **Plot > Contour: Contour - Color Fill**. This will open the **plotvm** dialog box, where you need to specify the data organization for your **Virtual Matrix**, as the data is contained in a worksheet instead of a matrix window.

5. Change **Y Values in** to **Column Label**, and then set **Column Label** to **Excitation Wavelength(nm)**.

6. Click the **OK** button to apply the settings and create the contour graph.

7. Go back to the workbook with waterfall data. Keep the whole worksheet highlighted and this time select the menu **Plot > 3D: 3D Color Map Surface with Projection**.

8. The **plotvm** dialog opens. Note that the **Theme** box on the top of dialog is set as **<sheet>**. This is because the settings used last time were saved in the worksheet. Click **OK** to accept the same settings. A surface graph with contour projection will be created.

9. Double-click on the contour projection to open the **Plot Details** dialog. Note that on the **Surface** tab, the **Flat** check box is checked, and an offset of 100% has been applied. This setting makes the data plot appear as a flat contour on top of the cube. Click **OK** to close Plot Details.

![Flat check box](image)

10. Double click on the **Z** axis to open the **Axis** dialog. Switch to the **Scale** tab and set the **To** value to 4000 and click **OK**. This allows better viewing of the 3D surface. The contour project will stay on the top plane of the cube.

💡 Data from different matrices or virtual matrices can be plotted in the same 3D graph layer by specifying an appropriate offset value for each, and further specifying which datasets to flatten. This allows to examine related data together in the same graph.
1.7.1.4 3D Function Plot

2. In the dialog box, click the triangle button next to the Theme box on the top. Then select Mexican Hat(System) in the context menu to load the settings for this example.
3. Press OK to create the plot.

A parametric function can be added to an existing graph, thus allowing you to combine such plots with real data. Visit 3D Function Gallery to view and download more examples.

Save your project file.

1.8 Gadgets

In this lesson, we will use gadgets to perform exploratory analysis of data in a graph.

1.8.1.1 Integrate Gadget

1. Start with the project saved from the previous lesson and add a new folder named Gadgets at the root level in Project Explorer, then go to that folder.
2. With the new workbook active, select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Multiple Gaussians.dat. Drag-and-drop this file into the empty worksheet to import it.
3. We will add long names for the datasets. Enter "Peak 1" in the Long Name label row of column B. Click and select the long name cell. Then move the mouse to the lower-right corner of the cell so that the cursor changes to "+". Click the left mouse button and drag from column C to E. Origin will auto-fill the names as Peak 2, Peak 3 and Peak 4.
4. Click and drag on the column headers to highlight columns B to E. From the main menu, select Plot > Basic 2D: Stacked Lines by Y Offsets to create a stacked lines graph.
5. With the graph active, select Gadgets: Integrate... from the main menu.
6. Accept the default settings and press the OK button. A region-of-interest (ROI) box will be placed on the graph. Move and/or resize the ROI to cover a desired range of the data.
7. Click on the triangle button at the top-right corner of the ROI box and select Preferences to re-open the dialog.
8. In the Output tab, expand the Output Quantities to branch and select the Append to Worksheet check box. Click OK to close the dialog box.
9. When there are multiple plots in a layer, the gadget acts on the active data plot by default. In this case, the active plot is Peak 1. To change the data to Peak 3 for example, click on the triangle button at the top-
right corner of the ROI box and select **Change Data: Plot(3): Peak 3** from the context menu.

10. Click on the triangle button again and select **New Output for All Curves**. A workbook with integration results for all curves will be generated. Click the triangle button and select **Go to Report Worksheet** to switch to the output workbook.

11. Click the X button at the top-right corner of the ROI box in the graph to remove the gadget.

### 1.8.1.2 FFT Gadget

1. Start with a new workbook, and import the file `<Origin EXE Path>\Samples\Signal Processing\Chirp Signal.dat`.
2. Highlight column B, then select **Plot > Basic 2D: Line** from the main menu to create a line graph.
3. With the graph active, select **Gadgets: FFT** from the main menu. Accept defaults in the dialog that opens, and click **OK**. An ROI box will be placed on the graph, and another graph named FFTPREVIEW will be created, displaying the FFT result.
4. In the top right corner of the FFTPREVIEW graph, uncheck **Log Scale**. Then reposition the source line graph and FFTPREVIEW window side by side. Move and resize the ROI to cover a small range of the beginning of the data curve.
5. Now you can use the arrow keys to move the ROI to the right, while watching the FFT result update in the other graph.

Save the project file.

1.9 Curve Fitting

In this lesson we will learn how to perform linear and nonlinear regression.

1.9.1 Linear Fit with Outliers

1. Start with the project saved from the previous lesson, and add a new folder at the root level in Project Explorer named Curve Fitting.
2. Import the file `<Origin EXE Path>\Samples\Curve Fitting\Outlier.dat` by dragging-and-dropping the file into an empty worksheet.
3. Select the 2nd column and create a scatter plot.
4. Select the menu item Analysis: Fitting: Linear Fit. In the dialog that opens, accept default settings and click OK to perform the linear fit.
5. In the graph, click on the fitting results table and select Quantities in Table button from pop-up mini toolbar. Remove all entries except Intercept, Slope and Pearson’s r (use CTRL + select for multiple selections). Click OK and resize the results table as needed.
6. Now click the Mask Points on Active Plot button on the left side toolbar and mask the point at the right bottom, which is distinctly separated from the rest of data points.
7. The lock on the top left of the graph page turns yellow indicating that the data has changed, but the fit results are in need of an update.
8. Hit the ESC key to switch the cursor back to pointer mode. Then click on the yellow lock, and from the fly-out menu select Recalculate Mode: Auto. The fit results will be updated.

You can update all pending operations in a project by clicking on the Recalculate button located in the Standard toolbar.
9. Go back to the graph and use the masking tool to mask the outlier point towards the top. You will notice that the results automatically update. Your graph should now look similar to this image:

![Graph Image]

1.9.1.2 Nonlinear Curve Fit

1. Start with a new workbook, and import the file `<Origin EXE Path>\Samples\Curve Fitting\Gaussian.dat`.  
2. Highlight the column named `Amplitude` and make a scatter plot.  
3. Go back to workbook, highlight column named `Error`, then select Set As Y Error button from pop-up mini toolbar.  
4. Place the mouse cursor close to the right edge of the highlighted column. The cursor will change to . At this point, drag and drop the column onto the graph. The data will be added as error bars on the scatter plot.  
5. Now let's fit this data. Select the menu Analysis: Fitting: Nonlinear Curve Fit to open then NLFit dialog.  
6. In the Function Selection page, set Category drop down to Peak Functions, and set the Function drop down to Gauss.
7. Click **Fit** button to perform fitting and choose **No** in the prompt dialog, to keep the graph window active.

8. Now we want to fix \( y_0 \) as 0 and update the results. Click on the green lock on the top left of the graph page, and select **Change Parameters**.

9. The dialog re-opens with the settings that were used last time the operation was performed. Go to the **Parameters** tab, check the **Fixed** box for \( y_0 \) and enter **Value** as 0.

<table>
<thead>
<tr>
<th>NO.</th>
<th>Param</th>
<th>Meaning</th>
<th>Fixed</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>( y_0 )</td>
<td>offset</td>
<td>✔️</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>( xc )</td>
<td>center</td>
<td>✔️</td>
<td>( 26 )</td>
</tr>
</tbody>
</table>

10. Click the **Fit** button to update the file and close the dialog. From the updated table on the graph, we can see that \( y_0 = 0 \pm 0 \).

1.9.1.3 **Global Fit with Parameter Sharing**

1. Start a new workbook and import the file `<Origin EXE Path>\Samples\Curve Fitting\Exponential Decay.dat`.
2. Drag and select the three Y columns and create a line plot.
3. We want to fit all three data plots simultaneously over the x range of 0.4 s to 1.0 s. In the **Tools** toolbar docked to the left side of the interface, click the down arrow button on the right of **Selection on Active Plot** button ⬇️. From the fly-out, choose **Selection on All Plots**. Go to the graph and drag and draw a
rectangle to roughly cover the x range of 0.4 to 1.0, including all the three curves in the process.

4. Press CTRL+Y to quickly launch the NLFit dialog. Then set Category as Exponential and Function as ExpDec1.

5. Click on Data Selection under the Settings tab, expand the Input Data node and you will find all three curves are added. You can expand the Range# node to further adjust data ranges either by row index or by x value.

   ![Image](image.png)

   If no range selection has been made on the multiple plots, Origin will only pick up the active data plot from the graph layer containing multiple plots. In that case you can click the button on the right side of Input Data and select Add all plots in active page.

6. Change Multi-Data Fit Mode to Global Fit, switch to the Parameters tab and click the Fit until converged button to fit all three curves simultaneously, keeping the dialog open.

7. You can share parameters during a global fit. Check the Share box for the time constant \( t_1 \). You will notice that the time parameter for the other curves has been removed from the parameters list.

8. Click the Fit button and select Yes in the prompt that appears, to switch to report sheet. If the prompt does not come up, you can click on the green lock in the graph and select Go to Results.

9. Scroll down to the Summary table in the report. You will find that all time constants \( t_1 \) share the same values.

   ![Table](table.png)

10. Now click on the down arrow button beside the Summary node and choose Create Copy as New Sheet. A new worksheet with the fit results will be added to the book.
11. Select column D, E and create a column plot to display how the amplitude parameter (A1) changed across the three datasets.

![Column Plot Example]

Save the project file.

**1.10 Peak Analysis**

In this lesson we will perform fitting, including deconvolution of overlapping peaks and baseline correction.

1.10.1.1 Multiple Peak Fit with Deconvolution

1. Let’s continue with the project file we saved in the previous lesson. Create a new folder in Project Explorer, rename it as **Peak Analysis**, then go to the empty folder.
2. In a new workbook, import the file `<Origin EXE Path>\Samples\Spectroscopy\HiddenPeaks.dat`.
3. Highlight column B and create a line plot.
4. With the graph window active, click **Analysis: Peaks and Baseline: Multiple Peak Fit**. This will open the **Multiple Peak Fit** dialog. Set the **Peak Function** drop-down as Gauss and click **OK**.
5. A **Get Points** dialog will open within the graph window. Note that you can re-position this dialog within the window. Double-click on a peak center to select it. Select a total of 7 peaks as in the following image, including two hidden peaks:
If you click the **Open NLFit** button in the **Get Points** dialog, the NLFit dialog will open with the peak centers initialized with your selection. You can further control the fitting process as desired.

6. After selecting all seven peaks, click the **Fit** button. A fit report will be added to the workbook.

### 1.10.1.2 Fit Peaks with Baseline

1. This part of the lesson assumes you have OriginPro. Start with a new workbook and import the file \<Origin EXE Path>\Samples\Spectroscopy\Peaks_on_Exponential_Baseline.dat.
2. Highlight column B and then click **Analysis: Peaks and Baseline: Peak Analyzer**. This will open the **Peak Analyzer** dialog, and a preview window displaying the selected data.
3. In the bottom panel, select the **Fit Peaks (Pro)** choice under **Goal**. The top panel will update, displaying a map of the steps involved in the peak fitting process.
4. Click **Next**. On the **Baseline Mode** page, select **User Defined** for **Baseline Mode**. Click **Next** to go to the **Create Baseline** page. You can then see in the preview window that 8 anchor points connected by a red line, are added to the spectrum. This is the baseline created using the current settings. Now click the **Prev** button to go back to the **Baseline Mode** page to adjust the baseline mode settings.
5. Click the **Find** button below **Number of Points to Find**, to find the baseline anchor points in the spectrum. Eight (8) anchor points are added.
6. Clear the **Enable Auto Find** checkbox and then click the **Add** button to add one or more anchor points on the spectrum. Double-click on the tail of the spectrum like the following image to add 1 anchor point.

![Anchor Points](image)

7. Note that you can also select and delete anchor points. Click **Done** to return to the **Peak Analyzer**.

8. Select the **Snap to Spectrum** checkbox to force anchor points to snap to the closest data point in the spectrum. Click **Next**.

9. On the **Create Baseline** page, select **Fitting** in the **Connect by** option. Select **ExpDec2** for **Function** under the **Fitting** branch. Click **Next** twice to go to the **Find Peaks** page.

10. Click the **Find** button. Two (2) peaks are found in the preview.

    There are several options available for peak finding including a 2nd derivative method to find overlapping peaks. You can also view the 2nd derivative curve, and turn on smoothing to help find peaks in noisy data.

11. Click **Next** to go to the **Fit Peaks** page. Accept defaults and click **Finish** to perform peak fitting. A graph containing fitting results is generated.

    ![Fitting Results](image)

    You can click the **Fit Control** button to control the fitting process including fixing and sharing parameters, and specifying bounds and constraints.

12. Now, let’s customize the **Fitting Results** table to hide some peak properties we don't want to display. Right-click on the table and select **Peak Report Field...** from the context menu. The **Peak Report Field** dialog will open, listing all properties that can be included in the table. You can remove or change the order properties in this dialog. Select **Peak Gravity Center** and click the **Remove** button to hide it. Do
the same for **Peak Area by Integrating Data(%)**. Press **OK** to update the table in the graph.

Save your project file.

### 1.11 Statistics

Origin provides many tools for statistical analysis. Advanced statistical tools are available in OriginPro. In this lesson, we will work with tools available in standard Origin.

#### 1.11.1 Descriptive Statistics

1. Start with the project saved from the previous lesson, create a new folder in Project Explorer and rename it as **Statistics**. Open the empty folder.
2. Create a new workbook and import the file `<Origin EXE Path>\Samples\Statistics\body.dat`.
3. Drag and select the first 5 rows of column **D(Height)**. Basic statistics (average, sum, count) for your selected data will be displayed in the status bar at the bottom right side of the interface.

   ![Status Bar](image)

You can right-click on the statistics listed in the status bar to customize what quantities to display there.
5. From the menu, select **Statistics: Descriptive Statistics: Statistics on Columns**. In the dialog, select the **Input** tab, then expand **Range 1**. Click on the interactive button to the right of **Data Range**. Return to the worksheet, then drag and select columns **D** and **E**. Click the interactive button again to restore the dialog.

6. In the **Group** control, click the triangle button and select **B(Y): age**. Click the button again and select **C(Y): gender**. In the list, select "gender" in the **Group** box, then use the **Move Up** button to move it to the top.

7. Click **OK** to generate the report.

8. Click the downward-pointing triangle button on the right of the **Descriptive Statistics** node in the report sheet and select **Digits...** from the context menu.

9. In the opened dialog, change **Digits** to **Set Decimal Places** and set **Decimal Number** as 1. Click **OK** to update the display format in all tables of the report.

The numeric display in all report sheets can be globally set using the **Digits in Report** control on the **Numeric Format** tab of the **Options** dialog accessible from the **Preference: Options** main menu.

1.1.1.2 **Normality Test**

1. Create a new workbook by clicking the **New Workbook** button.

2. Double-click in the **F(x)** label row of column A. This will put you into edit mode for that cell. Type the formula:

   \[ \text{nint}(100+20*\text{normal}(100)) \]

3. The column will be filled with random integer numbers centered around 100.

4. Highlight column A and click **Statistics: Descriptive Statistics: Normality Test** to open the dialog. The selected column is set as **Input Data** automatically. Accept default settings and click **OK**. This will generate the report sheet for **Normality Test**. The footnote under the **Shapiro-Wilk** table indicates that...
this data is normally distributed, as expected.

1.11.1.3 Frequency Counts

1. Activate Sheet1 of the workbook from the previous section. Keep column A highlighted, then click Statistics: Descriptive Statistics: Frequency Counts.
2. Accept all default settings in the dialog and press OK.
3. In the result sheet, highlight the column C(Y). On the 2D Graphs toolbar, click the triangle button next to the Column button, then choose Column + Label to create a column graph with labels. This will create a histogram plot with counts as labels.

The Plot: Statistical menu provides multiple histogram plot options when a worksheet is active. This Frequency Counts tool provides an alternate way to first perform counting, and then plot a histogram from the results. This allows for more flexibility and customization such as adding labels to the columns.

1.11.1.4 One Way ANOVA

1. Create a new workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file nitrogen.txt. Drag-and-drop this file into the empty worksheet to import it.
2. Select the menu Statistics: ANOVA: One Way ANOVA to open the One Way ANOVA dialog. In the Input tab, set Input Data to Indexed. Press the triangle button to the right of Factor and select A(X): plant. Press the triangle button to the right of Data and select B(Y): nitrogen.

The ANOVA dialog box provides two options for input mode: Indexed or Raw. You can refer to the FAQ-333: What is indexed versus raw data and how to transform from one to another? to learn more about how data can be arranged for either mode.
3. In the **Means Comparison** tab of the dialog, select the **Tukey** check box. Then switch to the **Plots** tab and select **Means Comparison Plot**. Click **OK** to close the dialog and generate the report.

4. Go to the report sheet **ANOVA1Way1**. From the result, we can draw following conclusions:
   - The ANOVA table (**Overall ANOVA**) reports a p-value that is smaller than 0.05, hence at least two of the four groups have significantly different means.
   - Double-click on the **Means Comparison Plot** to open it. The red plots indicate significantly different mean values. **PLANT4** has the smallest mean and is significantly different from the other three groups.

Save your project file.

### 1.12 Analysis Template

In this lesson we will learn how create an **Analysis Template** and re-use it for new data.

1. Continue with the project file saved from the previous lesson. Create a new folder in Project Explorer and rename it as **Analysis Template**. Open the empty folder.
2. Create a new workbook and import the file `<Origin EXE Path>\Samples\Curve Fitting\Sensor01.dat`.
3. Highlight column B and select **Plot > User Templates: My Line** to create a line graph from the graph template `My_Line.otp` that we saved in lesson 1.
4. With the graph window active, select **Analysis: Fitting: Linear Fit** from menu. This will bring up the **Linear Fit** dialog.
5. In the **Fit Control** tab, select the **Fix Intercept** check box to force the fitted curve go through (0,0). Select **Auto** for **Recalculate**. Click **OK** to perform the linear fit. The fitted curve and a result table will be added to the graph.

6. Click on the result table and select **Quantities in Table** button from the popped-up mini toolbar. In the dialog, remove all entries other than **Slope** and **Adj. R-Square**, then click **OK** to update the table.
7. Double-click on the X axis to open the **Axis** dialog. With the **Scale** tab active, hold down the **Ctrl** key and select both **Horizontal** and **Vertical** in the list box on the left. Change **Rescale** to **Auto** and click **OK**.
This is to make sure the axis range will update when data changes.

8. Select the legend on the graph and delete it.

9. Go back to the source workbook. Right-click on any one of the sheet tabs and select **Add Graph as Sheet** from the context menu to insert it as an embedded graph inside a new worksheet.

10. Now we have source data and all analysis results in one book. Let's save it as an Analysis Template. Select **File: Save Workbook as Analysis Template...** from menu. Save the workbook as **My Sensor Analysis.ogw**.

   ![Image](image)

   Any work book which has an operation linking input and output, indicated by a lock on output sheets or columns, can be saved as an analysis template. The simplest example would be a sheet where column value calculations have been performed.

11. Now use the **File: Recent Books** menu command to open **My Sensor Analysis.ogw**. The analysis template will open. Note that the date sheet, results and graphs are empty.

12. With the first data worksheet active, select **Help > Open Folder: Sample Folder**. Then go to the **Curve Fitting** subfolder. Drag **Sensor02.dat** to the sheet.

13. The linear regression results and the embedded graph will update automatically, because we had set the **Recalculate** mode in the linear fit tool to **Auto**.
Tutorials for Origin 2024b

Analysis templates can be used manually to process one file at a time, or can be used to perform batch analysis of multiple data files or datasets. Please view the [Batch Processing tutorial](#) to learn more.

Save your project file.

### 1.13 Apps in Origin

Besides the tools and capabilities pre-shipped and included in Origin, you are able to install the free Apps to extend graphing and analysis functionality of Origin.

In this lesson, we will show you how to search an App, install and use it to plot a tangent curve at specified point of a line+Scatter plot.

1. Continue with the project file saved from the previous lesson. Create a new folder in Project Explorer and rename it as **Apps**. Open the empty folder.

2. Select the **F10** key to open the App Center dialog.

   **Note:** You can as well open the **App Center** dialog by selecting **Add Apps** in the **Apps Gallery** Window.

3. Select the Search tab and input **Tangent** into the search engine and select the Search icon in order to search for the app. Click the **download and install** icon. Once the App is installed, the download and
install icon will change to a green check-mark (Up-to-date Version icon).

Besides installing apps from App Gallery, you can also go to the OriginLab File Exchange to download the app you desired, drag and drop the .opx file into Origin workspace to install it. You can see the details here.

4. Close App Center. An icon named Tangent will appear in the Apps Gallery window docked to the right end of the workspace.

5. Here, we are allowed to add new tabs in App Gallery to manage the installed apps. Right-click in an empty portion of the Gallery and choose New Tab, then double-click on the default tab name and enter
“Graphing” as the tab name.

6. Go back to the tab All, right-click on the icon of Tangent app we just installed, select Tab Views: Graphing. This app will show in the Graphing tab.

7. Now import the file <Origin EXE Path>\Samples\Curve Fitting\Exponential Decay.dat into a new workbook.

8. Highlight col(A) and col(B) to select Plot > Basic 2D: Line + Symbol from the main menu to plot a scatter plot.

9. Click the Tangent button in the Apps Gallery to open the Tangent: addtool_tangent dialog.
App operations may be window-specific,

- If the App is dimmed (grayed out), the active window cannot be operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps Gallery).
- If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by clicking on it in the Apps Gallery.

10. Keep the default setting and click OK. A red vertical line and a blue tangent line are added to the plot. The value of slope is shown at the top. The tangent point is intersected point of the two lines.

11. You can move the red anchor to a position, click the triangle button at the top right corner of the layer to select New Output to output the results. You can also select Preferences... from this context menu to open the Tangent Preferences dialog to do more settings such modifying the Smooth method.

You can always access to the document of an App by right-clicking App icon and selecting:

- Open App Webpage to open this App’s OriginLab File Exchange web page for the detailed document.
- Open App Tutorial Webpage to read or request a tutorial of how to use this App.
## Video Tutorials

To get started quickly with Origin, you could watch the videos in the following table:

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction to Origin</strong></td>
<td>Learn how to quickly start using Origin from importing data, customizing column label rows, creating a multi-panel graph, selecting part of the data, performing integration, finding and fitting peaks, and using Recalculate to perform fitting with altered parameters.</td>
</tr>
<tr>
<td><strong>Importing Data</strong></td>
<td>Learn how to import ASCII file, customize your Import ASCII dialog settings and save them for future reuse, and use the Import Wizard to import data file and customize the import settings.</td>
</tr>
<tr>
<td><strong>Creating a Graph</strong></td>
<td>Learn how to create a graph using the graph toolbars or the Plot Details dialog, add data to an existing graph, and plot groups of plots by label.</td>
</tr>
<tr>
<td><strong>Customizing a Graph</strong></td>
<td>Learn how to add a layer title, resize a layer, change the axes properties, save a graph as a template and reuse it, customize a graph by using theme, change the plotting order, customize a single data point or a grouped data plot.</td>
</tr>
<tr>
<td><strong>Interpolation</strong></td>
<td>Learn how to change line connection to interpolate data and use Interpolate Gadget to perform data interpolation. Also, interpolate new Y data from given X data based on specified XY range.</td>
</tr>
<tr>
<td><strong>Linear Fitting</strong></td>
<td>Learn how to perform a linear fit with outlier removal.</td>
</tr>
<tr>
<td><strong>Nonlinear Curve Fit Tool</strong></td>
<td>Learn how to fit with a built-in fitting function and change the NLFit settings using Change Parameters. Also, learn how to define and fit with a user-defined function.</td>
</tr>
<tr>
<td><strong>Creating an Analysis Template</strong></td>
<td>Learn how to set up a workbook for repetitive analysis using a linear regression example.</td>
</tr>
<tr>
<td><strong>Batch Processing</strong></td>
<td>Learn how to create an analysis template, and use this template to batch process multiple data files.</td>
</tr>
<tr>
<td><strong>Introduction to OriginPro</strong></td>
<td>Learn about all of the extended analysis tools in the areas of peak fitting, surface fitting, statistics, signal processing and image processing offered in OriginPro.</td>
</tr>
</tbody>
</table>

**Note:** Please visit the [video tutorial page](#) on our website for a complete and most up-to-date list of video tutorials.
3 User Interface

3.1 User Interface

- Tutorial: Origin GUI

3.2 Origin GUI

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename Windows in Origin</td>
<td></td>
</tr>
<tr>
<td>Origin Window Basics</td>
<td></td>
</tr>
<tr>
<td>Customize Menus</td>
<td></td>
</tr>
<tr>
<td>Customize Toolbars</td>
<td></td>
</tr>
<tr>
<td>Start Menu with Search</td>
<td></td>
</tr>
<tr>
<td>Object Manager</td>
<td></td>
</tr>
<tr>
<td>The Formula Bar</td>
<td></td>
</tr>
</tbody>
</table>

3.2.1 Summary

This tutorial will introduce you to the Origin workspace. You will learn about the different kinds of Origin windows that make up a Project, how to manipulate these windows with Project Explorer, how to manipulate layers and plots with Object Manager and how to manage Apps with Apps Gallery.

Minimum Origin Version Required: Origin 2016 SR0

3.2.2 What you will learn

This tutorial will show you how to:

- Manipulate Workbooks
- Create Graph Windows
- Manage workspace with Project Explorer
- Manipulate Layers and Plots with Object Manager
- Manage Apps with Apps Gallery

3.2.3 Origin Application: Title Bar and Status Bar

The Origin Title Bar displays the Origin(Pro) version, any open project name and the current folder within that project (if any) along with the standard Window controls for moving, sizing and closing the window.
The **Status Bar** appears at the bottom of the Origin workspace and hosts the **Start Menu**; plus it displays messages, the state of Auto Update, summary statistics (user-customizable) of currently-selected worksheet cells, Child Window Theme (if any), Last active Workbook, Current Window and Angular Units indicator.

1. Customize what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items from the context menu.
2. Copy summary stats by selecting **Copy Statistics** from the context menu. The copied data are TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.

The **Auto Update** item on the Status Bar shortcut menu relates to the current state of all auto-updated recalculation operations. Normally, you will see **AU: ON** on the status bar, indicating that any change to input data will trigger automatic recalculation of output where the **Recalculate Mode** is set to **Auto**.

![Average=-1.6656 Sum=-1.6656 Count=1 [AU: OFF] 1: [Coherence]Coherence!]()

When a large number of such operations slow your work, consider turning **Auto Update OFF**. When ready, you can turn it back on or trigger manual recalculation of output.

### 3.2.4 Windows

#### 3.2.4.1 Dynamic menus according to the active child window

The Origin menu dynamically changes according to the active Child Window. Some menus (Help, File, Edit, etc.) appear on all Child Window menus, although their content may change.

1. Click on the **New Project** button on the **Standard Toolbar**.
2. The workbook window is the active window. Note that there are 13 menu items.
3. Click on the **New Graph** button on the **Standard Toolbar**. A new window called **Graph1** is created. Note that there are 11 menu items displayed.

Thus, we say that the menus are "context sensitive." They will change depending on which type of Child Window is active.

**Note:** New Child Windows may be added by selecting the **File: New** menu option or clicking the appropriate button on the **Standard Toolbar**. All Child Windows have standard controls for moving and sizing and windows can be placed anywhere within the Origin workspace. The **Window** menu has options (cascade, tile) for arranging child windows within the workspace. In the central Origin Workspace is where you will find all Origin Child Windows which can include:

- **Workbooks** - The Origin workbook is the primary structure for organizing your data. Each workbook is composed of one or more, up to 255 worksheets.

- **Graphs** - With Origin, you can create over 60 graph types, each from a built-in graph template. Graph windows can be embedded in a worksheet cell.

- **Matrices** - The Origin matrix holds data and images and is required for many 3D graph types.

- **Notes** - Notes windows are a text-only Origin child window useful for recording analysis procedures, making notes to students and colleagues, etc. You can embed notes windows in a worksheet cell.

- **Layouts** and **Excel** (If you have Excel installed)
The Origin workbook is the primary structure for organizing your data. Each workbook is composed of one or more Origin worksheets. Each worksheet is generally composed of one or more worksheet columns or datasets. Columns in Origin have different column types (“designations”) such as X, Y, Z, yError, etc. These user-configurable designations are used to determine how data should be treated for graphing and analysis purposes.

Origin and OriginPro projects can contain any number of workbooks (limited by system resources). Projects saved with the Student Version are limited to 30 windows total (graph, workbook, matrixbook, etc.).

- The workbook has a Short Name and optionally, a Long Name and Comments.
- The workbook can contain up to 1,024 worksheets.
- The worksheet can contain up to 65,500 columns or 90,000,000 rows.
- Each sheet has a data area and a set of Column Label Rows that can be used to display column metadata.

To get familiar with manipulating Origin workbooks, try the following:

1. Click New Workbook button to create a new worksheet.
2. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Gaussian.dat. Drag-and-drop this file into the empty worksheet to import it.
3. On import, sparklines were automatically turned on, allowing you to quickly view the shape of the data; the sheet name became the name of the file; and as needed an additional column was added to the worksheet. You can see from the Long Name that the 3rd column represents data error. To set this column as an Error Column, click the column title to highlight the column, right-click to bring up a fly-out menu, and then select Set As: Y Error.
4. Plotting data in Origin is now easy; highlight column B and C (Y and Y error), then select Plot > Basic 2D : Scatter from the menu to create a scatter plot with error bar.

**Note:** Do not delete this workbook and graph as we will revisit these windows in the section on Mini Toolbars.

3.2.4.3 Graph

The Graph window is a container for graphical depictions of your experimental data and your analysis results. Graph windows may contain a single plot in a single graph layer or they may contain multiple plots in multiple graph layers.

The graph layer is the fundamental unit of the Origin graph. The layer is comprised of a set of axis scale values, one or more data plots, and any included text labels, drawing objects, graph legends/color scales, button objects, etc. Graph layers can be created, sized, and moved independently of one another, allowing you a great deal of latitude in charting your data.

To learn how to organize layers in a graph window, try the following:

1. Create a new workbook, and import the file *Linear Fit.dat* from the \Sample\Curve Fitting folder. You can see that there are three Y columns and one X column after import; each Y column will use the left-most X column as its X coordinates.
2. Highlight columns B and C, and select Plot: Multi-Panel/Axis: Vertical 2 Panel to plot the curves. This is a two layer graph. While a graph can have multiple layers, only one layer is active at any given time. You can perform operations on the active layer, such as resizing, changing the plot color, etc. When working on a layer, the active layer is denoted by a depressed layer n icon in upper left corner of the
graph window.

3. To rearrange these two layers, with the graph window active, select the menu item **Graph: Layer Management** to bring up the dialog. Activate the **Arrange** tab, on the middle panel. Enter 2 in the **Column** edit box. Enter 1 in the **Row** edit box and click the **Apply** button. After you click the **OK** button,
the graph layers are arranged horizontally.

Most often you will use the worksheet for tabulating and manipulating your data, while you will use the graph window for plotting your data.

3.2.4.4 Matrix

The Origin matrix window is a container for one or more Origin matrices. Each matrix window contains one or more matrix sheets, and each matrix sheet can contain one or more matrix objects. The matrix object itself, is a vector of Z values. These Z values are related to one another in the X and Y dimensions by their relative row and column positions in the matrix. Matrices are a precursor to constructing Origin's 3D graph types such as contour graphs and color-mapped surfaces, and since they are used in depiction and manipulation of 3D data, they are used by Origin in image processing and analysis. We will show you how to use the Origin Matrix to create a 3D plot in a later tutorial.

3.2.5 Toolbars

The Customize Toolbar dialog box handles displaying or hiding toolbars and toolbar buttons.

2. Check the box next to Column. This toolbar now appears in the workspace.
3. Make the Button Groups tab active.
4. Scroll to select AutoUpdate in the Groups list.
5. Click and drag the one button which appears in this group and drop the button next to the green version of this button without the red line, on the **Standard Toolbar**. You can drag buttons back and forth.

6. Click **Close**.

All these toolbars may be dragged away from their docked positions to become floating windows. Floating windows have additional controls besides the X to hide a window. A push-pin control can allow or prevent docking and a minimize button can roll-up a window to save space and restore the window when it is needed.

### 3.2.5.1 Toolbar Reference

Below are the most commonly used toolbars.

**Standard Toolbar**

![Standard Toolbar Image]

**Worksheet Data Toolbar**

![Worksheet Data Toolbar Image]

**Graph Toolbar**

![Graph Toolbar Image]

**Format Toolbar**

![Format Toolbar Image]

**Style Toolbar**

![Style Toolbar Image]

**Tools Toolbar** *(vertical on the left side of the Origin workspace)*

![Tools Toolbar Image]

**2D Graphs Toolbar**

![2D Graphs Toolbar Image]

**3D and Contour Graphs Toolbar**

![3D and Contour Graphs Toolbar Image]

**Mask Toolbar**

![Mask Toolbar Image]

### 3.2.6 Mini Toolbars

Mini Toolbars are context-sensitive tools made available for common workbook, graph and matrixbook editing and configuration tasks.

1. Create a new workbook, select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Statistics** subfolder and find the file **automobile.dat**. Drag-and-drop this file into the empty worksheet to import it.

2. Click on column header **C(Y)** to select the column and on the Mini Toolbar, click the **Set as X** button.

   Click on the **F(Y2)** column (Gas Mileage) and click the **Scatter** button on the 2D Graphs toolbar.
3. Click on the data plot of Gas Mileage (mpg) vs Power (kw) and on the Mini Toolbar that appears, click the Plot Symbol button and switch to a round symbol. Click the Decrease Symbol Size button twice to reduce symbol size. If the Mini Toolbar fades before you click this button, press the Shift key to restore the Mini Toolbar.

4. Finally, click on the data plot again and then click the dots in the lower center of the Mini Toolbar. The Customize Mini Toolbar dialog opens allowing you to add or remove buttons from the active toolbar. You may wish to use this feature if there are buttons on the Mini Toolbar that you never use.

3.2.7 Project Explorer

Project Explorer is a tool to help you organize your Origin data. It is particularly useful if you are working with a project that contains numerous child windows. Use Project Explorer to develop a folder structure to organize the child windows in your project.

3.2.7.1 Open/Close Project Explorer

When you first start Origin, Project Explorer displays docked to the edge of the workspace. You can dock it to any other edge or float it in the workspace. Because Project Explorer uses some of your workspace, you may want to close Project Explorer, even if you have already created a folder structure. To close/open Project Explorer, click the Auto Hide button to pin the Project Explorer, then press Alt + 1 or select menu item View: Project Explorer.
3.2.7.2 Change the Display Properties of Project Explorer

The project explorer can be auto-hidden, hidden, floating or docking. In another aspect, it has vertical and horizontal alignment.

1. Select **Customizing Graphs.opj** in `<Origin EXE Folder>\Samples\Graphing` folder.
2. By default the **Project Explorer** is auto hidden, move mouse over to the **Project Explorer** bar in the left of work space to expand it.

3. Click the **Auto Hide** button to pin the **Project Explorer**, so it will be always displayed.

4. Select the **Window Position** drop-down and select **Floating** to make the Project Explorer float over the work space, and you can freely move its position:

5. Right click on the title bar of the floating Project Explorer and select **Horizontal Alignment**.
Note: Other dockable windows (Object Manager, Apps, Message Log, Smart Hint Log, etc.) have the similar controls to change the display properties.

3.2.7.3 **Browse Origin windows in Project Explorer**

There are two panels in Project Explorer: the folders panel and the contents panel, which displays all objects in the active folder. When you start a new Origin session, you can click the new workbook, new graph or new matrix button to create some blank windows, and then you can see these window's icons in the contents panel. Double-click the icon to hide/view the window.
3.2.7.4 **Add a Sub Folder in Project Explorer**

To create a new folder, right-click on the project folder (or a subfolder) in the folder panel, and select **New Folder** from the shortcut menu.
Once you have created one or more subfolders, you can move child windows between folders by dragging & dropping them within the Project Explorer workspace.

### 3.2.8 Object Manager

Object Manager provides a hierarchy structure to help you view and manipulate layers and plots in the active graph window. It is particularly useful if the graph contains multi-layers and each layer contains multi-plots.

#### 3.2.8.1 Open/Close Object Manager

When you first start Origin, Object Manager is docked to the right edge of the workspace. Like Project Explorer, you can dock it to any other edge or float it in the workspace. To close/open Object Manager, select menu item **View: Object Manager**.

#### 3.2.8.2 Manipulate layers and plots in Object Manager

Object Manager works interactively with active graph window. Selecting layer or plot in graph window will highlight the corresponding item in Object Manager and vice versa. This makes it very easy to select an item and then show or hide it.
For example, try the following:

1. Select **Help: Learning Center** menu or press **F11** key to open **Learning Center**. Select **Graph Sample** in the left side of dialog, choose **Multiple Panel** for **Samples in** drop-down list. Double-click on **Multiple Panel by Column Label** thumbnail to open the sample graphing project.

2. Select any plot object (such as a layer, a plot group or a curve) in graph window, the corresponding items will be highlighted in Object Manager. Select items in Object Manager, the corresponding object will be highlighted in the graph window.

3. In Object Manager, Uncheck the checkbox before the plot **Trial Run 1 of Layer1** to hide this plot.

4. Right click on the plot **Trial Run 2 of Layer1** and select **Hide Plots with Same Name** to hide all plots named **Trial Run 2**.

5. Right click on the plot **Trial Run 2 of Layer1** again and select **Show All Plots**. All **Trial Run 2** plots are back.
The plot names in Object Manager is the Auto Legend Translation mode set in the graph. Therefore same name or not depends on what the legend translation mode is used.

Besides using Object Manager to turning on or off layers or plots, it can also be used to:

- Change plot orders by right clicking on a plot and selecting **Move Up/Move Down**
- Change plot type by right clicking on a plot and selecting **Change Plot To**
- Go to source workbook/matrixbook by right clicking on a plot and selecting **Go to xxx**
- Double click on an item to open corresponding node in Plot Details dialog for further customization or use context menu to open Useful dialogs.

### 3.2.9 Apps

**Apps** are custom applications for Origin that perform specific graphing and/or analysis tasks. Apps are not pre-installed with Origin. If you want to get an App, you can

- Browse to our [File Exchange](#) page of the OriginLab website, search and download the app you desired to install.
• Open **App Center** (by selecting **Help:App Center**, or pressing **F10** key, or clicking the **Add Apps** button that appears on all tabs of the Apps Gallery), browse available Apps, search for Apps using keywords and phrases, and install or update Apps with a single click.

![App Center](image)

Browse for Apps, search using keywords or phrases, and install or update Apps with a single click.

When Apps get installed, they will be visible in the **Apps Gallery** window of the Origin interface.

![Apps Gallery](image)

In the **Apps** panel, you can add new tabs from the context menu and then classify these installed APPs by putting them to different tabs, see "Graphing", "Analysis" tab in the above APP Gallery. All Apps will be presented in the **All** tab in the order of their installation times.
Each installed App will be displayed as an icon in the gallery window. You can simply click on the icon to launch the App and right-click on the icons for other options such as hiding, uninstalling the App or movement between the tabs.

### 3.2.10 Learning Center

The **Learning Center** dialog helps you get started with Origin easily. You can select **Help: Learning Center** from Origin menu or press F11 key to open it.

With this dialog, you can
• Open Graph and Analysis Samples
• With the Learning Sources, get started with Origin
• Transfer User Files

3.2.11 Messages Log
The Messages Log window shows messages about operations including Output Information, Results and Errors. It displays messages that are not sent to the Script Window or the Command Window. To close/open Messages Log, press Alt + 6 or select menu item View: Messages Log.

1. Open a new workbook, highlight the A(X) and B(Y) columns, right-click and and choose Fill Columns With: Row Numbers from the shortcut menu.
2. Highlight the columns and from the Main Menu, choose Plot: 2D: Line: Line. A simple line plot is drawn.
3. Select File: Export Graphs... from the main menu to open the ExpGraph dialog. In this dialog, keep the default settings and click OK to export the graph.
4. The Output Information is reported to the Messages Log window.
4 Data Analysis

4.1 Data Analysis

4.1.1 Gadgets

- Global Vertical Cursor
- Integrate Gadget
- Curve Intersection Gadget
- Rise Time Gadget
- Interpolate Gadget
- Cluster Gadget
- Quick Fit Gadget
- Quick Peaks Gadget
- Quick Sigmoidal Fit Gadget
- Using Multiple Gadgets

4.1.2 Curve Fitting

4.1.2.1 Linear and Polynomial Fitting

- Linear Fitting and Outlier Removal
- Linear Fit for Kinetic Models

4.1.2.2 Nonlinear Fitting

- Nonlinear Curve Fit Tool
- Nonlinear Fitting with System Function
- Global Fitting with Parameter Sharing
- Global Fit for Different Functions with Shared Parameters
- Parameters Initialization using LabTalk in NLFit
- User Defined Fitting Function
- Fit Surface with User Defined Function
- Fitting One Dataset as a Function of Other Datasets
- Fitting With Multiple Independent Variables
- User Defined Fitting Function using GNU Scientific Library
- Fitting with NAG Special Function
- Fitting Integral Function with parametric limit using NAG Library
- Fitting with Integral using NAG Library
- Fitting with Integral using LabTalk Function
- Fitting with Two Integrals using LabTalk Function
- Fitting with Summation
- Fitting Complex Function
- Fitting with Convolution
- Quoting Built-in Functions in Your New Function
- Fit Function with Non-constant Background
- Fitting with Piecewise Functions
- Fit Curve Through Certain Points
- Distribution Fit with the Probability Density Function and Cumulative Distribution Function
- Fitting Integral Function with a Sharp Peak
- Fitting with a Piecewise Linear Function
- Fitting with an Ordinary Differential Equation
- Fitting with Convolution of Two Functions
- Parameter Initialization for Rational Functions
- Surface Fitting with Multiple Peaks
- Nonlinear Multiple Variables Fitting
- Modifying Derived Parameters in Build-in Functions
- Fit Multiple Datasets by Fitting One and then Using Those Fit Parameters for Other Datasets
- Implicit Fitting with Three Variables
- Nonlinear fitting using Orthogonal Distance Regression

4.1.3 Signal Processing
• FFT and IFFT
• FFT Filter
• Smoothing
• STFT (Short-Time Fourier Transform)
• IIR Filter
• 2D FFT and Filter
• Convolution
• Wavelet
• Coherence and Correlation
• Decimation and Signal Envelope
• Rise Time
• Sound Processing

4.1.4 Peak Analysis

4.1.4.1 Create and Subtract Baseline with Peak Analyzer

4.1.4.2 Batch Peak Analysis Using Theme with Script Before Each Process

4.1.4.3 Combine Quick Peaks Gadget with Peak Analyzer

4.1.4.4 Peak Finding

• Picking and Marking Peaks

4.1.4.5 Peak Integration

• Integrating Peaks

4.1.4.6 Peak Fitting

• Peak Fitting with Baseline
• Peak Fitting with Preset Peak Parameters
• Setting the Fix, Share Status or Bounds for Multiple Peak Parameters Simultaneously
4.1.5 Data Manipulation

4.1.5.1 Setting Column Values

- Set Column/Cell Values

4.1.5.2 Worksheet Data Operations

- Worksheet Query
- Data Reduction
- Data Filter
- Lock Filter with Analysis
- Unstacking and Sorting Worksheet Columns by Label

4.1.5.3 Pivot Table

4.1.5.4 Categorical Values Ordering and Sharing

4.1.6 Analysis Templates

- Creating and Using Analysis Templates
- Creating Analysis Templates using Set Column Value
- Creating a Custom Report Sheet

4.1.7 Analysis Themes

4.1.8 Batch Processing

- Batch Processing Multiple Datasets
- Batch Processing Multiple Files using Analysis Template
- Batch Processing with Summary Report in External Excel File
- Batch Processing with Word Template for Reporting
- Batch Processing Grouped Datasets Using Analysis Template with Multi-Data Sheets

4.2 Gadgets
4.2.1 Gadgets

- Global Vertical Cursor
- Integrate Gadget
- Curve Intersection Gadget
- Rise Time Gadget
- Interpolate Gadget
- Cluster Gadget
- Quick Fit Gadget
- Quick Peaks Gadget
- Quick Sigmoidal Fit Gadget
- Using Multiple Gadgets

4.2.2 Global Vertical Cursor

4.2.2.1 Summary

The Vertical Cursor gadget can be used to read X and Y coordinate values for data points in stack/multi-panel plots or contained in multiple graphs simultaneously.

Minimum Origin Version Required: Origin 2021

4.2.2.2 What You Will Learn

This tutorial will show you how to:

- Use the vertical cursor gadget to read XY coordinates for multiple graphs and output the results.
- Link/Unlink graphs when using the vertical cursor gadget.
- Move or relocate the cursor line among the linked graph windows.
- Add cursors in linked layers of the multi-panel graph which has multiple panels side-by-side

4.2.2.3 Steps

4.2.2.3.1 Using Vertical Cursor on a Stacking Graph

1. New a project with an empty workbook. select Data > Import From File: Multiple ASCII... to open ASCII box, browse to <Origin Folder>/Samples/Curve Fitting and add the files Step01.dat, Step02.dat and Step03.dat. Click OK button to open the ASCII:impASC dialog.

2. In the dialog, select Start New Books for Import Mode, Column Designation = (XY) and From = 2 for Partial Columns as below. All these three files selected will be imported into one workbook.
3. Activate the workbook with long name Step01.dat and highlight the whole worksheet. Select Plot > Multi-Panel/Axis: Stack from the menu item to open the Plotstack dialog. Under the Plot Assignment branch, enter 3 for Number of Plots in Each Layer, accept other settings as default and click OK to create a stacked graph.

4. Similarly create two other stacked graphs for the other two workbooks. So now we have Graph1, Graph2, and Graph3 for workbooks Step01, Step02 and Step03 respectively.

5. Activate Graph1 and choose Gadgets:Vertical Cursor to open the Vertical Cursor dialog. Right-click on the column header to check Book to add one more column "Book" in the data points table.
6. Click the **Link/Unlink Graphs** button in control panel and open the **Graph Browser**, you can choose whether to link or unlink a graph to the current active graph.

7. Select Graph2 and Graph3 in the left panel and click the **button** to add the two graphs as linked graphs to Graph1. Click **OK**.
Note: You can also unlink graphs in this dialog by using the button to remove a graph from the right panel.

On the upper right-hand corner of each linked graph, a icon appears to indicate that it belongs to a group of linked graphs.

8. Make sure Graph1 is active and the Vertical Cursor dialog is open, the asterisk before the graph name marks the current active plot on which the cursor is on. Enter 25 as the X value, uncheck the box before Snap Cursor to Nearest X and click the Move Cursor to X button to read the data points in each plot when X=25.
9. Click the **Add Tag and Label** button to add tags at X=25 for all linked graphs.

10. Click the **Output Report** button, then click the **Go to Report Worksheet** button to generate and open the results worksheet. The XY coordinates of all plots in linked graphs are listed in the report sheet. Each time you click the **Output Report** button, a new row of data will be output to the result sheet.

11. Activate Graph2, click on the icon and select **Move Cursor Line here**, the cursor line will be moved to Graph2.

12. In the **Vertical Cursor** dialog, double click any row of **Graph3** to activate the **Graph3** window. Click on the previously added tag and press the **Delete** key to delete it. The tags in all the linked Graph windows are deleted. To go back to Graph2 where the cursor is currently on, click on the icon and select **Go to Cursor Line Window**.
4.2.3.2 Using Vertical Cursor on a multi-panel graph with side-by-side layers

1. New a workbook, select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Graphing subfolder and find the file Waterfall.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Right-click on the first row to select Set As Lone Name. Highlight col(B)~col(E) to select Plot > Multi-Panel/Axis : 4 Panel to plot the graph with 4 panels, 3 rows and 2 columns.

3. Click the first panel and select Gadgets: Vertical Cursor. The cursor will be added on the first column of panels, and only the data points in first and third panel will show up in the list.

4. We are going to read the point $X=1113.31$ in all layers. Click the Add Linked Cursor for Each Layer button to add a cursor in all layers which are linked together. (Once you clicked this button, it will
turn to be its paired button [button] which can be used to remove the cursors in linked layers and go back to the initial status). And, enter 1113.31 in the X= box and click **Move Cursor to X** button to move all cursors to this X value.

5. Click **Add Tag and Label** button [button] to tag this position in all layers. Click on the cursor in Layer1, drag-and-drop it to the other peaks to read the data points in all layers.
6. You can click **Output Report** button at any time to output the interested data points to the result sheet row by row.

### 4.2.3 Integrate Gadget

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
<th>Name</th>
<th>Sheet</th>
<th>Graph</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1251.08</td>
<td>918.44</td>
<td>600</td>
<td>Waterfall</td>
<td>*Graph1</td>
<td>✓</td>
</tr>
<tr>
<td>1251.08</td>
<td>914.95</td>
<td>502</td>
<td>Waterfall</td>
<td>Graph1</td>
<td>✓</td>
</tr>
<tr>
<td>1251.08</td>
<td>965.84</td>
<td>504</td>
<td>Waterfall</td>
<td>Graph</td>
<td>✓</td>
</tr>
<tr>
<td>1251.08</td>
<td>980.35</td>
<td>506</td>
<td>Waterfall</td>
<td>Graph1</td>
<td>✓</td>
</tr>
</tbody>
</table>
4.2.3.1 Summary

The Integrate Gadget performs numerical integration on a data plot to calculate the area under the curve. You can select an arbitrary range of the data plot using the region of interest (ROI) object overlaid on the plot.

4.2.3.2 What you will learn

- How to easily integrate a segment of data plot under the rectangular region.
- How to specify the integration limits and baseline.
- How to display the integral curve inside the ROI and calculate quantities including: peak area, peak height, peak center, and FWHM.

4.2.3.3 Integrate and output the quantities

1. Start with a new workbook and import the Origin sample data *Multiple Peaks.DAT* which is located in `<Origin Program Folder> \Samples\Curve fitting`.
2. Highlight the Col(C) and select **Plot > Basic 2D: Line** from the Origin menu to draw a graph.

![Graph3](image)

3. Select **Gadgets: Integrate** from the Origin menu when a graph is active, to bring up the **Integrate: addtool_curve_integ** dialog box.

   In **Integration** tab, choose **Restrict to Rectangle** in the **Integral Curve** drop-down list to plot the
integral curve within the rectangle.

4. Click **OK** button. You will see that a yellow rectangle and a blue integral curve are added to the plot. The integral area is filled with gray, and the value is shown at the top of the rectangle.
5. Move the yellow region of interest rectangle to set the region for the single peak you want to integrate.
6. Click the triangle button at the top right corner of the ROI tool to open the fly-out menu and choose **New Output**. Then the **Gadget Integration Results** will display in the **Script Window**.

![Image of Gadget Integration Results]

4.2.3.4 **Integrate with a data plot baseline**

1. Start with a new workbook and import the file `<Origin Program Folder>\Samples\Spectroscopy\Peaks with Base.DAT`
2. Highlight Col(B) and Col(C) and select **Plot>2D: Line: Line** from the Origin menu to draw a graph.

3. Select **Gadgets: Integrate** from the Origin menu when a graph is active, to bring up the **Integrate: addtool_curve_integ** dialog box.

4. In **Baseline** tab, choose **Use Existing Dataset** for the **Mode**. Then select **Plot(2): Base** as **Dataset** and click **OK** button.
5. Click the triangle button and select **Expand to Full Plot(s) Range** in the fly-out menu to integrate the whole range of the curve starting from the baseline.

![Graph showing integration and output](image)

6. Select **New Output** from the fly-out menu to output the results to the script window.

💡 Some gadgets operate on a single curve at a time, but you can repeat your analysis for other curves by clicking on the fly-out menu and choosing **New Output for All Curves** or **New Output for All Layers**.
4.2.4 Curve Intersection Gadget

4.2.4.1 Summary

When there is more than one curve in a graph layer, you might want to calculate the intersection data points of these curves. Since Origin 8.6, a new gadget Intersect is available to calculate the intersection points of the input curves on the graph.

Minimum Origin Version Required: Origin 8.6 SR0

4.2.4.2 What you will learn

This tutorial will show you how to:

- Use the Intersect gadget on a graph.
- Tag the intersection points.
- Output the intersection points to worksheet.

4.2.4.3 Steps
This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open Tutorial Data.opj and browse to the Curve Intersection Gadget folder in Project Explorer (PE).

2. Highlight the Col(A)~col(D) in workbook Book6B, and then click Plot > Basic 2D: Line to plot a line graph.

3. Select Gadgets: Intersect... from the main menu to open the dialog. Go to the Options tab.

4. Check the Intersection Label check box in the Options tab, set Size as 15, set Type as Y and set Rotate(deg.) as 0.
5. Click **OK** button to go back to the graph window. The yellow ROI box will be added onto the graph.
6. Click the Arrow button at the top right of the ROI box, select **Expand to Full Plot(s) Range** from the context menu. The ROI box will be expanded to cover full plot range as shown below.

7. Click the Arrow button at the top right of the ROI box. Select **Preferences...** from the context menu to open the **Intersect Preferences** dialog. Go to the **Output To** tab, click the flyout button to the right of **Result Worksheet Name** box and choose **Sheet in Input Book**.
8. Click **OK** button to go back to the graph window. Click the arrow button at the top right of the ROI box, select **New Output** from the context menu.

9. The results will be output to the **Script Window**. Click the arrow button again, select **Go To Report Worksheet** from the menu. The X and Y coordinates of the intersection points will be listed in the results worksheet.

### 4.2.5 Rise Time Gadget

#### 4.2.5.1 Summary

The Rise Time Gadget can be used to analyze the rising and falling stages of a step-like signal in a graph. With this gadget, you can intuitively select an area on the graph with a rectangle, and then calculate the rise time or fall time within that area.

Minimum Origin Version Required: OriginPro 2015 SR0
• How to select a specific region of the signal by moving and resizing a region of interest (ROI).
• How to mark **Rise Time** (**Fall Time**) and **Rise Range** (**Fall Range**) in the graph.
• How to switch the tool between **Rise Time** and **Fall Time**.
• How to output analysis results of **Rise Time** (**Fall Time**).

4.2.5.3 **Analyze Rise Time**

1. Start with a new workbook and click the button to import the **Step Signal with Random Noise.dat** file under the `<Origin EXE Folder>\Samples\Signal Processing` path.
2. Highlight Column B and select **Plot: Line: Line** in the menu to create a graph.

3. Double-click the X axis to open the **Axis** dialog box. Go to the **Scale** tab and set the axis range and major ticks as shown in the image below.
Data Analysis

X Axis - Layer 1

<table>
<thead>
<tr>
<th>Scale</th>
<th>Tick Labels</th>
<th>Title</th>
<th>Grids</th>
<th>Line and Ticks</th>
<th>Special Ticks</th>
<th>Breaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>400</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>To</td>
<td>600</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Linear</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rescale</td>
<td>Normal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rescale Margin(%)</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reverse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Major Ticks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>By Increment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minor Ticks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>By Counts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Select multiple axes to customize together.

Apply To... OK Cancel Apply
4. Click the **OK** button and the graph will be updated as shown below:

![Graph with signal and noise](image)

5. Select **Gadgets: Rise Time** from the Origin menu to open the **Rise Time: addtool_rise_time** dialog box. Go to the **Display on Graph** tab, and click the **Rise Time** and **Rise Range** check boxes.
6. Click **OK** button, and you will see that a yellow rectangle is added to the plot. Move the rectangle horizontally on the rise signal step.

In the graph, you can see the **Rise Time** and **Rise Range** values are shown at the top of the rectangle. The two blue vertical lines go through the two indicators marking the **Rise Time**. The two blue horizontal lines that display the **Low Reference Level** and **High Reference Level** go through the two indicators marking the **Rise Range**. The two red horizontal lines display **Low State Level** and **High State Level**.

7. Click the triangle button at the top right corner of the rectangle. Then select **New Output**. The results will be output to the **Script Window**.
4.2.5.4 Analyze Fall Time

1. This gadget also allows you to get the fall time and fall range in a graph. Move the rectangle horizontally on the fall signal step.

2. Click the triangle button and select Preferences in the fly-out menu to open the Rise Time Preferences dialog. Go to the ROI Box tab and select Fall Time in the Tool drop-down list.
3. Click the **OK** button, the **Fall Time** and **Fall Range** values are shown at the top of the rectangle.

4. Click the triangle button and select **New Output**. The results will be output to the **Script Window**.
4.2.6 Interpolate Gadget

4.2.6.1 Summary

Origin supports the interpolate gadget to perform quick interpolation on a ROI (Region of Interest) range when a graph is active. And you can easily change the interpolate region by moving the ROI.

4.2.6.2 What you will learn

- How to easily interpolate data points on a rectangular region.
- How to quickly find out an interpolated Y value from any given X value.
- How to output the interpolated values to Script Window, Result Log, or a specified worksheet.

4.2.6.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open Tutorial Data.opj and browse to the Interpolate Gadget folder in Project Explorer (PE).
2. Highlight the Col(A) and col(B) in workbook Book1R and plot a Line +Symbol graph.

3. Select Gadgets: Interpolate from the Origin menu when a graph is active, to bring up the Interpolate: addtool_curve_intep dialog box.
4. Go to the Interpolate/Extrapolate Options tab. Choose Cubic Spline for the Method, and then select Interpolate/Extrapolate to Rectangle Edge for Fit Limits To.
5. Click **OK** button. It will add an interpolation line onto the plot. And the Y values of interpolation line at right and left are shown at the top of the rectangle region.

6. You can change the data range by moving or resizing the yellow region of interest rectangle, the interpolated curve displayed will update as the ROI is being moved.

   Click the triangle button and select **Expand to Full Plot(s) Range** in the fly-out menu to interpolate the total area for the curve.
7. This gadget also allows you to find Y values from a given X value. Click the triangle button and select Interpolate X/Y to open the Interpolate Y from X dialog. You can enter multiple X values and click the interpolate button. This tool will output the interpolated Y values for each of the X values.

8. The interpolated Y values can be output to Script Window, Result Log, or a specified worksheet.
4.2.7 Cluster Gadget

4.2.7.1 Summary

Origin supports the **Cluster Gadget** to perform simple statistics on a region of interest (ROI) in a graph. The gadget can also be used to edit, clear, mask, or categorize data points. The statistics results are dynamically updated as the ROI object is moved or resized.

Minimum Origin Version Required: Origin 2016 SR0 (Pro only)

4.2.7.2 What you will learn

- How to perform simple statistics on a region of interest (ROI) in a graph.
- How to edit the data points such as clear, or mask points in graph using menu options or buttons.
- How to view or output the statistic for points inside and outside of the ROI.
- How to categorize data points and color map points with the categorical data

4.2.7.3 Perform basic statistics

1. Start with a new workbook and import the Origin sample data *Categorical Data.dat* which is located in *<Origin Program Folder> \Samples\Graphing*.

   Right-click on Col(D) and select **Sort Worksheet: Ascending**. Then you will see the worksheet is sorted by the category of *Drug*.

2. Pressing **Ctrl** key, highlight three parts of the Col(B) separately.
3. Select **Plot: Basic 2D: Scatter** from the main menu to create a graph. The graph with three plots display the recovery for each drug.
4. Right-click on the graph legend and select **Properties** to open **Object Properties** dialog. Then edit the legend as shown below. Click **OK** button.

5. Select **Gadgets: Cluster** from the Origin menu to bring up the **Cluster: addtool_cluster** dialog box. Choose **Circle** in the **Shape** drop-down list of the **ROI Box** tab.
6. Click **OK** button. It will add a yellow circle for **ROI** on the plot and bring up the **Cluster Gadget** dialog.
7. Move the yellow circle to the region for which you want to get statistics and see the results shown on the **Inner Points** tab of the dialog.
8. Click the **Output Statistics Report** button. The results are output to the Result Log, Script Window, and the Cluster workbook.

9. Click the **Go to Report Worksheet** button, then the **Cluster** workbook will be shown.

If you have Origin 2021b or later, you have more options for the ROI shape. In the addtool_cluster dialog, set **Shape** to **Arbitrary Shape**. When you click **OK**, a small **Create ROI** dialog opens in which you can click on a shape button and -- without closing the Create ROI dialog -- **drag out a shape on your graph**. Keep this dialog open until you get the ROI that you want and then click **Done**. That will open the **Cluster Gadget**.

Also note that the Cluster Gadget toolbar now has buttons to **Modify ROI** and **Add New ROI** (for adding multiple ROIs to the graph).

### 4.2.7.4 Exclude the data points in a cluster

In this section, we will show you how to exclude a specific plot from the cluster. Based on the example above, we will do simple statistics on *Recovery of Drug A* and *Recovery of Drug B*, excluding *Recovery of Placebo*.

1. Click the **Data** menu in the **Cluster Gadget** dialog and uncheck **Plot(1)** and **Plot(2)**. The first and second rows become gray in the lower panel, and they can no longer be manipulated by the buttons in the dialog.

2. Click **Mask Data Points** button. The *Recovery of Placebo* data points in the ROI are masked and the color becomes red. At the same time the statistics results for *Recovery of Placebo* become missing values.
3. Click the **Output Statistics Report** button. The results are output to the Result Log, Script Window, and the Cluster workbook.

4.2.7.5 **Get statistics results for points outside of the ROI**

1. Click **Settings: Preferences** from the **Cluster Gadget** dialog’s menu to open the **Cluster Manipulation Preferences** dialog.

2. Go to the **Calculation** tab. Check the **Calculate Outer Points** box.
3. Click the **OK** button, the statistics results for points out of the ROI are shown on the **Outer Points** tab of the dialog.
4. Click the **Output Statistics Report** button. The results for inner and outer points are shown in the Result Log, Script Window, and the Cluster workbook.

4.2.7.6 **Color data points in different regions**

You can categorize data points from graph directly and output the Categorical group column to the source worksheet, and further map symbol characters to the categorical group column.

Create a new workbook and re-import the sample data `<Origin Program Folder>\Samples\Graphing\Categorical Data.dat`. Highlight Column(B) and plot a Scatter graph.

Data points cluster into 4 groups. We will use the **Create Categories** feature of **Cluster Gadget** to create a categorical column according to the cluster groups and map symbol color to this column.
1. Select **Gadgets: Cluster** to bring up the **Cluster: addtool_cluster** dialog. Choose **Circle** in the **Shape** drop-down list of the **ROI Box** tab. Click **OK** button to add a yellow circle for ROI on the plot and bring up the **Cluster Gadget** dialog.

2. Move and adjust the size of the ROI box to circle only the first cluster of data points at the low-left corner.

Click the **Create Categories** button on the **Cluster Gadget** dialog to open the **Create Categorical Value** dialog. Enter **Group** for **Category Group Name** and **1** for **Category**. Select the **Color Data by Category** check box.

Click the **OK** button. A new categorical column named "Group" is added to the source data sheet and data points inside ROI are tagged as "1" in this column(**Group**). Also, scatter plot use this categorical column as the color index.
3. Repeat step 2 for the rest of 3 clusters and tag them as 2, 3, 4 in sequence.
Close the **Cluster Gadget**.

4. Now you will find the graph shows as below:
5. Delete the original legend. Select **Graph: Legend: Categorical Values** to bring up the **legendcat** dialog. Uncheck the **Show All Categories** checkbox. Click **OK**. The scatter plot with new legend should look like following.

4.2.8 Quick Fit Gadget
4.2.8.1 Summary

The Quick Fit gadget can be used to quickly perform curve fitting within the ROI (Region of Interest) range.

Minimum Origin Version Required: Origin 8.6 SR0

4.2.8.2 What you will learn

This tutorial will show you how to:

- carry out linear fit with the Quick Fit gadget.
- carry out nonlinear curve fit using Quick Fit gadget.
- save and reuse a dialog theme.

4.2.8.3 Steps

4.2.8.3.1 Linear Fit

1. Open Origin and choose Data: Import from File: Import Wizard. For the Data Source, browse to `<Origin Folder>/Samples/Curve Fitting` and add the Step01.dat. Note that when this file is selected, the import filter Data Folder: step is automatically chosen (this is shown in in the Import Filters for Current Data Type box). Click Finish to import the file.

2. Highlight through column A to F and click the button to generate a scatter plot.
3. Select **Gadgets: Quick Fit: 1 Linear(System)** from the main menu to add a region-of-interest (ROI) box on the graph. Click the arrow button 🔄 and select **Expand to Full Plot(s) Range** from the fly-out menu to expand the ROI box to the full plot range.
4. Click the arrow button and select Preferences... from the fly-out menu. This opens the Quick Fit Preferences dialog. In this dialog, go to the Label Box tab, select Equation with Values for the Equation drop-down list.

5. Go to the Report tab, select Worksheet for the Output To drop-down list.
6. Click **OK** to close this dialog. Click the arrow button to select **New Output** from the fly-out menu. This outputs the plot fitting results "Sensor 01" to the report worksheet and adds a label box to the graph window. The label box reports your analysis results.
7. Select the label box on the graph and delete it. Click the arrow button and select Preferences... from the fly-out menu. This opens the Quick Fit Preferences dialog. In this dialog, go to Label Box tab, uncheck the Add Label Box to Graph check box and click OK.

8. Click the arrow button again to select New Output for All Curves(N) from the fly-out menu, so that the customized linear fit process will be performed on all data plots.

9. Click the arrow button one more time to select Go to Report Worksheet. You will see the fitting results of all three plots in the report worksheet. Note, the first result row has been created at step 6 above and the last three rows are our current results.

Note: With the ROI box shown on graph, you can click the arrow button to select Switch to Linear
Fit... from the fly-out menu to transfer your current settings to the **Linear Fit** dialog. Then, you can do further operations in this more powerful dialog to do linear fitting.

### 4.2.8.3.2 Nonlinear Curve Fit

1. Start with a new workbook and import the Origin sample data **Gaussian.DAT** which is located in `<Origin Program Folder>\Samples\Curve fitting` path.

2. Highlight the Col(B) and select **Plot>2D: Scatter: Scatter** from the Origin menu to draw a graph.

3. Select **Gadgets: Quick Fit: 4 Peak - Gauss (System)** from the Origin menu to add a ROI box to the graph.
4. Click the arrow button to select **Expand to Full Plot(s) Range** from the fly-out menu to expand the ROI box to the full plot range.

5. Click the arrow button and select **Preferences...** from the fly-out menu. This opens the **Quick Fit Preferences** dialog. In this dialog, go to the **ROI Box** tab, and set the **Parameter List** as below.
6. Click **OK** to close this dialog. Click the arrow button \( \rightarrow \) and select **New Output** from the fly-out menu. A label box will be added to the graph as shown below.
7. Click the arrow button and select Preferences... from the fly-out menu. This opens the Quick Fit Preferences dialog again. In this dialog, go to the Label Box tab, choose Use ROI Box Tab Settings for Parameter Table. Click OK to close this dialog.
8. Click the arrow button and select **Update Last Output** from the fly-out menu. The Label box will be updated and only the parameters "xc" and "FWHM" will be displayed.
9. Click the arrow button and select **Save Theme** from the fly-out menu. In the **Theme Save as...** dialog, set the **Theme Name** as **My_Gauss** and click **OK**.

![Theme Save as... dialog](image)

10. Go back to the worksheet, highlight col(C) and select **Plot>2D: Scatter: Scatter** from the top menu. This draws a scatter graph.
11. Click on the new plot to activate it and select Gadgets: Quick Fit: 9 My_Gauss to load the theme. A ROI box will be added to the graph with parameters \( xc \) and \( FWHM \) displaying above the ROI.

12. Click the arrow button \( \rightarrow \) to select Expand to Full Plot(s) Range from the fly-out menu to expand the ROI box to the full plot range, and then select New Output from the fly-out menu to output the result. You can see that our theme is applied as the label box on the graph only reports the values of parameter "xc" and "FWHM".

Note: With the ROI box shown on graph, you can click the arrow button \( \rightarrow \) to select Switch to NLFit... from the fly-out menu to transfer your current settings to the NLFit dialog. Then, you can do further operations in this more powerful dialog to do nonlinear fitting.

4.2.9 Quick Peaks Gadget
4.2.9.1 Summary

The Quick Peaks gadget can be used to pick peaks, subtract baseline, integrate the peaks and/or fit peaks in a ROI (Region of Interest). It is also possible to use this tool in combination with the **Peak Analyzer**. Please refer to [this tutorial](#) for details.

Minimum Origin Version Required: Origin 2015 SR1

4.2.9.2 What you will learn

This tutorial will show you how to:

- Find and subtract baseline for spectrum with the Quick Peaks gadget.
- Find peaks on the graph with the Quick Peaks gadget.
- Customize preference settings.

4.2.9.3 Steps

1. Create a new workbook by clicking the **New Workbook** button. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the Spectroscopy subfolder and find the file Zircon.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight Col(B) and plot a line graph with the **Line** button on the **2D Graphs Toolbar**.

3. Select **Gadgets: Quick Peaks** from the main menu to open the **Quick Peaks: addtool_quickpeaks** dialog.
4. On the **Baseline** tab, set **Mode** to **2D Derivative**, and then set **Range** to **Full Plot Range**. Click **OK** to apply.

5. The peaks within the yellow ROI box will be found and marked. Resize the ROI box so that it covers X range[0,7000] as shown in graph below, the baseline and peak finding need a further refinement.
6. Click the triangle button and select Preference from the fly-out menu, so you can further adjust the Smoothing Method in Baseline tab follows the graph:
Data Analysis

7. Click **OK** to apply the settings and close the dialog, the baseline and peaks finding are better than before which can be attribute to the optimizing **Threshold** and **Maximum Anchor Points** for Baseline and
Threshold Height% for Find peak:

8. Click the triangle button and select **New Output** to generate the peak finding results to a report worksheet.

Click the triangle button again and select **Go to Report Worksheet** to view the quantities output:

<table>
<thead>
<tr>
<th>Long Name</th>
<th>Dataset Identifier</th>
<th>Peak ID</th>
<th>Peak Row</th>
<th>Peak X</th>
<th>Peak Y</th>
<th>Height</th>
<th>Peak Area</th>
<th>FWHM</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>intensity</td>
<td>Peak 1</td>
<td>94</td>
<td>355.3067</td>
<td>5983.22381</td>
<td>.3696 .95396</td>
<td>102109 .95465</td>
<td>31 .57915</td>
<td>31 .57915</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 2</td>
<td>138</td>
<td>549.1658</td>
<td>6422.58143</td>
<td>.4537 .52551</td>
<td>207719 .66552</td>
<td>37 .79971</td>
<td>37 .79971</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 3</td>
<td>431</td>
<td>1095.199</td>
<td>9687.95659</td>
<td>7.1923598</td>
<td>258440 .19682</td>
<td>32 .15372</td>
<td>32 .15372</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 4</td>
<td>1077</td>
<td>2250.989</td>
<td>8735.85689</td>
<td>6579.55414</td>
<td>493137 .37324</td>
<td>49 .58275</td>
<td>49 .58275</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 5</td>
<td>1290</td>
<td>2546.044</td>
<td>9375.11743</td>
<td>7472.17799</td>
<td>691806 .11383</td>
<td>57 .24765</td>
<td>57 .24765</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 6</td>
<td>2470</td>
<td>4937.343</td>
<td>12845.63008</td>
<td>6538 .23493</td>
<td>454832 .77396</td>
<td>43 .3493</td>
<td>43 .3493</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 7</td>
<td>3226</td>
<td>6395.264</td>
<td>16057.24058</td>
<td>3904 .09332</td>
<td>173161 .57649</td>
<td>26 .96293</td>
<td>26 .96293</td>
<td></td>
</tr>
<tr>
<td>intensity</td>
<td>Peak 8</td>
<td>3250</td>
<td>6441.547</td>
<td>36844 .54608</td>
<td>240110 .1041</td>
<td>1907238 .84756</td>
<td>37 .12551</td>
<td>37 .12551</td>
<td></td>
</tr>
</tbody>
</table>

9. Activate the graph window to which the gadget was applied, click the triangle button and select **Subtract Baseline**, click **OK** for pop-up window, the baseline was subtract from the data.

**Note**: Check the worksheet after subtracting the baseline, if nothing happens, it's because the data is imported by the connect. In this case you need to click the green icon in the upper left hand corner of the worksheet, and click **Unlock Imported Data** or **Remove Data Connector**. Then subtract baseline again.

10. Click X button on the top right corner to close the gadget. The finished graph is shown like this:
4.2.10 Quick Sigmoidal Fit Gadget

4.2.10.1 Summary

The Quick Sigmoidal Fit gadget can be used to quickly perform a sigmoidal fit on a portion of your graph that you define interactively as your region of interest (ROI).

Minimum Origin Version Required: Origin 2015 SR0

4.2.10.2 What you will learn

- How to use the Quick Sigmoidal Fit gadget on a graph.
- How to select your fitting options.
- How to switch to the NLFit dialog.
- How to output the fitting result.
- How to find X/Y values on the fit curve.

4.2.10.3 Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

Note: For advanced fitting options, you can combine Quick Peaks gadget with Peak Analyzer.
4.2.10.3.1 Quick Fit

1. Open Tutorial Data.opj and browse to the Quick Sigmoidal Fit Gadget folder in Project Explorer (PE).

2. Highlight Col(A) through Col(D) in the workbook DoseResponseN and from the menu choose Plot:Symbol:Scatter to plot a scatter graph.

3. Double-click the X axis to open Axis dialog. In the Scale tab, set the Type as Log10 and click OK button to close the dialog.
4. Click the **Rescale** button to show the plot with the proper scale.
5. Select **Gadgets: Quick Sigmoidal Fit...** from the main menu to open the `addtool_sigmoidal_fit` dialog box. Select the function `Logistic5` from the **Function** drop-down list on the **Settings** tab.

6. Click the **ROI Box** tab and uncheck the parameters `x0`, `h`, and `s` under the **Parameter List** branch.
7. Click the **Fit Curve** tab, select **Mean, SD** from the **Plot Type** drop-down list and **Source Book, New Sheet** from the **Output Fit Curve To** drop-down list.
8. Click **OK** to add the ROI box to the graph. At the top right corner of the ROI box, click the Arrow button to select **Expand to the Full Plots Range** from the menu. The ROI box will cover the full data range on the graph.
9. Click the arrow button again to select Preferences... from the menu. This opens the Sigmodial Fit Preferences dialog box. In this dialog, click the Report tab and set Output To as None.

![Sigmodial Fit Preferences dialog box](image)

10. Click OK to close the dialog box. Click the arrow button again to select Change Function: Logistic and change the fitting function to Logistic. The label text on top of the ROI box will update automatically.
11. Click the arrow button to select **New Output** and output the fitting result to the worksheet and graph.
4.2.10.3.2 Connect to NLFit

When using the Quick Sigmoidal Fit gadget you can easily switch to the NLFit tool. This makes it easy to get a detailed fit report using the current fitting settings in the gadget.

1. Redo step 1 through step 8 as shown above.

2. Click the arrow button \( \text{Switch to NLFit...} \) to open the NLFit dialog with the inherited settings.
3. Click the **Fit** button to perform curve fitting. The results are output to the result sheets and the source graph.
4.2.10.3.3 Find X/Y

With his gadget you can also quickly find X/Y values on the fitted curve.

1. Redo step 1 through step 8 as shown in the first section.

2. Click the arrow button to select **Find X/Y...** from the menu to open the **Find X/Y** dialog.
3. Select the **Worksheet** radio box and enter 40;45;50 for $Y$, then click **Find X** to show the corresponding X values in the empty X box. Then, click the **Output** button and the X and Y values are output to the specified worksheet.

4. Click the **Go** button beside the **Worksheet** radio box to open the **Find X/Y** workbook. Click the **Close** button to close the **Find X/Y** dialog.
4.2.11 Using Multiple Gadgets

4.2.11.1 Summary

Multiple gadgets can be used in combination to achieve certain goals. To avoid overlapping of several gadget windows over same plot, we can arrange them into different layers to layout them onto different panels. The results from all other gadgets can be eventually added to the last gadget window and kept updated at each new output. In this tutorial, we will illustrate an example to show how we can combine the use of Quick Peaks, Quick Fit and Intersect gadgets to find the intersection point between the baseline and slope of a curve.

Minimum Origin Version Required: Origin 2016 SR0

4.2.11.2 What you will learn

This tutorial will show you:

- how to simultaneously use multiple gadgets to analyze same data.
- how to output Gadget analyzed results onto a specific graph and keep them updated.
- how to find the intersection point of baseline with the linear fitting of a curve.

4.2.11.3 Create a layout for multiple gadget windows

1. Start with a new workbook and import the file \Samples\Curve Fitting\Gaussian.dat.
2. To avoid overlapping the gadgets in one graph, we are going to prepare a multi-layer graph as shown below with same data in each layer.
3. Click and select the second column and use the menu item Plot:Multi-Curve:4 Panel to create a 4 panel plot.
Note: To make the explanation of following steps more clear, we marked above figure with blue font to help you distinguish the layers in the graph.

4. Go back to the workbook, select the Ampplitude column, and position the cursor at the edge of the column, until you see the cursor turn into . Then you can drag-and-drop the column into layer 2 on the graph page and click OK to close the appeared dialog box. Do it again to add the plot to layer 3 in the panel, and then click the bottom right area to select the unwanted layer 4 and use the Delete key on the keyboard to delete it.
4.2.11.4 Using Quick Peaks gadget to find baseline

1. Select **Gadgets:Quick Peaks** from the Origin menu when layer 1 is active to bring up the **Data Exploration:addtool_quickpeaks** dialog box. According to the lineshape of this curve, spline connection would be a better choice for fitting the baseline. To do so, go to the **Baseline** tab, choose **Spline** in the **Connect Method** drop-down list to connect anchor points with spline method.
2. Since we do not want to create new columns in the source sheet to save baseline data at every new output, we can save the result to a new workbook and the newly created baseline data will replace existing data instead. To do so, go to Output to tab, uncheck the Append to Worksheet box and check the Output Baseline to Worksheet to output baseline data into a new book QkPeak with sheet name as Baseline.
3. Click **OK** to close the dialog box. Place the mouse cursor over the edge of the Region of Interest (ROI), when the cursor turns into a double arrow icon, you can resize the box as needed.
4. Click the triangle button at the top right corner of the ROI to open the fly-out menu and choose **New Output** to output baseline data.
4.2.11.5 Using Quick Fit to find the linear fit of the curve

1. Activate the second layer by clicking on the layer icon on the top left corner of the graph or directly click on the plotting area of top right panel.

2. Select Gadgets:Quick Fit:Linear(System) from the Origin menu to bring up the Quick Fit ROI, and adjust the position and range of appeared ROI properly to perform linear fitting over the left half of the peak envelope.
3. Click the triangle button at the top right corner of the ROI to open the fly-out menu and choose Preferences to customize Quick Fit Preferences dialog box.

4. Since we do not need other unnecessary output about this linear fitting, we can go to the Label Box tab, uncheck Add Label Box to Graph.
5. For the same purpose, to avoid outputting summary report we can go to the **Report** tab, choose **None** in the **Output To** drop down list and click **OK** to close the dialog box.
6. Return to the triangle button at the top right corner of the ROI, choose New Output to output linearly fitted results to worksheet.

4.2.11.6 Using Intersect gadget to find intersection point

1. Before we apply the Intersect gadget, the first step to do is to add the fitted baseline and linearly fitted line from last two gadgets to the third plot. To do so, click on the layer icon on the top left corner to activate layer 3. Right click on the layer icon to choose Layer Contents to bring up Layer Contents-Layer 3 window. Select the data with long name QuickFit Y1 and Baseline Y of Amplitude and add them to the right panel through the right arrow icon.
2. Click **OK** to close the window and the fitted baseline and linear line will display in the third layer.
3. Select **Gadgets:Intersect** from the Origin menu when layer 3 is active to bring up the **Data Exploration: addtool_curve_intersect** dialog box. Click **OK** to close the dialog box and it will bring up **Intersect** Gadget ROI.

4. Position and resize the ROI properly to have the intersection point between baseline and slope inside the box. To exclude other intersection points with the original curve, go to the triangle button at the top right corner of the ROI and uncheck **Plot(1) Amplitude** from the context menu of **Change Data**.
5. Return to the triangle button at the top right corner of the ROI, choose **New Output (O)** to output the result of intersection point between baseline and linearly fitted line.
4.2.11.7 Update the output

1. Click on the layer icon to activate layer 1, reposition **Quick Peaks** ROI to create a new baseline. Then go to the triangle button at the top right corner of the ROI, choose **New Output(O)** to output the newly created baseline.

2. Click on the layer icon to activate layer 2, reposition **Quick Fit** ROI to the other side of the curve so it will create a new linear fit line. Then go to the triangle button at the top right corner of the ROI, choose **Update Last Output(O)** to output linearly fitted line result.

3. Click on the layer icon to activate layer 3, reposition **Intersect** ROI to have the intersection point between newly created baseline and linearly fitted line inside the box. Then go to the triangle button at the top right corner of the ROI, choose **New Output(O)** to output the result of new intersection point.
4.3 Curve Fitting

4.3.1 Curve Fitting

4.3.1.1 Linear and Polynomial Fitting

- Linear Fitting and Outlier Removal
- Linear Fit for Kinetic Models

4.3.1.2 Nonlinear Fitting

- Nonlinear Curve Fit Tool
- Nonlinear Fitting with System Function
- Global Fitting with Parameter Sharing
• Global Fit for Different Functions with Shared Parameters
• Parameters Initialization using LabTalk in NLFit
• User Defined Fitting Function
• Fit Surface with User Defined Function
• Fitting One Dataset as a Function of Other Datasets
• Fitting With Multiple Independent Variables
• User Defined Fitting Function using GNU Scientific Library
• Fitting with NAG Special Function
• Fitting Integral Function with parametric limit using NAG Library
• Fitting with Integral using NAG Library
• Fitting with Integral using LabTalk Function
• Fitting with Two Integrals using LabTalk Function
• Fitting with Summation
• Fitting Complex Function
• Fitting with Convolution
• Quoting Built-in Functions in Your New Function
• Fit Function with Non-constant Background
• Fitting with Piecewise Functions
• Fit Curve Through Certain Points
• Distribution Fit with the Probability Density Function and Cumulative Distribution Function
• Fitting Integral Function with a Sharp Peak
• Fitting with a Piecewise Linear Function
• Fitting with an Ordinary Differential Equation
• Fitting with Convolution of Two Functions
• Parameter Initialization for Rational Functions
• Surface Fitting with Multiple Peaks
• Nonlinear Multiple Variables Fitting
• Modifying Derived Parameters in Build-in Functions
• Fit Multiple Datasets by Fitting One and then Using Those Fit Parameters for Other Datasets
• Implicit Fitting with Three Variables
• Nonlinear fitting using Orthogonal Distance Regression

### 4.3.2 Linear and Polynomial Fitting

#### 4.3.2.1 Linear and Polynomial Fitting

• Linear Fitting and Outlier Removal
• Linear Fit for Kinetic Models

#### 4.3.2.2 Linear Fitting and Outlier Removal

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Linear Fitting</td>
<td></td>
</tr>
</tbody>
</table>

#### 4.3.2.2.1 Summary

An outlier is typically described as a data point or observation in a collection of data points that is "very distant" from the other points and thus could be due to, for example, some fault in the measurement procedure. Identification and removal of outliers is often controversial, and is typically "more acceptable" in situations where the model used to describe the data is well known and well accepted.

#### 4.3.2.2.2 What you will learn

This tutorial will show you how to:

• Perform linear regression on a set of data points
• Examine the Residuals Table in the output and "identify" outliers
• Use the Masking Tool to remove the outlier points
• Use the Recalculation mechanism to automatically update the result after outlier removal

The procedure described in this tutorial is also applicable to other fitting tools such as Polynomial and Nonlinear Fitting

#### 4.3.2.2.3 Steps

1. Start with a new workbook and import the file \Samples\Curve Fitting\Outlier.dat.
2. Click and select the second column and use the menu item **Plot: Symbol: Scatter** to create a scatter plot.
3. With the graph active, use the menu item **Analysis: Fitting: Linear Fit...** to bring up the Linear Fit dialog. Note that if you have used the Linear Fit dialog before, there will be a fly-out menu and you need to select the **Open Dialog...** sub menu.

4. In the **Fit Control** tab, clear the **Apparent Fit** check box.

5. In the **Residual Analysis** tab in the dialog, and check the **Standardized** check box.

6. Change the **Recalculate** drop-down at the top of the dialog to **Auto** and press the **OK** button at the bottom of the dialog. The dialog will close and linear regression will be performed on the data.
7. Select the FitLinearCurve1 result sheet in the data workbook and scroll to the right side to view the Standardized Residual column. You will note that the value in row 6 of this column is \(-2.54889\):

4.3.2.3.1 Masking plotted data by selecting points in the worksheet

At this point, we can mask data using either the worksheet or the graph. We will start by demonstrating how to mask plotted data from the worksheet.

1. Return to the original Outlier sheet and highlight row 6.
2. On the Mini Toolbar that pops up, click the Mask/UnMask Data button and note that the outlier is now masked (marked as red) in the graph window.
3. Click on row 6 again and toggle the Mask/Unmask Data button to remove the mask from the point, noting that the point reverts to black.
4.3.2.2.3.2 Masking plotted data by selecting points in the graph

To mask data in the graph:

1. Make the graph active and then click and hold down the mouse left button on the "Regional Mask Tool" button in the Tools toolbar. Select the "Masked Points on Active Plot" submenu which will be the first item in the fly-out menu:

2. With the above submenu selected, go to the graph and click on the 6th data point to mask the point (note that you can drag out a rectangle around the point).
Whether you have masked the point in the worksheet or masked the point in the graph window, masking the point changes the input data to the linear fit operation and the auto update mechanism is triggered. The linear fit will be repeated with this particular masked point left out. The fit curve in the graph and the parameters table will automatically update. The resulting graph should look like this:

![Graph with linear fit and parameters table]
4.3.2.3 Linear Fit for Kinetic Models

4.3.2.3.1 Summary

Non-linear kinetic models are widely used across many disciplines of natural science, such as, physics, chemistry, biology. Experimentally, all the crucial parameters in kinetic models are obtained through fitting the raw data. The intuitive way to fit the raw data is to do a non-linear fit with the expression directly from the kinetic equation. Alternatively, linear fit can be applied if we can transform the equation in the way that the dependent variable related to independent variable linearly.

Minimum Origin Version Required: Origin 2015

4.3.2.3.2 What you will learn

This tutorial will show you how to:
• Perform linear fit on same non-linear kinetic model using different linear transformations.
• Perform apparent linear fit on non-linear kinetic models.

4.3.2.3.3 Linear fit for Langmuir model
4.3.2.3.3.1 Identify transformed independent and dependent variables

Langmuir model is described by the non-linear equation below:

\[ y = \frac{ym \cdot K \cdot x}{1 + K \cdot x} \]

where \( ym, K \) are the parameters we want to obtain through fitting.

To perform linear fit on Langmuir model, we can transform it into linear equation in two different ways:

1. Transform it into traditional linear Langmuir equation:

\[ y = -\frac{1}{K} \frac{y}{x} + ym \]

where the independent variable is \( y/x \), dependent variable is \( y \), slope is \(-1/K\) and intercept is \( ym \).

2. Transform it into double reciprocal linear Langmuir equation:

\[ \frac{1}{y} = \frac{1}{ym \cdot K} \frac{1}{x} + \frac{1}{ym} \]

where the independent variable is \( 1/x \), dependent variable is \( 1/y \), slope is \( 1/(ym \cdot K) \) and intercept is \( 1/ym \).

4.3.2.3.3.2 Create new independent and dependent variable data

1. Open a new workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file LangmuirModel.dat. Drag-and-drop this file into the empty worksheet to import it.

2. If there is a Sparklines label row, right-click it to select Hide from the context menu to hide it. Use Ctrl+D to bring up Add New Columns dialog, enter 4 and click OK to add 4 columns to store transformed XY dataset later.

3. For traditional linear Langmuir model transformation, the independent variable is now \( y/x \) and dependent variable is still \( y \). Type \( y/x \) and \( y \) as the long name for column C and D respectively so that it will show as X axis title, Y axis title respectively in later plot.

4. Type \( B/A \) in \( F(x) = \) formula cell in column C to set the value for independent variable \( y/x \), and press ENTER. Highlight column C, right click and select Set As:X to make it as the default X dataset for plotting column D.

5. Type \( B \) in \( F(x) = \) formula cell in column D to set the value for dependent variable \( y \), and press ENTER.

6. For double reciprocal linear Langmuir model transformation, the independent variable is \( 1/x \) and dependent variable is \( 1/y \). Similarly, make the long name of column E, F as \( 1/x \), \( 1/y \), respectively, and set their column values as \( 1/A \) and \( 1/B \) accordingly. Set column E designation as X.
7. The worksheet is then as following:

<table>
<thead>
<tr>
<th></th>
<th>A(X1)</th>
<th>B(Y1)</th>
<th>C(X2)</th>
<th>D(Y2)</th>
<th>E(Y2)</th>
<th>F(Y2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Na</td>
<td>x</td>
<td>y</td>
<td>y/x</td>
<td>y</td>
<td>1/x</td>
<td>1/y</td>
</tr>
<tr>
<td>Units</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>F(x)=</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.1</td>
<td>0.939</td>
<td>9.392</td>
<td>0.939</td>
<td>10</td>
<td>1.065</td>
</tr>
<tr>
<td>2</td>
<td>0.12</td>
<td>1.124</td>
<td>9.364</td>
<td>1.124</td>
<td>8.333</td>
<td>0.89</td>
</tr>
<tr>
<td>3</td>
<td>0.14</td>
<td>1.149</td>
<td>8.206</td>
<td>1.149</td>
<td>7.143</td>
<td>0.87</td>
</tr>
<tr>
<td>4</td>
<td>0.16</td>
<td>1.406</td>
<td>8.785</td>
<td>1.405</td>
<td>6.25</td>
<td>0.711</td>
</tr>
<tr>
<td>5</td>
<td>0.18</td>
<td>1.354</td>
<td>7.524</td>
<td>1.354</td>
<td>5.556</td>
<td>0.738</td>
</tr>
</tbody>
</table>

4.3.2.3.3 Linear fit on transformed linear data

1. First, we will perform linear fitting on traditional linear Langmuir transformation. Highlight column D and select Plot:Symbol:Scatter to make a scatter plot.

2. To perform linear fitting, select Analysis:Fitting:Linear Fit:Open Dialog to bring up the Linear Fit dialog box and click OK to close dialog. In the appeared prompt, choose No and click OK.
Similarly, to perform linear fit on double reciprocal linear Langmuir transformation, highlight column F, follow the steps above to create a scatter plot and then do a linear fit.
The coefficients in Langmuir model are then can be calculated using corresponding slope and intercept expressions.

### 4.3.2.3.4 Apparent linear fit on original non-linear data

Alternatively, we can use apparent linear fit to directly perform linear fit on raw non-linear kinetic data by customizing only the axis scales. Take Langmuir kinetic model for example, based on double reciprocal Langmuir linear transformation we found that the inverse of original dependent variable $1/y$ is in linear relationship with the inverse of original independent variable $1/x$. Therefore, if set the X scale as $1/x$ and set the Y scale as $1/y$, raw Langmuir kinetic data would appear with linearity.

1. To perform apparent linear fit on Langmuir kinetic raw data, highlight column \textit{B} and select \textit{Plot:Symbol:Scatter} to make a non-linear scatter plot.
2. Double click on the X axis to bring up Axis dialog, set From as 0.08 and To as 3. Then select Custom Formula from the Type drop-down list and input 1/x as the Direct Formula and 1/x as the Inverse Formula. Choose Fixed From in the Rescale drop-down list. Click OK to close the dialog.
3. As can be see from the plot, the default X axis ticks are not well separated. To make the ticks of X axis display reasonably, we will create a dataset to set the positions of ticks. To do so, activate `LangmuirModel` worksheet and use Ctrl+D to add one more column. Enter dataset 0.1, 0.15, 0.2, 0.3, 0.4, 0.7, 1, 3 in newly added column G.

4. To use column G as major tick positions for X axis, double click on the X axis to bring up Axis dialog. Then go to Major Ticks node choose By Custom Positions from Type drop-down list and choose [LangmuirModel]LangmuirModel!G from the Dataset drop-down list.
5. Click **Vertical** icon on left panel, similarly, choose **Custom Formula** from **Type** drop-down list and input $1/x$ in both **Direct Formula** and **Inverse Formula** boxes. Click **OK** to close the dialog box.
6. To perform apparent linear fit, select **Analysis:Fitting:Linear Fit:Open Dialog** to bring up the **Linear Fit** dialog box. In the **Fit Control** tab, we can see that by default the **Apparent Fit** box is checked.
7. Click **OK** to close dialog and choose **No** radio box in the prompt, then click **OK** to close it.
4.3.2.3.4 Solutions for other non-linear kinetic models

4.3.2.3.4.1 Freudlich equation

The non-linear kinetic equation for Freudlich model is as below:

\[
\ln(y) = \ln(K) + \frac{\ln(x)}{n}
\]

where the independent variable is \(\ln(x)\), dependent variable is \(\ln(y)\), slope is \(1/n\) and intercept is \(\ln(K)\), \(K\) and \(n\) are the coefficients to be determined.

Apparent linear fit is recommended since Ln scale is a build-in scale setting. To fit this non-linear kinetic model, use apparent fit with X and Y axis scales both set to be Ln scales.

Alternatively, you can perform linear fit after you calculate the Ln value of both X and Y dataset. See the example of Langmuir model above for details.

4.3.2.3.4.2 Lagergren’s pseudo-first order

The non-linear kinetic equation for Lagergren’s pseudo-first order model is as below:

\[
\log(q_{e,exp} - y) = \log(q_{e,fit}) - \frac{k_1 \cdot x}{2.303}
\]

where the independent variable is \(x\), dependent variable is \(\log(q_{e,exp} - y)\), slope is \(-k_1/2.303\) and intercept is \(\log(q_{e,fit})/2.303\), \(q_{e,exp}\) is known constant, \(-k_1\) and \(q_{e,fit}\) are the coefficients to be determined.

Apparent linear fit is recommended since Log scale is a build-in scale setting. To fit this non-linear kinetic model, first calculate \(q_{e,exp} - y\) and then use apparent fit with only Y axis scale set to be Log scale.

Alternatively, you can firstly calculate \(\log(q_{e,exp} - y)\) and use this newly created data to do linear fit directly. Refer to the example of Langmuir model above for details.

4.3.2.3.4.3 Ho’s pseudo-second order

The non-linear kinetic equation for Freudlich model is as below:

\[
\frac{x}{y} = \frac{1}{k_2q_e^2} + \frac{x}{q_e}
\]

where the independent variable is \(x\), dependent variable is \(x/y\), slope is \(1/q_e\) and intercept is \(1/(k_2q_e^2)\), \(k_2\) and \(q_e\) are the coefficients to be determined.

To linearly fit this model, you have to firstly calculate \(x/y\) and use this newly created data to perform linear fit.

Alternatively, we can transform this equation into the form below:

\[
\frac{1}{y} = \frac{1}{k_2q_e^2} \cdot \frac{1}{x} + \frac{1}{q_e}
\]

where the independent variable is \(1/x\), dependent variable is \(1/y\), slope is \(1/(k_2q_e^2)\) and intercept is \(1/q_e\).

For this transformation, we can either perform linear fit once we created new independent variable data as \(1/x\) and new dependent variable data as \(1/y\). Or we can perform apparent linear fit by set both X and Y axis scales as \(1/x\) scale. Please refer to Langmuir model for more details.
4.3.3 Nonlinear Fitting

4.3.3.1 Nonlinear Fitting

- Nonlinear Curve Fit Tool
- Nonlinear Fitting with System Function
- Global Fitting with Parameter Sharing
- Global Fit for Different Functions with Shared Parameters
- Parameters Initialization using LabTalk in NLFit
- User Defined Fitting Function
- Fit Surface with User Defined Function
- Fitting One Dataset as a Function of Other Datasets
- Fitting With Multiple Independent Variables
- User Defined Fitting Function using GNU Scientific Library
- Fitting with NAG Special Function
- Fitting Integral Function with parametric limit using NAG Library
- Fitting with Integral using NAG Library
- Fitting with Integral using LabTalk Function
- Fitting with Two Integrals using LabTalk Function
- Fitting with Summation
- Fitting Complex Function
- Fitting with Convolution
- Quoting Built-in Functions in Your New Function
- Fit Function with Non-constant Background
- Fitting with Piecewise Functions
- Fit Curve Through Certain Points
- Distribution Fit with the Probability Density Function and Cumulative Distribution Function
- Fitting Integral Function with a Sharp Peak
- Fitting with a Piecewise Linear Function
- Fitting with an Ordinary Differential Equation
- Fitting with Convolution of Two Functions
4.3.3.2 Nonlinear Curve Fit Tool

4.3.3.2.1 Summary

Nonlinear fitting in Origin is performed using the NonLinear Fitting (NLFit) dialog box. The NLFit tool contains more than 200 built-in fitting functions used in many different disciplines.

To do a quick and simple fit without opening the NLFit dialog, try the Quick Fit Gadget.

Minimum Origin Version Required: 8.5

4.3.3.2.2 What you will learn

- How to fit with a built-in fitting function.
- How to change NLFit setting using Recalculate.
- How to define and fit with a user-defined function.

4.3.3.2.3 Use a built-in function to fit the data

1. Click File: Open... to open the Intro_to_Nonlinear Curve Fit Tool.opj from the \Samples\Curve Fitting folder and select the Built-In Function folder from the Project Explorer window.
2. With the **Graph1** active, select the menu item **Analysis: Fitting: Nonlinear Curve Fit** to bring up the **NLFit** dialog, and then select **Gauss** from the **Function** drop-down list:

3. In the **Parameter** tab, initial parameter values are automatically assigned, because the built-in functions have parameter initialization code.

   If you go to the **Residual** tab, you can see the current residuals and decide whether the current fit results are acceptable.
4. Note that a fitted curve drawn using the initial parameter values, is shown in the graph.

5. Click the **Fit until converged** button. To see if the fitting operation was successful, click the **Messages** tab and note the number of iterations, reduced chi-sqr value, $R^2$ value, etc.

<table>
<thead>
<tr>
<th>Residual</th>
<th>Formula</th>
<th>Sample Curve</th>
<th>Messages</th>
<th>Function File</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Initialization was called.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Levenberg-Marquardt:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reduced Ch-sqr = 7.8157274469</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COD($R^2$) = 0.99966112534176</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Iterations Performed = 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Iterations in Session = 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[3] Fit converged. Chi-Sqr tolerance value of 1E-9 was reached.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6. Click the OK button. The **FitNL1** report sheet is created with fit results including parameter values and fit statistics.
7. Reopen the Nonlinear Curve Fitting dialog by clicking on the green lock icon on the upper left corner of the graph and selecting **Change Parameters**.

8. Go to the **Parameters** tab, change the value of $x_c$ to 25 (note that by double-clicking in the cell, you can edit the value) and select the **Fixed** check box.

9. Once again, click the **Fit until converged** button and then **OK**.
10. In the report sheet, you can see that fixing the value of \( xc \) to 25 results in a Standard Error of 0.

| Parameters | Value | Standard Error | \( t \)-Value | Prob>|t| | Dependency |
|------------|-------|----------------|--------------|---------|-----------|
| \( y_0 \)  | 5.34629 | 0.58432 | 9.14955 | 5.20235E-12 | 0.54068 |
| \( xc \)   | 25    | 0              | --          | --      | 0         |
| \( w \)    | 10.16855 | 0.20486 | 49.6359 | 2.92631E-42 | 0.52119 |
| \( A \)    | 984.68626 | 21.48327 | 45.83503 | 1.14874E-40 | 0.69379 |
| \( \sigma \) | 5.08427 | 0.10243 |
| FWHM       | 11.972655 | 0.24121 |
| Height     | 77.26433 | 1.21488 |

4.3.3.2.4 Define and fit with a user-defined function

In this section, we will show you how to define your own fitting function and use it in the Nonlinear Curve Fit tool. Our function is \( y = y_0 + a \exp(-b\cdot x) \)

1. With the project file used in the first section opened. Select **Tools: Fitting Function Builder...** menu to bring up the **Fitting Function Builder** dialog box.

2. On the Goal page, click **Create a New Function**, then click the **Next** button to go to the **Name and Type** page.

3. On the **Name and Type** page, then name the function and select a Function Type. This function will be put to the **User Defined** category by default.
- Set **MyFunction** as the **Function Name**.
- Select **Expression** from the **Function Type list**. Note that the left panel displays Hints regarding the Function Type you selected.
- Click the **Next** button to turn to the **Variables and Parameters** page.

4. On the **Variables and Parameters** page, make sure **Independent Variables** reads \( x \) and **Dependent Variables** reads \( y \). Then input the comma-separated values \( y_0, a, b \) into the **Parameters** text box. Click the **Next** button.
5. On the **Function Body** page, perform the following operations:
   - Set the **Initial Values** for parameters as shown below.
   - In the **Function body** edit box, enter $y_0 + a \cdot \exp(-b \cdot x)$.
   - Use **Quick Check** to check the validity of current function. After entering a value for the independent variables $x$, click the **Evaluate** button, you will get a return value of the dependent variable $y$ which can be used to check the validity of this function.

6. Click the **Finish** button to finish defining the function.
7. Open Project Explorer (**View: Project Explorer**), and select the **User-Defined Function** folder.
8. Highlight column A and B in [Book1]Sheet1, select the menu item **Analysis: Fitting: Nonlinear Curve Fit** to bring up the **NLFit** dialog. Select the **User Defined** category and your function **MyFunction** on the
Function Selection page, under the Settings tab:

9. By successively clicking the **1 iteration button**, you can see the change in parameter values as well as the increasing conformance of the fitted curve.
   - Click the "1 Iteration" button.

   ![Image of the function selection page](image)

   ![Image of the parameter table](image)

   ![Image of the fitted curve](image)

   - Click the "1 Iteration" button again.
Click the **Fit until converged** button.

![Image of a data analysis graph and table](image-url)
10. Click the **OK** button and the FitNL1 report sheet of fitting results is created. Here, you will find best-fit parameter values and other fit statistics.

4.3.3.3 Nonlinear Fitting with System Function

**Videos**

- Nonlinear Curve Fit Tool
- Global Fitting
- Setting Data Range in the Nonlinear Fit Tool

**OriginBlog**

4.3.3.3.1 Summary

The NLFit dialog is an interactive tool which allows you to monitor the fitting procedure during the non-linear fitting process. This tutorial fits the Michaelis-Menten function, which is a basic model in Enzyme Kinetics, and shows you some basic features of the NLFit dialog. During the fitting, we will illustrate how to perform a Global Fit, which allows you to fit two datasets simultaneously and share some parameter values.
4.3.3.2 What you will learn

This tutorial will show you how to:

- Import a single ASCII file.
- Perform a global fit with shared parameters.
- Select a fitting range and fit part of the data.
- Use the Command Window to perform a simple calculation.

4.3.3.3 Steps

4.3.3.3.1 Import the file

Open a new workbook. Select Help: Open Folder: Sample Folder... to open the “Samples” folder. In this folder, open the Curve Fitting subfolder and find the file Enzyme.dat. Drag-and-drop this file into the empty worksheet to import it.

4.3.3.3.2 Plotting the Data

Select columns B and C and plot as a scatter plot by clicking the button.
4.3.3.3.3 Fitting with the Michaelis-Menten Function

The single-substrate Michaelis-Menten function is a basic model used in enzyme kinetics studies.

\[ v = \frac{V_{\text{max}}[S]}{K_m + [S]} \]

The parameter \( v \) is the reaction velocity, \([S]\) is the substrate concentration, \( V_{\text{max}} \) is the maximal velocity, and \( K_m \) represents the Michaelis constant. Parameters \( V_{\text{max}} \) and \( K_m \) are important enzyme properties and their values can be determined by fitting the M-M function to a \( v \) vs. \([S]\) curve. While there is no M-M fitting function in Origin, we can use a more general model, the built-in Hill function to perform the fit:

\[ v = V_{\text{max}} \frac{x^n}{K^n + x^n} \]

where \( n \) is the cooperative sites. For a single-substrate model, we fix \( n = 1 \), thus simplifying the model so that it behaves like the M-M function.

There are two curves, one is the reaction without an Inhibitor and the other is the reaction with a Competitive Inhibitor. We will use the NLFit tool to fit these two curves simultaneously. Since for competitive inhibition reactions, the maximum velocity is the same as with no inhibition, we can share the \( V_{\text{max}} \) value during the fitting procedure and perform a Global Fit.

1. With the graph active, select the menu item **Analysis: Fitting: Nonlinear Curve Fit** to bring up the NLFit dialog. Select Hill function from Growth/Sigmoidal category on the **Settings: Function Selection** page.
2. On the Settings: Data Selection page, click the triangular button next to the Input Data and choose Add all plots in active page to set the data range.

3. Select Global Fit from Multi-Data Fit Mode drop-down list on the Settings: Data Selection page.
4. Switch to the **Parameters** tab, check the **Share** box on the Vmax row. These Share check boxes are only available when using **Global Fit** mode. Check the **Fixed** box for n and n_2, and make sure their values are 1.

5. Click the **Fit** button to generate the analysis reports. A table of fit parameters is pasted to the original graph (only the fit parameter values table is shown in the following figure.)
From the fit result, we can conclude that the maximum velocity is $2162.8 \mu M/min$. The value of $K_m$ for the no inhibitor model is $1.78 \mu M$. The value $K_m$ for the competitive inhibitor model is $4.18 \mu M$.

4.3.3.4.4 Fitting Lineweaver-Burk Plot

As we know, the model parameters can also be estimated by the Lineweaver–Burk or double-reciprocal plot. The Lineweaver–Burk plot takes the reciprocal of both sides of the $M$-$M$ function and plots by $1/v$ vs. $1/[S]$:

$$\frac{1}{v} = \frac{1}{V_{max}} + \frac{K_m}{V_{max}[S]}$$

This is actually a linear function:

We will use the No Inhibitor data to illustrate how to calculate $K_m$ and $V_{max}$ by L-B plot.
1. Go back to the raw data worksheet and add two more columns by clicking the button. Right-click on column D and select Set As: X from the context fly-out menu to set it as an X column. Right-click on column D again and select Set Column Values to bring up the Set Values dialog. In the dialog edit box, enter: \( \frac{1}{\text{Col}(A)} \) and set the Recalculate mode as None, since we don't need to auto update the reciprocal values in this example.

Similarly, set column E’s values as \( \frac{1}{\text{Col}(B)} \). Enter the long name for column D & E as \( \frac{1}{[S]} \) & \( \frac{1}{V} \), respectively. And then we have:

![Enzyme - Enzyme.dat](image)

2. Highlight columns D & E and click button to create a scatter plot.
From the above equation, we know there is a linear relationship between $\frac{1}{v}$ and $\frac{1}{[S]}$, so we can use the NLFit tool to fit a straight line on this plot. (You can also use the Fit Linear tool from Analysis: Fitting: Fit Linear)

3. Bring up the NLFit dialog again, select Line function from Polynomial category, and then click the Fit button directly to generate results.

From the plot, one may doubt that this is the best fit curve since there is a point located far away. Actually, the right side of L-B plot is low substrate concentrations area, the measurement error may be large, so we'd better exclude these points during fitting.
4. Click the lock icon on the graph upper-left corner, and select Change Parameters to bring back NLFit dialog.

In Settings: Data Selection page, click the button on Input Data node, and then choose Reselect All Data from Graph from fly-out menu.
Then the NLFit dialog rolls up and your cursors become when you move to the graph page. Click and draw a rectangle to select data points you want to fit. The input range is labeled by vertical lines. You can also click-and-move these lines to change the input range.

Click the button on Select Data in Graph window to go back to NLFit dialog.
5. Click the **Fit** button on the NLFit dialog to recalculate the result. You can see from the graph that the report table was updated.

6. Since the intercept of the fitted curve is $1/V_{max}$, it is equal to $4.76191E-4$ in this example. To get the $V_{max}$ value, select **Window: Command Window** to open the command window, type

   \[
   1/4.76191E-4 =
   \]

   and press ENTER:

   ![](Command_Window.png)

   Origin returns the value 2099, which is close to what we got above, 2160. (When fitting the hill function above, we shared $V_{max}$ when fitting two datasets. If you fit the No Inhibitor data only, this value will be closer.)
4.3.3.4.1 Summary

The term "global fitting" generally refers to simultaneous curve fitting operations performed on multiple datasets. Because datasets remain distinct, they may or may not "share" parameter values during the fit process. When a parameter is shared, a single parameter value is calculated for all datasets; When a parameter is not shared, a separate parameter value is calculated for each dataset.

By contrast, "concatenated fitting" is performed by combining all datasets into a single dataset. Because curve fitting operations are performed on a single dataset, only a single set of parameter values is returned.

Since 2016 SR2, a new app Sequential Fit has been released to do sequential fitting on multiple datasets. With this app, the fit parameter values obtained from the current dataset will be used to initialize the parameters of the next dataset. This is very applicable for those datasets, the common parameters of which keep changing in turn.

4.3.3.4.2 What you will learn

This tutorial will show you how to:

- Select multiple datasets for fitting.
- Select different fitting modes.
- Perform global fit with parameter sharing.

4.3.3.4.3 Steps

1. Create a new workbook by clicking the button.
2. Click the button to import the file Enzyme.dat in the <Origin EXE Folder>\Samples\Curve Fitting\ folder.
3. Highlight column B and C and click the button to generate a scatter plot.
4. Keep the graph window activated and select the Analysis: Fitting: Nonlinear Curve Fit menu item to open the NLFit dialog.
5. Set the Recalculate mode to Auto.
6. In the Function Selection page, choose the Hill function from the Growth/Sigmoidal category.
7. Go to the Data Selection page, click the triangle button next to the Input Data selection box and choose Add All Plots in Active Layer, to add both plots as input data.
8. Select **Global Fit** mode from the **Multi-Data Fit Mode** drop-down list:

9. Go to the **Parameters** tab. Check the **Fixed** check box for $n$ and $n_2$ to fix their values to 1.

10. Click the **Fit** button to fit curves. You will get these results from the **Parameters** table of the report worksheet:
11. The fitted curves will be added to the original data plot.

12. In this case, the maximum velocity \( V_{\text{max}} \) may be the same, so we could share this parameter value when fitting.
13. Click the green lock icon in the report worksheet and select **Change Parameters** to bring back the **NLFit** dialog.

14. In the **Parameters** tab, check the **Share** check box for **Vmax**.

![Image of NLFit dialog with Vmax checked in Share box]
15. Click the **Fit** button again to update results. You can see the \( V_{\text{max}} \) values for both curves are the same.

The asterisk in the parameter name indicates that this parameter is shared:

### Parameters

|          | Value     | Standard Error | \( t \)-Value | \( \text{Prob}>|t| \) | Dependency |
|----------|-----------|----------------|---------------|----------------|------------|
| \( V_{\text{max}} \) | 2162.82534 | 42.2049        | 51.24584      | --             | 0.76631    |
| \( k \)   | 1.78077   | 0.19046        | 9.35003       | --             | 0.63991    |
| \( n \)   | 1         | 0              | --            | --             | 0          |
| \( V_{\text{max}} \) | 2162.82534 | 42.2049        | 51.24584      | 7.81935E-22    | 0.76631    |
| \( n \)   | 4.18392   | 0.33105        | 12.63784      | 1.07513E-10    | 0.60034    |

Reduced Chi-sqr = 4812.1410794
COD(R^2) = 0.9810872387706
Iterations Performed = 7
Total Iterations in Session = 7

Fit converged. Chi-Sqr tolerance value of 1E-9 was reached.

Some parameter values were fixed.
Standard Error was scaled with square-root of reduced Chi-Sqr.
* : Shared Parameter

16. The fitted curve will automatically update.

### 4.3.3.5 Global Fit for Different Functions with Shared Parameters

#### 4.3.3.5.1 Summary

This tutorial is aimed at solving the following problem: do global curve fitting on two or more curves using different functions for each curve, but sharing some parameters, the shared parameter was common to all the datasets. This problem arises in a wide variety of scientific fields such as fitting for anisotropy spectrum.
Minimum Origin Version Required: Origin 2015 SR1

4.3.3.5.2 What you will learn

This tutorial will show you how to:

- Select multiple datasets for global fitting.
- Set a switch parameter which connect all functions.
- Perform global fit with parameter sharing for multiple fitting functions.

4.3.3.5.3 Steps

1. Create a new workbook by clicking the button.
2. Click the button to import the file MultiFunctionsFit.dat in the <Origin EXE Folder> \Samples\Curve Fitting\ folder.
3. Highlight column A, B and C and select the Analysis: Fitting: Nonlinear Curve Fit menu item to open the NLFit dialog.
   The user defined fitting function will be built in next 3 steps, the functions are built based on the quantitative model below:
   \[
   \begin{align*}
   \text{Col}(B) : L_1 &= \frac{A_1 e^{-t/t_0} + B_1}{A_2 e^{-t/t_0} + B_2} \\
   \text{Col}(C) : L_2 &= A_2 e^{-t/t_0} + B_2
   \end{align*}
   \]
4. In the Function Selection page, choose the <new...> function from the User Defined category.
5. Enter "GlobalFit" as the function name, and set the Function Model and Function Type follows the graph below:
Then, click **Next** to go to the variables and parameters page.
6. Set the variables and parameters follows the graph below:

Then, click **Next** to go to the Expression Function page.

7. Type the expression which contained formula of $L_1$ and $L_2$ in the function body box:

$$s \times \left( A_1 \exp\left(\frac{-t}{t_0}\right) + B_1 \right) / \left( A_2 \exp\left(\frac{-t}{t_0}\right) + B_2 \right) - (s-1) \times \left( A_2 \exp\left(\frac{-t}{t_0}\right) + B_2 \right)$$

The parameter $s$ is a switch for global fitting, if $s=1$, the $L_1$ is used for fitting, if $s=0$, $L_2$ is used for fitting. The value of $s$ will be controlled in the following fitting procedure. Set the Initial Value of $A_1$ and $B_1$
to 0. Then, click **Finish**.

8. Back to **NLFit** dialog, select GlobalFit function in User Defined Category. Go to the Data Selection Page, Select Global Fit mode from the Multi-Data Fit Mode drop-down list:

9. Go to the **Parameters** tab. Check on the **Share** check box for A2, B2 and t0, then Check on the **Fixed** box for s and s_2 to fix their values to 1 and 0, respectively. The setting of s will control fitting Col(B)
Tutorials for Origin 2024b

using $L_1$ while fitting Col(C) using $L_2$

<table>
<thead>
<tr>
<th>NO.</th>
<th>Param</th>
<th>Meaning</th>
<th>Share</th>
<th>Fixed</th>
<th>Value</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>B1</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>0</td>
<td>..</td>
</tr>
<tr>
<td>1</td>
<td>A2</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>1</td>
<td>..</td>
</tr>
<tr>
<td>1</td>
<td>B2</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>1</td>
<td>..</td>
</tr>
<tr>
<td>1</td>
<td>t0</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>1</td>
<td>..</td>
</tr>
<tr>
<td>1</td>
<td>s</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>1</td>
<td>..</td>
</tr>
<tr>
<td>2</td>
<td>A1_2</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>0</td>
<td>..</td>
</tr>
<tr>
<td>2</td>
<td>B1_2</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>0</td>
<td>..</td>
</tr>
<tr>
<td>2</td>
<td>s_2</td>
<td>?</td>
<td>✔</td>
<td>✔</td>
<td>0</td>
<td>..</td>
</tr>
</tbody>
</table>

Double click cells to change operator. Right click cells for more columns.

10. Click the **Fit** button to fit curves. You will get these results from the **Parameters** table of the report worksheet:

<table>
<thead>
<tr>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 2.5887072951</td>
<td>0.1678709978</td>
</tr>
<tr>
<td>B1 0.4859001021</td>
<td>0.0052845018</td>
</tr>
<tr>
<td>A2* -12.6787277087</td>
<td>0.1035113131</td>
</tr>
<tr>
<td>B2* 8.9810129162</td>
<td>6.5535940841E-4</td>
</tr>
<tr>
<td>t0* 3.3462910396</td>
<td>0.0113070784</td>
</tr>
<tr>
<td>s 1</td>
<td>0.0000000000</td>
</tr>
</tbody>
</table>

share
11. The fitted curves will be added to the graph window. You can check the fitted curve for \( \text{Col}(B)/L_1 \) and \( \text{Col}(C)/L_2 \) in Sheet **FitNL1** by double clicking the Graphs.

4.3.3.6 **Parameters Initialization using LabTalk in NLFit**
4.3.3.6.1 Summary

In previous Origin versions, one can only initialize fitting parameters with Origin C code. Since Origin 9.0 SR1, it is also supported to use LabTalk script to initialize parameters. This implement is especially useful when one wants to use worksheet values for the initial parameters.

In this tutorial, three adsorption uptake curves at three different temperatures were measured, and the results are exported in three .txt files. The experimental conditions are stored in the same .txt file as header info. We are going to fit the data to the isothermal-spherical model, according to the following equation:

\[
y = 1 - \frac{6}{n^2} \cdot \exp\left(-\frac{p_n^2}{T} \cdot x\right)
\]

where \(y\) is the normalized mass uptake (mg/g), \(x\) is the time span (s), \(T\) is the time constant (1/s), and the fitting parameter.

There is an empirical equation describing the relationship between the temperature and time constant, which is:

\[
T = 25000 - 58 \cdot Temp
\]

For the uptake curve at each temperature, we will calculate \(T\) from this equation and use it as the initial value for the curve fitting.

Minimum Origin Version Required: Origin 9.0 SR1

4.3.3.6.2 What you will learn

This tutorial will show you how to:

- Create a user-defined fitting function and use Labtalk script to do parameter initialization.
- Use values in worksheet for initialized parameters.

4.3.3.6.3 Steps

4.3.3.6.3.1 Write Parameter Initialization Script for a User-Defined Fitting Function

1. Select Tools:Fitting Function Builder (or press F8) to open the Fitting Function Builder, in the Goal page, select Create a New Function and click Next.
2. In the Name and Type page, make sure the function is created under the User Defined category, name the function UptakeCurveFit, keep the Function Model as Explicit, and select Origin C for Function Type. Click the Next button.
3. In the Variables and Parameters page, keep the Independent Variables and Dependent Variables as the default \(x\) and \(y\), respectively. Set the Parameters to \(T\) and click Next.
4. In the Origin C Fitting Function page, type in the following equation in the Function Body edit box, and then click Next.
\[ y = 1 - \frac{6}{\pi^2} \exp\left(-\frac{\pi^2}{T}x\right) \]

5. In the Parameter Initialization Code page, select Use Custom Code radio button, and then select the Use Labtalk radio button to enable the use of Labtalk script. In the Initialization Code edit box, type in the following script:

```labtalk
//Code to be executed to initialize parameters

//Get the current worksheet page.
range rpage=ry.getpage();

//Get the data worksheet
range rlayer=ry.getlayer();
```


//Get the data worksheet index

int inext=rlayer.index;

//Make sure the data workbook is active

win -a %(ry.getpage())$;

//Make sure the data worksheet is active

page.active=inext;

//Active column 2 in the data worksheet

wks.col=2;

//Get the temperature as a string from column comment

string str1$ = wks.col.comment$;

//Get the string of the temperature number

string str2$ = str1.Left(3)$;

//Substitute the string variable to a double number

double Temp = %(str2$);

//Use the empirical equation to calculate the initial value of T

T=25000 - 58 * Temp;

//Check whether parameter initialization script runs successfully

type -b "Experimental temperature is $(Temp) K, so the initial value of T is $(T)."

Notes: The ry in the script above is an auto-defined range variable for the input data range of parameter y, the syntax for such range variable is r+parameter name. For example, if the parameter name is Temp, the range variable should be rTemp.
7. Click **Finish** to create the user defined fitting function **UptakeCurveFit**, you could find its .fdf file in the **User Files Folder**.

### 4.3.6.3.2 Fit Data with the User Defined Fitting Function

1. Create a new Origin project by clicking the button on the **Standard** toolbar. Click the button (or **Data: Import from File: Import Wizard** or press Ctrl+3) to open the **Import Wizard**.

2. In the **Data Source**, select the **UptakeCurve_343K.txt** as the **File**, which is located under path `<Origin Folder>\Samples\Curve Fitting`. Click **Next** button to navigate to the **Header Lines** page.

   Set the **Long Names**, **Units**, and **Comments** as 3, 4, and 1 to 1, respectively.

3. Click **Finish** to import the data file. Note that the experimental temperature is stored as the comment of column 2, which will be retrieved by the Labtalk script for parameter initialization in the **UptakeCurveFit** fitting function.
4. Highlight column B and select **Analysis:Fitting:Nonlinear Curve Fit** (or press Ctrl+Y) to open the **NLFit** dialog, select **User Defined** for **Category** and **UptakeCurveFit(User)** as **Function**.

5. An attention box pops up and shows the experimental temperature and the calculated initial value of time constant.

   ![Attention Box]

   Experimental temperature is 343 K, so the initial value of T is 5106.

6. Go to the **Parameters** tab. The value of parameter T is 5106, which indicates the parameter initialization script is successfully called.

7. Go to the **Code** tab and select the **Parameter Init** section, there you could double check the parameter initialization script by clicking the button.

8. Click **OK** to close the attention box, and click **Fit** to carry out the fit.

4.3.6.3.3 Create an Analysis Template and Do Batch Processing

1. Go to the report sheet **FitNL1** which is generated from previous steps, click the triangle button right to the **Summary** table and choose **Create Copy as New Sheet**. A new sheet will be created, delete column A in the new sheet and rename it as **Result**.
2. Keep the workbook active and select **File:Save Workbook as Analysis Template** to save this workbook as **MyUptakeFit.ogw**.

3. Create a new Origin project and select **File:Batch Processing** to open the **batchProcess** dialog.

4. Load the analysis template **MyUptakeFit.ogw**, select the files **UptakeCurve_343K.txt**, **UptakeCurve_373K.txt**, and **UptakeCurve_403K.txt** under the `<Origin Folder>\Samples\Curve Fitting\` path, choose **File Name** for **Dataset Identifier** and make sure the other settings are the same according to the image below:

5. Click **OK** to carry out the batch processing, for every file being executed, the attention box pops up and indicates the initial value being used, click **OK** every time to close the attention box and continue the batch processing. Finally, a summary report will be created:
4.3.3.7 User Defined Fitting Function

Besides the 200+ built-in fitting functions, you can also create your own fitting functions in Origin. A number of Origin tools support fitting with your own functions, including:

- **Simple Fit App**
  
  Simple Fit App provides a much more convenient way to fit simple functions that can be expressed in the form \( y = f(x) \), you only need to type your formula or select an existing function, specify the initial values and then generate fitting reports immediately. You can learn how to use this App in this section.

  **Note:** The Simple Fit app is pre-installed with Origin program, you can call it from the App Gallery with a graph window activated.

- **Quick Fit Gadget**

  Quick Fit gadget is another easy way to do both linear and nonlinear fitting without open the Linear Fit or NLFit dialog which might look a little bit complicated but with many advanced controls. Start a fitting process with this gadget, you need first add your own function into the Function List.
Data Analysis

- **NLFit tool.**

  NLFit tool is a powerful fitting wizard which allows you to define more complex fitting functions and control the fitting process in every possible way. For fitting user defined function in NLFit tool, you will need to create it in Fitting Function Builder first.

In this tutorial, we will mainly illustrate how to create a user-defined fitting function in Fitting Function Builder, carry out nonlinear curve fit with it and also show how to fix a parameter for curve fitting using NLFit tool.

Minimum Origin Version Required: Origin 2016 SR0

### 4.3.3.7.2 What You Will Learn

This tutorial will show you how to:

- Create a user-defined fitting function
- Carry out nonlinear curve fit with user-defined fitting function.

### 4.3.3.7.3 How to Create a Fitting Function and Use it to Perform Curve Fitting

The data we are going to fit is the file ConcentrationCurve.dat under the `<Origin EXE Folder>\Samples\Curve Fitting\` path.

The fitting function to be created and used is shown below:

\[
y = A \exp(2.303kx - km) \sqrt{2.303 + \frac{C}{(x - C_0)}}
\]

in which

- \(y\) is the dependent variable
- \(x\) is the independent variable
- \(A, km, k, C, C_0\) are all fitting parameters.

#### 4.3.3.7.3.1 Method 1: Using Simple Fit app

1. Create a new workbook. Click the \(\text{Import Data}\) button to import the ConcentrationCurve.dat file under `<Origin EXE Folder>\Samples\Curve Fitting\` path.

2. Highlight column B and click the \(\text{Graphs}\) button to generate a scatter plot.

3. Click on Simple Fit icon from the Apps panel to open the Simple Fit app. Switch to Nonlinear tab, enter the equation in the \(y(x)=\) box. And then the parameter table will appear to let you enter the...
initial values for the parameters.

4. Once the equation has been entered and parameters have been initialized and fixed, click **Fit** button to fit the curve with the function you just defined. Of course, you can check the trend of fitting by clicking **Iter.** button once by once.

5. You can click **Save As...** to save this function for further use. Click **Close** button to check the fitting results.

4.3.7.3.2 Method 2: Using Fitting Function Organizer and NLFit Tool

Step 1: Create a Fitting Function Using Fitting Function Organizer
In this section, we will show how to create a user defined fitting function in the **Fitting Function Builder**. But there is an alternative tool **Fitting Function Organizer** which also can be used to create user defined fitting functions (open it by selecting **Tools: Fitting Function Organizer** or pressing **F9**).

1. Launch Origin and choose **Tools: Fitting Function Builder** (or press **F8**) to open the **Fitting Function Builder**.
2. In the **Goal** page, select **Create a New Function** and click **Next**.
3. In the **Name and Type** page, change the setting as the following image and then click **Next**:

   ![Fitting Function Builder - Name and Type - MyFitFunc](image)

4. In the **Variables and Parameters** page, enter the variable and parameter names as the image below and then click **Next**:
In the **Parameters** box, use comma ("," as delimiter.

5. In the **Expression Function** page, enter the equation below in **Function Body**:

\[ A \cdot \exp(R_0 \cdot k \cdot x - k_m) \cdot \sqrt{R_0 + c/(x - c_0)} \]

6. Go to the **Constant** tab, set the value of **R_0** to **2.303**.

7. Give estimated initial values to the parameters according to this particular data and function.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Param</strong></td>
<td><strong>Unit</strong></td>
</tr>
<tr>
<td>A</td>
<td>?</td>
</tr>
<tr>
<td>km</td>
<td>?</td>
</tr>
<tr>
<td>k</td>
<td>?</td>
</tr>
<tr>
<td>c</td>
<td>?</td>
</tr>
<tr>
<td>c_0</td>
<td>?</td>
</tr>
</tbody>
</table>

**Note:** You can also give different initial values each time before you actually carry out the fitting.

8. Can click the **Evaluate** button to quick check whether the function is valid (if it is valid, an actual value will be returned for y).

**Note:** If you used **Origin C** as **Function Type** at the beginning, you can also compile the function at this stage to check if there is any error, this is especially useful for brackets matching.
9. Click the **Next** button three times until it goes to **Derived Parameters** page.

10. In this page, we will define the derived parameter \( A_0 \), enter its equation in the **Derived Parameters Equations** box:

    \[
    A_0 = -A \times \exp(km) \times 1E^{-4}
    \]

11. Click **Finish** to create this user defined fitting function. The .FDF file for it will be stored in the **User Files Folder**.

You can always modify the user defined fitting function later, either in the **Fitting Function Builder** (choose **Edit a User-defined Function** in **Goal page**), or in the **Fitting Function Organizer**.

Step 2: Carry Out Curve Fitting using NLFit Tool

1. Create a new workbook. Click the **button to import the **ConcentrationCurve.dat** file under <Origin EXE Folder>|Samples|Curve Fitting> path.

2. Highlight column B and click the **button to generate a scatter plot.

3. Keep the graph activated, select **Analysis:Fitting:Nonlinear Curve Fit** to open the **NLFit** dialog.

4. In the **Function Selection** page, set **Category** as **User Defined** and then set **Function** as **MyFitFunc(User)**.

5. Click the **button to fit the data.

6. An error message returns in the **Message** tab of the lower panel, indicates the fit did not converge because of overparameterization.

   ![Error Message]

   (1) Parameter Initialization was called.
   (2) Levenberg-Marquardt---------
   Reduced Chi-sqr = 2.75888725186E-6
   CDD(R^2) = 0.9998364795542
   Iterations Performed = 19
   Total Iterations in Session = 19

   **3) Fit did not converge - mutual dependency exists between parameters. You may have overparameterized the fitting function. Fixing one of them may eliminate this problem.**

7. The parameters \( A \) and \( km \) have mutual dependence, so fixing either one will solve the problem. We will fix \( A \) this time.
8. Go to the Parameters tab, click the \( \text{Fixed} \) box to restore the initial value setting, check the Fixed box of parameter A:

<table>
<thead>
<tr>
<th>NO.</th>
<th>Param</th>
<th>Meaning</th>
<th>Fixed</th>
<th>Value</th>
<th>Error</th>
<th>Parameter</th>
<th>Conf Lim</th>
<th>Conf Lr</th>
<th>Significant Digits</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>( A )</td>
<td>?</td>
<td>✔️</td>
<td>325</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>System</td>
</tr>
<tr>
<td>1</td>
<td>( km )</td>
<td>?</td>
<td></td>
<td>10</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>System</td>
</tr>
<tr>
<td>1</td>
<td>( k )</td>
<td>?</td>
<td></td>
<td>1</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>System</td>
</tr>
<tr>
<td>1</td>
<td>( c )</td>
<td>?</td>
<td></td>
<td>2</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>System</td>
</tr>
<tr>
<td>1</td>
<td>( c0 )</td>
<td>?</td>
<td></td>
<td>0.1</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>System</td>
</tr>
</tbody>
</table>

9. Click the Fit button to carry out the fit.
10. The fitted curve will be added to the original data plot,
11. A report sheet will be generated as well, in which the fitted value of all parameters (including the derived parameter A0) are reported in the parameters table:

|      | Value | Standard Error | t-Value | Prob>|t| | Dependency |
|------|-------|----------------|---------|-------|-------------|
| A    | 325   | 0.03316        | 254.39421 | 5.00288E-35 | 0.99957 |
| km   | 8.43667 | 0.03316        | 254.39421 | 5.00288E-35 | 0.99957 |
| k    | 0.07231 | 0.007          | 90.01794  | 5.39792E-27  | 0.99046 |
| c    | 1.97517 | 0.1426         | 13.85121  | 2.21628E-11  | 0.9992 |
| c0   | 0.06017 | 2.74698E-4     | 210.03071  | 8.58066E-34  | 0.84502 |
| A0   | -149.92769 | 4.97217         |         |         |            |

In the case of overparameterization, you can fix different parameters to get multiple fit results and then compare the fit models statistically by Analysis:Fitting:Compare Models tool.

4.3.3.8 Fit Surface with User Defined Function

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Multi-peak Surface Fitting</td>
<td>• User-defined Fitting Functions</td>
</tr>
</tbody>
</table>

4.3.3.8.1 Summary

Origin provides a NonLinear Surface Fit tool to fit surface. Besides the built-in surface fitting functions, you can also create your own fitting functions in Fitting Function Builder.

In this tutorial, we will illustrate how to create a user-defined surface fitting function in Fitting Function Builder, and carry out nonlinear surface fit with it using NLFit tool.

Minimum Origin Version Required: Origin 2016 SR0

4.3.3.8.2 What You Will Learn

This tutorial will show you how to:
• Create a user-defined surface fitting function using the **Fitting Function Builder**.
• Carry out nonlinear surface fit with user-defined fitting function.

### 4.3.3.8.3 Steps

For this tutorial, we will define and use the following fitting function:

\[
z = z_0 + A_1 x + A_3 x^3 + B_1 y + B_3 y^3 + C x y + C_2 x^2 y + C_3 x y^2
\]

in which

- \( z \) is the dependent variable
- \( x \) and \( y \) are the independent variables
- and \( z_0, A_1, A_3, B_1, B_3, C, C_2, C_3 \) are all fitting parameters.

#### 4.3.3.8.3.1 Create a Surface Fitting Function

In this section, we will show how to create a user defined surface fitting function in the **Fitting Function Builder**. But there is an alternative tool **Fitting Function Organizer** which also can be used to create user defined surface fitting functions(open it by selecting Tools:Fitting Function Organizer or pressing F9).

1. Launch Origin and choose Tools:Fitting Function Builder (or press F8) to open the **Fitting Function Builder**.
2. In the Goal page, select **Create a New Function** and click Next.
3. In the Name and Type page, select Surface Fitting from Select or create a Category drop-down list since **Nonlinear Surface Fit** tool lanches functions in the Surface Fitting category only.
4. Enter a name “MyPolynomialSurface” in Function Name and select Expression for Function Type. Click Next.

5. In the Variables and Parameters page, enter the variable and parameter names as the image below and then click Next:
In the **Parameters** box, use comma ("," as delimiter.

6. In the **Expression Function** page, enter the equation below in **Function Body**:

\[ z0 + A1 \cdot x + A3 \cdot x^3 + B1 \cdot y + B3 \cdot y^3 + C \cdot x \cdot y + C2 \cdot x^2 \cdot y + C3 \cdot x \cdot y^2 \]
7. Give estimated initial values to the parameters according to this particular data and function.

1. You can also give different initial values each time before you actually carry out the fitting.

2. You can click the **Evaluate** button to quick check whether the function is valid (if it is valid, an actual value will be returned for z).

8. Click **Finish** to create this user defined fitting function. The .FDF file for it will be stored in the **User Files Folder**.

You can always modify the user defined fitting function later, either in the **Fitting Function Builder** (choose **Edit a User-defined Function** in **Goal** page), or in the **Fitting Function Organizer**.

---

4.3.3.8.3.2 Carry Out Surface Fitting
1. With a new workbook active, choose **Data: Connect to File: Text/CSV** and browse to `<Origin Program>\Samples\Curve Fitting` and import the file `PolynomialSurface.dat` (accept defaults in the **CSV Import Options** dialog).

2. Highlight column **C(Y)** and click the **Set as Z** button on the Mini Toolbar.

3. Keep worksheet **C(Z)** activated, then select **Analysis:Fitting:Nonlinear Surface Fit** to open the **NLFit** dialog.

4. In the **Function Selection** page, you can see that **Category** is read only and set as **Surface**. Set **Function** as `MyPolynomialSurface(User)`.

5. Click the **Fit** button to carry out the fit.

6. A report sheet will be generated, in which the fitted value of all parameters are reported in the parameters table. A **FitSurfaceCurve** worksheet is added to the source workbook as well, in which the data of fitted...
surface is stored.

7. Activate the source worksheet and highlight col(C). Click the button to generate a 3D scatter plot. To add the fitted surface to the source data, double click on the Layer 1 icon. In the Layer Contents dialog that opens, set the drop-down list in the upper-left corner to Worksheets in Folder. Select FitZ of FitSurfaceCurve1 worksheet in the panel below the drop-down, then click the menu button beside “A” in the middle of the dialog and change the plot type to 3D - Surface. Click on the rightward pointing arrow just below it to add the dataset to the right panel.
Click **OK** to add the surface to the source data graph.

![Graph](image)

**Note:**

A [Polynomial Surface Fit App](#) is available for Origin 2016 and higher. If you want to fit a polynomial surface, it is recommended to try this App first.

### 4.3.3.9 Fitting One Dataset as a Function of Other Datasets

#### 4.3.3.9.1 Summary

Sometimes, one may want to perform "Dataset Fitting", that is, the output may be composed of one or several datasets, like:

\[
Output = A_1 \times Dataset_1 + A_2 \times Dataset_2
\]

For example, you may want to analyze a composite spectrum to find the contributions/ratio from individual component spectra. This can be accomplished either by defining multiple independent variables or by calculating the "combination" inside the fitting function.

Minimum Origin Version Required: Origin 8.0 SR6

#### 4.3.3.9.2 What you will learn

This tutorial will show you how to:

- Perform "Dataset Fitting"
• Define multiple independent variable fitting function

4.3.3.9.3 Steps

Import the Composite Spectrum.dat file from the \Samples\Curve Fitting\ folder. In this sample data, we can see that column A is the index, columns B and C are the values for the spectrum of components A and B. Column D contains values obtained after reading a composite spectrum of components A and B. By fitting column D to an equation determined by the component spectra of the pure forms of columns B and C, the coefficients for the contributions of B and C (call them c1 and c2 respectively) can be found. (Note: In this case, we supposed the independent and dependent variables have the same size. If not, interpolation is need.)

Bring up the Fitting Function Organizer and define a new fitting function as follow:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>Multindep</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>a, b</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>ab</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>C1, C2</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
<tr>
<td>Function:</td>
<td>ab = C1<em>a + C2</em>b;</td>
</tr>
</tbody>
</table>

Initialize both C1 and C2 to 1 in the Parameter Initialization edit box by entering:
C1=1;
C2=1;

Save the fitting function and close Fitting Function Organizer. Highlight ONLY Column D and bring up the NLFit dialog, specify the input datasets in the Data Selection page as follow:
Then you can click the **Fit** button to generate results.

### 4.3.3.9.4 Results

You are supposed to get these results:

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>0.37169</td>
<td>0.00483</td>
</tr>
<tr>
<td>C2</td>
<td>0.66469</td>
<td>0.0047</td>
</tr>
</tbody>
</table>

To verify the fitted results, you can add a new column and Copy + Paste the fitted value, which comes from the fitted Y (col(C)) in the worksheet *FitNLCurve1*, into it. Then Highlight the Composite and the fitted data and plot a line graph to see how good the fit is:
4.3.3.10 Fitting With Multiple Independent Variables

**Summary**

The **Function Organizer** tool can be used to create user-defined functions with more than one independent or dependent variable. The **NLFit dialog** can then be used to fit with such functions. The preview window in the NLFit dialog is capable of plotting only one quantity versus another. However, even if the preview does not "make sense", the fitting process will correctly proceed, once proper data and parameter assignments have been made.

Note that if you wish to fit multiple independent variables with an equation of the type

\[ y = A_0 + A_1 \cdot x_1 + A_2 \cdot x_2 + \ldots \]

you can make use of the Multiple Regression tool instead of the nonlinear fitter dialog.

Minimum Origin Version Required: Origin 8.0 SR6

**What you will learn**
Tutorials for Origin 2024b

This tutorial will show you how to:

- Create a user-defined fitting function with two independent variables and one dependent variable
- Fit with that function in NLFit

### 4.3.3.10.3 Steps

1. Start with a new workbook and import the file \Samples\Curve_Fitting\Activity.dat.
2. Select **Tools: Fitting Function Organizer** from menu (or press **F9**) to bring up the **Fitting Function Organizer** and define a new fitting function named **MultiIndep** in **NewCategory** (create the category if it does not exist) as follow:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>MultiIndep</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>substr, inhib</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>act</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>ki, km, vm</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
<tr>
<td>Function:</td>
<td>double mix = inhib / ki; act = vm * substr / (km + (1 + mix) * substr);</td>
</tr>
</tbody>
</table>

3. **NOTE:** Since we are using OriginC, case must match between defined names and their use in the function definition. e.g. Substr does NOT equal substr.

4. Click Save and then OK to save the function and close the Organizer.

5. For more details about User Defined Fitting Function please refer to [User Defined Fitting Function using Origin C](#).

6. Highlight ONLY column C and select **Analysis: Fitting: Non-linear Curve Fit** from menu to bring up the NLFit dialog. Select the function **MultiIndep** from **NewCategory** on the **Settings: Function Selection**
Set the input datasets in the **Data Selection** page as follow:

7. Select the **Fitted Curves** page and expand the **Fitted Curves Plot** branch. Then select **Same as Input Data** from the drop-down list next to the **X Data Type** branch.
8. Select **Parameters Tab** and set the initial values as follow:

![Parameter table]

9. Click **Fit** button to generate the fitting reports. You can see these results from the report worksheet as below:

- **Parameters**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k_i$</td>
<td>0.0373</td>
<td>0.00233</td>
</tr>
<tr>
<td>$k_m$</td>
<td>7.30567</td>
<td>0.71748</td>
</tr>
<tr>
<td>$v_m$</td>
<td>653.116</td>
<td>22.39698</td>
</tr>
</tbody>
</table>

- **Statistics**

<table>
<thead>
<tr>
<th>Activity</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Points</td>
<td>18</td>
</tr>
<tr>
<td>Degrees of Freedom</td>
<td>15</td>
</tr>
<tr>
<td>Reduced Chi-Sqr</td>
<td>155.36102</td>
</tr>
<tr>
<td>Residual Sum of Squares</td>
<td>2330.41531</td>
</tr>
<tr>
<td>Adj. R-Square</td>
<td>0.98357</td>
</tr>
<tr>
<td>Fit Status</td>
<td>Succeeded(100)</td>
</tr>
</tbody>
</table>

From the Statistics table we can know that the fitting is fairly successful.

4.3.3.11 **User Defined Fitting Function using GNU Scientific Library**

This article demonstrates how to use GSL function as fit function.

**Minimum Origin Version Required: Origin 8.0 SR6**

1. We will fit the sample Data below by the following model:

\[ y = y_0 + a \int_0^x \! e^{\beta \cdot t} \, dt \]

<table>
<thead>
<tr>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.10517</td>
</tr>
<tr>
<td>0.2</td>
<td>0.2214</td>
</tr>
<tr>
<td>0.3</td>
<td>0.34986</td>
</tr>
<tr>
<td>0.4</td>
<td>0.49182</td>
</tr>
<tr>
<td>0.5</td>
<td>0.64872</td>
</tr>
<tr>
<td>0.6</td>
<td>0.82212</td>
</tr>
<tr>
<td>0.7</td>
<td>1.01375</td>
</tr>
<tr>
<td>0.8</td>
<td>1.22554</td>
</tr>
<tr>
<td>0.9</td>
<td>1.4596</td>
</tr>
</tbody>
</table>
1   1.71828  
1.1  2.00417  
1.2  2.32012  
1.3  2.6693   
1.4  3.0552   
1.5  3.48169  
1.6  3.95303  
1.7  4.47395  
1.8  5.04965  
1.9  5.68589  
2  6.38906   
2.1  7.16617  
2.2  8.02501  
2.3  8.97418  
2.4 10.02318  
2.5 11.18249  
2.6 12.46374  
2.7 13.87973  
2.8 15.44465  
2.9 17.17415  
3  19.08554   
3.1 21.19795  
3.2 23.53253  

2. Add the file `ocgsl.h` in (User Files folder), before next step, make sure the gsl dlls are copied to this same location, see Calling GNU Scientific Library.

`ocgsl.h`

```c
#pragma dll(libgsl, header)

// this is OC special pragma,

// header keyword is to indicate libgsl.dll is in same location as this file

#define GSL_EXPORT // for OC, this is not needed, so make it empty
```

Data Analysis
// you can directly search and copy gsl function prototypes here

typedef double (* FUNC)(double x, void * params);

struct gsl_function_struct
{
    FUNC function;
    void * params;
};

typedef struct gsl_function_struct gsl_function;

typedef struct
{
    size_t limit;
    size_t size;
    size_t nrmax;
    size_t i;
    size_t maximum_level;
    double *alist;
    double *blist;
    double *rlist;
};
double *elist;

size_t *order;

size_t *level;

} gsl_integration_workspace;

GSL_EXPORT gsl_integration_workspace *gsl_integration_workspace_alloc (const size_t n);

GSL_EXPORT void gsl_integration_workspace_free (gsl_integration_workspace * w);

GSL_EXPORT int gsl_integration_qag (const gsl_function * f,

        double a, double b,

        double epsabs, double epsrel, size_t limit,

        int key,

        gsl_integration_workspace * workspace,

        double *result, double *abserr);

3. Press F9 to open the **Fitting Function Organizer** and then add a new function as follows:
4. Press the button on the right hand side of the Function Field to open the code builder and add the following codes and compile: 

```c
#include "..\cgsl.h"

static double f_callback(double x, void * params)
{
    double alpha = *(double *)params;
    return exp(alpha*x);
}
```
void _nlsfgsl_integration_qag{

    // Fit Parameter(s):
    double y0, double a, double beta,

    // Independent Variable(s):
    double x,

    // Dependent Variable(s):
    double& y

} // Beginning of editable part

double result, err, expected = -4.0;

// Allocates a workspace sufficient to hold 1000 double precision intervals,
// their integration results and error estimates

gsl_integration_workspace *ww = gsl_integration_workspace_alloc(1000);

gsl_function F;

    F.function = f_callback;

    F.params = &beta ;

// integral interval (0, x), within the desired absolute
// error 0 and relative error 1e-7

gsl_integration_qag(&F, 0, x, 0, 1e-7, 1000, 0, ww, &result, &err);
// frees the memory associated with the workspace w

gsl_integration_workspace_free (ww);

    y = y0 + a*result;

    // End of editable part

}

Furthermore, a more elaborate but efficient version of the fitting function is given as follows

// ----------------------------------------------------------------------------

//

#include <ONLSF.h>

#include "../cgsl.h"

static double f_callback(double x, void * params)
{
    double alpha = *(double *)params;

    return exp(alpha*x);
}

void _nlsfgsl_integration_qag(

    // Fit Parameter(s):

}
double y0, double a, double beta,

// Independent Variable(s):

double x,

// Dependent Variable(s):

double& y

{

    // Beginning of editable part

    NLFitContext *pCtx = Project.GetNLFitContext();
    if ( pCtx )
    {

        static vector vInteg;
        NLSFCURRINFO stCurrInfo;
        pCtx->GetFitCurrInfo(&stCurrInfo);
        int nCurrentIndex = stCurrInfo.nCurrDataIndex;

        BOOL bIsNewParamValues = pCtx->IsNewParamValues();
        if ( bIsNewParamValues )
        {

            vector vx;
            pCtx->GetIndepData(&vx);
            int nSize = vx.GetSize();

        }
    }
}
vInteg.SetSize(nSize);

// Allocates a workspace sufficient to hold 1000 double precision intervals,

// their integration results and error estimates

gsl_integration_workspace *ww =
gsl_integration_workspace_alloc(1000);

gsl_function F;
F.function = f_callback;
F.params = &beta;

double result, err, expected = -4.0;

for(int ii=0; ii<nSize; ++ii)
{

    // integral interval (0, vx[ii]), within the desired absolute error 0 and relative error 1e-7

    gsl_integration_qag(&F, 0, vx[ii], 0, 1e-7, 1000, 0, ww, &result, &err);

    vInteg[ii] = result;

}

// frees the memory associated with the workspace w
Data Analysis

```c

// End of editable part

5. Add the following initialization codes:

Parameter Init

// Code to be executed to initialize parameters

sort( x_y_curve );

double coeff[2];

fitpoly( x_y_curve, 1, coeff);

a = coeff[0];

y0 = coeff[1];

beta=1.0

6. Fit using the user-defined function `gsl_integration_qag`, here are the results:

y0 = -1.06363E-6
a = 1
beta =1
```
4.3.3.12 Fitting with NAG Special Function

4.3.3.12.1 Summary

Origin allows user to define an Origin C fitting function using NAG special functions. You can call NAG routine to evaluate the special function.

Minimum Origin Version Required: Origin 8.0 SR6

4.3.3.12.2 What you will learn

This tutorial will show you how to:

- Create fitting function using Fitting Function Organizer
- Create fitting function using NAG special function

4.3.3.12.3 Example and Steps

We will fit the following model:

\[ \text{inorm} = A \times \exp\left(-td/2.0/(t-t0)\right) \times \left(I_0(td/2.0/(t-t0)) + I_1(td/2.0/(t-t0))\right) \]

Here \( A, td \) and \( t0 \) are the model parameters we want to obtain from the data fitting. \( I_0 \) and \( I_1 \) are the first kind of Modified Bessel function of order 0 and order 1, respectively. For current example, we use the sample data in the end of this tutorial. The fitting procedure can be outlined into the following steps:

Press F9 to open the Fitting Function Organizer and then create a new Category named FittingWithNAGSpecialFunc. Define a new fitting function FittingWithBessel in the new category as follow:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>FittingWithBessel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>t</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>inorm</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>A,t0,td</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
<tr>
<td>Function:</td>
<td></td>
</tr>
</tbody>
</table>

Click the button (icon) beside the Function box to open the code builder and define and compile and save the fitting function as follows:

```
#include <origin.h>
```
// Add your special include files here.

// For example, if you want to fit with functions from the NAG library,

// add the header file for the NAG functions here.

#include <OC_nag8.h>

// Add code here for other Origin C functions that you want to define in this file,

// and access in your fitting function.

// You can access C functions defined in other files, if those files are loaded and compiled

// in your workspace, and the functions have been prototyped in a header file that you have

// included above.

// You can access NLSF object methods and properties directly in your function code.

// You should follow C-language syntax in defining your function.

// For instance, if your parameter name is P1, you cannot use p1 in your function code.

// When using fractions, remember that integer division such as 1/2 is equal to 0, and not 0.5

// Use 0.5 or 1/2.0 to get the correct value.
// For more information and examples, please refer to the "User-Defined Fitting Function" section of the Origin Help file.

//---------------------------------------------------------------------

//

void _nlsfFittingWithBessel(

// Fit Parameter(s):

double A, double t0, double td,

// Independent Variable(s):

double t,

// Dependent Variable(s):

double& inorm)

{

    // Beginning of editable part

    //inorm =  A* exp(-td/2.0/(t-t0)) * ( s18aec(td/2.0/(t-t0),NAGERR_DEFAULT)+s18afc(td/2.0/(t-t0),NAGERR_DEFAULT) );

    static NagError fail1;

    static NagError fail2;
```c
double dtemp = td/2.0/(t-t0);

inorm = A* exp(-dtemp) * ( sl8aec(dtemp,&fail1)+sl8afc(dtemp,&fail2) );

if(fail1.code != NE_NOERROR)
    printf("%sn",fail1.message);

if(fail2.code != NE_NOERROR)
    printf("%sn",fail2.message);

// End of editable part
```
Tutorials for Origin 2024b

4.3.3.13 Fitting Integral Function with parametric limit using NAG Library

4.3.3.13.1 Summary

Before you start delving into this tutorial, you are recommended to read the relevant tutorial in Fitting with Integral using NAG Library. And as far as programming is concerned, the two tutorials are basically the same, except that here you will learn to define Origin C fitting function with fitting parameters in the integral limit, while in the previous tutorial we in fact define a fitting independent variable in the integral limit. Also note that a different NAG integrator is used here.

Minimum Origin Version Required: Origin 8.0 SR6

4.3.3.13.2 What you will learn

This tutorial will show you how to:

- Create a fitting function with Definite Integral using the NAG integration routine
- Create a fitting function with a parametric integral limit
- Use a log function to scale a large return value from the fitting function

<table>
<thead>
<tr>
<th>2</th>
<th>0.7868954118</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.080808081</td>
<td>0.8133022141</td>
</tr>
<tr>
<td>2.161616162</td>
<td>0.8178216765</td>
</tr>
<tr>
<td>2.242424242</td>
<td>0.8427866729</td>
</tr>
<tr>
<td>2.323232323</td>
<td>0.8315815363</td>
</tr>
<tr>
<td>2.404040404</td>
<td>0.8484657180</td>
</tr>
<tr>
<td>2.565656566</td>
<td>0.8618233553</td>
</tr>
<tr>
<td>2.646464646</td>
<td>0.8745962570</td>
</tr>
<tr>
<td>2.727272727</td>
<td>0.8921620316</td>
</tr>
<tr>
<td>2.808080808</td>
<td>0.8687399759</td>
</tr>
</tbody>
</table>
4.3.3.13.3 Example and Steps

For example, we will fit the sample data at the bottom of this page with the following model:

\[ y = \int_c^d \frac{\cosh \left( \left( x_i + b^2 \cdot x^2 \right)/(b + x) \right)}{a + (x_i^2 + x^2)} \, dx_i \]

Note that we use \( x_i \) to indicate the integral independent variable while \( x \) indicates the fitting independent variable. The model parameters \( a, b, c, \) and \( d \) are fitted parameters we want to obtain from the sample data. To prepare the data, you just need to copy the sample data to an Origin Worksheet. The fitting procedure is similar to the previous tutorial:

4.3.3.13.3.1 Define Fitting Function in Fitting Function Organizer

Press F9 to open the Fitting Function Organizer and add the User-Defined integral fitting function nag_integration_fitting_cosh to the Category FittingWithIntegral, similar to the first tutorial.

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>nag_integration_fitting_cosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>x</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>y</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>a, b, c, d</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
</tbody>
</table>

Click the button beside the Function box to open the code builder and define and compile the fitting function as follows: (Note: Remember to save the Function after compiling it and returning to the Function Organizer Dialog):

```c
#include <origin.h>

// Add your special include files here.

// For example, if you want to fit with functions from the NAG library,

// add the header file for the NAG functions here.

#include <OC_nag.h>
```
// Add code here for other Origin C functions that you want to define in this file,
// and access in your fitting function.

struct user
{
    double a, b, fitX; // fitX the independent variable of fitting function
};

static double NAG_CALL f_callback(double x, Nag_User *comm) // x is the independent variable of the integrand
{
    struct user *sp = (struct user *)(comm->p);

    double aa, bb, fitX; // temp variable to accept the parameters in the Nag_User communication struct

    aa = sp->a;
    bb = sp->b;
    fitX = sp->fitX;

    return cosh((x*x+bb*bb*fitX*fitX)/(bb+fitX))/(aa+(x*x+fitX*fitX));
// You can access C functions defined in other files, if those files are loaded and compiled

// in your workspace, and the functions have been prototyped in a header file that you have

// included above.

// You can access NLSF object methods and properties directly in your function code.

// You should follow C-language syntax in defining your function.

// For instance, if your parameter name is P1, you cannot use p1 in your function code.

// When using fractions, remember that integer division such as 1/2 is equal to 0, and not 0.5

// Use 0.5 or 1/2.0 to get the correct value.

// For more information and examples, please refer to the "User-Defined Fitting Function"

// section of the Origin Help file.

//-------------------------------

//

void _nlsfnag_integration_fitting_cosh
/ Fit Parameter(s):

double a, double b, double c, double d,

// Independent Variable(s):

double x,

// Dependent Variable(s):

double& y)
{

    // Beginning of editable part

double epsabs = 0.00001, epsrel = 0.0000001, result, abserr;

Integer max_num_subint = 500;

    // you may use epsabs and epsrel and this quantity to enhance your desired precision

    // when not enough precision encountered

    Nag_QuadProgress qp;

    static NagError fail;

    // the parameters parameterize the integrand can be input to the call_back function
     // through the Nag_User communication struct

    Nag_User comm;

    struct user s;

    s.a = a;
s.b = b;

s.fitX = x;

comm.p = (Pointer)&s;

d01sjc(f_callback, c, d, epsabs, epsrel, max_num_subint, &result, &abserr, &qp, &comm, &fail);

// you may want to exam the error by printing out error message, just uncomment the following lines

// if (fail.code != NE_NOERROR)

// printf("%s\n", fail.message);

// For the error other than the following three errors which are due to bad input parameters

// or allocation failure  NE_INT_ARG_LT  NE_BAD_PARAM  NE_ALLOC_FAIL

// You will need to free the memory allocation before calling the integration routine again to
// avoid memory leakage

if (fail.code != NE_INT_ARG_LT && fail.code != NE_BAD_PARAM && fail.code != NE_ALLOC_FAIL)
{

  NAG_FREE(qp.sub_int_beg_pts);
}
In the above code, we define the integrand as a callback function \texttt{f_callback} just outside the fitting function body \_\texttt{nlsfnag_integration_fitting_cosh}. Note that we parametrize the integrand function with the variables \texttt{a, b} and \texttt{fitX}, and pass them into the callback function through the \texttt{Nag_User} struct. After that we perform the integration using NAG integrator \texttt{d01sjc}. Besides, you can also use other Quadrature Routines as you want. In the current example, we also use a log scale for the fitting function. (The sample data are already scaled by a log function)

Compile the code, return to the dialog and then Save the fitting function in the function Organizer and open the Nonlinear Curve Fit dialog in the Analysis-Fitting menu. You can then select this user-defined fitting function in the Function Selection page under Setting Tab.

4.3.3.13.3.2 Set the Initial Values for the Parameters

Similarly, as it is a user-defined fitting function, you have to supply the initial guess values for the parameters. You may manually set them in the Parameter tab in Nonlinear Curve Fit dialog. For current example, you can just set the initial values for the parameters \(a = 1, b = 10, c = 3, d = 4\). After the parameters are initialized, you can perform the fitting to obtain the fitting result, as shown in the following.

4.3.3.13.4 Sample Data

<table>
<thead>
<tr>
<th>Sample Data</th>
<th>Results</th>
</tr>
</thead>
</table>

250
Data Analysis

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Y</td>
</tr>
<tr>
<td>-5</td>
<td>498.19046</td>
</tr>
<tr>
<td>-4.33333</td>
<td>329.43196</td>
</tr>
<tr>
<td>-3.66667</td>
<td>210.28005</td>
</tr>
<tr>
<td>-3</td>
<td>126.55799</td>
</tr>
<tr>
<td>-2.33333</td>
<td>69.01544</td>
</tr>
<tr>
<td>-1.66667</td>
<td>31.3555</td>
</tr>
<tr>
<td>-1</td>
<td>9.1393</td>
</tr>
<tr>
<td>-0.33333</td>
<td>-0.84496</td>
</tr>
<tr>
<td>0.33333</td>
<td>-0.99914</td>
</tr>
<tr>
<td>1</td>
<td>6.86736</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>0.99303</td>
<td>0.06577</td>
</tr>
<tr>
<td>b</td>
<td>10</td>
<td>5.3108E-6</td>
</tr>
<tr>
<td>c</td>
<td>3.00083</td>
<td>0.0062</td>
</tr>
<tr>
<td>d</td>
<td>4.00022</td>
<td>9.38713E-4</td>
</tr>
</tbody>
</table>

4.3.3.14 Fitting with Integral using NAG Library

4.3.3.14.1 Summary

Origin allows user to define an Origin C fitting function which involves an integral. You can call NAG functions to perform the integration while defining the fitting function. There are built-in functions in Origin C which perform integration. For the current example, the NAG solution is recommended. It has a better performance compared to the built-in integration algorithm. Note that an infinite NAG integrator is used here.

Minimum Origin Version Required: Origin 8.0 SR6

4.3.3.14.2 What you will learn

This tutorial will show you how to:

- Create a fitting function using the Fitting Function Organizer
- Create a fitting function with a Definite Integral using a NAG integration routine
- Set up the Initial Code for the fitting function
4.3.3.14.3 Example and Steps

We will fit the following model:

\[ y = y_0 + \int_{-\infty}^{x} \frac{A}{\sqrt{\pi w}} e^{-\frac{(t-x_c)^2}{w^2}} dt \]

Here \( y_0, A, x_c \) and \( w \) are the model parameters we want to obtain from the data fitting. The fitting procedure can be outlined into the following steps:

4.3.3.14.3.1 Define the Function

Press \( \text{F9} \) to open the Fitting Function Organizer and then create a new Category named \( \text{FittingWithIntegral} \). Define a new fitting function \( \text{nag_integration_fitting} \) in the new category as follow:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>nag_integration_fitting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>x</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>y</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>( y_0, A, x_c, w )</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
<tr>
<td>Function:</td>
<td></td>
</tr>
</tbody>
</table>

Click the \( \text{button} \) beside the Function box to open the code builder then follow the steps below:

1. Scroll up to go to line

\[
//\text{add the header file for the NAG functions here.}
\]

2. and paste the following code below this line.

\[
\text{#include}<\text{OC\_nag}\_\text{h}>
\]

3. Go to line
4. and paste the following code below.

```c
struct user  // parameters in the integrand
{
    double amp, center, width;
}

// Function supplied by user, return the value of the integrand at a given x.
static double NAG_CALL f_callback(double x, Nag_User *comm)
{
    struct user *sp = (struct user *) (comm->p);
    double amp, center, width;  // temp variable to accept the parameters in the Nag_User communication struct
    amp = sp->amp;
    center = sp->center;
    width = sp->width;

    return amp * exp(-2*(x - center)*(x - center)/width/width) / (width*sqrt(PI/2));
}
```
5. Go to line

```cpp
// Beginning of editable part.
```

6. and paste the following code below.

```cpp
// Through the absolute accuracy epsabs, relative accuracy epsrel and max_num_subint you can

    // control the precision of the integration you need
    // if epsrel is set negative, the absolute accuracy will be used.
    // Similarly, you can control only relative accuracy by set the epsabs negative

    double epsabs = 0.0, epsrel = 0.0001;

    // The max number of sub-intervals needed to evaluate the function
    // in the integral
    // The more difficult the integrand the larger max_num_subint should be

    Integer max_num_subint = 200;

    // Result keeps the approximate integral value returned by the algorithm
    // abserr is an estimate of the error which should be an upper bound for the |I - result|

    double result, abserr;
```
// The structure of type Nag_QuadProgress,
// it contains pointers allocated memory internally with max_num_subint elements

Nag_QuadProgress qp;

// The NAG error parameter (structure)
static NagError fail;

// Parameters passed to integrand by Nag_User communication struct

Nag_User comm;

struct user s;

s.amp = A;

s.center = xc;

s.width = w;

comm.p = (Pointer)&s;

// Perform integration

// There are 3 kinds of infinite boundary types you can use in Nag
// infinite integrator

// Nag_LowerSemiInfinite, Nag_UpperSemiInfinite, Nag_Infinite
d01smc(f_callback, Nag_LowerSemiInfinite, x, epsabs, epsrel,
max_num_subint, &result, &abser, &qp, &comm, &fail);

    // you may want to exam the error by printing out error
message, just uncomment the following lines

    // if (fail.code != NE_NOERROR)

        // printf("%s\n", fail.message);

    // For the error other than the following three errors which are
due to bad input parameters

    // or allocation failure NE_INT_ARG_LT NE_BAD_PARAM
NE_ALLOC_FAIL

    // You will need to free the memory allocation before calling the
integration routine again to avoid memory leakage

    if (fail.code != NE_INT_ARG_LT && fail.code != NE_BAD_PARAM &&
fail.code != NE_ALLOC_FAIL)

    {

        NAG_FREE(qp.sub_int_beg_pts);

        NAG_FREE(qp.sub_int_end_pts);

        NAG_FREE(qp.sub_int_result);

        NAG_FREE(qp.sub_int_error);

    }

    // Calculate the fitted value
7. Click **Compile** to compile the file.

In the above code, we firstly define the integrand as a callback function `f_callback` just outside the fitting function body `_nlsfag_integration_fitting`. Note that we parametrize the integrand function with the variables `amp, center` and `width`, and pass them into the callback function through the `Nag_User` struct. Inside the fitting function, we perform the integration using NAG integrator `d01smc`.

Calling NAG functions should be more efficient than writing your own routines. Using an analogous method, you can perform finite, infinite, one-dimension and multi-dimension quadrature in your fitting function. Please read the NAG Quadrature page and select a proper routine.

### 4.3.3.14.3.2 Set the Initial Values for the Parameters or Setup the Initial Code

As it is a user-defined fitting function, you have to supply the initial guess values for the parameters. You may do it later by setting them manually in the **Parameter** tab in Nonlinear Curve Fit dialog.

### 4.3.3.14.3.3 Simulate the Function

After entering the function body codes, you can click the **Compile** button in **Code Builder** to check syntax errors. And then click **Return to Dialog** button to go back **Fitting Function Organizer** dialog box. Now click the **Save** button to generate the .FDF file (Function definition file).

Once you have a .FDF file, you can click the **Simulate** button to simulate a curve, this will be very helpful to evaluate the initial values. In the **simcurve** dialog, enter some proper parameter values and X range, and see what the curve looks like in the **Preview** panel.

### 4.3.3.14.3.4 Fit the Curve

Before you start to fit the curve, it is very helpful to simulate the function first. Performing integration may take some time, if there is any mistake, you may see Origin "freeze" after you click the **Fit** button. So in the **Fitting Function Organizer** dialog, select the function we defined and click the **Simulate** button. This will bring up the **simcurve** X-Function. Enter some "guess" values and click the **Apply** button. If the simulated curve looks like your source data, you can go further to fit.

To test the fitting function:

1. Import \Samples\Curve Fitting\Replicate Response Data.dat to Origin.
2. Next we are going to use log scale of the data in Col(A). To do this, in the \( F(x) = \) column label row of column A, type in the formula `Col(A) = log(Col(A))` and hit **Enter** once to change the data.
3. Highlight column A and B and create a scatter plot, the shape is a sigmoid curve.
4. Bring up the **NLFit** dialog from **Analysis: Fitting: Nonlinear Curve Fit** menu item.
5. Select the fitting function we defined in the previous sections and go to the **Parameters** tab, initialize all parameters by 1 and fit (click **Fit** button).
6. You are supposed to see these results:

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>( y_0 )</td>
<td>-0.00806</td>
<td>0.18319</td>
</tr>
<tr>
<td>( A )</td>
<td>3.16479</td>
<td>0.39624</td>
</tr>
</tbody>
</table>
4.3.3.15 Fitting with Integral using LabTalk Function

4.3.3.15.1 Summary

Since version **Origin 8.6**, Origin introduces a new LabTalk function, **integral()**, to do one-dimensional integration. This function returns the integral value of:

\[
\int_{\text{Lower Limit}}^{\text{Upper Limit}} f(t, \text{arg1, arg2, ...}) \, dt
\]

And the interface of the **integral()** function is defined as below:

\[
\text{integral(integrandName, LowerLimit, UpperLimit [, arg1, arg2, ...])}
\]

Where **integrandName** here is the function name of the integrand:

\[
f(t, \text{arg1, arg2, ...})
\]

In other word, the **integral()** function do the following things:

- Accept another function (the first argument) as the integrand.
- Perform integration on specified lower and upper limit and return the integral value.
- If need, pass the subsequent arguments (**Arg1, Arg2, ...**) into the integrand function.

Using this feature, we can define a fitting function with **integral()** function, and pass proper fitting parameters to the integrand, to do integration in curve fitting.

In this tutorial, we will modify the other tutorial, calling NAG functions to do integration during fitting, into LabTalk form, and show you how simple and straightforward to fit an integration function.

**Minimum Origin Version Required: Origin 8.6**

Beginning with Origin 2018b, you can define a an implicit function using integrals

4.3.3.15.2 What you will learn

This tutorial will show you how to:

- Create a fitting function using the Fitting Function Builder
- Create a fitting function with a Definite Integral using Labtalk function
- Set up the Initial Code for the fitting function
4.3.3.15.3 Example and Steps

4.3.3.15.3.1 The Fitting Model

The fitting model is described as below:

\[ y = y_0 + \int_{-\infty}^{x} \frac{A}{w \sqrt{\frac{\pi}{2}}} e^{-2 \left( \frac{(t-x_0)^2}{w^2} \right)} \, dt \]

There are four parameters in the fitting function, and we need to pass three of them into the integrand, and use the independent variable as upper limit, to do integration. So you should define the integrand first, and then use the `integral()` function to perform integration inside your fitting function body.

4.3.3.15.3.2 Define the Function

1. Press F8 to open Fitting Function Builder dialog. Make sure choosing Create a New Function option, and click Next to navigate to the next page.
2. In the Name and Type page, enter a function name, say `MyIntegGauss`. Leave the default function type as Expression, and then check the Include Integration During Fitting checkbox. This will lead you to a new page in the next step.

3. In the Integrand page, you can define the expression of the integrand. Currently, Origin supports one-dimensional integral only, so the integrand should have ONE integration variable. In this example, the expression of the integrand is:

\[ \frac{A}{w \sqrt{\frac{\pi}{2}}} e^{-2 \left( \frac{(t-x_0)^2}{w^2} \right)} \]
The other variables, like \( x_c \), \( w \), and \( A \), are parameters of the integrand. To distinguish from fitting parameters, we named them Arguments here, and use the arguments name \( ixc \), \( iw \), and \( iA \) instead. Later, we can pass fitting parameters into these arguments. So, the integrand definition should looks like:

Note that this is a LabTalk function. To get the integration value, you must have a **RETURN** statement in the function body. And the integrand expression in this example should be:

```
return iA * exp(-2*(t-ixc)^2/iw^2) / (iw*sqrt(PI/2));
```

4. When all set, click **Next** to go to the **Variables and Parameters** page to define the variables and parameters for the fitting function as below:
5. The next **Function** page is where you define the fitting function body. Once you choose to include integration in your fitting function at the beginning of the fitting function builder wizard, there is an extra tab, **Integrand**, shown on this page. In this tab, you can map the fitting variables and parameters with elements of the integrand, including lower limit, upper limit, and integrand arguments. And in this example, we will map the variables as below:

<table>
<thead>
<tr>
<th>Integrand elements</th>
<th>Values pass into integrand</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower Limit</td>
<td>-inf</td>
</tr>
<tr>
<td>Upper Limit</td>
<td>x</td>
</tr>
<tr>
<td>ixc</td>
<td>xc</td>
</tr>
<tr>
<td>iw</td>
<td>w</td>
</tr>
</tbody>
</table>
6. Once set up all the mappings as above table, click the **Insert** button, then well prepared `integral()` function is inserted into the **Function Body** box as:

```
integral(MyIntegrand, -inf ,x ,xc ,w ,A)
```

7. This expression means perform integration on the function, whose name is `MyIntegrand`, from negative infinite to `x`, and pass the three fitting parameters, `xc`, `w`, and `A` to the integrand.

8. By adding the constant parameter, `y0`, into the expression, the whole fitting function body should be:

```
y0 + integral(MyIntegrand, -inf, x, xc ,w ,A);
```

9. And the page may looks as below:

![Fitting Function Builder - Expression Function - MyIntegGauss](image)

11. Then active the **Parameters** tab, and give some proper initial values for each fitting parameters as:
Now, you can click **Finish** button to save this fitting function.

### 4.3.3.15.3.3 Fit the Curve

Copy and paste the following data into Origin worksheet:

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1.69897</td>
<td>0.13136</td>
</tr>
<tr>
<td>-1.22185</td>
<td>0.34384</td>
</tr>
<tr>
<td>-0.92082</td>
<td>0.6554</td>
</tr>
<tr>
<td>-0.82391</td>
<td>0.73699</td>
</tr>
<tr>
<td>-0.69897</td>
<td>1.00157</td>
</tr>
<tr>
<td>0</td>
<td>1.70785</td>
</tr>
<tr>
<td>0.30103</td>
<td>2.31437</td>
</tr>
<tr>
<td>0.69897</td>
<td>2.77326</td>
</tr>
<tr>
<td>1</td>
<td>2.79321</td>
</tr>
</tbody>
</table>

Highlight the **Y** column, and press **Ctrl + Y** to open the **NLFit** dialog. Select the function you just defined, and click **Fit** button to perform fitting. The fitting result should be the same like using NAG function directly.
4.3.3.16 Fitting with Two Integrals using LabTalk Function

### 4.3.3.16.1 Summary

In some circumstance, one may want to create fitting function with multiple integrals:

$$\int_{L1}^{U1} f(t, arg1, arg2, \ldots) \, dt + \int_{L2}^{U2} g(x, arg3, arg4, \ldots) \, dx$$

We refer to [Fitting with Integral using LabTalk Function](#) for detailed description of parameters in the expression.

In version Origin 8.6, however, [Fitting Function Builder](#) just supports one integral in fitting function. Bypassing complex Origin C code, we can use [Fitting Function Organizer](#) to reach the goal.

In this tutorial, we will show you how to create a fitting function comprised of two integrals using function organizer. Of course, one can include more integrals as desired.

Minimum Origin Version Required: Origin 8.6

Beginning with Origin 2018b, you can define a an implicit function using integrals.

### 4.3.3.16.2 What you will learn

This tutorial will show you how to:

- Create a fitting function using the Fitting Function Organizer
- Create a fitting function with two integrals using LabTalk function

### 4.3.3.16.3 Example and Steps

#### 4.3.3.16.3.1 The Fitting Model

The fitting model is described as below:

$$y = y_0 + \int_{-5}^{x} A \, t \, dt - \int_{-\infty}^{x} B \, t \, \exp(-t^2/w^2) \, dt$$
There are four parameters in the fitting function, and we need to pass three of them into the integrand, and use the independent variable as upper limit, to do integration.

4.3.3.16.3.2 Define the Function

1. Press F9 to open Fitting Function Organizer dialog. Add a new function by pressing New Function after you select a category in which you want to put your function. One can also add new category by pressing the New Category button.

2. Specify the function name in the Function Name edit box as you like. Define Independent Variables, Dependent Variables and Parameter Names in corresponding edit box.

3. Select the Function Form in the drop box. One can find explanations in the Hints tab at the bottom of the dialog.
4. In the **Function** edit box, define your fitting function. The integrals are written in the form of LabTalk **integral** function.

\[ y = \text{integral}(\text{polyint}, -5, x, a) - \text{integral}(\text{gaussint}, -\infty, x, b, wc) + y0 \]

5. As described in **Fitting with Integral using LabTalk Function**, \( x, a, b \) and \( wc \) are parameters passed into the integrand functions.

6. Press the button at the right corner of **Parameter Settings** box to active **Parameter Settings** dialog. Set initial values as well as other constraints such as lower bounds, upper bounds for each parameter.
7. Define the two integrals in the **LabTalk Functions Definition and Initializations** box. In this case, the functions should be:

```c
function double polyint(double t, double ia)
{
    return ia*t;
}
```
function double gaussint(t, ib, iwc)
{
    return ib * t * exp(-t^2/iwc^2);
}

8. We have successfully set our two integrals fitting function. You can set other information in corresponding box. Do not forget to Save your fitting function after you finish.

4.3.3.16.3.3 Fit the Curve

Copy and paste the following data into Origin worksheet:

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>-3</td>
<td>2.47613</td>
</tr>
<tr>
<td>-2.6</td>
<td>2.24016</td>
</tr>
<tr>
<td>-2.2</td>
<td>2.01543</td>
</tr>
<tr>
<td>-1.8</td>
<td>1.83094</td>
</tr>
<tr>
<td>-1.5</td>
<td>1.85038</td>
</tr>
<tr>
<td>-1.1</td>
<td>2.17725</td>
</tr>
<tr>
<td>-0.9</td>
<td>2.44967</td>
</tr>
<tr>
<td>-0.7</td>
<td>2.61423</td>
</tr>
<tr>
<td>-0.5</td>
<td>3.02305</td>
</tr>
<tr>
<td>-0.3</td>
<td>3.23057</td>
</tr>
<tr>
<td>-0.1</td>
<td>3.37822</td>
</tr>
</tbody>
</table>
Highlight the Y column, and press CTRL + Y to open the **NLFit** dialog. Select the function you just defined, and click fit button to perform fitting.

### Parameters

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a</td>
<td>0.26191</td>
</tr>
<tr>
<td></td>
<td>b</td>
<td>3.5282</td>
</tr>
<tr>
<td>wc</td>
<td></td>
<td>1.07153</td>
</tr>
<tr>
<td>y0</td>
<td>4.57942</td>
<td>0.29938</td>
</tr>
</tbody>
</table>

Reduced Chi-sqr = 0.00376913022391
COD(R^2) = 0.98854435477482
Total Iterations in Session = 7
Fit converged. Chi-Sqr tolerance value of 1E-9 was reached.

### 4.3.3.17 Fitting with Summation

#### 4.3.3.17.1 Summary

We have showed you how to perform fitting with an integral using the **NAG Library**, and now you'll learn how to do that without calling NAG functions. In this tutorial, we will show you how to do integration by the trapezoidal rule and include the summation procedure in the fitting function.

Minimum Origin Version Required: Origin 8.0 SR6

#### 4.3.3.17.2 What you will learn
• How to include summation in your fitting function.
• Trapezoidal rule for integration.

4.3.3.17.3 Example and Steps

We will fit the same model as the integral fit using NAG:

\[
y = y_0 + \int_{-\infty}^{x} \frac{A}{w \sqrt{\frac{x}{2}}} e^{-\left(\frac{x-x_c}{w}\right)^2} \, dx
\]

The difference is that we will perform the integration within the fitting function. Using the trapezoidal rule, we will first divide the curve into pieces and then approximate the integral area by multiple trapezoids. The precision of the result then depends on how many trapezoids will be used. Since this is a semi-infinite integration, we will set an increment (steps) and construct trapezoids from the upper integral limit, \(x\), to the lower integral limit, negative infinity and then accumulate the area of these trapezoids. When the increment of the area is significantly small, we will stop the summation. Before doing the summation, you should guarantee that the function is **CONVERGENT**, or you should include a convergence check in your code.

4.3.3.17.3.1 Define the Function

Select **Tools:Fitting Function Organizer** or alternatively press the **F9** key to open the **Fitting Function Organizer** and then define the function as follows:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>summation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>(x)</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>(y)</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>(y_0, A, x_c, w)</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
</tbody>
</table>
Click the button (icon) beside the **Function** box to open Code Builder. Define, compile and save the fitting function as follows:

```plaintext
#pragma warning(error : 15618)

#include <origin.h>

// Subroutine for integrand

double f(double x, double A, double xc, double w)
{
    return A * exp(-2*(x-xc)*(x-xc)/w/w) / w / sqrt(PI/2);
}

//----------------------------------------------------------
//
//
void _nlsfsummation(

    // Fit Parameter(s):
    double y0, double A, double xc, double w,

    // Independent Variable(s):
    double x,

    // Dependent Variable(s):
    double& y)
{
}
```
// Set the tolerance for stop integration.

double dPrecision = 1e-12;

// Initialization

double dIntegral = 0.0;

double dTrapezia = 0.0;

// Steps, or Precision.

double dStep = 0.01;

// Perform integrate by trapezoidal rule.

// Note that you should guarantee that the function is CONVERGENT.

do
{
  // Trapezia area.

dTrapezia = 0.5 * ( f(x, A, xc, w) + f(x-dStep), A, xc, w ) * dStep;

  // Accumulate area.

  dIntegral += dTrapezia;

  x = x - dStep;
}

while( (dTrapezia/dIntegral) > dPrecision );

// Set y value.

y = y0 + dIntegral;

// End of editable part
### 4.3.3.17.3.2 Fit the Curve

We can use the same data to test the result.

1. Import \Samples\Curve Fitting\Replicate Response Data.dat.
2. Highlight the first column, right-click on it, and select Set Column Values from the context menu.
3. Set \(Col(A) = \log(Col(A))\) in the Set Column Values dialog. This will make a sigmoidal curve.
4. Highlight columns A and B and create a scatter plot.
5. Then bring up the NLFit dialog by pressing Ctrl + Y. Select the fitting function we just defined and go to the Parameters tab, initialize all parameters to 1 and fit. You should see these results:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>(y_0)</td>
<td>-0.00806</td>
<td>0.18319</td>
</tr>
<tr>
<td>(A)</td>
<td>3.16479</td>
<td>0.39624</td>
</tr>
<tr>
<td>(xc)</td>
<td>-0.19393</td>
<td>0.10108</td>
</tr>
<tr>
<td>(w)</td>
<td>1.7725</td>
<td>0.33878</td>
</tr>
</tbody>
</table>

### 4.3.3.18 Fitting Complex Function

#### 4.3.3.18.1 Summary

When fitting with a complex function, we can easily separate the complex function to two functions: one corresponding to its real part and the other corresponding to its imaginary part. With these two functions, we can define the complex fitting function with two dependent variables by Fitting Function Organizer and can access it in NLFit dialog. We will illustrate how to fit with complex function below. More details about fitting with multiple dependent or independent variable please refer to Fitting with Multiple Independent Variables.

Minimum Origin Version Required: Origin 8.0 SR6

#### 4.3.3.18.2 What you will learn

This tutorial will show you how to:

- Create a user-defined complex fitting function with two dependent variables and one independent variable
- Fit with such function in NLFit

#### 4.3.3.18.3 Steps

1. Select whole form below (including header line) and right click to choose Copy to put the data in clipboard.
### Tutorials for Origin 2024b

<table>
<thead>
<tr>
<th>Omega</th>
<th>Y1</th>
<th>Y2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>3</td>
<td>0</td>
</tr>
<tr>
<td>0.01</td>
<td>2.88462</td>
<td>-0.28846</td>
</tr>
<tr>
<td>0.02</td>
<td>2.58621</td>
<td>-0.51724</td>
</tr>
<tr>
<td>0.03</td>
<td>2.20588</td>
<td>-0.66176</td>
</tr>
<tr>
<td>0.04</td>
<td>1.82927</td>
<td>-0.73171</td>
</tr>
<tr>
<td>0.05</td>
<td>1.5</td>
<td>-0.75</td>
</tr>
<tr>
<td>0.06</td>
<td>1.22951</td>
<td>-0.7377</td>
</tr>
<tr>
<td>0.07</td>
<td>1.01351</td>
<td>-0.70946</td>
</tr>
<tr>
<td>0.08</td>
<td>0.8427</td>
<td>-0.67416</td>
</tr>
<tr>
<td>0.09</td>
<td>0.70755</td>
<td>-0.63679</td>
</tr>
<tr>
<td>0.1</td>
<td>0.6</td>
<td>-0.6</td>
</tr>
<tr>
<td>0.11</td>
<td>0.5137</td>
<td>-0.56507</td>
</tr>
</tbody>
</table>

2. Select Import/Import Wizard to open Import Wizard dialog. Then choose Clipboard in Data Source group and click Finish to import the data.
3. Select **Tools: Fitting Function Organizer** from menu (or press **F9**) to bring up the **Fitting Function Organizer** and define a new fitting function named **ComplexFitting** in **NewCategory** (create the category if not exist) as follow:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>ComplexFitting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>omega</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>y1, y2</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>A, tau</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
<tr>
<td>Function:</td>
<td>complex cc = A/(1+1i<em>omega</em>tau); y1 = cc.m_re; y2 = cc.m_im;</td>
</tr>
</tbody>
</table>

4. Note: To use the imaginary unit “i” for creating complex numbers, you need to write it as “1i” in Origin C, as in the above **Function** row. And **complex** is a class that implements a complex number data type. It contains both a Real and an Imaginary component.

5. For more details about creating user-defined fitting function, please refer to **User Defined Fitting Function using Origin C**.

6. Highlight all the columns and select **Analysis: Fitting: Non-linear Curve Fit** from menu to bring up the **NLFit** dialog. Select the function **ComplexFitting** from **NewCategory** on the **Settings: Function**
Selection page. Set the input datasets in the Data Selection page as follow:

7. Select Parameters Tab and set the initial values as follows:

<table>
<thead>
<tr>
<th>Param</th>
<th>Meaning</th>
<th>Fixed</th>
<th>Value</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>?</td>
<td></td>
<td>1</td>
<td>--</td>
</tr>
<tr>
<td>tau</td>
<td>?</td>
<td></td>
<td>1</td>
<td>--</td>
</tr>
</tbody>
</table>

8. Click Fit to generate the fitting report sheet. You can see the results from the report worksheet as below:

**Parameters**

<table>
<thead>
<tr>
<th></th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y1,Y2</td>
<td>2.36712</td>
<td>0.15413</td>
</tr>
<tr>
<td>tau</td>
<td>15.84746</td>
<td>1.94844</td>
</tr>
</tbody>
</table>

**Statistics**

<table>
<thead>
<tr>
<th></th>
<th>Y1,Y2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Points</td>
<td>24</td>
</tr>
<tr>
<td>Degrees of Freedom</td>
<td>22</td>
</tr>
<tr>
<td>Reduced Chi-Sqr</td>
<td>0.12339</td>
</tr>
<tr>
<td>Residual Sum of Squares</td>
<td>2.71451</td>
</tr>
<tr>
<td>Adj. R-Square</td>
<td>0.92387</td>
</tr>
<tr>
<td>Fit Status</td>
<td>Succeeded (100)</td>
</tr>
</tbody>
</table>

From the Statistics table, we can see that the fitting is fairly successful.

4.3.3.19 Fitting with Convolution
4.3.3.19.1 Summary

When performing curve fitting to experimental data, one may encounter the need to account for instrument response in the data. One way to do this is to first perform deconvolution on the data to remove the instrument response, and then perform curve fitting as a second step. However, deconvolution is not always reliable as the results can be very sensitive to any noise present in the data. A more reliable way is to perform convolution of the fitting function with the instrument response while performing the fitting. This tutorial will demonstrate how to perform convolution while fitting.

If your data is a convolution of Gauss and Exponential functions, you can simply use built-in fitting function GaussMod in Peak Functions category to directly fit your data.

Minimum Origin Version Required: Origin 2016 SR0.

4.3.3.19.2 What you will learn

This tutorial will show you how to:

- Access fitting information during iterations.
- Perform convolution while fitting.

4.3.3.19.3 Example and Steps

4.3.3.19.3.1 Background

Let's start this example by importing \Samples\Curve Fitting\FitConv.dat.

<table>
<thead>
<tr>
<th>A(χ)</th>
<th>B(γ)</th>
<th>C(γ)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampling</td>
<td>Signal</td>
<td>Impulse</td>
</tr>
<tr>
<td>0</td>
<td>-0.19775</td>
<td>0</td>
</tr>
<tr>
<td>0.1</td>
<td>-0.32893</td>
<td>0</td>
</tr>
<tr>
<td>0.2</td>
<td>0.10055</td>
<td>0</td>
</tr>
<tr>
<td>0.3</td>
<td>0.09394</td>
<td>0</td>
</tr>
<tr>
<td>0.4</td>
<td>-0.1292</td>
<td>0</td>
</tr>
<tr>
<td>0.5</td>
<td>0.06346</td>
<td>1.48672E-6</td>
</tr>
<tr>
<td>0.6</td>
<td>0.19453</td>
<td>1.3383E-4</td>
</tr>
</tbody>
</table>

The source data includes sampling points, output signal, and the impulse response. This experiment assumes that the output signal was the convolution of an exponential decay function with a Gaussian response:
Now that we already have the output signal and response data, we can get the exponential decay function by fitting the signal with the below model:

\[ y = y_0 + \int_{-\infty}^{+\infty} A e^{-t x} \otimes \text{Response}, dx \]

4.3.3.19.3.2 Define the Function

Obviously, column 1 and column 2 are \( x \) and \( y \) respectively in the function. How about column 3, the impulse response? We will access this column within the fitting function, and compute the theoretical exponential curve from the sampling points. Then we can use fast Fourier transform to perform the convolution.

Press **F9** to open the **Fitting Function Organizer** and define a function like:

**Function Name:** FitConv  
**Function Type:** User-Defined  
**Independent Variables:** \( x \)  
**Dependent Variables:** \( y \)  
**Parameter Names:** \( y_0, A, t \)  
**Function Form:** Origin C

**Function:**

Click the button (icon) beside the **Function** box and write the function body in **Code Builder**:

```c
#pragma warning(error : 15618)

#include <origin.h>

// Header files need to be included
#include <ONLSF.h>

#include <fft_utils.h>

//

//

void _nlsfFitConv(

    // Fit Parameter(s):
    double y0, double A, double t,

    // Independent Variable(s):
    double x,
```
// Dependent Variable(s):

double& y)
{
    // Beginning of editable part

    NLFitContext *pCtxt = Project.GetNLFitContext();

    Worksheet wks;

    DataRange dr;

    int c1,c2;

    dr = pCtxt->GetSourceDataRange(); //Get the source data range

    dr.GetRange(wks, c1, c2); //Get the source data worksheet

    if ( pCtxt )
    {
        // Vector for the output signal in each iteration.
        static vector vSignal;

        // If parameters were updated, we will recalculate the convolution result.
        BOOL bIsNewParamValues = pCtxt->IsNewParamValues();

        if ( bIsNewParamValues )
        {
            // Read sampling and response data from worksheet.
            Dataset dsSampling(wks, 0);
            Dataset dsResponse(wks, 2);
int iSize = dsSampling.GetSize();

vector vResponse, vSample;

vResponse = dsResponse;

vSample = dsSampling;

vSignal.SetSize(iSize);

vResponse.SetSize(iSize);

vSample.SetSize(iSize);

// Compute the exponential decay curve
vSignal = A * exp(-t*vSample);
// Perform convolution
int iRet = fft_fft_convolution(iSize, vSignal, vResponse);
//Correct the convolution by multiplying the sampling interval
vSignal = (vSample[1]-vSample[0])*vSignal;

}
NLSFCURRINFO stCurrInfo;

pCtxt->GetFitCurrInfo(&stCurrInfo);

// Get the data index for the iteration
int nCurrentIndex = stCurrInfo.nCurrDataIndex;

// Get the evaluated y value
y = vSignal[nCurrentIndex] + y0;

// For compile the function, since we haven't use x here.
x;

} // End of editable part

Traditionally, for a particular x, the function will return the corresponding y value. However, when convolution is involved, we need to perform the operation on the entire curve, not only for a particular data point. So, from Origin 8 SR2, we introduced the NLFitContext class to achieve some key information within the fitter. In each iteration, we use NLFitContext to monitor the fitted parameters; once they are updated, we will compute the convolution using the fast Fourier transform by the fft_fft_convolution method. The results are saved in the vSignal vector. Then for each x, we can get the evaluated y from vSignal with the current data index in NLSFCURRINFO.

4.3.3.19.3.3 Fit the Curve

In the fitting function body, we read the response data directly from the active worksheet. So, you should perform the fit from the worksheet.

1. Highlight column B and press Ctrl + Y to bring up the Nonlinear Fitting dialog.
2. Choose X Data Type from Fitted Curves page as Same as Input Data.
3. Go back to the Function Selection page to select the FitConv function you just defined.
4. Go to the Parameter tab to initialize the parameters as y0=0, A=10, t=1.
5. Click the Fit button to generate the results.

If you use a fitting function similar to this tutorial, please note when you run NLFit in Origin, in NLFit dialog, choose X Data Type from Fitted Curves page as Same as Input Data.

4.3.3.20 Quoting Built-in Functions in Your New Function

4.3.3.20.1 Summary
This tutorial will show you how to reference a built-in function when creating a user-defined fitting function.

Minimum Origin Version Required: Origin 8.0 SR6

4.3.3.20.2 What you will learn

This tutorial will show you how to:

- Define a piecewise fitting function
- Access built-in functions in your new function
- Auto initialize the parameters

4.3.3.20.3 Steps

4.3.3.20.3.1 Data

Start by importing the file \Samples\Curve Fitting\Asymmetric Gaussian.dat into a new workbook.

Highlight column B and create a graph. The peak in the data is slightly skewed to the right. How to fit such a curve? One idea is to divide the curve into two parts - We can consider this curve to be composed of two Gaussian functions as below. These two Gaussian curves share the same baseline and peak center, but differ in peak width and amplitude.

4.3.3.20.3.2 Define the Function

Press F9 to open the Fitting Function Organizer and define the function as below:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>AsymmetricGauss</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>x</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>y</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>y0, xc, w1, w2, A1, A2</td>
</tr>
</tbody>
</table>
**Function Form:**

**Origin C**

**Function:**

\[ y = x < xc? \text{nlf\_Gauss}(x, y0, xc, w1, A1) : \text{nlf\_Gauss}(x, y0, xc, w2, A2); \]

**Note:**

For versions before **Origin 8.1**, the function body should be defined as:

\[
y = x < xc? \text{nlf\_Gauss}(x, y0, xc, w1, A1) : \text{nlf\_Gauss}(x, y0, xc, w2, A2);
\]

\[
x; y0; xc; w1; w2; A1; A2;
\]

Listing the parameters at the end is used to avoid the "parameter not used inside the function body" error, although you already use these parameters. This is required to compile the function successfully.

When calling **nlf\_FuncName** to reuse built-in functions, the syntax is:

\[
\text{nlf\_FuncName}(\text{independent variable, parameter list} \ldots)
\]

where **FuncName** is the fitting function name. Besides, the old notation, **nlf\_FuncName** also supported.

The **Parameter List** follows the parameter order in function definition file for the built-in function (the FDF file. You can open the FDF file in Notepad. The files are located in the \%Origin EXE Folder\%FitFunc\%). Note that, the function name we use is the DLL interface name. The actual name in the [General Information] section of the FDF file. Look at the **Function Source** item and the value is **fgroup\_FuncName**, and use the **FuncName**. In most cases, this function name is consistent with the function name visible in the NLFit dialog. For a few few functions such as Voigt, these names are different.

For parameter initialization of this skewed gaussian function, we can simply copy the initialization code of the built-in gauss function, and make a few minor modifications:

\[
xc = \text{peak\_pos}(x\_y\_curve, \&w1, \&y0, \&A1);
\]

\[
w2 = w1;
\]

\[
A2 = A1;
\]

The final function body should be as below:
Once compiled successfully, save the function and fit the curve. The results should be as below:
4.3.3.21 Fit Function with Non-constant Background

4.3.3.21.1 Summary

Many of the Origin built-in functions are defined as:

\[ y = y_0 + \ldots \]

Where \( y_0 \) can be treated as the "constant background". How about fitting a curve with a non-constant background? One option is to use the Peak Analyzer we provide. The Peak Analyzer includes multiple methods to subtract the baseline, including exponential or polynomial backgrounds. In this tutorial, we will show you how to fit such curves without using the Peak Analyzer.

Minimum Origin Version Required: Origin 8.0 SR6

4.3.3.21.2 What you will learn

- Review Worksheet Query.
- Quote a built-in function by \texttt{nlfxFuncName} method.
- Auto Initialize the parameters.

4.3.3.21.3 Example and Steps

4.3.3.21.3.1 Prepare the Data

Let's start this tutorial by importing \texttt{\Samples\Spectroscopy\Peaks on Exponential Baseline.dat}. From the worksheet sparkline, we can see that there are two peaks in the curve. To simplify the problem, we will fit just one peak in this example.

<table>
<thead>
<tr>
<th>Amplitude 1</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>y0</td>
<td>1.80002</td>
<td>4.79492E-5</td>
</tr>
<tr>
<td>xc</td>
<td>4.50001</td>
<td>3.44845E-5</td>
</tr>
<tr>
<td>w1</td>
<td>1.80003</td>
<td>4.49661E-5</td>
</tr>
<tr>
<td>w2</td>
<td>2.99998</td>
<td>4.87666E-5</td>
</tr>
<tr>
<td>A1</td>
<td>30</td>
<td>0.00103</td>
</tr>
<tr>
<td>A2</td>
<td>49.99962</td>
<td>0.00111</td>
</tr>
</tbody>
</table>

4.3.3.21.3.2 Extract Data

Now bring up the Worksheet Query dialog from Worksheet : Worksheet Query. And we will extract data from row 1 to row 240:
So the curve we will fit should look like this:

![Graph](image)

4.3.3.21.3.2 Define the Function

As illustrated below, we can consider the source curve is the combination of an exponential decay component (the background) with a Voigt peak:
So should we write down the whole equation to define the function? Like:

\[ y = y_0 + A_1 e^{-x/t_1} + A_2 \frac{2w_L \ln 2}{\pi^{\frac{3}{2}} w_G^2} \int_{-\infty}^{\infty} \frac{e^{-t^2}}{(\sqrt{\ln 2} \frac{w_L}{w_G})^2 + (\sqrt{4 \ln 2} \frac{x-x_c}{w_G} - t)^2} dt \]

Well, this is a complicated equation and it includes infinite integration. Writing such an equation directly is painful. Now that we already have these two built-in functions:

- ExpDec1:
  \[ y = y_0 + Ae^{-x/t} \]

- Voigt:
  \[ y = y_0 + A \frac{2w_L \ln 2}{\pi^{\frac{3}{2}} w_G^2} \int_{-\infty}^{\infty} \frac{e^{-t^2}}{(\sqrt{\ln 2} \frac{w_L}{w_G})^2 + (\sqrt{4 \ln 2} \frac{x-x_c}{w_G} - t)^2} dt \]

we can simply use the `nlfxFuncName` method to quote these two built-in functions and create a new one. Press F9 to open the Fitting Function Organizer and define a function as below:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>ExpVoigt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>x</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>y</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>y0, A1, t1, xc, A2, wG, wL</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
</tbody>
</table>
Function:  
\[ y = nlf\_ExpDec1(x, y0, A1, t1) + nlf\_Voigt(x, y0, xc, A2, wG, wL) - y0; \]

Note:  
Some of the built-in function names do not consistent with the actual DLL function name. Just like this Voigt function, it's defined in Voigt5.FDF, and if you open the FDF file by Notepad, you can see a line under [GENERAL INFORMATION] section says:

Function Source=fgroup.Voigt5

The name after "fgroup" is the actual name we should put into \texttt{nlf\_FuncName}.

Besides, for versions before Origin 8.1 SR2, the function body should use old \texttt{nlf\_FuncName} notation and define as:

\[
y = nlfxExpDec1(x, y0, A1, t1) + nlfxVoigt(x, y0, xc, A2, wG, wL) - y0;
\]

\[ x; \; xc; \; A1; \; t1; \; A2; \; wG; \; wL; \]

Listing the parameters at the end is done to avoid the "parameter not used inside the function body" error, although you already use these parameters. If not, you will not compile the function successfully.

Click the button on the right of the Parameter Settings and enter these parameter initial values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>y0</td>
<td>0</td>
</tr>
<tr>
<td>A1</td>
<td>5</td>
</tr>
<tr>
<td>t1</td>
<td>50</td>
</tr>
<tr>
<td>xc</td>
<td>100</td>
</tr>
<tr>
<td>A2</td>
<td>50</td>
</tr>
<tr>
<td>wG</td>
<td>10</td>
</tr>
<tr>
<td>wL</td>
<td>10</td>
</tr>
</tbody>
</table>

So the final function definition part should look like:
In the above section, we set fixed parameter initial values. If you know the possible fitted results, you can set the initial values in this way. But how about when the data is changed? Origin provides an Origin C interface to "guess" the initial values. To use the parameter initialization code, make sure to check the **Enable Auto Initialization** and **Use OriginC** checkboxes, and edit the code in Code Builder by clicking the icon.

(P.S: If you know the initial values very well, or you don't like coding, please skip this section.)
Now that the curve is composed by two components, we can guess the parameter values by separating these two parts, the initialization code includes:

1. Use the `get_exponent` function to fit the curve and get the parameter values for exponential component.
2. Remove the background -- exponential component -- from source data.
3. Approaching the peak by Gaussian peak using `peak_pos` function and set the initial values for peak component

So, the initialization code in Code Builder should look like this:

```cpp
void _nlsfParamExpVoigt(
    // Fit Parameter(s):
    double& y0, double& A1, double& t1, double& xc, double& A2, double& wG, double& wL,

    // Independent Dataset(s):
    vector& x_data,

    // Dependent Dataset(s):
    vector& y_data,

    // Curve(s):
    Curve x_y_curve,

    // Auxilary error code:
    int& nErr)
{

    // Beginning of editable part

    int nSign;

    // Evaluates the parameters' value, y0, ln(A) and R for y = y0+A*exp(R*x).
    t1 = get_exponent(x_data, y_data, &y0, &A1, &nSign);

    // Set the exponential component values for the fitting function.
```
Data Analysis

\[ t_1 = -1/t_1; \]

\[ A_1 = n\text{Sign}\ast \exp(A_1); \]

// Remove the exponential component from the curve;

\[ x_y_{\text{curve}} = x_y_{\text{curve}} - (y_0 + A_1 \ast \exp(-x_{\text{data}}/t_1)); \]

// Fit to get peak values.

\[ x_c = \text{peak}_\text{pos}(x_y_{\text{curve}}, \&wG, \&y_0, \&A2); \]

\[ wL = wG; \]

// End of editable part

}  

Note: 
When you check the **Enable Auto Initialization** and enter the initialization code, this code will cover the initial values in **Parameter Settings**.

4.3.3.21.3.4 Fit the Curve

No matter what kind of parameter initialization method you used, highlight column B and press Ctrl + Y to bring up the NLFit dialog, select the ExpVoigt function and fit. The result should be:

<table>
<thead>
<tr>
<th>Amplitude</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>( y_0 )</td>
<td>0.04862</td>
<td>0.00724</td>
</tr>
<tr>
<td>( A_1 )</td>
<td>5.08842</td>
<td>0.02599</td>
</tr>
<tr>
<td>( t_1 )</td>
<td>50.67096</td>
<td>0.51939</td>
</tr>
<tr>
<td>( x_c )</td>
<td>102.81043</td>
<td>0.07241</td>
</tr>
<tr>
<td>( A_2 )</td>
<td>32.91106</td>
<td>0.92012</td>
</tr>
<tr>
<td>( wG )</td>
<td>9.65255</td>
<td>0.67731</td>
</tr>
<tr>
<td>( wL )</td>
<td>5.7529</td>
<td>0.81022</td>
</tr>
</tbody>
</table>

4.3.3.22 Fitting with Piecewise Functions

4.3.3.22.1 Summary

We will show you how to define piecewise fitting function in this tutorial.

Minimum Origin Version Required: Origin 8.0 SR6

4.3.3.22.2 What you will learn
This tutorial will show you how to:

- Define piecewise (conditional) fitting functions.

4.3.3.22.3 Example and Steps

We can start this tutorial by importing the sample \Samples\Curve Fitting\Exponential Decay.dat data file. Highlight column D and plot a Scatter Graph. You can fit this curve using built-in functions under Growth/Sigmoidal category, however, in this tutorial, we will separate the curve into two parts by a piecewise function.

So the equation will be:

\[
y = \begin{cases} 
  a + bx + e^{-\frac{x-x_c}{t1}}, & \text{if } x < x_c \\
  a + bx, & \text{if } x \geq x_c 
\end{cases}
\]

4.3.3.22.3.1 Define the Function

Press F9 to open the Fitting Function Organizer and define a function like:

<table>
<thead>
<tr>
<th>Function Name:</th>
<th>piecewise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Type:</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Independent Variables:</td>
<td>x</td>
</tr>
<tr>
<td>Dependent Variables:</td>
<td>y</td>
</tr>
<tr>
<td>Parameter Names:</td>
<td>xc, a, b, t1</td>
</tr>
<tr>
<td>Function Form:</td>
<td>Origin C</td>
</tr>
</tbody>
</table>
Click the button on the right of the Function edit box and define the fitting function in Code Builder using:

```c++
void _nlsfpiecewise(
    // Fit Parameter(s):
    double xc, double a, double b, double t1,
    // Independent Variable(s):
    double x,
    // Dependent Variable(s):
    double& y)
{
    // Beginning of editable part
    // Divide the curve by if condition.
    if(x<xc) {
        y = a+b*x+exp(-(x-xc)/t1);
    } else {
        y = a+b*x;
    }
    // End of editable part
}
```

4.3.3.22.3.2 Fit the Curve

Press Ctrl + Y to bring up NLFit dialog with the graph window active. Select the piecewise function we defined and initialize the parameter values:
4.3.3.23 Fit Curve Through Certain Points

4.3.3.23.1 Summary

This tutorial shows you three methods to force a fit curve to go thru a particular point. Choice of method depends on function expression and the data point you want the fit curve to go through.

4.3.3.23.2 What you will learn

- Learn different methods to force a curve to go through a point.
- Fix fitting parameters during nonlinear fitting.
- Use general linear constraints in nonlinear fitting.
- Fit with weights.

4.3.3.23.3 Example and Steps

4.3.3.23.3.1 Fixing Function Parameters

This method works only when the point you want to fit through is related to a function parameter. One typical example: force the fitted line to go through the origin point, (0, 0), when fitting a straight line, \( y = a + b \times x \). In this particular case we know that if we let \( a = 0 \), the line will go through (0,0).

1. Import the data "\{Samples\Curve Fitting\}Linear Fit.dat" into an Origin worksheet.
2. Highlight one of the Y column, column D for example, and select Analysis: Fitting: Nonlinear Curve Fit to bring up the NLFit dialog.
3. Choose the **Line** function after selecting the **Polynomial** category.

4. Click the **Fitted Curves** page on **Settings** tab. Under the **X Data Type** branch, make sure the **Range** option is **Use Input Data Range + Margin**, and then enter **10** in the **Range Margin(%)** edit box. This option will lengthen the fitted curve.

5. Click the **Fit until converged** button 📊. You can see from the **Fit Curve** tab that the curve does not go through the origin point.

6. Now go to the **Parameters** tab, check the **Fixed** checkbox for parameter **A** and fix the value to **0**. Click the **Fit until converged** to fit the curve again. Now you can see the curve go through zero.
Note: You can also use the Fix Intercept option in the Linear Fit dialog to force the linear fitted line to go through the origin point.

4.3.23.2 Use Linear Constraint

This method works when the fitting function is based on a LINEAR model, such as Line, Parabola, or Cubic, etc.

We will show you how to force the fitted curve to go through a particular point by using linear constraint:

1. Import the data "\Samples\Curve Fitting\Polynomial Fit.dat" into Origin worksheet.
2. Highlight column B and press Ctrl + Y to bring up the NLFit dialog.
3. Select Parabola \(y = A + B \times x + C \times x^2\) from the Polynomial category. From the Fit Curve tab, we can see the initial value already fits the data very well.
4. Suppose we want to force the curve through \((10, 100)\). Substitute \((10, 100)\) to the fitting function \(y = A + B \times x + C \times x^2\), we then have \(100 = A + 10 \times B + 100 \times C\). We can use this equation as a general linear constraint condition. Select the Constraints page on Code tab. Check the Enable Linear Constraints checkbox, and enter the following expression into the edit box.
5. Click the **Fit until converged** button. We can see the fitted curve deviates from the data points, but it goes through the specified point.

4.3.3.23.3.3 Use weighting

If the parameters are some eigenvalues such as upper or lower asymptotes, and your raw data includes the points you want to fit through, you can fit the curve by assigning larger weights to these particular points. This is not an analytical solution, but you can assign larger weights to reduce the error:

1. Prepare data by running the following script:

```plaintext
newbook;
string fname$ = system.path.program$;
```
2. First, let's see how the fitted curve looks when there is no weighting. Highlight column B and bring up NLFit dialog from Analysis: Fitting: Nonlinear Curve Fit. Select the Logistic function from Growth/Sigmoidal category. Then click the Fit until converged button. From the Fit Curve tab, we can see the curve does not go through any points near the top.
3. Note that in the raw data worksheet, we have prepared column C and assigned large values for the first and last data points. If we use this column as weights, these two points will contribute more impact on the fitted curve and hence force the curve to go through these two points.

Now, activate the **Data Selection** page on the **Settings** tab. Expand the **Input Data** branch as below to...
expose the weighting option. Choose the **Direct Weighting** method and assign column C as the weighting dataset. Then click the **Fit until converged** button.

From the preview result, we can see that the fitted curve goes through the first and last data points.

**4.3.3.24 Distribution Fit with the Probability Density Function and Cumulative Distribution Function**

**4.3.3.24.1 Summary**

To know the location or scale parameters of a sample distribution, one can perform distribution fit on the data. However, you can also fit a probability density function or cumulative distribution function on the binned data to get these values. This tutorial shows you how to estimate these parameters by curve fitting.

Minimum Origin Version Required: Origin 2016 SR2

**4.3.3.24.2 What you will learn**

- GeneratingNormally Distributed Data for Fitting
- Fitting with Probability Density Function (PDF)
- Fitting with Cumulative Distribution Function (CDF)
4.3.3.24.3 Example and Steps
4.3.3.24.3.1 Generating Normally Distributed Data for Fitting

1. Run the following script to create sample dataset

```plaintext
newbook;
col(2) = normal(1000) * 2 + 5;
```

2. This script generates 1000 normally distributed points where mean ≈ 5 and σ ≈ 2.
3. We can first perform simple descriptive statistics on this column to see the corresponding Moments output.

Highlight the data column and select Statistics: Descriptive Statistics: Statistics on Column to open the dialog. Select Quantities tab, then make sure the Mean and Standard Deviation checkboxes are selected. And the click OK to generate report.

From the report worksheet, we can see the Mean and Standard Deviation are very close to the value we just set.

4.3.3.24.3.2 Fitting with Probability Density Function (PDF)

1. To fit the data with the PDF, we should calculate the binned data with Frequency Counts tool first.

Highlight the source data column and select Statistics: Descriptive Statistics: Frequency Counts from menu. This dialog will count the number of data points on specified bins.

   - Expand the Computation Control branch, and make sure Bin Size radio button is selected beside Step by. Set the Bin Size to 0.5 (you’ll have to clear the Auto check box).
   - Make sure the Bin Center, Count and Cumulative Count check boxes under Quantities to Compute branch are selected. Then click OK to count the data.

2. Highlight the Count column on the Frequency Counts result worksheet, select Plot>2D: Bar: Column to create a column graph. Now we have the histogram of the source data.

3. With the graph active, select menu Analysis: Fitting: Nonlinear Curve menu to open the NLFit dialog. Then select the Gauss function from the Statistics category. Leave other options as defaults and click the Fit button directly to output fitting report.
From the fitting report, we can see that the fitted $x_c$ and $\sigma$ are close to 5 and 2.

4.3.3.24.3.3 Fitting with Cumulative Distribution Function (CDF)

1. To fit the data with the CDF, we should start from the cumulative binned data. Select the **FreqCounts1** sheet from the previous section. Highlight the **Cumulative Count** column. Select menu **Plot>2D: Scatter: Scatter** to plot the CDF points.

2. With the graph active, select menu **Analysis: Fitting: Nonlinear Curve Fit** to open the **NLFit** dialog. Select the **NormalCDF** function from the **Statistics** category. Leave other options as defaults and click the **Fit** button directly to output fitting report.

From the fitting report, we can see that the fitted $x_c$ and $w$ are close to 5 and 2.

After you got binned data from the **Frequency Counts** tool, you can also fit the binned data with your user-defined probability density function or cumulative distribution function. View this page for defining and fitting with a user-defined function.
4.3.3.25 Fitting Integral Function with a Sharp Peak

4.3.3.25.1 Summary

In this tutorial, we will show you how to define an integral fitting function with a sharp peak in the integral function, and perform a fit of the data using this fitting function.

Because the integral function contains a sharp peak, the integral should be performed in three segments so that the sharp peak can be integrated in a narrow interval.

Minimum Origin Version Required: Origin 9.0 SR0

4.3.3.25.2 What you will learn

This tutorial will show you how to:

- Define an integral fitting function.
- Integrate a function with a sharp peak.
- Divide the integral interval into several segments.

4.3.3.25.3 Example and Steps

4.3.3.25.3.1 Import Data

1. Open a new workbook.
2. Copy data in Sample Data to the workbook.
3. Highlight column B, and select Plot: Symbol: Scatter from Origin menu. The graph should look like:

![Graph1](image)

4.3.3.25.3.2 Define Fitting Function
The fitting integral function is described as follows:

\[ y = \log\left( \int_0^1 \frac{1}{\sqrt{2\pi b}} e^{-\frac{(t-a)^2}{2b^2} - xt} \, dt \right) \]

where \( a \) and \( b \) are parameters in the fitting function.

Initial parameters are: \( a=1e^{-4} \), \( b=1e^{-4} \). Note that the integral function contains a peak whose center is about \( a \) and width is \( 2b \). And the peak's width \( (2e^{-4}) \) is very narrow compared with the integral interval \([0,1]\). To make sure it is integrated correctly at the neighborhood of the peak center, the integral interval \([0,1]\) is divided into three segments: \([0,a-5*b], [a-5*b,a+5*b], [a+5*b,1]\). It is integrated in each segment, and then the three integrals are summed up.

The fitting function can be defined using the **Fitting Function Builder** tool.

1. Select **Tools: Fitting Function Builder** from Origin menu.
2. In the **Fitting Function Builder** dialog's **Goal** page, click **Next** button.
3. In the **Name and Type** page, select **User Defined** from **Select or create a Category** drop-down list, type **fintpeak** in the **Function Name** field, and select **Expression** in **Function Type** group, check **Include Integration During Fitting** check box. And click **Next** button.
4. In the **Integrand** page, type **myint** in **Integrand Name** edit box, **t** in **Integration Variable** edit box and **a**, **b**, **x** in **Arguments** edit box. Type the following script in **Integrand Function** box.

   ```
   return 1/(sqrt(2*pi)*b)*exp(-(t-a)^2/(2*b^2)-x*t);
   ```

5. And click **Next** button.

6. In the **Variables and Parameters** page, type **a**, **b** in the **Parameters** field. Click **Next** button.
7. In the **Expression Function** page, click **Parameters** tab, and set **Initial Value** for parameters \( a \) and \( b \) to \( 1e^{-4} \), click **Integrand** tab, and set **Value** for **Lower Limit** and **Upper Limit** to 0 and 1, **Value** for **a**, **b**, **x** to **a**, **b**, **x** respectively.
8. In the **Expression Function** page, click **Insert** button. In the **Quick Check** group, type 0 in **x**= edit box, click **Evaluate** button, and it shows \( y=9.3e^{-21} \). This implies that the peak is not integrated correctly because \( y \) should approach 1 for \( x=0 \). Divide the integral into three segments, and type following script in **Function Body** box.

   ```
   integral(myint, 0, a-5*b, a ,b ,x)+integral(myint, a-5*b, a+5*b, a ,b ,x)+
   integral(myint, a+5*b, 1, a ,b ,x)
   ```

9. Click **Evaluate** button again, and it shows \( y=0.84 \), hence it is clear that the peak is integrated correctly this time.

10. In the **Expression Function** page, update the script in **Function Body** box as follows.

   ```
   log(integral(myint, 0, a-5*b, a ,b ,x)+integral(myint, a-5*b, a+5*b,
   ```
4.3.3.25.3.3Fit the Curve

1. Select **Analysis: Fitting: Nonlinear Curve Fit** from Origin menu. In the **NLFit** dialog, select **Settings: Function Selection**, in the page select **User Defined** from the **Category** drop-down list and **fintpeak** function from the **Function** drop-down list. **Note** that initial parameters have been set during defining the fitting function.

2. Click **Fit** button to fit the curve.

4.3.3.25.3.4Fitting Results

The fitted curve should look like:

Fitted Parameters are shown as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>4.98302E-4</td>
<td>1.07593E-5</td>
</tr>
<tr>
<td>b</td>
<td>1.94275E-4</td>
<td>8.21815E-6</td>
</tr>
</tbody>
</table>
The **Adj. R-Square** is 0.99799. Thus the fitting result is very good.

### 4.3.3.25.3.5 Sample Data

<table>
<thead>
<tr>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-0.00267</td>
</tr>
<tr>
<td>60</td>
<td>-0.01561</td>
</tr>
<tr>
<td>240</td>
<td>-0.05268</td>
</tr>
<tr>
<td>500</td>
<td>-0.10462</td>
</tr>
<tr>
<td>1000</td>
<td>-0.22092</td>
</tr>
<tr>
<td>1500</td>
<td>-0.31004</td>
</tr>
<tr>
<td>2000</td>
<td>-0.40695</td>
</tr>
<tr>
<td>3000</td>
<td>-0.61328</td>
</tr>
<tr>
<td>4000</td>
<td>-0.75884</td>
</tr>
<tr>
<td>5000</td>
<td>-0.9127</td>
</tr>
<tr>
<td>6000</td>
<td>-0.98605</td>
</tr>
<tr>
<td>7000</td>
<td>-1.18957</td>
</tr>
<tr>
<td>9000</td>
<td>-1.43831</td>
</tr>
<tr>
<td>10000</td>
<td>-1.41393</td>
</tr>
<tr>
<td>12000</td>
<td>-1.61458</td>
</tr>
<tr>
<td>15000</td>
<td>-1.88098</td>
</tr>
</tbody>
</table>
Fitting with a Piecewise Linear Function

Summary

In this tutorial we will show you how to define a piecewise fitting function consisting of two linear segments, perform a fit of the data using this fitting function, and calculate the intersection location for two linear segments from the fitting result.

Minimum Origin Version Required: Origin 8.6 SR0

What you will learn

This tutorial will show you how to:

- Define a piecewise (conditional) fitting function.
- Auto initialize parameters.
- Calculate the intersection location of the piecewise fit lines.

Example and Steps

Import Data

1. Start with an empty workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Step01.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Right click on the Sensor E x column (column J), and select Set As: X from the context menu. Highlight Sensor E y column, and select Plot: Symbol: Scatter from Origin menu. The graph should look like:
4.3.3.26.3.2 Define Fitting Function

From the above graph, the curve consists of two segments of lines. It can be fitted with a piecewise linear function. The function can be expressed as:

\[ y = \begin{cases} 
  y_1(x_3 - x) + y_3(x - x_1), & \text{if } x < x_3 \\
  y_3(x_2 - x) + y_2(x - x_3), & \text{if } x \geq x_3 
\end{cases} \]

where \( x_1 \) and \( x_2 \) are \( x \) values of the curve's endpoints and they are fixed during fitting, \( x_3 \) is the \( x \) value at the intersection of two segments, and \( y_1, y_2, y_3 \) are \( y \) values at \( x_i \), \( i = 1, 2, 3 \) respectively.

The fitting function can be defined using the Fitting Function Builder tool.

1. Select Tools: Fitting Function Builder from Origin menu.
2. In the Fitting Function Builder dialog's Goal page, click Next button.
3. In the Name and Type page, select User Defined from Select or create a Category drop-down list, type pwl2s in the Function Name field, and select Origin C in Function Type group. And click Next button.
4. In the Variables and Parameters page, type \( x_1,y_1,x_2,y_2,x_3,y_3 \) in the Parameters field. Click Next button.
5. In the Origin C Fitting Function page, click the button on the right of the Function Body edit box and define the fitting function in Code Builder as follows.
6. Click **Compile** button to compile the function body. Then click **Return to Dialog** button. Click **Next** button.

7. In the **Parameter Initialization Code** page, click the button on the right of the **Initialization Code** edit box and initialize the fitting parameters in **Code Builder** as follows.

```cpp
int n1, n2, n3;

x_data.GetMinMax( x1, x2, &n1, &n2 );
x3 = x1 + (x2 - x1)/2;

y1 = y_data[n1];
y2 = y_data[n2];

vector vd;
vd = abs( x_data - x3 );
double xta, xtb;
vd.GetMinMax( xta, xtb, &n3 );
y3 = y_data[n3];
```

8. Click **Compile** button to compile it. Then click **Return to Dialog** button. Click **Finish** button.
4.3.3.26.3.3 Define Derived Parameters for Slopes and Intercepts

During function defined process, you can also define some additional derived Parameters such as slopes and intercepts, which are computed from the function parameter values after the fitting process ends.

1. Click <<Back button twice to go back to Variables and Parameters page, type \textbf{a1,b1,a2,b2} in the Derived Parameters field.
2. Click Next button four times to go to Derived Parameters page, fill in the Meaning column and type the equations in the Derived Parameters Equations area as follows, then click Finish button.

\[
\begin{align*}
a1 &= (y1*x3-y3*x1)/(x3-x1); \\
b1 &= (-y1+y3)/(x3-x1); \\
a2 &= (y3*x2-y2*x3)/(x2-x3); \\
b2 &= (-y3+y2)/(x2-x3); \\
\end{align*}
\]

4.3.3.26.3.4 Fit the Curve

1. Select Analysis: Fitting: Nonlinear Curve Fit from Origin menu. In the NLFit dialog, select Settings: Function Selection, in the page select User Defined from the Category drop-down list and \textbf{pwl2s} function from the Function drop-down list.
2. In the **NLFit** dialog, select **Parameters** tab, and fix parameters $x_1, x_2$ as shown in the dialog.

<table>
<thead>
<tr>
<th>NO.</th>
<th>Param</th>
<th>Meaning</th>
<th>Fixed</th>
<th>Value</th>
<th>Error</th>
<th>Dependency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$x_1$</td>
<td>?</td>
<td>✔</td>
<td>0.8</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>$y_1$</td>
<td>?</td>
<td></td>
<td>0</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>$x_2$</td>
<td>?</td>
<td>✔</td>
<td>60</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>$y_2$</td>
<td>?</td>
<td></td>
<td>0.90662</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>$x_3$</td>
<td>?</td>
<td></td>
<td>30.4</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>$y_3$</td>
<td>?</td>
<td></td>
<td>0.73608</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

3. Click **Fit** button to fit the curve.

### 4.3.3.26.3.5 Fitting Results

The fitted curve should look like:

![Fitted Curve](image)

The fitted curve shows the relationship between $x$ and $y$ with the parameters estimated as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x_1$</td>
<td>0.8</td>
<td>--</td>
</tr>
<tr>
<td>$y_1$</td>
<td>0.0271 ± 0.01053</td>
<td></td>
</tr>
<tr>
<td>$x_2$</td>
<td>60</td>
<td>--</td>
</tr>
<tr>
<td>$y_2$</td>
<td>0.90662 ± 0.0093</td>
<td></td>
</tr>
<tr>
<td>$x_3$</td>
<td>22.28316 ± 0.58445</td>
<td></td>
</tr>
<tr>
<td>$y_3$</td>
<td>0.68108 ± 0.0197</td>
<td></td>
</tr>
</tbody>
</table>

The goodness of fit is indicated by the *Reduced Chi-Sqr* of 4.23249E-4 and the *R-Square(COD)* of 0.98511, suggesting a good fit to the data.
Thus the intersection point for the two segments is (22.26316, 0.66106).

**Note** that fitting with a piecewise linear function for more than two segments can be done in a similar way.

4.3.3.27 Fitting with an Ordinary Differential Equation

### User-defined Fitting Functions

#### 4.3.3.27.1 Summary

In this tutorial we will show you how to define an ordinary differential equation (ODE) in the **Fitting function Builder** dialog and perform a fit of the data using this fitting function.

Minimum Origin Version Required: Origin 9.1 SR0
This tutorial will show you how to:

- Define an ODE fitting function.
- Call NAG functions using Origin C code.
- Recalculate the ODE result only when parameters are updated.
- Interpolate on the ODE result.

### 4.3.3.27.3 Example and Steps

In this tutorial, we will use a first order ordinary differential equation as an example:

\[
\frac{dy}{dx} = ay
\]

\[
y|_{x=x_0} = y(0)
\]

where \( a \) is a parameter in the ordinary differential equation and \( y(0) \) is the initial value for the ODE. NAG functions \texttt{d02pvc} and \texttt{d02pcc} are called using the Runge–Kutta method to solve the ODE problem.

#### 4.3.3.27.3.1 Import Data

1. Start with an empty workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Exponential Growth.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight B column, and select Plot: Symbol: Scatter from Origin menu. The graph should look like:
4.3.3.27.3.2 Define Fitting Function

The fitting function can be defined using the **Fitting Function Builder** tool.

1. Select **Tools: Fitting Function Builder** from Origin menu.
2. On the **Fitting Function Builder** dialog’s **Goal** page, ensure the **Create New Function** radio button is selected. Click the **Next** button.
3. On the **Name and Type** page, From the **Select or create a Category** drop-down list select **User Defined**. For **Function Name** type **FitODE**. In the **Function Type** section select the **Origin C** radio button. Click **Next**.
4. On the **Variables and Parameters** page, in the **Parameters** field type **a, y0**. Click **Next**.
5. On the **Origin C Fitting Function** page, click the button on the right of the **Function Body** edit box and define the function in **Code Builder** as follows. Include header files for NAG and fitting:

```c
#include <oc_nag.h>
#include <ONLSF.H>
```

6. Define a static function to solve ODE by calling NAG functions. Call NAG function **d02pvc** to establish ODE model and **d02pcc** to solve the model:
struct user  // parameter in the ODE
{
    
    double a;
};

//Define the differentiate equation: y'=a*y
static void NAG_CALL f(double t, Integer neq, const double *y, double *yp,
                        Nag_Comm *comm)
{
    neq; //Number of ordinary differential equations
    t;  //Independent variable
    y;  //Dependent variables
    yp; //First derivative

    struct user *sp = (struct user *) (comm->p);
    double a;
    a = sp->a;

    yp[0] = a*y[0];
}
//Use Runge-Kutta ODE23 to solve ODE

static bool nag_ode_fit( const double a, const double y0, const double tstart,

            const double tend, const int nout, vector &vP )
{

    //nout: Number of points to output

    if( nout < 2 )
    {
        return false;
    }

    vP.SetSize( nout );
    vP[0] = y0;

    int neq = 1; //Number of ordinary differential equations
    Nag_RK_method method;

    double hstart, tgot, tinc;

    double tol, twant;

    int i, j;
vector thres(neq), ygot(neq), ymax(neq), ypgot(neq), ystart(neq);

Nag_ErrorAssess errass;

Nag_Comm comm;

struct user s;

s.a = a;

comm.p = (Pointer)&s;

ystart[0] = y0;

for (i=0; i<neq; i++)
    thres[i] = 1.0e-8;

errass = Nag_ErrorAssess_off;

hstart = 0;

method = Nag_RK_2_3;

tinc = (tend-tstart)/(nout-1);

tol = 1.0e-3;

NagError nagErr1;

//Setup ODE

int iwsav[130];

double* rwsav = (double*)malloc((350 + 32*neq)*sizeof(double));
nag_ode_ivp_rkts_setup(neq, tstart, tend, ystart, tol, thres, method, errass, hstart, iwsav, rwsav, &nagErr1);

if ( nagErr1.code != NE_NOERROR )
{
  free(rwsav);
  return false;
}

for (j=1; j<nout; j++)
{
  twant = tstart + j*tinc;

  NagError nagErr2;
  //Solve ODE

  nag_ode_ivp_rkts_range(f, neq, twant, &tgot, ygot, ypgot, ymax, &comm, iwsav, rwsav, &nagErr2);

  if ( nagErr2.code != NE_NOERROR )
  {
    free(rwsav);
    return false;
  }
}
vP[j] = ygot[0];

}

free(rwsav);

return true;

}

7. Define the fitting function body _nlsFitODE:

NLFitContext *pCtxt = Project.GetNLFitContext();

if (pCtxt)
{

static vector vX, vY;

static int nSize;

BOOL bIsNewParamValues = pCtxt->IsNewParamValues();

// If parameters were updated, we will recalculate the ODE result.

if (bIsNewParamValues)
{

// Initial and final values of the independent variable

double tstart = 0.02, tend = 2, tinc;

int nout = 100; // Number of points
tinc = (tend-tstart)/(nout-1);

vX.Data( tstart, tend, tinc );

nSize = vX.GetSize();

if( !nag_ode_fit( a, y0, tstart, tend, nout, vY ) )
   return;
}

//Interpolate y from fitting data's x on the ODE result.

ocmath_interpolate( &x, &y, 1, vX, vY, nSize );

8. Click the Compile button to compile the function body. To return, click Return to Dialog button. The Evaluate button on the dialog has a black figure of a running person. Clicking on it will show y=2.6627270424371. This implies that the function works. Click Next.

9. In the Parameter Initialization Code page, select Use Custom Code radio button, and type the code in the Initialization Code box:

   //Set the start y value in fitting data as the initial value of y0

   y0 = y_data[0];

   a = 1;

10. and click Finish.

   Note: In order to monitor the the fitted parameters, NLFitContext class was introduced in defining fitting function to achieve some key information within the fitter.
4.3.3.27.3.3 Fit the Curve

1. Highlight B column, then select **Analysis: Fitting: Nonlinear Curve Fit** from Origin menu. In the **NLFit** dialog, select **Settings: Function Selection**, in the page select **User Defined** from the **Category** drop-down list and **FitODE** function from the **Function** drop-down list.

2. Select **Parameters** tab, and fix \( y_0 \) as shown in the dialog.

<table>
<thead>
<tr>
<th>NO.</th>
<th>Param</th>
<th>Meaning</th>
<th>Fixed</th>
<th>Value</th>
<th>Error</th>
<th>Dependency</th>
<th>Lower Co.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>( a )</td>
<td>?</td>
<td>1</td>
<td>1</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>1</td>
<td>( y_0 )</td>
<td>✓</td>
<td>0.77038</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

3. Click **Fit** button to fit the curve.

4.3.3.27.3.4 Fitting Results

The fitted curve should resemble the following image:

![Fitted Curve](image.png)

Fitted Parameters will be shown as in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>( a )</td>
<td>1.30272</td>
<td>0.00858</td>
</tr>
<tr>
<td>( y_0 )</td>
<td>0.77038</td>
<td>0</td>
</tr>
</tbody>
</table>

**Note:** Fitting with more complex ODE fitting functions can also be done in a similar way.
4.3.3.28 Fitting with Convolution of Two Functions

4.3.3.28.1 Summary

In this tutorial, we will show you how to define a convolution of two functions, and perform a fit of the data with non-evenly spaced X using this fitting function.

If your data is a convolution of Gauss and Exponential functions, you can simply use built-in fitting function GaussMod in Peak Functions category to directly fit your data.

Minimum Origin Version Required: Origin 9.0 SR0

4.3.3.28.2 What you will learn

This tutorial will show you how to:

- Sample a function.
- Calculate a convolution of two functions.
- Define constants in the fitting function.
- Pad zeroes before the convolution.
- Interpolate the convolution result for non-evenly spaced X.
- Use a parameter to balance the speed and the precision.
- Use Y Error Bar as weight.

4.3.3.28.3 Example and Steps

4.3.3.28.3.1 Import Data

1. Start with an empty workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file ConvData.dat. Drag-and-drop this file into the empty worksheet to import it. Note that column A is not evenly spaced. We can use LabTalk diff function to verify it.

2. Right click on column C, and select Set As: Y Error from the short-cut menu. Highlight column B and C, and select Plot: Symbol: Scatter from the Origin menu. The graph should look like:
4.3.3.28.3.2 Define Fitting Function

The fitting function is a convolution of two functions. It can be described as follows:

\[ y = y_0 + b_1 x + \frac{b_2 A_2}{w_2 \sqrt{\pi/2}} e^{-\frac{(x-x_c)^2}{w_2^2}} + (f \ast g)(x) \]

where \( f(x) = \frac{s}{\pi} \left( \frac{x - x_{c1}}{\tau_L} \right) \left( x - x_{c1} \right)^2 \left( x - x_{c1} \right)^2 + \left( \frac{x - x_{c1}^2}{\tau_L} \right)^2, \]

\[ g(x) = \frac{1}{w_1 \sqrt{\pi/2}} e^{-\frac{2x^2}{w_1^2}}. \]

And \( x_0, x_L, \tau_L, s, y_0, b_1 \) and \( b_2 \) are fitting parameters. \( w_1, x_{c1}, w_2, x_{c2} \) and \( A_2 \) are constants in the fitting function.

The fitting function can be defined using the **Fitting Function Builder** tool.

1. Select **Tools: Fitting Function Builder** from Origin menu.
2. In the **Fitting Function Builder** dialog’s **Goal** page, click Next.
3. In the **Name and Type** page, select User Defined from Select or create a Category drop-down list, type convfunc in the **Function Name** field, and select Origin C in **Function Type** group. And click Next.
4. In the **Variables and Parameters** page, type \( x0, xL, tL, s, y0, b1, b2 \) in the **Parameters** field, \( w1, x_{c1}, w2, x_{c2}, A2 \) in the **Constants** field. Click Next.
5. In the **Origin C Fitting Function** page, set initial parameters as follows:
6. Click **Constants** tab, set constants as follows:

\[
\begin{align*}
\text{x0} &= 3.1 \\
\text{xL} &= 6.3 \\
\text{tL} &= 0.4 \\
\text{s} &= 0.14 \\
\text{y0} &= 1.95 \times 10^{-3} \\
\text{b1} &= 2.28 \times 10^{-5} \\
\text{b2} &= 0.2 \\
\end{align*}
\]

7. Click the button on the right of the **Function Body** edit box and define the fitting function in **Code Builder** as follows:

8. Include header files,

\[
\begin{align*}
\text{#include <ONLSF.H> } \\
\text{#include <fft_utils.h>} \\
\end{align*}
\]

9. Define the function body

\[
\text{NLFitContext *pCtx = Project.GetNLFitContext();} \\
\text{if ( pCtx )}
\]
// Vector for the output in each iteration.
static vector vX, vY;

static int nSize;

BOOL bIsNewParamValues = pCtxt->isNewParamValues();

// If parameters were updated, we will recalculate the convolution result.
if ( bIsNewParamValues )
{

    //Sampling Interval
    double dx = 0.05;

    vX.Data(-16.0, 16.0, dx);

    nSize = vX.GetSize();

    vector vF, vG, vTerm1, vTerm2, vDenominator, vBase, vAddBase;

    double Numerator = tL * x0^2 * (xL^2 - x0^2);

    vTerm1 = ( (vX - xc1) * tL * ( (vX - xc1)^2 - xL^2 ) )^2;
vTerm2 = ( (vX - xc1)^2 - x0^2 )^2;

vDenominator = vTerm1 + vTerm2;

//Function f(x)

vF = (s/pi) * Numerator / vDenominator;

//Function g(x)

vG = 1/(w1*sqrt(pi/2)) * exp(-2*vX^2/w1^2);

//Pad zeroes at the end of f and g before convolution

vector vA(2*nSize-1), vB(2*nSize-1);

vA.SetSubVector(vF);

vB.SetSubVector(vG);

//Perform circular convolution

int iRet = fft_fft_convolution(2*nSize-1, vA, vB);

//Truncate the beginning and the end

vY.SetSize(nSize);

vA.GetSubVector(vY, floor(nSize/2), nSize + floor(nSize/2)-1);
//Baseline

vBase = (b1*vX + y0);

vAddBase = b2 * A2/(w2*sqrt(pi/2))*exp(-2*(vX-xc2)^2/w2^2);

//Fitted Y

vY = dx*vY + vBase + vAddBase;

//Interpolate y from x for the fitting data on the convolution result.

ocmath_interpolate(&x, &y, 1, vX, vY, nSize);

10. Click **Compile** button to compile the function body. And click the **Return to Dialog** button.

11. Click **Evaluate** button, and it shows y=0.02165 at x =1. And this indicates the defined fitting function is correct. Click **Next**.

12. Click **Next**. In the **Bounds and General Linear Constraints** page, set the following bounds:

<table>
<thead>
<tr>
<th>Bound</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 &lt; x0 &lt; 7</td>
</tr>
<tr>
<td>0 &lt; xL &lt; 10</td>
</tr>
<tr>
<td>0 &lt; tL &lt; 1</td>
</tr>
<tr>
<td>0 &lt;= s &lt;= 5</td>
</tr>
<tr>
<td>0 &lt; b2 &lt;= 3</td>
</tr>
</tbody>
</table>

13. Click **Finish**.

**Note:** In order to monitor the the fitted parameters, **NLFitContext class** was introduced in defining fitting
function to achieve some key information within the fitter

4.3.3.28.3.3 Fit the Curve

1. Select **Analysis: Fitting: Nonlinear Curve Fit** from the Origin menu. In the **NLFit** dialog, select **Settings: Function Selection**, in the page select **User Defined** from the **Category** drop-down list and **convfunc** function from the **Function** drop-down list. Note that **Y Error Bar** is shown in the active graph, so column C is used as Y weight, and **Instrumental** weighting method is chosen by default.

2. Click the **Fit** button to fit the curve.

4.3.3.28.3.4 Fitting Results

The fitted curve should look like:

![Fitted Curve](image)

Fitted Parameters are shown as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>x0</td>
<td>3.1424</td>
<td>0.07318</td>
</tr>
<tr>
<td>xL</td>
<td>6.1297</td>
<td>0.1193</td>
</tr>
<tr>
<td>tL</td>
<td>0.42795</td>
<td>0.02972</td>
</tr>
<tr>
<td>s</td>
<td>0.14796</td>
<td>0.00423</td>
</tr>
</tbody>
</table>
Note that you can set a smaller value for \( dx \) in the fitting function body, the result may be more accurate, but at the same time it may take a longer time for fitting.

4.3.3.29 Parameter Initialization for Rational Functions

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>( y_0 )</td>
<td>0.00216</td>
<td>1.76145E-4</td>
</tr>
<tr>
<td>( b_1 )</td>
<td>4.90363E-5</td>
<td>1.61195E-5</td>
</tr>
<tr>
<td>( b_2 )</td>
<td>0.07913</td>
<td>0.02855</td>
</tr>
</tbody>
</table>

In this tutorial, we will show you how to calculate initial parameters for rational fitting functions using the multiple linear regression method, and perform a fit of the data using calculated initial parameters.

Minimum Origin Version Required: Origin 9.0 SR0

4.3.3.29.2 What you will learn

This tutorial will show you how to:

- Calculate initial parameters for rational fitting functions.
- Perform multiple linear regression using Origin C code.

4.3.3.29.3 Example and Steps

4.3.3.29.3.1 Algorithm

In this tutorial, we will use the following rational function as an example:

\[
y = \frac{a + bx + c x^2}{1 + dx + e x^2}
\]

where \( x \) is the independent variable, \( y \) is the dependent variable, and \( a, b, c, d, e \) are fitting parameters.
Multiplying both sides by the denominator on the right side yields:

\[ y + dx^2 + cx^2 = a + bx + cx^2 \]

and the equation can be expressed as:

\[ y = a + bx + cx^2 - dx^2 - cx^2 \]

Substituting fitting data \((x_i, y_i)\) \(i = 1 \ldots N\) into the equation gives:

\[
\begin{align*}
  a + bx_1 + cx_1^2 - dx_1y_1 - cx_1^2y_1 &= y_1 \\
  a + bx_2 + cx_2^2 - dx_2y_2 - cx_2^2y_2 &= y_2 \\
  &\vdots \\
  a + bx_N + cx_N^2 - dx_Ny_N - cx_N^2y_N &= y_N
\end{align*}
\]

Hence estimating initial parameters for a rational polynomial fitting function becomes a multiple linear regression problem with linear coefficients \(a, b, c, d, e\).

\[
\begin{bmatrix}
  1 & x_1 & x_1^2 & -x_1y_1 & -x_1^2y_1 \\
  1 & x_2 & x_2^2 & -x_2y_2 & -x_2^2y_2 \\
  & \vdots & \vdots & \vdots & \vdots \\
  1 & x_N & x_N^2 & -x_Ny_N & -x_N^2y_N
\end{bmatrix}
\begin{bmatrix}
  a \\
  b \\
  c \\
  d \\
  e
\end{bmatrix}
= 
\begin{bmatrix}
  y_1 \\
  y_2 \\
  \vdots \\
  y_N
\end{bmatrix}
\]

Origin provides a function \texttt{ocmath\_multiple\_linear\_regression} in Origin C for multiple linear regression, which can be called in initialization code.

4.3.3.2.9.3.2 Import Data

1. Open a new workbook.
2. Copy data in \texttt{Sample Data} to the workbook.
3. Highlight column B, and select \texttt{Plot: Symbol: Scatter} from Origin menu. The graph should look like:
4.3.3.29.3.3 Define Fitting Function and Initialize Parameters

The fitting function can be defined using the **Fitting Function Builder** tool.

1. Select **Tools: Fitting Function Builder** from Origin menu.
2. In the **Fitting Function Builder** dialog's **Goal** page, click the **Next** button.
3. In the **Name and Type** page, select **User Defined** from the **Select or create a Category** drop-down list, type `rationalfunc` in the **Function Name** field, and select **Expression** in the **Function Type** group. Click the **Next** button.
4. In the **Variables and Parameters** page, type `a, b, c, d, e` in the **Parameters** field. Click the **Next** button.
5. In the **Expression Function** page, type the following script in the **Function Body** box.

\[
\frac{(a+b*x+c*x^2)}{(1+d*x+e*x^2)}
\]

6. Click the **Evaluate** button, and it shows \(y=1\) at \(x=1\), hence this implies the expression is correct. Click the **Next** button.

7. In the **Parameter Initialization Code** page, select **Use Custom Code** radio button, click the **Open Code Builder** button to the right of the **Initialization Code** box, and initialize fitting parameters as follows, in terms of the algorithm.

\[
\text{UINT nOSizeN = x_data.GetSize();} // Number of points
\]
UINT nVSizeM = 5;  //Number of parameters

matrix mX(nOSizeN, 5);

//Construct matrix for data points of independent variables

vector vCa(nOSizeN), vCb, vCc, vCd, vCe;

vCa = 1;

mX.SetColumn( vCa, 0 );

vCb = x_data;

mX.SetColumn( vCb, 1 );

vCc = x_data^2;

mX.SetColumn( vCc, 2 );

vCd = -x_data*y_data;

mX.SetColumn( vCd, 3 );

vCe = -x_data^2*y_data;

mX.SetColumn( vCe, 4 );

//Options for multiple linear regression

LROptions stLROptions;

stLROptions.UseReducedChiSq = 1;

stLROptions.FixIntercept = 1;  //Fix the intercept at 0.
FitParameter stFitParameters[ 6 ]; // should be nVSizeM+1

UINT nFitSize = nVSizeM + 1;

int nRet = ocmath_multiple_linear_regression(mX, nOSizeN, nVSizeM, y_data,

     NULL, 0, &stLROptions, stFitParameters, nFitSize );

if( nRet == STATS_NO_ERROR )
{
    a = stFitParameters[1].Value;
    b = stFitParameters[2].Value;
    c = stFitParameters[3].Value;
    d = stFitParameters[4].Value;
    e = stFitParameters[5].Value;
}

8. Click the Compile button to compile the code. And click the Return to Dialog button. Click Finish to close the Fitting Function Builder dialog.

4.3.3.29.3.4 Fit the Curve

1. Select Analysis: Fitting: Nonlinear Curve Fit from Origin menu. In the NLFit dialog, select Settings: Function Selection, in the page select User Defined from the Category drop-down list and rationalfunc function from the Function drop-down list.
2. Click the Parameters tab. Initial parameters calculated from initialization code are listed in the dialog, and the fitting function curve for initial parameters is shown as follows. It seems that initial parameters
3. Click the **Fit** button to fit the curve.

### 4.3.3.2 Fitting Results

The fitted curve should look like:

Fitted Parameters are shown as follows:
### Data Analysis

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>3.17139</td>
<td>0.30284</td>
</tr>
<tr>
<td>b</td>
<td>-1.65602</td>
<td>1.76748</td>
</tr>
<tr>
<td>c</td>
<td>0.26407</td>
<td>1.81764</td>
</tr>
<tr>
<td>d</td>
<td>3.6884</td>
<td>0.26362</td>
</tr>
<tr>
<td>e</td>
<td>5.31812</td>
<td>0.55265</td>
</tr>
</tbody>
</table>

#### 4.3.3.29.3.6 Sample Data

<table>
<thead>
<tr>
<th>x</th>
<th>y</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1.5</td>
<td>1.13173</td>
</tr>
<tr>
<td>-1.39474</td>
<td>0.8262</td>
</tr>
<tr>
<td>-1.28947</td>
<td>1.06999</td>
</tr>
<tr>
<td>-1.18421</td>
<td>1.37155</td>
</tr>
<tr>
<td>-1.07895</td>
<td>0.79569</td>
</tr>
<tr>
<td>-0.97368</td>
<td>2.11346</td>
</tr>
<tr>
<td>-0.86842</td>
<td>2.32006</td>
</tr>
<tr>
<td>-0.76316</td>
<td>3.9205</td>
</tr>
<tr>
<td>-0.65789</td>
<td>5.81904</td>
</tr>
<tr>
<td>-0.55263</td>
<td>7.38037</td>
</tr>
<tr>
<td>-0.44737</td>
<td>8.31272</td>
</tr>
</tbody>
</table>
### 4.3.3.30 Surface Fitting with Multiple Peaks

Origin provides several built-in surface fitting functions under the Surface function category which can be used to perform fitting on 3D data. The surface fitting function is similar to the nonlinear fitting function.

Surface Fitting is only available in OriginPro.

Minimum Origin Version Required: OriginPro 9.0 SR0

#### 4.3.3.30.1 What you will learn

- How to do surface fitting on a surface.
- How to fit the surface with multiple peaks.

#### 4.3.3.30.2 Steps

This tutorial is associated with the **Surface Fitting (Pro Only)** folder in the **Tutorial Data.opj** (<Origin EXE Folder>\Samples\Tutorial Data.opj).

1. With the matrixsheet active, select **Plot: 3D > 3D Colormap Surface** to plot a 3D graph.
2. With the graph window activated, select **Analysis: Fitting : Nonlinear Surface Fit...** menu to open the **NLFit** dialog. Please note, if you started the fit from a matrix sheet, you have to select **Analysis: Fitting : Nonlinear Matrix Fit...** menu.

---

**Note**: You can also use this method to initialize parameters for other rational polynomial fitting functions.
3. Select **Gauss2D** from the **Function** dropdown menu.

![Function dropdown menu](image)

4. Go to **Advanced** sub-tab, set **Number of Replicas** to 3, and set **Peak Direction** as **Positive**. You can see four peaks have been found.

![Advanced settings](image)
5. Click **Fit** to perform a multiple peak fit and generate a report worksheet with fitting results.

![Graph](image)

**4.3.3.31 Nonlinear Multiple Variables Fitting**

**4.3.3.31.1 Summary**

Origin supports fitting functions with multiple dependent or independent variables. With the nonlinear fitting function, you can define multiple variables and separate them with semicolons. Since global fitting allows you to fit only one function at a time, this is a good way to defeat that limitation.

Origin ships with three built-in functions with multiple dependent and independent variables. These functions, available in the Multiple Variables category, are actually composites consisting of two ordinary functions. The GaussianLorentz function, for example, is a combination of the Gaussian and Lorentz functions, sharing \( y_0 \) and \( x_c \):

\[
y_1 = y_0 + \frac{A_1}{w_1 \sqrt{\pi} / 2} e^{-\frac{(x-x_c)^2}{w_1^2}}
\]

\[
y_2 = y_0 + \frac{2A_2}{\pi} \frac{w_2}{4 (x-x_c)^2 + w_2^2}
\]

This tutorial will demonstrate how to fit such multi-variable functions.

**4.3.3.31.2 What you will learn**
• Use Nonlinear Multiple Variables Fitting to fit a curve with two different functions.
• Assign data to fitting variables.

4.3.3.31.3 Steps

1. Start with a new project or create a new workbook and import the data file `samples\curve fitting\Gaussian.dat`.

2. Highlight Column(A) and Column(B). In the main menu, click Analysis, then point to Fitting, and then click Nonlinear Curve Fit.

3. In the NLFit dialog’s left panel, select Function Selection. In the right panel, select Multiple Variables in the Category dropdown menu. In the Function dropdown menu, select GaussianLorentz.
As you can see on the Sample Curve tab, the equations in this fitting function share the same parameters, $y_0$ and $x_c$.

4. In the NLFit dialog’s left panel, select **Data Selection**. In the right panel, expand the **Range** node and assign data to the fitting variables. In this example, we have assigned column B to both $y_1$ and $y_2$, which means that both expressions will fit the same dataset.
5. Click **Fit until converged** to fit, then **OK**. In the results sheet, compare parameters A and w, with the Gaussian and Lorentz functions sharing the same offset and peak center.
4.3.3.32 Modifying Derived Parameters in Build-in Functions

4.3.3.32.1 Summary

Derived parameters are additional parameters computed using the fitted parameter values. You can define your own derived parameters for any built-in or user-defined fitting functions. They are not involved in the fitting process and are computed only at the end of the fitting session.

4.3.3.32.2 What you will learn

- How to add derived parameters in a built-in fitting function by Fitting Function Organizer.
- How to remove derived parameters in a built-in fitting function by Fitting Function Organizer.

4.3.3.32.3 Adding Derived Parameters

The built-in Gauss function fits the peak area with the following equation:

\[ y = y_0 + \frac{A}{w \sqrt{\pi/2}} e^{-\frac{(x-x_c)^2}{w^2}} \]

Suppose that you also want to know the peak height, which can be computed as follows:

\[ h = \frac{A}{w \sqrt{\pi/2}} \]

1. Select Tool: Fitting Function Organizer in the menu. In the left panel of the dialog, select Origin Basic Functions: Gauss.
2. Go to **Derived Parameters** section and input the \( h = \frac{A}{(w^*\sqrt{\pi/2})} \)

- **Note:**
  - Each derived parameter should be specified in a separate row.
  - Derived parameters cannot be computed from other derived parameters.

3. Click on **Save** and the **OK** button.

4. Start with an empty worksheet. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file *Gaussian.dat*. Drag-and-drop this file into the empty worksheet to import it.

5. Highlight column A and B, then select **Analysis: Fitting: Nonlinear Curve Fit** to open the **Nonlinear Curve Fitting** dialog, and select **Gauss** from the Function drop-down list.
6. Go to **Code** tab and click **Derived parameters** on the left panel. You can see the Derived Parameters listed on the right panel.

7. Click **Fit** button to generate report sheets. After fitting, Origin will compute the height and include the result in the Parameters table on the fitting results worksheet.
8. If you want to obtain the confidence interval for derived parameters, you can click on the green lock and select Change Parameters to go back to the NLFit dialog. Click Advanced option under Settings tab, expand Quantities node on the right panel and check the LCL and UCL checkboxes under Fit Parameters branch. Click Fit button to recalculate.

9. Then confidence interval 95% LCL and 95% UCL are calculated for both parameters and derived parameters as below:
4.3.3.32.4 Removing Derived Parameters

You can also remove derived parameters from result sheet. Continue with the tutorial above, follow the steps below:

1. Select Tool: Fitting Function Organizer in the menu to open the dialog again. In the left panel of the dialog, select Origin Basic Functions: Gauss.
2. Go to **Derived Parameters** section and remove expression $h=A/(w*\sqrt{\pi/2})$ from that panel.

3. You may need to wait one or two seconds before the **Save** button is enabled. Click **Save** button and then **OK** button to close dialog.

4. Click on the green lock on the top left corner in result sheet *FitNL1* to change parameters and click **Fit** button again in the appeared **NLFit (Gauss)** dialog. We will see the derived parameter $h$ has been removed from result table.
4.3.3.33 Fit Multiple Datasets by Fitting One and then Using Those Fit Parameters for Other Datasets

4.3.3.33.1 Summary

In some cases, you might have multiple datasets, and want to fit them using the user-defined function without parameter initial code. For increased efficiency, you can fit one and then apply the fit parameters for other datasets.

Minimum Origin Version Required: Origin 8.6

4.3.3.33.2 What you will learn

This tutorial will show you how to:

- Create a user-defined fitting function in Fitting Function Builder
- Perform an independent fit.
- Fit one of multiple datasets by doing 1-iteration, full-iteration.
- Apply the parameter values of one dataset to other datasets.

4.3.3.33.3 Steps

4.3.3.33.3.1 Create a User-Defined Function in Fitting Function Builder

The Fitting Function Builder can be used to create or edit a user-defined function. In the following section, we will define a fitting function MyExp with this tool.

1. Select Tools: Fitting Function Builder... from the main menu (or press F8) to open the Fitting Function Builder. Select the Create a New Function radio box.
2. Click the **Next** button to go to the **Name and Type** page. Enter *MyExp* in the **Function Name** box and select the **Origin C** radio box for the **Function Type**.
3. **Click the Next button to go to the Variables and Parameters page.** Enter the variables and parameters as shown in the following screenshot:
4. Click the Next button to go to the Origin C Fitting Function page. Enter the function body 
\( y = y_0 + a \exp(b \cdot x) \) in the Function Body box. To verify the correctness of the function, click the button beside the Function box to open the Origin Code Builder.
In the **Code Builder**, click the **Compile** button to compile the function. If passed, the message **Compile Done** will show, and then you can click the **Return to Dialog** button to return to the **Fitting Function Builder**.
5. Click the Finish button to create this fitting function MyExp.

4.3.3.3.2 Fit Multiple Dataset with User-Defined Fitting Function

1. Import \Samples\Curve Fitting\Exponential Decay.dat to Origin worksheet.
2. Highlight all columns and then select Analysis: Fitting: Non-linear Curve Fit from the menu to open the NLFit dialog.
3. Select the function just defined in Settings tab, Function Selection page:
4. Switch to **Parameters** tab, enter 80, 100, -5 on the **Value** column as initial values for \(y_0, a, b\) of the first dataset. Then select 1 from the independent fit drop-down list and iterate the first dataset until converged.

5. The parameter values are calculated and the fitting result is hinted in the bottom left corner of this dialog.
6. To initialize the parameters of other datasets, apply the parameter values of the first dataset to other datasets by right-clicking the values, and then selecting **Apply Whole Set of "Value" to All Datasets** from the fly-out menu.

7. Click **Fit** button to finish the fitting for all datasets.
4.3.3.34 Implicit Fitting with Three Variables

4.3.3.34.1 Summary

This tutorial will show you how to define an implicit fitting function with three independent variables, then perform implicit fitting with it on fitting data.

Minimum Origin Version Required: OriginPro 9.0 SR1

4.3.3.34.2 What you will learn

This tutorial will show you how to:

1. Define an implicit fitting function.
2. Perform implicit fitting with three independent variables.
3. Plot the fitted surface manually.

4.3.3.34.3 Examples and Steps

4.3.3.34.3.1 Import Data
1. Start with an empty worksheet. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Curve Fitting** subfolder and find the file `Ellipsoid.dat`. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight column C, right click on selection and choose **Set As: Z** from the context menu. Select **Plot: 3D: 3D Scatter** from Origin menu. Double click on the graph. In the **Plot Details** dialog, select **Layer1** in the left panel, click **Axis** tab, set **X, Y, Z Length** as 100, 75, 50 respectively. Click the **Fit frame to layer** button in the **3D Rotation** toolbar. The graph should look like:

   ![Graph1](image)

4.3.3.34.3.2 Define Fitting Function

The graph can be fitted with an ellipsoid. The function can be expressed as:

\[
\frac{(x - x_0)^2}{a^2} + \frac{(y - y_0)^2}{b^2} + \frac{(z - z_0)^2}{c^2} = 1
\]

where \((x_0, y_0, z_0)\) is the ellipsoid’s center location, \(a, b\) and \(c\) are semi-principal axes lengths, \(x, y\) and \(z\) are three independent variables for fitting data.

The fitting function can be defined using the **Fitting Function Builder** tool.

1. Select **Tools: Fitting Function Builder** from the Origin menu.
2. In the **Fitting Function Builder** dialog’s **Goal** page, click **Next**.
3. In the **Name and Type** page, select **Implicit** from **Select or create a Category** drop-down list, type **Ellipsoid** in the **Function Name** field, and select **Implicit** in **Function Model** group. And click **Next**.
Note that implicit functions must be defined in Implicit category.

4. In the Variables and Parameters page, type \(x, y, z\) in the Variable field and \(x_0, y_0, z_0, a, b, c\) in the Parameter field. Click Next.

5. In the Expression Function page, type the following script in the Function Body edit box.

\[
(x-x_0)^2/a^2 + (y-y_0)^2/b^2 + (z-z_0)^2/c^2 - 1
\]

6. **Note** that for an implicit function \(f_1(x_i, p_i) = f_2(x_i, p_i)\) where \(x_i\) \((i=1,2...)\) are independent variables, \(p_i\) \((i=1,2...)\) are parameters, it must be defined as \(f = f_1(x_i, p_i) - f_2(x_i, p_i)\) in Origin where \(f\) is the Estimate.

Set initial parameters as follows in the Parameters tab.

\[
x_0=0 \quad y_0=0 \quad z_0=0 \quad a=3 \quad b=3 \quad c=3
\]
7. In the **Quick Check** group, click **Evaluate** button, it shows \( f = -0.667 \) at \( x=1, y=1, z=1 \).

8. In the **Bounds and General Linear Constraints** page, set lower bounds for \( a, b \) and \( c \) as follows. Then click the **Finish** button to close the dialog.

   Note that a message in **Messages Log** is shown that the implicit function is saved in the **User Files** folder.

**4.3.3.43.34 Fit the Curve**
1. For implicit fitting with more than 2 independent variables, Origin only supports input data from workbooks not graphs. So we have to make the workbook for fitting data active before fitting. Select Analysis: Fitting: Nonlinear Implicit Curve Fit from Origin menu. In the NLFit dialog, select Settings: Function Selection, in the page select Ellipsoid function from the Function drop-down list.

2. Select Data Selection page, expand Input Data: Range1, and choose column A as X, column B as Y and column C as Z. An error message is shown at the bottom of the Settings panel. Following the suggestion of the error message, go to the Fitted Curves page and change the Data Type of X to Fitted Point for Input Data. The Data Type of y and z should automatically change as well.

3. Since initial parameters have been set in Fitting Function Builder dialog, we can click Fit button to fit the curve.

4. Switch to the fitted report. Parameters and Statistics tables are shown in the report.

Fitted Parameters are shown as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Standard Error</th>
</tr>
</thead>
</table>

**Note** that Origin doesn't support Fit Curve preview in the NLFit dialog or fitted surface in the fitted report for implicit fitting with more than two independent variables.
And **Adj. R-Square** is 0.99823, which means the fitted result is very good. **Note** that this result is from Origin9.0 32Bit, while in Origin9.0 64Bit the result is slightly different, and the latter is better.

In the **FitODRCurve1** worksheet, the first three columns show XYY coordinates for fitted points.

**Note** that in the implicit fitting, x, y and z are all independent variables, they will all be adjusted during iterations in the fitting.

### 4.3.3.34.3.5 Fitted Surface

Although Origin9.0SR1 doesn't show the fitted surface in the fitted report for implicit fitting with more than two independent variables, in this example you can plot the fitted ellipsoid using **3D Parametric Function Plot** tool in Origin as follows.

1. Make the fitted report active, run following LabTalk script in the **Script Window** in order to get fitted parameter variables.

```labtalk
getnlr tr:=tt;
x0=tt.x0;
y0=tt.y0;
z0=tt.z0;
a=tt.a;
b=tt.b;
c=tt.c;
```

2. Variables **x0, y0, z0, a, b** and **c** can be used in following steps.
3. Make **Graph1** active. Select **File: New: Function Plot: 3D Parametric Function Plot** from Origin menu. In the **Create 3D Parametric Function Plot** dialog, set **u** from 0 to pi, **v** from 0 to 2*pi. And define **X**, **Y** and **Z** as follows.

   \[
   X(u,v) = x_0 + a \sin(u) \cos(v) \\
   Y(u,v) = y_0 + b \sin(u) \sin(v) \\
   Z(u,v) = z_0 + c \cos(u)
   \]

4. And choose **Add to Active Graph** from the drop-down list at the bottom left of the dialog.

5. Click **OK** button to close the dialog. A 3D ellipsoid plot will be added to **Graph1**.

7. Double click on the graph. In the **Plot Details** dialog, you can customize the graph as follows. **Note** that only OpenGL of 2.1 or higher version supports 3D transparency in Origin9.0. You can select
Preferences: 3D OpenGL Settings from Origin menu to see your OpenGL version, if your OpenGL version is lower than 2.1, you should ignore the setting for 3D transparency in Step 3.2.

1. Select Layer1 in the left panel, click Size/Speed tab, clear Worksheet data, maximum points per curve check box in the Speed Mode, Skip Points if needed group. Click Lighting tab, choose Directional in the Mode group, and select blue color as Ambient color in the Light Color group.

2. Select the second plot in the Layer1 branch, click Surface tab, set Transparency as 50%. Select Fill tab, and change Fill piece by piece color to white in the Front Surface group. Click OK button to close the dialog.

The graph for the fitted ellipsoid will look like:

4.3.3.35 Nonlinear fitting using Orthogonal Distance Regression

4.3.3.35.1 Summary

When performing non-linear curve fitting to experimental data, one may encounter the need to account for errors in both independent variables and dependent variables. In Origin, you can utilize the Orthogonal Distance Regression (ODR) to fit your data with implicit or explicit functions. This tutorial will demonstrate how to perform non-linear curve fitting on data with both X errors and Y errors using ODR with a built in function.
4.3.3.35.2 What you will learn

This tutorial will show you how to use Orthogonal Distance Regression to fit nonlinear data with both X and Y errors.

4.3.3.35.3 Example and Steps

1. Open a new workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file ODR fitting.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Highlight column XError (long name) and right click to select Set As: X Error to set it as X error column.
3. Highlight column YError (long name) and right click to select Set As: Y Error to set it as Y error column.
4. Highlight all four columns and go to Plot:Basic 2D:Scatter to make a scatter plot with both X and Y error bars.
5. Go to Analysis:Fitting:Nonlinear Curve Fit:Open dialog... to open NLFit dialog.
6. On Function Selection page, select Category as Polynomial, Function as Poly4 and Iteration Algorithm as Orthogonal Distance Regression (Pro).

7. Since X error and Y error columns have been specified in step 3, 4 so that when Orthogonal Distance Regression is selected as iteration algorithm these two columns will be automatically assigned as corresponding weight for X and Y data respectively. You can go to Data Selection page and expand x
and y nodes under Input Data to see.

8. Click Fit button and choose No radio box in the appeared Reminder Message dialog. The fitting results are as shown below:
You can refer to this page for the details of the algorithm of ODR as well as Levenberg Marquardt (L-M) algorithm. Another example of using Orthogonal Distance Regression for Implicit Functions can be found here.

4.4 Signal Processing

4.4.1 Signal Processing

- FFT and IFFT
- FFT Filter
- Smoothing
- STFT (Short-Time Fourier Transform)
- IIR Filter
- 2D FFT and Filter
- Convolution
- Wavelet
- Coherence and Correlation
- Decimation and Signal Envelope
- Rise Time
- Sound Processing

4.4.2 FFT and IFFT

<table>
<thead>
<tr>
<th>Videos</th>
</tr>
</thead>
<tbody>
<tr>
<td>• FFT</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>• How to Remove DC Offset before Performing FFT</td>
</tr>
</tbody>
</table>

4.4.2.1 Summary

FFT (Fast Fourier Transform) is able to convert a signal from the time domain to the frequency domain. IFFT (Inverse FFT) converts a signal from the frequency domain to the time domain. The FFT of a non-periodic signal will cause the resulting frequency spectrum to suffer from leakage. Origin provides several windows for performing FFT to suppress leakage.
4.4.2.2 What You Will Learn

In this tutorial, you will learn how to:

- Perform FFT on signal with different windows.
- Recover the original signal with the spectrum.
- Perform FFT on a graph by using the FFT gadget.

4.4.2.3 FFT Gadget

Origin's FFT gadget places a rectangle object to a signal plot, allowing you to perform FFT on the data contained in the rectangle. This is convenient for quickly observing the FFT effect on the data.

The following tutorial shows how to use the FFT gadget on the signal plot.

1. Start with a new workbook, and import the data `<Origin Installation Directly>\Samples\Signal Processing\Chirp Signal.dat`.

2. Highlight column B and make a line plot by clicking menu item **Plot>2D: Line: Line**.
3. With the plot active, select menu **Gadgets: FFT...** to start the FFT gadget.

4. Using the default settings, click **OK** to add the rectangular Region of Interest (ROI) to the graph.
5. Note that the **FFTPREVIEW** graph is created showing the FFT results for the selected data.

![Graph1](image)

6. You can move the rectangle left and right to cover different portions of the data. You can also change the width of the rectangle to cover different numbers of data points. Repositioning or resizing the ROI changes the **FFTPREVIEW** graph.

![FFTPREVIEW](image)

4.4.2.4 **FFT**

In this example, we are going to change the window for suppressing the spectrum leakage.
1. Use the same data as the **FFT Gadget** subsection above.

2. Highlight column B, then select menu **Analysis: Signal Processing: FFT: FFT...**. This opens the **FFT: fft1** dialog box.

3. In the dialog, check the **Auto Preview** box at the bottom to preview the result in the right panel. Change the **Window** to **Blackman**, but keep the remaining default settings. In the right panel, we can see that there is a sharp narrow peak spectrum for Amplitude. The **Blackman** window has suppressed the spectrum leakage very well.

4. Click **OK** to generate the resulting data and graphs.

4.4.2.5 **IFFT**
This example will show how to recover the signal from the results of doing an FFT. To do so, both settings for FFT and IFFT need to be the same, and the Spectrum Type needs to be Two-sided and Window needs to be set to Rectangle.

1. Start with your FFT results, above, and click on any of the green locks. Select Change Parameters... from the menu to open the dialog box again.

2. As mentioned above, the Window needs to be set to Rectangle, and Spectrum Type should be Two-sided, so edit these two settings.

3. Click OK and the results will be modified.

4. Go to the FFTResultData1 worksheet. We can see one column is Complex, one column is Real, and one is Imaginary. Here, we can use the Complex column (the Real column and Imaginary column also can be used). Highlight it and select the menu item Analysis: Signal Processing: FFT: IFFT... to open the FFT: ifft1 dialog. (Note, if using Real and Imaginary columns, the first line for Input should be the Real column, and the Imaginary box should point to the Imaginary column.) Check the Auto Preview check box at the bottom to preview the result in the right panel.
5. Keep the default settings and click the **OK** button.

6. Now, we can make a comparison between the IFFT result (in **IFFTResultData1** worksheet) and the original signal data. As the image below shows, they are almost the same.

4.4.3 FFT Filter
4.4.3.1 Summary

Origin offers an FFT filter, which performs filtering by using Fourier transforms to analyze the frequency components in the input dataset.

There are six types of filters available in the FFT filter function: low-pass, high-pass, band-pass, band-block, threshold and low-pass parabolic. Low-pass filters block all frequency components above the cutoff frequency, allowing only the low frequency components to pass. High-pass filters work in the opposite way: they block frequency components that are below the cutoff frequency.

This tutorial will show you how to perform the low-pass and band-pass filtering using Origin's FFT filter.

4.4.3.2 What you will learn

This tutorial will show you how to:

- Perform low pass filtering.
- Perform band pass filtering.

4.4.3.3 Low-pass Filter

1. Start with an empty workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Signal Processing subfolder and find the file Origin 8 Message.wav. Drag-and-drop this file into the empty worksheet to import it.
2. Highlight column A(Y) and click the **Line** button on the **2D Graph** toolbar to create a line plot.

3. This signal is a sound wave and it is already known that the high frequency components can be regarded as noise, and should be blocked. So we will use the **Low Pass** method in the **FFT Filter** tool to approximate the low frequency component for further analysis.

4. Make sure the line plot is active, then select **Analysis:Signal Processing:FFT Filters** to open the fft_filters dialog box.

5. Make sure the **Filter Type** is set to **Low Pass**.

6. Check the **Auto Preview** box to turn on the **Preview** panel:

![Preview Panel](image)

The top two images show the signal in the time domain, while the bottom image shows the signal in the frequency domain after Fast Fourier Transform. The X position of the red vertical dot line indicates the cutoff frequency. By moving the vertical line horizontally, you can preview the comparison between the original signal and the filtered signal in real time, in the top part of this panel.

7. Move the vertical line to the X position of the peak amplitude (as in the image below). Note that human error may be introduced during this step, but it is acceptable since we only want to roughly filter the signal.
8. Click **OK** to apply the FFT filter to the original signal.

9. The signal after filtering will be added to the data plot of original signal. Select **Graph: Speed Mode** and turn off speed mode in this graph. The resulting graph should look like this:

![Graph1](attachment:image.png)

10. In the resulting graph, we can see that the high frequency components are blocked by the Low Pass FFT filter.

4.4.3.4 **Band-pass Filter**
1. Start with a new workbook. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Signal Processing** subfolder and find the file **fftfilter3.dat**. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight column B and click the **Line** button on the **2D Graphs** toolbar to generate a line plot.

3. With the graph active, select **Analysis:Signal Processing:FFT Filters**. This opens the **fft_filters** dialog box.

4. Check the **Auto Preview** box to enable the **Preview** panel.

5. From the plot of frequency domain (the image below), we can see that this signal has components at several different frequencies. Now we are going to get the component at about 300Hz. So we will use the **Band Pass** method.
6. Set the **Filter Type** to be **Band Pass**.

When **Band Pass** is chosen, there will be two vertical red lines in the preview panel, marking the Lower Cutoff Frequency and Upper Cutoff Frequency. You can similarly move these two lines and get the real time preview of filtering results in the top parts of this panel.

7. Enter the values of the lower and upper cutoff frequencies according to the image below:

As long as only the desired amplitude peak stays within the cutoff frequency range, the error in filtering could be considered as acceptable even though the values of upper and lower cutoff frequencies may slightly differ for different cases.

8. Click **OK** to execute filtering.

9. We obtain the components at a frequency of around 300 Hz after filtering.
4.4.4 Smoothing

4.4.4.1 Summary

Smoothing is a common technique for removing noise from signals. Origin provides multiple smoothing methods, including Adjacent Averaging, Savitzky-Golay, Percentile Filter, and FFT Filter. Additionally, there is a wavelet-based tool available.

For matrix data, Origin’s smoothing is performed in two ways. If the number of columns or rows is less than 32, it will expand the matrix first, then shrink it back to the original size. If greater than 31, the matrix is first shrinked, then expanded.

4.4.4.2 What You Will Learn

This tutorial will show you how to:

- Smooth signals by several methods.
- Smooth signals using wavelets.
- Smooth a 3D surface.

4.4.4.3 Smoothing by Several Methods
1. Start with an empty workbook. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Signal Processing** subfolder and find the file **Signal with High Frequency Noise.dat**. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight column B in the worksheet. Then, select menu item **Analysis: Signal Processing: Smooth...** (if the tool has been used before, select **Open Dialog**) to open the **Smooth** dialog box.

**4.4.4.3.1 Adjacent-Averaging**

The Adjacent-Averaging method performs a broad smoothing of data.

1. Choose **Adjacent-Averaging** for **Method**. Set the **Points of Window** to **100** and **Boundary Condition** to **Periodic**. To preview the result in the right panel, check the **Auto Preview** check box.

2. Click **OK** to generate the result.
4.4.4.3.2 Savitzky-Golay

The Savitzky-Golay method is good for preserving the shapes of signal peaks.


2. In the smooth dialog box, set Method to Savitzky-Golay. Set Points of Window to 100, Boundary Condition to Periodic and Polynomial Order to 3.

3. Click OK.

4.4.4.3.3 Percentile Filter


2. For Method, choose Percentile Filter. Set Points of Window to 100, Boundary Condition to Periodic, and for Percentile accept the default value of 50.

3. Click OK button.
4.4.4.3.4 FFT Filter


2. Set Method to FFT Filter. Set Points of Window to 100.

3. Click OK to close the dialog box.

4. Note that in the worksheet, there are now four added columns containing the results of your four smoothing operations. Highlight those four columns (C,D,E,F), then from the menu select Plot>2D: Line: Line to make a line graph with these four datasets.
4.4.4.4 Smoothing by Wavelet

1. Start a new workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Signal Processing subfolder and find the file Signal with High Frequency Noise.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Highlight column B, and from the menu select **Analysis: Signal Processing: Wavelet: Smooth...** to open the **Smooth: wtsmooth** dialog box.

3. In the dialog, set **Wavelet Type** to **DB6**, and **Cutoff (%)** to **98**. Check **Auto Preview** to preview the result in the right panel.

4. Click **OK** to close the dialog box and generate your result.

5. To see the difference between the original signal and the smoothed signal, highlight all columns in the worksheet and from the menu select **Plot>2D: Line: Line**.
4.4.4.5 Smoothing Matrix

1. Start with a new matrixbook.
2. Select menu Data: Import from File: Image to Matrix... to import the image scale.jpg under the folder <Origin Installation Directory>\Samples\Image Processing and Analysis (if the impImage dialog box opens, simply accept the defaults and click OK).
3. Origin is not able to apply to perform smoothing on an image so we must convert the image to matrix data first. From the menu select Image: Conversion: Convert to Data.... Accept the dialog box default settings and Click OK.
4. With the converted matrix activated, select menu View: Image Mode to view this matrix as image.
5. To perform smoothing, select **Analysis: Signal Processing: Smooth**.... This opens the **Smooth: msmooth** dialog box.

6. Accept the default settings and click **OK**. To view the result, select **View: Image Mode** from the menu.
4.4.5 **STFT (Short-Time Fourier Transform)**

### Videos

- [Short-Time Fourier Transform (STFT)]

### OriginBlog

4.4.5.1 **Summary**

Short-Time Fourier Transform (STFT) is a time-frequency analysis technique suited to non-stationary signals. Short-Time Fourier Transforms can provide information about changes in frequency over time.

4.4.5.2 **What You Will Learn**

In this tutorial, you will learn how to:

1. Perform Short-Time Fourier Transform (STFT).
2. Change dialog settings to improve the time and frequency resolution.
3. Change window type to improve resolution.

4.4.5.3 **Steps**

1. Start with a new workbook, and import the data `<Origin Installation Directory>\Samples\Signal Processing\Chirp Signal.dat`. 
2. Highlight column B, and select menu **Analysis: Signal Processing: STFT**... to open the **STFT: stft** dialog box.

3. In the dialog box, check **Auto Preview** at the bottom of the dialog so that you can preview your results in the right panel. Uncheck the **Auto** check box next to **Window length** and **Overlap**, then change **Window length** to **8**, and **Overlap** to **7**. Set **Window Type** to **Hanning** and **Option** to **Amplitude Result**.
4. Click **OK** to perform STFT with the chosen settings and obtain your results, including a matrixbook with data and a color fill contour plot.
5. We can see from the above image that the time resolution is good, but the frequency is not so apparent. Click on the lock on the graph, then choose **Change Parameters**... from the menu. This reopens the STFT dialog box. Change the **Window Type** to **Rectangle** and click **OK**.
6. Now, we are better able to see resolution of both time and frequency. Please note that it is not possible to optimize for both time and frequency; the best we can do is to find the balance between them.

7. To view the result in 3D, activate the resulting matrix, then select menu **Plot>3D:Surface:3D Color Map Surface** to create a 3D surface of the result.

8. Double click on the 3D graph to open the **Plot Details** dialog, and go to the **Colormap/Contours** tab in the right panel. Click the **Line...** heading to open the **Contour Lines** dialog and **Hide All** lines.
9. Go to the **Mesh** tab and clear the **Enable** check box.
10. Click **OK** to finish the settings. To get a better view, rotate the graph.
4.4.6 IIR Filter

4.4.6.1 Summary

In OriginPro, it is possible to design, analyze, and implement IIR (Infinite Impulse Response) digital filters. The IIR filter supports four methods, including **Butterworth**, **Chebyshev Type I**, **Chebyshev Type II**, and **Elliptic**.

This provides users more choices in signal processing.

Minimum Origin Version Required: 9.0 SR0

4.4.6.2 What You Will Learn
This tutorial will show you:

- How to design and apply an IIR filter
- A comparison between IIR filter and FFT filter

4.4.6.3 Steps

4.4.6.3.1 Design and Apply IIR Filter

1. Start with a new worksheet and import the EMG Recording.dat file from \Samples\Signal Processing\.
2. Highlight column B and Select Analysis:Signal Processing:IIR Filter from the top menu to open the dialog.
3. Change the Response type as High Pass, keep the Method as Butterworth, uncheck the Minimum for Filter Order and set it as 4. In the Frequency Specification branch, set the Cutoff Frequency(Fc) as 20, then check the Forward-Backward Filtering. The dialog settings should look like the following figure, and the IIR filter is designed.
4. Click **OK** to apply the created IIR filter to the input dataset.

5. A new column will be added to the original data as a new column of filtered data and a new SOS Matrix worksheet.

### 4.4.6.3.2 Compare Results with FFT Filter

1. Highlight column B in the original worksheet, perform FFT filter by **Analysis:Signal Processing:FFT Filters**.

2. In the opened dialog, choose **High Pass** for Filter Type and set **20** as Cutoff Frequency.
3. Click OK button. Column C in the EMGRecording worksheet is the filtered result of the previously designed IIR filter, highlight column B and column C to generate a line plot with the button (Graph 1).

4. Use the scale in button to zoom the area between 12.5s and 13.3s.

5. Column E in the EMGRecording worksheet is the filtered result of the FFT filter, highlight column B and column E to generate a line plot with the button (Graph 2).

6. Also use the scale in button to zoom the area between 12.5s and 13.3s, the two graphs could be used for visualized comparison.
• Note that there are many ripples in the FFT filter result, but almost no ripples in the IIR filter result.

### 4.4.6.3.3 Ripples in FFT Filter

1. Highlight column E and click on the button to create a line plot (Graph 3).
2. Activate Graph 3, choose **Gadget:FFT** and set the X Scale as From 12.664 To 13.052.

3. Click OK to bring up the preview window, in which ripples are almost pure 20.125 Hz sine.

4. Now we will try to remove the ripples at 20.125 Hz by applying another high pass filter at 25 Hz, keep column E highlighted and select **Analysis:Signal Processing:FFT Filters**.
5. Select **High Pass** for Filter Type and set Cutoff Frequency as 25.

6. The result is listed in Column G, highlight column G and click on the button to create a line plot (Graph 4).

7. Activate Graph 4, choose **Gadget:FFT** and set the X Scale as From 12.664 To 13.052, in the preview window, there are still ripples, and they are shifted from 20.125 Hz to 25.157 Hz.
Note that the ripples could not be removed by FFT filter for this dataset.

### 4.4.7 2D FFT and Filter

#### 4.4.7.1 Summary

2D FFT (2-dimensional Fast Fourier Transform) can be used to analyze the frequency spectrum of 2D signal (matrix) data. Conversely, 2D IFFT (2-dimension Inverse Fast Fourier Transform) is able to reconstruct a 2D signal from a 2D frequency spectrum. OriginPro provides both for conversion between time and frequency domains in 2 dimensions, together with the 2D FFT filter to perform filtering on a 2D signal.

#### 4.4.7.2 What You Will Learn

This tutorial will show you how to:

1. Convert image into data.
2. Perform 2D FFT on matrix data with DC shift to center.
3. Perform 2D IFFT on the 2D FFT result to recover the original matrix data.
4. Perform 2D FFT filter on matrix data.

#### 4.4.7.3 Steps

##### 4.4.7.3.1 2D FFT

1. Start with a new matrixbook, and select menu item **Data: Import from File: Image to Matrix...** to import the image `<Origin Installation Directory>\Samples\Image Processing and Analysis\cell.jpg`. 
2. Because Origin is not able to perform analyses on image data directly, we need to convert the image to matrix data first. So, select menu item **Image: Conversion: Convert to Data** to bring up the **Convert to Data: img2m** dialog box. Set **Type** to **byte(1)**.

3. Click **OK** to finish the conversion. The result shows below. You can choose menu item **View: Data Mode** and **View: Image Mode** to convert between data mode and image mode.
4. With the converted result matrix active, select the menu item **Analysis: Signal Processing: FFT: 2D FFT...** to open the **2D FFT: fft2** dialog box. Check the **DC Shift Center** check box to shift the direct current to center. In the **Output** node, only check **Complex Matrix** and **Log Amplitude Matrix**.
5. Click the **OK** button to generate the FFT results. Both the complex matrix and the log amplitude matrix are in the same matrixbook. Change to image mode (**View: Image Mode**) for the log amplitude matrix. The results should look like this:
4.4.7.3 2D IFFT

1. Start with the complex matrix (FFT2_Complex1) generated in the 2D FFT section above. Make it the active window.

2. Select the menu item **Analysis: Signal Processing: FFT: 2D IFFT...** to bring up the 2D IFFT: ifft2 dialog box.

3. In the dialog box, the imaginary matrix is not needed because the Input Matrix is a complex matrix. Check Undo Shift because DC has been shifted. Output should have the Real Matrix and Imaginary Matrix boxes checked.

4. Click the **OK** button, and the result will be output to the same matrixbook as the input complex matrix.
5. From the comparison shown below, the IFFT has recovered the original signal.

### 4.4.7.3.32D FFT Filter

1. Start with an empty matrixbook and from the menu select `Data: Import from File: Image to Matrix...` to import the image `<Origin Installation Directory\Samples\Image Processing and Analysis\myocyte1.tif>`. 
2. With the imported image active, select the menu item **Image: Conversion: Convert to Data**. This opens the **Convert to Data: img2m** dialog box. Set **Type** to **byte(1)** and click **OK** to finish the conversion.
3. Activate the converted matrix and select the menu item **Analysis: Signal Processing: 2D FFT Filters**.... This opens the **2D FFT Filters: fft_filter2** dialog box.

4. In the dialog box, check the **Auto Preview** check box at the bottom to view the result in the right panel. Set **Filter Type** to **Band Pass**, and set **Lower Cutoff Value** and **Upper Cutoff Value** to **0.05** and **0.25** respectively. For other controls, keep the default values.

5. Click **OK** to obtain the filtered result. As the image below shows, the background noise (the light) is removed.
4.4.8 Convolution

4.4.8.1 Summary

Convolution is commonly used in signal processing. Origin uses the convolution theorem, which involves the Fourier transform, to calculate the convolution.

4.4.8.2 What You Will Learn

With this tutorial, you will learn how to perform convolution in Origin.

4.4.8.3 Steps

1. Start with a new workbook.

2. Import the data `<Origin Installation Directory>\Samples\Signal Processing\Convolution.dat`. 
3. Highlight column B and C, and from the menu select **Analysis: Signal Processing: Convolution**... This opens the **Convolution: conv** dialog box. In the dialog, column B is labelled as Signal, and column C as Response and the Sample Interval will be set according to the input signal's associated X column.

4. Expand the **Options** node and change **Convolution Type** to **Circular**, to repeat the data within range for the data outside range, but not pad with zeroes.
5. Click **OK** to obtain the result.

6. In the worksheet, highlight column B and E (press CTRL to select non-adjacent columns), then from the menu select **Plot: Line: Line** to make a graph with input signal and the output signal.
4.4.9 Wavelet

4.4.9.1 Summary

Wavelet transforms are useful for analyzing signals which exhibit sudden changes of phase and frequency, local maxima and minima, or related parameters. Wavelet transforms have become a popular tool in time-frequency analysis, especially for analysis of non-stationary signals. OriginPro provides wavelet transform tools for both continuous and discrete transforms.

4.4.9.2 What You Will Learn

This tutorial will show you how to:

1. Perform one-level discrete wavelet decomposition and reconstruct a signal from approximation coefficients and detail coefficients.
2. Apply multi-level discrete wavelet decomposition.
3. Perform continuous wavelet transform.
4. Remove noise from signals by using wavelet transform.
5. Perform 2D wavelet decomposition and reconstruction on matrix data.
6. Convert an image to matrix data.
7. Merge graph windows into one graph.

4.4.9.3 1D Wavelet Transform

4.4.9.3.1 Decomposition
1. Start with an empty workbook. Select **Help: Open Folder: Sample Folder...** to open the “Samples” folder. In this folder, open the **Signal Processing** subfolder and find the file **Chirp Signal.dat**. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight column B, and select menu item **Analysis: Signal Processing: Wavelet: Decompose...** to open the **Decompose: dwt** dialog.

3. In the dialog, choose **DB6** for **Wavelet Type & Order**, and **Zero-padded** for **Extension Mode**.

4. Click **OK** to close the dialog box and output the approximation coefficients and the detail coefficients.
5. Highlight columns B, C, and D (columns C and D should contain your approximation coefficients and your detail coefficients, respectively). From the menu, select **Plot: Multi-panel: Stack...** to open the **Stack: plotstack** dialog box.

6. In this dialog, clear the **Link Layers** check box in the **Options** node. Check the **Auto Preview** check box at the bottom to see the preview graph in the right panel.

7. Click **OK** to close the dialog box and create a stack graph.
Data Analysis

4.4.9.3.2 Reconstruction

Reconstruction is the inverse operation of decomposition and this example will recover the signal from the result generated above.

1. Highlight columns C and D (your approximation coefficients and detail coefficients, from above).
2. Choose menu item **Analysis: Signal Processing: Wavelet: Reconstruction...** to bring up the **Reconstruction: idwt** dialog box.
3. To reconstruct the signal, we need to specify the same **Wavelet Type**, and **Boundary**, so set them to **DB6** and **Zero-padded**, respectively.

Note: To perform level 2 (3, 4, etc.) discrete wavelet decomposition, repeat steps 2 to 4 on the approximation coefficients (column C, in our example). Multi-scale wavelet decomposition (available in OriginPro) is demonstrated below.
4. Click OK and the recovered signal is output to column E of the worksheet.

5. Press CTRL and select columns B and E. From the menu, choose Plot: Line: Line to make a graph with these two columns of data.

6. We can see from the resulting graph that the original signal and the recovered signal overlay each other.
4.4.9.3.3 Multi-Scale Wavelet Decomposition

1. Start with a new workbook, and then import the same data used in the Decomposition section above.
2. Highlight column B and select menu item Analysis: Signal Processing: Wavelet: Multi-Scale DWT... to open the Multi-Scale DWT: mdwt dialog box.

3. In the dialog, change Extension Mode to Zero-padded, and Decomposition Level to 3. Click the arrow button beside Multiple Coeff Data and select \([<input>]<input>\) from the menu.

4. Click OK to obtain 3rd level discrete wavelet decomposition results. The coefficients are stored in the same worksheet as the input signal.

5. Select all columns in the worksheet, then choose menu Plot: Multi-panel: Stack... to open the Stack: plotstack dialog box. Click the arrow button to the right of Dialog Theme and select System Default. Check the Auto Preview check box at the bottom of the dialog box to preview the graph.
6. Click **OK**. The resulting graph is shown below.
4.4.9.3.4 Continuous Wavelet Transform

1. Start with a new workbook with two empty columns (columns A and B) in a single worksheet.

2. Select column A and then right-click and choose Set Column Values... from the shortcut menu. This opens the Set Values dialog box. In the text box, enter data(0, 1, 1/1023) and click Apply. This fills column A with data.
3. Click the >> button to select column B. Enter \( \sin(1.5/(0.25 - \text{col}(A))) + \cos(0.2/(0.2 - \text{col}(A))) \) and click OK.

4. We can make a plot to see how the data looks. With column B selected, choose Plot: Line: Line from the menu.
5. With the worksheet active, add a new column to the worksheet by selecting **Column: Add New Columns...** from the menu. In the dialog box, accept the default value of 1 and click **OK**.

6. Column C is added to the worksheet. Select it, right-click and choose **Set Column Values** from the shortcut menu. In the text box, enter `data(1, 512)` and click **OK**.
7. Select both columns B and C, then from the menu, select Analysis: Signal Processing: Wavelet: Continuous Wavelet... to open Continuous Wavelet: cwt dialog box.

8. In the dialog, set Wavelet Type to MexHat, and check Coefficient Matrix.

9. Click OK button to exit dialog.
10. The coefficients are output to a new worksheet and a matrix and a contour plot is added. Double-click on the plot to open the **Plot Details** dialog box. Select the **Colormap** tab and click on the **Fill...** heading. The **Fill** dialog box opens with color controls. Click **Load Palette**, and choose **Pumpkin Patch** from the **Select Palette** menu. Click **OK** to return to the **Plot Details** dialog box.

11. Click **OK** to change the color of the contour plot. It should now look like the graph below.
4.4.9.3.5 Noise Removal by Wavelet Transform

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Signal Processing subfolder and find the file Signal with Shot Noise.dat. Drag-and-drop this file into the empty worksheet to import it.
2. We can see from the Sparklines in the image above that there is shot noise in the signal. Highlight column B and select menu **Analysis: Signal Processing: Wavelet: Denoise...** to bring up the **Denoise: wtdenoise** dialog box.

3. Check **Auto Preview** to preview your result. Set **Wavelet Type** to DB9, **Extension Mode** to Zero-padded, **Threshold Type** to sqtwolog, and **Thresholding Level** to 7.

4. Click **OK** to remove the shot noise from the signal. Results are output to worksheet columns C and D.
5. Highlight all columns in the worksheet, then choose menu item **Plot: Line: Line** to make a graph with the original signal and the cleaned-up signal. We see from the graph below that the shot noise has been removed.
4.4.9.4 2D Wavelet Transform

4.4.9.4.1 2D Wavelet Decomposition

1. Start with a new matrixbook. From the menu, choose Data: Import from File: Image to Matrix... and import the image, <Origin Installation Directory>\Samples\Image Processing and Analysis\Car.bmp.
2. To begin, we need to convert the image into data. To do this, select menu item Image: Conversion: Convert to Data. The Convert to Data: img2m opens. Set Type to byte(1).

3. Click OK to obtain the converted matrix data.

4. With the converted matrix active, select menu Analysis: Signal Processing: Wavelet: 2D Decompose... and open the 2D Decompose: dwt2 dialog box.
5. Accept the default settings and click OK. This performs 2D wavelet decomposition on the matrix data. A matrix book with four matrix sheets (CA, CH, CV, and CD) is generated. CA, CH, CV, and CD contain approximation coefficients, horizontal detail coefficients, vertical detail coefficients, and diagonal detail coefficients respectively. You can change the view mode to image mode by choosing View: Image Mode from the menu.
With the CA matrixsheet active, make an image plot by selecting Plot: Image Plot from the menu. Repeat for CH, CV, and CD matrixsheets.

7. Double click on graph of them to open the Plot Details dialog, in the left panel, activate Layer1, and then go to the Size/Speed tab in the right panel, and deselect the Matrix data, maximum points per dimension checkboxes. Click OK. select the axes related objects (including axis, label) in the graph and press the DELETE key to delete them.

### 4.4.10 Coherence and Correlation

#### 4.4.10.1 Summary

Coherence measures the degree of linear dependency of two signals by testing for similar frequency components. If two signals correspond to each other perfectly at a given frequency, the magnitude of coherence is 1. If they are totally unrelated coherence will be 0.

Correlation is another measure of the relationship between two signals. A correlation coefficient is used to evaluate similarity. If two signals have a high degree of similarity, the magnitude of the computed correlation coefficient is large. If there is little or no linear relationship between two signals, the magnitude of the coefficient is small.

#### 4.4.10.2 What You Will Learn

This tutorial will show you how to:

1. Test coherence and find out the frequency where two signals are in the highest degree of linear dependency.
2. Perform correlation and find the lag to translate a dataset.

#### 4.4.10.3 Coherence

1. Start with a new workbook.

2. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Signal Processing subfolder and find the file Coherence.dat. Drag-and-drop this file into the empty worksheet to import it.
3. Select column A, then right-click and select Set As: Y from the shortcut menu. This sets the plot designation for column A to Y.

4. Highlight the two columns and from the menu select Analysis: Signal Processing: Coherence... This opens the Coherence: cohere dialog box.

5. Change the Window Type to Welch, and click OK.
6. Two columns of data are added to the worksheet. Highlight these two new columns and from the menu select **Plot > Basic 2D: Line** to plot coherence against frequency.
7. Select the Data Reader on the Tools toolbar to read the strongest peak in the graph. The image above shows that at a frequency of 0.25 there is a strong peak, indicating a strong correspondence between the two signals at this frequency.

4.4.10.4 1D Correlation

1. Start with a new workbook.

2. Select menu File: Import: Single ASCII... and import the file <Origin Installation Directory>\Samples\Signal Processing\Correlation.dat.

3. Select column A. Right click on it to open the shortcut menu, then choose item Set As: Y to set this column's plot designation to Y.

4. Highlight the two columns and from the menu select Analysis: Signal Processing: Correlation.... This opens the Correlation:corr1 dialog box. Accept the default settings.
5. Click **OK** to perform a correlation on the two signals.

6. The correlation result and a time lag column are output to the worksheet. Highlight column D, and from the menu select **Plot > Basic 2D: Line** to plot the result.
7. The Data Reader in the image above shows that at Time = 49, there is a strong positive peak, which means that the second dataset needs to be translated forward 49 units to align these two signals.

8. Return to the worksheet, highlight column A and B, then from the menu select **Plot > Multi-Panel/Axis: Vertical 2 Panel** to plot the two signals to two separate graph layers.

9. Double click on the top plot to open the **Plot Details** dialog box. In the left panel, select **Layer 2** (take care not to clear the check box). Go to the **Link Axes Scales** tab in the right panel and click the **Straight (1 to 1)** radio button in the **X Axis Link** group.
10. Click **OK** and both X axes now have the same scale.

11. To make the datasets movable, delete the lock by clicking on it and choosing **Recalculate Mode: None**. Click **OK** if the **Reminder Message** dialog pops up.
12. Select the top plot, then select menu **Analysis: Data Manipulation: Horizontal Translate** to add a vertical line to the layer, together with a triangle button. Click on the triangle button to open a menu and uncheck **Keep Tool after Translation**. Open the menu again, select **Translate Duplication in: New Columns** from the menu. Another two columns will be added and the source data of current curve will be copied to these two new columns.

![Data Analysis](image1.png)

13. Again, open the menu and click **Shift Curve...** to bring up the **Shift Curve** dialog box. Set **Value** to 49.

![Data Analysis](image2.png)
14. Click **OK** to translate the plot. This should align the two signals.

4.4.11 Decimation and Signal Envelope

4.4.11.1 Summary

Decimation is used to reduce the size of the signal sequence by merging every N samples into one. Envelope detection adds an envelope curve to the input signal. Origin’s signal envelope tool computes an envelope and plots an upper envelope, a lower envelope, or both.

4.4.11.2 What You Will Learn

This tutorial will show you how to:

1. Decimate a signal to reduce the size of the input signal sequence.
2. Perform envelope detection to add the envelope curve.

4.4.11.3 Decimation

In this tutorial, we are going to perform decimation on sunspot count data. Measurements of sunspot number were collected every month for more than 200 years. We will use decimation to reduce our dataset to one sunspot count for each year.

1. Start with a new workbook, and import the data `<Origin Installation Directory>\Samples\Signal Processing\Sunspot.dat`. 

---

436
2. Select column A. Right click on the column and choose Set As: Y to set this column’s plot designation to Y. This will ensure that sunspot number is not associated with column A as X. That is because decimation needs the X column data to be strictly monotonic.

3. Select column C and from the menu choose Analysis: Signal Processing: Decimation.... This opens the Decimation: decimate dialog box.

4. In the dialog, set Resample Factor to 12. Set the Filter Type to Moving Average Filter. To preview the result in the right panel, check the Auto Preview check box.
Tutorials for Origin 2024b

5. Click **OK** to output results.

6. In the worksheet, select column D (the X column generated from the result), then right-click and choose **Insert** from the shortcut menu to insert a new column. Right click again and choose **Set As: Y** to change the column's plot designation as **Y**.

7. Highlight the newly inserted column and right click on it and choose **Set As: X** from the context menu to change this column's plot designation to **X**. Right-click on the column again and choose **Set Column Values...** to bring up the **Set Values** dialog box and enter \( data(1749, 1749 + 255) \) into the text box and and click **OK**.

8. Select column A, then right-click to choose **Set As: X** from the shortcut menu, to set the column's plot designation back to **X**. The final worksheet will look similar to the one below.
9. Press CTRL and select columns C and E. From the menu, choose **Plot: Multi-Panel: Vertical 2 Panel** to make a graph. Note that the decimated line looks smoother as the image below shows.
Tutorials for Origin 2024b

1. Start with a new workbook.

2. Select menu item **Data: Import from File: Single ASCII...** to import the data <Origin Installation Directory>\Samples\Signal Processing\Gaussian Envelope.dat.

3. Highlight column B and from the menu choose **Plot: Line: Line** to create a line plot.
4. With this graph active select **Analysis: Signal Processing: Envelope...** from the menu. This opens the **Envelope: envelope** dialog box.

5. In the dialog box, set **Envelope Type** to **Both Envelopes**, and **Smooth Points** to **10**. Check the **Auto Preview** box to preview the result in the right panel.
6. Click OK to create the graph showing upper and lower envelope curves.

4.4.12 Rise Time
4.4.12.1 Summary

In a step-like signal, rise time refers to the time required to change from a specified low value to a specified high value (or from a specified high value to a specified low value in the case of fall time). Origin's rise time tool allows you to graphically select a rectangular area tracing a rising or falling step in the signal, and from it calculate the rise time or fall time for this selected step.

4.4.12.2 What You Will Learn

With this tutorial, you will learn how to:

1. Use the Rise Time gadget tool to calculate the fall time.
2. Change the settings for fall time calculation.
3. Set the display elements on the graph.
4. Select the desired output options and output the result to worksheet.

4.4.12.3 Steps

1. Start a new workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Signal Processing subfolder and find the file Step Signal with Random Noise.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight column B and make a line plot of it by selecting Plot: Line: Line from the menu.
3. Click the **Scale In** button on the **Tools** toolbar, then select a range along the X axis from about 500 to 700, so that we can focus on this portion of the plot.

4. With the graph active, choose **Gadgets: Rise Time...** from the menu to launch the tool.
5. In the dialog box, click the **ROI Box** tab and set **X Scale From** to 510 and **To** to 650. Set **Tool** to **Fall Time** and **Method** to **Histogram**.

6. Click the **Fall Range** tab and change **From (%) of Step Height** to 20 and **To (%) of Step Height** to 80.

7. Click the **Quantities** tab, check only three check boxes: **Dataset Name(name)**, **Fall Range(dVref)** and **Fall Time(dT)**.
8. Click the **Output To** tab, clear **Script Window** and check **Append to Worksheet**.

9. Click the **Display on Graph** tab, expand the **Indicator** branch, and change **Edge Color** to **Blue**. Check **Fall Range**.
10. Click **OK** to add the rectangular region-of-interest (ROI) to the graph.

11. As the above image shows, the two red horizontal lines delineate the upper level and lower level. The vertical distance between the two blue lines is the fall range, shown by the two indicator points on the line plot. At the top of the rectangle, the fall time and fall range are reported.
12. Click on the triangle button in the upper-right corner of the ROI to open a menu and select **Fix ROI Position**, so that the yellow ROI rectangle is locked in place.

13. Open the menu again and click **New Output** to output the results. Open the menu again and choose **Go to Report Worksheet**.

14. The report worksheet is activated and we can see that the three parameters that we chose on the **Quantities** tab are reported.
4.4.13 Sound Processing

4.4.13.1 Summary

Origin features some useful signal processing tools, such as smoothing, FFT filtering, and spectral analysis tools like the Fast Fourier Transform (FFT). These can be useful for performing sound analysis. This tutorial will remove a specific noise from an audio signal (.WAV file) based on the spectral range of the noise.

Minimum Origin Version Required: Origin 9 SR0

4.4.13.2 What You Will Learn

1. Import a sound file (.WAV) into Origin.
2. How to view sampling interval information.
3. How to use FFT gadget to check the frequency spectra of a signal.
4. Perform FFT filter on the audio signal.
5. Export a filtered signal as a .WAV file.

4.4.13.3 Steps

In this tutorial, we will use "Origin8 Message.wav" and "Dial Tone.wav" which can be found under the subfolder "\Samples\Signal Processing\" of the Origin installation folder.

Play the sound file "Origin 8 Message.wav" and you will hear a dial tone noise in the background. The 2nd file is a recording of the dial tone.

1. Start Origin, and create a new project with an empty worksheet in a workbook.

2. Select menu File: Import: Sound (WAV)... to open the Sound dialog. (Hint: if this menu item is not shown, select menu File: Import: Customize... to open the Import Menu Customization dialog to add it.) Navigate to the "\Samples\Signal Processing\" folder and double click "Origin 8 Message.wav" and "Dial Tone.wav" to add them to the import list. Make sure Show Options Dialog is checked and click OK.
3. In the **Import and Export: impWav** dialog, click the triangle button to the right of **Dialog Theme**, and select **System Default** from the context menu. Then expand **Import Options** node, change **Multi-File (except 1st) Import Mode** to **Start New Sheets**.
4. Click **OK** to import the two sound files into two worksheets:

5. In each worksheet, we can see the **Sampling Interval** has the same value of **2.26757E-5 (second)**. Click the / icon in the top left corner of the column and the **Column additional information** dialog pops up with the sampling interval information. Click **OK** to close this dialog.
6. With **Dial Tone** worksheet activated, highlight column A, and select menu **Plot: Line: Line** to make a line plot.

7. Using this graph, select menu **Gadgets: FFT** to open the **Data Exploration: addtool_curve_fft** dialog. Using the default settings, click **OK** button to perform an FFT of the data and create the **FFTPREVIEW** graph with the results.
8. Uncheck the Log Scale checkbox on the FFTPREVIEW graph, and then select menu **Graph:** Rescale to Show All to rescale the graph. We can see that the distribution of frequency is mainly under 2000 Hertz with the largest peaks being under 500 Hertz.
9. Activate the worksheet **Origin 8 Message** and highlight column A. Select menu **Analysis: Signal Processing: FFT Filters** to open the **Signal Processing: fft_filters** dialog. In the dialog, change **Recalculate** to **None**, select **High Pass** for **Filter Type**, uncheck the **Auto** checkbox for **Cutoff Frequency** and change value to 500. Clear **Keep DC Offset** checkbox. We can auto preview the result by ticking the **Auto Preview** checkbox at the bottom, and the result will be shown in the right panel, which can be shown or hidden by using the button in the bottom right corner of the left panel.

Note: If **Recalculate** is not **None**, the results need to be copied to new columns without the recalculate lock for changing the **Data Type**, see step 11 below.

10. Click **OK** to generate the results. We can see that the filtered result is in floating point format. In order to create a new WAV file, we need to convert this to an integer format.
11. Highlight column D (the filtered result column), and then choose Properties... item from the right-click context menu, to open the Column Properties dialog. In this dialog, expand Options node, set Format to Numeric, then change Data Type to Short(2). Click OK to apply these settings to column D and close this dialog.
12. Keeping column D highlighted, select menu File: Export: Sound (WAV)... In the open dialog, enter a file name (such as Origin 8 Message_filtered.wav) and save to a familiar location. Make sure the Show Options Dialog checkbox is ticked.

13. Click Save button and the Import and Export: expWAV dialog pops up. Clear the Auto checkbox for Column, and change it to 4.
Note: The **Column** is specified for the Y column, and Origin will find its sampling interval if exists or its associated X column. If no X column or the X column is not even spacing, there will be error messages.

14. Click **OK** to export column D as a wave file. Now you can play this wave file and hear that the dial tone has been removed. Note that information with the same spectra as the dial tone is also removed.

### 4.5 Peak Analysis

#### 4.5.1 Peak Analysis

- **4.5.1.1** [Create and Subtract Baseline with Peak Analyzer](#)
- **4.5.1.2** [Batch Peak Analysis Using Theme with Script Before Each Process](#)
- **4.5.1.3** [Combine Quick Peaks Gadget with Peak Analyzer](#)
- **4.5.1.4** Peak Finding
  - [Picking and Marking Peaks](#)
- **4.5.1.5** Peak Integration
  - [Integrating Peaks](#)
- **4.5.1.6** Peak Fitting
4.5.2 Create and Subtract Baseline with Peak Analyzer

4.5.2.1 Summary

In OriginPro, the Peak Analyzer is capable of creating and subtracting baseline. There are various ways for baseline creation. You can generate baseline anchor points automatically or manually and then connect them with interpolation or fit them with a function.

Minimum Origin Version Required: 2016 SR0

4.5.2.2 What you will learn

- How to create baseline with 2nd Derivative method
- How to create baseline with Asymmetric Least Squares (ALS) Method (Pro)
- How to subtract a baseline from the spectrum

4.5.2.3 Steps

4.5.2.3.1 Create baseline with 2nd Derivative method
1. Start a New Workbook and import the `<Origin EXE Folder>\Samples\Spectroscopy\Baseline.dat`. Highlight the second column. In the main menu, select Analysis: Peaks and Baseline: Peak Analyzer to open the dialog of the Peak Analyzer.

2. In the first page (the Goal page) of the Peak Analyzer, select Create Baseline as Goal. Click Next to go to the Baseline Mode page.

3. Next we are going to create an user defined baseline for this spectrum by defining anchor points. On the Baseline Mode page, select User defined from the Baseline Mode dropdown list. Check on Snap to Spectrum to make sure when you add or move a baseline anchor point, it will be pulled back onto the spectrum.
4. The first two methods in Anchor Points Finding are the most commonly used, and they can find anchor points automatically based on the derivative of the spectrum. If the baseline is approximately constant, 1st Derivative and 2nd Derivative is more powerful, otherwise, we should use 2nd Derivative. In this example, the baseline is more curly, so we use 2nd Derivative(zeros) method for locating anchor points.

For other methods in Anchor Points Finding and related smoothing parameters, you can refer to the link: Baseline Mode Page.

5. Now click the Find button in the Baseline Anchor Points group. You can preview the anchor points in preview window.
6. Click **Next** to go to the **Create Baseline** page, select **Interpolation** in the **Connect by** drop-down list. In **Interpolation** method group, select **Spline** from the drop-down list. You can preview the spectrum in preview window, and then click **Finish** to get the baseline data.
4.5.2.3.2 Create baseline with ALS Method (Pro)

1. Start from the Baseline Mode page, and select the **Asymmetric Least Squares Smoothing Baseline** (ALS) as the baseline method. The ALS baseline can be tuned easily with a few parameters without pre-selecting any anchor points.
2. Click **Next** go to **Asymmetric Least Squares Smoothing Baseline** page, adjust the parameters to make the baseline optimal, then click **Finish** button to output the results table and graph.
4.5.2.3.3 Subtract Baseline from a Spectrum

1. If you want to subtract baseline, select **Subtract Baseline** as the **Goal** at start page.
2. After you created a baseline, click **Next** button to go to **Subtract Baseline** page.
3. Click **Subtract** button for previewing the subtracted data. The baseline data and subtracted spectrum will be outputted after clicking **Finish** button. The figures below displayed the **Subtract Baseline** page and the preview of the subtracted spectrum.
4.5.3 Use Script to Search for Baseline Anchor Points in Peak Analyzer

4.5.3.1 Summary
In OriginPro, the Peak Analyzer is capable of creating and subtracting baseline. You can create a baseline by finding baseline anchor points first and then connect those anchor points either by interpolation or by fitting. To search for those baseline anchor points, you can either use built-in methods or define the search method on your own using LabTalk scripts.

4.5.3.2 What you will learn

- How to create baseline with user-defined scripts
- How to integrate peaks from user-defined baseline

4.5.3.3 Steps

4.5.3.3.1 Create baseline with User-Defined Scripts

1. Start a New Workbook and import the <Origin EXE Folder>\Samples\Spectroscopy\Chromatography\Liquid chromatogram.dat. Highlight the second column. In the main menu, select Analysis: Peaks and Baseline: Peak Analyzer to open the dialog of the Peak Analyzer.
2. Make sure Goal is selected as Integrate Peaks and click Next button to go to Baseline Mode page.
3. Select Baseline Mode as User Defined and continue to select Anchor Points Finding Method under Baseline Anchor Points node as Use Script to Search.
4. Enter apt_x and apt_y in X= and Y= edit boxes, respectively. Then paste the scripts shown below into Before Formula Script box. Click Find button will run the scripts and the detected baseline anchor points will display on the preview window.
Dataset dspos;

pkfind iy:=(dsx, dsy) dir:=p npts:=5 value:=200 ocenter:=dspos; // Find major peak positions

int npk=dspos.GetSize(); // Get major peak numbers

    // Create datasets to store anchor points

int nn = dsx.GetSize(); // Get source X size

dataset apt_x, apt_y; // Create datasets to store anchor points

apt_x.SetSize(npk+1); // Set anchor points number

apt_y.SetSize(npk+1);

apt_x[1] = dsx[1]; // Set 1st data point as 1st anchor point
The script will firstly find all major peak positions and then treat the minimum between every two adjacent
peaks as one baseline anchor point, then add the first and last data points as two baseline anchor points.

Note: You can still uncheck Enable Auto Find checkbox and then use Add or Modify/Del to add or remove
baseline anchor points.

5. Click Next button to go to Create Baseline page, make sure Connect by is selected as Interpolation
and the Interpolation Method is Line. Then click Finish to obtain integration areas for each peak.

4.5.4 Batch Peak Analysis Using Theme with Script Before Each Process

- Introduction Batch Processing without Programming
- Sequentially initialize fitting parameters in batch peak
4.5.4.1 Summary

Origin can perform batch peak analysis of multiple datasets using an Analysis Theme. You can choose to pre-process the peak data (e.g., exclude unwanted datasets) before actually inputting data, by running a script before each process. Note that while Batch Peak Analysis Using Theme is not an OriginPro-only feature, this tutorial uses the Peak Analyzer Goal of Fit Peaks to create the Theme and Fit Peaks is a Pro-only feature.

Minimum Origin Version Required: 2016 SR0

4.5.4.2 What Will You Learn

This tutorial will show you how to:

- Save analysis settings as a theme for batch peak analysis
- Write script before each process to pre-process data
- Do batch peak analysis using an analysis theme

4.5.4.3 Steps

4.5.4.3.1 Save Analysis Settings as a Theme

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open Tutorial Data.opj and browse to the Script Before Process in Batch PA folder in Project Explorer (PE).
2. Click on worksheet Data1 in the workbook. Highlight column B and go to menu Analysis: Peaks and Baseline: Peak Analyzer to open dialog. Select Fit Peaks(Pro) as Goal.
3. Click Next button, select None(Y=0) as Baseline Mode. Click Next button twice to go to Fit Peaks(Pro) page, expand Configure Graph subnode under Result node and set Create Summary Graph to <None> to turn off generating report graph, which can speed up the analysis process.
4. Now click the button next to the Dialog Theme control and select Save as ... to open Theme Save as... dialog. In the Theme Name edit box, enter MyPeakAnalysis and click OK button to save it.
5. Click Finish Button to perform the analysis and output results.

4.5.4.3.2 Prepare Script for Pre-processing Peak Data

- Pre-processing of Data for Batch Analysis
- Dialog Themes: Time-saving Feature for Recalling Analysis Dialog Settings
- Batch Processing of Peak Data Using Theme
The **Batch Peak Analysis Using Theme** dialog provides three edit boxes to allow running script before each process, after each process and at the end of all processes. In this section we will mainly show how to write script before each process to pre-process the peak data.

1. Activate worksheet **Data1** again, we can see from the sparkline of each dataset that some of peak data are very noisy, e.g., column $C$, $E$, $F$, and we want to exclude such noisy dataset if it reaches certain noise level.

2. The way used to identify whether data is noisy in this tutorial follows the routine below (if you don’t see the Sparklines label row, right-click in the gray area to the right of your worksheet columns and enable by **View: Sparklines**):
   - Filter raw data with a high-pass FFT filter to obtain the high-frequency noise from the data.
   - Find the standard deviation(SD) of the noise and the corresponding raw data.
   - Set a criteria that if the ratio of the square of SD of the noise over the square of SD of the raw data is over 30%, it will be regarded as noisy data and will be excluded for batch analysis.

3. Follow the routine above, the script for pre-withholding noisy data is as following:

   ```plaintext
   dataset dr;
   fft_filters iy:=_ry filter:=high oy:=dr; // Perform high-pass fft filter to obtain noise
   stats dr;
   double nSD = stats.sd; // Calculate SD of noise
   stats _ry;
   double sSD = stats.sd; // Calculate SD of raw data
   if(nSD^2/sSD^2>0.3) // Set noise identification criteria
     _skip=1;
   else
     _skip=0;
   ```

4. where _ry refers to current y data, _skip determines whether to skip current dataset.

4.5.4.3.3 Batch Analyze Datasets Using Analysis Theme
1. Activate worksheet Data1, highlight all columns in the sheet and go to menu Analysis: Peaks and Baseline: Batch Peak Analysis Using Theme... to open dialog.

2. Select MyPeakAnalysis from Theme drop-down list, Peak Properties(Pro) from Result Sheet drop-down list.

3. To output results to a specified sheet, you can enter the range syntax in Output Sheet edit box. Suppose we want to export to MyResults sheet in MySummary book, you can input [MySummary]MyResults! in the edit box.

4. Input the script we wrote in section above into Script Before Each Process under Script node (Hint: Clicking the button to the right of the text box opens an edit box where you can paste and edit your script).
5. Click **OK** button to perform batch peak analysis and you will see noisy datasets (say column C, E and F) are excluded in **MyResults** sheets.

![Image of MyResults sheet]

### 4.5.5 Combine Quick Peaks Gadget with Peak Analyzer

#### 4.5.5.1 Summary

The Quick Peaks gadget provides an intuitive way to carry out peak analysis, and Peak Analyzer provides further options for peak finding, fitting, etc. You can first use Quick Peaks gadget to find peaks and then use the Peak Analyzer to analyze the peaks. You can save the whole analysis as a theme in the Peak Analyzer for future use and/or batch processing.

Minimum Origin Version Required: OriginPro 9.0 SR0

#### 4.5.5.2 What You Will Learn

This tutorial will show you how to:

- Use the Quick Peaks gadget to find peaks.
- Open the Peak Analyzer from Quick Peaks gadget.
- Further analyze the peaks found in Quick Peaks gadget using the Peak Analyzer.

#### 4.5.5.3 Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

1. Open **Tutorial Data.opj** and browse to the **Quick Peaks Gadget** folder in **Project Explorer** (PE).
2. Highlight all columns in the **Nitrate** worksheet and click the ![Graph button](image) on **2D Graph** toolbar to generate a line graph.
3. Activate the generated graph window and select **Gadgets:Quick Peaks**.
4. In the **ROI box** tab, change the **From** and **To** values of X scale to **34.75** and **35** respectively, select the **Fixed(Prevent moving by ROI)** check box.
5. In the **Baseline** tab, select the **Full Plot Range** radio button for **Range**.

6. In the **Find Peak** tab, change the **Method** for **Peak Filtering** to **By Number**, and set the **Number of Peaks** as 3, select **Blue** as the color of the **Peak Label**.
7. In the **Output to** tab, change the **Result Worksheet Name** to `[QkPeak]%C_Result2`. 

---

**Tutorials for Origin 2024b**
8. In the **Quantities** tab, you can decide which quantities to output. Leave only the check boxes for **Peak ID**, **Peak X**, **Peak Y**, **Height**, **Peak Area** and **FWHM** checked, and clear the other check boxes. Click **OK** to add the gadget to the plot.
9. Click the triangle button to the right of the ROI box and select **New Output** to generate the report worksheet.

10. Bring up the context menu again to select **Go to Report Worksheet** to open the result worksheet.

11. Now we are going to open the Peak Analyzer to carry out peak fitting. Bring up the context menu and choose **Switch to Peak Analyzer**.
12. The Peak Analyzer is opened, the **Fit Peaks** goal is already selected, the baseline mode and peak finding method follow the settings in the Quick Peaks gadget.

13. Go to the **Fit Peaks** page directly and click the **Fit** button to fit the three found peaks with default Gaussian function.

14. Click the ▶ button and select **Save As** in the context menu to save this analysis as a theme with the name *MyQuickPeaks*. 
15. In the Peak Analyzer, click the Finish button to generate the peak fitting results.

**Notes:** The theme can be used in the batch peak analysis. Select Analysis:Peaks and Baseline:Batch Peak Analysis using Theme to open the paMultiY dialog. The batch peak analysis is very useful when you have multiple data files that are similar. You can refer to this example for more details.

### 4.5.6 Peak Finding

4.5.6.1 Peak Finding
4.5.6.2 Picking and Marking Peaks

**Summary**

The Peak Analyzer provides several methods to pick peaks automatically. Also, user can opt to add/delete/modify the peaks manually.

Labels are added to the peak centers after they are found or added, to show user the positions of the current peaks.

Minimum Origin Version Required: Origin 8.0 SR6

**What you will learn**

- How to use and customize the auto peak finding in the Peak analyzer
- How to customize the labels for the peak centers

**Steps**

1. Start a new workbook and import the file `<Origin Program Folder>\Samples\Spectroscopy\HiddenPeaks.dat`.
2. Highlight the second column.
3. Create a line plot by selecting **Plot: Line: Line**.
4. With the graph active, select **Analysis: Peaks and Baseline: Peak Analyzer** to open the dialog of the Peak Analyzer.
5. In the first page (the **Start** page), select the **Find Peaks** radio button in the **Goal** group. Then click the **Next** button to go to the next page.
6. In the **Baseline Mode** page, select **None(Y=0)** for **Baseline Mode**.

![Baseline Mode](image)

Click the **Next** button to go to the **Find Peaks** page.

7. In the **find Peaks** page:

   1. Expand the **Peak Finding Settings** branch. Make sure that **Local Maximum** is selected for **Method**. Then click the **Find** button. Only five peaks are detected.
2. Change **Method** to **2nd Derivative (Search Hidden Peaks)**. Click the **Find** button again. This time, seven peaks are detected.
3. Click **Finish** to complete the analysis. We will get this final graph:
4.5.7 Peak Integration

4.5.7.1 Peak Integration

- Integrating Peaks

4.5.7.2 Integrating Peaks

4.5.7.2.1 Summary

Use the Peak Analyzer to integrate peaks and find their areas.
Minimum Origin Version Required: Origin 8.0 SR6

4.5.7.2.2 What you will learn

- How to pick an existing dataset as baseline
- How to subtract a baseline from the spectrum data
- How to calculate peak areas with the Peak Analyzer

4.5.7.2.3 Steps

1. Start a new workbook and import the file \Samples\Spectroscopy\Peaks with Base.DAT.
2. Highlight the second column.

![Image of a table with columns labeled A(X), B(Y), and C(Y).](image)

3. In the main menu, click **Analysis**, then point to **Peaks and Baseline**, and then click **Peak Analyzer**.
4. In the first page (the Goal page) of the Peak Analyzer, select Integrate Peaks in the Goal group. Click Next to go to the Baseline Mode page.

5. On the Baseline Mode page, select Use Existing Dataset from the Baseline Mode dropdown list. Click the triangular button to the right of the Dataset dropdown menu, and then select [PeakswithBase]"Peaks with Base"[IC"Base" on the fly-out menu. Click Next to go to the Baseline
6. Select the **Auto Subtract Baseline** check box. Click the **Integrate Peaks** page icon in the upper panel (or click **Next** twice to go to the Integrate Peaks page). In the preview graph, you will see two numbered...
yellow rectangles representing two peaks found with the default settings.

7. For **Integration Window Width**, select **Adjust on Preview Graph**. On the graph, click inside the rectangle marked with 1. A pair of “handles” appears on either side of the yellow integration window. Drag these handles to adjust the range for which integration will be performed. Click inside the rectangle
marked with 2 and adjust the integration range for the second peak.

8. In the **Integrate Peaks** page of the Peak Analyzer, make sure all the desired quantities to compute have been selected in the **Quantities** group. For example, if you want to calculate the peak centroid for each peak, select the **Peak Centroid** check box. If you don't want to output the percent areas, clear the **Percent Area** check box. When you are done, click **Finish** to perform the analysis.
The result is in a worksheet named *Integration_Result1*.
If the Area check box was selected in the Quantities group, peak area data appears in the Area column of the result worksheet.

### 4.5.8 Peak Fitting

#### 4.5.8.1 Peak Fitting

- [Peak Fitting with Baseline](#)
- [Peak Fitting with Preset Peak Parameters](#)
- [Setting the Fix, Share Status or Bounds for Multiple Peak Parameters Simultaneously](#)

#### 4.5.8.2 Peak Fitting with Baseline

**Videos**

- [Quick Peaks Gadget](#)
- [Fitting Multiple Spectra with Peak Analyzer](#)
- [Find Peaks, Label Peaks, Remove Unwanted Labels](#)

**OriginBlog**

- [How do I Perform Peak “Deconvolution”?](#)
- [Define a Peak Function for Peak Fitting](#)

#### 4.5.8.2.1 Summary

In OriginPro, the **Peak Analyzer** is capable of performing multiple peak fitting with several baseline subtraction options.

There are various ways to create a baseline for your spectrum data. You can select a few anchor points and then fit them with a function. The fitting of the baseline can be done along with the peak fitting.
4.5.8.2.2 What You Will Learn

- How to perform fitting of peaks
- How to fit the baseline

4.5.8.2.3 Steps

1. Start a new worksheet and import the file <Origin Program Folder>\Samples\Spectroscopy\Peaks on Exponential Baseline.dat.
2. Highlight the second column in the worksheet.
3. Select Analysis: Peaks and Baseline: Peak Analyzer from the main menu to open the Peak Analyzer.
4. Select the **Fit Peaks** radio button in the **Goal** group on the first page.

5. Click **Next** to go to the **Baseline Mode** page. In the **Baseline Mode** page, select **User Defined** from the **Baseline Mode** drop-down list. Click the **Find** button in the **Baseline Anchor Points** group. Eight anchor
points should be found.
6. Click Next to go to the Create Baseline page. In the Create Baseline page, select Fitting with the Connect By drop-down list. In the Fitting group, select ExpDec2 from the Function drop-down list.
7. Click **Next** to go to the **Baseline Treatment** page. In the **Baseline Treatment** page, select the **Fit Baseline with Peaks** check box.
8. Click Next to go to the **Find Peaks** page. In the **Find Peaks** page, click the Find button to search peaks. Two peaks should be found.

9. Click Next to go to the **Fit Peaks** page. In the **Fit Peaks** page, click the Fit Control button to open the **Peak Fit Parameters** dialog.
10. In the **Peak Fit Parameters** dialog, make sure that both peak types are Gaussian. Click the **Fit Until Converge** button.

11. When the fitting is done, click **OK** to close this dialog.

12. Back to the **Fit Peaks** page, click **Finish** to complete the analysis. See the results in the source workbook and the graph report.

### 4.5.8.3 Peak Fitting with Preset Peak Parameters

**Summary**

In some cases, you may want to perform peak fitting with preset peak parameters. For example, you may have many datasets with fixed numbers of peaks and the centers of these peaks do not vary from dataset to dataset. What you are interested in is mainly other parameters of the peaks, for example, heights. Using the theme feature of the Peak Analyzer, you may carry out peak fitting with fixed peak parameters easily.

Minimum Origin Version Required: OriginPro 2016 SR0
4.5.8.3.2 What You Will Learn

1. How to save Peak Analyzer settings in a theme and reuse them
2. How to fix peak parameters

4.5.8.3.3 Steps

4.5.8.3.3.1 Save a theme with peak positions and peak parameters

1. Start a new worksheet and import the file `<Origin Program Folder>\Samples\Spectroscopy\HiddenPeaks.dat`.
2. Highlight the second column and select **Analysis: Peaks and Baseline: Peak Analyzer** from the Origin menu to open the **Peak Analyzer**.
3. On the first page, select the **Fit Peaks** radio button in the **Goal** group. Click **Next** to go to the **Baseline Mode** page.
4. In the **Baseline Mode** page, select **None (Y=0)** with the **Baseline Mode** drop-down list. Click **Next** to go to the **Find Peaks** page.

5. In the **Find Peaks** page:
a. Clear the **Enable Auto Find** check box, because we want to find the peaks manually. Click the **Peaks Info** button to open the **Peak Info** dialog.

![Peak Analyzer dialog](image)

b. In the **Peak Info** dialog, click the **Add** button seven times to add 7 peaks. Enter the peak centers and heights as follows:
6. In the Fit Peaks page:
   a. Click Fit Control to open the Peak Fit Parameters dialog.
   b. In the Peak Fit Parameters dialog, click the Fix or release all peak centers button. Then click the Fit Until Converge button. When the fitting is done, click OK to return to the Peak Analyzer dialog (see this important note about Fit until converged).
   c. Click the right-sided triangle button to the right of Dialog Theme in the upper panel. Select Save As from the short-cut menu. The Theme Save as dialog opens.
   d. In the Theme Save as dialog, enter MyFitting after Theme Name. Clear and select the check boxes as the screenshot below:

To auto assign peak height, check the "Snap to Spectrum" check box after closing this dialog.

Click OK to return to the Peak Analyzer.

c. Click Next to go to the Fit Peaks page.
Data Analysis

4.5.8.3.3.2 Reuse the theme

1. Start another new workbook and import the file <Origin Program Folder>\Samples\Spectroscopy\HiddenPeaks.dat.
2. Highlight the second column
3. Select Analysis: Peaks and Baseline: Peak Analyzer from the Origin menu to open the Peak Analyzer dialog.

Click OK to save the theme. This should bring you back to the Peak Analyzer dialog.

e. Click the Finish button in the Peak Analyzer to complete the analysis.
4. On the first page of the Peak Analyzer, click the right-sided triangle button to the right of Dialog Theme. From the short-cut menu, pick MyFitting.

5. Click Next to check if the settings in every step are correct. Note that in the Find Peaks page, you can see the peak centers and heights are same as last time.

6. When you reach the last page, click the Fit Control button to open the Peak Fit Parameters dialog. Make sure that all peak centers are fixed and the values are the same as last time. Click OK to return to the Peak Analyzer.

7. Click Finish to complete the analysis. Check the results to see whether they are the same as the results we got last time.

4.5.8.4 Setting the Fix, Share Status or Bounds for Multiple Peak Parameters Simultaneously

4.5.8.4.1 Summary
When performing peak analysis, one often wants to fix parameter values, or share parameters between multiple peaks, or specify bounds. If your data has a few peaks, you can simply perform these settings for each peak. But if your data has many, it may be time consuming to set individually. To make the process more efficient, the Peak Analyzer offers context menus which can allow you to set the fix, share status or bounds for multiple peak parameters simultaneously. For more details about these settings, please refer to the Origin Help File.

Minimum Origin Version Required: OriginPro 8.0 SR6

4.5.8.4.2 What You Will Learn

- How to set share status of multiple peak parameters simultaneously.
- How to set upper bounds and upper bound values to multiple peak parameters simultaneously.

4.5.8.4.3 Steps

1. Start a new workbook and import the file `<Origin Program Folder>\Samples\Spectroscopy\Positive & Negative Peaks.dat`.
2. Highlight the second column and select Analysis: Peaks and Baseline: Peak Analyzer to open the Peak Analyzer dialog. In the first page (the Start page), select the Fit Peaks radio button in the Goal group. Then press the Next button to go to the next page.
3. In the Baseline Mode page, select Constant with the Baseline Mode drop-down list and choose Mean in the Constant group. Then click Fit Peaks in the wizard map to directly go to the Fit Peaks page.
4. In the **Fit Peaks** page:

1. click **Fit Control** button to open the **Peak Fit Parameters** dialog. In the lower left corner of the dialog, set the fitting function to **Voigt**.

2. Make sure the **Parameters** tab is active and then select 1 in the **Share** column of the **wG_1** row. Then right click on it and select **Apply Same "Share" to All wG**. Then you will find that all the parameters with the **wG** prefix are shared in the same group.
3. Then select 2 in the **Share** column of the **wl_1** row. Then right click on it and select **Apply Same "Share" to All wl**. Then you will find that all the parameters with the **wl** prefix are shared in the same group. After this, the **Parameters** tab should look like below:
4. Activate the **Bounds** tab. Double-click in the cell in the first **Gaussian width** row and the second `< or <=` column. And you will find `<=` is shown in this cell (the `<` will be shown if you double-click in the cell for one more time). Then type 5 into the **Upper Bounds** column in the same row.

5. Then right click on it and select **Apply Same "Bounds" to All wG**.
After this, the **Bounds** tab should look like:
5. Click the **Fit Until Converged** button. When the fitting is done, click **OK** to close the dialog.

6. Back in the **Fit Peaks** page, click **Finish** to complete the analysis. See the results in the source workbook and the graph report.

See [FAQ-1012 Why Does “Fit until converged” Generate Different Results Than Multiples of “1 Iteration” When Peak Fitting?](#)

### 4.6 Data Manipulation

#### 4.6.1 Data Manipulation

* **Setting Column Values**

  - **Set Column/Cell Values**

* **Worksheet Data Operations**
4.6.2 Setting Column Values

4.6.2.1 Setting Column Values

- Set Column/Cell Values

4.6.2.2 Set Column/Cell Values

4.6.2.2.1 Summary

Origin provides several ways to compute a column or matrix of values. One of Origin's most powerful features is Set Column Values, a tool for performing mathematical operations, generally on values stored in a workbook or matrix. These operations can make use of Origin's built-in functions, custom Origin C functions, Python functions, mathematical and logical operators, built-in or user-defined variables, and can even allow for pre-processing of input data.

- Using Metadata in Worksheet in Calculation – Part 1: Column Label Rows
- New in Origin 2021- The Formula Bar
- Extracting Dates from Text Strings
- How to Create a Timeline in Origin

Videos

- Set Column Values
- Setting Column Values
- Worksheet Set Column Values to Reference Other Info
- Use Spreadsheet Notation to Set Column Values
- Cell Formula
- Formula Bar
- Set Multiple Column Values
This tutorial will show you how to compute cell or column values by:

- Filling a Column with an Arithmetic Series
- Using Built-in Functions
- Using Other Columns of Values
- Using Cell Values
- Using Variables from Workbook Metadata

In addition, you will learn:

- How to enter a formula into worksheet cell to compute cell values
- Auto behaviors of setting cell values

4.6.2.2.2 Setting Column values

4.6.2.2.2.1 Filling a Column with Arithmetic Series

Origin provides multiple methods to fill a column with arithmetic series.

Using Auto Fill

1. Enter a few starting values in cells.

2. Select the two cells.

3. Move the mouse to the bottom right-hand corner of the second cell. The cursor will change to display "+".
4. Drag the mouse toward the bottom of the column. The column will be filled with 1, 3, 5, 7, ... .

Note that a row can also be auto filled by dragging towards the right. In addition, to copy a sequence of cell values to other column or row cells, press SHIFT while selecting the desired sequence, then press CTRL and drag.

Using Filling A Set of Numbers

1. Right click on the column B and select **Fill Column with: A Set of Numbers** from the context menu to bring up the **PatternN** dialog
2. Enter 1 in the From edit box and 23 in the To edit box. Enter 2 in the Increment edit box.

![A set of Numbers: patternN dialog box]

3. After you click the OK button, Column B will be filled with values: 1, 3, 5, 7, ..., 23

4.6.2.2.2 Using Other Columns

We will show you how to enter expressions in the $F(x)$ row to set column values.

1. Create a new workbook. Import US Metropolitan Area Population.dat from the \Samples\Data Manipulation\ folder.
2. Add a new column to the worksheet (right-click to the right of the last column in the worksheet and select Add New Column from the context menu). Change the Long Name of the column to Population/Sq. Mi.
3. To calculate the population density, enter the expression, $A/B$, in the $F(x)$ row of column E.

![US Metropolitan Area Population dataset]

4. The column will get computed using data from the other two columns.
4.6.2.2.3 Using Built-in Functions

1. Create a new workbook. Import *Step Signal with Random Noise.dat* from the \Samples\Signal Processing\ folder. We are going to calculate the moving average of column B, that is, calculating the adjacent average value at each point of column B.

2. Click the **Add New Columns** button on the Standard toolbar to add a new column C. Highlight this column and right-click, and then click **Set Column Values...** to open the **Set Values** dialog.

3. In **Set Values** dialog, click the **Search and Insert Functions** button to search for keyword *adjacent average*.

![Image of Search and Insert Functions dialog](image)

**Statistical Functions**

**Movavg(vd,back,forward)**

- Takes a vector vd, a backward and forward offset, and returns a vector of adjacent averages. Backward and forward offset are with respect to the current row number.
- **Example**: for(ii=1;ii=10;ii++) col(1)[ii] = ii; col(2)=movavg(col(1),0,2); fills col(2) with adjacent average values at each point (Note that col(2)[9] = (col(1)[9]+col(1)[10])/2 and col(1)[10] = col(2)[10]).
4. Double click function name `Movavg(vd, back, forward)` to insert it into dialog and close the dialog.

5. Highlight the characters `vd`. replace `vd` with `B`, replace `back` with `0` and replace `forward` with `2`. Your formula should look like this:

   `movavg(3, 0, 2)`
6. Click **OK**. The last column will fill with the moving average from column B.

When referring to another column in the same worksheet, you can use index (e.g. "col(1)"), short name (e.g. "A" or "col(A)"), or long name (e.g. "signal with noise") to identify the column.

4.6.2.2.2.4 Using Columns from Other Sheets

The **Set Values** dialog provides an **Variable** menu to easily insert range variables that point to columns in other books/sheets, which can then be used to compute column values for the current column.

1. Open the project `\Samples\Data Manipulation\Setting Column Values.opj` and click on the **Columns from Other Sheets** subfolder.
2. In the workbook, right-click on the worksheet tab labelled **Sample** and select **Duplicate Without Data**. Rename(by double-clicking on the current name) the new sheet as: **Corrected Sample**.
3. Now you will fill these three columns with data based on formulas that reference columns in the other sheets. Highlight the first column and right-click on it to select **Set Columns Values** to open the dialog. Select **Variables: Add Range Variable by Selection** to open the **Select from Worksheet** dialog. With this dialog, you could select a column from worksheet and insert it as a range variable to the **Before Formula Script** panel.
4. When the **Select from Worksheet** dialog is open, activate the **Sample** sheet, highlight column A to select and click the **Done** button to confirm selection and click **OK** (accept **Column Notation**) in the **Insert Mode** dialog box that appears.
5. "range r1 = Sample!Col(A);" will be automatically inserted into the **Before Formula Scripts** panel. Edit the formula to read as:
Tutorials for Origin 2024b

range rTime = Sample!Col(A);

6. Then enter \texttt{rTime} in the \textbf{Column Formula} and click the \textbf{OK} button to generate data for the first column and close the dialog.

7. In the \textbf{Corrected Sample} worksheet, highlight column B and column C and right-click on them. From the shortcut menu, select \textbf{Set Multiple Column Values} to open the dialog. Select \textbf{Variables: Add Range Variable by Selection} and insert two range variables, one by one, to the \textbf{Before Formula Script} panel similarly as the previous steps. Edit these new entries as follows:

range rSample = Sample!Col(B);

8. and

range rRef = Reference!Col(B);

9. Now we will edit the range variables in the \textbf{Before Formula Scripts} panel and use another expression to get the same results. Remove the column names \texttt{Col(B)} of the two range variables and select \textbf{Variables: Predefined Variables: wcol(j)} in both lines so it looks as follows:

range rSample = Sample!wcol(j);

range rRef = Reference!wcol(j);

11. Then input the following expression into the \textbf{Column Formula}:
12. You reference a particular cell value with square brackets, so `[1]` in the Column Formula expression above means the first element.

13. Click the OK button to generate data for the column B and column C of the Corrected Sample worksheet.

1. You reference a particular cell value with square brackets, so `[1]` in the Column Formula expression above means the first element.

2. You can select Formula: Save and Formula: Load in the Set Column Values dialog to save your formulas and reload them into other columns to generate new data.
4.6.2.2.2.5 Using Cell Values

Values contained in specific worksheet cells can be referenced and used to compute the formula for setting column values. This provides an easy way to use worksheet cells as control cells for updating values in a column.

1. Open the project \Samples\Data Manipulation\Setting Column Values.opj and switch to the Cells in a Worksheet subfolder in Project Explorer.
2. Right-click on column C and select the Set Column Values... context menu to bring up the Set Values dialog.
3. Use the Variables: Add Range Variable by Selection menu item to open the Select from Worksheet dialog. Then select column G(Value) in this worksheet, click the button. Click OK when the Insert Mode dialog appears (accept Column Notation) to add its expression to the Before Formula Scripts panel.
4. In the Before Formula Scripts panel, change the name of the range variable to be rControl and add these additional lines so that the script looks like below

```plaintext
range rControl = Col(G);

//range r1 = Col(7);

int nOrder = rControl[2];

int nPoints = rControl[3];

differentiate -se iy:=(1,2) order:=1 smooth:=1 poly:=nOrder npts:=nPoints oy:=(1,3);
```

5. The script calls the differentiate X-Function and passes the cell values from column G as arguments for polynomial order and number of points, which controls the Savitzky-Golay smoothing performed during the differentiation.
6. The **Set Values** dialog then should be as following:

![Set Values dialog](image)

6. Click **OK** to close the dialog and see the results in column C. Now you can try to change the values in column G, to change the output.

Note: Allowed values of polynomial order are 1 to 9.

The graph shown in the worksheet was first created and then embedded into the worksheet by merging a group of cells.

4.6.2.2.2.6 Using Variables from Workbook Metadata

Metadata stored in the workbook, such as variables saved when importing data using the Import Wizard, can be referenced and used for computing column values.

1. Open or continue working with `\Samples\Data Manipulation\Setting Column Values.OPJ`, and switch to the **Worksheet Metadata** subfolder from the Project Explorer window.
2. Select column A and right-click to select the **Insert** menu option. A new column is inserted to the left of column A.
3. Select the first column (this newly inserted column) and right-click on it. Then select the **Set Column Values** menu item to open the Set Values dialog.
4. Select the **Variables: Add Info Variable** menu item to open the **Insert Variables** dialog. Select **Numeric int** from the **Variable Type** drop-down list. Expand the USER.VARIABLES node and click to highlight **NUMBEROFPOINTS** row with **Value** as **3800**. Press the **Insert** button to insert this variable into the **Before Formula Scripts** panel.

5. Next, set **Variable Type** to **Numeric double**. Hold the **Shift** key down to select both **StartFrequencyKHz** and **StepFrequencyKHz**, and then press **Insert** to insert these two variables. Press the **Close** button to close the dialog.

6. In the upper **Column Formula** panel, input `{d1:d2:d1+(n1-1)*d2}` and then press the OK button to generate data and close the dialog. The column will be filled with frequency values.

7. Highlight the first and second columns, right-click on them and select **Set As: XYY** to change the plotting designations to X and Y. After you change the long name of the first column to **Frequency**, the worksheet
Data Analysis

should look like:

4.6.2.2.3 Setting Cell Values

In the Cell-Edit Mode, you can enter a cell formula beginning with an equals sign "=" into a cell (a data cell or UserDefined Parameter Row cell) just as below.

<table>
<thead>
<tr>
<th>Morning</th>
<th>Evening</th>
<th>Stats</th>
</tr>
</thead>
<tbody>
<tr>
<td>(°F)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mem</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97.09975</td>
<td>97.08043</td>
<td>98.23468</td>
</tr>
<tr>
<td>97.2</td>
<td>97.09497</td>
<td>0.4952297</td>
</tr>
<tr>
<td>97.29991</td>
<td>97.46701</td>
<td>0.50379</td>
</tr>
<tr>
<td>97.40002</td>
<td>97.53114</td>
<td></td>
</tr>
<tr>
<td>--</td>
<td>97.51223</td>
<td></td>
</tr>
<tr>
<td>--</td>
<td>97.40901</td>
<td></td>
</tr>
</tbody>
</table>

Once the formula has been entered, you exit edit mode (in-place edit or Edit: Edit Mode) to see the resulting cell value.

Let us use an example to show you how cell formulas work in Origin:

1. Open a new workbook in your Origin Project.
2. Import the sample data "automobile2.dat" located at the folder <Origin Program Folder>\Samples\Statistics into the workbook.

3. Right-click on the header cell of column label row "F(x)=" and select Add User Parameters from the context menu to add a user parameter.

4. Here, let's add two user parameters and enter Mean and Std Dev as their parameter names separately. And then, add one more column at the end of this worksheet, enter Power/Engine Displacement as the column Long Name.

5. Select Edit: Edit Mode menu to switch to the Edit Mode. And then, in the cell Mean and Std Dev of Col("Power"), enter =mean(this) and =stddev(this) respectively. Once the edit done, click outside the cell
to exit cell-edit mode reselect the **Edit: Edit Mode** menu item to display cell formula results.

Note: About the meaning of the variable “This”, please refer to this page.

6. Click the cell **Mean of Col(“Power”)** to select it, put the cursor to the lower right corner of this cell. When the cursor turns to a cross +, grab this “+” handle and drag with your mouse horizontally to Col(“Engine Displacement”). Release the cursor, you will find other cells of this row will be filled with some result values. Alternately, you could simply double-click on the “+” handle and copy the formula to all **Mean** row cells to the right of Col(“Power”).

7. Double-click those **Mean** cells, you will found the filled formulas are all same, =mean(this).

8. Do the same thing for the **Std Dev** row to calculate the standard deviation for all these five columns.
9. Go to the last column we just added, in the first cell enter \( \frac{E1}{I1} \).

Note: Here, \( E1 \) means the first cell of col(E) and \( I1 \) means the first cell of col(I). You can refer to this page to learn more about the formula.

10. Release your cursor to execute the division. Use the same way at Step 6 to grab this "+" handle and drag with your mouse vertically to the end cell of this column (Hint: If you hover on the lower-right corner of the cell, directly over the cell handle, the cursor changes to a "+" sign. When this "+" sign appears, double-click to extend the formula to the end of the column. This is faster and easier than dragging with your mouse).

11. Release the cursor to get all division results of \( \text{col(E)} / \text{col(I)} \) at each row.
Select **Edit: Edit Mode** menu, you can check and edit all these cell formulas.

Note: Additionally, you are also allowed to extend formulas across rows and columns. For details about setting cell values with formula, please refer to this page.

### 4.6.3 Worksheet Data Operations

#### 4.6.3.1 Worksheet Data Operations

- **Worksheet Query**
- **Data Reduction**
- **Data Filter**
- **Lock Filter with Analysis**
- **Unstacking and Sorting Worksheet Columns by Label**
4.6.3.2.1 Summary

This tutorial will show you how to use the **Worksheet Query** dialog.

Minimum Origin Version Required: Origin 2019b

4.6.3.2.2 What you will learn

This tutorial will show you how to:

- Extract numeric and time data
- Use an alias in an extraction condition
- Use LabTalk functions in an extraction condition

4.6.3.2.3 Dialog Overview

The **Worksheet Query** dialog box will differ slightly from the image below if (a) **Spreadsheet Cell Notation (SCN)** is OFF in the active workbook (you see this icon in the upper-left corner of the workbook), or (b) you have SCN turned ON but you have checked the **Use Alias** box in the upper-right corner of Worksheet Query. The **Worksheet Query** dialog box was modified for version **2019b** to allow for more flexible column naming. You can still work through this tutorial by defining column Aliases. See **Select Column Variables for If Test**, for guidance.
There are two main panels in the **Worksheet Query** dialog:

- The left panel lists all the columns in the active worksheet. Right-click in the left panel and choose which column properties to display (e.g. Format, 1st Value, etc). Note that only those columns checked in the Extract column will be output when you click OK in the dialog box.

- The right panel is where you set, test and execute query conditions. If SCN is off or you have opted to check the **Use Alias** box, select those worksheet columns that you want to use in the extract condition in the left panel, then click the button to move them into the **Select Column Variable for If Test** box. You will then have the Aliases that you need to define your **Condition**. If you intend to use column names or indices instead of Aliases, you can simply define your **Condition** directly.

### 4.6.3.2.4 Define the Condition

#### 4.6.3.2.4.1 Extract Numerical Data

1. Start with a new workbook and import the file `\Samples\Statistics\body.dat`.
2. Click the menu item **Worksheet: Worksheet Query** to open the Worksheet Query dialog box.

   If you know the correct syntax, you can type your expression directly into the **Condition** box. To aid you
in constructing your expression, you can use the buttons to the right side of **Condition**. Additionally, you can insert functions and variables from the **Function** menu.

3. To extract the data of individuals who are at least 160cm in height, type the following into the **Condition** box:

   \[
   \text{col(height)} \geq 160
   \]

4. When there are multiple conditions, you can combine these conditions using logical operators **AND, OR, NOT**. We will add a second condition that tests for individuals that weigh no more than 50kg. Click the **AND** button and type the following after **AND**:

   \[
   \text{col(weight)} \leq 50
   \]

5. Your expression should now look like this:
6. To test your query, click the All Rows button to select all rows (note that the 0 in 1 To 0 signifies the last row in the sheet), then click Test -- select if true to test your expression. Origin will return 5 records found.
8. Accept other default settings and click the **OK** button. A new workbook containing the 5 found records, is created.

### 4.6.3.2.4.2 Extract Strings

When extracting strings, you need to enclose the string with double quotes (e.g. "California").

1. In order to extract just female (F) subjects, we type the following into the **Condition** box:

   \[
   \text{col(gender)} = "F"
   \]

2. Click the **All Rows** button, then click **Test -- select if true**. A message shows that 18 records are found.

3. Accept other defaults and click the **OK** button to close the dialog and extract data for female subjects to a new workbook.

### 4.6.3.2.4.3 Extract Time Data

*Date and Time* data are internally saved as numeric values in Origin. Date is the integer part of the numeric value, while Time is the fractional part. You can use the `int()` and `frac()` functions to return the integer and fractional parts of a number, and use the `Date(MM/DD/YY)` and `Time(HH:mm:ss)` functions to convert date-time string data to numeric *Julian day* data.

1. Start with a new workbook. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the *Import and Export* subfolder and find the file *Custom Date and Time.dat*. Drag-and-drop this file into the empty worksheet to import it. Note that the "date-time" data in column A is left-aligned, indicating that it is being treated as text strings and not as true date-time data (which is numeric).

2. Select column A, right-click and select **Properties**. Set **Format** = **Date**, **Display** = **Custom Display** and in **Custom Display** enter the following:

   \[
   'dd'.'MM'.'yyyy HH':'mm':'ss'.'##
   \]
3. This formats the date-time strings in column A as date-time numeric data.

4. Next, we will extract that portion of worksheet data that falls within the time period 10:00:00 and 11:00:00. Click **Worksheet: Worksheet Query** and in the **Condition** box, enter the following:

\[
\frac{(A)}{Time(10:00:00)} \text{ AND } \frac{(A)}{Time(11:00:00)}
\]

5. Click the **All Rows** button, then click **Test -- select if true**. A message shows that 120 records are found.

6. Accept other defaults and click the **OK** button to close the dialog and extract data recorded between 10:00:00 and 11:00:00 to a new workbook.

You could have imported the data in step 1, using a **Data Connector**. A simple drag-and-drop of the data file *Custom Date and Time.dat* would have split the date and time data into two columns, each formatted properly as Date and Time. This saves you the trouble of having to manually format the data using the string in step 2.

### 4.6.3.3 Data Reduction

#### Videos

- Data Reduction
- Extract Worksheet Data
- Data Filter

#### OriginBlog

- Reduce Rows or Columns from Worksheet
- Speed Mode -- How does it affect my graph and its exported image?

### 4.6.3.3.1 Summary

Origin offers a number of tools which can be used for data reduction in worksheets: **Data Filters**, **Worksheet Query** and several **X-Functions** which reduce the number of data rows by different methods.

**Minimum Origin Version Required:** 2015 SR0

### 4.6.3.3.2 What You Will Learn

In this tutorial, you will learn how to:

- Reduce XY data to evenly spaced X
- Reduce Duplicate X Data for XY dataset
- Reduce XY data by Group
Tutorials for Origin 2024b

- Reduce worksheet rows

4.6.3.3.3 Steps
4.6.3.3.3.1 Reduce to Evenly Spaced X

1. Create a new workbook and click the button to import the file Signal with High Frequency Noise.dat under <Origin EXE folder>\Samples\Signal Processing path.

2. Highlight column B and select Worksheet:Reduce to Evenly Spaced X to open the reduce_ex dialog. Edit the settings so that they match the following.

   ![Data Manipulation: reduce_ex dialog](image)

   - **Recalculate**: Manual
   - **Input**: Signal with High Frequency Noise.dat
   - **Subgroup**: By Sampling Interval
   - **Sampling Interval**: 0.3
   - **Input Sampling Interval**: 0.01905
   - **New Sampling Interval**: 0.3
   - **X Start**: 1
   - **X End**: 40
   - **Sampling Method**: Y Mean
   - **Plot FFT for Preview**: No
   - **Output**: (new.dat)

3. Click OK. A new column (column C) is added to the worksheet. This column contains its own sampling interval information. Click on the column header to select the column then choose Column: Show X Column. In the Show X Column: colshowx dialog box, click OK to generate an X column using the sampling interval. You can see that the original XY dataset has been reduced by generating a new, larger sampling interval.
4. Highlight column B and D (hold down the Ctrl key for multiple selection), and click the button to generate a line plot for original (Black) and reduced (Red) data.

5. You can see from the plot that the data size is considerably reduced:
4.6.3.3.2 Reduce Duplicate X

1. Create a new workbook and click the button to open the Import Wizard. Select the data files Step01.dat, Step02.dat and Step03.dat under the file path <Origin EXE Folder>\Samples\Curve Fitting. Change the Import Mode to Start New Rows and make sure the default import filter step is applied. Click Finish to import these data files.

2. Highlight column A and B, select Worksheet:Reduce Duplicate X Data to open the reducedup dialog. Duplicate the settings as depicted below:
3. Click **OK** to apply settings and in the results sheet **Sheet2**, we can see that for each X value, 3 duplicates are found. In the reduced dataset, the Y values for each duplicated X have been replaced by the sum of the Y values.
4.6.3.3.3 Reduce/Combine Duplicate Rows

1. Go to Sheet1 of the previous section, highlight column A and select **Worksheet:Remove/Combine Duplicated Rows**... to open the *wdeldup* dialog. Select **Average** from **Merge Duplications by** drop-down list, and click the right-sided triangle button on the **Output Worksheet** row to select `<new>:New Sheet` and check the **Output Counts** box and click **OK**.
2. Entire worksheet rows are reduced into the average values of merged rows which are determined by duplications in the selected column. A new column **Counts** is added to the end of the result worksheet *wdeldup* and it reports the number of duplicates found for each X value.
The tool **Reduce Duplicate X** works for XY dataset only, while the tool **Remove/Combine Duplicate Rows** works for an entire worksheet.

You can also remove duplicate XY data from an XYZ dataset by using the **Statistics on Columns** tool, please refer to this Quick Help.

### 4.6.3.3.4 Reduce by Group

1. Open a new workbook, then click the button to import the Magnetization.dat file under `<Origin EXE folder>\Samples\Data Manipulation` path.

2. Highlight columns A and B and click the button to generate a line plot.

3. Activate this graph and select **Worksheet:Reduce by Group** to open the reducexy dialog. Edit your settings as below:
4. Click **OK** to reduce the data. The reduced XY dataset will be added as two new columns at the end of original worksheet:
5. The reduced XY dataset is added as a new data plot to the original graph:
4.6.3.3.5 Reduce Worksheet Rows

1. Open a new workbook, then Click the button to import the file Nitrite.dat (path is <Origin EXE folder>\Samples\Spectroscopy). There are 6392 data points in this file.
2. Highlight both columns in the Nitrite worksheet and select **Worksheet:Reduce Rows** to open the **wreducerows** dialog, and edit the settings to match the image below:
**Note:** You can select the arrow button right to the Output select box and choose `<new>:New Column(s)` to make the selection.

3. When you click **OK**, only the first of every 10 rows is kept. Ninety percent of data points are discarded. Remaining data points are output to new columns:

4. Select the entire worksheet and click the button to generate line plots for original (Black) and reduced (Red) data:
5. Note that peak heights were changed with data reduction. To maintain data plot shape, we should keep more data points. Click the green lock on Graph 1 and choose Change Parameters to open the \texttt{wreducerows} dialog again. Change the value of Delete Rows to 3 and click OK.

6. This time 25% of data points were kept, better preserving the shape of the original data plot.
4.6.3.4 Data Filter

The Data Filter is a column-based tool to reduce rows of worksheet data, and consequently also hide the undesired rows for relevant data analysis and graphing. Three data formats are supported: numeric, text and date/time.

Minimum Origin Version Required: Origin 2015 SR0
4.6.3.4.2 What you will learn

This tutorial will show you how to:

- Use the data filter to reduce worksheet data
- Auto update the graphs and analysis results when apply a column filter
- Add a floating graph to a worksheet.

4.6.3.4.3 Steps

1. Start with a new workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file automobile.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Highlight column C(Power), right click and choose Set As:X in the context menu to set this column as X.
3. Highlight column C and G (hold Ctrl key when clicking), click the button on the 2D Graph toolbar to generate a scatter plot from these two columns.
4. Activate the generated graph and select Analysis:Fitting:Linear Fit from menu item to open the Linear Fit dialog. In this dialog, set Recalculate to Auto to ensure auto update of the analysis result, accept other settings as default and click OK to carry out the analysis.

![Linear Fit dialog](image)

5. A fitted curve and a result table will be added to the graph. Activate the graph again and double click on the X axis to open the Axis dialog. Select the Horizontal icon in the Scale tab, then choose Auto for Rescale. Do the same for the Y axis (Vertical icon) and also set its rescale mode to Auto. Click OK to apply the settings and close the dialog.
6. Go back to the original worksheet `automobile` and click **Column: Add New Columns** and add 7 columns to the worksheet.

7. Right-click in the gray area to the right side of the worksheet columns and select **Add Graph...** in the context menu to open the **Graph Browser**. In this dialog, select the previously generated graph in the left panel and click **OK** to add this graph as a floating chart to the worksheet. Drag the floating chart onto the empty worksheet columns you just created and resize it using the selection handles.
8. Highlight column A and B and click the Add/Remove Data Filter button on the Worksheet Data toolbar to add empty data filters to both columns.

9. Click the Filter icon on the column header of column B, clear the check boxes before Buick, Chrysler, GMC, Kia, Lincoln, Mercedes, Saab, Volvo to hide all rows with these entries, to leave only the Japanese makers. Click OK to apply the filter. The worksheet data, graph and analysis result will all be auto updated accordingly.

10. Click the Filter icon on the column header of column A and select Between, note that the data type of column A is numeric by default from importing. Accept default setting of the Between dialog and click OK. A data filter is applied to this column.

11. Again click the Filter icon on column A and this time choose Custom Filter in the context menu to customize the filter, change the Condition as x.between(1996,2000) to set the From and To value respectively, click the Test button and in the original worksheet, only the rows meet this testing condition will be highlighted, this works as a preview of the data reduction.
To view the whole worksheet at this stage, you can minimize the **Custom Filter** dialog, allowing you to scroll up and down the worksheet freely. You can later restore the dialog by clicking the "Minimize" button.

12. Click the **OK** button to apply the new filtering condition and the data, graphs and analysis results are updated and the graph is also auto rescaled.

Beginning with Origin 2019, you can copy data filters from one column and paste to other columns of data. Right-click on the column's **Filter** cell and choose **Copy**; or click on the Filter cell and press Ctrl+C to copy the filter. Select your target column(s) and press Ctrl+V to paste the filter and apply it to data in those columns.

### 4.6.3.5 Lock Filter with Analysis

#### 4.6.3.5.1 Summary

Generally, when graphing or analysis is done on data with a filter, changes in the filter condition of the source worksheet trigger recalculation for the analysis results and graph.

However for **Copy Columns** and **Pivot Table**, in the Recalculate lock icon context menu, there are **three worksheet filter options**. These are used to control whether the results will be affected by further filter changes.

Minimum Origin Version Required: Origin 9.1 SR0

#### 4.6.3.5.2 What you will learn

- How to copy columns to a new sheet or new workbook
- How to lock a Data Filter condition on copied columns
- How to push back the Data Filter condition to the source worksheet
### 4.6.3.5.3 Steps

1. Import the Origin sample data *automobile.dat* which is located in `<Origin Program Folder>\Samples\Statistics`.
2. Highlight the *Make* column then from the menu choose **Column: Filter: Add or Remove Filter** or select the **Filter** button from the **Worksheet** toolbar.
3. To show only the **Honda** data, click on the filter icon that appears on the top left of the column's first cell. Choose **Select All** to clear all the options. Select **Honda**. Click the **OK** button.

4. To copy columns to a different sheet, hold down the CTRL key and select the **Make**, **Power** and **Engine Displacement** columns. Next, right-click and select the **Copy Columns to...** in the context menu.

5. In the **colcopy** dialog, select **Auto** in the **Recalculate** drop-down list. Make sure the **Destination Columns** is set to a new worksheet in the same workbook (see Tip, below). A new sheet with the copied
6. Click and drag the sheet tab of the copied worksheet to blank Origin workspace. This will create a new workbook to hold the copied data so the copied data and original data can now be compared side by side.

7. Click on the green Recalculate lock icon on the top left of the first cells’ in the columns of this copied sheet. Select **Worksheet Filters: Lock** in the context menu. The filter conditions will be saved into the
8. In the source worksheet, add Data Filter to **Power** column, and click on the filter icon to select **Greater Than**... In the **Simple Number Filter** dialog, set **Value** to 100, and click **OK**. The filter will show only the **Power** data above 100 in the original workbook but since the filter was locked in the copied workbook the data in it will no longer update.

9. The filter conditions on the original workbook were changed and in order to set them back to the way they are in the copied workbook, use **Push Back**. In the copied sheet, click on the green lock in column(A) and select **Worksheet Filters: Push Back** from the context menu. This will result in the data filter condition in the original workbook being pushed back so that the filter condition set on **Power** no longer applies.

The lock filters options are only available in the new sheet created by column copy. If you copy columns to the same worksheet, the options will not show in the **Recalculate** lock icon’s context menu.

4.6.3.6 **Unstacking and Sorting Worksheet Columns by Label**
4.6.3.6.1 Summary

When working with a dataset -- particularly one that was not created with any particular analysis or plotting operation in mind -- one is often faced with "cleaning up" (e.g. rearranging, reducing, etc.) the data before you can do any useful work on it. This can be particularly challenging when the dataset is large and where "cut and paste" rearrangement of data is not practical. Even a CSV file that has a simple row x column arrangement, frequently needs some "massaging" prior to analysis or graphing.

In this tutorial, we will connect to a large UN-FAO dataset of global temperature data for years 1961 – 2019, perform a couple of operations to rearrange the data, then apply data filters to two categorical data columns before plotting the result as an interactive row-wise line series graph with error bars.

Minimum Origin Version Required: Origin 2021

4.6.3.6.2 What you will learn

- How to Connect to a web data source
- How to "unstack" a worksheet based on categories in one of the columns
- How to sort unstacked columns by column label
- How to set filters on multiple columns to manage a large dataset and view trends in data
- How to plot a row-wise graph on filtered data
- How to create a dynamic graph title that uses substitution of column metadata to label your graph

4.6.3.6.3 Steps

1. With a workbook active, click **Data: Connect to Web**. In the Connect to Web dialog, copy the following into the URL box, then click **OK**:
   
   http://shared.originlab.com/techdownload/FAO_Temperature_Change.csv

2. Accept the CSV Import Options settings and click **OK** to connect the web-data to the Origin worksheet.
3. Resize the workbook so that you can get a good look at your data columns and note a few things:
   - the second column, labeled *Area* is a repeating list of geographic regions and economic groupings.
the fourth column, labeled Months is a repeating list of time periods (months, quarters, years).

- the sixth column, labeled Element contains Temperature change and Standard Deviation categories.


- While there are potentially many ways we could manipulate and plot this data, the horizontal arrangement of the data, plus the inclusion of an error measurement (std. deviation) suggests a row-wise plot with error bars. However, we will need to rearrange our data to get it into a form that we can plot.

4. We begin with the need to split the Temperature change and Standard Deviation data into separate columns, by year (i.e. what we want is to have a sequence of measurement > std. dev, measurement > std. dev., grouped by year). For this, we will use the Unstack Columns tool. Click Restructure: Unstack Columns and open the dialog box.

5. The temperature data is in the Y1961 - Y2019 columns so click the flyout (arrow) button to the right of Data to be Unstacked and choose Select Columns. In the Column Browser dialog, scroll until you can see LName = Y1961, then hold the Ctrl + Shift keys and press the End key on your keyboard. This will select all temperature data columns. Click the Add as One Block button and click OK to close the Browser.

6. Click the Group Columns flyout button and choose F(Y): Element.
7. Under Options, (a) check the Include Other Column(s) box, then (b) click the "Select from Worksheet" button to the right of the text box. When the dialog rolls up, hold down the Ctrl key and select worksheet columns B(Y) and D(Y) by clicking on the column headers. Click the button to restore the dialog, accept remaining dialog defaults and click OK to close and generate your output.

8. Click on the added UnstackCols1 tab and note that we now have a clean separation of Temperature change and Standard Deviation measurements. However, we need to reorder columns by year so that each year’s Temperature change is followed by its Standard Deviation. We cannot rearrange columns in this sheet because of the "operations locks", so we will proceed by making a copy of the sheet, then removing the operations from the copied sheet (leaving our original output intact).

9. Right-click on the UnstackCols1 sheet tab and choose Duplicate. On the UnstackCols2 sheet that is added, click on the green lock icon in the upper-left corner and choose Recalculate Mode: None. Click OK on the attention message.
10. Now that the protected operations are removed from the output sheet, we are free to sort the columns by label. Click on the UnstackCols2 tab and drag the sheet out to create a separate book. Click on the column C(Y) header (Y1961) to select it, then press Ctrl + Shift + End to select all remaining columns. Click Worksheet: Sort Columns by Label and set the following:

11. Click OK to rearrange columns so that each year’s Temperature change measurement is followed by its Standard Deviation measurement. Now, right-click on the still-selected data and choose Set As: Custom... and enter YE in the Designation box, then click OK. This will set the selected columns, in sequence, as $Y$, $yEr\pm$, setting the worksheet up for plotting.
12. **One minor detail**: Scroll the worksheet so that you can see column **C** (*Long Name = Y1961*) and double-click in the **Units** cell, type a left paren then right-click and choose **Symbol Map**. Browse the Symbol Map to find a "degree" symbol (F0B0), **Insert** and **Close**. Type a capital "C" and a closing paren. Then hover on the lower right corner of the cell until you see the "+" cursor and double-click to extend the (°C) to the end of the sheet.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
<td>(°C)</td>
</tr>
</tbody>
</table>

**4.6.3.6.3.1 Adding Data Filters to Categorical Columns**

At this point, we have a very large dataset and trying to plot all data in our worksheet would overwhelm the row-wise plot we want to create. To better see trends in the data and make comparisons, we will add data filters to the **Area** and **Months** columns.

1. **Click on the Area column header to select the column, then click **Column: Filter: Add/Remove Filter**. A filter icon is added to the column heading. Click on the column filter icon and clear the **Select All** box and clear all check marks, then check the boxes beside **Africa**, **Antarctica**, **Asia**, **Australia & New Zealand**, **Europe**, **Northern America** and **South America**, then click **OK**.
2. **Click on the Months column header to select the column, then click **Column: Filter: Add/Remove Filter**. Click on the column filter icon and clear the **Select All** box and clear all check marks, then check the box beside **Meteorological year** and click **OK**.
3. Select the **Area** column, right-click and choose **Set As X**. Press Ctrl and select column **C**, then press Shift + End to select the remaining columns in the worksheet.
4. **Click Plot > Basic 2D: Row-wise...**. Click the flyout button beside the **Y Label** in box and choose **A(X): Area** and **X Data in Column label**, then click **OK**.
5. Once the graph is created (it may take a few moments), choose **Format: Page**, click the **Legends/Titles** tab to the right and set **Translation mode of %1, %2** to @LA: Long Name.
4.6.3.6.3.2 Labeling the Plot, Cleaning up Cosmetic Issues

1. Double-click on the crowded axis tick labels on the horizontal axis. On the Tick Labels > Format sub-tab, set Rotate(deg.) = Auto and check the Auto Hide Overlapped Labels box.

2. Click the Scale tab and set From to 0, To to 60, Rescale to Fixed and Minor Ticks to Count = 0. Click OK to close the dialog.

3. Right-click in the upper-center portion of the graph window, choose Add Text and in the text object, enter the following text:

   Months: %([Book2]Unstackcols2, @WL, B[F], W)

4. Right-click on the label object and choose Properties. Click on the Programming tab and set Link to (%,$), Substitution Level to 1 and click OK. The label now reads "Months: Meteorological year" which is the filter condition that is set for column Months (This is an example of a text substitution of worksheet information. For more information, see Text Label Substitution).

5. To change the graph aspect ratio and be able to change graph proportions as desired, choose Format: Page and on the Miscellaneous tab, set View Mode = Window View. Click OK to close Plot Details.

6. Press the Ctrl key and drag the graph legend horizontally to create a one-line legend.

7. Finally, choose View: Show and place a check mark beside Frame. This adds a frame to the graph layer. Reposition your page title and legend, as needed.
By clicking on one of the plots in the **Object Manager**, you dim all others, giving you a better view of the trend in a single plot.

### 4.6.4 Pivot Table

#### 4.6.4.1 Summary

The Pivot Table provides a quick way to summarize your data, and to analyze, compare, and detect relationships in your data. This tool can sort, count, sum, or compute minimum, maximum, or mean of data stored in a worksheet.

Minimum Origin Version Required: Origin 2015 SR0

#### 4.6.4.2 What you will learn

- How to summarize data by a Pivot Table.
- How to sort output by row or column totals in Pivot Table.
- How to combine small values in columns or rows, and custom extra value.

#### 4.6.4.3 Import Data from Database

1. Before creating a pivot table, we should can import data from database. Suppose we have already set up a database named *AdventureWorks2008R2* on a server machine - *myServer* - running SQL Server, with user name as "accounting", and password as "mydatabase".
2. To connect the database, we use a connection string:

```
Provider=SQLOLEDB.1;Password=mydatabase;Persist Security Info=True;
User ID=accounting;Initial Catalog=AdventureWorks2008R2;Data Source=myServer
```
3. Activate an empty worksheet and open SQL Editor by clicking the Open SQL Editor button on the Database Access toolbar.

4. Select menu item Edit Connection String... from SQL Editor’s File menu, in the open dialog, put the connection string (see step 1 above) to the text box. And then you can click the Test button to test if the connection is fine. If fine, click the OK button to connection to the database.

5. In the right text box, put the following SQL statements.

```
SELECT
DatePart(yyyy, SOH.OrderDate) AS YEAR,
CR.Name As CustomerCountry,
    Pr.Name As ProductName,
    Pr.Color As ProductColor,
    PC.Name As ProductCategory,
    PS.Name As ProductSubcategory,
    SOH.OrderDate As OrderDate,
    SOD.OrderQty As OrderAmount,
    SOD.LineTotal As TotalCost
```
FROM Person.CountryRegion AS CR
INNER JOIN Person.StateProvince AS SP
ON SP.CountryRegionCode = CR.CountryRegionCode
INNER JOIN Person.Address AS A
ON A.StateProvinceID = SP.StateProvinceID
INNER JOIN Person.BusinessEntityAddress AS BEA
ON BEA.AddressID = A.AddressID
INNER JOIN Person.Person AS P
ON P.BusinessEntityID = BEA.BusinessEntityID
INNER JOIN Sales.PersonCreditCard AS PCC
ON PCC.BusinessEntityID = P.BusinessEntityID
INNER JOIN Sales.SalesOrderHeader AS SOH
ON SOH.CreditCardID = PCC.CreditCardID
INNER JOIN Sales.SalesOrderDetail AS SOD
ON SOD.SalesOrderID = SOH.SalesOrderID
INNER JOIN Production.Product AS Pr
ON Pr.ProductID = SOD.ProductID
INNER JOIN Production.ProductSubcategory AS PS
ON PS.ProductSubcategoryID = Pr.ProductSubcategoryID
INNER JOIN Production.ProductCategory AS PC
ON PC.ProductCategoryID = PS.ProductCategoryID
6. Select menu **File: Save to Active Worksheet** to save these settings to the worksheet, and then select menu **Query: Import** to import the data into worksheet, and then close SQL Editor. We can see the imported data form the image below.

![Imported Data](image.jpg)

7. Click **Close** to close the dialog.

### 4.6.4.4 Create a Pivot Table

The imported dataset is a total cost summary of three product categories (Bikes, Accessories, Clothing) in six different countries by year. Suppose now you want to create a pivot table to see the yearly **Sum of Total Cost** of different product category. Follow the steps below to create the pivot table.

1. Activate the Sheet1, select **Restructure: Pivot Table** from the main menu to open the dialog. And specify the following settings in the dialog:
   - For **Pivot Table Row Source**, click the triangle button to add column A.
   - For **Pivot Table Column Source**, click the triangle button to add column E.
   - Select **Sum** with the **Summarize by** drop-down list. Then select column I for **Pivot Table Data Source**.
   - Expanding **Options** branch, check **Total for Rows** and **Total for Columns** check boxes, and select **Row Label Ascending** from the **Sort Output Rows** drop-down list.
2. Click the **OK** button to create the pivot table. The table should like this:

```
<table>
<thead>
<tr>
<th>Long Name</th>
<th>YEAR</th>
<th>Sum of TotalCost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F(x)=</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UserParam1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2005</td>
<td>3.11421E6</td>
</tr>
<tr>
<td>2</td>
<td>2006</td>
<td>6.26258E6</td>
</tr>
<tr>
<td>3</td>
<td>2007</td>
<td>281089.1</td>
</tr>
<tr>
<td>4</td>
<td>2008</td>
<td>391752.38</td>
</tr>
<tr>
<td>5</td>
<td>Total_ProductCategory</td>
<td>672841.48</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

4.6.4.5 **Combine Small Values**
In this section, we will show you how to present those categories with the percentage of the summarized value (Count/Sum/Mean/Min/Max) accounts for that of grand total exceeding a threshold percent, and combine small value categories into a default **Others** category.

1. Based on the above example, click on the lock icon in the **Pivot1** worksheet, and select **Change Parameters** to open the dialog again.

2. Specify the following settings in the dialog:
   - Expanding **Combine Smaller Values** branch, select **Column** in the **Combine Direction** drop-down list.
   - Select **By Percent of Grand Total** in **Mode** drop-down list.
   - Enter 30 in **Percent** textbox and **Other Smaller Items** in the **Column Label** textbox.
   - Expanding **Options** branch, uncheck the boxes of **Totals for Rows** and **Totals for Columns**

3. Click **OK** button. The pivot table shows the summarization of data by **Sum**. And only Category **Bikes** has the percent of grand total exceeding the threshold percent 30 %, other smaller categories has been
reduced into Category **Other Smaller Items**.

<table>
<thead>
<tr>
<th>Long Name</th>
<th>YEAR</th>
<th>Sum of TotalCost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Bikes</td>
<td>Other Small</td>
</tr>
<tr>
<td>F(x)=</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UserParam1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2005</td>
<td>3.1142E6</td>
</tr>
<tr>
<td>2</td>
<td>2006</td>
<td>6.26258E6</td>
</tr>
<tr>
<td>3</td>
<td>2007</td>
<td>8.96743E6</td>
</tr>
<tr>
<td>4</td>
<td>2007</td>
<td>413817.79</td>
</tr>
<tr>
<td>5</td>
<td>2008</td>
<td>8.70936E6</td>
</tr>
<tr>
<td>6</td>
<td>2008</td>
<td>584441.14</td>
</tr>
</tbody>
</table>

### 4.6.4.6 Extra Categories Source

In this section, we will show you how to present those categories that are missing in the source data sheet with **Column Source Extra Value**. This is useful when you want to ensure all needed categories will be presented in the result pivot table that might be used for later plotting.

Suppose we want to know the **Sum of Total Cost** of different product categories before Year 2007. Follow the steps below to create the pivot table.

1. To filter the years before 2007, we use the data filter. Go to Sheet 1 and select **Col A**. Click button in the main menu bar. Click again the filter icon on **Col A** and select **Less Than**. Customize the pop-out filter dialog as follow, then click OK to close the dialog.

2. Click on the lock icon in the **Pivot1** worksheet, and select **Recalculate**. As shown in the following pivot table, only **Bikes** is presented here, because other two product categories do not has any cost data record.
in Year 2005 and 2006.

3. Back to Pivot1 worksheet, select col(b) and then click Plot > 2D: Bar: Column to plot a column graph(Graph1).

4. Next we want to add two missing categories back into the pivot table. Click on the lock icon in the Pivot1 worksheet, and select Change Parameters. Customize the dialog as follow, click OK to close the dialog. The pivot table would look as follow.

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals for Rows</td>
</tr>
<tr>
<td>Sort Output Rows</td>
</tr>
<tr>
<td>Totals for Columns</td>
</tr>
<tr>
<td>Sort Output Columns</td>
</tr>
<tr>
<td>Normalize by Column Totals</td>
</tr>
<tr>
<td>Show Zeros when Empty</td>
</tr>
<tr>
<td>Row Source Extra Values</td>
</tr>
<tr>
<td>Column Source Extra Values</td>
</tr>
</tbody>
</table>

Separate extra values by ’|’, for example A|B|C.
Combine different column/row info by ’_’, for example, A_1|A_2
The pivot table would look as follow.

<table>
<thead>
<tr>
<th>Long Name</th>
<th>YEAR</th>
<th>Sum of TotalCost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F(x)=</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UserParam1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Less than 2007</td>
<td>2005</td>
<td>3.1142E6</td>
</tr>
<tr>
<td></td>
<td>2006</td>
<td>6.2E5</td>
</tr>
<tr>
<td></td>
<td>2007</td>
<td>231089.1</td>
</tr>
<tr>
<td></td>
<td>2008</td>
<td>391752.38</td>
</tr>
</tbody>
</table>

5. Back to Pivot1 worksheet again. Click again the filter icon on Col A and select Clear Filter from the pop-up menu to remove the filter. Then select all columns to plot a column graph(Graph2). The graph would show the missing categories.

6. Back to Pivot1 worksheet again, right click the grey area and select Add Graph to add Graph2 onto the Pivot1 worksheet.

4.6.4.7 Create analysis template

Year filtering can also be obtained in Database. In this case, you can customize the favorable time period by rewriting this script:

```
WHERE SOH.OrderDate BETWEEN '1/1/2005' AND '12/31/2008'
```
In this section we will show you how to create analysis template for the pivot table, reimport data from database and reuse the analysis template to create pivot table for new data.

1. Activate the Book1, click **File: Save Workbook as template** and save it as `SumTotalCost.ogw`.
2. Open a new OPJ file and then click **File: Open** to open `SumTotalCost.ogw`.
3. To change the data source as `AdventureWorks2008` in database,
   - Activate Sheet1 and open SQL Editor by clicking the **Open SQL Editor** button.
   - Click **File: Edit Connection String** then type the following string in the open dialog, click **Test** then click OK to connect the database.

   ```
   Provider=SQLOLEDB.1;Password=mydatabase;Persist Security Info=True;
   User ID=accounting;Initial Catalog=AdventureWorks2008;Data Source=myServer
   ```

   - Back to the **SQL Editor** dialog, On the right panel, rewrite the last script as

   ```
   --WHERE SOH.OrderDate BETWEEN '1/1/2001' AND '12/31/2004'
   ```

   - Select menu File: Save to Active Worksheet to save these settings to the worksheet, and then select menu Query: Import to import the data into worksheet, and then close SQL Editor. We can see the imported data form the image below.

4. To update the pivot table, go to Sheet ‘Pivot1’, click the yellow lock and select **Recalculate**. The pivot table would be updated according to new data.
5. To update the embedded graph,
   - double click the embedded graph and a floating chart would pop up.
   - Select the graph and click **Rescale** button to refresh. The floating chart would be updated too.
   - click the arrow button at the upper right corner of the floating chart to put it back to the worksheet. The worksheet would look as follow.

4.6.5 Categorical Values Ordering and Sharing

4.6.5.1 Summary

Categorical values are used to store categories information in a column. In Origin, you have the capacity to manually add, remove, order categories in a column and the categorical information stored in the column will be carried over to result sheet during analysis. You can easily save categories into a text file and share across columns or worksheets.

Minimum Origin Version Required: Origin 2015 SR0

4.6.5.2 What you will learn
• How to manipulate categorical values
• How to order categorical map
• How to share categorical values

4.6.5.3 Manipulate Categorical Values

1. To import the Origin sample data, select Data: Import from File: Excel(XLS, XLSX, XLSM...) from the Origin menu. Browse to <Origin Program Folder>\Samples\Statistics and select HouseholdCareSamples.xls. Click the Add File(s) button. Make sure that the Show Options Dialog: check box is selected. Click the OK button to open the impMSEExcel dialog.

2. Specify the following settings in the impMSEExcel dialog:
   - Under File Info, expand the HouseholdCareSamples.xls branch. Unselect File Sheet(s), then check the check boxes next to HQ Family Mart and TX Trust-Mart.
   - In the Header Lines branch, select 1 in Number of Subheader Lines drop-down list and then 1 for Long Names. Check Apply Header to All Sheets box.
   - Click OK to import the data into Origin.

3. On the HQ Family Mart worksheet, highlight column Category (long name) and right click to select Set As Categorical. Double click on the Unsorted on Categories label row to bring up Categories dialog.

4. Now we want to only keep Household Clean, Kitchen Clean, Dishwashing Liquid, Laundry Powder and Fabric Conditioner five categories and order them as listed. To do so, first check Customize Categories (Add, Delete, Set Arbitrary Order) box, hold Ctrl key to select unwanted categorical values
and use **Remove** button \(\times\) to remove them.

5. Drag the row headings or use the \(\uparrow\), \(\downarrow\), and \(\leftrightarrow\) buttons to reorder, as shown below:
6. Then click **Save >** button and select **Save As** to bring up **Categories Save as** dialog. Enter **HouseholdCare Category** as **Name** and click **OK** to save the categorical values in a text file under displayed **Save Path** for sharing later.

![Categories Save as dialog](image)

7. Click **OK** to close **Categories** dialog box.

8. Next we want to know the total number of items in each of the five categories specified in step 4 and make a column plot of results. To do so, highlight column **Number** (long name) and go to Statistics: **Descriptive Statistics: Statistics on Columns: Open Dialog...** to bring up **Statistics on Columns** dialog, click right-sided triangle icon on **Group** row to select **E(Y):Category** as grouping column and click **OK** to close the dialog. In the prompt dialog, click **OK**.

9. Switch to **DescStatsQuantities1** flat sheet, select column **N total** (long name) and go to Plot: **2D: Bar: Column** to create the column plot.

10. Double click on the X axis tick labels to bring up **Tick Labels** page on **Axis** dialog, go to **Format** tab and select 45 from **Rotate (deg.)** drop-down list and click **OK** to close the dialog.

11. Double click on the graph to bring up **Plot Details** dialog, expand **Layer1** node to go to its subnode. In the Pattern tab, expand the **Color** drop-down list in the **Fill** group, select **By Points** tab, and choose the color **Black** under **Increment from** list to set it as the starting color. Click **OK** to close dialog.

![Plot Details dialog](image)

12. Right click on the page and select **Fit Page To Layers...** and click **OK** in the appeared dialog to bring the X axis label into page. Delete the legend, use **Text** tool to add **HQ Family Mart** as graph title. Move X axis
Beginning with Origin 2020b, you can toggle between display of Categories and Category Index in the worksheet column by clicking the **Show Category Indices** button on the worksheet page-level Mini Toolbar.

### 4.6.5.4 Share Categorical Values

1. Continue from the section above, now we want to share the categories saved earlier with second worksheet **TX Trust-Mart**. To do so, activate **TX Trust-Mart** sheet and highlight column *Category* (long name) and right click to select **Set As Categorical**.
2. Double click on the *Unsorted* on **Categories** label row to bring up **Categories** dialog, check **Customize Categories (Add, Delete, Set Arbitrary Order)** box and click **Load >** button on the right and select
appeared HouseholdCare Category file.

<table>
<thead>
<tr>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Household Clean</td>
</tr>
<tr>
<td>2 Kitchen Clean</td>
</tr>
<tr>
<td>3 Dishwashing Liquid</td>
</tr>
<tr>
<td>4 Laundry Powder</td>
</tr>
<tr>
<td>5 Fabric Conditioner</td>
</tr>
</tbody>
</table>

Customize Categories (Add, Delete, Set Arbitrary Order)
3. Follow steps 7-12 in above section and add text *TX Trust-Mart* instead of *HQ Family Mart* in step 12, we will obtain a column plot from *TX Trust Mart* source sheet as following:

![Graph2](image)

**4.7 Analysis Templates**

### 4.7.1 Analysis Templates

- [Creating and Using Analysis Templates](#)
- [Creating Analysis Templates using Set Column Value](#)
- [Creating a Custom Report Sheet](#)

### 4.7.2 Creating and Using Analysis Templates
4.7.2.1 Summary

Routine tasks can be simplified by creating an Analysis Template. Such templates can contain multiple analysis results and also custom report sheets. A new instance of the template can then be opened at any time and source data can be changed to update all analysis results and custom reports.

Minimum Origin Version Required: Origin 2015 SR0

4.7.2.2 What you will learn

- How to create an analysis template (OGWU)
- How to re-use an analysis template with new data

4.7.2.3 Steps

4.7.2.3.1 Importing Data

1. Start with a new workbook, activate the first empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Sensor01.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Double-click on the worksheet tab and rename the sheet as Data.

4.7.2.3.2 Performing Analysis

1. Highlight column B and use the Analysis: Fitting: Linear Fit menu item to open the Linear Fit dialog box.
2. Set Recalculate to Auto, accept other default settings and click OK to perform a linear fit. A hierarchical report sheet will be added to the book, with result tables and embedded graphs.
3. Answer Yes to the attention message to go to the FitLinear1 report sheet.
4. Under the Fitted Curves Plot tree node, double-click on the graph of plotted data plus fit curve to open the graph in an editable popup window.
5. Click the menu item View: Show: Frame to show the graph frame.
6. Click the **Rescale** button

7. Select **Format: Axes: X Axis...** to open the **Axis** dialog box. In **Scale** tab, make sure **Type** is set to **By Increment** under **Major Ticks** node and set the **Value** to **2**. Change the **Rescale** mode to **Auto**.

8. In the left panel, click the **Vertical** icon. Set Rescale to **Auto** and **Major Ticks** to **Type = By Increment** and set **Value** = **5**. Click **OK** to save the setting and close the dialog.

9. Manually move the legend object and the result table to suitable positions on the graph. At this point, you can also do such things as customize the scatter symbol. The final graph should look something like the image below:

10. Put this graph back into the result sheet by clicking on the restore button at the top right of the title bar.

### 4.7.2.3.3 Saving an Analysis Template

1. Activate the workbook and select **File:Save Workbook as Analysis Template**.

2. Browse to the desired location and enter a file name, for example **MySensorData**, and click the **OK** button.

3. Now the file **MySensorData.OGWU** is saved as an Analysis Template. This template can be re-used in the future to carry out similar analyses.

### 4.7.2.3.4 Re-using the Analysis Template
1. Start a new project, then select the menu item **File: Recent Books**. From the fly-out menu options, select the Analysis Template **MySensorData.ogwu** that was saved earlier.

2. Make the **Data** worksheet active, select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Curve Fitting** subfolder and find the file **Sensor02.dat**. Drag-and-drop this file into the worksheet "Data" to import it.

3. Since the **Recalculate** mode was set to **Auto**, the linear analysis will be performed automatically for the new data.

4. Go to the **FitLinear1** worksheet and under the **Fitted Curves Plot** node, double-click to open the graph and view the updated results.

   The Analysis Template can be used in the batch processing of similar data, see [this tutorial](#) for details.

### 4.7.3 Creating Analysis Templates using Set Column Value

#### 4.7.3.1 Summary

This tutorial will demonstrate how to add a column, set up **Before Formula Script** and have that script run whenever data changes in other columns. This technique can be used to create an **Analysis Template** for repeated analysis of similar data.

Minimum Origin Version Required: Origin 8.0 SR6

#### 4.7.3.2 What you will learn

- How to use Set Column Values to create an analysis template
- How to select rows via the **Go to** function

#### 4.7.3.3 Steps

1. Import the data from `\Samples\Statistics\automobile.dat` into a newly created workbook, as below. In this example, we will extract data, according to the **Make** column, into different worksheets.
2. Add an empty column to the worksheet and bring up the **Set Column Values** dialog of the column. In the **Before Formula Script** box, enter the script below.

```plaintext
// Data range on which to perform discrete frequency count
range makeCol = !col(make);

// Worksheet to be extracted
range sourceWks = !;

// Clear worksheets
int sheetNum = page.nlayers;
int colNum = wks.ncols - 1;

if (sheetNum>1)
{
    for (jj=2; jj<=sheetNum; jj++)
```
{       
    layer -d 2;
}
}

// Tree variable to hold discfreqs outputs

tree tr;

// Perform discrete frequency count

discfreqs irng:=makeCol rd:=tr;

// String array to get result from tree

StringArray sa;

sa.append(tr.FreqCount1.Data1);

if( sa.GetSize() != NANUM )
{
    // Loop to extract data
    for (ii=1; ii<=sa.GetSize(); ii++)
    {
        string sn$ = sa.GetAt(ii$);

        // Extract condition string

        string cond$ = "makeCol$ = " + sn$;
3. This script will first perform a discrete frequency count on the Make column to get distinct values for Make. It will then create a new worksheet for each brand and extract data into these sheets.

4. Make sure the recalculate mode is set to Auto and click OK. The data will be separated into different worksheets. Then the empty column (H) with a green lock icon indicates that this procedure can be updated automatically.
6. There are 18 makes of cars in the source data, so 18 new worksheets were created. Now we can check whether auto-update works.

   Go to the Honda tab. Notice that there are 19 rows.

7. Switch to the first sheet. Scroll down and delete the last row.

   Then auto-update will be triggered. Go to the Honda tab. You will see there are only 18 rows.
4.7.4 Creating a Custom Report Sheet

**Videos**
- Creating Batch Reports using Origin Analysis Template and Microsoft Word

**OriginBlog**
- Creating HTML Reports and Documents in Origin 2019b

### 4.7.4.1 Summary

Worksheets in Origin can be customized by merging cells and coalescing various objects such as graphs, external images, links to variables and tables/cells in other sheets, into a custom report.

This tutorial will show you how to add a custom report to an existing analysis template. You can then import new data, recalculate results, and export or print the custom report.

**Note:** This tutorial suggests that you can drag-and-drop data files onto Origin. If you do so, please do not run Origin as administrator.

Minimum Origin Version Required: Origin 9.0 SR0

### 4.7.4.2 What you will learn

- How to create a custom report sheet
- How to save a custom report as part of an Analysis Template (OGW) and re-use it with new data
4.7.4.3 Steps

Note: Please complete the previous tutorial named "Creating and Using Analysis Templates" in which an analysis template named MySensorData.OGWU is created.

4.7.4.3.1 Importing Data

1. Using the File:Open menu item, set the Files of type drop-down to Workbooks (*.ogwu), then navigate to and open the Analysis Template MySensorData.OGWU. This analysis template was saved with a linear fit analysis for column B of the first worksheet, and a customized embedded graph with the data and the linear fit line (note that templates do not contain data, so at this point, you see no data and no results).

2. Make the Data worksheet active. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Sensor01.dat. Drag-and-drop this file into the worksheet Data to import it.

4.7.4.3.2 Creating a Custom Report Sheet

1. Right-click on the Data worksheet and select Add to add a new worksheet. Rename this worksheet as Custom Report.

2. Activate the Custom Report sheet and choose Format:Worksheet (or hit F4) to open the Worksheet Properties dialog. Go to the Size tab and under the Size node, set Row Number as 20 and Column Number as 9. Then go to the Miscellaneous tab and check the Auto Add Rows check box. Click OK to apply these settings and close the dialog.

3. In the worksheet, click and drag on the row headers for Long Name, Unit, Comments and \( F(x) = \) to select these four rows. Then right click and select Hide from the context menu. This hides the four rows from the worksheet.

4. Highlight the range of the cells in the first three rows for all columns and click the Merge Cells button located in the Styles toolbar to merge the cells. Enter the text Sensor Data Analysis Report in this merged cell.

5. In the 5th row, merge the cells in columns G and H. Repeat for the 6th row. In row 5, column F, enter the text File Name: In row 6, column F, enter the text File Date:.

6. Right click the merged (column G and H) cells in row 5 and choose Insert Variables from the context menu. Make sure the dialog settings look like those in the image below and insert the FILENAME variable into this cell.
7. Right click the merged (column G and H) cells in row 6 and choose **Insert Variables** from the context menu. Insert the **FILEDATE** variable following the settings in the image below:
8. Right click on the cell containing the date information and choose **Format Cells** from the context menu. Change the **Format** drop-down to **Date** and click **OK**.

9. Go to the **FitLinear1** worksheet and locate the **Parameters** table. Click the triangle button next to it and choose **Copy Table** from the fly-out menu.

10. Go to the **Custom Report** sheet and select the 9th row in column E. Right click and choose **Paste Link**. Clear the pasted text **Sensor Output** in column E by pressing the **Delete** key.

11. In the 13th row, merge the cells in columns G and H. Do the same in the 14th row.

12. Return to the **FitLinearity** sheet and in the **Statistics** table, select the two data cells for **Pearson's r** and **Adj. R-Square**. Right click and choose **Copy** to copy only these two cells.

13. Go to the **Custom Report** sheet and select the merged cell in the 13th row, then right-click and choose **Paste Link**. The two merged cells are filled with corresponding values. Enter the text **Pearson's r** and **Adj. R-Square** in the cells to the left of these pasted values.

14. In the 8th row, merge the three cells in columns F, G and H. Do the same in rows 12 and 20. Enter the text **Fit Parameters**, **Fit Statistics** and **Report Date: $(@D, D1)** in rows 8, 12 and 20, respectively.

15. Right click on the merged cells in row 20 and choose **Set Data Style: Rich Text** from the context menu. By enabling rich text, the string $(@D, D1) will display as the actual system date.

16. Hold the CTRL key and select all cells with numeric values, then right-click and choose **Format Cells** in context menu, then choose **Set Decimal Places**= from the **Digits** drop-down menu, and enter 3 as **Decimal Number**, and press OK.
17. Using buttons in the **Style** and **Format** toolbars, change cell borders, font sizes, styles and colors to customize the report as in the image below. You may also need to manually adjust the width of some columns to ensure that all text is displayed.

18. Go to the **FitLinear1** sheet and double-click on the graph under **Fitted Curves Plot** to open the embedded graph. Right click on the graph's title bar and choose **Duplicate** from the context menu to duplicate the graph window (Graph1). Double click on the axis of duplicated graph to bring up **Axis** dialog. Go to **Scale** tab under both **X Axis** and **Y Axis** and choose **Auto** from the **Rescale** drop-down list. Then close the original embedded graph window.

19. Return to the **Custom Report** worksheet, right click on the gray area of this worksheet and select **Add Graph** from context menu. In the **Graph Browser**, select **Graph1** which was created by duplicating the embedded graph. Click **OK** to add this graph to this worksheet as a floating chart.

20. You can manually resize and move this floating chart using its anchor points and position it anywhere in the worksheet.

21. Go to **Format:Worksheet** (or press F4) to open the **Worksheet Properties** dialog. In the **View** tab, under the **Show Grid Lines** node, clear the check boxes next to **Column Grid** and **Row Grid**. On the **Format** tab, make sure **Apply To** is set to **Data**, and select **Show Missing as Blank** to show missing values as blank instead of displaying the "--" characters. Press **OK** to close this dialog.

22. Select **File:Print Preview** to preview the custom report. It should look similar to the image below:
Beginning with Origin 2018b all merged cells within a selected range, including non-contiguous blocks of merged cells, can be un-merged by clicking the Merge cells button on the Style toolbar.

### 4.7.4.3.3 Saving the Analysis Template

1. Activate the workbook and select File: Save Workbook as Analysis Template.
2. Browse to a desired file path and enter the file name SensorDataReport and click Save.
3. You can use this SensorDataReport.OGWU as an Analysis Template for future analyses of similar data, and the custom report will also be included in the workbook.

### 4.7.4.3.4 Re-using the Analysis Template

1. Start a new project and then select the menu item File: Recent Books and from the fly-out options select the Analysis Template SensorDataReport.ogw which was saved earlier.
2. Make the Data worksheet active, select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file Sensor02.dat. Drag-and-drop this file into the worksheet "Data" to import it.
3. The linear fit results and the custom report are automatically generated using the newly imported data.

### 4.8 Analysis Themes

#### 4.8.1 Summary

In Origin 8, analysis procedures can be controlled by Themes. Themes are actually XML files which save settings in the analysis dialog. For example, after performing the analysis, there will now be a <Last Used> theme for this dialog which has saved the most recently used settings. You can assign a proper name for the theme and use it in the future.
Tutorials for Origin 2024b

For this tutorial, the Statistics on Columns dialog will be used to demonstrate how to create and use an analysis theme. This analysis provides descriptive statistics about the data such as mean, standard deviation, minimum, maximum, and more. For visualization, a histogram or box chart can also be created in the Analysis Result Sheet.

Minimum Origin Version Required: Origin 8.0 SR6

4.8.2 What you will learn

This tutorial will show you how to:

- Perform simple descriptive statistics
- Create an Analysis Theme
- Use the theme

4.8.3 Steps

4.8.3.1 Save the analysis procedure as Theme

1. Start with a new workbook and import the file \Samples\Statistics\automobile.dat.
3. Select Quantities tab, then expand the Moments tree node, and check the N Total, Mean, Standard Deviation, SE of Mean and Sum box.
4. Expand the Plots tree node, and check the Histograms and Box Charts check boxes. You will then get the corresponding histogram as well as box chart graphs.
5. Your selections in this analysis dialog can be saved as your theme, so that you may easily repeat the procedure. Click the arrow to the right of Dialog Theme and choose Save as... ...

... to bring up this dialog:
6. Type a proper theme name, such as "MyTheme" and click OK.

7. Click the OK button in the Statistics on Columns dialog. Results are reported to a new worksheet named DescStatsOnCols1.

You can save a customized dialog theme as default, so it will be used every time you open the dialog of analysis operation. To do this, choose Save as <Default> to save the current dialog theme as the default setting of this dialog. It is also possible to delete the default theme and roll back to system default, to do this, choose Delete from the fly-out menu.

You can save also save your Analysis Report Sheet configuration to a Theme file by expanding or collapsing output nodes, then choosing Save Node Configuration from the shortcut menu. For more information, see Save Node Configuration in this table.

4.8.3.2 Repeat the analysis procedure by Theme
Once you save a theme, there are many ways to use it. For example, you can highlight column E and perform the same statistical analyses on it.

- Open the **Statistics on Columns** dialog from the **Most Recently Used** items at the bottom of the **Statistics** menu. Most of the menu accessible dialogs can be opened from MRU menus.

When you open the dialog from MRU, the default theme is <Last Used>. To use the **MyTheme** theme, select **MyTheme** from the **Dialog Theme** shortcut menu. The settings from that theme will then be displayed in the dialog. Click the **OK** button to do the analysis.

- Another way to apply the analysis theme is to use the cascaded menu item. Once you use an analysis dialog for the first time after installation, or save a theme for a dialog, there will be one more menu level added. You can choose the **MyTheme** menu.
When selecting, *Open Dialog...*, the dialog will open to the <Factory Default> theme. To change the settings of your theme, you can select your theme name from the *Dialog Theme* shortcut menu inside the dialog, make changes, and resave the theme. Alternatively, to open a dialog with a saved theme without performing the analysis, hold down the *shift* key while selecting the theme from the menu. This will bring up the dialog with your theme applied so you can make changes as needed.

### 4.9 Batch Processing

#### 4.9.1 Batch Processing

- Batch Processing Multiple Datasets
- Batch Processing Multiple Files using Analysis Template
- Batch Processing with Summary Report in External Excel File
- Batch Processing with Word Template for Reporting
- Batch Processing Grouped Datasets Using Analysis Template with Multi-Data Sheets

#### 4.9.2 Batch Processing Multiple Datasets

- Introduction Batch Processing without Programming
- Batch Processing improvements in 2020b
- Use the Distributed Batch Processing App for Faster Batch Processing Results Creating HTML Reports and Documents in
4.9.2.1 Summary

Origin can perform batch analysis of multiple files or datasets, using a pre-saved Analysis Template or current active workbook with analysis operations. This tutorial will focus on batch analysis of multiple datasets using current active workbook/analysis template.

While not as flexible or powerful as the Batch Processing, you can "clone" import and analysis operations in the active workbook, using the procedure outlined in this tutorial.

4.9.2.2 What You Will Learn

This tutorial will show you how to:

- Perform analysis on one sample data and create new result sheet with the results you desired
- Perform batch processing multiple datasets using current active workbook containing analysis operations with recalculation.

4.9.2.3 Steps

4.9.2.3.1 Perform fitting on one data firstly

1. Start with a new workbook, click the button and browse to `<Origin EXE folder>\Samples\Curve Fitting` folder and select file `Sensor01.dat` to import data with default import settings.
2. Highlight col(B) to select Analysis: Fitting: Linear Fit... to open the Linear Fit dialog. Set Recalculate to Auto, and then go to the tab Fit Control, check Fix Intercept check box and set Fix Intercept at as 0.
3. Click OK button to perform the fitting.
4. Go to the sheet `FitLinear1`, click the downward arrow aside the Summary branch to select Create Copy as New Sheet. A new sheet "Summary" will be created with the fitting results. Go to this new sheet, rename it to "Result" and delete the col(A).

4.9.2.3.2 Performing the fitting on multiple datasets with Batch Processing tool
1. With the workbook active, select **File: Batch Processing** from the menu or click the **Batch Processing** button to open the **Batch Processing** dialog.

2. Select the **Repeatedly Import into Active Analysis Template Window** radio button for the **Batch Processing Mode**.
   **Note:** You can also save an analysis template and use it with **Load Analysis Template** option in your Batch Processing routines.

3. Select **Import From Files** for the **Data Source** drop-down list.

4. Click on the **Browse** button in the **File List** section and select all sensor data **Sensor##.dat** from the `<Origin EXE Folder>\Samples\Curve Fitting` folder.

5. Select **File Name** for the **Dataset Identifier**.
6. Make sure the **Data Sheet(s)** drop-down is set to **Sensor01**.
7. Make sure the **Result Sheet** drop-down is set to **Result**.
8. Click **OK**. All sensor data will be analyzed, and a workbook "Summary" will be generated, displaying the summarized analysis results based on the **Result** sheet in the original worksheet.

![Image of Origin Analysis Results](attachment:image.png)

### 4.9.3 Batch Processing Multiple Files using Analysis Template

#### Videos
- Introduction Batch Processing without Programming
- Batch Processing improvements in 2020b
- Use Clone Import to batch process more data files
- Batch Processing Improvements in Origin 2018
- Batch Import and Analysis of Groups of Files
- Import Multiple Data into Cloned Book or Sheets for Batch Processing

#### OriginBlog
- Use the Distributed Batch Processing App for Faster Batch Processing Results Creating HTML Reports and Documents in Origin 2019b
- Creating HTML Reports and Documents in Origin 2019b
- Batch Processing when Dragging and Dropping Data into Origin

### 4.9.3.1 Summary

Origin can perform **Batch Analysis** utilizing a previously-created **Analysis Template**, by either importing multiple files or loading existing datasets. This tutorial covers importing multiple text files with a common file structure, then processing them one-by-one using an Analysis Template set up to perform linear curve fitting.
While not offering as many options as the Batch Processing tool, you can "clone" import and analysis operations in the active workbook, using the procedure outlined in this tutorial.

4.9.3.2 What You Will Learn

This tutorial will show you how to:

- Make an analysis template which contains a Result Summary Sheet to collect the output of batch processing.
- Perform batch processing with multiple data files using an analysis template

4.9.3.3 Steps

This tutorial is divided into two parts:

1. Set up an Analysis Template. The template is an empty framework that includes a Summary sheet to collect the analysis output of batch processing operations.
2. Perform the Batch Processing of multiple files using the previously-saved Analysis Template.

4.9.3.3.1 Preparing an Analysis Template containing a Result Summary Sheet

1. Since batch operations work on similarly-structured data files, the first step is to import a typical data file. Create a new workbook and click Data: Connect to File: Text/CSV. Browse to <Origin EXE folder>\Samples\Curve Fitting\Sensor01.dat and choose the file. Accept CSV Import Options defaults and click OK to import your data.
2. Now we'll perform a linear fit on the data. Highlight column B(Y) and choose Analysis: Fitting: Linear Fit. Set Recalculate = Auto and then click OK (note that by choosing Auto, we have assured that new input will trigger automatic recalculation of results). Answer Yes to the reminder message and open the FitLinear1 report sheet.
3. We'll now add a Results sheet to our workbook where we will collect key statistics from our batch analysis. Go to FitLinear1 and next to the Summary table, click the downward-pointing arrow button and choose Create Copy as New Sheet. Click the button TWICE to add two new columns to your Summary sheet.
4. We'd like to add Pearson's r value to our summary so return to FitLinear1, find the Statistics table, then click the caption beside the value and right-click and choose Copy. Go to Summary, right-click in the Parameters cell of column G(Y) and Paste Link. Copy the Pearson's r value and Paste Link into row 1 of column G(Y).
5. We'll now add a data plot with fit curve to our summary sheet. Return to FitLinear1, scroll down to the Fitted Curves Plot, right-click on the plot and choose Copy. Return to the summary sheet and in row 1 of column H(Y), right-click and choose Paste Link. To the Long Name cell in this column, add Fitted Curve.
6. To save the workbook as an Analysis Template, choose File: Save Workbook as Analysis Template, accept the default \User Files location and name the template as Sensor Analysis. Click Save.
4.9.3.3.2 Performing Batch Processing with Multiple Data Files

We'll now use our Analysis Template to batch process a number of data files and obtain summary output.

1. Start a new project and choose **File: Batch Processing...** or click the button on the Standard toolbar.
2. Set **Batch Processing Mode** = **Load Analysis Template**, then browse to your User Files folder and choose **Sensor Analysis.ogwu**.
3. Set **Data Source** = **Import from Files** and use the browse button to the right of **File List** to `<Origin EXE Folder>\Samples\Curve Fitting` and add files `Sensor02.dat` through `Sensor07.dat`.
4. Set **Dataset Identifier** = **File Name** to tag output in our Summary sheet with the source file name.
5. Set **Data Sheet** = **Sensor01** and **Result Sheet** to **Summary**.
6. Check the **Delete Intermediate Workbook** (Note that since **Origin 2018** you have the option of using the **Open Book(s)** button in the Summary sheet to regenerate individual intermediate workbooks, if needed).

7. Click **OK**. All data files will be processed a Summary workbook generated to summarize analysis of each file.
4.9.4 Batch Processing with Summary Report in External Excel File

### Videos

- Creating Batch Reports using Origin Analysis Template and Microsoft Word
- Markdown and HTML Reports

### OriginBlog

- Creating HTML Reports and Documents in Origin 2019b
- Using Markdown for Custom Origin Reports
- Improved Table Support in HTML Reports in Origin 2019b
- COVID-19 Daily Update of World Situation Report of Confirmed Cases
- COVID-19 Real Time Report from China

#### 4.9.4.1 Summary

This tutorial is associated with the Sample Origin Project: \Samples\Batch Processing\Summary Report in External Excel File.opj

Minimum Origin Version Required: Origin 8.1 SR2

#### 4.9.4.2 What you will learn

- How to perform batch processing of multiple data files
• How to send results to an external Excel file and save that file

4.9.4.3 Steps

1. Make the 'Raw Data' Worksheet in the 'Book1' Workbook active.

2. Select File : Batch Processing... from the menu or click the Batch Processing button on the Standard Toolbar.

3. Select the Repeatedly Import into Active Analysis Template Window radio.

4. Set Data Source as Import From Files.

5. Check the Use Import Setting in Workbook check box.

6. Click the ... browse button next to File List.

7. Select All Files (*.*) in Files of Type and browse to Origin's \Samples\Batch Processing folder.

8. Select all 10 .csv files in the folder, click Add File(s) then click OK.

9. Dataset Identifier should be set to None.

10. Data Sheet(s) should be set to 'Raw Data'. Note: 'Raw Data' is the first sheet of 'Analysis Template', it will be renamed as the file name of last import file by default if this template has already been used and re-saved.

11. Result Sheet should be set to 'My Results'.

12. Click the button to the right of the "Output Sheet" edit box. This will minimize the main dialog. Then click on the title bar of the Excel book (Book2), and press the button to the right of the scrolled up dialog to expand it again.

13. Expand the Options branch and check the Clear Output Sheet on Start check box and enter 7 as the Starting Row of Output Sheet.

14. Check the Append Label Rows check box.

15. Click OK

4.9.5 Batch Processing with Word Template for Reporting

4.9.5.1 Summary

Origin can perform batch analysis of multiple files and output cell-linked analysis results to an external Word template for reporting.

Minimum Origin Version Required: Origin 2016 SR0

4.9.5.2 What you will learn

This tutorial will show you how to:

• Add bookmarks from a Word template to a specific Analysis Template
• Link analysis results to bookmarked cells in Word template and adjust the sizes of graphs to be exported
• Sending one time results to Word template for reporting
• Perform batch analysis of multiple files and export results to Word/PDF files
4.9.5.3 Steps

In this tutorial we will use a built-in Word template Sensor Analysis Report.dotx which is located at <Origin EXE folder>\Samples\Batch Processing\ folder. To view the bookmark labels on the Word template, with the file open go to File: Options to open Word Options dialog. Then select Advanced on the left panel and scroll down to section Show document content on the right panel and check Show bookmarks checkbox there.
4.9.5.3.1 Add Bookmarks to Analysis Template
1. Start Origin. Click **File: Open** and browse to `<Origin EXE>\Samples\Batch Processing` folder and select the file **Sensor Analysis.ogw** (NOT "Sensor Analysis.ogwu") and open it.

2. Activate worksheet **Data**, click the button and browse to `<Origin EXE folder>\Samples\Curve Fitting` folder and select file **Sensor01.dat** to import data for analysis.

3. Go to menu **File: Add Word Bookmarks to Analysis Template...** to open dialog. Click the browse button to the right of the **Word template** box and browse to `<Origin EXE folder>\Samples\Batch Processing` folder to select **Sensor Analysis Report.dotx**.

4. Click to select all bookmark entries in the **Bookmarks** list under **Select Bookmarks** and click **OK** to add a **Bookmarks** sheet to the active analysis template.

4.9.5.3.2 **Link Analysis Results to Word Template**

1. Click on the **Bookmarks** tab.

2. In the **Links** column, right-click the cell to the right of **FileName** and select **Insert Variables**.

3. In the Insert Variables dialog, click the **Info** tab, expand the SYSTEM.IMPORT node and highlight **FILENAME**. Click the **Insert** button to insert the file name into the worksheet cell.

4. Right-click the cell beside **FileDate** and again choose **Insert Variables**, expand the SYSTEM.IMPORT node, highlight **FILEDATE** and click the **Insert** button to insert the file date into the worksheet cell. Note that the value that is inserted is a Julian Day value, the number that Origin uses internally to store date-time data. To display in a more familiar date format, right-click the cell and select **Format Cells**.

5. From the **Format** drop-down list, select **Date** and click **OK** to close the dialog.
6. Right-click the cell beside the FittedGraph cell and select **Insert Graph**. Click the browse button \(\ldots\) to the right of the **Graphs** box to open **Graph Browser** dialog. Check the **Show Embedded Graph** box to display a list of worksheet-embedded graphs. Click to select the FitLine graph and add it to panel on the right. Click **OK** twice to insert the graph into **Bookmarks** worksheet. In the **GraphWidth** column to the right, enter 250 (units = point size) to specify the size of the graph that will be exported to Word.

![Graph Browser](image)

7. Repeat the last step for the row ResidualPlot.
8. For bookmarks related to parameter values, we will copy and paste link values from the report sheet **FitLinear1**. Click the report sheet **FitLinear1** and locate the **Parameters** table. Click on the data cell at the intersection of Intercept and Value, right-click and select **Copy**. Return to the **Bookmarks** sheet, right-click the cell to the right of InterceptValue and select **Paste Link** to create a link between bookmarks in the Word template and values in report sheet.
9. Repeat this "Copy and Paste Link" operation to fill in the rest of cells in the **Links** column (you'll find the RSquare value beside Adj. R-Square in the Statistics table). When done, click **File: Save Workbook as**
4.9.5.3.3 Sending One Time Results to Word Template to Create Word Report

Sometimes we may just want to analyze one data file and quickly create one Word report. Continue from the example above, suppose we have all results linked to Word bookmarks as shown in Bookmarks worksheet, to create an one time Word report for active sheet you can simply click Export to Word button on the top left corner to create it.

You can further specify where to output the Word report in appeared Export Path dialog.

4.9.5.3.4 Batch Process and Export Results to Word/PDF Files

Beginning with Origin 2020, you can export PDF and MS Word reports as a single multi-page File. To do so, check the Export as multi-page File box before running you batch operation.

1. Start with a new project.
2. Click on the Batch Processing button.
3. Make sure Load Analysis Template is selected as Batch Processing Mode. In the Analysis Template drop-down, select the Sensor Analysis Template.ogw(u) file we created earlier (you may need to click the button to the right of the list and browse to the created file).
4. Select **PDF** from **Export to** drop-down list to export report as PDF file.

5. Click the browse button to the right of the **Word template** box and browse to `<Origin EXE folder>\Samples\Batch Processing\` folder to select **Sensor Analysis Report.dotx**.

6. Optionally you can click browse button on the right of **Export Path** to specify another path for export.

7. Click on the browse button to the right of **File List**, browse to the `<Origin EXE Folder>\Samples\Curve Fitting` folder and select all sensor files **Sensor0#.dat**.

8. Click **Add File(s)**, then click **OK**.

9. Select **File Name** as **Dataset Identifier**.

10. Make sure the **Data Sheet** drop-down is set as **Data**.

11. Make sure the **Result Sheet** drop-down is set as **Result**.

12. Make sure that **Delete Intermediate Workbook** is cleared.

13. Click **OK** to close the dialog and process the "Sensor" data files.
If you forget where to look for your exported PDF files, the location is output to **Messages Log**.
A sample of exported PDF version report is as following:

---

**Sensor Data Analysis Report**

File Name: Sensor02.dat
File Date: 9/13/2017

<table>
<thead>
<tr>
<th>Summary Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
</tr>
<tr>
<td>Slope</td>
</tr>
<tr>
<td>Adj. R-Square</td>
</tr>
</tbody>
</table>

---

**Fitted Curve Plot**

**Residual Plot**

---

### 4.9.6 Batch Processing Grouped Datasets Using Analysis Template with Multi-Data Sheets

#### 4.9.6.1 Summary

Origin can perform batch analysis on grouped datasets using an analysis template with multiple data sheets.

Minimum Origin Version Required: 2016 SR0
4.9.6.2 What you will learn

This tutorial will show you how to:

- Create a multi-data sheets analysis template
- Perform batch analysis on grouped datasets using analysis template

4.9.6.3 How the Analysis Template Works

The reference multi-data sheets analysis template Multi-Data Sheets Analysis.ogw that we are going to make is located in <Origin EXE Folder>\Samples\Batch Processing folder. This analysis template will process 10 CSV files located in <Origin EXE Folder>\Samples\Batch Processing folder in group of 5. Every 5 data files will be imported into the sequential data sheets in the analysis template and a non-linear fit will be conducted to obtain the peak area and its standard error of each curve. Eventually we will perform linear fit to peak area versus temperature data extracted from file name and output the results.

4.9.6.4 Steps

4.9.6.4.1 Create Multi-Data Sheets Analysis Template

Import CSV Files into Sequential Data Sheets

1. Create a new workbook. From the menu, click Data: Connect Multiple Files to open the files2dc dialog.
2. Set the Data Connector dropdown to CSV, then browse to the <Origin EXE Folder>\Samples\Batch Processing folder and select the first five data files.
3. Check the Same Book box and click OK.

Perform Nonlinear Fit to Obtain Peak Area

4. Highlight column 2 in sheet T275k, hold Ctrl + Y or go to menu Analysis: Fitting: Nonlinear Curve Fit to open the NLFit dialog.
5. Set Recalculate = Auto.
7. Click Fit button to perform the fitting. Click OK in the prompt to close it.
8. Repeat steps 4 - 7 for data T285k, T295k, T305k, T315K to obtain peak areas for all five peaks.

Prepare Data for Linear Fit

8. Right click sheet tab FitNLCurve5 and select Add to add a worksheet. Double click on the name and input TempData as sheet name.
9. Hold Ctrl+D to open Add New Columns dialog and input 2 in the edit box to add 2 extra columns. Click OK button to close dialog.
10. Set the Long Name of the 4 columns as Data File, Temperature, Area Value, Area Error, respectively.
11. Right click the first data cell in column Data File and select Insert Variable to open dialog. In the right panel, right-click the Book node and check Show Sheet Level to show sheets in the book. Then click T275K sheet on the right panel and click Label tab on the left panel. Click property Name to highlight that row and click Insert button to insert sheet name into this cell.

12. Repeat this step for other four sheets to add the sheet name to column Data File.

13. Next we want to extract the temperature number from sheet name in first column, to do so highlight column Temperature and right click to select Set Column Values... Input formula below in the edit box to extract the middle 3 numbers from file name and click OK to close dialog and apply.

```
Value(mid(col(A),2,3)
```

14. Go to sheet FitNL1 and highlight the two value cells under variable A in Summary' node. Right click to select Copy to copy the data. Then go to TempData sheet and paste link the data in the first row in column Area Value and Area Error. Repeat this step for other four data files.

15. Set the designation of column Temperature as X, column Area Error as Y Error.

Perform Linear Fit and Create Result Sheet

16. Highlight column Area Value and Area Error and go to menu Analysis: Fitting: Linear Fit to open dialog, select Recalculate mode as Auto, click OK to perform linear fitting and close the dialog. Click OK in appeared prompt to close it.

17. Right click sheet tab FitLinearCurve1 and select Add to add a new sheet and name it as Results.

18. Hold Ctrl + D to open Add New Columns dialog and input 3 in edit box to add 3 new columns.

19. Set the Long Name of the 5 columns as Intercept Value, Intercept Error, Slope Value, Slope Error and Adj. R-Square, respectively.

20. Go to sheet FitLinear1, copy the 5 value cells under Summary node and go back to Results sheet and click the first cell in first data row to paste as link.

21. Go to menu File: Save Workbook As Analysis Template... to save it as an analysis template and name it as Multi-Data Sheets Analysis.

4.9.6.4.2 Batch Analyze Files in Groups

In <Origin EXE Folder>\Samples\Batch Processing folder, we have 10 CSV data files. Suppose now we want to group the files as two groups and re-order them as: group 1 as T365K, T345K, T325K, T305K, T285K; group 2 as T355K, T335K, T315K, T295K, T275K. After we will process those two grouped files using the analysis template we created in section above.

1. Go to menu File: Batch Processing... to open dialog, click the more options button next to Analysis Template edit box to browse to analysis template Multi-Data Sheets Analysis.ogwu.

2. Click the more options button next to File List edit box to bring up Open dialog. Firstly drag and drop CSV files one by one to re-order them as shown below and click Add File(s) button to add the files to list.
Click **OK** button to exit dialog.
3. Select **File Name** as **Dataset Identifier**, **Results** sheet as **Result Sheet** and uncheck **Delete Intermediate Workbook**.

4. Click **OK** button to start processing. And click OK button to save the Batch Processing dialog settings into the analysis template used (only available since Origin 2018b). The results will be outputted to **Summary** workbook as shown below:

Note the three buttons added to the top of the **Output Sheet** (Summary book, Results sheet):

- **Open Book(s)**: If you enable **Delete Intermediate Workbook** (see step #3, above), then later decide you need them, you can highlight corresponding rows in
the *Results* sheet and click this button to regenerate deleted books.

- **Reprocess**: Click this button to re-run import and update results when there have been changes to external data files.
- **Update**: Click this button to update results when something is changed on the input side of your analysis (e.g. masking of data in your data sheets).
5  Statistics

5.1  Statistics

5.1.1  Descriptive Statistics

- Descriptive Statistics
- Cross Tabulation and Chi-square
- 2D Binning
- Distribution Fit
- Partial Correlation Coefficient

5.1.2  Hypothesis Tests

5.1.3  ANOVA

- One Way ANOVA
- One-Way Repeated Measures ANOVA
- Two Way ANOVA
- Two Way Repeated Measures ANOVA
- Two-Way Mixed-Design ANOVA
- Three-Way ANOVA

5.1.4  Nonparametric Tests

- Non-parametric Statistics Overview

5.1.5  Survival Analysis

- Kaplan-Meier Estimator
- COX Model Estimator
- Weibull Fit

5.1.6  Multivariate Analysis
5.1.7 **Power and Sample Size**

5.1.8 **ROC curve**

5.2 **Descriptive Statistics**

5.2.1 **Descriptive Statistics**

- Descriptive Statistics
- Cross Tabulation and Chi-square
- 2D Binning
- Distribution Fit
- Partial Correlation Coefficient

5.2.2 **Descriptive Statistics**

5.2.2.1 **Summary**

Origin provides comprehensive Descriptive Statistics support including basic statistics (mean, median, variance, etc.), frequency counts, and correlation coefficients of your data sets. In addition to strong plotting features, Origin's statistical tools help you summarize and analyze your data.

5.2.2.2 **What You Will Learn**

This tutorial will show you how to:
• Use the **Statistics on Column** dialog to calculate descriptive statistics for grouped data.
• Copy statistical results to a new worksheet for further processing.
• Sort worksheet data by the attribute values in a designated column.
• Analyze data sets with the **Correlation Coefficient** Tool.

Minimum Origin Version Required: Origin 2015 SR0

5.2.2.3 Finding Frequency Information for Groups

We will use the **Discrete Frequency** tool to quickly obtain frequency information for groups of data.

1. Open a new workbook. Select **Data: Import from File: SingleASCII** menu, and import the data file `\Samples\Statistics\automobile.dat`.
2. Highlight the first two columns in the **automobile** worksheet. From the Menu Bar, select **Statistics: Descriptive Statistics: Discrete Frequency**.
3. Change the **Recalculate** mode to **Auto**. To make operation in the source data worksheet **Controlling the Categorical Values section** working, change the **Sort Data By** to **Categorical Order**. Then click **OK**.
4. The resultant worksheet **DiscretFreq1** displays data and its counts for automobile Year and Make, respectively.

In spite of the fact that there are locks on the columns, the worksheet can be rearranged by highlighting the desired column, going to the Menu Bar, selecting **Worksheet:Sort Worksheet**, and selecting **Ascending**, **Descending**, or **Custom** from there.

5.2.2.4 **Calculating Descriptive Statistics on Grouped Data**

Basic statistical treatments can be performed on the data in individual columns using the **Statistics on Columns** tool.
1. Return to the **automobile** worksheet. From the Menu Bar, select **Statistics: Descriptive Statistics: Statistics on Columns: Open Dialog**.

2. In the **Statistics on Columns** dialog box, in the **Input** tab, expand **Range 1** and click the interactive button to the right of **Data Range**. Return to the worksheet, select column **C** and drag to column **G**. Click the interactive button again to restore the dialog box. In the dialog box, after adjusting **Input Data** under **Range 1**, click the arrow button at the top-right corner of the Group control box to select B(Y): **Make** as grouping data. Change the **Recalculate** mode to **Auto**.

3. In the **Output** tab, under the **Graph** branch, check the **Arrange Plots of Same Type in One Graph** box. Also, in the **Plots** tab, check the **Box Charts** check box.
Tutorials for Origin 2024b

Statistics on Columns

Graph:
- Arrange Graphs into Columns
- Arrange Plots of Same Type in One Graph

Dataset Identifier:
- Report Tables
- Quantities
- Optional Report Tables

Statistics on Columns

Input | Quantities | Computation Control | Output | Plots

- Histograms
- Box Charts

OK  Cancel
4. Click **OK** to get the results in a report sheet.

In order to modify any embedded box plot in report sheet, double-click to open it, then customize the graph and click the **Return** button in the top right corner to restore the modified graph back to the report sheet.

5.2.2.5 Using Statistical Results for Further Operations

It is possible to perform further data analysis and to plot the statistical results.

For example, to obtain average attribute values (i.e. horsepower, 0-60 mph time, weight, mileage) by Vehicle Make from 1992 to 2004, perform the following:

1. Return to the **automobile** - **automobile.dat** workbook, and open the **DescStatsQuantities1** worksheet. Highlight the **D(Y2)** and the **E(yEr±)** columns, go to the Menu Bar and select **Worksheet: Unstack Columns: Open Dialog**....

2. In the **wunstackcol** dialog box, change the **Recalculate** mode to **Auto**, select **Group Columns** and click the context menu button and select **A(X1) Data**.

3. Expand **Options** and check the **Include Other Columns** box. On **Other Columns**, click the context menu button and select **B:(X2) Make**. Set **Matching Longest Group** as Extract Rule for Other Columns Values, expand **Output Settings**, and from **Put Grouping Info. to**, select **Long Name**. Click
4. To see the results, open worksheet **UnstackCols1**, highlight the worksheet, and from the Menu Bar, select **Plot > Multi-Panel/Axis : Stack**.

5. In the **Plotting:plotstack** dialog box, set **Plot Type** to **Scatter**. Click **OK**.

6. Now we are going to rotate the tick labels at top X axis for clarification. Double click on the top X axis tick labels to open the **Axis** dialog, and set the following in **Top** icon. Click **OK**.
Rotate the Tick Labels for bottom in the same way.
7. The report sheet and the graph will appear as shown below:

![Graph](image)

5.2.2.6 Analyzing the Relationship Between Different Indicators

Use a correlation coefficient to explore the relationship between columns of the automobile data. Next, construct scatter plots with confidence ellipses to obtain graphical representations of the correlations.

1. In the **automobile - automobile.dat** workbook, open the **automobile** worksheet, and highlight the last five columns.
2. From the Menu Bar, select **Statistics: Descriptive Statistics: Correlation Coefficient: Open Dialog...**. In the **corrcoef** dialog box, expand **Correlation Types** and check the **Pearson** box.
3. Expand **Plots** and check the **Add Confidence Ellipse** box. The **Scatter Plot** check box will be automatically selected. Click **OK**.
4. The ScatterMatrix1 and CorrCeof1 worksheets should appear as below, demonstrating the high positive correlation between Engine Displacement and Power, and the high negative correlation between Gas Mileage and Engine Displacement.

5.2.2.7 Controlling the Categorical Values

1. In the following steps, we want to customized the order of values shown in the graph but not change the source data. Right click Column B in workbook, select Set As Categorical in the context menu, double click the Categories cell of the column, "Unsorted", to open the Categories dialog.

2. Check Customize Categories checkbox, use \[\ldots\] to adjust position of each item to follow the image below, in this way we can sort the items by country of the manufacturers, which is U.S.->Japanese/Korea->Europe. Click OK to close the dialog.
3. You can go to the report sheet created in section above. Because **Auto** mode is used for recalculation, the report sheet of **Discrete Frequencies** and **Statistics on Columns**, including the box charts, are updated automatically with the specified order of the Categorical data.
4. The results of **Unstacked Columns** and the stacked graph are updated automatically as well.
Note: If the operation hasn't been auto-updated, you can also manually trigger the operations by clicking the **Recalculate** button in the **Standard** toolbar. The button will turn green after recalculation is done.

### 5.2.3 Cross Tabulation and Chi-square
5.2.3.1 Summary

Cross tabulation is particularly useful for analyzing categorical data. In these analyses, a contingency table is used to display the frequency distribution of two or more variables. Analyses based on the table can determine whether there is a significant relationship between variables, and assess the strength of the relationship between the variables.

Minimum Origin Version Required: Origin 2016 SR0

5.2.3.2 What you will learn

This tutorial will show you:

1. How to perform the Cross Tabulation.
2. How to interpret the results.

5.2.3.3 User Story

Our data are from the Montana Economic Outlook Poll conducted in May 1992, with accompanying demographics for 209 out of 418 poll respondents. We have data on seven variables: Age(under 35, 35-54, 55 and over), Sex(male, female), Financial Status(worse, same, or better than a year ago), etc. With the data, we want to learn:

1. The frequency distribution of financial status in three different age groups, and whether male and female differ in the distribution.
2. Whether there is significant relationship between "Financial status" and "Age" for male and female groups.
3. The strength of the relationship.

5.2.3.4 Preparing Data for Analysis

1. Open a new project or a new workbook. Import the data file \Samples\Statistics\MontanacOutlookPoll.dat
2. We begin by sorting the categorical values.
   o On the MontanacOutlookPoll worksheet, highlight column B and right click to select Set As Categorical. Double-click on Unsorted in the Categories label row to open the Categories dialog box. Check Customize Categories (Add, Delete, Set Arbitrary Order) box. Then use the Move To Top, Move Up, Move Down and Move To Bottom buttons to reorder categories as "under 35", "35-54" and "55 and over":

631
Repeat the same steps for column C so that the categorical mapping is <Female, Male>

Repeat the same steps for column G so that the categorical mapping is <Better, Same, Worse>

To exclude missing values from analysis, we should set the columns as categorical. Otherwise the missing values will be kept as numeric values.

5.2.3.5 Performing Cross Tabulation and Chi-square

1. Open the Cross Tabulation and Chi-square dialog by choosing the menu item Statistics: Descriptive Statistics: Cross Tabulation and Chi-square.

2. Click on the Input tab. The data is in raw data mode, so select column B, G and C for Row, Column and Layer, respectively.
3. Click on the **Statistics** tab, uncheck the **Expected Counts, Residuals, Standardized Residuals** and **Adjusted Residuals** and accept all the other default settings.

4. On the **Tests** tab, select the **Chi-Square Test** check box. Expand the **Measures of Association** branch, and then select the **Contingency Coefficients, Phi, and Cramer’s V** boxes (for measuring nominal association).
5. Click on the **Output** tab and select the **Mosaic Plot** check box. Accept the other default settings and click **OK**.

### 5.2.3.6 Interpreting The Results

Go to sheet **Crosstab1**

#### 5.2.3.6.1 Frequency Distribution

We can get frequency distribution information from the **Mosaic Plot** and the **Contingency Table**. The area of each rectangle in the **Mosaic Plot** is proportional to the percentage of the Y variable for each level of the X variable, so we can visually compare the frequency distribution of "Financial status" and "Age" for female, male and total. From the **Contingency Table** we can get more specific information. Combining the **Mosaic Plot** with **Contingency Table**, we learn:

1. There is a major difference between younger and older women’s views.
A majority of women under 35, 59.5%, feel they have better financial status. A majority of women 55 and over, 58.3% think their financial status remains the same.

Fewer women under 35, 11.9%, think their wealth status remains the same, while fewer women over 55, 11.1% think that they are better off financially.

2. Compared to women, men's feeling for financial status shows another interesting pattern:
   - Men show no significant difference in financial status between age groups.
   - Men between 35 - 54 are a little more likely to be confident of their financial status.
3. Regardless of the sex of respondents, there are some trends by age:
   - People under 55 are more likely to be confident of their financial status
   - People over 55 are more likely to feel that their financial status did not change.
Detecting Relationships Between Age and Financial Status

The **Chi-Square Tests** Table show test results for the independence of row and column variables. If the `Prob>ChiSq` is less than 0.05, this means the row and column variables, in this case age and financial status, are significantly related. Note the conclusions in the footnotes beneath the table. We conclude that:

- Women of different ages differ in financial status.
- In contrast, there is no evidence to show an association between men's age and their financial status.
- Regardless sex, people of different ages usually differ in financial status.
### 5.2.3.6.3 Assessing the Strength of the Relationship

The **Measures of Association** table helps in assessing the strength of the relationship between "Financial status" and "Age". As this is a 3x3 table (three levels for Age and three levels for Financial status), we can choose a **Contingency Coefficient** to compare across layers. (See the introduction page for the difference of the three statistics). From the table we can see:

- Women’s financial status shows a stronger association with age than is the case with men.
  
  (0.444 v.s. 0.155)

### 5.2.4 2D Binning
5.2.4.1 Summary

The 2D Frequency Count/Binning operation counts the frequencies for data with two variables. A 3D bar graph and/or an image plot of the results can be generated, giving a graphic representation of data distribution.

Minimum Origin Version Required: Origin 2015 SR0

5.2.4.2 What you will learn

- How to count the frequencies for data with two variables.
- How to plot 2D binning into 3D Histogram.

5.2.4.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.
1. Open the Tutorial Data.opj and browse to the folder **2D Frequency Count (Binning)**, and activate the **3D Histogram.dat** book.

2. Highlight column A and column B, select menu **Statistics: Descriptive Statistics: 2D Frequency Counts/Binning** to bring up the TwoDBinning dialog.

3. Specify the following settings in the dialog box:
   - Uncheck the **Auto** checkbox, set the **Bin Size** for X to 40.
   - Set the **Bin Size** for Y to 15.

![TwoDBinning dialog screen](image)
Check on **Output Matrix** checkbox in the end of the dialog and check on **3D Bars** for **Matrix Plot**.

4. Click the **OK** button, then you will get the following outputs:

- **Worksheet**

<table>
<thead>
<tr>
<th>Bin Ends of Tensile Strength?</th>
<th>Count</th>
<th>Count</th>
<th>Count</th>
<th>Count</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>120 - 135</td>
<td>840</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>135 - 150</td>
<td>880</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>150 - 165</td>
<td>920</td>
<td>1</td>
<td>0</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>165 - 180</td>
<td>960</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td>17</td>
</tr>
<tr>
<td>180 - 195</td>
<td>1000</td>
<td>0</td>
<td>2</td>
<td>4</td>
<td>39</td>
</tr>
<tr>
<td>195 - 210</td>
<td>1043</td>
<td>1</td>
<td>3</td>
<td>9</td>
<td>36</td>
</tr>
<tr>
<td>210</td>
<td>1080</td>
<td>0</td>
<td>2</td>
<td>3</td>
<td>22</td>
</tr>
</tbody>
</table>

- **Matrix**

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>1</td>
<td>3</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>17</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>3</td>
<td>14</td>
<td>32</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>1</td>
<td>11</td>
<td>42</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>37</td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>17</td>
</tr>
<tr>
<td>9</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>6</td>
</tr>
</tbody>
</table>

- **3D Histogram**
5.2.4.4 Further Customizations

4. Double click the 3D Histogram to go to the Plot Details dialog, go to the Colormap tab, click the Fill button to open the Fill tab, specifies the Fill tab follows the graph below.
Click **OK** to close the **Fill** tab, and click **OK** in **Plot Details** to close the dialog.

5. Double click the Axis to open the **Axis** dialog and go to **Scale** tab, specifies the **Scale** for XYZ axis follows the graphs below:

   - Change the scale for X axis in X icon form 820 to 1220 with Major Ticks value 40.
▪ Change the scale for Y axis in Y icon form 127.5 to 277.5 with Major Ticks value 15.
▪ Change the scale for Z axis in Z icon form 0 to 100 with Major Ticks value 20.

6. Change title for X, Y, Z axis in Title tab into Tensile Strength, Brinell Hardness and Number of Tests, respectively. Click OK to apply the setting and close the dialog.

5.2.5 Distribution Fit

5.2.5.1 Summary

Knowing the distribution model of the data helps you to continue with the right analysis or make estimation of your data. The Distribution Fit tool helps users to examine the distribution of their data, and estimate parameters for the distribution.

5.2.5.2 What you will learn

This tutorial will show you:

- How to carry out distribution fit for practical data with Origin
- How to interpret the generated results

5.2.5.3 User Story

A house builder is trying to decide how many new houses he should build in the next year based on past sales of houses in the surrounding area. He would like to know the following:
• If he is going to build 80 new houses, what is the probability that all of them will be sold?
• The builder believes that he can make a profit if there is at least a 60% probability that he will sell all of his houses. How many houses should he build?

To solve this problem, The house builder needs to:

• Perform a distribution fit to sample data (houses sold in the surrounding area)
• Select the best fitting distribution
• Calculate the probability using the cumulative distribution function of the selected distribution
• If the probability is more than 60%, reconsider the schedule.

### 5.2.5.4 Choosing Distributions

1. Start with a new project or a new workbook. Import the data file: \Samples\Statistics\HouseSold.dat

2. Highlight Column B, select **Plot > Statistical > Histogram** from Origin menu

![Histogram of New House Sold](image)

3. Consider the facts as below to choose the distributions:
   - The data are taken on integer values only so we can consider to fit both continuous and discrete distributions. (If there are floating point numbers, only continuous distributions can be considered). However, as usually continuous distributions provide better fit than discrete distributions we want to choose from continuous distributions.
   - Value of new house sold are positive values, we don't need to consider the normal distribution, which can take on negative values
   - Look at the histogram, the data is clustered around a value, we don't need to consider the exponential distribution, which is for data extremely asymmetric
5.2.5.5 Performing Distribution Fit

1. Return to the HouseSold worksheet and highlight the column B. From the Menu Bar, select the Statistics: Descriptive Statistics: Distribution Fit menu.

2. In the dialog that opens, in the Distributions tab, clear Normal and select the following three distributions based on the conclusions in the Choosing Distributions section:
   - LogNormal
   - Weibull
   - Gamma

3. In the Plots tab, select Probability Plot.
4. In the **Goodness of Fit** tab, check all three methods. Click **OK** to apply the settings and close dialog.

5.2.5.6 **Comparing and Selecting Fitting Models**

We can compare and select a fitting model based on the following results of distribution fit:

- **Probability (P-P) Plot**
The closer all the scatter points are to the reference line, the better the distribution is for the dataset. From the Probability Plot, both lognormal and gamma distribution can be considered as good models for the data.

- **Goodness of Fit Tests** table
  
  Look at the P-values in table, if the p-value is less than 0.05, it means we reject the distribution at the 0.05 level. P-value of lognormal and gamma are larger than 0.05, then from the Goodness of Fit Tests, we can see that both lognormal and gamma are good models for the data.
From the **Probability (P-P) Plot** and **Goodness of Fit Tests** table, we can draw a conclusion that lognormal and gamma are both good choices. Here we choose the lognormal as an example for further analysis.

### 5.2.5.7 Making Estimations

Once the best distribution model is found, we can use the CDF and INV functions to calculate these probabilities:

- If he is going to build 80 new houses, what is the probability that all of them will be sold?
- How many houses should be built if he hopes to have a 60% chance of selling all of the houses?

1. To answer the first question, open the **Command Window** or the **Script Window** from the **Windows** menu, and type commands as below

   \[
   \text{logncdf}(80, 3.94262, 0.35614) = \]

2. where 3.94262 is mu and 0.35614 is sigma, obtained from the **Parameter Estimates** table in the Report Sheet.

3. You will get

   \[
   \text{logncdf}(80, 3.94262, 0.35614) = 0.89136185728793
   \]

5. We can conclude that if the house builder builds 80 new houses, there is an 89% probability that he will NOT sell all of those houses.

1. To answer the second question, run the script below in the **Command Window** or the **Script Window**

   \[
   \text{logninv}(1-0.6, 3.94262, 0.35614) = \]

2. You will get

   \[
   \text{logninv}(1-0.6, 3.94262, 0.35614) = 47.105650533425
   \]

3. We can conclude that the house builder is more likely to make a profit if he builds 47 new houses.
We choose the lognormal model in **Choosing Distribution** section so we use logncdf and logninv for the estimation. If we choose gamma, we can use **gamcdf** and **gaminv** for the estimation, which will result in a similar conclusion.

**Notes:** There are also other descriptive statistics and graphs in results of **Distribution Fit** which help you to take a quick look of your data

- **Descriptive Statistics** table
- **Quantiles** table
- **Histogram**
- **Box Chart**
- **CDF** (Cumulative Distribution Function Plot)

### 5.2.6 Partial Correlation Coefficient

#### 5.2.6.1 Summary

The Partial Correlation Coefficient is a tool for measuring the linear relationship between two random variables, after excluding the effects of one or more control variables.

#### 5.2.6.2 What you will learn

This tutorial will show you:

- How to carry out partial correlation in Origin, using a practical example.
- How to interpret the generated results.

#### 5.2.6.3 User Story

We have some public data from the World Bank that includes 11 indicators (health expenditure, GDP, population, etc.) by country, for years 2000 to 2010. We want to study the relationship between internet use, mobile phone use and health expenditures in the United States.

#### 5.2.6.4 Detect Relationship with Pearson’s R

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

1. Open the **Tutorial Data.opj** and browse to the folder **Partial Correlation Coefficient**, and activate the **Partial Correlation Coefficient** book.
2. Activate **Sheet1** with source data. We have already applied a data filter to get data for the United States between 2000 and 2010.
3. First we will use the **Correlation Coefficient** tool to visually detect the relationship between **Mobile phone subscribers**, **Total internet users**, **Health expenditures per capita** and the **GDP per capita**.
1. Press the `Ctrl` key and highlight `Col(E), Col(U1), Col(H)` and `Col(S)`.
2. From the menu, select **Statistics: Descriptive Statistics: Correlation Coefficient**.

3. In the opened dialog, select the **Scatter plots** and **Add Confidence Ellipse** check boxes under the **Plots** branch. Clear the **Show Significance in Result Table** check box and select the **Flag Significant Correlations** check box.

4. From the Pearson’s correlation coefficient and the scatter matrix, we can see:
   
   3. 
   
   - The scatter data are fairly linear.
   - The shape of confidence ellipses is narrow.
   - All Pearson’s correlation coefficients are flagged in red.
   - Each Pearson’s correlation coefficient is larger than 0.9.

   It appears that there is a strong relationship between **Mobile phone subscribers**, **Total internet users**, **Health expenditures per capita** and **GDP per capita**.
5.2.6.5 Revealing the Real Relationship with Partial Correlation Coefficients

Though it appears that Mobile phone subscribers, Total internet user and Health expenditure per capita are strongly related, we know that GDP per capita also affects these three indicators. We want to measure the real relationship of the three indicators after excluding the effect of GDP per capita.

1. Activate the sheet with source data. Press the Ctrl key and highlight Col(E), Col(U1) and Col(H).
3. In the opened dialog, the three highlighted columns are automatically selected as Variables.
4. We want to remove the effect of GDP per capita, so we choose Col(S) as Controlling Variables. Select the Flag Significant Correlations check box.
5. Go to sheet PCorr1. It contains the partial correlation coefficients after excluding the effect of GDP per capita. We can see:
   o Only Mobile phone subscribers and Health expenditures per capita are significantly related (The Partial Corr value is marked as red). But the real relationship is not as strong as the Pearson's r seemed to show previously. (Partial Corr = 0.87307 v.s. Pearson's Corr = 0.99157).
The Partial correlation coefficient for Mobile phone subscribers and Total internet users decreased to be 0.26178. They are not significant related.

There is no evidence to show Total internet users and Health expenditures per capita are related (Partial Corr = 0.07615), while previously, we obtained a Pearson's $r = 0.96685$.

### Conclusion

Why such different results? Looking at the Pearson's $r$ value of GDP per capita between the other three indicators, we can see GDP per capita influenced the three indicators. Even though there is no relationship between Total internet users and Health expenditures per capita, Total internet users and Mobile phone subscribers, the “false relationship” is still shown by the Pearson's $r$ because of the effect of GDP per capita. Partial Correlation Coefficients are useful for examining the true relationship between two factors by eliminating the effects of correlated control variables. The statistic is useful for experiments where various interrelated phenomena are to be studied.

### 5.3 Hypothesis Tests

#### 5.3.1 Summary

Hypothesis tests are frequently used to measure the quality of sample parameters or to test whether estimations for two samples on a given parameter are equal.

With parametric methods, assumptions are made about the underlying distribution from where the sample populations are selected. Usually, it requires that the data are independently sampled from a normal distribution.

#### 5.3.2 What you will learn

This tutorial will show you:

- How to carry out hypothesis tests for practical data with Origin
- How to interpret the generated results
5.3.3 Steps

5.3.3.1 Hypothesis Tests in Origin

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Goal</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Sample</td>
<td>Compare the mean with a given value</td>
<td>One-Sample t-Test</td>
</tr>
<tr>
<td></td>
<td>Compare the variance with a given value</td>
<td>One-Sample Test for Variance</td>
</tr>
<tr>
<td>Two Samples</td>
<td>Test whether the means are equal</td>
<td>Two-Sample t-Test</td>
</tr>
<tr>
<td></td>
<td>Test whether the variance are equal</td>
<td>Two Sample Test for Variances</td>
</tr>
<tr>
<td>Paired Samples</td>
<td>Test whether the means are equal</td>
<td>Pair-Sample t-Test</td>
</tr>
</tbody>
</table>

5.3.3.2 One-Sample t-Test

5.3.3.2.1 Perform One-Sample t-Test using Raw data

Suppose a manufacturer produces high-quality screw nuts that must equal 21 millimeters in diameter. The quality control department randomly drew 120 nuts from the finished products, measured the diameters for each and stored the results in Diameters.dat file. They want to determine whether the mean diameter of the nuts is equal to 21 or not. Historically, the distribution of the measured diameters is known to be approximately normal, but the standard deviation of the population is unknown. Hence they may use the One-Sample t-Test in Origin following the steps below:

1. Start with a new workbook and import the file \Samples\Statistics\diameter.dat.
2. Open the One-Sample t-Test dialog by using the menu item Statistics:Hypothesis Testing:One-Sample t-Test.
3. Click the Input tab, set Input Data Form to Raw.
4. Click the arrow button to the right of Input and select A(X):diameter.
5. Click the t-Test for Mean tab and set Test Mean to 21; Make sure that Alternate Hypothesis is set to Mean <> 21 (two-sided test), check Confidence Interval(s) and set Confidence Level(s) in % to 95.
Note that by default the test procedure provides descriptive statistics of the variable and the hypothesis test results. Additionally, it is possible to produce a histogram of the data and a confidence interval for the mean.

Click the **OK** button to finish the analysis and generate results.
The Descriptive Statistics table shows the sample size, mean, standard deviation, and standard error for the variable. The sample mean, 21.00459, is comparatively little bigger than the hypothesis mean 21, and the standard error of the mean (SEM) is 0.00156.

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Mean</th>
<th>SD</th>
<th>SEM</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;diameter&quot;</td>
<td>100</td>
<td>21.005</td>
<td>0.0159</td>
<td>0.00156</td>
</tr>
</tbody>
</table>

From the t-Test table, the t statistic (2.9437) and the associated p-value (0.00404) provide evidence that the average diameter of screw nuts is significantly different with 21 at the $\alpha = 0.05$ level.

|                | t Statistic | DF | Prob>|t| |
|----------------|-------------|----|------|-----|
| "diameter"     | 2.9437      | 99 | 0.00404 |

Null Hypothesis: Mean = 21
Alternative Hypothesis: Mean $\neq$ 21
"diameter": At the 0.05 level, the population mean is significantly different from the test mean (21).

The confidence interval indicates that it is 95% confident that the true mean of the variable lies within the interval [21.0015, 21.00769].

<table>
<thead>
<tr>
<th></th>
<th>Conf. Levels in %</th>
<th>Lower Limits</th>
<th>Upper Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;diameter&quot;</td>
<td>95</td>
<td>21.0015</td>
<td>21.00769</td>
</tr>
</tbody>
</table>

5.3.3.2.1.2 Perform One-Sample t-Test using Summarized data

To perform a One-Sample t-Test using summarized data, we need to change the Input Data From in Input tab into Summarized data.

Assume we have measured 70 nuts this time, so the sample size will be 70. After a further calculation, we have got 20.95 for the mean, and 0.218 for the standard deviation. So we enter the mean, standard deviation.
and sample size into the **Input** Box below:

Then, we set 21 as the **Test Mean** in **t-Test for Mean** tab, click **OK** to execute.

We get the summary table shown below, the results indicate that the population mean is **NOT** significantly different from the test mean in this study.

5.3.3.3 **Pair-sample t-Test**

5.3.3.3.1.1 **Perform Pair-sample t-Test using Raw data**

Suppose you want to compare abrasion resistance between two kinds of tires. You randomly draw from each type of tires respectively and group them into 8 pairs. Make sure each pair consists of two types of tires. Next, equip the paired tires on 8 planes to run the abrasion test and measure the abrasion data to do paired-sample t-test.

1. Start with a new workbook and import the file "\Samples\Statistics\abrasion_raw.dat."
2. Open the **Pair-sample t-Test** dialog by using the menu item **Statistics:Hypothesis Testing:Pair-sample t-Test**.
3. On the **Input** tab, set column `tireA` as **1st Data Range** and column `tireB` as **2nd Data Range**.
4. Click the **t-Test for Mean** tab and enter 0 to be **Test Mean**.
5. Accept other settings as default and click the OK button to generate results.

From the t-Test table, the t statistic (2.83119) and the associated p-value (0.02536) indicate that the difference between the two means is significant, that is to say, the two types of tires have different abrasion resistance.

5.3.3.3.1.2 Perform Pair-sample t-Test using Summarized data

Perform Pair-Sample t-Test using Summarized data

To perform a Pair-Sample t-Test using summarized data, we need to change the Input Data From in Input tab into Summarized data.

Assume 16 samples has been tested this time, so the sample size will be 16. After a further calculation, we have got 305 for the mean paired difference, and 310 for the standard deviation for the difference between
paired data points (please refer to Algorithms: Pair Sample T-Test). So we enter the mean difference, standard
deviation and sample size into the Input Box below:

Since our data yielded a p-value of 0.0013, which is less than our 0.05 a-level, we can reject the null hypothesis.

This study indicates the difference between the two means is significant, thus, the two types of tires have
different abrasion resistance.

5.3.3.4 Two-Sample independent t-Test

5.3.3.4.1 Perform Two-Sample t-Test using Raw data

A physician is evaluating the effect of two kinds of soporifics. To test the effectiveness of these two medicines,
20 insomniacs patients are randomly selected. Half took medicine A and the other half took medicine B, The
extended sleeping time were recorded after each patient took the medicine. The result is saved as the
time_raw.dat file.
To determine whether the two medicine have different effect on patients, we could carry out a two-sample
independent t-test with the following steps:

1. Start with a new workbook and import the file \Samples\Statistics\time_raw.dat.
2. Open the Two-Sample t-Test dialog by using the menu item Statistics:Hypothesis Testing:Two-
   Sample t-Test.
3. On the **Input** tab, select **Raw** for the **Input Data Form**; set **medicineA** as **1st Data Range** and **medicineB** as the **2nd Data Range**.

![Two-Sample t-Test: TwoSampleTTest](image)

4. Accept other settings as default and click the **OK** button to generate results.

The t-Test procedure automatically provides two tests of the mean difference. One is based on the assumption that the variances of two samples are equal and the other is not. In this example, both tests indicate that there is no significant evidence for a difference in cure effects between medicine A and medicine B. (p-values are 0.0738 and 0.074, both greater than the significance level 0.05.)

![t-Test Statistics](image)

5.3.4.1.2 Perform Two-Sample t-Test using Summarized data

To perform a Two-Sample t-Test using summarized data, we need to change the **Input Data From** in **Input** tab into **Summarized data**.

Assume 50 patients has been tested this time, so the sample size will be 50. After a further calculation, we have got 2.33 for the 1st mean, and 1.858 for the 1st standard deviation, and 1.28 for the 2nd mean, and 1.671 for the 2nd standard deviation. So we enter the mean, standard deviation and sample size into the Input Box below.
We can also check on the Confidence Intervals (Levels in 95%) in **t-Test for mean** tab, to calculate the difference between test groups. Click **OK** to execute.
Since our data yielded a p-value of 0.0037, which is less than our 0.05 a-level, we can reject the null hypothesis. This study indicates that the mean extended sleeping of two patients groups are not the same. In fact, we can conclude that 1st soporific has a stronger effect on patients.

The Confidence Intervals show that we can be 95% confident that the mean time difference between two groups is 0.3487~1.7513.

Note that both equal variance and unequal variance assumptions are supported. To determine whether the two samples have equal variances, we may select from top menu Statistics:Hypothesis Testing:Two-Sample Test for Variance to use the two-sample test for variance for testing.

5.3.3.5 Two-Sample Test for Variance

1. Continue with a new workbook and import the file \Samples\Statistics\time_raw.dat.
2. Open the Two-Sample Test for Variance dialog by using the menu item Statistics:Hypothesis Testing:Two-Sample Test for Variance.
3. Select "Raw" for the Input Data Form; set column A and column B as the first and second data range respectively.
4. Accept other settings as default and click the OK button to generate results.

According to result, \( P_{value} = 0.77181 > 0.05 \), therefore, it fail to reject null hypothesis, so two population variances are not significant difference.

5.4 ANOVA

5.4.1 ANOVA
5.4.2 One Way ANOVA

5.4.2.1 Summary

Statistics has two modes of data input; indexed and raw. When a statistical analysis is performed, there is usually no need to use an entire data set; Origin provides several methods of data selection. For example, the interactive Regional Data Selector button can be used in the graphical selection of data, or the Column Browser dialog can be employed to make the selection.

In this tutorial, you will learn how to use the two methods of data input so that the Analysis of Variance (ANOVA) statistical test can be performed.

ANOVA is a parametric method for means comparison of several groups, and it is also an extension of two independent sample t-tests. ANOVA is more powerful than multiple t-tests since it controls the chance to commit type I error better when the number of groups is relatively large. For example, when comparing the means among 5 groups using a t-test, ten multiples of the t-test, each with a significance level of 0.05, are performed, resulting in an overall chance to commit type I error of 1-(1-0.05)^10=0.401. Under the same circumstances, the chance to commit type I error in ANOVA is 0.05.

ANOVA requires normality and equal variance. If these requirements are not met, non-parametric analysis should be used.

Minimum Origin Version Required: Origin 2016 SR0

5.4.2.2 What You Will Learn

This tutorial will show you how to:

- Use different input data modes in the statistical analysis dialog
- Do normality tests
- Perform one-way ANOVA
5.4.2.3  **Steps**

Origin can perform ANOVA from an indexed data mode, or from a raw data mode.

When an indexed data mode is used, the data needs to be organized in a factor column and a data column.

![Indexed Data Mode](image1)

When a raw data mode is used, the data needs to be organized with different levels in different columns.

![Raw Data Mode](image2)

### 5.4.2.3.1 Indexed Data Mode

Nitrogen content, in milligrams, has been recorded for 4 kinds of plants. We are interested to know whether different plants have significantly different nitrogen content. As a result, we will use the index data mode in One-Way ANOVA analysis.

1. Start with a new workbook and select **Help: Open Folder: Sample Folder...** to open the “Samples” folder. In this folder, open the **Statistics** subfolder and find the file **nitrogen.txt**. Drag-and-drop this file into the empty worksheet to import it.
2. Next, we perform a normality test on each group of data to determine whether it follows a normal distribution. Highlight the first column of the workbook and from the Menu Bar, select **Worksheet: Sort Worksheet: Ascending**.
3. From the Menu Bar, select **Statistics: Descriptive Statistics: Normality Test: Open Dialog**. In the **Normality Test** dialog, in the **Input** tab, expand **Input Data** and **Range 1**. Press the triangle button at the right of **Data Range** and select **B(Y): nitrogen**, then press the triangle button at the right of **Group** and select **A(X): plant**. Click **OK**.

4. With the **nitrogen** worksheet active, go to the Menu Bar and open **Statistics: ANOVA: One-Way ANOVA...**. In the **ANOVAOneWay** dialog box, in the **Input** tab, set **Input Data** to **Indexed**. Pressing the triangle button at the right of **Factor**, select **A(X): plant** and pressing the triangle button at the right of **Data**, select **B(Y): nitrogen**.
5. In the **Means Comparison** tab, check the **Tukey** check box; In the **Tests for Equal Variance** tab, check the **Levene** check box; In **Power Analysis** tab, select **Actual Power** check box; In the **Plots** tab, check the **Means Plot [SE as Error]** and the **Means Comparison Plot** check boxes. Click **OK**.

**Result Interpretations**

- On the ANOVA1Way1 report sheet, you will see a **Homogeneity of Variance Test** node. If results are not visible, click to expand the node. Because the p-value is greater than 0.05, the four groups are considered to have equal variance.

  ![Levene's Test](image)

  At the 0.05 level, the population variances are not significantly different.

- The ANOVA table (Overall ANOVA) reports a p-value that is smaller than 0.05, hence at least two of the four groups have significantly different means.

  ![Overall ANOVA](image)

- Expanding the results of "Means Comparisons" reveals further information regarding relationships between groups.
Here we see that the mean of PLANT4 differs significantly from the other three groups. Looking at the Means Plot and Means Comparison Plot, we can see that PLANT4 has the smallest mean and is significantly different from the other three groups.
In the "Powers" table, **Actual Power** = 0.99976, that is, the chance of a Type II error occurring is almost equal to zero.

![Means Comparison using Tukey Test](image)

- In the "Powers" table, **Actual Power** = 0.99976, that is, the chance of a Type II error occurring is almost equal to zero.

<table>
<thead>
<tr>
<th>Powers</th>
<th>Alpha</th>
<th>Sample Size</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.05</td>
<td>80</td>
<td>0.99976</td>
</tr>
</tbody>
</table>

**5.4.3.2 Raw Data Mode**

1. Start with a new workbook and select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file *nitrogen_raw.txt*. Drag-and-drop this file into the empty worksheet to import it.
2. Choose **Statistics: ANOVA: One-Way ANOVA**.
3. On the **Input** tab, set **Input Data** to **Raw**, then set **Number of levels** to 4.
4. Click the browse button to the right of **Data** and choose **Select from Worksheet**. The dialog box rolls up.
5. Select all four columns (Plant1, Plant2, Plant3, Plant4) and on the rolled-up dialog box, click **Done**. Click **OK** to perform the ANOVA.
6. Examine the analysis results and you will see that we reach the same conclusions as we did when using **Indexed data mode**.
If the Level Name is set to Auto, it will follow the column long name of the selected data.

5.4.3 One-Way Repeated Measures ANOVA

5.4.3.1 Summary

One-way repeated measures ANOVA is similar to one-way ANOVA, but deals with a dependent variable subjected to repeated measurements. In this situation, the independence assumption of general one-way ANOVA is not tenable, since there is probably a correlation between levels of the repeated factor.

Similar to one-way ANOVA, one-way repeated measures ANOVA can be employed to test whether the means are equal or not. These means include the mean of different measurements and the mean of different subjects. The results will be shown in the table named Test of Within-Subjects Effect and Test of Between-Subjects Effect respectively. Note that the repeated measures ANOVA in Origin requires balanced sample data, that is, equal sample size at each level.

Minimum Origin Version Required: Origin 8.6 Pro SR0

5.4.3.2 What you will learn

This tutorial will show you how to:
- Input indexed data into the statistical analysis dialog.
- Perform One-way Repeated Measures ANOVA.
- Interpret results of a One-way Repeated Measures ANOVA analysis.

5.4.3.3 Steps

Origin can perform **One-Way Repeated Measures ANOVA** in both indexed and raw data mode. For **One-Way Repeated Measures ANOVA**, if the indexed mode is used, data should be organized into three columns: **Factor**, **data**, and **Subject**. When the Raw data mode is used, the different levels should be in different columns.

**5.4.3.3.1 Indexed data mode**

The data contains measurements for 3 different doses on 20 subjects, and we are interested in whether different doses on subjects have different effects. To test this, we will perform a One-Way Repeated Measures ANOVA using the indexed data mode.

1. Start with an empty worksheet. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the **Statistics** subfolder and find the file **One Way_RM_ANOVA_indexed.dat**. Drag-and-drop this file into the empty worksheet to import it.

2. Select **Statistics: ANOVA: One-Way Repeated Measures ANOVA** to open the dialog. In the **Input** tab of this dialog, select **Indexed** from the **Input Data** drop-down list and set column **B(dose)**, **C(Data)**, and **A(Subject)** as the **Factor**, **Data**, and **Subject** respectively.
3. Go to **Means Comparison** tab, select the check box after **Bonferroni** to enable the Bonferroni test.

4. Select the **Means Plot (SE as Error)** and **Means comparison Plot** check boxes in the **Plots** tab.

5. Click the **OK** button to perform the analysis.
5.4.3.3.2 Results Interpretation

Go to the worksheet **ANOVAOneWayRM1**, where the analysis results are listed.

You can refer to this help file for details of interpreting results of repeated measures ANOVA.

<table>
<thead>
<tr>
<th>Multivariate Tests</th>
<th>Value</th>
<th>F</th>
<th>Num df</th>
<th>DF</th>
<th>Prob&gt;F</th>
</tr>
</thead>
<tbody>
<tr>
<td>dose</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pillai's Trace</td>
<td>0.17777</td>
<td>3.02689</td>
<td>2</td>
<td>28</td>
<td>0.06455</td>
</tr>
<tr>
<td>Wilks' Lambda</td>
<td>0.82223</td>
<td>3.02689</td>
<td>2</td>
<td>28</td>
<td>0.06455</td>
</tr>
<tr>
<td>Hotelling's Trace</td>
<td>0.21621</td>
<td>3.02689</td>
<td>2</td>
<td>28</td>
<td>0.06455</td>
</tr>
<tr>
<td>Roy's Largest Root</td>
<td>0.21621</td>
<td>3.02689</td>
<td>2</td>
<td>28</td>
<td>0.06455</td>
</tr>
</tbody>
</table>

Origin prints out MANOVA automatically alongside repeated measures to detect repeated-measures effects. Note that the four different methods (Pillai's trace, Wilks' lambda, Hotelling's trace, and Roy's largest root) generate identical F statistics and probabilities, P=0.06455, so the means under three levels condition are not statistically different. Compare with the following report in repeated measures ANOVA, we can see that the conclusion is conservative.

<table>
<thead>
<tr>
<th>Mauchly's Test of Sphericity</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>dose</td>
<td>0.94367</td>
<td>1.01448</td>
<td>2</td>
<td>0.44609</td>
</tr>
</tbody>
</table>

This table shows the results of the Mauchly's Test of Sphericity. From the test results we can see that Sphericity holds. We are interested in the value of **Prob > ChiSq**, which is the significance level of the Mauchly's Test, we can see from this example that the significance level (0.44609) is greater than 0.05. Therefore, the assumption of Sphericity has not been violated.

<table>
<thead>
<tr>
<th>Tests of Within-Subjects Effects</th>
<th>Sum of Squares</th>
<th>DF</th>
<th>Mean Square</th>
<th>F</th>
<th>Prob&gt;F</th>
</tr>
</thead>
<tbody>
<tr>
<td>dose</td>
<td>Sphericity Assumed</td>
<td>0.4473</td>
<td>2</td>
<td>0.22365</td>
<td>3.43018</td>
</tr>
<tr>
<td></td>
<td>Greenhouse-Geisser</td>
<td>0.4473</td>
<td>1.09309</td>
<td>0.23618</td>
<td>3.43018</td>
</tr>
<tr>
<td></td>
<td>Huynh-Feldt</td>
<td>0.4473</td>
<td>2</td>
<td>0.22365</td>
<td>3.43018</td>
</tr>
<tr>
<td></td>
<td>Lower-bound</td>
<td>0.4473</td>
<td>1</td>
<td>0.4473</td>
<td>3.43018</td>
</tr>
<tr>
<td>Error(dose)</td>
<td>Sphericity Assumed</td>
<td>3.78162</td>
<td>56</td>
<td>0.0652</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greenhouse-Geisser</td>
<td>3.78162</td>
<td>64.92273</td>
<td>0.06886</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Huynh-Feldt</td>
<td>3.78162</td>
<td>56</td>
<td>0.0652</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lower-bound</td>
<td>3.78162</td>
<td>29</td>
<td>0.1304</td>
<td></td>
</tr>
</tbody>
</table>

From this table we are able to get the F value for the factor in addition to its associated significance level and effect size. As our data follow the assumption of Sphericity, we can conclude that when using an ANOVA with repeated measures with **Sphericity Assumed**, the means under three levels condition are statistically different (P = 0.03908 < 0.05). In other words, dose is a significant factor.

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Mean</th>
<th>Std Error</th>
<th>95.00% LCL</th>
<th>95.00% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1.1312</td>
<td>0.06975</td>
<td>0.99065</td>
<td>1.27181</td>
</tr>
<tr>
<td>20</td>
<td>0.95877</td>
<td>0.05254</td>
<td>0.84988</td>
<td>1.06765</td>
</tr>
<tr>
<td>30</td>
<td>1.03663</td>
<td>0.06119</td>
<td>0.91178</td>
<td>1.16207</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pairwise Comparison</th>
<th>Mean Difference</th>
<th>Std Error</th>
<th>DF</th>
<th>t-value</th>
<th>Prob&gt;</th>
<th>Alpha</th>
<th>Sig Flag</th>
<th>95.00% LCL</th>
<th>95.00% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 20</td>
<td>0.127243</td>
<td>0.06593</td>
<td>58</td>
<td>2.61543</td>
<td>0.03462</td>
<td>0.05</td>
<td>1</td>
<td>0.00289</td>
<td>0.33486</td>
</tr>
<tr>
<td>10 30</td>
<td>1.00427</td>
<td>0.05693</td>
<td>65</td>
<td>1.42089</td>
<td>0.47434</td>
<td>0.05</td>
<td>0</td>
<td>-0.08287</td>
<td>0.26581</td>
</tr>
<tr>
<td>20 30</td>
<td>-0.07816</td>
<td>0.06593</td>
<td>58</td>
<td>1.10554</td>
<td>0.21922</td>
<td>0.05</td>
<td>0</td>
<td>-0.2407</td>
<td>0.08436</td>
</tr>
</tbody>
</table>
The results presented in the previous table showed that there is an overall significant difference among the means but we do not know where those differences came from. This table shows the results of the Bonferroni test, which allows us to learn which specific means are different. In this case, the means of dose=10 and dose=20 have a significant difference ($P = 0.03402 < 0.05$ and Sig Flag = 1).

From the two plots below, we can also easily come to the same conclusion.

### Means Comparison using Bonferroni Test

- **Mean Diff (significant difference)**
- **Mean Diff (nonsignificant difference)**

#### 5.4.4 Two Way ANOVA
5.4.4.1 Summary

In some cases, we want to examine the relationship between two factors (categorical variables) and a continuous outcome variable. The effects on the outcome of the change in one factor may depend on the level of the other factor, so we need to consider the interactions between two factors. Two way ANOVA is an appropriate method to analyze the main effects of and interactions between two factors.

Minimum Origin Version Required: Origin 2016 SR0

5.4.4.2 What you will learn

This tutorial will show you how to:

- Perform Two-way ANOVA
- Interpret results from Two-Way ANOVA
- Make the Interaction Plot

5.4.4.3 Steps

Researchers are interested in the effects of sex and dietary group on systolic blood pressure (SBP). The "dietary group" factor includes three groups: strict vegetarians (SV) who eat no animal products of any kind; lacto vegetarians (LV) who eat dairy products but no other animal products; and "normal" (NOR) subjects who eat a standard American diet. Sex and dietary group may be independent or they may interact with each other. One approach to solve this problem is to construct a two-way ANOVA model predicting mean SBP level.

5.4.4.3.1 Indexed data mode

5.4.4.3.1.1 Perform Two Way ANOVA

1. Start with a new workbook and import the file `Samples\Statistics\SBP_Index.dat`.
2. Open the Two-Way ANOVA dialog by choosing the menu item Statistics: ANOVA: Two-Way ANOVA, then in the Input tab, set the Input Data mode as Indexed.
3. Also in the Input tab, select column A,B and C for Factor A, Factor B and Data, respectively. Check the Interactions box.
4. In the **Descriptive statistics** tab, check all boxes.

5. In the **Means Comparison** tab, set **Significance Level** to 0.05, and check the box beside **Tukey** to select this test as the means comparison method.

6. Click the **OK** button to perform Two-Way ANOVA.

5.4.4.3.1.2 **Interpreting Results**
From the “Overall ANOVA” table in the Two-Way ANOVA result sheet, we can see that **Dietary** and **Sex** are both significant factors, but the interaction between them is not significant. So we can say that the main effects of both **Dietary** groups and **Sex** are significant, yet the effect on the outcome of the change in **Dietary** doesn’t depend on the level of **Sex**.

5.4.4.3.1.3 The Interaction Plot

To further detect interaction, we can make an "Interaction Plot" using the following steps.

1. Click on the green lock in the **ANOVA2Way1** result sheet, and select **Change Parameters** to open the dialog again.

2. Go to **Mean Plot**, and check all boxes.
3. We will get the Interaction plot

![Interaction plot image]

5.4.4.3.1.4 Recalculate

1. Click on the green lock in the **ANOVA2Way1** result sheet, and select **Change Parameters** to open the dialog again.
2. In the **Input** tab in the open dialog, clear the **interactions** box and click the **OK** button.

We can see that the **Dietary** and **Sex** are significant factors from the "Overall ANOVA" table. The mean of **Nor** is significantly greater than that of **LV** and **SV** for factor **Dietary**. The mean of Male is significantly greater than that of Female, from the "Dietary" table.
5.4.4.3.2 Raw Data Mode

1. Start with a new workbook and import the file \Samples\Statistics\SBP_Raw.dat
2. Highlight all columns and select menu item Statistics : ANOVA : Two-Way ANOVA to bring up the ANOVATwoWay dialog box. In the Input tab, choose Raw as the Input Data mode.
3. Also in the Input tab, set Number of levels of Factor A as 2 and type Sex , Male and Female for Name, Level1 Name and Level2 Name in Factor A branch, respectively.
4. Also in the Input tab, set Number of levels of Factor B as 3, and type Dietary Group, SV, LV and Nor for Name, Level1 Name, Level2 Name and Level3 Name in Factor A branch, respectively.
5. In the **Means Comparison** tab, set **Significance Level** to 0.05, and check the box beside **Tukey** to use it as the means comparison method.

6. Click the **OK** button to perform Two-Way ANOVA.

### 5.4.5 Two Way Repeated Measures ANOVA

#### 5.4.5.1 Summary

For Two-Way Repeated Measures ANOVA, "Two-way" means that there are two factors in the experiment, for example, different treatments and different conditions. "Repeated-measures" means that the same subject received more than one treatment and/or more than one condition. Similar to two-way ANOVA, two-way repeated measures ANOVA can be employed to test for significant differences between the factor level means within a factor and for interactions between factors. Using a standard ANOVA in this case is not appropriate because it fails to model the correlation between the repeated measures, and the data violates the ANOVA assumption of independence. Two-Way Repeated Measures ANOVA designs can be two repeated measures factors, or one repeated measures factor and one non-repeated factor. If any repeated factor is present, then the repeated measures ANOVA should be used.

In the following example, the two factors are the repeated measures factors.

Minimum Origin Version Required: Origin 8.6 Pro SR0

#### 5.4.5.2 What you will learn

This tutorial will show you how to:

- Input raw data in the statistical analysis dialog.
Tutorials for Origin 2024b

- Perform Two-Way Repeated Measures ANOVA.
- Interpret results of a Two-Way Repeated Measures ANOVA

5.4.5.3 Steps

Origin can perform Two Way Repeated Measures ANOVA in both indexed and raw data modes. For Two-Way repeated measures ANOVA, if the indexed mode is used, data should be organized into four columns: Factor A, Factor B, Data, and Subject. When the Raw data mode is used, the different factors and levels should be in different columns.

In this example, we are interested in whether different drugs and doses have different effects on subject. We will perform the Two-Way Repeated Measures ANOVA to determine whether the drug type and dosage have significant effect on a subject. If there is significant difference, we will perform pairwise comparison to determine of which level the effects are different.

5.4.5.3.1 Raw data mode

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics\ANOVA subfolder and find the file Two-Way_RM_ANOVA_raw.dat. Drag-and-drop this file into the empty worksheet to import it.
3. In Input tab, select Raw from the Input Data drop-down list.
4. In this example, there are two factors. Set 3 and 2 for Number of Levels in Factor A and Factor B drop-down list to specify levels of the factor. Set Name to drug and dose respectively.

   Notes: Factor A and Factor B are set as repeated measures factor by default (The Repeat check box under Factor is checked ). If one factor is a non-repeated measures factor, just uncheck the Repeated check box.

5. Now under the Data branch, there are three subgroups. In the drug Level1 subgroup, select column d1d1 as the dose Level1 input data range.
6. Similarly, select d1d2, d2d1, d2d2, d3d1, and d3d2 for the next 5 input data range.
7. Check the **Interactions** check box to calculate interaction effects.
8. In the **Descriptive Statistics** tab, select all check boxes to compute the mean, standard error, and 95% confidence interval of all the levels of the factors as well as interactions.

![Descriptive Statistics tab](image)

9. In the **Means Comparison** tab, select the **Bonferroni** check box to enable the Bonferroni test.

![Means Comparison tab](image)

10. Click the **OK** button to perform the analysis.

### 5.4.5.3.2 Results Interpretation

Go to the worksheet **ANOVA_TwoWayRM1**, where the analysis results are listed.

You can refer to this help file for details of interpreting results of repeated measures ANOVA.

<table>
<thead>
<tr>
<th>Multivariate Tests</th>
<th>Value</th>
<th>F</th>
<th>Num df</th>
<th>DF</th>
<th>Prob&gt;F</th>
</tr>
</thead>
<tbody>
<tr>
<td>drug</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pillai's Trace</td>
<td>0.133</td>
<td>1.99423</td>
<td>2</td>
<td>26</td>
<td>0.1564</td>
</tr>
<tr>
<td>Wilks' Lambda</td>
<td>0.867</td>
<td>1.99423</td>
<td>2</td>
<td>26</td>
<td>0.1564</td>
</tr>
<tr>
<td>Hotelling's Trace</td>
<td>0.1534</td>
<td>1.99423</td>
<td>2</td>
<td>26</td>
<td>0.1564</td>
</tr>
<tr>
<td>Roy's Largest Root</td>
<td>0.1534</td>
<td>1.99423</td>
<td>2</td>
<td>26</td>
<td>0.1564</td>
</tr>
<tr>
<td>dose</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pillai's Trace</td>
<td>0.19986</td>
<td>6.74428</td>
<td>1</td>
<td>27</td>
<td>0.01504</td>
</tr>
<tr>
<td>Wilks' Lambda</td>
<td>0.80014</td>
<td>6.74428</td>
<td>1</td>
<td>27</td>
<td>0.01504</td>
</tr>
<tr>
<td>Hotelling's Trace</td>
<td>0.24979</td>
<td>6.74428</td>
<td>1</td>
<td>27</td>
<td>0.01504</td>
</tr>
<tr>
<td>Roy's Largest Root</td>
<td>0.24979</td>
<td>6.74428</td>
<td>1</td>
<td>27</td>
<td>0.01504</td>
</tr>
<tr>
<td>drug * dose</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pillai's Trace</td>
<td>0.27164</td>
<td>4.8482</td>
<td>2</td>
<td>26</td>
<td>0.01624</td>
</tr>
<tr>
<td>Wilks' Lambda</td>
<td>0.72836</td>
<td>4.8482</td>
<td>2</td>
<td>26</td>
<td>0.01624</td>
</tr>
<tr>
<td>Hotelling's Trace</td>
<td>0.37294</td>
<td>4.8482</td>
<td>2</td>
<td>26</td>
<td>0.01624</td>
</tr>
<tr>
<td>Roy's Largest Root</td>
<td>0.37294</td>
<td>4.8482</td>
<td>2</td>
<td>26</td>
<td>0.01624</td>
</tr>
</tbody>
</table>
Origin uses a multivariate analysis to detect repeated-measures effects. In this example, four different methods (Pillai's trace, Wilks' lambda, Hotelling's trace, and Roy's largest root) generate identical F statistics and probabilities. For drugs, $P_{value}=0.1564$, so we can conclude that the effect of drugs did not reach conventional levels of statistical significance. Similarly, we can also conclude that dose and drugs* dose are significant.

This table shows the results of Mauchly's Test of Sphericity and evaluation of epsilon. From the column Prob>ChiSq, we can learn that the significance level of drugs is greater than 0.05 ($P_{value}=0.11096$), and the value of drugs* dose is smaller than 0.05. For drugs* dose, the assumption of sphericity has been violated. Note that Greenhouse-Geisser Epilon=0.65362, which is smaller than 0.75, so we will proceed with the test by using Greenhouse-Geisser correction.

From this table we are able to find out the F value for the factor, its associated significance level and the effect size. For drug, the $P_{value}$ is 0.06461 in the prob>F column, so drugs have no significant effect on subjects, while dose have($P_{value}=0.01504$). For interaction drugs*dose, we can still proceed with the test by using the Greenhouse-Geisser correction and conclude that interaction drugs*dose have significant effect ($P_{value} = 0.02564$).
In general, Bonferroni tests are recommended to determine which specific means differed and determine whether or not the Sphericity assumption is violated. The Bonferroni correction relies on a general probability inequality and therefore isn't dependent on specific ANOVA assumptions. This table presents the results of the Bonferroni test, we can conclude that the means are not significant different (P>0.05 and Sig Flag=0). Of course, we do not need to perform pairwise comparison because drugs have no significant effect.

In this table, we can conclude that means of different dose are not significantly different (P_value = 0.06714 and Sig Flag = 0).

In this table, we can conclude that dose1 is significantly larger than dose2 within drug1, and drug1 is significantly larger than drug2 and drug3 within dose1.

5.4.6 Two-Way Mixed-Design ANOVA
5.4.6.1 Summary

The two-way mixed-design ANOVA is also known as two way split-plot design (SPANOVA). It is ANOVA with one repeated-measures factor and one between-groups factor.

Minimum Origin Version Required: OriginPro 2016 SR0

5.4.6.2 What you will learn

This tutorial will show you how to:

- Perform the two-way mixed design ANOVA.
- Interpret results of the two-way mixed design ANOVA

5.4.6.3 User Story

A researcher wants to know whether a treatment can help people lose weight. 48 participants (24 male) take part in the study. The researcher record their weights every three months during the treatment program.

5.4.6.4 Preparing Analysis Data

To preform two-way mixed-design ANOVA, the data can be arranged as below

![Data Table]

Notes: Data can also be arranged in index mode for two-way mixed-design ANOVA. Refer to the sample data, \Samples\Statistics\ANOVA\two-way rm ANOVA1_indexed.dat, for index mode of data of this tutorial.

5.4.6.5 Performing Two-Way Mixed-Design ANOVA

1. Open a new project or a new workbook. Import the data file \Samples\Statistics\ANOVA\two-way rm ANOVA1_raw.dat
3. In the opened dialog, choose the Input tab,
   - Set Input Data as Raw
Tutorials for Origin 2024b

- Expand **Factor A** branch, change the **Name** as **Weight** and set **Number of Levels** = 3. Expand **Factor B** branch, change the **Name** as **Gender** and unselect **Repeat** check box.
- In the **Data** branch, set column C, D and E to be **Weight Level1**, **Weight Level2** and **Weight Level3**, respectively, and set column B as **Gender**.
- Select **Interactions** check box.

4. Choose the **Descriptive Statistics** tab. select all check boxes.

<table>
<thead>
<tr>
<th>Input</th>
<th>Descriptive Statistics</th>
<th>Means Comparison</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>FactorA</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FactorB</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interaction</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Choose the **Means Comparison** tab, select **Bonferroni** check box.
5.4.6.6 Interpreting the Results

Go to the worksheet ANOVATwoWayRM1, where the analysis results are listed.

You can refer to this interpreting results help page for details of interpreting results of repeated measures ANOVA.

1. From the Mauchly’s Test of Sphericity table, we can see Prob>ChiSq(0.01258) < 0.05. So the repeated measure variable, Weight, violates the Sphericity assumption. We should consider the Greenhouse-Geisser correction ect. While the Epsilon is larger than 0.75, we will look at the Huynh and Feldt correction in step 2 below.

<table>
<thead>
<tr>
<th>Mauchly’s Test of Sphericity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mauchly’s W</td>
</tr>
<tr>
<td>Weight</td>
</tr>
</tbody>
</table>

2. From the Tests of Within-Subject Effects table, we can see
   - For Weight, the p_value is about 0 in the Prob>F column. It indicates that the weight is a significant effect, that is, the weights change over time.
   - While the interaction, Weight*Gender, is not significant different(p_value = 0.14025), we can conclude that there is not a significant interaction effect, Weight*Gender

6. Click OK button to perform the analysis
3. We can further study how the weights change over time during the treatment. Expand the **Weight** branch. From the tables we can see
   - From the **Descriptive Statistics** table we can see that the weights are decreasing
   - In the **Pairwise Comparison** table, the 1 in the **Sig Flag** column indicates the pair of group is significant different. We can draw conclusion that the weights are significantly decreasing

4. From the **Tests for Between-Subjects Effects** table, we can see **Gender** is a significant effect, that is, Female and Male can be significant different.

5. Look at the **Gender** branch to see the details.
   - There are only two levels for Gender and we already know they are significant different, so we don't need to look at the **Pairwise Comparison** table
   - From the **Descriptive Statistics** table we can see that average weight of men is more than women.
Notes: As there is no serious violation of sphericity assumption, we can ignore the Multivariate Tests table. See more details from the interpreting results help page.

5.4.7 Three-Way ANOVA

5.4.7.1 Summary

Three-way ANOVA tests for main effects, and interaction effects between all combinations of three factors, on a dependent variable.

Minimum Origin Version Required: OriginPro 2016 SR0

5.4.7.2 What you will learn

1. How to carry out three-way ANOVA for practical data with Origin
2. How to interpret the generated results

5.4.7.3 User Story

We have some public data from the World Bank. It includes three factors: Region (Asia/Europe/Africa, etc.), Developing Index (Developing/Developed Country) and Year (2000/2005/2010). We want to understand how these three factors affect the number of internet users and whether there are any significant differences between the groups.

5.4.7.4 Performing Three-Way ANOVA

1. Choose menu Help: Learning Center to open Learning Center dialog. Select Analysis Sample in the left side and then choose Statistics - ANOVA from the Samples in drop-down list in the right side.
2. Double-click on third item in the list box to open the folder Three-Way ANOVA(Pro).
3. Click on worksheet Sheet1 containing the source data.
5. In the **Input** tab of the opened dialog, set **Input Data** as **Indexed**. Then expand the **Input Data** branch, select column C, D, B, and E for **Factor A**, **Factor B**, **Factor C**, and **Data**, respectively.

<table>
<thead>
<tr>
<th>Input</th>
<th>Model</th>
<th>Descriptive Statistics</th>
<th>Means Comparison</th>
<th>Power Analysis</th>
<th>Mean Plot</th>
<th>Output</th>
</tr>
</thead>
</table>

**Indexed: factor variable and response data are stored in separate columns.**

- **Factor A**: [Book2]Sheet1IC"Developing Index"
- **Factor B**: [Book2]Sheet1ID"Year"
- **Factor C**: [Book2]Sheet1IB"Region"
- **Data**: [Book2]Sheet1IE"internet user (% of Total)"

**Homogeneity Tests[Levene's Test]**

| Significance Level | 0.05 |

6. In the **Model** tab, make sure all boxes are selected. This determines that a full factorial model will be used for the three-way ANOVA.

| Data = A + B + C + A*B + A*C + B*C + A*B*C |
| Effect A*B | ✓ |
| Effect A*C | ✓ |
| Effect B*C | ✓ |
| Effect A*B*C | ✓ |

7. Click **OK** to apply all settings and close the dialog.

8. Go to sheet **ANOVA3Way1**. The **Overall ANOVA** table includes ANOVA test results for the main effects and the interactions. If the **P Value** is less than 0.05, this means the levels in the corresponding factor are significantly different. Note the conclusions in the footnotes beneath the table.
From the Overall ANOVA table above we can see the two-way interaction of factors Developing Index*Year is not significant (p-value = 0.23954). The three-way interaction of factors Region*Developing Index*Year, is not significant. (p-value = 0.88834).

5.4.7.5 Examining Significant Interactions

In the following, we are going to further examine factors showing a significant interaction.

1. Click the green lock in the sheet ANOVA3Way1 and choose Change Parameters from the context menu

2. In the Model tab, clear the Effect A*B and Effect A*B*C check boxes, where interactions between factors could not detected.
3. In the **Means Comparison** tab, select the **Bonferroni** check box. Bonferroni is the most commonly used post-hoc test. It controls the overall Type I error.

4. In the **Mean Plot** tab, select all available check boxes. (**Effect A*B** and **Effect A*B*C** are disabled because they are not included in the model.)

5. Click **OK** to apply all setting and close the dialog.

5.4.7.6 **Interpreting Results**

The results in the sheet **ANOVA3Way1** are updated using the new calculation parameters.

5.4.7.6.1 **Overall ANOVA**
Statistics

From the table we can see all remaining effects are significantly different. We can use the Means Comparisons results and Means Plots to further detect differences between each group.

5.4.7.6.2 Means Comparison and Means Plot of the Three Main Effects

Expanding the branch ANOVA: Means Comparison: Bonferroni Test, you can see the means comparison table for each effect. It is useful, along with the Means Plot at the bottom of the result sheet, for pairwise comparisons between members of a group.

5.4.7.6.2.1 Comparison between Developing and Developed Country

<table>
<thead>
<tr>
<th>Developing Index Developed Country</th>
<th>MeanDiff</th>
<th>SEM</th>
<th>t Value</th>
<th>Pr(&gt;</th>
<th>Alpha</th>
<th>Sig</th>
<th>LCL</th>
<th>UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Developing Country</td>
<td>-31.24647</td>
<td>2.60998</td>
<td>-12.01337</td>
<td>&lt;0.0001</td>
<td>0.05</td>
<td>1</td>
<td>-36.356</td>
<td>-25.13694</td>
</tr>
</tbody>
</table>

1 in this column means the pair of group is significantly different. We can further look at the Mean Plot for details of the comparison.

From the result above we can see the number of internet users of developing countries is much fewer than the developed countries.

5.4.7.6.2.2 Comparison between Years

At the 0.05 level, the population means of Developing Index are significantly different.
At the 0.05 level, the population means of Year are significantly different.
At the 0.05 level, the population means of Region are significantly different.
At the 0.05 level, the population means of Developing Index * Region are significantly different.
At the 0.05 level, the population means of Year * Region are significantly different.
From the result above we can see the number of internet users greatly increased between 2000 and 2010.

5.4.7.6.2.3 Comparison between Regions
The results above tell us:

- Internet users in Africa are significantly fewer than other continents.
- Internet users in the Middle East are significantly fewer than Europe and the Americas.
- There is no significant difference between other pairs of continents.

### 5.4.7.6.3 Comparing Same Level Between Different Groups

We can compare the sample level between different groups with **Mean Comparison** results of the interactions. In the following we will show how to use a data filter to quickly view the results we are interested in.

1. In the sheet **ANOVA3Way1**, expand the branch **ANOVA: Means Comparison: Bonferroni Test**.
2. Click the triangle button next to **Interactions** and choose **Create Copy as New Sheet** from the context menu.

3. Go to the generated sheet **Interactions**. Now we are going to compare developing and developed countries in different regions by applying a data filter in the results.

   1. Highlight column C, click the **Add/Remove Data Filter** button to add a data filter to the column.
   2. Click the **Filter** icon on the column header, choose **Custom Filter**.
   3. Select the **Advanced** check box in the bottom-right corner of the open dialog. Add following script in the **Condition** box:

```
col(c)$==col(f)$
```

4. From the results below we can see:
   - The internet users in the developed and developing countries are not significantly different in Africa and Middle East.
- The internet users in the developed countries are significantly higher than the developing countries on the following four continents.

1. Asia  
2. Europe  
3. The Americas  
4. Oceania  

<table>
<thead>
<tr>
<th>Region</th>
<th>Developing Country</th>
<th>Year</th>
<th>Developing Index</th>
<th>Year</th>
<th>Developing Country</th>
<th>Year</th>
<th>Developing Index</th>
<th>MeanDiff</th>
<th>SE</th>
<th>t Value</th>
<th>Pr(&gt;</th>
<th>t)</th>
<th>Alpha</th>
<th>Sig</th>
<th>LL</th>
<th>UL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asia</td>
<td>Developing Country</td>
<td>2022</td>
<td>25.3456</td>
<td>Europe</td>
<td>Developing Country</td>
<td>2022</td>
<td>12.3456</td>
<td>-12.9567</td>
<td>3.45</td>
<td>-3.54</td>
<td>0.006</td>
<td>0.05</td>
<td>0.05</td>
<td>-10.34</td>
<td>10.34</td>
<td></td>
</tr>
<tr>
<td>Europe</td>
<td>Developing Country</td>
<td>2022</td>
<td>20.3456</td>
<td>Europe</td>
<td>Developing Country</td>
<td>2022</td>
<td>10.3456</td>
<td>-10.34</td>
<td>3.45</td>
<td>-3.54</td>
<td>0.006</td>
<td>0.05</td>
<td>0.05</td>
<td>-7.34</td>
<td>7.34</td>
<td></td>
</tr>
<tr>
<td>The Americas</td>
<td>Developing Country</td>
<td>2022</td>
<td>15.3456</td>
<td>Europe</td>
<td>Developing Country</td>
<td>2022</td>
<td>5.3456</td>
<td>-10.34</td>
<td>3.45</td>
<td>-3.54</td>
<td>0.006</td>
<td>0.05</td>
<td>0.05</td>
<td>-7.34</td>
<td>7.34</td>
<td></td>
</tr>
<tr>
<td>Oceania</td>
<td>Developing Country</td>
<td>2022</td>
<td>10.3456</td>
<td>Europe</td>
<td>Developing Country</td>
<td>2022</td>
<td>0.3456</td>
<td>-10.34</td>
<td>3.45</td>
<td>-3.54</td>
<td>0.006</td>
<td>0.05</td>
<td>0.05</td>
<td>-7.34</td>
<td>7.34</td>
<td></td>
</tr>
</tbody>
</table>

1 in the Sig column means the pair of lands are significantly different, while 0 means no significant difference.

### 5.5 Nonparametric Tests

#### 5.5.1 Nonparametric Tests

- Non-parametric Statistics Overview

#### 5.5.2 Non-parametric Statistics Overview

Videos

- Non-Parametric Statistic for Two

OriginBlog
5.5.2.1 Summary

Nonparametric tests are used when you don’t know whether your data are normally distributed, or when you have confirmed that your data are not normally distributed.

5.5.2.2 What you will learn

This tutorial will show you:

- An introduction on non-parametric tests in Origin
- How to run the non-parametric tests for different practical situations
- How to calculate correlation coefficient in non-parametric statistics

5.5.2.3 Introduction: Nonparametric Tests in Origin

Nonparametric tests do not require the assumption of normality. They are commonly used in the following situations:

- Small sample size.
- Categorical/Binary/Ordinal data.
- Normal distribution cannot be assumed.

<table>
<thead>
<tr>
<th>Samples</th>
<th>Nonparametric Statistics for Multiple Sample</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Nonparametric</th>
<th>Parametric</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Data from any distribution</td>
<td>Data from normal distribution</td>
</tr>
<tr>
<td></td>
<td>Small Samples</td>
<td>Large Samples</td>
</tr>
</tbody>
</table>

- One Sample
  - Wilcoxon Signed Rank Test
  - One Sample T-Test

- Two Samples
  - Mann-Whitney test
  - Kolmogorov-Smirnov test
  - Two Sample T-Test

- Paired Samples
  - Wilcoxon signed rank Test
  - Paired Sample T-Test
5.5.2.4 Examples

5.5.2.4.1 One Sample Independent Tests

The One-Sample Wilcoxon Signed Rank test is designed to examine the population median relative to a specified value. You may choose a one- or two-tailed test. The Wilcoxon signed rank test hypotheses are H0: median = hypothesized median versus H1: median ≠ hypothesized median.

In this example, a quality engineer in a production shop is interested in whether median (or average) of the weight of product is equal to 166. So select 10 product at random and measured their weight. The data measured as following:

151.5 152.4 153.2 156.3 179.1 180.2 160.5 180.8 149.2 188.0

The engineer perform Normality Test to determine if the distribution of the data is normal distribution

1. Open a new worksheet and input the above data in col(A). Select Statistics: Descriptive Statistics: Normality Test... to open the Normality Test dialog.

2. Select A(X) as Data range.
3. Click the OK button to generate results.

<table>
<thead>
<tr>
<th></th>
<th>DF</th>
<th>Statistic</th>
<th>p-value</th>
<th>Decision at level(5%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shapiro-Wilk</td>
<td>10</td>
<td>0.83472</td>
<td>0.03814</td>
<td>Reject normality</td>
</tr>
</tbody>
</table>

According to result, p-value = 0.03814, the distribution of the data is not normal distribution at the 0.05 level. So, perform One-Sample Wilcoxon Signed Rank test:

1. Select Statistics: Nonparametric Tests: One-sample Wilcoxon Signed Rank Test... to open the dialog.
2. Set column A as Data Range.
3. Input 166 in Test Median text box.
4. Click the OK button to generate results.
According to the result, it fails to reject null hypothesis at the 0.05 level and concludes that the median is equal to 166.

### 5.5.2.4.2 Two Sample Independent Tests

Origin provides two tests for non-parametric statistics of two sample independent system: the **Mann-Whitney Test** and **Two Sample Kolmogorov-Smirnov Test**.

This following example shows the practical use of **Mann-Whitney Test**. The abrasions (in mg) are measured for two types of tires (A and B), 8 experiments were carried out for each tire type. The data is indexed and stored in abrasion_indexed.dat file.

1. Import the abrasion_indexed.dat file from \Samples\Statistics\.
2. Select **Statistics: Nonparametric Tests: Mann-Whitney Test** to open the dialog.
3. Keep **Input Data Form** as **Index**
4. Set column A as **Group Range**, set column B as **Data Range**.
5. Select the **Exact P Value** check box.
6. Click the OK button to generate results, which should be in the MannWhitney1 sheet.

- **U**: The U statistic can be simply calculated from the rank of two groups. It is the number of times a score in the 2nd group is larger than a score in the 1st group.
- **Z**: The approximate Normal test statistic. It provides an excellent approximation as the sample size grows.
- **Exact Prob**: The exact p-value, only available when Exact P Value is selected in the dialog. However, it could be very CPU-time consuming for large sample size.
- **Asymp.Prob**: The asymptotic p-value calculated from the approximate Normal test statistic, Z

**5.5.2.4.3 Non-parametric Measures of Correlation**
Correlation coefficient is used as a measure of relationship between two variables. It is possible to calculate the correlation coefficient for non-parametric statistics.

Origin provides two non-parametric methods to measure the correlations between variables:

- **Spearman**: common substitution of Pearson correlation coefficient, Spearman's coefficient can be used when both dependent (variable and independent variable are ordinal numeric, or when one variable is an ordinal numeric and the other is a continuous variable. However, it can also be appropriate to use Spearman's correlation when both variables are continuous.

- **Kendall**: Used with ordinal variables for assessing agreement among raters

The following example shows how to calculate correlation coefficient for non-parametric situations.

1. Import the abrasion_raw.dat file from Samples\Statistics;
2. Highlight Column A and column B. Select **Statistics: Descriptive Statistics: Correlation Coefficient** to open the corrcoef dialog;
3. Check **Spearman** and uncheck **Pearson**;
4. Click the **OK** button to generate the results, in the **CorrCoef1** sheet.
From the value of **Spearman Corr.**, it can be concluded that the abrasion between tire A and tire B are strongly related.

<table>
<thead>
<tr>
<th></th>
<th>tireA</th>
<th>tireB</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;tireA&quot;</td>
<td>Spearman Corr.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Sig.</td>
<td>--</td>
</tr>
<tr>
<td>&quot;tireB&quot;</td>
<td>Spearman Corr.</td>
<td>0.90476</td>
</tr>
<tr>
<td></td>
<td>Sig.</td>
<td>0.00201</td>
</tr>
</tbody>
</table>

2-tailed test of significance is used

### 5.5.2.4.4 Paired Sample wilcoxon Signed Rank Tests

We will compare the two medians of tire A and tire B in above example.

1. Continue with the abrasion.raw.dat file from Samples\Statistics;
2. Select **Statistics: Nonparametric Tests: Paired Sample wilcoxon Signed Rank Tests** to open the dialog;
3. Select Column A as **1st Range Data** and column B as **2nd range Data**;
4. Click the **OK** button to generate the results.
We can conclude that two medians are significantly different. Obviously, median of group A is larger than that of group B.

### 5.5.2.4.5 Multiple Independent Samples Test

In this example, the gas mileage of four car makers are measured. Several experiments are carried out for each car makers. The results are listed in the sample data table.

<table>
<thead>
<tr>
<th>GMC/mpg</th>
<th>Infinity/mpg</th>
<th>Saab/mpg</th>
<th>Kia/mpg</th>
</tr>
</thead>
<tbody>
<tr>
<td>26.1</td>
<td>32.2</td>
<td>24.5</td>
<td>28.4</td>
</tr>
<tr>
<td>28.4</td>
<td>34.3</td>
<td>23.5</td>
<td>34.2</td>
</tr>
<tr>
<td>24.3</td>
<td>29.5</td>
<td>26.4</td>
<td>29.5</td>
</tr>
<tr>
<td>26.2</td>
<td>35.6</td>
<td>27.1</td>
<td>32.2</td>
</tr>
<tr>
<td>27.8</td>
<td>32.5</td>
<td>29.9</td>
<td></td>
</tr>
<tr>
<td>30.6</td>
<td>30.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28.1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To evaluate whether the gas mileage of the four car makers are equal, and which one is the most efficient, Kruskal-Wallis ANOVA is chosen as the nonparametric test method.

1. Create a new workbook in Origin, copy the sample data and paste into it;
2. Select **Statistics: Nonparametric Tests: Kruskal-Wallis ANOVA** to open the kwanova dialog;
3. Specify Raw as **Input Data Form**;
4. Click the **triangle button** next to **Input**, and select **All Columns** in the context menu;

![Kruskal-Wallis ANOVA dialog box](image)

5. Click the **OK** button to generate results, the results are stored in a new worksheet **KWANOVA1**.

From the p-value we can conclude that gas mileage of the four car makers are significant different.

![Test Statistics](image)

5.5.2.4.6 Multiple Related Samples Test

Ophthalmologists are investigating whether laser He-Ne therapy works for children. They have data from 2 groups, 6-10 Years Old and 11-16 Years Old. Each data set contains study of 5 persons' naked-eye eyesight difference after 3 period of therapy. The results are stored in the eyesight.dat.

Due to the small sample size, non-parametric statistics would be needed in analysis, following the steps below:

1. Import the eyesight.dat file from \Samples\Statistics\;
2. Select **Statistics: Nonparametric Tests: Friedman ANOVA** to open the friedman dialog;
3. Select Column A as **Data Range**, Column C as **Factor Range**, and Column D as **Subject Range**;
4. Click the OK button to generate results.

The p-value of $X^2$ is 0.0067379, which is less than 0.05. The populations are significantly different, indicating that the therapy are effective for the age group 6-10.

In a similar way, choose column B as **Data Range** and the rest setting of **Input** are the same with Step 3 previously.
Check the result, we can see that p-value of $\chi^2_{11-16}$ is 0.02599, less than 0.05 or 0.10. So we can also conclude that eyesight of 11-16 years old kids is better after 3 period of therapy.

And we can see that $\chi^2_{6-10} > \chi^2_{11-16}$, that means, laser He-Ne therapy works better on 6-10 years old kids. The earlier children are to be involved in therapy, the more their eyesight can be improved.

5.6 Survival Analysis

5.6.1 Survival Analysis

- Kaplan-Meier Estimator
- COX Model Estimator
- Weibull Fit
5.6.2 Kaplan-Meier Estimator

5.6.2.1 Summary

Survival analysis is the study of the time until a certain event, such as a death or failure in treatment. It also is called event history analysis in social science, or reliability analysis in engineering.

The Survival function, \( S(t) \), can describe the survival rate at time \( t \). Further, \( S(t)=1-F(t) \), where \( F(t) \) is the cumulative distribution function of the failure times. While the hazard function \( h(t) \) (also known as the failure rate, hazard rate, or force of mortality) is the ratio of the probability density function \( P(t) \) of \( F(t) \) to the survival function \( S(t) \).

The Kaplan-Meier Estimator, also called product-limit estimator, provides an estimate of \( S(t) \) and \( h(t) \) from a sample of failure times which may be progressively right-censored.

5.6.2.2 What you will learn

This tutorial will show you how to:

- Perform Kaplan-Meier Estimator
- How to interpret the results

5.6.2.3 Steps

5.6.2.3.1 Running Kaplan-Meier Estimator

Scientist is looking for a better medicine for cancer resistance. After exposing some rats to a carcinogen DMBA, they apply different medicine to different groups of rats and record their survival status for first 60 hours. In the 1st group, 15 rats survived after being exposed, on which Medicine 1 is applied. Note that on the 30th hours, 1 rat is dead but not for carcinoma. In the 2nd group, 15 rats survived with drug 2 applied. Note that on the 14th hour, the 15th hour and the 25th hour, 1 rat die but not because of carcinoma. And the records of two groups rats are sorted in the file /Samples/Statistics/SurvivedRats.dat. Note that in Status, 0 = dead but not because of carcinoma, 1 = dead because of carcinoma, 2 = alive.

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file SurvivedRats.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Analyze the dataset using the Kaplan-Meier Estimate tool. Use the menu item Statistics: Survival Analysis: Kaplan-Meier Estimator to open the dialog.
3. Set column A, B and C as Time Range, Censor Range and Grouping Range respectively in the Input tab.
4. Set 0 and 2 as Censored Value(s)
5. In the **Survival Table** tab, select the **Event and censor values Summary**, **Survival Estimates**, **Quartile Estimates** and **Mean Estimates** check boxes.

6. Select **Survival**, **One Minus survival** and **Hazard** check box in the **Survival Plots** tab.
7. Select the Log-Rank, Breslow and Tarone-Ware check box in the Equality Test tab.

8. Click the OK button.

5.6.2.3.2 Interpreting the Results

Go to worksheet KaplanMeier1 for the analysis report:

1. From the "summary of event and censored values" table, we can see that Censored=3 and Percent Censored =0.2 for drug 1 group and Censored=9 and Percent Censored=0.6 for drug 2 group.

2. "Kaplan-Meier Survival Estimates " tables display a descriptive procedure for examining the distribution of time-to-event variables. We also can compare the distribution by levels of a factor
variable. **Quartile Estimates** and **Means Estimates** table Provides the estimates and confidence interval of quartile and mean.
### Survival Analysis of Time (drug1)

<table>
<thead>
<tr>
<th>Time</th>
<th>Status</th>
<th>Cumulative Survival</th>
<th>Standard Error</th>
<th>Cumulative Event</th>
<th>Number Remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td></td>
<td>0.93333</td>
<td>0.06441</td>
<td>1</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>0.8</td>
<td>0.10328</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>0.60607</td>
<td>0.12172</td>
<td>5</td>
<td>12</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>0.5</td>
<td>0.12649</td>
<td>6</td>
<td>10</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>0.53333</td>
<td>0.12881</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>0.46667</td>
<td>0.12881</td>
<td>8</td>
<td>7</td>
</tr>
<tr>
<td>30</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>32</td>
<td></td>
<td>0.38889</td>
<td>0.1287</td>
<td>9</td>
<td>5</td>
</tr>
<tr>
<td>38</td>
<td></td>
<td>0.31111</td>
<td>0.12426</td>
<td>10</td>
<td>4</td>
</tr>
<tr>
<td>42</td>
<td></td>
<td>0.23333</td>
<td>0.11499</td>
<td>11</td>
<td>3</td>
</tr>
<tr>
<td>58</td>
<td></td>
<td>0.15656</td>
<td>0.09555</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

Observations with status as + are censored ones.

#### Quartile Estimates

<table>
<thead>
<tr>
<th>Percent Failures</th>
<th>Estimate</th>
<th>95% LCL</th>
<th>95% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>17</td>
<td>15</td>
<td>23</td>
</tr>
<tr>
<td>50</td>
<td>23</td>
<td>17</td>
<td>42</td>
</tr>
<tr>
<td>75</td>
<td>42</td>
<td>23</td>
<td>58</td>
</tr>
</tbody>
</table>

#### Mean Estimate

<table>
<thead>
<tr>
<th>Estimate</th>
<th>Std.Error</th>
<th>95% LCL</th>
<th>95% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>32.02222</td>
<td>4.53441</td>
<td>23.13404</td>
<td>40.9095</td>
</tr>
</tbody>
</table>

Estimation is underestimated because the largest observation is censored.

### Survival Analysis of Time (drug2)

<table>
<thead>
<tr>
<th>Time</th>
<th>Status</th>
<th>Cumulative Survival</th>
<th>Standard Error</th>
<th>Cumulative Event</th>
<th>Number Remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>0.92308</td>
<td>0.07391</td>
<td>1</td>
<td>12</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>0.84615</td>
<td>0.10007</td>
<td>2</td>
<td>11</td>
</tr>
<tr>
<td>25</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>30</td>
<td></td>
<td>0.67692</td>
<td>0.13366</td>
<td>4</td>
<td>8</td>
</tr>
<tr>
<td>36</td>
<td></td>
<td>0.59231</td>
<td>0.14122</td>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>60</td>
<td></td>
<td>0.50769</td>
<td>0.14418</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>60</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

Observations with status as + are censored ones.

#### Quartile Estimates

<table>
<thead>
<tr>
<th>Percent Failures</th>
<th>Estimate</th>
<th>95% LCL</th>
<th>95% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>28</td>
<td>23</td>
<td>60</td>
</tr>
<tr>
<td>50</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>75</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

#### Mean Estimate

<table>
<thead>
<tr>
<th>Estimate</th>
<th>Std.Error</th>
<th>95% LCL</th>
<th>95% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>46.4</td>
<td>5.20463</td>
<td>30.08152</td>
<td>58.71846</td>
</tr>
</tbody>
</table>
3. The survival curves give a visual representation of the life tables. A plot of the Kaplan-Meier estimate of the survival function is a series of horizontal steps of declining magnitude. In the plot, the survival curve declines more rapidly, the survival rate is smaller. This Survival function plot shows proportion of individuals surviving at each hour for drug 1 group and drug2 group and the survival curve of drug1 always declines more rapidly, so we can conclude that drug 2 is one better medicine for cancer resistance.

4. Form one minus survival function, we can get the same conclusion as Survival function plot.
5. Hazard rate is the instantaneous probability of the given event occurring at any point in time. It can be plotted against time on the X axis, forming a graph of the hazard rate over time. And hazard function is the equation that describe this plotted line. From the graph, we can get the hazard rate of drug1 group is greater than drug 2 group. So we can conclude that drug 2 is one better medicine for cancer resistance.
6. For overall tests of the equality of survival times across groups, Origin provides three methods:

- Log rank: Tests equality of survival functions by weighting all time points the same.
- Breslow: Tests equality of survival functions by weighting all time points by the number of cases at risk at each time point.
- Tarone-Ware: Tests equality of survival functions by weighting all time points by the square root of the number of cases at risk at each time point.

Since the significance values of the tests are all smaller than 0.05, there is statistically significant difference between two treatments (drug1 and drug2) in survival time.

**5.6.3 COX Model Estimator**

**5.6.3.1 Summary**
Tutorials for Origin 2024b

The Cox Model Estimation, also called the proportional hazard model, is a classical semi-parameter method in survival analysis. A Cox model provides an estimate of the effect on survival for variables and the hazard of death for an individual. Using Cox regression analysis, we will obtain an equation for the hazard as a function of several variables. A positive regression coefficient for an explanatory variable means that the hazard is higher with higher values of that variable. While for a negative regression coefficient for an explanatory variable, the hazard is lower with higher values of that variable.

The proportional hazards assumption: Observations should be independent, and the hazard ratio should be constant across time; that is, the proportionality of hazards from one case to another should not vary over time.

5.6.3.2 What you will learn

This tutorial will show you how to:

- Perform COX Model Estimator
- How to interpreting the results

5.6.3.3 Perform COX Model Estimator

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file phm_Cox.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Select Statistics: Survival Analysis: Cox Model Estimator to open the dialog.
3. Put the A(X):month column into Time Range. Similarly, put the B(Y):status column into Censor Range.
4. Click the interactive data selection button and choose the Charlson and tKt_y column into the Covariate Range edit box.
5. Select 0 as the censoring value form censoring value(s) drop-down list.
6. Check Survival and Hazard box in Survival Plots group.
7. Click the OK button to perform the Cox Model Estimator analysis.
Interpreting the Results

5.6.3.4  Interpreting the Results

Go to worksheet **CoxPHM1** for the analysis report.

1. From the "Summary of event and censored values" table, we can see that **censored** =112 and **percent Censored** =0.8.

| Summary of Event and Censored Values |
|-----------------------------|-----------------|
| Total | Events | Censored | Percent Censored |
| 140   | 28    | 112      | 0.8             |

2. The following table displays the result of test whether the model is significant or not. Note that the null hypothesis is $\beta_1 = \beta_2 = 0$. In this example, **Pr > ChiSq** $=4E(-4) <0.05$, therefore we reject the null hypothesis; that is, either $\beta_1$ or $\beta_2$, or both, $\neq 0$. 
3. In the "Analysis of parameter Estimates" table, the coefficient estimate of variable charlson is 0.2876 and Pr > ChiSq = 5E-4 < 0.05, so \( \beta_1 = 0.287 \) and charlson is a significant variable. The Hazard ratio can be interpreted as the predicted change in the hazard for a unit increase in the predictor. For variable charlson, hazard ratio = 1.333, meaning that the hazard becomes 1.333 times when charlson increments one unit. Similarly, tKt_v is a significant variable. The coefficient estimates of tKt_v \( \beta_2 = -0.837 \) and hazard ratio = 0.433. We know the hazard function: 

\[ h(t,x) = h_0(t) \exp(0.2876 \times \text{charlson} - 0.837 \times \text{tKt_v}) \]

4. The Survival function plot shows the proportion of individuals surviving at each hour and is a visual display of the model-predicted. The horizontal axis shows the time to event. The vertical axis shows the probability of survival.

5. The Hazard function plot displays the instantaneous probability of the given event occurring at any point in time.
5.6.4 Weibull Fit

5.6.4.1 Summary

Weibull fit is a kind of parameter method to analyze the relationship between the survival function and failure time. After analysis, we can get parameter estimates, which can determine survival function and hazard function of Weibull distribution.

Weibull distribution:

$$f(x) = \frac{c}{\sigma} \left( \frac{x - \theta}{\sigma} \right)^{c-1} \exp\left( - \left( \frac{x - \theta}{\sigma} \right)^c \right) \text{ where } x > \theta, \text{ for } c, \sigma > 0$$

Survival function:

$$S(x) = \exp\left( - \left( \frac{x - \theta}{\sigma} \right)^c \right)$$

Hazard function:

$$h(x) = \frac{c}{\sigma} \left( \frac{x - \theta}{\sigma} \right)^{c-1}$$

where $c$ is the shape parameter, $\sigma$ is the scale parameter, and $\theta$ is the location parameter. In Origin, Weibull fit only discusses $c$ and $\sigma$, and assumes $\theta = 0$.

If $c > 1$ the hazard increases, if $c = 1$ the hazard is constant (exponential model), if $c < 1$ the hazard decreases.

Minimum Origin Version Required: OriginPro 9.1 SR0

5.6.4.2 What you will learn

This tutorial will show you how to:
• Perform Weibull Fit
• How to explain analysis report

5.6.4.3 Perform Weibull Fit

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file weibull fit.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Select Statistics: Survival Analysis: weibull fit to open the dialog.
3. Put the A(X) column into Time Range. Similarly, put the B(Y) column into Censor Range.
4. Select 0 as the censoring value form censoring value(s) drop-down list.
5. Expand Plots branch and check Survival Plot and Hazard Plot.

6. Click the OK button to perform the Weibull fit analysis.
5.6.4.4 Interpreting the Result

Go to worksheet **WeibullFit1** for the analysis report.

- From the "Summary of Event and Censored Values" table, we can see that **censored** = 19 and **percent Censored** = 0.2111.

- From the "Analysis of parameter estimates", we can get all parameter estimates for Weibull distribution. Intercept = $\hat{\theta} = 4.1959$, ($\theta$ is the intercept of the small extreme distribution, $\hat{\theta} = \ln($Weibull Scale$)$)
  - Weibull Scale = $\hat{\sigma} = 66.4153$,
  - Weibull Shape = $c = 2.0204$,
  - Scale = 0.495 (scale = 1/c).
c > 1, so we can conclude that the hazard increases as time.

- Furthermore, we can get the survival function and hazard function:

\[ S(x) = e^{-\left(\frac{x}{66.4153}\right)^{2.0204}} \]

\[ h(x) = \frac{2.0204 \left(\frac{x}{66.4153}\right)^{1.0204}}{66.4153} \]
5.7 Multivariate Analysis

5.7.1 Multivariate Analysis

- Principal Component Analysis
- Cluster Analysis
- Discriminant Analysis
- Partial Least Squares

5.7.2 Principal Component Analysis

5.7.2.1 Summary

Principal Component Analysis is useful for reducing and interpreting large multivariate data sets with underlying linear structures, and for discovering previously unsuspected relationships.

We will start with data measuring protein consumption in twenty-five European countries for nine food groups. Using Principal Component Analysis, we will examine the relationship between protein sources and these European countries.

5.7.2.2 Selecting Principal Methods

To determine the number of principal components to be retained, we should first run Principal Component Analysis and then proceed based on its result:

1. Open a new project or a new workbook. Import the data file \samples\Statistics\Protein Consumption in Europe.dat
2. Select the entire worksheet and then select Statistics: Multivariate Analysis: Principal Component Analysis.
3. Accept the default settings in the open dialog box and click OK.
5. In the **Eigenvalues of the Correlation Matrix** table, we can see that the first four principal components explain 86% of the variance and the remaining components each contribute 5% or less. We will keep four main components.

```
<table>
<thead>
<tr>
<th>Eigenvalue</th>
<th>Percentage of Variance</th>
<th>Cumulative</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4.00644</td>
<td>44.52%</td>
</tr>
<tr>
<td>2</td>
<td>1.635</td>
<td>62.68%</td>
</tr>
<tr>
<td>3</td>
<td>1.12792</td>
<td>75.22%</td>
</tr>
<tr>
<td>4</td>
<td>0.95466</td>
<td>85.82%</td>
</tr>
<tr>
<td>5</td>
<td>0.46384</td>
<td>90.98%</td>
</tr>
<tr>
<td>6</td>
<td>0.32513</td>
<td>94.59%</td>
</tr>
<tr>
<td>7</td>
<td>0.27161</td>
<td>97.61%</td>
</tr>
<tr>
<td>8</td>
<td>0.11629</td>
<td>98.90%</td>
</tr>
<tr>
<td>9</td>
<td>0.09911</td>
<td>100.00%</td>
</tr>
</tbody>
</table>
```

6. A scree plot can be a useful visual aid for determining the appropriate number of principal components. The number of components depends on the "elbow" point at which the remaining eigenvalues are relatively small and all about the same size. This point is not very evident in the scree plot, but we can still say the fourth point is our "elbow" point.
7. Click the lock icon in the results tree and select Change Parameters in the context menu. In the Settings tab, set Number of Components to Extract to 4. Do not close the dialog; in the next steps, we will retrieve component diagrams.
5.7.2.3 Request Principal Component Plots

In the Plots tab of the dialog, users can choose whether they want to create a scree plot or a component diagram.

- **Scree Plot**
  The *scree plot* is a useful visual aid for determining an appropriate number of principal components.

- **Component Plot**
  Component plots show the component score of each observation or component loading of each variable for a pair of principal components. In the Select Principal Components to Plot group, users can specify which pair of components to plot. The component plots include:

  - **Loading Plot**
    The *loading plot* is a plot of the relationship between the original variables and the subspace dimension. It is used to interpret relationships between variables.

  - **Score Plot**
    The *score plot* is a projection of data onto subspace. It is used to interpret relationships between observations.

  - **BiPlot**
    The *biplot* shows both the loadings and the scores for two selected components in parallel.

Number of Components to Extract: 4
1. In the dialog that was opened in the preceding steps, select the **Plots** tab. Make sure **Scree Plot**, **Loading Plot**, and **Biplot** are selected.

2. The first two components are usually responsible for the bulk of the variance. This is why we are going to plot the component plot in the space of the first two principal components. In the **Select Principal Components to Plot** group, set **Principal Component for X Axis** to 1, and set **Principal Component for Y Axis** to 2. Click **OK**.

5.7.2.4 **Interpreting The Results**

1. In the **Correlation Matrix**, we can see that the variables are highly correlated. Many values are greater than **0.3**. Principal Component Analysis is an appropriate tool for removing the collinearity.
2. The main component variables are defined as linear combinations of the original variables. The **Extracted Eigenvectors** table provides coefficients for equations.

<table>
<thead>
<tr>
<th></th>
<th>Coefficients of PC1</th>
<th>Coefficients of PC2</th>
<th>Coefficients of PC3</th>
<th>Coefficients of PC4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Meat</td>
<td>0.30261</td>
<td>-0.05625</td>
<td>-0.29758</td>
<td>0.64643</td>
</tr>
<tr>
<td>White Meat</td>
<td>0.31056</td>
<td>-0.36885</td>
<td>0.6239</td>
<td>-0.03699</td>
</tr>
<tr>
<td>Eggs</td>
<td>0.42668</td>
<td>-0.03534</td>
<td>0.18153</td>
<td>0.31318</td>
</tr>
<tr>
<td>Milk</td>
<td>0.37773</td>
<td>-0.18459</td>
<td>-0.39566</td>
<td>-0.00332</td>
</tr>
<tr>
<td>Fish</td>
<td>0.13565</td>
<td>0.64682</td>
<td>-0.32127</td>
<td>-0.21596</td>
</tr>
<tr>
<td>Cereals</td>
<td>-0.43774</td>
<td>-0.23349</td>
<td>0.09592</td>
<td>-0.0062</td>
</tr>
<tr>
<td>Starch</td>
<td>0.29725</td>
<td>0.35283</td>
<td>0.24298</td>
<td>-0.33668</td>
</tr>
<tr>
<td>Nuts</td>
<td>-0.42033</td>
<td>0.14331</td>
<td>-0.05439</td>
<td>0.33023</td>
</tr>
<tr>
<td>Fruits &amp; Vegetables</td>
<td>-0.11042</td>
<td>0.53619</td>
<td>0.40756</td>
<td>0.46206</td>
</tr>
</tbody>
</table>

\[ PC1 = 0.30261 \times \text{Red Meat} + 0.31056 \times \text{White Meat} + 0.42668 \times \text{Eggs} + 0.37773 \times \text{Milk} + 0.13565 \times \text{Fish} - 0.43774 \times \text{Cereals} + 0.29725 \times \text{Starch} - 0.42033 \times \text{Nuts} - 0.11042 \times \text{Fruits & Vegetables} \]

\[ PC2 = -0.05625 \times \text{Red Meat} - 0.23685 \times \text{White Meat} - 0.03534 \times \text{Eggs} - 0.18459 \times \text{Milk} + 0.64682 \times \text{Fish} - 0.23349 \times \text{Cereals} + 0.35283 \times \text{Starch} + 0.14331 \times \text{Nuts} + 0.53619 \times \text{Fruits & Vegetables} \]

\[ PC3 = -0.29758 \times \text{Red Meat} + 0.6239 \times \text{White Meat} + 0.18153 \times \text{Eggs} - 0.38566 \times \text{Milk} - 0.32127 \times \text{Fish} + 0.09592 \times \text{Cereals} + 0.24298 \times \text{Starch} - 0.05439 \times \text{Nuts} + 0.40756 \times \text{Fruits & Vegetables} \]

\[ PC4 = 0.64648 \times \text{Red Meat} - 0.03699 \times \text{White Meat} + 0.31316 \times \text{Eggs} - 0.00332 \times \text{Milk} - 0.21596 \times \text{Fish} - 0.0062 \times \text{Cereals} - 0.33668 \times \text{Starch} + 0.33029 \times \text{Nuts} + 0.46206 \times \text{Fruits & Vegetables} \]

3. The **Loading Plot** reveals the relationships between variables in the space of the first two components. In the loading plot, we can see that Red Meat, Eggs, Milk, and White Meat have similar heavy loadings for principal component 1. Fish, fruit, and vegetables, however, have similar heavy loadings for principal component 2.
4. The *biplot* shows both the loadings and the score for two selected components in parallel. It can reveal the projection of an observation on the subspace with the score points. It can also find the ratio of observations and variables in the subspace of the first two components. (Note: Double-click the graph to open and customize.)

5. We can use the Data Reader tool to open the Data Info window and examine the plot in greater detail. Click on a data point to read component scores for each country. We can see that Spain and Portugal's protein sources differ from those of other European countries. Spain and Portugal rely on fruits and vegetables, while eastern European countries such as Albania, Bulgaria, Yugoslavia, and Romania prefer cereals and nuts.
To display country information in the **Data Info** window, as in the image above:

1. Right-click the **Data Info** window and select **Preferences**....

2. Highlight **Country** in the left-panel, then click the Select button (the right-pointing arrow) to add **Country** to the Data Info display, then click **OK**.
5.7.2.5 Create 3D Components Plot

1. Click the lock icon in the results tree and select Change Parameters in the context menu.

2. In the Plots tab, set Components Plot Type to 3D. And enter 4 in the Principal Component for Z Axis.
3. Click **OK** to close the dialog. Then the PCA Plot Data and 3D loading plot will be created as follows.
5.7.3 Cluster Analysis

We will perform cluster analysis for the mean temperatures of US cities over a 3-year-period.

The starting point is a hierarchical cluster analysis with randomly selected data in order to find the best method for clustering. K-means analysis, a quick cluster method, is then performed on the entire original dataset.
Tutorials for Origin 2024b

Minimum Origin Version Required: Updated Origin 2020

5.7.3.2 Hierarchical Cluster Analysis

1. Start with a new project or a new workbook. Import the data file `\Samples\Graphing\US Mean Temperature.dat`.
2. Highlight Column D through Column O.
4. Select **Input** tab, click the **triangle button** next to **Variables**, and then click **Select Columns...** in the context menu.
5. In the lower panel of the Column Browser dialog, click the ... button. Set the data range from 1 to **100**. Click **OK**.

6. Click on the **Settings** tab and set **Cluster** to **Observations**, and **Number of Clusters** is **1**. For **Cluster Method**, select **Furthest Neighbor** and then click **OK**.
7. Go to the Cluster 1 sheet. After examining the resulting dendrogram, we choose to cluster data into 5 groups.

8. Click the lock icon in the dendrogram or the result tree, and then click Change Parameters in the context menu.
9. Set **Number of Clusters** to 5 in the **Settings** tab and then select the **Cluster Center** check box in the **Quantities** tab. Click **OK**.
10. In the resulting dendrogram, we can clearly see how observations are clustered. Note, that you can double-click on the embedded dendrogram in the report sheet to open the dendrogram in its own window. From here, you can customize the dendrogram -- for instance, by adding text labels, arrows, etc -- then click the **Close** button in the upper-right corner of the graph window to put changes back into the embedded graph in the report sheet.

11. To focus in on a particular subtree, click on a node to select it then right-click and choose **Duplicate Branch to New Window**. This opens the selected subtree in a new graph window.
5.7.3.3 Analyzing Original Data with K-Means Cluster

1. Right-click on Cluster Center and select Create Copy as New Sheet in the context menu. We are going to use the newly created Cluster Center as the Initial Cluster Centers in our k-means cluster analysis.

2. Go back to the worksheet with the source data (US Mean Temperature), and highlight col(D) through col(O). Select Statistics: Multivariate Analysis: K-Means Cluster Analysis.

3. Select the Specify Initial Cluster Centers check box in the Options tab. Click the interactive button next to Initial Cluster Centers. The dialog will "roll up".

4. Go to Cluster Center and highlight Col(D) through Col(O). Click the button on the rolled-up dialog to restore the dialog.

Note that beginning with Origin 2019b you will find, on the Plot tab of the hcluster dialog, a radio button for displaying Similarity on the Y axis of your Dendrogram (Distance is still default).
5. In the **Plot** tab, select **Additional Group Graph**. Click the interactive button next to **X Range**. The dialog will "roll up". Go back to the source worksheet **US Mean Temperature**, and highlight **Col(B):Longitude**. Click the button in the rolled up dialog to restore.

6. Click the **triangle button** next to **Y Range**, and then select **C(Y), Latitude**. Click **OK**.

7. Activate the worksheet **K-Means Plot Data1**. Observe that data has been clustered into 5 groups corresponding to the latitudes of the cities.
User can also select the output destination of **Cluster Membership** column, such as next to input data, for further operation if needed.

**5.7.4 Discriminant Analysis**

5.7.4.1 **Summary**

The Iris flower data set, or Fisher’s Iris dataset, is a multivariate dataset introduced by Sir Ronald Aylmer Fisher in 1936. This dataset is often used for illustrative purposes in many classification systems. The dataset consists of fifty samples from each of three species of Irises (iris setosa, iris virginica, and iris versicolor). Four characteristics, the length and width of sepal and petal, are measured in centimeters for each sample. We can use discriminant analysis to identify the species based on these four characteristics.

We will use a random sample of 120 rows of data to create a discriminant analysis model, and then use the remaining 30 rows to verify the accuracy of the model.

Minimum Origin Version Required: OriginPro 8.6 SR0

5.7.4.2 **Discriminant Analysis**
1. Open a new project or a new workbook. Import the data file `/Samples\Statistics\Fisher's Iris Data.dat`

2. Highlight columns A through D. and then select **Statistics: Multivariate Analysis: Discriminant Analysis** to open the **Discriminant Analysis** dialog, **Input Data** tab. Columns A ~ D are automatically added as **Training Data**.

3. Click the **triangle button** next to **Group for Training Data** and select **E(Y):Species** in the context menu.

4. Click the **Quantities** tab and select the **Discriminant Function Coefficients** check box. Expand the **Canonical Discriminant Analysis** branch and select the **Canonical Coefficients** check box. Accept all other default settings and click **OK**.
5.7.4.3 Interpreting Results

Click on the Discriminant Analysis Report tab.

5.7.4.3.1 Canonical Discriminant Analysis

The Canonical Discriminant Analysis branch is used to create the discriminant functions for the model.

1. Using the Unstandardized Canonical Coefficient table we can construct the canonical discriminant functions.

<table>
<thead>
<tr>
<th>Unstandardized Canonical Coefficients</th>
<th>Canonical Variable 1</th>
<th>Canonical Variable 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>-2.10511</td>
<td>-6.66147</td>
</tr>
<tr>
<td>Sepal Length</td>
<td>-0.82938</td>
<td>0.0241</td>
</tr>
<tr>
<td>Sepal Width</td>
<td>-1.53447</td>
<td>2.16452</td>
</tr>
<tr>
<td>Petal Length</td>
<td>2.20121</td>
<td>-0.93192</td>
</tr>
<tr>
<td>Petal Width</td>
<td>2.81046</td>
<td>2.83919</td>
</tr>
</tbody>
</table>

\[
D1 = -2.10511 - 0.82938 \times SL - 1.53447 \times SW + 2.20121 \times PL + 2.81046 \times PW \\
D2 = -6.66147 + 0.0241 \times SL + 2.16452 \times SW - 0.93192 \times PL + 2.83919 \times PW
\]
where SL = Sepal Length, SW = Sepal Width, PL = Petal Length, PW = Petal Width

2. The Eigenvalues table reveals the importance of the above canonical discriminant functions. The first function can explain 99.12% of the variance, and the second can explain the remaining 0.88%.

<table>
<thead>
<tr>
<th>Eigenvalue</th>
<th>Percentage of Variance</th>
<th>Cumulative Percentage</th>
<th>Canonical Correlation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>32.19193</td>
<td>99.12%</td>
<td>0.98482</td>
</tr>
<tr>
<td>2</td>
<td>0.28539</td>
<td>0.88%</td>
<td>0.4712</td>
</tr>
</tbody>
</table>

3. The Wilk’s Lambda Test table shows that the discriminant functions significantly explain the membership of the group. We can see that both values in the Sig column are smaller than 0.05. Both values should therefore be included in the discriminant analysis.

<table>
<thead>
<tr>
<th>Wilks’ Lambda Test</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Wilks’ Lambda</td>
<td>Chi-square</td>
</tr>
<tr>
<td>1 to 2</td>
<td>0.02344</td>
</tr>
<tr>
<td>2 to 2</td>
<td>0.77797</td>
</tr>
</tbody>
</table>

At the 0.05 level, the dimensionality is significantly 2.

5.7.4.3.2 Classification

1. The Classification Summary for Training Data table can be used to evaluate the discriminant model. From the table we can see that the classification in the groups setosa is 100% correct. For versicolor, only two observations are mistakenly classified as virginica, and for virginica, only one is mistakenly classified. The error rate is only 2.00%. This model is good.

<table>
<thead>
<tr>
<th>Classification Summary for Training Data</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification Count</td>
<td></td>
</tr>
<tr>
<td>Predicted Group</td>
<td>setosa</td>
</tr>
<tr>
<td>setosa 50</td>
<td>100.00%</td>
</tr>
<tr>
<td>versicolor 0</td>
<td>0.00%</td>
</tr>
<tr>
<td>virginica 0</td>
<td>0.00%</td>
</tr>
<tr>
<td>Total 50</td>
<td>33.33%</td>
</tr>
</tbody>
</table>

| Error Rate                               |
|-----------------------------------------|--|
| setosa 0.33333                           |
| versicolor 0.33333                        |
| virginica 0.33333                         |
| Total 0.00% | 4.00% | 2.00% | 2.00% |

Error rate for classification of training data is 2.00%. 
2. You can further switch to the **Training Result1** sheet to see which observation is mistakenly classified. In the sheet we can see the post probabilities calculated from the discriminant model and which group the observation is assigned to.

![Image of Training Result1 sheet]

- For the 84-th observation, we can see the post probabilities (virginica) 0.85661 is the maximum value, i.e. the 84-th observation will be assigned to the group **virginica** (at 85.7% probability).
- But in source data, the 84-th observation is in group **versicolor**. So this observation is mistakenly classified by the model.

5.7.4.4 **Model Validation**

Model validation can be used to ensure the stability of the discriminant analysis classifiers.

There are two methods to do the model validation:

- **Cross-validation**: In cross-validation, each training data is treated as the test data, exclude it from training data to judge which group it should be classified as, and then verify whether the classification is correct or not.
- **Subset Validation**: Usually we will randomly divide the set of observations into subsets, the first of which is used for the estimation of discriminant model (training set) and the second is for testing the reliability of the results (test set).

5.7.4.4.1 **Preparing Data for Analysis**
We are going to sort the data in random order, and then use the first 120 rows of data as training data and the last 30 as test data.

1. Go back to sheet *Fisher’s Iris Data*
2. Add a new column and fill the column with *Normal Random Numbers*.
3. Select the newly added column. Right-click and select *Sort Worksheet: Ascending* from the shortcut menu.

**Notes:** Origin will generate different random data each time, and different data will result in different results.

In order to get the same results as shown in this tutorial, you could open the *Tutorial Data.opj* under the *Samples* folder, browse in the *Project Explorer* and navigate to the *Discriminant Analysis (Pro Only)* subfolder, then use the data from column (F) in the *Fisher’s Iris Data* worksheet, which is a previously generated dataset of random numbers.

**5.7.4.4.2 Run Discriminant Analysis**

1. Select columns A through D.
3. To set the first 120 rows of columns A through D as *Training Data*, click the triangle button next to *Training Data*, and then select *Select Columns* in the context menu.
4. In the **Column Browser** dialog, click the ... button in the lower panel. Set data range from 1 to **120**. Click **OK**.
5. To set first 120 rows of Col(E) as Group for Training Data, click the triangle button next to Group for Training Data and select \textit{E(Y): Species} in the context menu. Then click the Group for Training Data triangle button again, select \textit{Select Columns} in the context menu, and set range from \texttt{1} to \texttt{120} with column browser. Click \texttt{OK}.

6. Select \textbf{Predict Membership of Test Data} check box. Click the \textbf{Test Data} interactive button. The dialog will "roll up". Select columns A through D in the worksheet. Click the button in the rolled up dialog to restore the dialog. Then click the triangle button to open Column Browser by selecting \textbf{Select Columns} in the context menu. Click \texttt{...} button in lower panel, and set range from \texttt{121} through \texttt{150}.

7. Click the \textbf{Settings} tab and select the \textbf{Cross Validation} check box. Click \texttt{OK}.
5.7.4.3 Cross-validation

Go to sheet Discriminant Analysis Report1. The Cross-validation Summary for Training Data table provides prediction error rate by classifying each case while leaving it out from the model calculations. However, this method is still more "optimistic" than subset validation.

5.7.4.4 Subset Validation

Error rate for Cross-validation of training data is 3.51%.
1. The **Classification Summary for Test Data** provide information that how the test data are classified.

   ![Classification Summary for Test Data](image)

   - **setosa**
   - **virginica**
   - **versicolor**
   - **Total**
   - **Count**
     - 6
     - 12
     - 12
     - 30
   - **Percent**
     - 20.00%
     - 40.00%
     - 40.00%
     - 100.00%

2. On the worksheet **Fisher's Iris Data**, copy the last 30 rows (121 through 150) of **Col(E): Species**.

3. On the worksheet **Test Result**, add one column, **Col(E)**, to the worksheet. Paste the copied values in the new column.

4. Add a new column, **Col(F)** to the worksheet, right click on it and select Set Column Values in the context menu. In the opened dialog, type **Compare(col(A),col(E))** in the pop-up dialog and click OK.

5. None of 30 values is 0, it means the error rate the testing data is 0. Our discriminant model is pretty good.

5.7.4.5 **Adjusting Prior Probabilities**

Discriminant analysis assumes that prior probabilities of group membership are identifiable. If group population size is unequal, prior probabilities may differ. We can use **Proportional to group size** for the **Prior Probabilities** option in this case.

1. Go to sheet **Discrim2**, Prior row of the **Error Rate** table under **Classification Summary for Training Data** branch indicate the prior probabilities for membership in groups. It is assumed that a case is equally likely to be one of the three groups. Adjusting the prior probabilities according to the group size can improve the overall classification rate.
2. Click on the button and select Change Parameter from the context menu. Select Proportional to group size for Prior Probabilities radio box. Click OK button.

3. We can see the classification error rate is 2.50%, it is better than 2.63%, error rate with equal prior probabilities.

Prior Probabilities = Proportional to group

Prior Probabilities = Equal

5.7.5 Partial Least Squares
5.7.5.1 Summary

Partial least squares (PLS) is a method for constructing predictive models when there are many highly collinear factors.

This tutorial will start with the spectral data of some samples to determine the amounts of three compounds present. The data includes:

- Data of the spectra emission intensities at different wavelength (v1 - v43)
- Amount of the three compounds in the sample (comp1, comp2, comp3)

This tutorial will establish a model to predict the amount of the three compounds from v1 - v43

Minimum Origin Version Required: OriginPro 2016 SR0

5.7.5.2 Partial Least Squares Regression

1. Start with a new project or a new workbook. Import the data file: \Samples\Statistics\MixtureSpectra.dat
2. Highlight Column("v1") through Column("v43").
4. The highlighted columns are automatically added as independent variables. Click the triangle button next to Independent Variables, and click Select Columns... in the context menu.
5. Ensure the lower panel is expanded by clicking the button with two arrows in the bottom right of the Column Browser dialog.
6. In the lower panel click the ... button. A Range dialog box will open. Clear the Entire Column(s) box and set the data range from 1 to 20. Click OK, then click OK to close the Column Browser.
7. Click the interactive button to the right of Dependent Variables. Return to the worksheet, select column("comp1") and drag to column("comp3"). Click the interactive button again to restore the dialog box.

8. Since v1 to v43 are absorbance, there is no need to standardize them. Click on the Settings tab, set Method to SVD and clear the Scale Variables check box.

9. Select the Cross Validation check box. It helps find the optimal number of factors in the model.
10. Click the **Plots** tab and expand the **Component Plot** branch. Select the following check boxes and click the **OK** button.

- Variable Importance Plot
- X Loadings Plot
- Y Loadings Plot
- X Scores Plot
- Y Scores Plot
- Diagnostics Plots

5.7.5.3 Developing the Model

In the workbook, select the tab for the **PLS1** sheet:

1. The **Cross Validation** table shows the optimum number of factors to extract. PRESS is the predicted residual sum of squares of the model. The model with minimum Root Mean PRESS has the optimal number of factors:
2. The Diagnostics Plots are residual plots of Y and X, which can be used to judge the quality of the model. Overall we can say that the fitted model is good because:
   
   - Layer 1 - The **Predicted values-Actual values** graph indicates that the model fits well for the first component.
   - Layer 2 - In the **Predicted values-Residual** graph, residuals are randomly distributed around zero. This indicates that there is no drift in the process.
   - Layer 4 - The P-P plot of residual can be used to check whether the variance is normally distributed. The result falls almost in a line, which means the variance is normally distributed.
3. A summary of importance of v1~v43 is given by the VIP plot. If the variable has small regression coefficients and low VIP values, we can consider excluding it in the model. For example

- VIP values of v41 ~ v43 in the plot below are low:
Coefficients of v41 ~ v43 are also small in the three coefficients below:

4. However, as in step 2, it appears that the model fits well so it is also acceptable to keep these less important variables.

5.7.5.4 Interpreting the Results

1. The **Variance Explained** table shows the proportion of variance explained by each factor. In the example, Factor 1 explains 71.36% variance for the X effect and 75.6% variance for the Y effect. Factor 2 explains 23.99% variance for the X effect and 22.14% for the Y effect. The **Variance Explained Plot** indicates that more attention should be paid to the first two factors as these two explained more than 95% variance for X and Y effects.

2. The Loading Plot reveals the relationships between X and Y variables in the space of the first two factors.
   - From the Y loading plot we can see that the three compounds have different loading on Factor 1 and Factor 2.
From the X loading plot it is apparent that v26 ~ v38 have similar heavy loadings for Factor 2, and v17, v18, v19, v23 and v24 have similar light loadings for factor 1 and factor 2.

Notes: To examine the plot in detail, you can double-click to open the graph containing the loading plot and zoom in it with the Scale In tool.
5.7.5.5 Using the Model to Predict

After the model is established, we can predict the amounts of the three compounds in new samples from their spectra emission intensities at different wavelengths:

1. Click the green lock on the PLS1 sheet and select Change Parameter from the context menu.
2. In the dialog that opens, click on the Input tab and select the Predict Responses check box.
3. Click the interactive button to the right of Independent Variables for Prediction. Return to the workbook, select the MixtureSpectra sheet. Select column("v1") to column("v43"). Click the interactive button again to restore the dialog box.
4. Click the triangle button next to Independent Variables for Prediction, and then click Select Columns... in the context menu.
5. In the lower panel of the Column Browser dialog, click the ... button. Deselect the Entire Column(s) box and set the data range from 21 to 25. Click OK to close the Range dialog and Column Browser dialog.

<table>
<thead>
<tr>
<th>Input</th>
<th>Settings</th>
<th>Quantities</th>
<th>Plots</th>
<th>Output</th>
</tr>
</thead>
</table>

   Independent Variables     [MixtureSpectralB"v1"[1]:AR"v43"[20]]       
   Dependent Variables       [MixtureSpectral]MixtureSpectralAS"comp1"     
   Observation Labels        <optional>                                       

6. Click the OK button to apply the settings and close the dialog.

7. The PLSResults1 sheet will now contain the predicted amounts of the three compounds in the five new samples:
5.8 Power and Sample Size

5.8.1 Summary

Power and sample size analysis is useful in design of experiments. Insufficient data translates into a lack of power to reject a false null hypothesis and collecting too much data is a waste of time and resources. Therefore, it is essential to determine the sample size requirements prior to conducting an experiment. The power of the experiment can be computed for a given sample size, and required sample sizes can be computed for given power values.

5.8.2 What you will learn

This tutorial will show you how to calculate sample size or estimate power value to design experiments, using some practical examples.

5.8.3 (PSS) One-Sample t-Test

**Background:**
A sociologist wants to determine whether the average infant mortality rate in the United States is equal to 8. In experiment design, the difference of rate cannot vary more than 0.5. And it is already known that the standard deviation should be 2.1 from pilot studies.

**Question:**
What would the sample size be, in order to estimate the average infant mortality rate at a confidence level of 95% ($\alpha = 0.05$) for power values of 0.7, 0.8 and 0.9?

**Steps in Origin:**
1. Activate an empty worksheet, select **Statistics: Power and Sample Size: (PSS) One-sample t-test**;
2. In the **PSS_tTest1** dialog box, choose the following settings and click **OK**.
Origin Output:
A result sheet will be generated, listing the calculated sample size for hypothetical powers.

Result Interpretation:
According to results, when designing his experiment the sociologist should conduct a survey of 111 samples for a power value of 0.7; 141 samples for power value of 0.8; and 188 samples for power value of 0.9.

5.8.4 (PSS) Two-Sample t-Test

Background:
A doctor’s office participates in two local insurance plans, Healthwise and Medcare. The purpose is to compare the mean time (in days) until reimbursement of claims for the two plans. Historical data shows that for the Healthwise plan, the average time is 32 days and the standard deviation is 7.5 days. For the Medcare plan, the average reimbursement time is 42 days and the standard deviation is 3.5 days.

Question:
If 10 claims from each plan were selected and the corresponding reimbursement times were recorded, what is
the power to detect the difference in mean reimbursement times between the 2 plans by 5% or more?

**Steps in Origin:**

1. Compute the pooled standard deviation as:
   \[
   \sqrt{((5 - 1)\cdot 7.5^2 + (5 - 1)\cdot 3.5^2)/(5 + 5 - 2)} = 5.85235
   \]
   *Note that this value will be used as the standard deviation later for the power calculation.*

2. Sample size of 1st group and 2nd group should be 10 (20 samples total).
3. Activate an empty worksheet and select **Statistics: Power and Sample Size: (PSS) Two-Sample t-Test**, 
4. In the **PSS_tTest2** dialog box, choose the following settings and click **OK**.

**Origin Output:**
A result sheet will be generated, showing the calculated power.
Interpretation of Results:
We can conclude that the doctor’s office has a 0.95054:1 (or 95%) chance of detecting a difference if it collects 10 claims for each plan. The chance that you will fail to reject the null hypothesis and incorrectly conclude that the two means are not different is 4.946% (1 - 0.95054).

5.8.5 (PSS) Paired-Sample t-Test

Background:
Two machines of the same type are used to measure the depth of an amorphous silicon (a-Si) thin film. To determine if there is a difference in the two machines measurements, an engineer plans a study to compare the depth measurements made by the two machines.

In a previous study on depth of the a-Si thin film, the standard deviation of the difference was found to be 2µm. In addition, it is known that the difference in measurement by the two machines should not exceed 0.5µm, and the average depth measured by Machine #1 is 5000µm.

Question:
How many samples must be taken at a confidence level of 99% to obtain power values of 0.8, 0.9 and 0.95?

Steps in Origin:
From the information above, it is concluded that the mean of the 1st group is 5000 µm and the mean of the 2nd group is 5000.5 µm.

1. Activate an empty worksheet and select Statistics: Power and Sample Size: (PSS) Paired t-Test
2. In the PSS_tTestPair dialog box, set controls as in the following image and click OK.
Interpretation of Results:
We conclude that the engineer has an 80% chance of detecting a difference if 191 thin film samples are measured; a 90% chance if 242 thin film samples are measured; and a 95% chance if 289 thin film samples are measured by each machine.

5.8.6 (PSS)One-Way ANOVA

Background:
Researchers are interested in whether different plants have different nitrogen contents. They planned to record nitrogen contents in milligrams for 4 species of plants (80 observations per species). Previous research suggests that the square root of MSE (Mean Squared Error) is 60 and the CSS (corrected sum of squares) of the means is 400.

Question:
Is the plan feasible? (i.e. will the calculated power be acceptable?)
**Steps in Origin:**

1. The sample size for each group is 80.
2. Activate an empty worksheet and select **Statistics: Power and Sample Size: (PSS)One Way ANOVA**
3. In the **PSS_ANOVA1** dialog box, choose the following settings and click **OK**.

**Origin Output:**
A result sheet is generated, and the power value is calculated from the known condition.

<table>
<thead>
<tr>
<th>Alpha</th>
<th>Sample Size</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.05</td>
<td>80</td>
<td>0.6993</td>
</tr>
</tbody>
</table>

**Interpretation of Results:**
It appears that the original research plan is deficient. There is only a 69% chance of detecting a difference from each group. To get more reliable results, researchers must collect more samples per species of plant.

5.9 **ROC curve**
5.9.1 Summary

The Receiver Operating Characteristic (ROC) analysis curve is mainly used for diagnostic studies in Clinical Chemistry, Pharmacology, and Physiology. It has been widely accepted as the standard method used for describing and comparing the accuracy of diagnostic tests.

Please refer to the Origin help file for details on how to use the ROC curve.

5.9.2 What you will learn

This tutorial will show you how to:

- Carry out ROC curve analysis.
- Interpret the analysis of results.

5.9.3 Steps

In this example, we perform a study to determine whether serum sodium can help to diagnose Rocky Mountain Spotted Fever (RMSF).

The data is retrieved from people with or without RMSF, the sodium level for each person is measured by 2 screening techniques. ROC curve analysis is carried out for data from both methods, used to check the relationship between serum sodium and RMSF, and helped to judge which diagnostic method is better.

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file sodium.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Select Statistics: ROC Curve... to open the ROC curve dialog.
3. Under the Input Data branch, select column B(Method1) and C(Method2) for Data, and column A(Sickness) for State, respectively.
4. Select RMSF in Positive State Value box and select the Positive v.s. Low button for Test Direction under the Computation Control branch.
5. Select Optimal Cutpoint check box under ROC Curve branch
6. Accept all other default settings and click the OK button to carry out the analysis.
Results Interpretation: Go to worksheet ROC Curve1, where the analysis results are listed.

<table>
<thead>
<tr>
<th>Area Under the Curve</th>
<th>Area</th>
<th>Std. Error</th>
<th>Asymptotic Prob</th>
<th>95% LCL</th>
<th>95% UCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method1</td>
<td>0.88862</td>
<td>0.04577</td>
<td>&lt;0.0001</td>
<td>0.79892</td>
<td>0.97833</td>
</tr>
<tr>
<td>Method2</td>
<td>0.79407</td>
<td>0.05344</td>
<td>3.66257E-4</td>
<td>0.66972</td>
<td>0.91842</td>
</tr>
</tbody>
</table>

From the table, we can see that the Asymptotic Prob of both methods are much smaller than 0.05, hence we can conclude that both methods are effective.

In ROC analysis, the closer the area is to 1.0, the better the test is, while the closer the area is to 0.5, the worse the test is. In this analysis, the area of method 1 and method 2 are 0.88862 and 0.79407, respectively. Both these results are much larger than 0.5. However, the area of method 1 is closer to 1.0, so we can conclude that method 1 is better than method 2.
In addition, we can examine the shape of ROC curve, which is also included in the report sheet. Since method 1 appears to have greater sensitivity than method 2, we can roughly conclude that method 1 is better than method 2.
6 Graphing

6.1 Graphing

6.1.1 Plotting

- 3D Bar with Labels
- Creating a Graph
- Basic 2D Plotting
- Basic 3D Plotting
- Plot from User Defined Graph Template
- Adding a Data Plot to Existing Graph
- Smart Peak Labels with Leader Line
- Error Bars with Fill Area
- Mark out a segment of plot with different plot style
- Overview of Customization
- Plotting Overlapping Data and Setting Transparency

6.1.2 Axis

- Multiple Axis Breaks
- User-Defined Arbitrary Tick Positions

6.1.3 Layers

- Merging and Arranging Graphs
- Multiple Layers with Linked Axis
- Multi Layer Graph Customization

6.1.4 Graph Template and Theme

- Copy and Apply a Plot Format to Another Plot
6.1.5 Line Symbol

- Complicated Fill Area
- Fill Partial Area between Function Curves
- Scatter Plot of Decay and Recovery Curves
- Micro-Raman spectroscopy of complex nanostructured mineral systems
- Multi-line-plot with Special Position Annotation Line
- Line Graph with Masked Data
- Symbol Plot with Color Transparency
- Symbol Plot with Size and Colormap from Other Columns

6.1.6 Column Bar Pie

- 2D Color Pie Chart of a Population Study
- Bar and Scatter Plot with Error Bar
- Column Graph with Error Bars
- Stack Column With Labels
- Grouped Column with Error Bars and Data Labels
- Grouped Stacked Column
- Stack Column Plot with Different Positive and Negative Y Scale
- Variable Column Width

6.1.7 Multi-Axis Multi-Panel

- Double Y Graph
- 3Ys Y-YY
- Stack Lines by Y Offsets
- Vertical 2 Panel Line
- Multiple Axis Plot
- Energy-Level Structure of the Er3+ Ion in A YAG Crystal
- Panel Graph with Inset Plots of High-resolution Electron Energy-loss Spectra
6.1.8 Contour

- XYZ Contour
- Contour Plots and Color Mapping
- Ternary Contour
- Contour Graph with XY Data Points and Z Labels
- Contour Plot with Vector Overlay
- Create Heatmap with Virtual Matrix and Colormap Bar Plot
- Contour plot in Sphere Surface Projections

6.1.9 Maps

- Add Google Map to Origin Graph
- Baidu Map
- Tile Grid Map from Base Graph

6.1.10 Statistics

- Box Plot
- Grouped Box Chart with Color Indexed Data Points
- Marginal Distribution Curve
- Grouped Box Plot
- Add multiple fitted curves in a Histogram
- Weibull Probability Plot
- Q-Q Plot
- Scatter Matrix

6.1.11 Polar

- Polar Contour
- Polar Plot with Error Bar
- Cropped Polar Plot with Custom Orientation
• Polar Graph with Custom Radial Axes
• Polar Graph with Multiple Layers
• Polar Graph with Columns
• Polar Graph with Custom Angular Scale

6.1.12 3D Graphs

• 3D Pie Chart
• 3D Vector
• 3D Scatter Plot with Line Projections of Core Drilling Locations
• 3D Bar and Symbol
• Creating Intersecting Surface Plots from Worksheets
• Colormap from Second Matrix
• Color Map Surface Graph
• Parametric Surface with Colormap from Data
• Stacked 3D Surface Plots
• Multiple Surfaces in Same Layer
• 3D Scatter with Colormap
• 3D Bar on Flatten Surface
• 3D Bar with Labels
• 3D Surface with Point Label
• 3D Scatter Plots with Confidence Ellipsoids
• Convert Data from Spherical Coordinate to XYZ and Make a 3D Plot
• Stack Flattened Surfaces with Certain Z Offset
• 3D Ternary Colormap Surface with Contour Lines Projection

6.1.13 6.1.13 Plot Functions with Parameters Defined in a Worksheet

6.1.14 Wind Rose

6.1.15 2D Function Plot
6.1.16 **2D Vector**

6.1.17 **Piper Diagram**

6.1.18 **Waterfall**
- 2D Waterfall
- 3D Waterfall

6.1.19 **Open-High-Low-Close Stock Chart**

6.2 **Plotting**

6.2.1 **Plotting**
- 3D Bar with Labels
- Creating a Graph
- Basic 2D Plotting
- Basic 3D Plotting
- Plot from User Defined Graph Template
- Adding a Data Plot to Existing Graph
- Smart Peak Labels with Leader Line
- Error Bars with Fill Area
- Mark out a segment of plot with different plot style
- Overview of Customization
- Plotting Overlapping Data and Setting Transparency

6.2.2 **3D Bar with Labels**

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Origin's 3D OpenGL Graphs</td>
<td></td>
</tr>
<tr>
<td>- 3D Graph Tick Label and Axis</td>
<td></td>
</tr>
<tr>
<td>- Overlay Locations on a 3D Map</td>
<td></td>
</tr>
<tr>
<td>- Placing 3D Bars on a Map</td>
<td></td>
</tr>
</tbody>
</table>
6.2.2.1 **Summary**

This tutorial will show you how to create the following graph:

Minimum Origin Version Required: 2015 SR0

6.2.2.2 **What You will learn**

This tutorial will demonstrate how to:

- Create and customize a flat Color Fill surface.
- Use Plot Setup to add a 3D bar plot to the original graph.
- Add and customize labels on the 3D bars.

6.2.2.3 **Steps**
6.2.2.3.1 Creating a Flat Color Fill Surface from a Matrix

Open Tutorial Data.opj and browse to the folder 3D Bar with Labels.

1. Activate the Matrix MBook1B.

2. From the Origin menu select Plot > 3D: 3D Color Fill Surface to create a 3D plot that will have Speed Mode turned on:


4. On the Size/Speed tab, clear Matrix data, maximum points per dimension. This turns off Speed Mode allowing for full display of the dataset. Click Apply.
5. Expand **Layer1** and select the plot under it.

6. To flatten the plot of the US, click on the **Surface** tab and enable the **Flat** option.

7. On the **Fill** tab, click the **Contour fill from matrix** radio button to set the colors according to the matrix information. Deselect the **Fill back surface** check box as well.

8. Next click the **Colormap/Contours** tab to set the matrix colors and click **Level...**

9. In the **Set levels** dialog that opens, select the **#Major Levels** radio button and set it to 2. Set the **Total # of Levels** to 2 and click **OK** to close the dialog.
10. Click on each color level under the Fill... heading to open the Fill dialog and choose the color. Set the three colors to Black, Gray and a customized blue with an RGB of 0, 64, 128 as shown below:

11. On the Mesh tab, clear the Enable box and click OK to close the dialog box.

12. The graph will resemble the image below:
6.2.3.2 Adding and Customizing 3D bars and labels

1. With the graph active select **Graph: Plot Setup** on the Origin menu. This opens the **Plot Setup** dialog box.
2. In the upper-left corner set **Available Data** to **Worksheets in Folder**. This will make the data in Book2B available for plotting on the same graph.
3. Select Book2B, set **Plot Type** to **3D - Bars**. In the middle panel set X, Y and Z as columns A1, G1 and D, respectively. Click **Add** to add the plot to the current layer:
Click **OK** to exit the dialog box.

In order to show all three panels in **Plot Setup** dialog, please expand **Plot Type** panel by clicking and expand **Available Data** panel by clicking again.

Please refer to [Plotting using Plot Setup](#) for more information.

4. To customize the 3-D bars, double-click on them to open the **Plot Details** dialog box. On the **Pattern** tab, set the border color to **Wine** and the fill color to **Red**. On the **Outline** tab set the **Width (in %)** to **10**. Click **Apply**
5. Next, select the **Label** tab and check the **Enable** box.
6. Set the **Label Form** as **Col(B):"City"** so that labels display the city name located in Col(B) of the worksheet.
7. Set the **Position** in **Z** as **Top Outside** with an Offset of **10** and set the **Orientation** in the **YZ** plane. Set the other controls as shown below and click **OK** to close dialog.

8. At this point the labels will not show as the axes scale is too small for them to be in the graph range. Double-click the vertical axis (Z Axis) and go to the **Scale** tab, set **From** to 0 and **To** to 8000000. Click **OK** to exit.

9. Double-click on the graph again and in the **Plot Details** dialog box, select the **Graph1** option in the left panel. On the **Display** tab set the **Color** to **LT Gray**. Click **OK** to close dialog.

10. Double-click the Z axis title and change it to **Population (Million)**.
11. The final graph should resemble the one shown below:

![Graphing](image)

12. Since this is a 3D OpenGL Graph, use the **Rotate Tool** button on the **Tools** toolbar or hold down the **R** key and use the mouse, to rotate. You can also click the graph and select the **button to enter
rotation mode as shown below, or use the controls in the **3D Rotation** toolbar:

![3D Rotation Diagram](image)

### 6.2.3 Creating a Graph

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Video Icon] Copy Data from Worksheet or Matrix to Graph</td>
<td></td>
</tr>
<tr>
<td>![Video Icon] Add Plots to a Graph by Drag and Drop</td>
<td></td>
</tr>
<tr>
<td>![Video Icon] Trellis Plot</td>
<td></td>
</tr>
<tr>
<td>![Video Icon] Trellis Plot with Double Y Graph</td>
<td></td>
</tr>
<tr>
<td>![Video Icon] Customize Panel Frame in Trellis Plot</td>
<td></td>
</tr>
<tr>
<td>![Video Icon] Adding, Grouping and Reordering Plots with Layer Contents</td>
<td></td>
</tr>
</tbody>
</table>
6.2.3.1 Summary

Origin provides templates library. You can create and modify templates by your own and add to the collection. Creating a graph in Origin is as simple as selecting the desired data and then selecting a template from a menu or from the graphing toolbars. The Plot Setup dialog offers more flexibility in creating plots, such as plotting data from multiple books or sheets.

Starting with Origin 2016, a more powerful "cloneable" template has been added. These templates are designed for "smart plotting", meaning you can clone a graph with a complicated layer hierarchy or with source data that cannot be specified by simple selection. See this tutorial on plotting from user-defined graph templates to learn how to save and use both standard and cloneable templates.

6.2.3.2 What you will learn

This tutorial will show you how to:

- Select data in a worksheet and quickly create a plot
- Change X/Y input of the data plot with context menu
- Add data to or remove it from an existing graph
- Use Plot Setup to plot data from multiple sheets
- Plot groups of plots by label

6.2.3.3 Create a Plot Quickly by Selecting Data

1. Click the Connect Multiple Files button to open the connector dialog. To import multiple ASCII, select CSV for Data Connector.
2. Click ... button next to File Names edit box. In the open dialog, select the files S15-125-03.dat, S21-235-07.dat and S32-014-04.dat from \Samples\Import and Export\ and click Add File(s) to add three files to the lower panel. Click OK to add them to File Names edit box.
3. Check Same Book checkbox.
4. Click **OK**. The imported results should appear as below:

![Image of Origin software interface](image)

5. Make the third worksheet, S32-014-4, active. To create a three layer graph, highlight the three Y columns, Delta Temperature, Magnetic Field, and Position, and then select **Plot > Multi-Panel/Axis: 3Ys Y-YY**. Note: There is no need to highlight the Time column, as Origin will automatically plot the Y columns against the associated X column in the worksheet.

![Graph of Delta Temperature, Magnetic Field, and Position](image)

6.2.3.4 Change X/Y Data of the Plot

Use the same worksheet from the previous example.
1. Highlight column B and click the **Line** button to generate a line plot.

![Graphing](image1)

2. Right click on the data plot and point to the **Change Y** context menu, then select column C (Magnetic Field) in the fly-out.

![Graphing](image2)
3. You may see a reminder message about rescaling the graph to show all data. Choose **Yes** and click **OK** so that the updated plot will be auto-rescaled.

   ![Reminder Message]

   A significant portion of the new data lie outside the current axes limits. Would you like to rescale the axes to show all the data?

   - **Yes**
   - Yes, and do the same in the future, no need to ask again.
   - **No**
   - No, and don’t bother me with this again.

4. The plot will update as shown below:

   ![Magnetic Field Graph]

   With this context menu, you can change the X or Y data of the current plot to be another column in the current project. This column will be any column other than the current X or Y data column, regardless of column designation. Choose **Select Column** menu item to specify column from current folder or current project.

   You are also allowed to use the **Change Worksheet** context menu to change the current X and Y data to be the columns with same column index in another worksheet.
of current workbook, regardless of column designation and column short name.

![Change Worksheet menu](image)

**Note:** You can also use the **Layer Contents** or **Plot Setup** dialog to change the input data.

6.2.3.5 **Add Data to an Existing Graph and Update Legend**

6.2.3.5.1 **By Drag and Drop**

1. Go back to the book with the three sheets of data from the above example.
2. Highlight the **Delta Temperature** column (Column B) from the first sheet and then select **Plot > Basic 2D: Line** to create a line plot.
3. Go back to the workbook. For each of the remaining two sheets, select the **Delta Temperature** column and position the cursor at the edge of the column until you see the cursor change to ![cursor change].
4. Then you can drag-and-drop the column into the graph page. Another curve will be added to the current layer.
5. After adding the other curves, expand the **Object manager** panel docked at the right-top corner of Origin workspace by default (you can use **View: Object Manager** menu to reload it if needed). Right-click on the last plot under Layer1 to select **Set As Group End** to group all these three curves together.
6. Grouping the plots allows for quick creation of presentation-ready graphs, because each selection in the group is assigned a differentiating set of plot attributes (line color = black, red, green; symbol shape = square, circle, triangle; etc...).
7. Select **Graph: Legend: Update Legend...** to open the `legendupdate` X-Function dialog. Set the **Auto Legend Translation Mode** to **Custom**. Enter `@WS` for **Legend Custom Format**.

![Graphing](image)

8. Click **OK** and the legend will now contain the worksheet name for each data plot.
The default plot type of the drag and drop plot is **Current**, which is the same as the current active plot. However you could change the default option. To do this, click **Preference: Options** and go to the **Graph** tab, and change the setting of **Drag and drop plot** drop-down menu.

### 6.2.3.5.2 By Copy for Plotting Mini Toolbar

In this section, we will use **Copy for Plotting** mini toolbar button to add new plots to an existing graph.

1. Go back to the book with the three sheets of data from the above example.
2. Highlight the **Delta Temperature** column (Column B) from the first sheet S15-125-03 and then select **Plot > Basic 2D: Line** to create a line plot.

3. Go back to the workbook, and activate the second sheet S21-235-07. Select the **Delta Temperature** column and a mini toolbar will appear. Click **Copy for Plotting** button.

4. Activate the graph window and press **Ctrl+P** to plot the copied column data as a line curve to the current layer.

5. For the remaining sheet S32-014-04, repeat the process of copying and pasting dataset to the existing graph to add the new line of Delta Temperature from S32-014-04.

### 6.2.3.5.3 By Layer Contents Dialog
The **Layer Contents** dialog box is useful primarily for adding or removing data plots from the graph layer. Starting with Origin 2016, you can switch layers without closing the dialog box, making it easier to add plots to, or remove plots from, a multi-layer graph. To demonstrate, we will return to the 3-layer graph that we created in the first exercise in this tutorial:

1. Right-click on the layer 1 icon in the upper-left corner of the graph window and choose **Layer Contents**.
2. In the dialog box that opens, click the drop-down list in the upper-left corner and select **Worksheets in Folder**.
3. Right-click on the left-panel headings, clear **Book Name** and select **Sheet** (if not already displaying) so that you can see which worksheets contain which workbook datasets, then click on the Sheet heading to sort datasets by sheet name.

In the first exercise, we plotted data from sheet S32-014-04. In this exercise, we will swap the data from sheet S32-014-04 with data from sheet S21-235-07.
4. In the right-hand panel of Layer Contents, select **Delta Temperature** from sheet S32-014-04 and click the **Remove Plot** button to remove the plot from graph layer 1.

5. In the left-hand panel, select **Delta Temperature** from sheet S21-235-07 and click the **Add Plot** button, then click **Apply** to add the new plot to layer 1. You have now swapped one dataset for another.

6. Click the **Layer(1)** button at the top of the dialog and choose **Switch Layer > 2. Layer 2**.

7. Repeat the process of removing the existing **Magnetic Field** dataset from layer 2 and replacing it with the Magnetic Field dataset from sheet S21-235-07, then click **Apply**.
8. Click the **Layer (2)** button and choose **Switch Layer > 3.Layer 3** and repeat the process of swapping the **Position** dataset in sheet S32-014-04 with the Position dataset in sheet S21-235-07, then click **Apply** and close the dialog box.

![Graphing](image)

6.2.3.6 **Create a Plot using Plot Setup**

The Plot Setup dialog box is useful for a variety of plotting tasks, including creating graphs, modifying the plot type, adding plots to or removing plots from the graph, grouping or ungrouping plots, and editing the plot range.

1. Return to your workbook and ensure that no data are selected. It doesn’t matter which worksheet is active; what is important is that no columns are highlighted.

2. Select **Plot > Multi-Panel/Axis : 4 Panel** from the menu. When no data are selected, Origin opens the **Plot Setup** dialog, allowing you to choose the data you wish to plot.

3. Expand the top panel by clicking the **Expand** button. Hold down **Ctrl** key to highlight the three worksheets. Alternatively, you can just click and drag your selection so that all three worksheets are highlighted.
4. In the middle panel, common columns in all three sheets are displayed. In this case, all three sheets have similar data with matching column names. Click the button at top-right of this panel to show the available plot columns listed with similar column long name. This mode is easier because you don’t have to check the X and Y designation check boxes.

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
<th>yEr</th>
<th>L</th>
<th>Column</th>
<th>Long Name</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>From/Step=</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A</td>
<td>Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B</td>
<td></td>
<td></td>
<td>Delta Temperature</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C</td>
<td></td>
<td></td>
<td>Magnetic Field</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>D</td>
<td></td>
<td></td>
<td>Position</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Open the bottom panel of the dialog, the Plot List, if it is not already visible. Layer 1 is highlighted. Select Delta Temperature in the middle panel, and then click the Add button. Since you already selected the three worksheets in Step 3, this will add all Delta Temperature columns from the selected worksheets to
6. Repeat these steps to add all **Magnetic Field** columns and all **Position** columns into Layer 2 and Layer 3, respectively.
7. Click the **OK** button to create the graph.

8. You'll note that the default legend that is created for each layer is not particularly helpful. The Origin graph legend object is highly customizable, so before we go further, we will modify the default legend. Right-click on any of the legend objects and select **Legend: Update Legend** from the shortcut menu.
9. In the dialog box that opens, do the same settings at step 8 of the section **By Drag and Drop**. Note that the **Legend Custom Format** syntax @WS is **LabTalk Substitution Notation** for the name of the worksheet containing the data for each line plot.

10. We have one extra (empty) layer on the graph page. To delete that layer, click on it once to select it then press the **Delete** key on the keyboard. Take care not to delete the graph window as we will use it in the next section of this tutorial.

In the graph above, the legend for each layer is same with each other. You can delete two of them. Or do settings below in **the Legend Update dialog**, to just show one legend for whole graph window.
Once the settings are applied, you can press Ctrl + double-click on the legend text to do further in-place edits; or you can right-click on the legend box to select Properties... from context menu and do further advanced editing in the Text Object dialog.

6.2.3.7 Plot Grouped Data As

When your data includes a column of categorical data, or multiple columns characterizing some sort of nested sub-grouping of data, just as the data below
then you might want to plot your data as:

### 6.2.3.7.1 Trellis Plot

Beginning with Origin 2017, you have introduced the **Trellis Plot** which has one layer but with $M \times N$ panels.

1. New a workbook.
   1. Start with an empty worksheet. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file 2010.dat. Drag-and-drop this file into the empty worksheet to import it.
2. Highlight col(H)~col(J) to select **Plot > Categorical : Trellis Plot** menu. The dialog **plot_group** will pop up. Select col("City") as horizontal group variable and col("Gender") as vertical group variable for the
3. Click OK button to plot the graph. Click on the X axis and click **Axis Scale** button on the mini toolbar that appears. In the simple dialog that opens, set **From** and **To** for horizontal axis to -10 and 90. You will get the graph as below:
Just as you can see, this trellis plot has only one layer but with six panels (2×3): 2 rows represent the variable "Gender", Female and Male; three columns represent the variable "City", A, B, and C.

6.2.3.7.2 Grouped Box Plot

Besides the trellis plot, you can also plot these kind of data as a grouped box/column plot.

1. Active the source worksheet above again. Highlight col(“Salary”) to select Plot > Categorical : Grouped Box Charts - Indexed Data menu to open the dialog plot_gboxindexed. Select col(“Gender”) and col(“City”) as Group Columns.
2. Click OK button to plot the graph.

Just as you can see, the data col("Salary") has been plotted as a grouped box charts: Two groups by "Gender", Female and Male; within these two groups, three subgroups by "City", A, B, and C.

6.2.3.8 Plot Graphs by Label

Origin offers a plotting option, Multiple Panels by Label, that allows you to create a multilayer graph, each layer of which contains multiple plots, identified by the same label.

1. Open the file Samples\Graphing\Automobile Data.ogw (Hint: Make sure that your Open files filter is set to Workbooks(*.ogw)).
2. Click on top left corner of the worksheet to select the entire sheet. Select **Plot > Multi-Panel/Axis**: **Multiple Panels by Label** to open the plotbylabel dialog.

3. Set the dialog options as following, and click the **OK** button to create the graph.

![Plot by Label dialog](image)

The graph should look like this:

![Graph example](image)

### 6.2.4 Basic 2D Plotting
6.2.4.1 Summary

Origin's 2D plots are highly customizable. You can easily modify plot attributes, arrange layers, and select different datasets for each layer. This tutorial will teach you the basic plotting skills.

6.2.4.2 What you will learn

This tutorial will show you how to:

- Perform simple row statistics
- Create a graph and save as a template
- Plot into your template
- Use the Plot Setup dialog

6.2.4.3 Steps

### 6.2.4.3.1 Simple row statistics

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the “Samples” folder. In this folder, open the Curve Fitting subfolder and find the file Dose Response - No Inhibitor.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight columns 2 through 4 and select Statistics: Descriptive Statistics: Statistics on Rows. Make sure to check the Mean and Standard Deviation check boxes on the Quantities tab to output these results.
3. After you click the **OK** button, two new columns, **Mean(Y)** and **SD(yErr)** are added to the source worksheet. Here, **yErr** means that this is an error column and the data in this column can be used to plot error bars.

**Note:** To simplify plotting, each column in an Origin worksheet has a plotting designation. To change a column's plotting designation, select the column and click on the **Column** menu. Alternatively, right-click on the column and choose **Set As** from the shortcut menu.

### 6.2.4.3.2 Create a graph and save as a template

1. Highlight the **Mean(Y)** and **SD(yErr)** columns and select **Plot > Basic 2D: Line+Symbol** to create the plot:
2. Click on the X Axis, and select the **Axis Scale** button in the Mini Toolbar. Then in the **Axis Scale** dialog, check the **Log** checkbox and click **OK** button.

3. Select **Graph: Rescale to Show All** from the menu, which will rescale the X and Y axes of the graph.

4. To edit the curve, double-click on any plot symbol to bring up the **Plot Details** dialog. Alternatively, right-click inside the graph and choose **Plot Details** from the shortcut menu. On the **Line** tab of right panel, select **B-Spline** as the connecting line type to get a smoother curve.
Click the OK button to close the dialog.

5. When all modifications have been made and the graph looks the way you want it, you can use this graph to create a template, to be used in the future with similar data. Select File: Save Template as to open the Save Template dialog. In the Category drop-down list, select UserDefined; and then type a proper Template Name. In this example, we use MyTemplate. Click OK to save the template.
**6.2.4.3 Plot into graph template with the Plot Setup dialog**

1. Click the **New Workbook** button and import the file \Samples\Curve Fitting\Dose Response - Inhibitor.dat as above. Perform **Statistics on Rows**, calculating the Mean and SD of this worksheet as you did above, following the same steps.

2. Highlight column **Mean(Y) and SD(yErr)** in this sheet. Select **Plot : My Template :MyTemplate** to choose the user defined template to create a new plot.

And then you will have:
6.2.5 Basic 3D Plotting

**Videos**
- Graph Template
- Origin 3D OpenGL Graphs
- Adding, Grouping and Reordering Plots with Layer Contents
- Convert Worksheet to Matrix to Plot 3D Surface
- Color Manager

**OriginBlog**
- Speed Mode – How does it affect my graph and its exported image?

6.2.5.1 Summary
In Origin, Contour plots and 3D plots, such as Color Map Surface plots, can be created directly from XYZ data. But, if you want to plot a smoother 3D surface, you are strongly advised to use one of Origin's built-in gridding routines to convert the XYZ data into a matrix.

Minimum Origin Version Required: Origin 9.0 SR1

6.2.5.2 What you will learn

This tutorial will show you how to:

- Create a 3D graph from XYZ data
- Use the **Layer Contents** dialog to add/remove a data plot
- Convert XYZ data into a Matrix
- Use the **Plot Details** dialog to customize a graph

6.2.5.3 Create a 3D Surface and Scatter Plot

1. Select **Data: Connect to File: Text/CSV** to import the file `\Samples\Matrix Conversion and Gridding\XYZ Random Gaussian.dat` with default settings.

2. Highlight column C and click **Z** button from the mini toolbar that appears.

3. Select **Plot > 3D : 3D ColorMap Surface** to create a 3D Colormap Surface plot (Graph1 by default).
4. Right click the layer icon on the left-top of the graph to open the **Layer Contents** dialog. In this dialog, click on the button and select **3D Scatter/Trajectory/Vector** from the fly-out menu.

5. Select column C from the left panel and click on the **Add Plot** button to add the 3D scatter plot to the graph. Click **OK** to close the dialog.

6. Double-click on the scatter plot of Graph1 to open the **Plot Details** dialog. In the **Symbol** tab, set **Shape** to **Ball**, **Size** to **12** and **Color** to **Map: Col(C)** (expand Color Chooser to do settings in the **By Points** sub-
7. In the **Drop Lines** tab, uncheck the **Parallel to Z Axis** checkbox.
8. In the **Colormap** tab, click on the column header **Fill...** to open the dialog. In the **Fill** dialog, choose **Load Palette**, click on **Select Palette**, and select **Rainbow** from the list.

9. Select **Layer1** from the left panel of the **Plot Details** dialog. In the **Lighting** tab, select **Directional** as **Mode** and do the settings under **Light Color** just as the image below showing. Click **OK** to close the dialog.
The graph should look as below:
Press the "S" key while hovering on a 3D openGL graph. The cursor will change modes. Drag with your mouse or use arrow keys to change lighting source direction.

6.2.5.4 **Smooth the 3D surface plot**

If you want to create a 3D surface that is smoother than the surface plot above (created from XYZ data), you can firstly convert the XYZ data into a matrix using the **XYZ Gridding** tool. And then, use the result Matrix data to create the 3D surface.

1. Activate the workbook **XYZ Random Gaussian** again.
2. Select **Worksheet: Convert to Matrix: XYZ Gridding** to open the dialog. Expand the **Gridding Settings** branch, select **Random (Thin Plate Spline)** from the **Gridding Method and Parameters** drop-down list, and set both the **Columns** and **Rows** to 30. Click **OK** to convert the XYZ data into a matrix.

![XYZ Gridding: Convert Worksheet to Matrix dialog](image)

3. Activate the matrix, and select **Plot > 3D: 3D Colormap Surface** to create another 3D graph, says **Graph2**.
4. Go back to Graph1, right-click on any white space in Layer frame to select **Copy Format: All Style Formats** in the context menu.

5. Switch to Graph2 again, right-click on the Layer frame, select **Paste Format** in the context menu.

6. Select **Format: Plot...** from main menu to open the **Plot Details** dialog. Go to **Colormap/Contours** tab, clear **Enable Contours** check box:
Graphing

Graph 2 should look as below:
6.2.6  Plot from User Defined Graph Template

6.2.6.1  Summary

In this tutorial, we will show you how to save a graph as an user-defined template and plot new data into the saved custom template. There are two types of graph templates available in Origin: standard template and cloneable template. Cloneable template can be easily used to clone a graph from a new workbook/worksheet, in spite of the complexity of data composition in target graph, but with one prerequisite that new data should share same data structure with the data in target graph. In comparison, standard template has more freedom over data source but lacks of the ability to duplicate a graph with complicated layer hierarchy or data structure.

This tutorial will show you how to:

- Create and save a graph as standard template
• Plot new data into a standard template
• Save a graph as cloneable template
• Plot data with same data structure into a cloneable template

6.2.6.2 Standard Template

6.2.6.2.1 Create and Save a Standard Graph Template

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

1. Open the Tutorial Data.opj and browse to the folder Custom Axis Scale to Show Different Scale Range.

2. Highlight column B Exothermic Energy and C Energy-SD, click scatter button on 2D Graphs toolbar to make a scatter plot with Y error bar.

3. Next we want to customize the symbol to be solid circle with blue color, to do so double-click on any data point on the graph to bring up Plot Details - Plot Properties dialog.

4. Make sure first plot under Layer1 branch is selected on the left panel. Go to Symbol tab. Select solid circle from the down-sided triangle button under Preview and set Symbol Color to be Blue in the Single tab of Color Chooser. Click OK.

5. To save it as standard template, right click on Graph1 window title bar and select Save Template As... to open dialog.

6. Input BlueCircle as Template Name and add some descriptions Blue solid circle in Template Description edit box.
7. If you want preset the long name of newly created graphs to be the first plot's long name, click the more options button next to Preset Graph Long Name edit box and select @LL: Long Name. %({1,@LL}) will show as Preset Graph Long Name.
8. Make sure Mark as Cloneable Template box is unchecked, click OK button to save it as standard template.

6.2.6.2.2 Plot New Data into Standard Template

1. Go back to workbook, highlight columns Temperature and Temperature-SD and go to menu Plot: My Templates: BlueCircle (UserDefined) to make the graph. The graph window long name is Temperature.

6.2.6.3 Cloneable Template

6.2.6.3.1 Save Graph as a Cloneable Template

1. Press F11 key or select Help: Learning Center to open the Learning Center dialog. Select Graph Sample in the left-side panel, and search for Raman.
2. Double-click on the graph that is returned to open the Raman Spectrum subfolder.
3. Graph Raman Spectrum is plotted from data in different worksheets of workbook Peak1 also with data labeling. It's hard to plot new data like this with one click using standard graph template. So let's save this graph as a cloneable template and clone this graph using data in workbook Peak2.
4. To do so, right click on graph **Raman Spectrum** window title bar and select **Save Template As...** to open **Utilities\File: template_saveas** dialog.

5. Input **MyPeakTemplate** as **Template Name**. Now we want to use **Raman Spectrum + Workbook Long Name** as graph Long Name. To do so, click more options button next to **Preset Graph Long Name** edit box and select **@WL: Book Long Name** to insert the right part first. Then input **Raman Spectrum** in front of added %%(1, @WL).

6. Make sure **Mark as Cloneable Template** box is checked, expand this node and match up the columns and worksheets by setting **Match Plot Columns by** and **Match Sheet by** to **Index**.

7. Click **OK** button to exit the dialog and save the template.
6.2.6.3.2 Clone a Graph Using Cloneable Template

1. Activate the workbook with title **Peak2** and click **Plot: Template Library** to bring to open the Template Library.
2. Click to select the cloneable template (indicated by Dolly icon) **MyPeakTemplate** and click **Plot** button to clone the graph.
3. Alternatively you can activate workbook Peak2 and go to menu Plot: My Templates: MyPeakTemplate (UserDefined) to directly clone the graph.

6.2.7 Adding a Data Plot to Existing Graph

Videos
- Add Plots to a Graph by Drag and Drop
- Adding, Grouping and Reordering Plots with Layer Contents
- Copy Data from Worksheet or Matrix to Graph
- Group and Ungroup Plots in Object Manager
- Use Object Manager to Reorder Plots
- Customize the Legend
- Combining Metadata in Legend

OriginBlog
- Plotting grouped column with mean values
6.2.7.1 Summary

Sometimes, once you have plotted a dataset into a graph layer, you might desire to plot one more dataset into the same graph layer.

Four methods might be available for this case:

- **Drag and drop dataset into the graph layer**
  You can add data to a graph by drag-and-drop. When using this method, Origin relies on worksheet Column Plot Designations to create the plot.

- **Use Plot Setup dialog to add the plot**
  The Plot Setup dialog can be used to add/reorder/arrange data plots in an exiting graph. This dialog provides flexibility in selecting the source data sheet and in specifying how data are to be plotted.

- **Use Layer Contents dialog to add the plot**
  The Layer Contents dialog box is used to add or remove data plots from a graph layer, group and ungroup plots, and reorder (change the drawing order of) the data plots.

- **Use Copy Plot button in mini toolbar to add an existing plot into the graph layer**
  Since Origin 2020, you can use the Copy Plot button in mini toolbar to copy one plot from a graph and paste this plot into another graph layer. In this way, you can add an existing plot into another existing graph layer.

6.2.7.2 What you will learn

This tutorial will show you how to:

- Use drag-and-drop to add data to a graph layer
- Use the Plot Setup dialog to add data to a graph layer
- Use the Layer Contents dialog to add data to a graph layer
- Use mini toolbar to copy a plot and paste it into a graph layer
- Group the plots in Object Manager
- Use the Legend Update dialog to modify the graph legend

6.2.7.3 Steps

6.2.7.3.1 Inputting data and plotting

1. Click the New Project button on the Standard toolbar, to begin with a new project.
2. Click the Import Wizard button on the Standard toolbar. The Import Wizard opens. (Note that if this is the first time that you have started the Import Wizard, you will experience a slight delay as Origin compiles the necessary files.)
3. Verify that the ASCII radio button is selected in the Data Type group.
4. Click the browse button to the right of the File text box. Navigate to the Origin folder; browse to the Samples folder and then the Import and Export folder.

5. Press CTRL and select files S15-125-03.dat, S21-235-07.dat, and S32-014-04.dat, then click Add Files.

6. Click OK.

7. Leave the Import Filters for current Data Type as Data Folder: VarsFromFileNameAndHeader. (This filter has the settings to use when importing the file.)

8. Set the Import Mode as Start New Sheets.

9. Click the Finish button. The three data files import into the workbook, each as a new sheet. You will have a book with three sheets: Trial Run 1, Trial Run 2, and Trial Run 3.

10. Select the Trial Run 1 sheet, highlight the D(Y) column. Click the Line button on the 2D Graphs toolbar. A new graph is created and named as Graph1.

### 6.2.7.3.2 Adding plot by Drag-and-Drop

1. Right-click on the title bar of Graph1 to select Duplicate from the context menu to duplicate the graph window.

2. Activate this new graph window, and move it to the gray space of Origin workspace (make it not be covered by the source workbook).

3. Click to select the second sheet "Trial Run 2" of source workbook, and then click on the column header of col(D) to select it. Move the cursor to the right border of col(D) until the Drag-and-drop icon appears.

4. Then you can drag-and-drop the column into the graph window.

5. A new curve will be added into the graph.

6. Click to select the third sheet "Trial Run 3" of source workbook and select its col(D) and drag-and-drop it into the graph window to add one more curve into the graph layer.

7. Now, you have a graph with three curves in the layer.
Alternately, you can use Copy for Plotting button on the mini toolbar to add the plot in step 3 and 4. That is

3. Click to select the second sheet "Trial Run 2" of source workbook, and then click on the column header of col(D) to highlight it. Click the Copy for Plotting button on the mini toolbar that appears.
4. Activate the graph window. Right-click on the white space inside the layer to select Paste: Paste from the context menu.

6.2.7.3.2.2 Using Plot Setup

1. Right-click on the title bar of Graph1 to select Duplicate from the context menu to duplicate the graph window.
2. Activate the new graph window, right-click on the layer 1 icon in the upper-left hand corner of the graph and choose Plot Setup.

   ![Lightbulb Icon]

   There are three panels in the Plot Setup dialog. Expand the Plot Type panel by clicking then expand the Available Data panel by clicking the second button.

   Please refer to Plotting using Plot Setup for more information.

3. Select Layer 1 in the Plot List of bottom panel. Press Ctrl key to select Trial Run 2 and Trial Run 3 simultaneously from the Available Data list (the top-most of the three panels). in the middle panel, select
**Time** as X and **Position** as Y. Click **Add** button to add these two data into the graph layer.

6.2.7.3.2.3 Using Layer Contents

1. Right-click on the title bar of Graph1 to select **Duplicate** from the context menu to duplicate the graph window.

2. Double-click Layer1 icon to open the **Layer Contents** dialog.

   **Alternately,**
   
   you can choose menu **Insert: Plot to Layer** to open the **Layer Contents** dialog.

3. In the dialog, select Col(D) of **Trail Run 2** and **Trail Run 3** both in the left panel and then click the button to add these two columns into the graph layer Layer1.
4. With the two new plots has been selected in right panel, click **Ungroup** button to ungroup them firstly. We will group all these three curves together later.

5. Click OK button to close the dialog.

**6.2.7.3.2.4 Using mini toolbar**

1. Highlight col(D) of sheet “Trail Run 2” to select **Plot > Basic 2D: Line** menu to plot a new graph with one curve.

2. Highlight col(D) of sheet “Trail Run 3” to select **Plot > Basic 2D: Line** menu to plot another new graph with one curve.

3. For these two graphs, click on the curve, in the popup mini toolbar, click the **Copy Plot** button to copy current plot. Activate Graph1 you created at the beginning back, right-click on the white space of the layer to select Paste: Paste from the context menu to paste the curve to the graph layer.
4. Once you copied and pasted all these two new plots into Graph1, you will get a graph with three curves.

6.2.7.3.3 Grouping plots in Object Manager

Once you had added multiple curves into the existing graph layer, these curves might not be grouped which makes you not be able to apply incrementing line formats (such as Line color and Line styles).

Now, let us group these plots.

1. Activate the graphs with three curves. At the right-top corner of the workspace, there is a panel named as "Object Manager" and listing all plots in current graph.

2. Right-click on the last plot to select Set as Group End from context menu.
3. You can see these three curves have been grouped and with incrementing line color.

6.2.7.3.4 Updating the Graph Legend

The existing graph legend uses the names of the imported data plots. We will modify the legend to show the sheet name.
1. Right-click on the legend object and choose **Legend: Update Legend**.
2. From **Auto Legend Translation Mode**, choose **Custom**.
3. For **Legend Custom Format**(@D, @LU etc), click the arrow to the right and choose @WS: Sheet Display Name and click **OK**. The graph legend now reads **Trial Run 1**, etc.

For more information on customizing the default legend, see these topics:

- **Graph Legends**
- **Legend Text Customization**

### 6.2.8 Smart Peak Labels with Leader Line

**Videos**

- Find peaks, Label peaks, and Remove Unwanted Labels
- Labeling Graphs with the Annotation Tool
- Customizing Annotation Labels
- Customize a Single Point

**OriginBlog**

- **Delete Peak Labels**

### 6.2.8.1 Summary

For the line/symbol plot in 2D Cartesian coordinate system, Origin supports smart labels which can be auto re-positioned to avoid overlapping. Leader lines (both straight lines and oblique lines) can be added to connect the data points and their labels.
6.2.8.2 What you will learn

This tutorial will show you how to:

- Add smart labels with leader lines
- Add a special data point and customize its label

6.2.8.3 Steps to Add Smart labels

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data.opj and browse to the Smart Peak Labels with Leader Line folder in the Project Explorer.
2. There are two sheets in A100527IR workbook. 100-52-7-IR is an IR absorbance data and Peak_Centers1 are peak center result found by Origin's Peak Analyzer tool.
3. Highlight Col(B) in sheet 100-52-7-IR to plot a line graph by selecting Plot > Basic 2D : Line menu.
4. Double click on layer 1 icon to open the Layer Contents dialog. Select col(pcy) in left panel. Click the dropdown list next to A button in the middle and select Scatter as plot type. Click -> button to add the data into the graph.
5. In the **Plot Details** dialog, select second plot in the left panel, go to **Symbol** tab, do following settings:

6. Go to **Label** tab, check the **Enable** check box, do settings as below:
7. Click on the Apply button, you will see the some labels are overlapped.

8. Go back to Label tab, check the Auto Reposition to Avoid Overlapping check box, select Y for the Reposition Direction drop-down box and set the Leader Lines group as below. Also set Vertical Offset to be 170 so the leader lines are more obvious.
9. Click OK button to close the dialog. You will see the labels are repositioned smartly.

6.2.8.4 Steps to Customize a Single Point and its Label

1. The highest peak's label can't be seen. Double-click on the Y axis to open the **Axis** dialog, go to **Vertical** icon in **Scale** tab, change **From** and **To** to -0.05 and 0.8, then click OK to apply the setting.
2. Press CTRL key down and double click the highest peak's label 1730 to open Plot Details dialog. A node 18 shows on left panel. It's the row indexing of the special point.

3. Go to Label tab of this point and customize the further.

4. Go to Symbol tab to change the symbol shape and size.

6.2.8.5 More Customization Steps

The following steps can further customize the graph to be exactly the same as the image in Summary.
1. Double click X axis to open **Axis** dialog. Set **From** and **To** for X axis to be 400 and 3500.

2. To show top and right frames around the graph, select **Grids** tab in **Axis** dialog. Check **Opposite** check box under the **Additional Lines** branch for both **Horizontal** and **Vertical**.

3. To change the layer size, select **Format: Layer...** from main menu to open the **Plot Details** dialog. On **Size/Speed** tab, change the layer size in the **Layer Area** group as below:

4. Select legend and press **Delete** key to delete the legend.

### 6.2.9 Error Bars with Fill Area

- **Fill Area Between Curves**
- **Plot Error Bars in 2D Graph**
- **Plot X and Y Error Bars**
- **Plot Mean and SD of data as Bar with error bar**
- **Plot Data with Different Y Plus and Minus Error Bars**
- **Creating Custom Colors**

### 6.2.9.1 Summary
This graph displays three datasets with error bars. The error bars have been set to draw as lines with fill areas. Transparency has been set for all three curves so that data in overlapping regions can be clearly seen.

Minimum Origin Version Required: Origin 8.5.1 SR0

6.2.9.2 What you will learn

- Plot the error bar with fill area
- Set transparency for error bar
- Set and save custom color

6.2.9.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Line and Symbol)

1. Open Tutorial Data.opj and browse to the Error Bars with Fill Area folder in Project Explorer (PE).

2. Highlight all columns in the worksheet. In the main menu, select Plot > Basic 2D : Line.
3. Click on one error bar of three plots, and click one the **Fill Area** button in the Mini Toolbar.

4. Click on one plot line, and then click **Line Color** button in the Mini Toolbar. Under the **By Plots** tab, press Ctrl key and click the color list to open the **Increment Editor** dialog.
5. In **Increment Editor** dialog, you can custom the color list. Click on the first color in the list, then click on the add color well under Custom to open **Color** dialog. Enter the color Hex code **9BBB59** to create a custom color as below:
6. Customize the second and third color as Hex(#C0504D), Hex(#4F81BD) respectively. Delete other color in this list and save this color increment list. Then this new color list will be set as increment list for the plots.

7. Click on one plot line again, and set **Line Thickness** to 3.

8. Double click on one plot line to open the **Plot Details** dialog, and set the **Transparency** to 50%
9. Click on the error bar of three color one by one to set the Fill Color to Hex(#9BBB59), Hex(#C0504D) and Hex(#4F81BD) respectively.
10. Click on the Enable/Disable Anti-Aliasing button to smooth the graph.

6.2.10 Mark out a segment of plot with different plot style

6.2.10.1 Summary

In Origin, you can mark out a segment of plot with different plot style, such as a segment of dashed in a solid line plot.

Minimum Origin Version Required: Origin 8.0 SR6

6.2.10.2 What you will learn

- Use the Plot Setup dialog to create a graph
- Mark out the special segment of a plot

6.2.10.3 Steps

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the “Samples” folder. In this folder, open the Graphing subfolder and find the file AXES.DAT. Drag-and-drop this file into the empty worksheet to import it.

2. Click the button on the Standard toolbar to create a new graph window and then select Graph: Plot Setup from the main menu to bring up the Plot Setup dialog.

3. Show all of the three panels of the Plot Setup dialog. Select the AXES worksheet in the top panel. Then go to the middle panel to select A as X and B as Y. After that, click Add to add this data plot to the
Repeat this step three times. Three data plots should be listed in the bottom panel.

4. In the lower panel, click in the Range column that corresponds to the first data plot. The button should be activated. Then click this button to open the Range dialog box.
5. Clear the **Auto** check boxes (if they are selected) and then set **From** to 1 and **To** to 20. Click **OK** to close the dialog.

![Range dialog]

6. Similarly, set the ranges for other two data plots to "20 to 30" and "30 to 40" respectively.

![Plot Setup dialog]

7. Click the **OK** button to close the **Plot Setup** dialog. You should get a graph like this:

![Graph1]

---

Tutorials for Origin 2024b
8. Double-click on the curve in the graph window to open the **Plot Details** dialog. Select the second data plot from the left panel. In the right panel, change the **Style** to **Short Dash**, and then click the **Ok** button.

9. Finally, we get the plot with a range marked out.

### 6.2.11 Overview of Customization
6.2.11.1 Summary

Editing your Origin graph is very easy. Any graph element can be selected and with its associated dialog, the properties can be modified. In fact, you can customize your graph right down to a single data point.

This tutorial will show you how to:

- Resize a Layer
- Add a Layer Title
- Customize and Save a Template
- Customize Axes
- Apply a Graph Theme
- Change Plotting Order in a Layer
- Customize a Point
- Customize a Grouped Plot
- Create a Color-mapped Waterfall Plot

6.2.11.2 Re-sizing Layer

1. Open *Customizing Graphs.OPJ* from the *\Samples\Graphing* folder and select the *Resize Graph and Customize Symbol* folder from the *Project Explorer* window.
2. Make Graph2 active and right-click inside the layer, above the data points to select Add/Modify Layer Title from the context menu that opens. Add a title, as shown in the graph below:

![Graph2](image1)

3. The layer can easily be resized graphically by dragging the sizing handles. To resize it, single click inside the layer, but not on a data point. The layer will become selected as seen below, and then you can drag one of the 8 anchor points to resize the layer. Note: If you hold the CTRL key down while dragging, the aspect ratio will be maintained.

![Graph2](image2)
4. You can also use the Plot Details dialog by specifying exact numbers to dictate the layer size more precisely. Double-click inside the layer to open the Plot Details dialog. On the Size/Speed tab, set the layer area to the values shown in the image below:

![Layer Area](image)

Note: Check the Link Axis Length to Scale with X:Y Ratio check box to set the length ratio of X and Y axes (the Width and Height of the layer frame) to maintain the aspect ratio of the actual X and Y scales when the layer size is changed. You can set your own ratio value in the following box.

6.2.11.3 Customize Data Plot and Axes

In this section, we will show you how to change the color of a data plot, and customize the axes.

1. Click on one of the data points of Graph2 to select the entire data plot, and change the color of the data points to red by using the Line/Border Color button in the Style toolbar.

2. Next use the Axis dialog to customize the axes. Double-click on the X-axis to open the dialog and set the controls as follows:
   - Select the Horizontal icon in the Scale tab, select the Type under Major Ticks as By Counts and input 5 as the Count.
   - Select the Vertical icon in the Scale tab, set the From as 0, To as 16, Type for Major Ticks as By Counts and enter 11 for Counts.
   - Go to the Line and Ticks tab and select both Top and Right page with CTRL button pressing down. Check the Show Line and Ticks box to show the line and ticks for the top X and the right Y axis. Click OK to apply the settings and close the dialog. The graph should appear as shown.
6.2.11.4 Save and Reuse a Template

In this section, we will show you how to save the graph above as a template and reuse it.

1. In the menu, select **File: Save Template As** (alternatively, right-click on the graph window title bar and choose **Save Template As** from the context menu) and rename the template as **MyGraphTemplate.**
Then click the **OK** button to save it.

2. Create a new workbook and import the data file `\Samples\Curve Fitting\Sensor2.dat`, by using **Data: Connect to File: Text/CSV**. Highlight column B and select **Plot: My Templates: MyGraphTemplate** to create a graph.
The graph should look like:

Note, you can also use the batch plotting tool to create multiple graphs at once from different worksheets/workbooks with same data structure. You can learn how this tool work from this tutorial.

6.2.11.5 Changing graph using theme

Origin stores the properties of a graph in a theme file. In this section we will show you how to customize a graph by using a theme.

1. With Graph3 active, select Preferences: Theme Organizer to open a dialog. Select the Times New Roman Font theme and click Apply Now. Select Ticks All In and click Apply Now, then click the Close.
button to close the dialog. The graph should resemble the following graph:

2. The next step is to copy the formatting of the current graph and paste it to Graph2. Right-click to the right of the layer, anywhere on an empty white or grey space and select **Copy Format: All Style Formats**. Activate Graph2, right-click in a similar spot and select **Paste Format**. Graph2 should look like the image below:
6.2.11.6 Plotting Order

You can reorder the data plots either by the Layer Contents dialog, Object Manager or the Plot Setup dialog.

Open Customizing Graphs.OPJ from the \Samples\Graphing folder and select the Plotting Order folder from the Project Explorer window.

6.2.11.6.1 By Layer Contents Dialog

1. Activate Graph 1 window. Double-click on the Layer 1 icon on the top left corner of the graph to open the Layer Content dialog.

2. Click the >> button to hide the left panel. In the right panel, select the Gauss Fit Count line plot. Click the downward pointing arrow button to move the line plot down in the plotting order.

3. Click the Apply button. The Gauss Fit Count line plot is now on top of the column plot. Click the Close button to close the dialog.
6.2.11.6.2  By Object Manager

1. Activate Graph 1 again. Expand the **Object Manager**, which should be docked to the right edge of Origin workspace by default, by moving your mouse over to the **Object Manager** bar.

2. Right-click on the Gauss Fit Count line to select Move Up from context menu to move this plot upward.
3. Then, you will see the red line will be back of the histogram plot.
6.2.11.6.3 By Plot Setup Dialog

1. Use the same data as the previous example. In the Plotting Order folder activate Graph 1. Select Graph: Plot Setup from the main menu to open the Plot Setup dialog (You can also right-click on layer 1 and select Plot Setup...).

   In order to show all three panels in Plot Setup dialog, please expand Plot Type panel by clicking and expand Available Data panel by clicking again.

2. In the Plot List panel, drag the line plot and drop it beneath Column/Bar Plot Type.
3. Click the **OK** button and you will see that the red curve is now drawn on top. Notice the legend reflects the new plotting order as well.

![Graph1](image)

6.2.11.7 **Customize points**

In this section, we will show you how to customize a single data point.

1. We will continue to work in the **Plotting Order** folder. Make sure **Graph 1** is active. Note that if you click to select one of the columns, all columns are selected. Click again to select just that one column. Change the color to **green** using the **Fill Color** button on the **Style** toolbar.

2. You can also use the **Plot Details** dialog to customize single columns separately from the rest. Hold down the CTRL key while double-clicking on the columns to open the **Plot Details** dialog. The settings in this dialog will edit the properties of just that single data point. Note that the index number for that selected data point is highlighted in the left panel of the Plot Details dialog. Set the **Gradient Fill** group as follows, to fill the column with a yellow to red color gradient.
Your graph should resemble the following image:

3. You can customize a pie chart segment in the same way. In the Edit Single Data Point folder, activate the pie graph. Hold down the CTRL key and double-click on one of the slices to open the Plot Details dialog. Under the Pattern tab, set the Fill Pattern to Dense, and set Pattern Color to Red. (Alternatively, you could have clicked once and then clicked again on a slice to select just that one point,
and then used the Style toolbar to customize that point.) The graph should appear as the image below:

4. You can customize a single data point and label it. Go back to the **Resize Graph and Customize Symbol** folder. Hold down the CTRL key and double-click on one of the scatter points to open the **Plot Details** dialog. Under the **Symbol** tab, click the triangular **Preview** button to open the symbol gallery, and select **Sphere** for the symbol type. Increase the **Size** to 18, and click the **OK** button to close the dialog.

5. Use the annotation tool to add the X and Y values that correspond to the customized data point. Select the **Annotation** button from the **Tools** toolbar (Hint: The Data Reader, Annotation and Data Cursor tools are grouped. If you don't see the Annotation tool, click the arrow to the lower-right of whichever tool is visible on the toolbar).

Move the annotation cursor to the customized data point and double-click on it. Origin will automatically add a text object. Hit the ESC key or click on the Pointer button to exit annotation mode. Single-click and drag to position the text object. A line will automatically be drawn connecting the point and the label.
Right-click on the text object and select the Properties... to open the Annotation-Text dialog. Then you can customize the text label format in the this dialog. In the Text tab enter \%(1,\text{LL})=\$(Y,2)\ %\(1,\text{LU}\) in the edit box. And the button to the right of the edit box
Graphing provides some frequently used notations and example syntax.

Beginning with Origin 2017, you can drag annotation labels from point to point. Click the Pointer button, press the ALT key and use the cross-hairs to drag the label to another data point.

6.2.11.8 Group plots

So far, we have been customizing data points in a single data plot. In this section, we will show you how to customize a grouped data plot.

1. Select the Grouped Data folder. Book3 will be active. Highlight the entire worksheet and click the line button on the 2D Graphs toolbar to create a line graph.

2. Double-click on the X-axis to open the Axes dialog box. Set From as 0.5 and To as 3.0. Select Fixed from the Rescale drop-down list (you will need to scroll up in the list). This prevents the From and To values from changing while rescaling. Click OK to apply these settings.

3. Double-click on a blank place above the line plots, to open the Plot Details dialog. On the Stack tab, select Auto in the Offset group. Click OK to close the dialog.
4. Select **Graph: Rescale to Show All**. The Y scale of the graph automatically rescales, while the X scale doesn’t change because the option was set to Fixed. Resize the layer and drag the legend to the desired spot.

5. Click on one of the data plots to select the entire group, and then use the **Line/Border Color** button on the **Style** toolbar to change the colors. Click on **By Plots** tab, select **Q03 Rainbow7** from the
Increment List as below.

6. Then select the first increment list. The graph should look like this:

7. Though these data plots have been grouped, you can also customize each of them individually by clicking on the data plot twice. For example, clicking the yellow data plot twice (click once, pause and click again) and then clicking the Line/Border Color button \( \text{on the Style toolbar} \) will change the color to another color, such as Olive.
8. You can also customize the graph by double-clicking on one of the data plots to open the **Plot Details** dialog. Under the **Group** tab, you can click the browse button...

<table>
<thead>
<tr>
<th>Increment</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Color</td>
<td>By One</td>
</tr>
<tr>
<td>Line Style</td>
<td>None</td>
</tr>
</tbody>
</table>

...to open the **Increment Editor** dialog. In this dialog, customize the graph as shown in the following image. Note that you can also drag the index of a row and move it to change the order of the color list.

9. Right-click on the inner position of this dialog and select **Save Increment List** to save it as **MyPalette** for future use. Right-click to get the context menu and select the **Load Increment List** option. You will
find that **MyPalette** appears as the first entry in the fly-out menu, as the following image shows:

In the following section, we will show you how to use **Palettes** to set colors for a group of data plots.

1. Activate **Book3** and highlight all the columns. Select **Plot > 3D: Waterfall** to create a graph. Double-click on the X-axis to open the **Axis** dialog, and set **From** as 0.5 and **To** as 3 in **Scale** tab. Select **Y** icon from the **Selection** list, and set the **From**, **To**, and **Increment** of **Major ticks** option to **-10**, **100** and
2. Click on one of the data plots and use the Line/Border Color button on the Style toolbar to change the colors. You can select the Rainbow palette under Palettes list in the By Plots tab. The graph should resemble the image below:
3. You can double-click on one of the plots to get the color list, as the following image shows:

You can find that the **Increment** has been set to **Binned**, so colors are picked from the 256 available in the **Rainbow** palette.

4. We will change the palette to **Reef** by clicking on the browse button to open the **Increment Editor** dialog. Then right-click on the inner portion of this dialog and select **Load Palette : Reef**, then click **OK**. The color list in the **Plot Details** dialog should be set as shown below:
Click on Ok button to close the Plot Details dialog. The graph should appear as shown below:

6.2.12 Plotting Overlapping Data and Setting Transparency

6.2.12.1 Summary

In this tutorial, we will show you how to create overlapping column plots, and then set transparency to make the overlapping parts visible.

6.2.12.2 What you will learn
This tutorial will show you how to:

- Customize the grouped column plots
- Set Transparency

6.2.12.3 Steps

1. Select Help:Learning Center menu to open Learning Center dialog. Select Graph Sample item in the left panel and then select Column and Bar Chart for Samples in drop-down list. Double-click on the thumbnail below to open the folder Overlapped Bars.

2. Highlight all columns in the worksheet [Counts]Sheet1 (The source data Counts.dat can also be imported from the folder <Origin Installation Directory>\Samples\Graphing\), and then from the menu, select
Plot>Basic 2D: Column to create a column graph.

3. Click on any bar in the graph, and in the popup mini toolbar, click the **Fill Color** button under the **Group** tab to expand the Color Chooser. In the Color Chooser, under the **By Plots** sub-tab, select or click the color list or color palette in the you desired to apply the bar colors.
Besides, you can also double-click on the plot to open the **Plot Details** dialog. In the dialog, choose the **Group** tab. Click on the **Details** button in the **Fill Color** row to open the **Increment Editor** dialog. In this dialog, you can set the first three colors to be some specific colors such as Royal Blue, Orange, and Dark Cyan. Click OK to close the dialog.
4. Double-click on the plot to open the **Plot Details** dialog, go to the **Pattern** tab in Plot Details, and set the **Transparency** control to 51%.

5. Select the **Spacing** tab, and set **Gas Between Bars** to zero and **Overlap** to 100.
Click the **OK** button to close the Plot Details dialog. Select **View: Show: Frame** to add the frame. The resulting graph should look like the image below:

![Graph](image-url)

### 6.3 Axis

#### 6.3.1 Axis

- **Multiple Axis Breaks**
- **User-Defined Arbitrary Tick Positions**

#### 6.3.2 Multiple Axis Breaks

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="video-url" alt="Video" /></td>
<td><img src="blog-url" alt="Blog" /></td>
</tr>
</tbody>
</table>

- **Add Multiple Axis Breaks to show details in one region**
- **Axis scale after break**
- **Multiple Axis Reference Line and**
6.3.2.1 Summary

Origin supports multiple breaks on an axis as shown below. The number of breaks and the break positions can be customized in the Axis dialog box. Furthermore, you can add recession bars (the "vertical bars" shown as below) by adding multiple reference lines on the X axis and fill the gaps between them.

Minimum Origin Version Required: 2017 SR0

6.3.2.2 What you will learn

This tutorial will show you how to:

- Add multiple breaks to both X and Y axes
- Customize axis tick label format
- Fill spans that are broken by missing values vertically

6.3.2.3 Steps to Customize Label Display and Add Axis Breaks

This tutorial is associated with the Multiple Axis Breaks folder of the sample project <Origin EXE Folder>|Samples|TutorialData.opj. Also, you can see this graph in Learning Center (Select Help: Learning Center menu or press F11 key). It is listed under the Line and Symbol sample graph table. Double-clicking on the thumbnail will open the target folder.

1. Activate the workbook. Highlight Col(A) and Col(B) and select Plot > Basic 2D: Line from the main menu to plot a line graph. Select and delete the legend.
2. To customize the graph axes, click on the bottom axis, and then select **Axis dialog** from the drop-down list of the last button in the Mini toolbar.

3. In the **Scale** tab for **Horizontal** axis in the dialog, set the X axis scale as graph below:
4. Go to **Bottom** icon in **Tick Labels** tab, change the display format of tick labels to **20** (means year as **yy**) and add a prefix ' **'.
5. In order to add several breaks to the X axis select the **Horizontal** icon in **Breaks** tab. Check the **Enable** box and set **3** axis breaks.

6. Click the **Details...** button to open the **Breaks Details** dialog, set **Break1** from **12/1/1961** to **9/1/1972**: 
7. Select the Break 2 node in the left panel, change it to be from 3/31/1977 to 8/29/1980. Switch to Break 3 node, change it to be from 7/27/1984 to 3/1/2007. Click the OK button to apply and exit the Break Details dialog and in the Axis dialog, click the Apply button to view the changes.

8. To customize the Y axis, select the Left icon under the Tick Labels tab and use the format Engineering:1k as the tick label display. Set the prefix as "\$". Click Apply to view the changes in the graph.
9. Go to the **Breaks** tab again and with the **Vertical** tab selected, enable 2 axis breaks at scale value **3.1 T** to **4.5T** and **6.7T** to **12.5T**, as we had done for the X axis in Step 4 to 6.

10. Click **OK** to apply the settings and get the graph similar as follows:

Once axis breaks are added to the graph axis, you can customize their appearance by clicking on the axis break and using the Mini Toolbar buttons for changing break symbol length, symbol gap, symbol shape, etc.
6.3.2.4 Steps to Add Recession Bars

1. Double-click on X axis to open the Axis dialog. Go to Reference Lines tab, click the interactive button beside the Reference Lines at Value text box to select col(C) from worksheet. The x coordinates of all recession periods will be listed in the display table as reference lines. Then check Alternate Fill box to fill each period.
2. Click **OK** to apply the settings.
6.3.2.5 More Customization Steps

The following steps can further customize the graph to be exactly the same as the image in Summary.

1. Double click X axis title **Date** in the graph and rename it as **Year**.

2. To change Y axis range, click on the left axis, and then select **Axis dialog** from the drop-down list of the last button in the Mini toolbar. In the **Scale** tab for **Vertical** axis in the dialog, set From, To, Major and Minor ticks as below.
3. Go to the Breaks tab again, select the first axis break and click Details to open the Break Details dialog with the Break 1 node selected. Clear the Auto check box next to the break position option and change it to 38%. Clear the Auto Scale check box and then change the tick settings as below:
4. Select **Break 2** node, set break position, Major Ticks and minor ticks as below:
5. Click **OK** to apply and exit the **Breaks Details** dialog. Click **Apply** in the **Axis** dialog to apply settings.

6. Select **Grids** tab. Select both **Vertical** and **Horizontal** icons on the left panel, check **Opposite** to show a frame around top and right axes.

7. Right click in a blank area inside graph layer 1 and select **Add/Modify Layer Title** from the context menu. Enter *US Recessions and Recoveries* as the layer title.

8. Adjust the page dimension with Graph node selected in **Plot Details** dialog.
6.3.3 User-Defined Arbitrary Tick Positions

This graph will show you how to specify tick locations using a dataset and show customized tick labels at those locations.
Minimum Origin Version Required: Origin 2015 SR0

6.3.3.2 What you will learn

- How to specify the tick location using dataset
- How to show the customized tick labels

6.3.3.3 Steps

1. Copy the sample data, and paste it into row 1 of column A in Origin worksheet. Set the first row as Long Name and the second row as Units.
2. Highlight columns A and B. Select **Plot > Basic 2D :Line + Symbol** from the main menu. Alternatively, you can simply click the Line + Symbol button on the **2D Graphs** toolbar.

3. Double-click the graph to open the **Plot Details** dialog. On the **Symbol** tab, change the symbol to a solid circle, and the color to **Olive**. On the **Line** tab, change the line color to Olive and click **OK** to close the dialog and apply the changes.
4. Double-click the X axis to open the **Axis** dialog. For both **Horizontal** and **Vertical** icon in **Scale** tab, enter these settings for the X and Y axes:
Tutorials for Origin 2024b

Enter space-separated position values OR select a dataset from drop-down.
5. On **Line and Ticks** tab, go to **Top** and **Right** page, and check on **Show** to show the axis on top (right), Set the ticks style follows the graph below:
6. Then, click the **Apply To...** button and go to the **Apply to Others** dialog, set the following:
7. Click **OK** to close the **Apply to Others** dialog and return to the **Axis** dialog.

8. Go to **Display** tab in **Tick Labels** tab, and set the ticks Labels for bottom follows the graph below. In addition, you need to rotate the tick labels by 90 degree in **Format** tab for both top and bottom (which can be done in **Bottom** page) axis.
9. On the **Bottom** page under **Tick Labels** of **X Axis**, set the **Rotate(deg.)** to **90** similarly.

10. Select the **Grids** tab in Axis dialog axis. Check on **Show** in **Major Grid Lines** group for both **Vertical** and **Horizontal**:
11. Click OK to close the Axis dialog. Adjust the Layer Area in **Format: Layer: Size/ Speed** tab. Your final graph should look like this:
6.3.3.4 Sample Data

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Transducer Output</th>
<th>Custom Temperature</th>
<th>Custom Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>°K</td>
<td>volts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.5</td>
<td>1.5</td>
<td>4.2</td>
<td>He Boiling Point</td>
</tr>
<tr>
<td>2.5</td>
<td>1.5</td>
<td>4.2</td>
<td>He Boiling Point</td>
</tr>
<tr>
<td>7.3</td>
<td>1.42048</td>
<td>77.36</td>
<td>N Boiling Point</td>
</tr>
<tr>
<td>13</td>
<td>1.28681</td>
<td>233.15</td>
<td>-40°C/-40°F</td>
</tr>
<tr>
<td>24</td>
<td>1.06011</td>
<td>273.15</td>
<td>0°C</td>
</tr>
</tbody>
</table>
6.4 Layers

6.4.1 Layers

- Merging and Arranging Graphs
- Multiple Layers with Linked Axis
- Multi Layer Graph Customization

6.4.2 Merging and Arranging Graphs

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>41</td>
<td>0.90549</td>
<td>373.15</td>
<td>H₂O Boiling Point</td>
</tr>
<tr>
<td>70</td>
<td>0.85831</td>
<td></td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>0.7679</td>
<td></td>
<td></td>
</tr>
<tr>
<td>181</td>
<td>0.63948</td>
<td></td>
<td></td>
</tr>
<tr>
<td>246</td>
<td>0.53202</td>
<td></td>
<td></td>
</tr>
<tr>
<td>288</td>
<td>0.40753</td>
<td></td>
<td></td>
</tr>
<tr>
<td>348</td>
<td>0.24898</td>
<td></td>
<td></td>
</tr>
<tr>
<td>399</td>
<td>0.13759</td>
<td></td>
<td></td>
</tr>
<tr>
<td>436</td>
<td>0.09435</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Videos

- Link Graph Layers
- Align legend, multi-line text, layer & text

OriginBlog

- Make Stacked Graph with Same Axis Unit Length
Tutorials for Origin 2024b

- Merge Graphs
- Merge 2D and 3D Graphs into one Window
- Merge Graphs in Specified Order and Label Them

- Plot Multi-Panel Graphs by Group

6.4.2.1 Summary

The Merge Graph Windows dialog allows you to select which graphs you wish to combine, choosing from any graph in the project. It also has controls to specify how you want the individual graphs arranged on the new page.

The Object Edit toolbar allows you to quickly align and size multiple layers.

The Layer Management dialog lets you add, arrange and link layers on a single graph page.

The Mini Toolbar (Since Origin 2020) lets you edit the graph elements more easily and interactively.

6.4.2.2 What you will learn

This tutorial will show you how to:

- Resize and align layers quickly
- Add a second axis using a nonlinear relationship with the primary axis
- Use Layer Management for more complex layer positioning and linking
- Merge multiple graphs into one graph

6.4.2.3 Aligning Layers using the Object Edit Toolbar

1. Select File:Open and open the OPJ \Samples\Graphing\Layer Management.opj and go to the subfolder Arranging Layers. (If you don't see the subfolders, click View: Project Explorer to open the Origin Project Explorer window.)

2. We want to use the Object Edit tools to rearrange the graph so make sure that this toolbar is visible. If it is not, you can open it from the View: Toolbars dialog box.

3. On the graph, hold the Shift key down and click on all four layers to select them as a group. Press the Uniform Width and Uniform Height buttons on the Object Edit toolbar to apply a uniform height and width. Then click on the white space in the layer to deselect all graph layers.

4. Hold Shift key to click and select the bottom two layers and then click the Bottom button on the Object Edit toolbar to align them. Click on the white space in the layer to deselect all graph layers.

5. Hold Shift key to click and select the top two layers, then click the Top button to align them. Click on the white space in the layer to deselect all graph layers.
6. Click and select the top and bottom in the left column, and click the **Left align** button. Click on the white space in the layer to deselect all graph layers.

7. Click and select the two in the right column and click the **Right align** button.

8. Do not save changes to your project, as the same project will be used later to demonstrate the usage of Layer Management.

The Object Edit toolbar provides a quick way to align and resize layers. The first layer you select is the reference layer and all others are adjusted relative to the first-selected layer. The **Layer Management** tool provides additional options such as layer reordering and linking.

Another way to select layers in a multiple layer graph is to press CTRL or SHIFT while clicking on the graph layer icons.

6.4.2.4 **Displaying Opposite Axes with a Nonlinear Formula**

An Origin 2D graph layer is a set of X, Y axes, and opposite axes can be turned on for both X and Y. In addition, the opposite axes can also display labels using any user-specified nonlinear formula with respect to the primary axis.

1. Using the Project Explorer window, switch to the subfolder named **Nonlinear Axis**.
2. Activate the graph window, click on the bottom X axis lines, the minitoolbar will pop up. Click the Show Opposite Axis button to show the top X axis.

3. Then, the top X will appear on the layer. Click on the axis line to expand the minitoolbar, click the Show Tick Labels button to show the axis labels and then click Tick Style button to set the tick to In.

4. Double-click on the axis labels of top X axis to open the Tick Labels tab of Axis dialog. We want to display the labels on the top axis in units of Energy and the relationship between wavelength(bottom X) and energy(top X) is:
Energy (eV) = 1240/Wavelength (nm). So enter $1240/x$ in the **Formula** box.

5. Click OK button. The axis labels shows the correct relationship with bottom X.

- If you are setting up a nonlinear relationship for the right Y-axis, in the **Formula** you still need to use $x$ instead of $y$.
- You can also do similar settings in the **Graph: Layer Management** dialog to add such opposite axis:
Layer Management

Layer Selection

1. Layer1

Modify Axes

- X Scale: Linear
- Y Scale: Linear
- Bottom: Linear
- Left: Linear

- Top
  - Axis: on
  - Tick: Out
  - Title: on
  - Tick Label: on
  - Formula: 1240/n

- Right

Use the Apply buttons on each tab to update your preview graph. Use the OK button to apply changes to the source graph.
6. Add a text object **Energy (eV)** as the top X-axis title (after creating this text object, right-click on it and choose **Properties**; then click the **Programming** tab and make sure that **Attach to** = **Layer Frame**).

7. In the above image, the first tick label of the top axis is a missing value for energy that corresponds to zero wavelength. To hide it, click on the top axis line to show up the mini toolbar, click the **Axis Dialogs** button to select **Special Ticks** from the context menu open the **Special Ticks** dialog.
8. In the opened dialog, select **Axis Begin** at the left panel and then select **Hide** for the **Show** drop-down list. Click **OK** to apply the settings and close the dialog.

6.4.2.5 Using Layer Management to Link and Position Layers

The Layer Management tool can be used to position, resize, swap, and link layers:

1. Reopen the project `\Samples\Graphing\Layer Management.opj` and then switch to the subfolder named **Arranging Layers**. You can reopen the project by selecting **File: Recent Projects: Layer Management.opj**. Do not save changes to the project.
2. Bring up the **Layer Management** tool from **Graph: Layer Management**. In the left panel, double-click on the name to rename the layers so that they are, top to bottom: Peak 1, Peak 2, Peak 3, Peak 4. The layer names now correspond to the legend for each layer.
3. Now switch to the **Arrange** tab and do the following:
   1. Check **Show Axes Frame**.
2. Set **Horizontal Gap** and **Vertical Gap** to 0.

3. Click **Apply**.

This resizes and repositions the layers so they are aligned, and hides ticks and labels where layers overlap.
4. Go to the **Axes** tab, hold down the **CTRL** key and select Peak 1 and 3 on left list, then expand the **Left** branch and set tick direction to **In**, and click **Apply**.

5. Now select Peaks 3 and 4, set the **Bottom** tick direction to **In** and click **Apply**. Then select Peaks 1 and 2, set the **Top** ticks to **In** and click **Apply**.

6. Go to the **Link** tab and select Peaks 2, 3, and 4 in the left list and link them to layer 1, making sure you have the X-Axes linked **Straight(1 to 1)**, and click **Apply**.

Click **OK** to close the dialog box.
7. Click and select the top left layer, layer 1, then drag and resize the layer, then move the layer. Note that the child layers resize and move too, since they are dimensionally linked to layer 1.

8. Click on the Top axis of Layer 1, and then click the **Axis Scale** button in the mini toolbar, the **Axis Scale** dialog will be opened. Change the scale **From 10 To 35**, and click **OK**. You'll see that all the other layers now display the same X-axis scale range.

9. With the graph active, choose **Graph: Fix Scale Factors**. This will reset all text labels on the page -- axis titles, tick labels, legend text -- to their true font size.

10. Finally, using the Mini Toolbar **Font Size** drop-down, change axis tick labels and legend text to **Font Size = 18**. Change axis titles to **Font Size = 22**.
If the layers are linked, they are treated as one unit. If you need to rearrange layers, you should first unlink them. You can re-link layers after arranging.

### 6.4.2.6 Merge Multiple Graphs

In this section, we merge two graphs from different subfolders of the same project while treating the four layers in one graph as a unit.

1. Click on the **Rescale** button when the Graph 1 in the **Arranging Layers** subfolder is active.
2. Select **Graph: Merge Graph Windows** in the main menu to open the dialog.
3. Do the following:
   - Click the triangle button to the right of **Graphs** and from the flyout menu choose **All in Project**. **Graph1** and **Graph2** will show in the **Preview** panel (not shown).
   - Make sure **Number of Rows = 2** and **Number of Columns = 1**.
   - Make sure **Treat Each Source Graph As a Unit** is selected.

When **Page Setup > Orientation = Auto**, the final page size will be determined by the sum of the layer sizes plus margins/gaps and will therefore be larger than the original page size. If you want to preserve the original page size, set **Orientation = Landscape or Portrait** and adjust gaps and margins accordingly.
Graphing
5. Click **OK** to close the dialog box. A new merged graph page is created:
6.4.3 Multiple Layers with Linked Axis

This tutorial will show how to merge four graphs to one graph, which contains multiple layers with linked axis.
What you will learn

- How to make a Line + Symbol plot
- How to merge graphs
- How to link axis of layers
- How to customize axis

Steps

This tutorial is associated with the Tutorial Data project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data project and browse to folder Multiple Layers with Step Plot in Project Explorer.
2. Activate the workbook and highlight column Value1 and make a graph by selecting Origin menu Plot > Basic 2D : Line + Symbol.
3. Activate the graph, right-click the legend and choose Properties from the context menu. In the Object Properties dialog,
   - In the Text tab, put this text in the text field: \b(Vertical) and set Size to 36.
   - Go to the Frame tab, and set as following image. Click the OK button. Move the legend to the correct position.
4. Double click on the open white space in layer of the graph to open the Plot Details dialog. In the left panel, select Layer1. Activate the Background tab in the right panel, choose LT Gray for the Color. Then select the plot in Layer1 from the left panel, under the Symbol tab in the right panel, set Size to 15 and Symbol Color to red. Switch to the Line tab, choose Step Vert from the Connect drop-down list and set Width to 4 and click OK to apply settings.
5. Now we are going to duplicate similar graphs from the other three columns. Right click on the graph window title bar and select **Duplicate (Batch Plotting)** from the context menu:
6. In the dialog that opens, select **Column** from the **Batch Plot with** drop-down list, hold Ctrl key and click to select all three columns C, D, E and click OK:
7. For graph from each column, the legend text and Connect drop-down list will be different, listed below.

For column **Value2**: legend text = \(\text{l}(\text{Vertical Center})\); **Connect** = Step V Center

For column **Value3**: legend text = \(\text{l}(\text{Horizontal})\); **Connect** = Step Horz

For column **Value4**: legend text = \(\text{l}(\text{Horizontal Center})\); **Connect** = Step H Center

8. Activate a graph and then select Origin menu **Graph: Merge Graph Windows** to open the **merge_graph** dialog. Change the settings as the following image shows. Then click the **OK** button to merge these graphs.
9. Activate the new merged graph, choose Origin menu **Graph: Layer Management** to open the **Layer Management** dialog. In the **Layer Selection** panel, rename the layers by double clicking on the name and reorder the layers by clicking on the layer index and dragging up and down. Make sure the final layers' names and order are the same as the image shows below (In the **Preview** panel, the layers' indices and positions can be shown).
10. In the **Layer Selection** panel, press **Ctrl** key on the keyboard to select the following layers: **Vertical Center**, **Horizontal** and **Horizontal Center**. Go to the **Link** tab, select *1* from the **Link To** drop-down list. Then both **X Axis Link** and **Y Axis Link** are set to **Straight(1 to 1)**. Then click the **Apply** button.
11. Go to the Axes tab, select Vertical layer from the left panel, then check all Axis check-boxes under Bottom branch, Left branch, Top branch and Right branch. Also, select In for Tick drop-down list under Top branch. Click the Apply button.

12. Select Vertical Center layer, in the Axes tab, Bottom branch, Left branch and Right branch share the same settings. And settings for Top branch shows in the image below. Click the Apply button.
13. Select *Horizontal* layer, in the *Axes* tab, check the *Axis* check-boxes under both *Top* branch and *Right* branch. Click the *Apply* button.
14. Select *Horizontal Center* layer, in the *Axes* tab, check the *Axis* check-box under *Top* branch. Click the *Apply* button.

15. Click the *OK* button to close the *Layer Management* dialog.
16. Double click on the X axis of the lower-left layer to open the **X Axis** dialog. In the **Scale** tab, change the axis scale as the image below:

17. Click the **Vertical** icon on the left panel to go to **Scale** tab for **Y Axis** and change the axis scale:
18. Go to **Tick Labels** tab and click **Bottom** icon on the left panel and change the display of X tick labels:
19. Go to **Special Ticks** tab and hide the label at axis end by selecting **Hide** from **Show** drop-down list for **Axis End**: 
20. Click on the **Left** icon on left panel, and hide the label at Y axis end by selecting **Hide** from **Show** drop-down list for **Axis End**.

21. Select **Layer 4** in the left-bottom corner of the Axis dialog. And then repeat step 18.

22. Go to **Tick Labels** tab and **Format** sub-tab, then set the **Size** to 16 and check **Bold** box.

23. Click **OK** to save the setting and close the dialog.

24. Right-click on the X Axis Tick Label, and select **Copy Format**. Right-click on the black space of the graph, and select **Paste Format to...** : **All Axis Tick Labels** : **Font**

25. Click on a Axis Title. In the Mini Toolbar, set font size to **18**.

26. Right-click on edited Axis Title, and select **Copy Format: Styles**. Right-click on the black space of the graph, and select **Paste Format to...** : **All Axis Titles** : **Font**

27. Change the both Y titles to **Price**, and then make Titles to bold.
6.4.4 Multi Layer Graph Customization

6.4.4.1 Summary

The graph layer is the basic building block of all Origin graphs. A graph layer consists of a set of coordinate axes and (usually) one or more data plots, plus attached axis titles, plot legends, text labels, drawn objects, button objects, etc. The graph layer can be moved to any location or resized to any dimensions within the graph window. An Origin graph window contains between 1 and 1,024 graph layers.

When working with graphs that contain multiple layers, it helps to have some tools and a strategy for applying customizations to multiple layers a time, as opposed to simply modifying each plot or each axis scale individually. Beginning with Origin 2018b, you can edit multiple graph layers simultaneously using the Plot Details Layers tab Common Display controls.

Minimum Origin Version Required: Origin 2018b

6.4.4.2 What you will learn

- How to control the scaling of elements (axis titles, tick labels and graph legends) when graphs are merged.
- How to merge graph windows containing a single layer into a multi-panel graph.
- How to configure the merged graph so that plot or axis customizations made in one layer are applied to all layers.
- How to fix scaling issues with fonts in merged graphs.
- How to remove white space from the merged, multi-panel graph.
- How to remove unneeded legend objects and customize one object so that it serves as a legend for the multi-panel graph.

6.4.4.3 Steps

1. Start a new project. Press F11 to open Origin Central, click the Graph Samples tab, set the graph drop-down list to Multi-Panel Graphs and double-click on the Multiple Panel Graph from Index Data.
2. In the worksheet that opens, click on the **Output Data** tab and resize the window so that you can see all 12 columns of data. Note that the column headings have (1) a green lock on them, indicating that these are calculated values and (2) the column designations repeat in the pattern $X_1$, $Y_1$, $Y_1$, $X_2$, $Y_2$, $Y_2$, etc.

3. Select columns $B(Y_1)$ and $C(Y_1)$ and click the **Line + Symbol** button on the **2D Graphs** toolbar. Repeat the process for columns $E(Y_2)+F(Y_2)$, $H(Y_3)+I(Y_3)$, $K(Y_4)+L(Y_4)$. You should now have 4 similar graph windows, each containing a single graph layer with two plots (Note that you don't need to select the X column when making these graphs because Origin's default behavior is to plot Y values against any X column immediately to the left of selected Y columns).

### 6.4.4.3.1 Scale Elements

We are going to merge the above graph windows into a single 4-panel graph window but before we do that, we will briefly discuss element (axis titles, graph legends, etc.) scaling so that we understand how to control this in a merged graph.

1. Click on one of the four graph windows -- it doesn't matter which one -- and click **Format: Layer**.
2. In the Plot Details dialog box, click the **Display** tab and note the **Scale Elements** settings. By default, **Scale With Layer Frame** is selected. This tells us that when the size of the layer is changed, the size of attached elements such as the axis titles, graph legend, etc., will be scaled accordingly.
3. Click **OK** to close Plot Details, then right-click on the graph window title bar and choose **Duplicate**. You now have two identical windows.

4. Click on the duplicated window and click **Format: Layer**, again. Click on the **Display** tab again, but this time, set **Scale Elements** to **Fixed Factor: 1**, then click **OK** to close Plot Details. We now have two identical graphs, one with **Scale Elements = Scale With Layer Frame** and one with **Scale Elements = Fixed Factor: 1**.

5. Reposition and resize your identical graphs so that we can do a side-by-side comparison.

6. In the graph window that is set to **Scale With Layer Frame**, click once in an empty portion of the graph page and when the green selection handles appear, hold the **CTRL** key and drag a corner handle so that the graph covers approximately 25% of the page.

7. Repeat the last step with the graph window that is set to **Fixed Factor: 1**.

8. Now, compare the resulting smaller graphs and note, in particular, the difference in the way that the various elements -- the plot symbols, the text and legend objects -- behaved when the graph was made smaller.
We can see that setting the elements to **Fixed Factor: 1** is probably going to cause problems when four graphs are merged onto a single page, so when we merge, we will leave the default setting for each of the merged graphs to **Scale With Layer Frame**.

9. So that you don't get it mixed up with the other graphs, delete the "Fixed Factor" graph.

### 6.4.4.3.2 Merging Graph Windows

1. With all four (and only the four) of your original graph windows showing in the workspace, choose **Graph: Merge Graph Windows** and open the **Merge Graph Windows** dialog box.

2. Make sure that all four graphs are listed in the **Graphs** box, then expand the **Scale Elements** branch and make sure that **Scale Mode** is set to **Auto**. Note the Preview pane to the right side of the dialog box, showing an approximation of your final, merged graph. **Tip:** If you want to keep your original graphs, make sure the **Keep Source Graphs** box is checked, or the graphs will be destroyed.

3. Click **OK** and a four-panel graph is created. Note the four layer icons in the upper-left corner of the merged graph -- one icon for each graph layer.
6.4.4.3.3 Common Display Controls for Simultaneous Edits to Multiple Layers

Suppose that we want to customize some elements or properties of the layers, plots and axes in a multi-panel graph? We could make edits to each layer, one-by-one, but this would be tedious. Beginning with Origin 2018b, you can use the Plot Details Layers tab Common Display controls to apply edits made to one layer, to other layers.

1. With your 4-panel (merged graph) active, click Format: Page. This opens the Plot Details dialog box.
2. Click on the Layers tab.
3. Under Common Display, check the Plot Properties box. As the “blue hint” tells us, we should check the appropriate boxes here first, then make customizations at the Layer/Plot level. We can use the Apply to controls to selectively apply Common Display changes (see documentation of Apply to controls).
4. In the left panel of Plot Details, click the arrow to the left of the Layer1 icon to expand to show the two data plots in the layer.
5. Click on the first plot in the layer, then on the **Symbol** tab to the right side of Plot Details, click on the symbol gallery (downward-pointing arrow) and change plot symbol shape to Circle, then change **Size** to 15. Leave **Symbol Color** as **Auto** as that will allow symbol color to follow line color. Click **OK** to close Plot Details and note that the symbol size is increased in all plots in our 4-panel plot.

6. We can continue to customize our 4-panel plot using **Format** and **Style** toolbar buttons. Click on one of the gray plots and note that both plots in the layer are now highlighted. Pause slightly and click a second time on the gray plot and this time, you will see that only *that* plot is selected.

7. Click the Line/Border Color button on the Style toolbar and choose **Navy**. Note that gray plots in each of the four panels are now navy blue in color. The graph should look something like this:

![Graph Image](image_url)

**6.4.4.3.4 Fix Scale Factors**

At this point, we have a satisfactory graph and we may consider our work finished. However, one thing that we should be aware of is that when the four graphs were merged, the scaling down of font size produced one small issue.

1. Select one of the graph legend objects, then hover over it with your mouse and you will see a tooltip that appears something like this:
The tooltip reports that the (font) size = 22 but that the actual size is 10.1. This occurs because, as we expected, the font was scaled down when we merged graphs. The problem now is that we have a font size that looks like it is 10.1 but Origin still thinks of it as a size = 22 (Look to the Font Size list on the Format toolbar and it will report the original size of 22). We can correct this conflict with a simple menu command.

2. With the graph window active, choose Graph: Fix Scale Factors and accept the default value of 1 by clicking OK. Now, select one of the four legend objects, hover and you’ll see that the tooltip now reports that both size and actual = .1 (the decimal is not meaningful as Origin rounds to the nearest 0.5). Note also, that the Format toolbar now reports Font Size = 10.

While we could have skipped this detail, it is not uncommon for users to want to be confused by conflicting information about scaled font sizes and this menu item is the best way to reset font size so that you know just what you are working with.

6.4.4.3.5 Fit Layers to Page

At this point, our graph looks satisfactory but we could do a couple of things to improve it. One would be to remove extra white space from the graph. We have a couple of options there but one quick way to do this is to choose the Fit Layers to Page menu item.

1. With the graph window active, choose Graph: Fit Layers to Page. This opens the Fit Layers to Page: gfitp dialog.
2. Set a Margin of 5 and clear the Maintain Layer Aspect Ratios box, then click OK. Our graph layers are slightly re-proportioned and the white space around the outside is reduced.

If you are exporting or copying your graph to an external application, the Export Margin Offsets dialog box can also be used to remove white space from the outside of the graph.

6.4.4.3.6 Graph Legend Adjustments for Panel Graphs

We don't need the four graph legend objects since each panel plots the same two variables. So, we will eliminate three objects and slightly reconfigure the fourth to act as a legend object for the four panels.

1. Press CTRL + select three of the legend objects and when the green selection handles appear surrounding the three, press Delete.
2. Drag the remaining legend object to the top-center of the graph page.
3. With the legend object still selected (green handles showing), press CTRL again and drag one of the green handles on the side of the legend object and drag it out horizontally until it looks like this:
1. Center the graph legend on top of the page. Your graph should now look something like this:

6.5 Graph Template and Theme

6.5.1 Graph Template and Theme

- Copy and Apply a Plot Format to Another Plot

6.5.2 Copy and Apply a Plot Format to Another Plot

6.5.2.1 Summary

It is possible to copy and paste formatting from one plot to another, so there is no need to spend time recreating identical customizations such as size and color of symbols and lines.

Minimum Origin Version Required: Origin 8.0 SR6

6.5.2.2 What you will learn

This tutorial will show you how to:

- Copy a plot format (color, size, etc. of the symbol or the line), and apply it to other plot.

6.5.2.3 Steps
1. Click the New Project button on the Standard toolbar to begin with a new project.

2. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Curve Fitting subfolder and find the file exponential decay.dat. Drag-and-drop this file into the empty worksheet to import it.

3. Highlight column B, C and D, and select Plot: 2D: Line+Symbol: Line+Symbol MENU to plot these three datasets.

4. Double-click on the plot to show the Plot Details dialog box.

5. Choose Group tab in the dialog, and select Independent for the Edit Mode -- this makes it easier to customize individual plots.

6. Make sure that the top data plot (Time(X) Decay 1(Y)) is selected in the left panel of the Plot Details dialog. If not, select this plot branch in the left panel.

7. Select the Symbol tab, and change the Size to "5". (You can also change the shape or the color to others of your choice.)

8. Select the Line tab, and change the width to "0.2". (You can also change the style or the color to others of your choice.) Click OK. You will see that the Decay 1 plot has been customized.

9. Click on Decay 1 plots to select. Right-click on it and select Copy format. This will copy the plot format of Decay 1 to the clipboard.

10. On the graph, click on the Decay 2 data plot to select it, right-click and select Paste Format to: All. You will see the plot format of Decay 1 copied to Decay 2.

Note: Right-clicking on third plot "Decay 3" to select Paste Format(Advanced) to open the Apply Formats dialog, you can do further and more detailed settings.

6.6 Line and Symbol

6.6.1 Line and Symbol

- Complicated Fill Area
- Fill Partial Area between Function Curves
- Scatter Plot of Decay and Recovery Curves
- Micro-Raman spectroscopy of complex nanostructured mineral systems
- Multi-line-plot with Special Position Annotation Line
- Line Graph with Masked Data
- Symbol Plot with Color Transparency
- Symbol Plot with Size and Colormap from Other Columns

6.6.2 Complicated Fill Area
6.6.2.1 Summary

Minimum Origin Version Required: 9.1 SR0

6.6.2.2 What You Will Learn

- Fill area between curves with two different colors.
- Use an ordered plot sequence to implement complex graph fills.

6.6.2.3 Creating the Basic Plot

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`. Note that this tutorial requires numerous steps to produce a complex graph. Users should understand that this is not a basic Origin graphing tutorial.
1. Open the Tutorial Data.opj and browse to folder *Multiple Fill Area*.
2. Activate workbook **Book2, Sheet1**. Highlight columns C through F, then click **Plot > Basic 2D : Line**. A grouped line plot is created.
3. Select and delete the X axis title and legend object from the graph.
4. Double-click on any plot to open the **Plot Details** dialog. Go to **Line** tab and set **Transparency** to 100%.

![Plot Details dialog](image)

5. Go to **Group** tab and set **Edit Mode** to **Independent**, then click **Apply**. This will allow us to specify custom fill area modes for each line.
6. Highlight the first plot in the left side of Plot Details. On the Line tab, enable Fill Area Under Curve and select Fill to data plot - Above Below Colors.

7. Go to Pattern_Above tab and choose settings as shown below.
8. Go to **Pattern_Below** tab and set **Fill Color** to Red, the click **Apply**. The first filled area part of our plot is added.

9. Highlight the second plot in the left side of Plot Details. Go to the **Line** tab, enable **Fill Area Under Curve** and select **Fill to data plot - One Color**.
10. On the **Pattern** tab, choose settings as shown below.
11. Repeat step 6~8 for the third plot in graph but on the Pattern_Above tab, set Fill Color to None and Transparency to 0 (you must clear Follow Line Transparency). On the Pattern_Below tab, set Fill Color to Blue.

12. Your stacked fill area plot should now look like this:
As an alternative to the Plot Details Line tab controls, note that you can select any two plots in the graph layer using the Ctrl key, then apply fills between the selected curves using Mini Toolbar buttons.

6.6.2.4 Steps to Eliminate Overlapping Fill Areas

In the graph we just created, there are some overlapping fill areas that we do not want. We will hide them by adding a white fill area to cover them. We will be using the Layer Contents dialog box to add datasets to the graph, some of them multiple times.

1. From the menu, select Graph: Layer Contents. Use the right-pointing arrow button in the middle of the dialog to add these plots to the datasets to the right side of the dialog.
2. Use the **Ungroup** button to ungroup any plots that come over as groups. Grouping is denoted by the gn beside each dataset. You want to **make sure that no groups exist** (you can ignore the first four datasets that were added).

3. Arrange added plots in exactly the order shown. Use the up- or down-arrow buttons above the right side list, to rearrange the list as needed. Note that only ungrouped plots can be independently ordered. When your list looks like the figure above, click **OK** to close the **Layer Contents** dialog box.

4. Double-click on a data plot to open the **Plot Details** dialog box.

5. In the left side of **Plot Details**, highlight the fifth plot down (C(Y)). On the **Line** tab, check **Fill Area Under Curve**, and from the drop-down choose **Fill to data plot - Above Below Colors**, **Color = Red** and **Transparency = 0**. On the **Pattern_Above** tab, **Transparency = 0** and **Fill Color = White**. On the **Pattern_Below** tab **Fill Color = Red**.

6. Highlight the sixth plot down (D(Y)) and set **Color = Red** and **Transparency = 0**.

7. Highlight the seventh plot down (E(Y)). On the **Line** tab, check **Fill Area Under Curve**, and from the drop-down choose **Fill to data plot - Above Below Colors**, **Color = Blue** and **Transparency = 0**. On the **Pattern_Above** tab set **Fill Color** to **White** and **Transparency** to **0**. On the **Pattern_Below** tab, **Fill Color = Blue**.

8. On the eighth plot down (F(Y)), click the **Line** tab and set **Color** to **Black** and **Transparency** to **0**.

9. On the ninth plot down (H(Y)), click the **Line** tab and set **Color** to **Orange** and **Transparency** to **0**.

10. On the tenth plot down (I(Y)), click the **Line** tab and set **Color** to **Blue** and **Transparency** to **0**.

11. For the eleventh and twelfth plots (B(Y), G(Y) respectively), click the **Line** tab and set the line **Color** to **Gray** and the **Transparency** to **0**.

12. For the thirteenth plot down (E(Y)), click the **Line** tab and from the drop-down set **Fill to data plot - Above Below Colors**, **Transparency = 0**. On the **Pattern_Above** tab, set **Fill Color = None**, **Transparency = 0**; on the **Pattern_Below** tab, **Fill Color = White**.

13. For the fourteenth plot down (C(Y)), click the **Line** tab and verify that **Color = Black** and **Transparency = 0**.

14. For the fifteenth (last) plot down, click the **Line** tab and set **Color = Red** and **Transparency = 0**.
15. Close **Plot Details** and click the **Rescale** button on the **Graph** toolbar. Your graph should look roughly like the following. To polish your graph, continue with the last section.

![Graph Image]

### 6.6.2.5 Further Customizations

1. Double-click on the X axis (bottom, horizontal) tick labels. This opens the X Axis dialog box. Click the **Scale** tab and set the date range **From 1/1/2013 To 8/20/2013**. Set **Minor Ticks Count** = 0.
2. On the **Tick Labels** tab set **Display** to show a three-letter abbreviation for month (e.g. *Apr*).
3. Click Apply.
4. To draw a box around the whole graph layer, choose **View: Show: Frame**.
5. Lastly, to add the dashed lines at temperature = -10 and +110, double-click on the Y axis (left, vertical). Click on the **Reference Lines** tab and enter the following:

<table>
<thead>
<tr>
<th>At Axis Value</th>
<th>Line</th>
<th>Fill To</th>
<th>Label</th>
<th>Label Text</th>
<th>Label Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis Begin</td>
<td></td>
<td>None</td>
<td></td>
<td>&lt;value as entered&gt;</td>
<td>Left</td>
</tr>
<tr>
<td>Axis End</td>
<td></td>
<td>None</td>
<td></td>
<td>&lt;value as entered&gt;</td>
<td>Left</td>
</tr>
<tr>
<td>110</td>
<td>✔</td>
<td>None</td>
<td>✔</td>
<td>&lt;value as entered&gt;</td>
<td>Left</td>
</tr>
</tbody>
</table>

![Reference Lines Table]
6. Click the **Details** button and in the **Reference Lines** dialog box, clear **Auto Format**, set **Style** to **Dash** and **Thickness** to 1. Do this for both the -10 and +110 lines and click **OK**.

7. In the **Axis** dialog box, click **OK** to close the dialog. Your graph should now look like this:

![Graph Example](image)

### 6.6.3 Fill Partial Area between Function Curves

#### Videos

- Fill Area Between Curves
- Set Column Values
- Annotate a Point on the Graph
- Customize a Single Point
- Special Ticks
- Adding Special Tick Labels to Graph Axes
- Set Column Values

#### OriginBlog

- Fill Area Under Intersection of Two Curves
- Fill Area Above and Below Curve
- Shading Sections of a Graph and Customizing their Formatting

### 6.6.3.1 Summary
This tutorial shows how to plot two functions and customize the graph by partially filling an area between the two function curves.

Minimum Origin Version Required: 2017 SR0

6.6.3.2 What you will learn

- Generate function data using Set Values tool.
- Fill areas between two lines with different colors.
- Add and edit objects on your graph.

6.6.3.3 Steps

This tutorial with the Fill Partial Area between Function Plots folder in the project <Origin EXE Folder>\Samples\Tutorial Data.opj.

6.6.3.3.1 Filling Area Between Parts of Two Curves

To apply different fill colors to two or more portions of the curve, you need to plot curves in segments. In this tutorial, you will learn how to fill an area between curves defined by $X <= 1$.

1. Open the Tutorial Data.opj and browse to the Fill Partial Area between Function Plots folder. Book2L contains two function curves (Note: To see how to generate a dataset from a function, see the last section of this Tutorial).
2. Select rows 1~36 (-2.5 <= X <= 1) of all three columns in Sheet1 of Book2L and on the menu, click Plot> Basic 2D: Line to plot two lines. The two datasets (lines) are automatically grouped.
3. Now, go back to the worksheet, select rows 36~51 (1 <= X <= 2.5) of all three columns and hover over the edge of the highlighted area until the cursor looks like this 📰. Drag and drop the selected range, onto the graph you just created . If prompted to rescale the axes and show all data, choose Yes.
4. Select and delete the legend and the axis title.
5. Double-click on one of the line plots, to open the **Plot Details** dialog box. Select the 1st plot under the **Layer1** node on left panel.

6. Go to the **Line** tab and below **Fill Area Under Curve**, select **Enable**. Set **Fill to data plot - Above Below Colors, Data Plot = Next Plot, Fill to = Common X Area**, then click **Apply**. Notice that this action adds a **Pattern_Above** and a **Pattern_Below** tab to the dialog box.
7. Go to **Group** tab, click the line color list in the **Details** column to select the increment list **Candy** as below:

8. Go to the **Pattern_Above** tab and set the fill color of the black line to **LT Magenta** with a 50% transparency.
9. Go to the **Pattern_Below** tab and set the fill color below the black line to be **LT Cyan**. Note that transparency controls for **Pattern_Below** are dimmed and set to **Auto**, meaning that the fill will use the same transparency settings as **Pattern_Above**.
10. Select the third plot in the left panel, go to Group tab, click the line color list in the Details column to select the increment list Candy as below:
11. Click **OK** to close the dialog box. The area in between the curves where $X \leq 1$ is now filled.

As an alternative to the Plot Details **Line** tab controls, note that you can select any two plots in the graph layer using the Ctrl key, then apply fills between the selected curves using Mini Toolbar buttons.
6.6.3.3.2 Changing the Axis Range

1. We want to change the display range of $X$ and $Y$ axis. To do this, click on the $X$ axis, and in the popup mini toolbar, click the Axis Scale button to open the Axis Scale dialog as below. Set the display range from $-2.5$ to $2.5$ with Tick Thickness $= 2$.

![Axis Scale dialog](image)

Do the same for $Y$ axis to set the $Y$ axis display range from $-10.5$ to $4$ with Tick Thickness $= 4$.

2. To configure the $X$ and $Y$ axes so that they intersect at $0,0$. Double-click on the $X$ axis to open the Axis dialog, go to the Line and Ticks tab, select both Bottom and Left icon in the left panel of the Axis Dialog. Set Axis Position to At Position $= 0$. 

![Axis dialog](image)
3. Click **OK** to close the dialog. Delete the Axis titles, and then select the two line groups separately to set **Width** to 2 both using the style toolbar. Then, the graph will looks like:

6.6.3.3 Adding Special Points with Labels to Annotate the Intersections

In the graph above, there are three intersections of two function curves. We want to mark two of them, at $X= -2$ and $X= 2$ respectively.
1. With Ctrl key been pressed down, click on the intersection at X=-2 to select this individual point and then right-clicking on it to select Edit Point to open the Plot Details dialog. You can learn more about how to show and customize an individual point on graph.

2. In the dialog that opens, you will see a special point showing its row index has been added and selected under the second plot.
   - Go to the Symbol tab, customize its style as below:
Tutorials for Origin 2024b

- Go to the **Drop Line** tab, enable the vertical drop line and set its style as shown below:

- Go to the **Label** tab, check the Enable check box to set **Label Form** to (X,Y) and **Font Size** to 22.

3. Click OK to turn off this dialog. Do the similar steps as step 1 to add another intersection at X=2 (row index = 46).
And then, set the same styles for it. At the end, you will get the graph such as the one shown below:

![Graph Example](image_url)

### 6.6.3.3.4 Adding Function Formulas and Axis Arrows

1. To hide the axis tick labels at (0,0), open the **Axis** dialog again and go to **Special Ticks** tab, then for the **Bottom** icon set as below and do the same for the **Left** icon.

2. To add arrows to the ends of the axes. Go to the **Line and Ticks** tab of **Axis** dialog. Select both **Bottom** and **Left** icon in the left panel of the **Axis** dialog. Expand **Arrow** node, check the **Arrow at End** checkbox,
and then set **Width** to **5**.

3. Double-click on X axis to open the **Axis** dialog. Go to **Reference Lines** tab, enter **1** in the **Reference Lines at Value** text box, then click any place in the list table to add a reference line at X=1. Do the settings as below:

Click the **Details** button to set the line style.
To add the two curves' formulas to the graph, right-click on a blank area and choose Add Text.... Type any character into the object to create a text object firstly. And then right-click on it to select Properties from the context menu to open the Object Properties dialog. Enter the first formula in the Text tab.

\[ y = -x + (2) + 3x \]
\[ y = 2x + (3) - x + (2) - 5x \]

5. Click OK button to close the dialog. Add one more text object and open Text Properties dialog again to enter the second formula above in Text tab. Click OK button again, then these two formulas have been added to the graph window both. Reposition them as needed.
6. Select the **Curved Arrow Tool** and add two curved arrows to connect formula labels to line plots.

![Curved Arrow Tool](image1)

7. Your final graph should look something like this:

![Graph Example](image2)

### 6.6.3.3.5 Generating Function Data using Set Values tool

1. Open a new workbook. Choose **Add New Columns** to the worksheet so there are 3 columns.
2. Right-click Col(A) and select **Fill Column with: A set of Numbers**...
3. In the patternN dialog box, set up the following parameters:

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Increment</th>
<th>Mode</th>
<th>Repeat Times for Each Value</th>
<th>Repeat Times for The Sequence</th>
<th>Total Number of Whole Set display</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5</td>
<td>2.5</td>
<td>0.1</td>
<td>Repeat</td>
<td>1</td>
<td>1</td>
<td>51</td>
</tr>
</tbody>
</table>

4. Double-click on the F(x) label row of Col(B) to turn to the in-place edit mode, then enter \(-1*A^2+3*A\) as below.

<table>
<thead>
<tr>
<th>A(X)</th>
<th>B(Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-2.5</td>
</tr>
<tr>
<td>2</td>
<td>-2.4</td>
</tr>
<tr>
<td></td>
<td>-13.75</td>
</tr>
<tr>
<td></td>
<td>-12.96</td>
</tr>
</tbody>
</table>

**Note:** Since Origin 2017, a new control Spreadsheet Cell Notation has been added and turned on by default. Origin supports use of column Short Name as notation in column formula, such as A+1 instead of col(A)+1.

For earlier version, you are supposed to enter \(-1*col(A)^2+3*col(A)\) instead.
5. Highlight col(C) and right-click on it to select Set Column Values from context menu to open Set Values dialog. In this dialog, enter formula and the range definition as below:

![Set Values dialog](image)

**6.6.4 Scatter Plot of Decay and Recovery Curves**

- Adding, Grouping and Reordering Plots with Layer Contents
- Group and Ungroup Plots in Object Manager
- Customize Legend Symbol
- How to customize legend symbols and user-defined legend entries

### 6.6.4.1 Summary

The scatter plot below depicts 3 decay and recovery curves obtained after taking two-photon fluorescence measurements of reversible photodegradation in a dye-doped polymer. To learn more about the graph, please read the case study.
Graphing

Minimum Origin Version Required: Origin 2016 SR0

6.6.4.2 What you will learn

- How to use the Plot Setup dialog to arrange plots in a layer
- How to customize the symbols in your graph

6.6.4.3 Steps

1. Download the zip file from [here](#) and extract the text files.
2. Open Origin and click the **Import Multiple ASCII** button on the **Standard** toolbar to open the **ASCII** dialog and then import the text files.

1. Go to the folder where the data files reside

2. Select the file type *.txt*

3. Select all data files

4. Click this button to add them to the bottom box

5. Check this check box

6. Click OK button
3. In the impASC dialog, set Import Mode as Start New Sheets. Click OK to finish importing.

![Graphing](image)

4. We will use the Plot Setup dialog to create a graph with 8 plots. Active the workbook, and make sure that no datasets are now selected. Click the button on the 2D Graphs toolbar to open the Plot Setup dialog.

Show all of the three panels of Plot Setup dialog (if not all of them are shown) by clicking the and buttons.

First, we will add 4 line plots into a graph by using the Plot Details dialog. Highlight all dataset in the top panel, and then select column Timemin as X, column Theory as Ys in the middle panel. Then add them into the bottom panel.

Then we will add 4 scatter plots into the same graph. Select Scatter from the Plot Type drop-down list, make sure all dataset in the top panel has been selected, and then select column Timemin as X, column
**NormData** as Ys in the middle panel. Then add them into the bottom panel.

In order to show all three panels in **Plot Setup** dialog, please expand **Plot Type** panel by clicking and expand **Available Data** panel by clicking again.

Please refer to *Plotting using Plot Setup* for more information.

5. In bottom panel, if there is a **Group** branch under **Layer1**, right-click on it to select **Ungroup** from the short-cut menu to ungroup these plots.
Click **OK** to generate the graph which look like the following image shows.

6. Double-click the layer icon at the top-left corner of graph window to open the **Layer Contents** dialog. Then group the **Theory** plots and **NormData** Plots as Group 1 and Group 2 using the **Group** button after
highlight the 4 Theory/Norma Data plots separately by using mouse and the **Shift** key,

7. Then we will customize the 8 plots in the Plot Details dialog. Select **Format: Plot** to open the Plot Details dialog. In the left panel of the dialog, you could see there are 8 plots: the first 4 plots are line plots, the other 4 are scatter plots.

8. We will first customize the 4 line plots. Open **Plot Details** by double clicking the plot. On the left panel, 4 line plots are put ahead of the 4 scatter plots. You can select the first line plot by selecting the first plot under **Layer 1** in this panel then go to **Line** tab. Select **B-Spline** from the **Connect** drop down list and set the **Width** to 3. Then click the **Apply** button. In the **Group** tab, select None for the **increment** cell in **Line Color** row. Click OK to apply these settings.

9. Then customize the 4 scatter plots. Go to **Plot Detail** and then select the fifth plot in the left panel, which should be the first scatter plot. Go to **Symbol** tab, change the **Size** to 8 and **Edge Thickness** to 0. In the **Symbol** tab, we will mainly customize the symbols in the list box that in the middle of the tab. In the **Symbol Type** row, select **By one** in the **Increment** column. Click the **button to open the **Increment Editor** dialog, in the dialog select **UpTriangle**, **Circle**, **Hexagon** and **Square** for the first 4 rows.

In the **Symbol Edge Color** row, select **By one** in the **Increment** column. In the **Details** column, click the color list to select the list **Q11: Candy** from the color list drop-down list.

In the **Symbol Interior** row, select **By one** in the **Increment** column. Click the **button to open the **Increment Editor** dialog, in the dialog select **Solid**, **Solid**, **Half Left** and **Solid** for the first 4 rows. Click
OK button to close the Plot Details dialog, then the graph will look like.

10. Then customize the Axes of the graph. Double click on the X axis to enter Axis Dialog. First, we customize the axes scale. Go to Horizontal icon in Scale tab, change From to -5, To to 690; set Major Ticks Type as By Increment and Value as 100, respectively. Repeat these steps to customize the Y axis range (the Vertical icon) as From to 0.61 and To to 1.01, and Value as 0.05.
To customize the Axis Ticks, select **Top** icon in **Line and Ticks** tab, enable the **Show** check box, then go to **Top** icon in **Line and Ticks** tab, select **In** from both **Major Ticks** and **Minor Ticks** drop-down lists.
Repeat the same steps for Right Axis under **Right** icon.

11. Then you will customize the titles and the legend. Change the titles follows the images shows. Right click on the legend and select **Legend: Update Legend** from the context menu to open **legendupdate** dialog. In this dialog, do the following:
Click Ok to close this dialog. Then the legend will update. Double-click on it to turn to the in-place edit mode, remove the first four rows. The final graph will look like...
6.6.5 Micro-Raman spectroscopy of complex nanostructured mineral systems

This tutorial will show you how to create a multiple line plot and how to customize it.

Minimum Origin Version Required: Origin 2015 SR0

6.6.5.2 Steps

1. Create a new worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Graphing subfolder and find the file Micro_Raman_Spectroscopy.txt. Drag-and-drop this file into the empty worksheet to import it.
Tutorials for Origin 2024b

2. Highlight all the columns in the worksheet. Right-click and select Set As: XY XY from the context menu. Then click the Line button on the 2D Graphs toolbar.

Delete the legend. The graph should look like this:
3. Double-click on the X axis to bring up the **Axis** dialog box. In the **Scale** tab, set the options as the screenshots below.
4. Click the **Vertical** icon on the left panel to go to the **Scale** tab of **Y Axis** and then set the options as in the screenshots below and Click **OK**.
5. Now, we will apply a Graph Theme to add a top X axis and a right Y axis. Select **Preferences: Theme Organizer** to open the **Theme Organizer** dialog. Activate the **Graph** tab and select **Opposite Lines** from the table. Then click **Apply Now**. Click **Close** to close the dialog.
6. Click the Line button on the Tools toolbar and draw a line across the peaks' centers as the sample image shows. Hold down the SHIFT key while drawing the line to force it to snap to the vertical. Double-click on the line. In the Line tab, select Dash with the Type drop-down list. Click OK.

7. Click the Text button in the Tools toolbar. Add a text object near the line object and enter 461 into the text object.

Right-click on the text object and select Properties from the shortcut menu. In the Text of the dialog, set the options as in the screenshot below. Click OK.
8. Right-click on the title of the Y axis and select **Properties** from the short-cut menu. In the **Text** of the dialog, enter **Raman intensity/arb.units** in the edit box, highlight it, click the **Bold** button, and change size to **28**. Click **OK**.
9. Right-click on X axis title and select Properties from the shortcut menu. In the Text of the dialog, enter \textit{Wavenumber/cm}^{-1} in the edit box, highlight it, click the Bold button, and change size to 28. Highlight -1 click SuprtScript button. Click OK.

The graph should look like this:

![Graph](image)
6.6.6 Multi-line-plot with Special Position Annotation Line

This tutorial will show you how to create a multi-line-plot with special position annotation line.

Minimum Origin Version Required: Origin 2015 SR0

6.6.6.2 Steps

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select Line and Symbol Graphs from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Line and Symbol Graphs - Multi-line-plot with Special Position Annotation Line".
Note: This tutorial is associated with the folder Multi-line-plot with Special Position Annotation Line of the "Tutorial Data" project: <Origin EXE Folder> \Samples\Tutorial Data.opju.

2. Active to the worksheet in workbook Multi-line-plot with Special Position Annotation Line. To plot a multiple line plot, highlight all the columns in the worksheet, and click the Line button on the 2D Graphs toolbar. Delete the legend object from graph.

3. Click on the left Y axis, and in the popup mini toolbar, click on the Tick Style button to select In in the list.
Click on the bottom X axis and do the same thing to set the axis tick style.

4. Click on the left Y axis again, and in the popup mini toolbar, click the Axis Scale button to open the Axis Scale button to set the scale for X and Y axis:
   For X (Horizontal): From 74505 to 74575;
   For Y (Vertical): From -2500 to 45000;
5. Click on the left Y axis again, and in the popup mini toolbar, click **Show Gradlines** button to select **Major** from the list to show only the major grid lines.

6. Click any white space within the layer frame, and in the popup mini toolbar, click **Layer Frame** button to add a line frame on the graph.
7. Click on one plot, and in the popup mini toolbar, click **Line Color** button to expand the color chooser.

Under the **Group** tab, select **By Plots** sub-tab, by pressing **Ctrl** key, click the current color list to open the **Increment Editor** dialog to change the first four colors for the 4 plots.

![Increment Editor dialog](image)

- **Ctrl+click to open the Increment Editor**
- **Select desired colors for the first 4 rows**
8. Double-click on the tick labels of Y axis to open the **Axis** dialog. Go to the **Ticks Labels** tab and change the display format for **Left** into **Scientific: 10^3**. Click OK button.
9. Then, you will add vertical line on Graph, select **Insert: Straight Line** in main menu to open the dialog, set the X coordinates in the dialog, and set color: **red**, click **OK** to apply the settings.

10. A straight line with text was added on the graph. Edit the Text object above the line object by double click it, the $x^2$ and $x_2$ in **Format** toolbar is helpful when creating superscripts and subscripts. Entering the content as shown in graph below:
Then, click somewhere outside the text box to quit the text editing, drag to move the text to a proper position.

Now, the text object get the X coordinates of the line, when you drag to move the line object horizontal, the text also updates simultaneously.

11. Add explanatory strings for line plot, add a title on the graph by using Text Tool as well.

There are 2 ways to edit text labels:

- In-place Text Editing: Double-clicking puts you in WYSIWYG edit mode. Using the Style and Format toolbars makes it easy to add formatting to any text. For special characters, the Symbol Map can be used.

  The Symbol Map can only be opened while in In-place edit mode. To enter In-place edit mode, double-click on the text label. Then, open the Symbol Map by pressing CTRL+M. Or right-click inside the text label and select Symbol Map.

- Text Control dialog box (from previous versions of Origin): Hold down the CTRL key when double-clicking text. Highlight any portion of the text and apply the desired style, Greek font, etc.

  You can also right-click on a text label and select Properties to open
12. The finished graph is similar to the graph in Summary Section in this tutorial.

6.6.7 Line Graph with Masked Data

You can masking subranges of data graphically. In this tutorial, a line graph is created first, then the masking tool is used to mask the low peaks on the graph.
Minimum Origin Version Required: Origin 2015 SR0

6.6.7.2 What you will learn

- Plot a line graph
- Set the scales of axes
- Mask data on the line graph

6.6.7.3 Steps

1. Start with an empty workbook. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Graphing subfolder and find the file Line_Graph_with_Masked_Data.txt. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight both columns in the worksheet and select Plot > Basic 2D : Line from the Origin main menu to plot a line graph.
3. Double click on the X axis to open the **Axis** dialog box. Set the increment value to 0.25 as in the image below:
4. Click the **Vertical** icon on the left panel to set the Y axis scale as in the following image:
5. Click OK to close the Axis dialog and delete the graph legend. Change the X label to Time[s] and the Y label to Signal[A.U.], and bold both text labels and set the font size as 28. Create a title by adding a text object that says Time Series. Bold the title and set the font size of the title to 36.
6. Activate this graph, then click and hold the **Regional Mask Tool** button on the Tools toolbar until a menu appears. Select **Mask Points on Active Plot** to enter masking mode.
7. Click an appropriate place on the graph and drag out a rectangle to select the low peaks and, at the same time, mask them. Drag out additional rectangles until all low peaks are masked. Then click the **Pointer** button on the Tool toolbar to exit masking mode.

Beginning with **Origin 2021**, there is a change to data point selection mode of the masking tools:

- Default is changed from mask by *row index number* to mask by *rectangular region*.
- Otherwise, behavior remains as before: change **masking mode** by pressing Spacebar.
- You can use system variable **@MTI=1** (persistent) to revert mask by row index as default.

### 6.6.8 Symbol Plot with Color Transparency
6.6.8.1 Summary

This tutorial will show you how to create a symbol plot with color transparency, categorical legend and bubble scale. This graph displays a symbol plot of XY data where the size of the symbol and its color have been mapped to two other data columns in the worksheet: Mass and Type. The categorical legend can be utilized to identify Type via color and the bubble scale can be used to check Mass via symbol size. Color transparency has been applied to the plot so that overlapping data points are visible.
This tutorial will show you how to:

- How to control the size and color of plot symbols using values in worksheet columns.
- How to add a legend from categorical values
- How to add a bubble scale and customize it
- How to set the transparency to the symbol plot
- How to add a frame to the graph

6.6.8.3 Steps

This tutorial is associated with <Origin EXE Folder>|Samples|Tutorial Data.opj. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Line and Symbol)

1. Open Tutorial Data.opj and browse to the Bubble with Transparency folder in Project Explorer (PE).
2. Go to Book2G, highlight Col(A)~Col(C) in the worksheet and select Plot > Basic 2D : Bubble from the main menu.
3. Select Format: Plot... in the main menu to open the Plot Details dialog. Then go to the Symbol tab and set the symbol format as in the following:
   - Set Scaling Factor to 3.
   - Click the down arrow next to the Preview box to open the symbol gallery and select the filled circle symbol.
   - In the Symbol Color drop-down list, select Indexing: Col("Type")
   - Set Transparency to 50%.
4. Click **OK** to save settings and close the dialog. The graph should now look like this:

![Graph1](image)

5. To update the axes scales and title, select **Format: Axes: X Axis...** to open the **Axis** dialog box. Modify the following settings:
   - In the **Scale** tab for **X Axis**, choose the following setting:
Click **Vertical** icon on the left panel and go to **Scale** tab for **Y Axis** and set the following:
o Go to Title tab, and change Y axis title as Sample Y-Dimension (cm) and set font and size as following:
Then click **Bottom** icon on the left panel and change X axis title as *Sample X-Dimension (cm)* and set and size as following:
Click **OK** to apply the settings.

6. Double click on the bubble scale to bring up **Bubble Scale Control** dialog. Select **Nested** from **Layout** drop-down list and check **Half Circle** and **Show Leader Line** boxes and click **Apply** as shown in following:
7. Click on the left panel to go to **Levels** page, set **From** as 20 and **To** as 50 and change increment **Value** to 10 as shown in following:
8. Click **Title** on the left panel, check **Show** box and change content in **Title** to be *Mass*, then set the **Size** to be **28** and check **Bold** box. Click **OK** to close dialog as shown in following:
9. The graph is as following now:
10. Go to **Graph:Legend:Categorical Values...** to bring up **Graph Manipulation:legendcat** dialog. Uncheck **Size** box and click **OK** to close the dialog and move the generated legend to a proper position in top-left corner.

11. Right click on the legend and select **Properties** from shortcut menu, customize the text as shown in the following:
12. Click **OK** to close dialog.

13. Select the **Text Tool** button on the **Tools** toolbar and click once to the left side of the page just above the frame. Type the following into the text object: *Agate Cross-Section by Type and Location*. Customize the font. Select and re-position the text object as needed.

The final graph should look something like this:
6.6.9 Symbol Plot with Size and Colormap from Other Columns

- Set Symbol Color and Shape by Other Column
- Using Data from other Worksheet Columns to Control Plot Attributes
- Adding, Grouping and Reordering Plots with Layer Contents
- Find Max and Min of Colormap Levels of Grouped Plots

6.6.9.1 Summary
This tutorial will show you how to create a symbol plot with size and color from other columns.

This graph displays a symbol plot of data from multiple columns where the size and color of the symbol have been derived from other data columns in the worksheets. User defined Colormap has been applied to the plot.

Minimum Origin Version Required: 2016 SR0

6.6.9.2 What you will learn

This tutorial will show you how to:

- How to control the size and color of plot symbols using values in worksheet columns.
- How to set the user defined colormap
- How to edit the grids lines for plot

6.6.9.3 Steps to Construct a Symbol Plot with Size and Colormap from Other Columns

This tutorial is associated with the Tutorial Data project: `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

1. Open the Tutorial Data project and browse to folder Symbol Plot with Size and Color Mapping in Project Explorer.
2. Select the Col(X) and Col(Y) in first sheet of the workbook and click **Plot > Basic 2D : Scatter** to get a scatter plot.

3. Click **Graph: Layer Contents** in main menu with the graph active, and select all the columns with Long name Y, Y1, Y2 and add them into the right panel. Click **Ungroup** button to ungroup all datasets. Click **OK** to close dialog. The order and quantity of column Long name listed in right panel should be exactly the same as the graph, use up and down button to adjust the position, and use **to remove the repetitive items.**

4. Double click the scatter to open the Plot Details dialog, go to **Symbol** tab, Set the Symbol for each plot one by one follows the Graph below, after each step setting, please click **Apply** to make a rudimentary saving.
5. The next 7 steps will guide you finish the symbol setting for each dataplot. Symbol setting for dataplot 1:
6. Symbol setting for dataplot 2
7. Symbol setting for dataplot 3
8. Symbol setting for dataplot 4
Add label for dataplot 4
9. Symbol setting for dataplot 5
Add label for dataplot 5
10. Symbol setting for dataplot 6 and 7, which act as the legend:
11. Then, Click OK to close the window. Double click the Axis X to open the Axis dialog, and set the Scale for both Horizontal and Vertical icons From -50 to 50 with same Major and Minor ticks style:
then click **OK** to apply. you can get a graph like this:
6.6.9.4 Steps to Set the Colormap and Legend

1. The Edge color of the post-Electrical Open and pre-Electrical Open plot both used Map:Col(C), so we will further make some style setting for Color scale in Colormap tab. Click Level to open Set Levels dialog, set levels from 0 to 155 with Major Levels 5.
2. Double click each Level value to edit them and double click each Fill color to edit them as well. Click Apply to apply these color setting to the graph (for the post-Electrical Open scatter).

3. Then we would like to save the setting as a theme named as mycolor.oth. The theme will be applied to the post-Electrical Open scatter.
Apply the theme to the pre-Electrical Open scatter.
Click OK to close the window.

4. Click **Graph: Legend: Dataplot** in main menu, a legend will display in the graph. Right click the legend and click **Properties** in list, and edit the content in Object Properties dialog as follows graph, then click
5. Click **Insert: Color Scale** in main menu, an Color Scale will display in the graph.

6.6.9.5 More Customization Steps
1. Select **Format: Layer** in main menu to open the **Plot Details** dialog, go to the **Size/Speed** tab, edit the Layer Area as follows:

![Plot Details dialog](image)

2. Go to the **Display** tab in **Plot Details** dialog, edit the **Clipping Margins(%)** to -2%, click OK to close dialog.
3. Copy the previous Legend and paste it on the graph, edit the new legend in this way:

![Legend Image]

Click OK to close dialog.

4. Double click the color scale to open the Color Scale Control, go to the Levels page, check on Hide Head Level and Hide Tail Level, then go to the Labels page and set the Display as graph below:

![Color Scale Control Image]

Add a title Elapsed Time for the color scale in Title tab, Click OK to apply.

5. Double click the axis to open the Axis dialog. Set Grids line for both Horizontal and Vertical in Grids tab in the same style as shown in graph below:
6. At last, add a Text "symbol size is relative to event energy" in the graph by using Text Tool in Tools box.

6.7 Column, Bar and Pie

6.7.1 Column, Bar and Pie

- 2D Color Pie Chart of a Population Study
- Bar and Scatter Plot with Error Bar
- Column Graph with Error Bars
- Stack Column With Labels
- Grouped Column with Error Bars and Data Labels
- Grouped Stacked Column
- Stack Column Plot with Different Positive and Negative Y Scale
6.7.2 2D Color Pie Chart of a Population Study

This tutorial will show you how to create and customize a 2D Pie chart.

![Pie Chart of Population by Major Ethnic Groups in Southern California]

- White: 35.7%
- Hispanic: 45.4%
- African American: 9.3%
- American Indian: 0.4%
- Asian/Pacific: 8.9%
- Other: 0.3%
Tutorials for Origin 2024b

Minimum Origin Version Required: Origin 2020

6.7.2.2 What will you learn

This tutorial will show you how to

- Create a 2D Color Pie chart
- Customize the Pie chart with mini toolbar and Plot Details dialog

6.7.2.3 Steps

1. Create a new worksheet paste the sample data shown here.

   ![Sample Data](image)

2. Highlight column B and choose the menu Plot > Basic 2D: 2D Color Pie Chart to plot a 2D pie chart.
3. Right click on the **Legend** and press **Delete** key to delete the legend box.

**6.7.2.3.1 Quick Customization with Mini Toolbar**
4. Click on the pie plot, and in the pop-up mini toolbar, click **Fill Color** button to expand the Color Chooser to select the color list "D02 Maple" in the **By Points** tab.
5. The color list you selected below will be applied to the slices directly. With the mini toolbar still pop-upted, click the Show Data Labels button to select **Categories** in the drop-down list.

![Pie chart with options menu open](image)

6. Now both the percentages and categories are shown as labels for pie slices. Click any white space to exit the mini toolbar of whole pie plot.
7. Click on the slice "Hispanic" twice to select this slice separately, and in the pop-up mini toolbar, click the **Explode** button to explode this slice from the whole pie.

![Pie Chart](image)

### 6.7.2.3.2 Further Customization with Plot Details

8. Double-Click on the pie plot to open the **Plot Details** dialog. With the plot been selected, go to the **Pattern** tab, set **Border Color** to **None** and **Transparency** to 20. Click Apply button to apply the settings.

![Plot Details Dialog](image)

9. Go to the **Pie Geometry** tab, in the **Rotation** control, set **Starting Azimuth(deg)** to **75** and check the **Counter Clockwise** check box.
Please note, you can also use the Rotation Clockwise button and Rotation Count-Clockwise button in the mini toolbar (see the screenshot in step 5) to rotate the pie chart step-by-step. Each click will rotate the pie chart in 10 degrees.

10. Go to the **Labels** tab, under the Leader Lines group, set **Connect** to **2-Seg Polyline** and the percent to 50.
11. Click OK button to close the dialog. Drag the labels farther to avoid overlapping. Add a title on the graph to get the finally graph as below:

![Population by Major Ethnic Groups](image)

6.7.2.4 Sample Data

Open a fresh worksheet and either click this link [http://www.originlab.com/ftp/graph_gallery/data/2D_Pie_Chart.txt](http://www.originlab.com/ftp/graph_gallery/data/2D_Pie_Chart.txt) and copy the data from your browser page; or select the data in the table below and copy.

Click on the empty data cell in row 1, column A(X) and paste the copied data.

<table>
<thead>
<tr>
<th>A(X)</th>
<th>B(Y)</th>
<th>C(Y)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hispanic</td>
<td>45.4</td>
<td>1</td>
</tr>
<tr>
<td>White</td>
<td>35.7</td>
<td>18</td>
</tr>
<tr>
<td>African American</td>
<td>9.3</td>
<td>19</td>
</tr>
<tr>
<td>American Indian</td>
<td>0.4</td>
<td>20</td>
</tr>
</tbody>
</table>
### 6.7.3 Bar and Scatter Plot with Error Bar

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Asian/Pacific</td>
<td>8.9</td>
<td>24</td>
</tr>
<tr>
<td>Other</td>
<td>0.3</td>
<td>18</td>
</tr>
</tbody>
</table>

#### 6.7.3.1 Summary

Below graph is made of bar chart and scatter plot.
What will you learn

- How to add a scatter plot to a bar graph
- How to set the Plus and Minus error bar

Steps

This tutorial is associated with the Tutorial Data project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data project and browse to folder Bar Plot with Errors in Project Explorer.
2. Activate the workbook Book2N, right-click the col(C) to select Set as: Y Error from the context menu.
3. Highlight Col(A), col(B) and col(C), select Plot > Bar, Pie, Area : Column from the main menu to plot a column graph with Y error bar.
4. Activate the graph window, and then select **Graph: Exchange X-Y Axes**.

5. Highlight the col(D) in the worksheet and then activate the graph window again. Select **Insert: Plot to Layer: Scatter** from the main menu to add the col(D) as scatter to the column graph.
6. Double-click the column graph to open the Plot Details dialog. Set the **Color** and **Pattern** options in the **Fill** group of **Pattern** Tab as below.

![Plot Details - Fill Tab](image)

7. Select the scatter plot in the left panel, then set the **Symbol** as below. Then click **OK** button to close the dialog.

![Plot Details - Symbol Tab](image)

8. Activate the graph window, hold the **Ctrl** key and select the first bar to set its pattern as **Dense** as below from the **Style** toolbar.

![Activate Graph Window](image)
9. Select **Graph: Legend: Reconstruct Legend** from the main menu to update the legend for graph.

10. Right-click the legend to select **Properties** from the context menu to open the **Objects Properties** dialog. Set **Background** as **Black Line**. Then edit and move the legend as below.
### 6.7.4 Column Graph with Error Bars

#### Videos
- Plot Error Bars in 2D Graph
- Adding Error Bars to a Graph
- Plot X and Y Error Bars
- Plot Data with Different Y Plus and Minus Error Bars

#### OriginBlog
- Plotting Bar/Column Graphs with Indexed Patterns
- Grouped Columns with Gap between Subgroups

#### Summary
This customized graph shows an example of a bar graph with added error bars. The same Y data is plotted twice, once as a scatter plot and again as a column plot. The error bars are attached to the scatter plot in this case. Error bars can be included in the graph in both the Y and X dimensions.

Minimum Origin Version Required: 2015 SR0

6.7.4.2 What you will learn

- Create and customize a column graph
- Use the Plot Setup dialog to add a new data plot to your graph

6.7.4.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj. (If you don't have the Project file, please download the data file from here)

1. Open the Tutorial Data.opj and browse to the folder Column Graph with Error Bars. Activate the worksheet and make sure the column plot designations are set as X, Y, Y Error and Label accordingly.
2. Highlight column 2 and select Plot > Bar, Pie, Area : Column to create a column graph.
3. With the graph window active, select Graph: Plot Setup... to bring up the Plot Setup dialog box. Click the up-sided double triangle arrow icon to expand top two panels and we will add the scatter data and
In order to show all three panels in Plot Setup dialog, please expand Plot Type panel by clicking and expand Available Data panel by clicking again.

Please refer to Plotting using Plot Setup for more information.

4. Click the Add button to add scatter data to the column plot. Then click OK to go back to column graph window.

5. Double-click the columns to bring up the Plot Details dialog box. Customize the graph using settings on the Pattern tab as shown below:
6. Double-click on the Y axis to open the **Axis** dialog box. Set the Y axis scale as shown in the screenshot below:
7. Then go to the **Tick Labels** tab to set X axis tick labels as shown in following screenshot:

8. Go to the **Grids** tab and click the **Horizontal** icon on the left panel to customize grids for **Y Axis** and turn on major grid lines by duplicating the settings in the image below:
9. Click **Apply** first, and then hold Ctrl key to select both **Vertical** and **Horizontal** icons on the left panel and select the **Opposite** checkbox to turn on opposite additional lines for both X and Y axes.

10. Click **OK** to apply settings and close the **Axis** dialog box. Finally, delete the legend object.

### 6.7.5 Stack Column With Labels

- **Connect Lines in 2D and 3D**
6.7.5.1 Summary

This graph displays a stack column plot. Each data point in each column has been labelled using the associated data value, and custom formatting applied to column fills and labels.

U.S. Population by Race

Minimum Origin Version Required: 2015 SR0

6.7.5.2 What will you learn

This tutorial will show you how to

- Create a stack column plot
- Add labels for columns
- Customize the column graph

6.7.5.3 Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`. 
1. Open **Tutorial Data.opj** and browse to the **Stack Column With Labels** folder in **Project Explorer** (PE).

2. Activate the worksheet and select columns B through E. In the main menu, select **Plot > Bar, Pie, Area : Stacked Column**. Alternatively, you can click the **Stacked Column** button on the 2D Graph toolbar.

3. Double-click the X axis tick labels to open the **Axis** dialog box. Go to **Tick Labels** tab and set the X axis tick labels as following:
4. Select the **Grids** tab and hold Ctrl key to select **Horizontal** icon in left panel to simultaneously apply changes to the **Y Axis**. Check the **Opposite** box to add lines opposite both the X and Y axes:
5. Go to the Scale tab and click Vertical icon on the left panel to set the value of To to 102 for Y axis and click OK to apply settings and close the Axis dialog box.

6. Double-click the plot to open the Plot Details dialog box. On the Group tab, set the Fill Color as shown below:
7. On the Label tab, select **Enable**. Set the **Font**, **Color**, and **Size** to **Verdana**, **white**, and **18**. Set **Label Form** to **Custom** and enter "$(y),.0\%" for the **Format String**.
8. On the **Spacing** tab, set **Gap Between Bars (in %)** to **30**.

9. On the **Pattern** tab, set **Gradient Fill** as shown below:
10. In the left panel, select Layer1. On the **Background** tab, set **Color** and **Gradient Fill** as shown below:
11. Click **OK** to close the dialog box. To complete the graph, change the X and Y axis labels to "Year" and "Population (%)", then add the graph title "U.S. Population by Race."

### 6.7.6 Grouped Column with Error Bars and Data Labels

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Plot Error Bars in 2D Graph</td>
<td>• Plotting Bar/Column Graphs with Indexed Patterns</td>
</tr>
<tr>
<td>• Adding Error Bars to a Graph</td>
<td>• Grouped Columns with Gap between Subgroups</td>
</tr>
<tr>
<td>• Plot X and Y Error Bars</td>
<td>• Plot Jitter Chart with Mean and SE Bar in Origin</td>
</tr>
<tr>
<td>• Plot Data with Different Y Plus and Minus Error Bars</td>
<td>• Plot x and y Error Bar as Rectangular Box</td>
</tr>
</tbody>
</table>

#### 6.7.6.1 Summary

Origin supports grouped column graphs with indexed data. Multiple group levels are supported. Grouping information can be shown in tick label tables on the X or Y axes.
6.7.6.2 What will you learn

This tutorial will show you how to

- Plot grouped column and error bar with indexed data
- Customize tick labels, colors, gaps, error bars and data labels
- Update legend to show grouping information.

6.7.6.3 Steps

1. Select Help: Learning Center menu or press F11 key to open the Learning Center, and then select Graph Sample in left panel and select the category "Column and Bar Charts", find this graph and double-
2. We are going to create a grouped column chart from the worksheet "Weekly Data". Highlight column D(Y2) and E(yErr) and select Plot > Categorical : Grouped Columns - Indexed Data... from the main menu.

3. In plot_gindexed dialog, click in the "Group Column(s)" to add columns B, C, and F (in that order) to the Group List. Click the OK button.

A grouped column plot with error bar is created. The 3-row tick label table at the bottom shows the
grouping information. Note that a worksheet is created to contain the data used to create this graph.
4. To hide the first tick label row, click on the tick label in the 1st row, and in the popup minitoolbar, click the Hide Selected Object button to hide this table row.

5. Double-click on another bottom table row to open the Axis dialog. Go to the Tick Labels tab, select the Bottom 2 icon on the left panel. On the Table sub-tab, clear the Auto box, clear all Border check boxes then click the OK button.
Two tick label rows remain, each with different layout.

6.7.6.4 Further Customizations

The tutorial steps that follow, further customize the graph so that it looks like the image in the Summary section.
1. Click on the left Y axis in the graph, and in the popup mini toolbar, click the **Show Gridlines** button to select **Major** from the drop-down list to add major grad lines for the graph.
2. Click on any error bar in the graph, and in the popup mini toolbar, click the **Direction** button to select **Plus Y Error** from the list to just show the plus Y errors.

3. Click on any column in the graph, and in the popup mini toolbar, click the **Show Data Labels** button to show the labels at the top of the error bars.
Click on any label, and in the popup mini toolbar, set Font Size to "16".

To format the label values, you can double-click on the labels to open the **Labels** tab of **Plot Details** dialog to set the **Numeric Display Format** dropdown list.

For instance, to show a single decimal place for each label, enter ".1", then click **OK**. For more information, see **Custom Numeric Formats**.
4. Double-click on the columns to open the **Plot Details** dialog. To adjust the gap between each week, go to the **Spacing** tab and set the **Gap Between Subsets (%)** to **15** (hint: you can type into the box).

![Spacing tab](image)

5. We are going to use the data in column C to set fill pattern and add a color gradient fill to the column plot. Go to the **Pattern** tab of **Plot Details** and set as follows.

   To set fill **Color** to White, click the drop-down, click the **Single** tab and click the White cell. Similarly, for fill **Pattern**, click the drop-down, click the **By Points** tab, and then click the pencil icon to the right of the pattern list. This opens the Increment Editor, where you create your custom pattern list. Rearrange the top three entries in your custom list as shown, by dragging the numbered buttons to the left side of the pattern gallery.

![Pattern tab](image)
6. Click OK button to close the editor. Click the **Use Column Values** button and choose *Col(C)* from the list. The Gradient Fill should be **One Color** and the direction should be **Horizontal Center Out**.

![Gradient Fill and Direction Settings](image)

7. To change the graph page background color, select the **Graph** icon in the left panel of the **Plot Details** dialog box. Go to the **Display** tab and set color to **LT Gray**.

![Graph Page Background Color Settings](image)

8. To change layer background color to white, select **Layer1** node on left panel of the **Plot Details** dialog. Go to the **Background** tab and set **Color** to **White**. Click **OK** to close Plot Details.

![Layer Background Color Settings](image)

9. To show pattern information in the legend, click the legend, and in the popup mini toolbar, click the **Reconstruct Legend** button to show all categories.

![Reconstruct Legend Button](image)
To arrange the legend horizontally, select the legend, and in the popup mini toolbar, click the **Arrange in Horizontal** button to show these legend entries horizontally.
10. Drag the legend to an appropriate position. Select and press **Delete** to remove the Y axis title.

To center and adjust margins on a finished graph, click on the graph to activate it, then choose **Graph: Fit Layers to Page**. Enter your **Margin** and determine whether to **Maintain Layer Aspect Ratios**, then click **OK**.

### 6.7.7 Grouped Stacked Column

#### Videos

- Plot Error Bars in 2D Graph
- Adding Error Bars to a Graph
- Plot X and Y Error Bars
- Plot Data with Different Y Plus and Minus Error Bars

#### OriginBlog

- Plotting Bar/Column Graphs with Indexed Patterns
- Grouped Columns with Gap between Subgroups

### Summary
In Origin, multiple datasets can be plotted as a stacked column graph. Usually these datasets are grouped together by default. In addition, subgrouping is possible for stacked column graphs such as the one shown below with 2 subgroups:

![Sales Graph](image)

Minimum Origin Version Required: 2021 SR0

6.7.7.2 What will you learn

This tutorial will show you how to:

- Plot a grouped stacked column graph with Online template
- Subgroup a general stacked column to get a grouped stacked column
- Add labels for columns
- Create and customize an X axis table for the graph

6.7.7.3 Create a Grouped Stacked Column Plot

This tutorial is associated with the Grouped Stacked Column folder in the project `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

**Note:** You can also access this sample graph by double-clicking on its thumbnail under the Column and Bar graph sample in the Learning Center dialog (**Help: Learning Center** menu or press **F11**).

There are two methods to create a grouped stacked column plot:

- Since Origin 2021, Origin provides a lot of online templates, you can download the template "Side-by-side Stacked Columns" from **Template Center** and use it to plot a grouped stacked column directly.
- Of course, you can still make a grouped stacked column starting from a general stacked column graph.
6.7.7.3.1 Method 1: Using the Online Template

1. Highlight col(B)~col(G), choose menu **Plot: Template Library** to open **Template Library**. Click the **Open Template Center** button in the upper-right corner.

![Template Library](image1)

2. The **Template Center** will be opened. Search the online template "Side-by-side Stacked Columns" and download it.

![Template Center](image2)

3. After the template is downloaded, close the **Template Center**. This template will be listed in the **Template Library**. Select it and click **Plot Button** to plot the graph.
4. You will get the graph as below:
6.7.7.3.2 Method 2: Subgroup the Stacked Columns

1. Activate the worksheet Sheet1, highlight col(B)~col(G) and select Plot > Bar, Pie, Area: Stacked Column from the menu to create a stacked column graph:

![Stacked Column Graph]

2. Double-click on the column plot to open the Plot Details dialog. On the Group tab, select By Size for Enable subgroup and set Subgroup Size to 3.
3. Select **Layer1** in left panel of **Plot Details** dialog and click the **Stack** tab. Check the **Offset Within Subgroup**(in Group tab) for Cumulative/Incremental check box. Click the **Apply** button.
4. Click **OK** to close the dialog. Select **Graph: Rescale to Show All** from the main menu to rescale the layer. You will get the graph as below:
6.7.7.4 Add Labels for Columns

1. Click on the column, and in the popup mini toolbar, click the Show Data Labels under the Group tab to show the data labels on the columns.

2. Click on the label, and in the popup mini toolbar, click the Label Source button and select Percent from the dropdown list.

Please note, to change the labels of all columns together with mini toolbar, you need select the first plot in current layer group. In this stacked column graph, the bottom one within the first subgroup should be the first plot.
3. Double-click on graph layer to open the **Plot Details** dialog. Select **Layer1** in left panel of **Plot Details** dialog and click the **Stack** tab. Check the **Show Total Label on Stacked Column/Bar**.

![Plot Details dialog](image)

4. You will get the graph with labels as below:

![Graph with labels](image)

7.7.7.5 **Create a Tick Label Table for X Axis**

1. To create two rows of tick labels for the X axis, double-click on the X axis tick labels to open the **Axis** dialog.
- Go to **Bottom** icon with **Tick Labels** tab selected.
- Under **Format** tab, change **Font Size** to **16**
- Under **Table** tab, check the **Enable** checkbox and set **Number of Rows** to **2**. **Bottom** icon will change into **Bottom 1** and **Bottom 2** on the left panel.
- Set the Table layout as shown below:

![Table Layout Diagram]

- The table layout of **Bottom 2** share(s) the settings in **Bottom 1**.

- Select the **Bottom 2** icon and set **Dataset Name** to **[Book4]Sheet1!H** in **Display** tab, and set the **Font size** to **12** in the **Format** tab. This will change the tick label row to the car names from the worksheet **label (Y)** column.
- Set the table layout as the dialog below:
2. Click OK button to close the dialog. Move the Legend box inside the layer. Click on the legend box, and in the popup minitoolbar, click on the button **Data Plot Legend Translation Mode** to select *Long Name* from the drop-down list.
3. You will get the graph as below:
6.7.7.6 Customize Column Colors

1. Double-click on the column plot to open the Plot Details dialog. On Group tab, click the button in the Details column of the Fill Color row. Build Colors dialog opens.

2. Select the first color, set Red, Green and Blue values to 165, 196 and 0, then click Replace button to add this color to the color list.

3. Create five more custom colors using these RGB values: (243, 62, 12), (243, 200, 30), (0, 64, 127) (119, 0, 31), and (124, 191, 243).

4. Select all colors under color(6), click Delete button to remove these colors so that you have just the six custom colors that you just created. Click OK to close the Build Colors.

5. Right-click on empty portion of the graph window and select Add/Modify Layer Title from the context menu. Type Sales as a layer title.

6. Resize as needed, using the green selection handles. Finally, you will get the graph as the Summary shows.
6.7.8 Stack Column Plot with Different Positive and Negative Y Scale

6.7.8.1 Summary

We will show how you can use axis break without a gap to produce this graph, that has much larger Y scale range for the negative bars.

Minimum Origin Version Required: 2015 SR0
6.7.8.2 **What You Will Learn**

This tutorial will show you how to:

- create a stacked column plot with error bars.
- enable an axis break without a gap.
- divide one axis into several segments and set scales separately.

6.7.8.3 **Steps to Add Axis Break with No Gap**

1. Select **Help: Learning Center** menu or press **F11** key to open Learning Center. Select **Graph Sample** tab and then select **Column and Bar Charts** from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Column and Bar Charts - Zero Length Break to Change Axis Scale".

![Learning Center](image)

**Note:** This tutorial is associated with the folder **Custom Axis Scale to Show Different Scale** of the "Tutorial Data" project: `<Origin EXE Folder>\Samples\Tutorial Data.opju`. 


2. Activate the workbook "Temperature & Exothermic Energy". Select all the columns in sheet 1 and choose Plot > Bar, Pie, Area : Stacked Column to create a stacked column plot with error bars.

3. Positive columns cannot be seen since their absolute values are too small comparing to those of negative columns.

4. We can break the Y axis at Y=0 and use different axis scale for those two segments. First double click on the Y axis to open the Axis dialog and set Y Range (in Vertical icon) to be from -180000 to 80.
5. Then go to the **Breaks** tab with **Vertical** icon active, and enable 1 axis break. Also set the Break Half Length to 0 so the break indicator will not show. Set both the **Break From** and the **Break To** to 0 so the axis will break at 0 and no break gap shows. Uncheck **Auto Position** and enter 50 for the **Position** cell.
6. Set Custom Scale for the region after break (Y>0) by clicking **Details**:
7. Click **Apply** to apply the settings and view the updated graph, you can see the axis scales are different for the regions above or below the Y=0 line and the columns for positive values can also be seen in the graph.

6.7.8.4 **More Customization Steps**

The following steps can further customize the graph to be exactly the same as the image in Summary.

1. Set the X scale to be from -2 to 20, **Major tick** by increment 2.
2. Go to the **Grids** tab and select both **Vertical** and **Horizontal** icons, select the **Opposite** check box so the grid lines opposite to both X and Y axes will show.
3. Click **OK** to apply the settings and close the **Axis** dialog.
4. To change the positive and negative column colors to light gray and gray, click on the columns, in the popup mini toolbar, go to the **Single** tab and click the **Fill Color** button, in the expanded
Color Chooser, set the color of positive columns to be gray.

Click on the negative columns to change the color to be light gray just as shown above.

5. To customize the legend, click on the legend object, in the popup mini toolbar, click the Arrange in Horizontal button to arrange two legend entries to be in the same row.

Then you will get the final graph you desired.

6.7.9 Variable Column Width

6.7.9.1 Summary
Origin allows you to specify a dataset to control column/bar width. When the Scaling Factor is 0, the dataset values determine bar width in terms of X axis scale values.

Minimum Origin Version Required: Origin 2020

What will you learn

This tutorial will show you how to

- Plot a stacked column graph
- Set the width of column with a variable and add labels for the columns
- Customize the axis ticks and tick labels

Steps

This tutorial is associated with the built-in graph sample Column and Bar Charts - Variable Column Width.

1. Select Help: Learning Center to open the Learning Center. Select Graph Samples tab in the left panel of Learning Center and then enter the keywords "variable column width" to search the sample. You will got the sample listed as below:
2. Double-click on the graph icon to open this sample. In the opened project folder, activate the workbook **Unit Sales (x1000) and Product Share**, highlight col(B) and col(C) to select **Plot > Bar, Pie, Area: Stacked Column** from menu to plot a stacked column.

3. Click on the plot, and in the pop-up mini toolbar, under the Group tab, use the **Fill Color** button to change the fill color of columns by plots with the specified palette *Lit LT Purple*. Of course, you can select other palette instead.
4. Double-click on the plot to open the **Plot Details** dialog. Go to the **Spacing** tab, select **Col(D): “w”** as **Width (in %)** and set **Scaling Factor** to <0=Use X Unit>.

5. Go to the **Label** tab, check the **Enable** check box, set **Label Form** to **Col(D): “w”** and **Numeric Display Format** to #%.

6. Click **OK** to close the dialog.
7. Double-click on the X Axis to open the **Axis** dialog.
Select **Horizontal** icon in the **Scale** tab, set **From** and **To** to 0 and 1; under the **Major Ticks** branch, select **By Custom Positions** for **Type** and ([Book8]Sheet1!A"Product Share (%)") for **Position**.

Go to **Tick Labels** tab, and then under the **Display** sub-tab, set **Type** to **Tick-indexed dataset** and **Dataset Name** to ([Book8]Sheet1!E"Item").

Under the **Format** sub-tab, set **Wrap Text** to **By Number of Characters** and **Wrap Minimum Width** to 3.
8. Double-click on the Y axis title and change it to **Unit Sales**. Click the white space of the layer, in the pop-up mini toolbar, click **Layer Frame** button to add the layer frame.

9. Right-click the legend box and select **Properties...** from fly-out menu. Edit the legend to display on one line. The graph should look like the following:
6.8 Multi-Axis and Multi-Panel

6.8.1 Multi-Axis and Multi-Panel

- **Double Y Graph**
- **3Ys Y-YY**
- **Stack Lines by Y Offsets**
- **Vertical 2 Panel Line**
- **Multiple Axis Plot**
- **Energy-Level Structure of the Er3+ Ion in A YAG Crystal**
- **Panel Graph with Inset Plots of High-resolution Electron Energy-loss Spectra**

6.8.2 Double Y Graph

---

**Videos**

**OriginBlog**

- **Showcase a 2D Graph with**
6.8.2.1 Summary

This tutorial will show how to create a graph with double Y axes in only one layer.

Minimum Origin Version Required: Origin 2023

6.8.2.2 What you will learn

- Create a graph with double Y axes
- Customize scatter plots
- Change axis scale

6.8.2.3 Steps

This tutorial is associated with the project: \Samples\Graphing\Double-Y.opj.
6.8.2.3.1 Method 1: Using Built-in Double-Y Template

1. Open the project `\<Origin Installation Directory>\Samples\Graphing\Double-Y.opj` and activate the workbook.

2. Highlight four columns of data in the worksheet, then choose menu **Plot > Multi-Panel/Axis** : **Double-Y** to create a graph with double Y axes.

3. Click on the plot, in the popup mini toolbar, click the button **Change Plot to** to select Scatter to change the plot type for all the plots.
4. Click on one scatter point of second plot, in the popup mini toolbar, switch to the Single Plot tab and set the color to Blue.
5. Click on bottom X axis, in the popup mini toolbar, click the button **Axis Scale** to open the Axis Scale dialog to set the axis scale for Bottom X, Left Y and Right Y.

6. You will get the final graph as below:

![Graph Image]

6.8.2.3.2 Method 2: Adding Right Y to the Graph with Left Y

1. Highlight four columns of data in the worksheet, then choose menu **Plot > Basic 2D : Scatter** to create a scatter graph.
2. Double-click on the scatter to open the Plot Details dialog. Select second plot in the left panel and go to Display tab and select Right Y Axis to make this plot against the right Y axis. **Note**: You can also use the Object Manager to assign a plot to a right Y axis as outlined here.

3. Click on the second plot, in the popup mini toolbar, change the symbol color to **Blue**. And change the symbol shape to **Square**.
4. Click on the white space of current layer to add layer frame from the mini toolbar.
5. Set the axis scale just like what we do in the Step 5 of Method 1.
6. You will get the same graph as that in Method 1.

**Note:** This kind of double-Y graph only has one graph layer, which is different from the 2Ys graph.

For the versions earlier than Origin 2023, Origin doesn't support two different axis scales for right Y and left Y in same layer simultaneously, so you have to plot the 2Ys graph to implement this graph.

### 6.8.3 3Ys Y-YY

### Videos
- Multi-Y Plots Using Templates

### OriginBlog
- Showcase a 2D Graph with Multiple Origin Features
- Plotting a Trellis Plot with Double Y Axis
- How to Make a Neat Double-X Graph
6.8.3.1 Summary

This tutorial will show how to create a graph with three Y axes; one left Y axis and double right Y axes.

Characteristics of Samples Grown Under Different Conditions

6.8.3.2 What you will learn

- Create a graph with three Y axes; one left Y axis and double right Y axes.
- Customize scatter plots.
- Change axis scale, type, title, etc.
- Add an axis to an existing graph.
- Update the graph legend.

6.8.3.3 Steps

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select Multiple Axis Graphs from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Multiple Axis Graphs - 3Ys Y-YY".
Note: This tutorial is associated with the folder 3Ys Y-YY of the "Tutorial Data" project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

2. Highlight all data columns in the workbook "Book4", select Plot > Multi-Panel/Axis: 3Ys Y-YY main menu to create a graph with three Y axes - one left Y and two right Y.

3. Customize the data plots:

   - Click the black plot in Layer1, and in popup mini toolbar, click Change Plot to button to change the plot type to Scatter.
Click this plot again, and in the popup mini toolbar, click **Symbol Edge Color** button to set the symbol color to **Olive**; and click **Plot Symbol** button to change the symbol to **Triangle**.

Click the data plot (on the symbol, not error bar) in Layer2, and in popup mini toolbar, click **Change Plot to** button to change the plot type to **Scatter**. Click on the error bar of this plot, and in popup mini toolbar, click **Line/Border Color** button to change the color to black.
4. Click the plot in Layer3, and in the popup mini toolbar, click **Plot Symbol** button to change the symbol to solid circle.

4. Let’s customize the X axes:

- Click on the bottom X axis, and in the pop up mini toolbar, click **Axis Scale** button to open the **Axis Scale** dialog to configure the X axis scale as shown in the following:

- Click on the bottom X axis again, and in the pop up mini toolbar, click **Show Opposite Axis** button to show the top X axis.
5. Let's customize the Y axes:

- Click on the left green Y axis, and in the popup mini toolbar, click *Axis Scale* button to open the **Axis Scale** dialog to configure the left Y axis scale as below:

  ![Axis Scale dialog](image)

  - Log: **on**
  - From: 1E-34
  - To: 100
  - Tick Increment: 1

- Click on the right green Y axis (the 1st one), and in the popup mini toolbar, click *Axis Scale* button to open the **Axis Scale** dialog to set **From** = 765 and **To** = 795, and set the **Major Ticks** increment **Value** to 10.

- Click on the right blue Y axis (the 2nd one), and in the popup mini toolbar, click *Axis Scale* button to open the **Axis Scale** dialog to set the axis scale to read from 0 to 6 with a major tick increment **Value** = 1.

6. On the graph, right-click the legend object and choose **Properties** from the shortcut menu. This opens the **Object Properties** dialog box. Go to **Frame** tab, and change **Frame** to **Shadow**. Go to **Text** tab,
and enter the text shown below, then click **OK** to close the dialog box. Reposition the legend object, as needed.

7. Add a graph title by creating a text object and typing *Characteristics of Samples Grown Under Different Conditions*. Reposition as needed.

8. Double-click on the left Y axis to open the Axis dialog. Go to Title tab, check Show check box and enter *Deposition Pressure (Torr)* into the Text box to add the axis title for left Y axis for Layer1.
9. **Select** Graph: **Fit Page To Layers...** to open the **Fit Page to Layer** dialog, accept the defaults and click **OK** to adjust the page size to better fit the graph layers.

10. To the right side of the graph, click once to select the axis titles and the blue Y axis, then drag to reposition them so that they don’t overlap one another. Your graph should now look something like this:
6.8.4 Stack Lines by Y Offsets

6.8.4.1 Summary

This tutorial will demonstrate how to create a graph with stack lines by Y offsets.
Aside from the stacked individual line plots described in this tutorial, you can create stacked line plots comprised of sub-groups of lines, with offsets created between sub-groups. See the Plot Details Stack tab for details.

6.8.4.2 What you will learn

- How to create a graph with stack lines by Y offsets
- How to customize a rectangular object
- How to add a new XY scaler

6.8.4.3 Steps

This tutorial is associated with the Tutorial Data project: `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

6.8.4.3.1 Create a Stack Line Plot

1. Open the Tutorial Data project and browse to folder Stack Lines by Y Offsets in Project Explorer.
2. Highlight all the columns in the data worksheet of Book6A, and choose menu Plot > Basic 2D : Stacked Lines by Y Offsets to create a graph with stack lines by Y offsets.

6.8.4.3.2 Customize the Stack Line Plot

1. Delete the following objects by selecting them and pressing the Delete key on your keyboard:
   - Legend
   - Y axis
2. Click on the X axis, and select **Axis Scale** button in the Mini Toolbar to open the **Axis Scale - X** dialog. Set **To** value to 10. Click **OK** to close the dialog.

---

6.8.4.3.1.3 Add XY Scaler

1. Click the **Rectangle** button on the **Tools** toolbar and then create a rectangle on the graph.

2. Double click on the rectangle to open its properties dialog. Change the following settings.

   **Fill tab**
**Fill Color** = LT Yellow

![Object Properties - Rect](image)

Dimensions tab

- **Units** = scale
- **Left** = 0.25
- **Top** = 9000
- **Right** = 3.75
- **Bottom** = 5000
3. Click OK to close the **Object Properties** dialog.

4. Select **Insert:XY Scaler** from the Origin menu to create a new XY scaler.

5. Double click on the scaler to open the **Scaler Properties** dialog. Set the following properties in the dialog:
   - **Font Settings** branch
     - **Font Size** = 24
   - **X** branch
     - **Length(Scale)** = 2
     - **Title** = 2
   - **Y** branch
     - **Position** = Right
     - **Length(Scale)** = 2500
     - **Title** = 2500
6. Click OK to close the Scaler Properties dialog.
7. Move the scaler object onto the rectangle you created.

6.8.4.3.1.4 Drag and Change Plot Offset

1. Click once on the top data plot to select it.
2. Drag with the mouse to move the data plot.

Note: an alternative is to go to the Offset tab in Plot Details dialog and change the Y offset.
6.8.5 Vertical 2 Panel Line

This tutorial will demonstrate how to merge and customize two graphs.

Minimum Origin Version Required: Origin 2015 SR0

6.8.5.2 What You Will Learn

In this tutorial, you will learn how to:

- Merge graph windows
- Customize graph axes after merging
Graphing

- Apply a graph theme

6.8.5.3 Steps

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Graphing subfolder and find the file Vertical_2_Panel_Line.txt. Drag-and-drop this file into the empty worksheet to import it.

2. Select column 2 to column 4, select Plot > Basic 2D: Line + Symbol main menu or click the Line + Symbol button on the 2D Graphs toolbar.

The following graph will be created:
Go back to the worksheet. Select column 5 to column 8 and click the Line + Symbol button on the 2D Graphs toolbar to create a new graph as shown below:

3. To merge the two graphs, select Graph: Merge Graph Windows from the menu. Accept the default settings and click OK. The two graphs will merge in one window:
4. Ensure that Layer 1 is selected on the top left corner of the graph and double-click on the Y axis of Layer 1 to open the Axis dialog. In the Scale tab, set the dialog options as shown below:
5. Click *Horizontal* icon on the left panel, and go to *Tick Labels* tab, uncheck the *Show* box to hide the tick labels in Layer 1 and click *OK* to apply settings.
6. Delete the X axis title in Layer 1. Set the same scale for the Y axis of Layer 2. The graph should now appear as shown below:
7. Apply a theme to add a top X axis and a right Y axis. Select **Preferences: Theme Organizer** from the main menu to open the **Theme Organizer** dialog. Activate the **Graph** tab and select the **Opposite Lines** from the table and click the **Apply Now** button. Use the **Close** button to close the dialog.
8. Select the **Legend** of Layer 1 and right-click on it to select **Properties** from the short-cut menu. Set the dialog options as shown below:

![Object Properties dialog]

Move the legend to the desired position.

9. Select the **Line** button from the **Tools** toolbar and draw a line on the Layer 1 as shown in the sample image. Hold down the **SHIFT** key while drawing to ensure that the line is vertical. Double-click on the line to open the Properties dialog of the line object. In the **Line** tab, select **Dash** in the **Type** drop-down list and enter 2 in the **Width** edit box. Click on the **Dimensions** tab. Select both the **Horizontal Movement** and the **Vertical Movement** check boxes. Click the **OK** button to finish.

10. Repeat steps 8-9 for Layer 2.

11. Select the **Text** button in the **Tools** toolbar. To add a title for the graph click in the middle of the graph and enter **Cigarette Smoking by Persons 18 Years and Over in the United States**. Double-click on the **Y** axis title of Layer 1 and Layer 2 and enter **Percent Who Smoke**.

The final graph should appear as shown below:
6.8.6 Multiple Axis Plot

6.8.6.1 Summary

This tutorial will demonstrate how to create a 4-Y plot and add recession bars.
Minimum Origin Version Required: Origin 2015 SR0

6.8.6.2 Steps

1. Create a new workbook, select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Graphing subfolder and find the file multi_axis_plot.txt. Drag-and-drop this file into the empty worksheet to import it.

2. Place the mouse cursor near the top left corner of the worksheet. When the cursor changes to a down-right arrow, left-click to select the whole worksheet.
3. Right-click and select **Set as: XY XY** from the short-cut menu to set proper plotting designations for the worksheet columns.

4. Highlight columns A through H. From the main menu, select **Plot > Multi-Panel/Axis: 4Ys YY-YY** to create a plot as shown below:
5. Double-click on the X axis to open the **X Axis - Layer 1** dialog box. Click the **Reference Lines** tab, then click the browse button to the right of the **Reference Lines at Value** box. The dialog rolls up, allowing you to select the col(I) of the worksheet. Click **Done** to return to the **Reference Lines** tab.

6. Check the **Alternate Fill** box, then check the box in the header of the **Line** column twice to clear all check marks from the column. Click **OK** to close the dialog and add a series of shaded regions representing **Recession Periods**, to the graph.
7. Double-click again on the bottom X axis to open the **Axis** dialog for Layer 1. On the **Scale** tab, change the dialog options as shown below and **Apply**.
8. Go to **Tick Labels** tab, change the dialog options as shown below and **Apply**.
9. Go to **Line and Ticks** tab, click the **Top** icon on the left panel and check **Show Line and Ticks**. Then choose **In** for **Style** under **Major Ticks** and **None** for **Style** for **Minor Ticks** and click **OK** to apply settings and close the dialog box.
10. Right-click on the legend object and choose **Properties**. Click the **Add Legend Symbol** button to the right, choose a filled-square for the **Shape**, for **Symbol Color** choose **LT Gray**, and for **Size** choose **30**. Click **Add** and **Close**. A new symbol is added to the legend preview box.

11. Click into the line of code that was just added to the top box, scroll to the end and type **Recession Period**. Click okay to close the dialog box.

12. Resize and reposition the legend as needed, and right-click on each curve to choose the context menu **Change Plot to: Line** to change the line+symbol curves to line curves. Finally, you will get the graph as below.
6.8.7 Energy-Level Structure of the Er3+ Ion in A YAG Crystal

6.8.7.1 Summary

This tutorial will demonstrate how to create a graph showing the energy-level structure of the Er3+ ion in a YAG crystal.
What you will learn

This tutorial will demonstrate how to:

- Create a graph by selecting part of the data from a column
- Set symbol properties
- Merge graphs
- Change the size and position of a layer

Steps

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Graphing subfolder and find the file Van_Rudd_Er_Energy_Levels.txt. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight column B and create a symbol plot by selecting menu Plot > Basic 2D : Scatter.

3. Double click the data points scatter to open the Plot Details dialog. In the Symbol tab of the right panel, change the symbol and symbol color as shown below:
4. In the Drop Lines tab, check the Horizontal box and set Width to 1. Click OK to apply the changes.
5. Double click on the X axis to open the **Axis** dialog. Set the X axis scale from 0 to 1 in the **Horizontal** icon in **Scale** tab:
6. Go to the Line and Ticks tab, Tick Labels tab, and Title tab respectively, make sure Bottom icon is selected and deselect the Show Line and Ticks or Show box to hide all elements in the bottom X axis including line & ticks, labels and title:

![Image of Line and Ticks settings](image)

7. In the Vertical icon in Scale tab, set the following for the Y axis scale: From: 0, To: 24000, Value(in Major Ticks Group): 2000.

8. Go to Left icon in Title tab, change the Text for the Y axis title to Energy Levels (cm\+\(-\)):
9. Go to the the **Left** icon in **Line and Ticks** tab, select **In** from the drop down menu for **Major Ticks** and **Minor Ticks**:
10. Use **OK** to save the axis settings. Delete the legend object in the graph by selecting it, right-clicking and choosing delete from the drop down menu. The graph should appear as shown below:
11. Highlight cell 1-8, cell 9-15, cell 16-21, cell 22-26, cell 27-31, cell 32-43, and cell 44-48 respectively, to plot scatter graphs by selecting menu **Plot > Basic 2D : Scatter** and then repeat step 3 through step 11 to make another 7 graphs. Set the increment value of the Y axis (step 7) to 100, and the From and To values as 0 to 600, 6500 to 6900, 10200 to 10500, 12300 to 12800, 15200 to 15600, 18300 to 20800, 22200 to 22700, respectively. The Title in Y axis (step 8) are also different and should be set as \(+4I\)-\((15/2), +4I\)-\((13/2), +4I\)-\((11/2), +4I\)-\((9/2), +4F\)-\((9/2), +4F\)-\((7/2) +2H2\)-\((11/2) +4S\)-\((3/2), and +4F\)-\((3/2) +4F\)-\((5/2), respectively. Then set the Y axis Major Ticks and Minor Ticks to None.

12. In order to change the rotation angle of the Y title created in step 9, select the Y title, choose **Properties** from the right-click menu and set the **Rotate(deg.)** to 0 in the **Object Properties** dialog that opens.
13. Activate one of the graphs and select menu **Graph: Merge Graph Window**. Change the settings as shown below and click the **OK** button to merge the 8 graphs previously created.
14. Double click on the merged graph to open the **Plot Details** dialog. In the **Size/Speed** tab of Layer 1, change the **Layer Area** as shown below:

![Plot Details dialog](image)

15. Set the other layers’ sizes to 15 x 15 (Width and Height in step 15), and move them to the desired position. Adjust the size of the Y axis label and add the corresponding arrows and circles. The graph should appear as shown below:
6.8.8 Panel Graph with Inset Plots of High-resolution Electron Energy-loss Spectra

- Merge Graphs
- How to Merge Graphs in different project files
- Browser Graph Stack
- Create Stack Graph with Common Scale Units
- Add Multiple Axis Breaks to show details in one region
- Axis scale after break

**Videos**

**OriginBlog**

- Making Dynamic Inset Graphs
- Browser Graph Improvements in Origin 2021
6.8.8.1 Summary

Origin can be used to create a three panel graph with inset plots similar to the image shown below:

![Graph of Wurtzite GaN](image)

Minimum Origin Version Required: 2015 SR0

6.8.8.2 What you will learn

This tutorial will demonstrate how to:

- Use the Plot Setup dialog to create curves on one graph using data from multiple workbooks.
- Add Inset Graphs.
- Copy and Paste Style formats.
- Use the Layer Management dialog to link axes.

6.8.8.3 Steps

6.8.8.3.1 Using the Plot Setup dialog
This tutorial is associated with `<origin exe folder>\Samples\Tutorial Data.opj`.

1. Open the Tutorial Data.opj and go to the folder `Three Panel Graph with Inset Graphs`.
2. Activate the workbooks `Measured` and `Original name: BOS`.
3. Ensure that nothing is selected in either workbook and click the line button on the 2D Graphing toolbar.
4. This will bring up the **Plot Setup** dialog box.

In order to show all three panels in **Plot Setup** dialog, please expand **Plot Type** panel by clicking and expand **Available Data** panel by clicking again.
5. Under **Available Data** select the **Worksheets in Folder** option from the drop-down list. This will ensure that in the panel to the right, data is available from all the workbooks in the current folder.

6. Make sure that the **Original name: BOS** worksheet is selected as shown above. In the center panel enable the box corresponding to **X** and **A4** and the second box corresponding to **Y** and **B4**.

7. This will set col(A4) as the X values and col(B4) as the Y values regardless of column designation in the workbook. Select **Add** and a new curve will be created in the pre-existing Layer on the third panel:

8. On the first panel, change the highlighted workbook to **Measured**.

9. On the left, set **Plot Type** to **Scatter**.
10. On the second panel, select the check boxes as shown below:

![Plot Setup: Select Data to Create New Plot](image)

- Select **Add** and the plot will be added to the Layer in the third panel. Select **OK** to close the dialog box.

Your graph should look like the one shown below:

![Graph Example](image)
12. Activate one of the workbooks and follow the procedure above to create two more graphs using the following designations in the Plot Setup dialog (remember to change the plot type to Scatter for the data from Measured):

**Graph 2**

<table>
<thead>
<tr>
<th>Worksheet Name</th>
<th>Set X as</th>
<th>Set Y as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original name:</td>
<td>A1</td>
<td>B1</td>
</tr>
<tr>
<td>BOS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured</td>
<td>C</td>
<td>D</td>
</tr>
</tbody>
</table>

**Graph 3**

<table>
<thead>
<tr>
<th>Worksheet Name</th>
<th>Set X as</th>
<th>Set Y as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original name:</td>
<td>A2</td>
<td>B2</td>
</tr>
<tr>
<td>BOS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured</td>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

### 6.8.8.3.2 Adding Inset Graphs

1. Select the **Add Inset Graph With Data** button on the Graph toolbar to add an inset graph to each graph. Each inset graph appears on its own layer and each graph can be customized, zoomed, panned and moved around like the full-size parent graph it was created from.

2. Select and drag each graph to the center:

![Inset Graph Example](image)

### 6.8.8.3.3 Merging Graphs
1. From the Origin menu select **Graph: Merge Graph Windows: Open Dialog**. Alternatively select the button on the **Graphs** toolbar.

2. In the **Graph Manipulation: merge_graph** dialog that opens, under **Arrange Settings**, set the **Number of Rows** as 3 and the **Number of Columns** to 1. The Preview will appear on a panel to the right.

3. Enable the check box for **Treat Each Source Graph as a Unit**, to keep the graphs and the corresponding inset graphs linked.

4. Enable **Show Axes Frames** to add frames around each graph:

5. Click **OK** to exit the dialog.

### 6.8.8.3.4 Customizing Plots and the Copy Format Feature

1. Double-click the first graph to open the **Plot Details** dialog box.

2. Use the button to expand the left panel. Click on the arrow next to the **Layer1** icon to expand it and show the layer 1 contents.

3. Select the plot *[Measured]*!E[ X ]... and on the **Symbol** tab, change the symbol to a circle, the **Size** as 5 and the **Symbol Color** to **Red** as shown below. Select **Apply**.
4. Select the plot \([ \text{Fitted}\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!\!"
Beginning with Origin 2018b, you can use the Plot Details Common Display controls for simultaneous editing of layer, plot and axis properties in a multi-layer graph. For more information, see The (Plot Details) Layers tab controls.

6.8.8.3.5 Using the Layer Management Dialog Box to Link and Customize Axes

The next step is to set the scales on the axes and add axis breaks to show the important parts of the graphs.

1. Select Graph: Layer Management. In the dialog box that opens there will be a panel named Layer Selection on the left. It lists all six of the layers in this graph - 3 for parent graphs and 3 for inset graphs.

2. In order to customize one parent graph axis and have the changes implemented on the other two parent graphs, the axes are linked in the Link tab. The first Layer cannot be linked so it is the one that is customized and the other graphs are linked to it. Select Layer 3 and in the Link tab set Link to as 1 and set X Axis Link and Y Axis Link as Straight[1 to 1] as shown below:
3. Click **Apply**.
4. Do the same for **Layer 5** and click **Apply**.
5. Click **OK** to exit the dialog box.
6. Double-click any axis on the first graph to open the **Axis Dialog**.

7. Go to **Horizontal** icon in **Scale** tab, set **From** and **To** to -250 and 1500. Set the Increment Value on the **Major Ticks** section as 250.

8. Go to **Horizontal** icon in the **Breaks** tab, set **Number of Breaks** to 1.
9. Select **Break 1** under the **Breaks** node and create a break **From**: 850, **To**: 1250.

10. On the same page, clear the **Auto** check box for **Position (% of Axis Length)** and set it as 75.
11. Go to **Vertical** icon in **Scale** tab, set the scale as From: 0, To: 0.22 with increments of 0.1.

12. Select **OK**. All three graphs will now reflect your changes.
13. To customize the Inset Graphs, zoom into the first one on Layer2 using the **Zoom Pan** button on the **Tools** toolbar. Use the mouse wheel to zoom in.

14. Once zoomed in, select the **Pointer** button on the **Tools** toolbar to exit the zoom mode. Double-click on the Inset Graph to open the **Plot Details** dialog. Select the \([\text{Measured}]\text{Sheet1}!\text{E}[X]...\) graph and on the **Drop Lines** tab, check the **Vertical** box. Click **OK**.

15. Double-click on any axis.

16. In the **Axis Dialog** that opens, set the scale for the **X Axis** on the **Scale** tab From: **1350**, To: **1450**, with increments of **50**.

17. Under the **Vertical** icon, set the scale From: **0**, To: **0.03**. Go to **Lines and Ticks** tab and on the left icon, set the Major Ticks to **None** and the Minor Ticks to **None**.
18. Select **OK** to exit the dialog box. Select the tick labels on the left Y axis and press **Delete** to remove them. Do the same with axis labels.

19. Press **CTRL+W** to zoom out and return to normal graph size.

20. Select the customized Inset Graph, right-click and choose **Copy Format: All Style Formats** from the context menu.

21. Select, right-click and **Paste Format** to the other two Inset Graphs, to duplicate the drop lines settings.

22. Repeat the last two steps, this time selecting **Copy Format: Scales** to duplicate the axis settings.

### 6.8.8.3.6 Adding Titles, Legend and Text Objects

1. Activate the first Layer by clicking the layer icon on the top left corner of the graph. Right-click on the graph and from the context menu choose **Add/Modify Layer Titles**. Type **Wurtzite GaN** in the box that opens, change the font size and type face as desired and drag to an appropriate position:

![Graph with Wurtzite GaN title]

2. Select the legend objects for the second and third graphs and press **DELETE**.

3. Select the remaining legend, right-click and choose **Properties**. In the **Text** tab of **Object Properties** dialog box, type **Fitted** in place of **%(1)** and **Measured** in place of **%(2)**. Place both on the same line. Set the font size as desired. Go to **Frame** tab, and set the **Frame to None**. Click **OK** and drag the legend object to an appropriate place.
4. Delete the first and third Y-axis titles. Double-click the second one and type \textit{Intensity [arb. units]}. Do the same for the single X-Axis title, labeling it \textit{Energy Loss [cm}^{-1}\text{].}

5. Right-click on the graph and choose \textit{Add Text} from the context menu or choose the \textbf{T} button on the \textbf{Tools} toolbar. Add text objects as shown below. Use the \textbf{x}_2 button for writing subscripts:

6. Select each of the inset graphs and change size or position as desired. Use the \textbf{button} on the \textbf{Tools} toolbar to create arrows where desired on the Inset Graphs:
7. The final graph should appear as shown below:
6.9 Contour

6.9.1 Contour

- XYZ Contour
- Contour Plots and Color Mapping
- Ternary Contour
- Contour Graph with XY Data Points and Z Labels
- Contour Plot with Vector Overlay
- Create Heatmap with Virtual Matrix and Colormap Bar Plot
- Contour plot in Sphere Surface Projections

6.9.2 XYZ Contour

6.9.2.1 Summary

This tutorial will show you how to create a contour from XYZ data, and add the X and Y boundary.
Prior to Origin 2018 SR0, the application of a custom boundary sometimes generated an imperfect fill at boundary margins. This has been improved in 2018. The user can restore the previous contour-fill behavior using system variable @TCSM.

6.9.2.2 What will you learn

This tutorial will show you how to

- Create a Contour Plot from XYZ data
- Customize levels, lines, and color mapping
- Use a Custom Boundary
- Customize the Color Scale
- Customize the axes of the plot
This tutorial is associated with the built-in graph sample **Contour Plots - XYZ Contour**.

1. Select **Help: Learning Center** to open the **Learning Center**. Select **Graph Samples** tab in the left panel of **Learning Center** and then enter the keywords "XYZ Contour" to search the sample. You will got the sample listed as below:

![Learning Center](image)

2. Activate the workbook and highlight column D and then select **Plot > Contour : Contour - Color Fill** menu to create a color-filled contour plot.

![Contour Plot](image)

3. Click on the plot, and in the pop-up mini toolbar, click the **Set Levels** button to open the **Set Levels** dialog. In this dialog, set **From** and **To** to 0 and 75 and **Major Levels** and **Minor Levels** to 15 and 4. Click **OK** button to close the dialog.
4. Click on the plot again, and in the pop-up mini toolbar, click the Palette button to select **Rainbow** from the Palette list.
5. Click on X axis, and in the pop-up min toolbar, click the **Axis Scale** button to open the **Axis Scale** dialog. In the dialog, set **From, To** equal to **-127, -65**. Click OK button.
6. Do the same operation on Y axis, and set \textbf{From=23, To=50} for it.

7. Click on any white space inside the layer frame to select the layer, and in the pop-up mini toolbar, click the \textbf{Axis Arrangement} button to select \textbf{None} button under the pop-up list to hide all axes for this plot.
8. Double-click on the contour plot to bring up **Plot Details** dialog. Go to the **Contouring Info** tab, select Custom Boundary radio box, and select \( \text{Col(E)}: \) "Boundary X" as **Boundary X Data** and \( \text{Col(F)}: \) "Boundary X" as **Boundary Y Data**. Then, set **Smoothing Parameter** to 0.0490234.

![Plot Details - Plot Properties](image)

9. Go to the **Colormap / Contours** tab, clear the check box **Follow Contour Line** under **Boundary** so that the boundary line could have separate style. Click the **Lines** heading, make sure that **Show on Major Levels Only** is selected. Select the **Color** check box under **Apply to All** and choose **LT Gray** from the drop-down list as contour line color. Click **OK** to close dialog.

![Colormap / Contours](image)

10. Click on the line at value 30 to customize it separately and click **OK** to close dialog.
11. Now we are going to change the layer size/aspect ratio. Select **Layer1** in the left panel, go to the **Size** tab and change the values in **Layer Area** as below:

12. Click **OK** to close the **Plot Details** dialog. With the graph window activated, select **Graph : Fit Page to Layers...** menu to open the **Fit Page to Layers** dialog, accept the default dialog settings and click **OK** to make all elements visible.

13. Now we will customize the color scale object. Double-click on the color scale to bring up the **Color Scale Control** dialog. Then do the following settings:
14. Click OK to apply the settings and close the Color Scale Control dialog.

15. Right-click above the contour plot and select Add Text to add a graph title 30-Year Mean Temperature for the Month of January. Use the Format toolbar and/or double-click on the completed text label to update the font, font size, etc. The graph should look like

![30-Year Mean Temperature for the Month of January](image)

### 6.9.3 Contour Plots and Color Mapping

- **Contour Plots and Color Mapping**
- **Contour Levels**
- **Plot 3D or Contour Graph from Virtual Matrix**
- **4D XYZ Plot With Custom Boundary**

### Videos

- XYZ Contour plot with colormap from second Z and custom boundary
- How to make a contour plot of the difference between two contours
- Stacked Contour Plots in Cylindrical Coordinates
- Contour Plot in Cylindrical Coordinates
- Faster plotting for large data in Origin 2020
6.9.3.1 Summary

Origin offers rectangular, polar, and ternary contour plots. For rectangular contour plots, the data can be either in a matrix or in a worksheet in XYZ format. Polar contour plots can be generated from three columns of data in a worksheet, organized either as R Z or R Z. Ternary contour plots can be generated from worksheet data organized in X Y Z Z format where the 2nd Z-column contains the 4th parameter which is the height value at a given XYZ point in the ternary space.

Many options are available for customizing contour plots, such as setting different major and minor contour levels, displaying contour lines only at major levels, applying color palettes, and also control for a custom boundary in the case of contour plots created directly from the worksheet.

6.9.3.2 What You Will Learn

This tutorial will show you how to:

- Set values in a Matrix and create a Contour Plot
- Customize levels, lines, and color mapping
- Extract data from contour lines
- Create a Contour Plot directly from XYZ data
- Use a Custom Boundary

6.9.3.3 Create Contour Plot from Matrix

1. To create a new matrix click the New Matrix button. Move the cursor to the upper left corner of the matrix until the shape of the pointer changes as in the following image and click to select the entire matrix.
To set the dimensions, right-click and select **Set Matrix Dimension/Labels** in the context menu. On the XY Mapping tab, change setting as shown below.

2. Input data into the matrix by highlighting it and right-clicking. Select **Set Matrix Values** in the context menu to open the **Set Values** dialog. Type $i \times \sin(x) - j \times \cos(y)$ in the **Formula** edit box and click the **OK** button to generate data. The matrix should look like this:
3. Each data point in the matrix corresponds to two different kinds of indices. One is the column and row indices. The other is the X and Y coordinates. Select View: Show X/Y from the main menu to see the X, Y coordinates:

![The X coordinates and The Y coordinates]

4. You can also select View: Image Mode to show the image form of the matrix:

![Image Mode]

5. Select View: Data Mode to exit the image mode. Create a contour plot by activating the matrix and selecting Plot > Contour: Contour - Color Fill. The graph should appear as shown below:

![Contour Plot]
6.9.3.4 **Customize Levels, Lines and Color Map**

Origin makes it easy to customize every aspect of the contour plot, including the color scale and adding labels:

1. **Active Graph1**, and select **Graph: Speed Mode** menu to open the dialog. Set **Speed Mode = Off** and click **OK**

2. Click on the Contour plot in **Graph1**, and then click on the **Set Levels** button on the pop-up Mini Toolbars. In the **Set Levels** dialog, click the **Find Min/Max** button and set **Major Levels** to **8** and **Minor Levels** to **32**. Click the **OK** button.
3. Click on the Contour plot, and then click on the **Palettes** button on the pop-up Mini Toolbars. Then select the **Rainbow** palette from the drop-down.
4. Click twice on a contour line (two separate single clicks) to select all lines at that level. Change the color to **Green** by using the **Line/Border Color** button in the **Font** toolbar. Change the width to **3** by using the **Line/Border Width** button in the same toolbar.
5. Make sure only one contour line is selected (not all the contour lines at that level) and right click on the selected contour line. Select *Add Contour Label* to add a label.

3 Contour Labels have been added. You can use the menu option to add more.

The Color and Width have been changed.
6. Click twice on a contour line to select it, right click and select **Extract Contour Lines**. Origin will extract the data for that contour line to a worksheet. The following image shows part of the data in the worksheet:

![Contour Lines from Graph1](image)

6.9.3.5 **Create a Contour Plot from XYZ Data**

Origin can create contour plots directly from XYZ data in a worksheet without the need for an intermediate matrix. Delaunay Triangulation is used to compute and draw the contour lines.

1. Start with an empty worksheet. Select **Help: Open Folder: Sample Folder...** to open the "Samples" folder. In this folder, open the *Matrix Conversion and Gridding* subfolder and find the file *3D XYZ.dat*. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight the third column and right click on it to select **Set As: Z**. Select **Plot > Contour: Contour - Color Fill** to create a graph as in the following image:
6.9.3.6 Show the Triangulation Grid

1. Show the triangulation grid that is used to create a contour plot from the data. The individual data points are located at the nodes or vertices of the grid.

2. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Matrix Conversion and Gridding subfolder and find the file XYZ Random Gaussian.dat. Drag-and-drop this file into the empty worksheet to import it.

3. Highlight the third column and right click on it to select Set As: Z. Select Plot > Contour: Contour - Color Fill to create a graph.
4. Double click on the contour plot to open the **Plot Details** dialog. On the **Colormap/Contours** tab, click on the **Line** heading to open the **Contour Lines** dialog. Deselect **Shown on Major Levels Only** and select **Hide All** to hide all the contour lines. Click **OK** to close this dialog. Then select the **Show Grid Lines** and **Show Data Points** check boxes. Click **OK** to close the **Plot Details** dialog.

The contour plot with its superimposed grid should look like this:
6.9.3.7 **Apply Custom Boundary**

A custom boundary can be applied to contour plots created directly from XYZ data where user provides the data points for the boundary in additional columns of the same worksheet. This feature is useful when there is a specific boundary data that defines the outline of an object, for example the profile of an engine where the contour shows engine temperature.

1. Continue to use the worksheet and the contour plot that was created with the **XYZ Random Gaussian.dat** in the previous example.

2. In the **XYZRandomGaus** workbook, click the **Add New Columns** button twice to add two columns. Highlight the two columns and right click on them. Select **Set As: XY XY** from the context menu and enter four rows of data such as below:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>10</td>
</tr>
<tr>
<td>18</td>
<td>12</td>
</tr>
<tr>
<td>16</td>
<td>18</td>
</tr>
<tr>
<td>14</td>
<td>16</td>
</tr>
</tbody>
</table>
3. Double click on the contour plot to open the Plot Details dialog. Select the Contouring Info tab in the right panel. Set the dialog as in the following image to customize the boundary for the contour plot. Remember to uncheck the Show Grid Lines and Show Data Points check boxes in the Color Map/Contours tab. Click OK to close the Plot Details dialog.

The graph should resemble the following image:

Prior to Origin 2018 SR0, the application of a custom boundary sometimes generated an imperfect fill at boundary margins. This has been improved in 2018. The user can restore the previous contour-fill behavior using system variable @TCSM.
6.9.4 Ternary Contour

This tutorial will show you how to create a Ternary Contour graph and to overlay a scatter plot.
Minimum Origin Version Required: 2020

6.9.4.2 What will you learn

- Create the Ternary Contour graph
- Overlay a scatter plot by drag-and-drop
- Customize the graph using the mini toolbars.

6.9.4.3 Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`.
Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then search the keyword “Ternary Contour”.)

1. Open Tutorial Data.opj and browse to the Ternary Contour folder in Project Explorer (PE).
2. Activate Book1A, highlight the entire worksheet and select Plot > Contour: Ternary Contour to create a Ternary Contour graph. And then, we are going to overlay a scatter plot on the ternary contour graph. Click on the column header of col(C) to select it and then hover the cursor on the right border of the column. The drag&drop data icon will appear. Pressing the left mouse key to drag and drop this data
into ternary coordinate.

3. Now we will customize the contour graph and the scatter plot. Click on the ternary contour, and in the pop-up mini toolbar, click the Set Levels button to set the Major Levels and Minor Levels as below:
4. Click **OK** to close the **Set Levels** dialog box. Click on the ternary contour again, and in the pop-up mini toolbar, click on the **Palettes** button to select **Rainbow** from the list.
5. Click on one scatter point on the graph, and in the pop-up mini toolbar, click the Symbol Edge Color button to set symbol color to *LT Yellow*.

6. Double-click on the color scale to open the **Color Scale Control** dialog. Select **Levels** in the left panel, check **Hide Head Level** and **Hide Tail Level** check box and click OK to close the dialog.
7. The graph should now look something like this:

![Contour Graph with XY Data Points and Z Labels](image)

### 6.9.5 Contour Graph with XY Data Points and Z Labels

**Videos**

- Contour Plots and Color Mapping
- Contour Levels
- Plot 3D or Contour Graph from Virtual Matrix
- 4D XYZ Plot With Custom Boundary

**OriginBlog**

- XYZ Contour plot with colormap from second Z and custom boundary
- How to make a contour plot of the difference between two contours

### 6.9.5.1 Summary

This tutorial will show you how to create a contour from XYZ data and add Z value as label for each XY data point.
6.9.5.2 **What will you learn**

This tutorial will show you how to

- Create a Contour Plot from XYZ data.
- Customize levels, lines, and color mapping.
- Plot a scatter plot on a contour graph.
- Show the labels for scatter points.

6.9.5.3 **Steps**

1. Start a new workbook and import the file
   `Sample/Matrix_Conversion_and_Gridding/XYZ_Random_Gaussian.dat`.

2. Highlight col(C) and set it as Z. Then highlight all columns and select **Plot > Contour : Contour - Color Fill** from the main menu to plot a contour graph.
3. Highlight col(B), and hover the mouse to the right edge of col(B). The drag-and-drop icon will appear. Press down the left mouse key to drag and drop the data into the contour graph layer as a scatter plot.
4. Double-click the graph to open the **Plot Details** dialog. In this dialog, go to the **Colormap/Contours** tab, the contour plot in the left panel is selected. Click the **Level...** header to open the **Set Levels** dialog to set the **Minor Levels** as 4.

![Plot Details dialog with Level... header highlighted]

5. Click the **OK** button to go back to the **Plot Details** dialog. Go to the **Label** tab while the scatter plot is selected in the left panel, check the **Enable** check box to activate this tab. Set the **Size** as 12, **Position** as **Below**, **Label Form** as **Col(C)** and **Numeric Display Format** as .1.

![Plot Details dialog with Label tab highlighted]

6. Click the **OK** button to close this dialog. The Z values will be added as labels to the graph.

In **Origin 2020** and later, you can click on the scatter points to select the scatter plot and **Show Data Labels** by clicking on a Mini Toolbar button. Once labels are enabled you can select them and use a second Mini Toolbar to format the labels, choose a label source, set position, etc.
6.9.6 Contour Plot with Vector Overlay

This tutorial will demonstrate how to create a contour plot with vectors overlay.
6.9.6.2 What you will learn

This tutorial will show you how to:

- Create and customize a contour graph and its color scale
- Create the XYAM vector graph
- Merge the two graphs

6.9.6.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Contour)

6.9.6.3.1 Create the Contour Graph

1. Open Tutorial Data.opj and browse to the Contour Plot with Vector Overlay folder in Project Explorer (PE).
2. Activate the **W147** matrix and select **Plot > Contour: Contour - Color Fill** in the menu. The graph below will be created:

![Graph](image)

3. Click on the plot, and in the pop-up mini toolbar, click the **Set Levels** button to open the **Set Levels** dialog, and then set the following levels:

![Set Levels dialog](image)

- Click **OK** button. Click on the plot again, in the pop-up mini toolbar, click the **Palette** button to choose **Temperature** from the list.
Click on the plot again, in the pop-up mini toolbar, click the **Contour Style** button to select **Color Scale without Contour Lines** from the list.
4. Let's make preparations for the third section **Merge the Two Graphs**. First, click on X axis, in the pop-up mini toolbar, click **Show Tick Labels** button to hide the labels. Second, with the pop-up mini toolbar expanded, click **Tick Style** button to select **None** from the list.

5. To change the color scale, double-click on the scale object to open the **Color Scale Control** dialog. Do the settings below:
   - In the **Labels** node,
     - Clear the **Auto** check box under Display branch, set **Custom Format** to *1*.
     - Set the **Font Size** to 22.
In the **Layout** page,

- Select **Black Line** from the **Background** drop-down list,
- Set **Color bar thickness** to 100.

In the **Title** page, enter $w(ms^{(-1)})$ in the **Title** box and set Font Size to 26.

In the **Line and Ticks** page, uncheck **Show Line and Ticks on Right** and **Show Border** check box.

Click **OK** and position the color scale in the desired location on the right side of the graph by selecting and dragging it.
6. Finally, the contour plot should now appear as shown below:

![Contour Plot Image]

**6.9.6.3.2 Create the XYAM Vector Graph**

1. Activate the **WOR81147** worksheet, highlight the last three columns and select **Plot > Specialized: Vector XYAM** in the menu.

2. Double-click on any vector to bring up the **Plot Details** dialog on the **Vector** tab. Use the settings shown below:
Then click **OK**.

3. To update the axis scales, select **Format: Axes: X Axis...** to open the dialog and complete the following:
On the Scale tab, set X From = 1, To = 10 and Value of Increment = 2.

On the Scale tab, choose Vertical icon in the left panel of Axis dialog. Set the scale of Y as From = 5, To = 95, and Value of Increment = 10.

Go to the Line and Ticks tab in the Axis dialog. Press Ctrl key to select the Top and Right icon in the left panel. Then check Show Line and Ticks check box, and set the Style of Major Ticks
Graphing

and **Minor Ticks to In.** The top X and right Y axis will be shown with line and ticks.

4. At this stage, you may notice that the vectors extend outside the axes (layer frame). To make sure they display within the layer frame, select **Format: Layer** and in the **Display/Speed** tab check the **Clip Data**.
5. Right-click on the legend of the vectors graph, and select Properties... in the context menu to open the **Object Properties**. Set the dialog as shown below:
Graphing

\( \sqrt{1} \)

3ms\(^{-1}\)

Frame: None

Fill Color: None

Border Color: None

Margin: Custom

Left: 0

Right: 0

Top: 0

Bottom: -47.4
6.9.6.3.3 Merge the Two Graphs

The contour and vector graphs are generated by the steps above, and are ready to be merged into one.

1. Minimize or Hide all other graphs except for the contour and vector graphs created using the instructions above. With one of the two graphs active, select Graph: Merge Graph Window... from the main menu.
2. In the Merge Graph dialog, specify the settings as the following:
   - Expand the Arrange Settings node, and set the Number of Rows as 1.
   - Expand the Spacing (in % of Page Dimension) node, and enter a value of approximately "25" in the Right Margin text box to show the color scale legend from the contour plot. Click OK.
3. To set font type as Verdana for all the objects:
   - Set the objects individually, by clicking on the object and selecting Verdana in the Font button in the Format toolbar.
   - Or
   - Use Theme Organizer to create and apply a font theme to the current graph.
4. The final graph should look something like this:

4. The final graph should look something like this:

6.9.7 Create Heatmap with Virtual Matrix and Colormap Bar Plot

Videos

- Virtual Matrix
- Plot 3D or Contour Graph from Virtual Matrix
- Add Color Scale in Graph
- Graph Theme
- What is Graph Theme and How Does it Make Graph Customization Easier?

OriginBlog

- Heatmap Improvements in Origin 2019b
- Easy Correlation Plots in Origin 2020b
- Conditional Formatting in Origin 2019

6.9.7.1 Summary
This tutorial creates two kinds of graph, a Heatmap Plot based on a virtual matrix together with a Bar Plot with Color Map, and merges them together.

**What you will learn**

- Create Heatmap Plot based on a Virtual Matrix.
- Create Bar Plot with Colormap.
- Merge the Heatmap Plot and Bar Plot together.

**Steps**
6.9.7.3.1 Create Heatmap Plot from Virtual Matrix

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data.opj and browse to the folder Heatmap and Virtual Matrix Manager. Open workbook Electricity Usage with first sheet active.
2. The XYZ mapping of workbook is shown in graph below, this will help you to understand how the Heatmap plot is created in next steps:

3. Highlight all cells in Z region by selecting the Cell in Column(B)-Row 1, then pressing CTRL+SHIFT+END. Click Plot > Contour: Heatmap in main menu to open the plotvm dialog for Heatmap plot.
4. Specified the X, Y ranges as shown in graph below.
5. In this dialog, check **Format X Data** and **Format Y Data** check boxes, click the button respectively to format X and Y data following the image below, then click OK to close the dialog.

6. The tick labels in Y axis are too dense to be seen, so now we are going to change that. Double click the axis in the graph to open the **Axis** dialog:
   - Select **Left** icon in **Tick Labels** tab, go to **Display** tab, select **Date** as the **Type**, and set **Display** drop-down list to *Dec (Current Month)*, click **Apply** to save the setting.
Go to the **Table** tab, check on **Enable** box, click **Apply** to save. You will find that the month names are shown as tick labels for Y axis in the form of a table.
7. Next, we will specify the scale and tick labels for X axis:
   - Go to **Bottom** icon in **Tick Labels** tab, and make sure **Time** is selected as the Type in **Display** tab, change the **Display** to **hh pm**, click **Apply** to save the setting.
Go to **Horizontal** icon in **Scale** tab, make sure the settings resemble the screenshot below, click **Apply** to save the setting. Click **OK** to close the dialog. Remove the title for X axis.

8. Click the tick labels for both XY axes in the graph, change the font size to 10 via **Format** Toolbar.

9. Select **Format: Plot** in main menu with Heatmap graph active.
   - Set the Level for Colormap follows the graph below:
Click **OK** to close the Set Levels dialog

- Click the Fill color of the Colormap on head cell (blue area) to set Fills follows the graph below:
- Scroll down to the Colormap tail, set its fill color to red in the same way.
- Click **Save** in **Colormap/Contours** tab to save the pattern as heatmap.oth which will be used in the second parts of the graph.
10. In the **Plot Details** dialog, click the first tree node in left panel (should be **Graph1** by default), change page size to 11*11 inch in **Print/Dimensions** tab, click **Apply**, then in the left panel, select the sub tree node for **Layer1**, go to the **Size/Speed** tab, change the Layer area follows graph below, click **OK** to apply the settings and exit the dialog:
11. We will turn off the speed mode by click the [ ] in Graph Toolbox to view the graph with higher resolution. The finished graph for Heatmap should be similar to the graph below:
Once the Virtual Matrix were created, they will be saved internally. You can browse them in Virtual Matrix Manager. The saved Virtual Matrix can be used for Contour/Heatmap/3D surface plot directly, you can select the virtual matrix from the input box of the plot dialog as shown in graph below:
6.9.7.3.2 Create the Bar Plot with Colormap

1. Go to the Temp sheet in Electricity Usage workbook, highlight the worksheet and select **Plot > Basic 2D > Bar** in main menu to create a Bar plot.
2. Now, we will define the style of axis:
   - Double click the axis to open the **Axis** dialog, change the **Scale** of axis (X) follows the graphs below in Vertical page of the **Scale** tab.
Then, change the Scale for axis(Y) in Horizontal page from -55 to 55 with Major Ticks value 25 and Minor Ticks counts 1, then click Apply.
We will also hide the line and ticks for X axis in \textbf{Line and Ticks} tab by uncheck the box of \textbf{Show Line and Ticks}. Besides, grids can be hide by using similar ways in \textbf{Grids} tab.

Click \textbf{OK} to close the dialog.

Change the Y axis title to \textit{CDD/HDD} by double clicking on the Y title object and entering the in-place edit mode. Delete the ticks labels and axis title of X axis by select it and hit \textbf{Delete} key.

Next, we will create the Colormap for the graph, the Colormap theme should be identical to the Heatmap created before. Click the \textbf{Format: Plot} in main menu to open the \textbf{Plot Details} dialog:

Set the color for both Border and Fill as \textbf{Map:Col(B)}. 

Go to the **Colormap** tab, load the heatmap.oth as Colormap Theme.

Click the Level of the Colormap to set Levels follows the graph below:
Click **OK** to close the **Set Level** dialog and Click **Apply** in Plot Properties dialog to save the settings.

4. In the left panel, select the first tree node (by default, **Graph2**), change page size to 11*11 inch in **Print/Dimensions** tab, click **Apply**, then switch to the **Layer1** tree node and go to the **Size/Speed** tab, change the Layer area follows graph below, then, click OK to close dialog:
The finished bar plot is similar to the graph below:
6.9.7.3.3 Merge the Heatmap Plot with Bar Plot and More Customization Steps

1. Select Graph: Merge Graph Window in main menu with Heatmap graph active, merge Graph1 and Graph2 together, the Rearrange Layout should be unchecked, click OK to apply the setting.
Then, you will resize the size of the merged graph (Graph3), click **Format: Page >> Print/Dimensions** tab, change the page size to 11*11 inch again, click **OK**. Click **CTRL+W** to adjust the graph view.

2. Specify the style of the color scale:
   - Double click the color scale to open the Color Scale Control dialog, set the Levels page as shown in graph below:
Set the Labels page as shown in the graph below:

Set the Layout page as shown in the graph below:
Click **OK** to apply the settings, drag the outline of the color scale in the graph to reach a proper size and location.

3. Select the unwanted axis title or legend and delete them, add text object with graph information by using text tool.
The finished graph is similar to the graph below:

![Contour plot in Sphere Surface Projections](image)

### 6.9.8 Contour plot in Sphere Surface Projections

#### 6.9.8.1 Summary

When you import global NetCDF data, for example global temperature data, you can create a Contour plot in a Sphere Surface Projection.
Minimum Origin Version Required: 2021b SR0

6.9.8.2 Steps

6.9.8.2.1 Create NetCDF data-based plot on a Sphere Surface Projection

1. Open this project file with a NetCDF data matrix.
2. Activate the matrix and add four new matrix objects in the same MatrixSheet.
3. Double click on the **Image Selector** to rename these matrix object to: *Lon, Lat, x* and *y*.

![Matrix Objects](image)

4. Activate each matrix, click on the **Properties** button on the pop-up mini toolbar, and select **Set Value**. In the **Set Value** dialog, enter the following formulas respectively:

```plaintext
//Lon object
x*pi/180

//Lat object
y*pi/180

//x object
3*Mat(2)/2 * sqrt(1.0/3 - (Mat(3)/pi)^2)

//y object
Mat(3)
```
5. 

6. Select the first matrix in **MBook1** and choose **Plot > Contour : Contour - Color Fill** from the main menu.
7. Double-click on the graph to open the **Plot Details** dialog. Navigate to the **Contouring Info** tab, select `[MBook1]air!4"x"` and `[MBook1]air!5"y"` in the **X Coordinates** and **y Coordinates** drop-down list.

8. Select **Layer1** in the left panel, and go to **Display/Speed** tab. Uncheck **X Axes** and **Y Axes** check boxes under **Show Elements** section. Click **OK** to save the settings.

9. Click the **Rescale** button
10. Delete the Axes Title and Color Scale Title. Then you will have the graph as displayed below:

6.9.8.2.2 Customize Levels, Lines and Color Map

1. Click on the Contour plot, and then click on the **Contour Style** button on the pop-up Mini Toolbars, select **Color Scale without Contour Line**
2. Click on the **Set Levels** button on the pop-up mini toolbar. In the **Set Levels** dialog, set **Major Levels** to 16 and **Minor Levels** to 16. Click the **OK** button.

3. Click on the Contour plot, and then click on the **Palettes** button on the pop-up mini toolbar. Then select the **Surface** palette from the drop-down.
Then you will get the contour plot similar to the graph below:

6.9.8.2.3 Add Map Lines and Grid line

There is longitude and latitude data as well as grid lines data in the workbook. First, we need to convert them to Spherical Surface.

1. Insert two columns as Column C and D, then in the formula column label row F(x) enter $3 \times A \times \pi / 180 \over 2 \times \sqrt{1/3 - (B / 180)^2}$ for Col(C), and then enter $B \times \pi / 180$ for Col(D).

2. Add two columns as Column G and H, then in the formula column label row F(x) enter $3 \times E \times \pi / 180 \over 2 \times \sqrt{1/3 - (F / 180)^2}$ for Col(G), and then enter $F \times \pi / 180$ for Col(H).

3. Set Col(C) and Col(G) to X.
4. Highlight Col(D) and Col(H), and drag and drop into contour plot. Double click on the graph to open the **Plot Details** dialog and set the **Style of Grid lines** to **Dash**.

5. Remove the legend for the lines. Then you will get the contour plot similar to the graph below:

---

**6.10 Map Overlays**

**6.10.1 Map Overlays**

- Add Google Map to Origin Graph
Graphing

- Baidu Map
- Tile Grid Map from Base Graph

6.10.2 Add Google Map to Origin Graph

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Google Map App</td>
<td>- Placing 3D Bars on a Map</td>
</tr>
<tr>
<td>- An Introduction to the Maps Online App</td>
<td>- Overlay Locations on a 3D Map</td>
</tr>
<tr>
<td>- Creating a 3D Bar on XY Plane using Maps Online App</td>
<td>- App to Import Google Map into Origin 2017</td>
</tr>
<tr>
<td>- Import Shapefile App</td>
<td>- Colormap with Specified Values for Map Data Plot</td>
</tr>
<tr>
<td></td>
<td>- Bubble Plot on Google Map</td>
</tr>
<tr>
<td></td>
<td>- COVID-19 Test Positivity Rates in Different US States</td>
</tr>
<tr>
<td></td>
<td>- COVID-19 Real Time Report from China</td>
</tr>
</tbody>
</table>

6.10.2.1 Summary

This tutorial will show you how to create a graph with google map as background.
6.10.2.2 What will you learn

This tutorial will show you how to:

- download **Google Map Import** app from App Center.
- Use the App to add google map to an graph.

6.10.2.3 Steps

1. Create a new workbook. Select From menu **Data: Connect to File: Text/CSV**. Select the data file `<Origin EXE Folder>\Samples\Graphing\US Mean Temperature.dat` to connect to. With default settings in pop-up dialog, click **OK**.
2. Select column B header and click X on the mini toolbar that pops up. This set column B as X.
3. Highlight column C header and select menu **Plot:Basic 2D:Scatter** to make a scatter plot.
4. Click **Add Apps** icon in **Apps** window that docks on the right side of Origin workspace and search **google map**. Click the **download** icon to download it.

5. With the scatter graph window active, launch the **Google Map Import** app. Click the **Set From Active Graph Layer** button first to relocate the frame to United States area in the preview window. Change **Map Type** to **Satellite**. Then click **Import as Update** button. Now The google map is added to the active graph as background. Close the App.
6. Click on any symbol to bring up mini tool bar. Set the symbol Size to 6, set symbol Type to solid circle. Change Symbol Color to By Point colormaping to Col(P)"Annual". Use mini toolbar to change palette to Temperature.

7. Click the Symbol, select Set Levels in mini toolbar. In the pop-up dialog, change # Minor Levels to 10.

8. To make circle smooth on graph, click Enable/Disable Anti-aliasing button on Graph toolbar on the right side of Origin workspace.

9. Delete the Legend. Click Add Color Scale button on the left side toolbar to add a color scale.

10. Right click on the color scale and select Properties. Select Levels in the left panel, check Hide Head Level and Hide Tail Level in the right panel. Select Labels in the left, uncheck Auto box in the right, change Custom Format to *3 to show only 3 significant digits on color scale. Click OK.

6.10.3 Baidu Map
6.10.3.1 Summary

This tutorial will show you how to create a graph with baidu map as background. Baidu map is recommended if the desired background map is inside the boundary of China.

6.10.3.2 What will you learn

This tutorial will show you how to:

- download Baidu Map Import app from App Center.
- use the App to add Baidu map to a 3D graph.
6.10.3.3 Steps

1. Start with a new project. With a blank workbook active, select from menu **Data: Connect to Web**. In the dialog, enter following URL link:
   Select *table/_1* to import data from this page. There are PM 2.5 values of several observation points in Beijing city at mid-day of 18/11/2020.

2. Select column C header and click X on the mini toolbar that pops up. This sets column B as X. Similarly, set column E as Z.

3. Highlight column D and select menu **Plot: 3D: 3D Scatter** to make a 3D scatter plot.

4. Click **Add Apps** icon in **Apps** window that docks on the right side of Origin workspace and search **baidu map**. Click the **download** icon to download it.
5. With the 3D scatter graph window active, launch the Baidu Map Import app. Click the From Graph button first to relocate the ROI box to cover all the observations in the preview window. Change Map Type to 3D Plane. Clear Create New Graph checkbox. Then click Import button. Now The baidu map is added to the active graph as background in the XY plane. Close the App.
6. Customize the graph. Double click the Symbol to open the **Plot Details** dialog.
   - Turn on drop lines to XY plane (plot level > Original branch > **Drop Lines** tab),
   - Change symbol shape to **Sphere** and enlarge its size to 18 (plot level > Original branch > **Symbol** tab).
   - Hide YZ plane and **Plane Border** (Layer level > **Planes** tab).

7. Customize axes. Delete X&Y axis title. Select menu **Format: Axes: Z Axis**. In the Scale tab of **Z Axis** dialog, change scale *From 0 To 100*.

8. Use 3D Rotation toolbar to rotate the graph to a desired angle.

### 6.10.3.3.1 Data

<table>
<thead>
<tr>
<th>Observation</th>
<th>Longitude</th>
<th>Latitude</th>
<th>PM2.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>DongSi</td>
<td>116.23128</td>
<td>40.22077</td>
<td>42</td>
</tr>
<tr>
<td>GuanYuan</td>
<td>116.35586</td>
<td>39.93239</td>
<td>45</td>
</tr>
<tr>
<td>Olympic Sports Center</td>
<td>116.41219</td>
<td>39.98538</td>
<td>35</td>
</tr>
<tr>
<td>Agriculture Exhibition Center</td>
<td>116.46865</td>
<td>39.94429</td>
<td>39</td>
</tr>
<tr>
<td>WanLiu</td>
<td>116.29696</td>
<td>39.96706</td>
<td>36</td>
</tr>
<tr>
<td>Northern XiQu</td>
<td>116.17035</td>
<td>40.04928</td>
<td>42</td>
</tr>
<tr>
<td>FengTai Garden</td>
<td>116.28371</td>
<td>39.86265</td>
<td>34</td>
</tr>
<tr>
<td>YunGang</td>
<td>116.162</td>
<td>39.81044</td>
<td>19</td>
</tr>
<tr>
<td>GuCheng</td>
<td>116.23128</td>
<td>40.22077</td>
<td>37</td>
</tr>
<tr>
<td>FangShan</td>
<td>116.14294</td>
<td>39.74788</td>
<td>30</td>
</tr>
<tr>
<td>DaXing</td>
<td>116.34159</td>
<td>39.72684</td>
<td>22</td>
</tr>
<tr>
<td>YiZhuang</td>
<td>116.23128</td>
<td>40.22077</td>
<td>26</td>
</tr>
<tr>
<td>GuYi</td>
<td>116.65477</td>
<td>40.13012</td>
<td>54</td>
</tr>
<tr>
<td>Location</td>
<td>Code</td>
<td>Latitude</td>
<td>Longitude</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>ChangPing</td>
<td>昌平</td>
<td>116.23128</td>
<td>40.22077</td>
</tr>
<tr>
<td>MenTouGou</td>
<td>门头沟</td>
<td>116.10146</td>
<td>39.94048</td>
</tr>
<tr>
<td>PingGu</td>
<td>平谷</td>
<td>117.12141</td>
<td>40.14062</td>
</tr>
<tr>
<td>HuaiRou</td>
<td>怀柔</td>
<td>116.63177</td>
<td>40.316</td>
</tr>
<tr>
<td>MiYun</td>
<td>密云</td>
<td>116.84317</td>
<td>40.37625</td>
</tr>
<tr>
<td>YanQing</td>
<td>延庆</td>
<td>115.97503</td>
<td>40.45678</td>
</tr>
<tr>
<td>DingLing</td>
<td>定陵</td>
<td>116.23128</td>
<td>40.22077</td>
</tr>
<tr>
<td>BaDaLing</td>
<td>八达岭</td>
<td>116.9779</td>
<td>40.36214</td>
</tr>
<tr>
<td>MinYun Reservoir</td>
<td>密云水库</td>
<td>116.88429</td>
<td>40.47824</td>
</tr>
<tr>
<td>DongGao</td>
<td>东高村</td>
<td>117.11673</td>
<td>40.10479</td>
</tr>
<tr>
<td>YongLeDian</td>
<td>永乐店</td>
<td>116.79679</td>
<td>39.70886</td>
</tr>
<tr>
<td>LiuLi River</td>
<td>琉璃河</td>
<td>116.02432</td>
<td>39.59867</td>
</tr>
<tr>
<td>YongDingMenNei</td>
<td>永定门内</td>
<td>116.3993</td>
<td>39.87311</td>
</tr>
<tr>
<td>NanSanHuan</td>
<td>南三环</td>
<td>116.38432</td>
<td>39.85701</td>
</tr>
<tr>
<td>DongSiHuan</td>
<td>东四环</td>
<td>116.48972</td>
<td>39.91923</td>
</tr>
</tbody>
</table>

### 6.11 Statistics

#### 6.11.1 Statistics

- **Box Plot**
- **Grouped Box Chart with Color Indexed Data Points**
- **Marginal Distribution Curve**
- **Grouped Box Plot**
- **Add multiple fitted curves in a Histogram**
- **Weibull Probability Plot**
- **Q-Q Plot**
- **Scatter Matrix**

#### 6.11.2 Box Plot

[Videos]

- **Box Plot**

[OriginBlog]

- **Easier Way to Control Grouped**
6.11.2.1 Summary

This tutorial demonstrates how to create the following box plot with the data points and distribution curves both.

Minimum Origin Version Required: Origin 2015 SR0

6.11.2.2 What you will learn

This tutorial will show you how to:

- Create a data overlapped box plot
- Customize box plot settings
- Change the layer background

6.11.2.3 Steps

This tutorial is associated with :<Origin EXE Folder>\Samples\Tutorial Data.opj.
1. Open **Tutorial Data.opj** and browse to the **Box Plot** folder in **Project Explorer** (PE).
2. Activate the first worksheet, select the January(Y), February(Y), and March(Y) columns and plot them as a Box Chart using **Plot > Statistical: Box Chart**.

3. Click on the plot, and the Mini Toolbar pops-up. Click on **Box Type** button and select **Box[Right] + Data[Left]** in the list.

4. Click on the **Border Color** button in the Mini Toolbar and select **Blue**.
5. Click on the **Fill Color** and create a custom color as below:
6. Double-click on one of the box charts to bring up the **Plot Details** dialog. The **Data** tab shows up because data plot is also included in the plot. In this tab, change the settings as shown below to change the binning options.
7. Then, go to the **Distribution** tab to create a normal distribution curve.

8. The next step is to customize the data symbols in the **Symbol** tab:
9. The style of the Percentile points is also changed in the **Percentile** tab:
10. The next step is to change the background color. In the same **Plot Details** dialog, select **Layer 1** in the left panel to activate the tabs of layer level. If the left panel is not expanded use the button on the bottom left of the dialog to expand it. In the **Background** tab, expand the **Color** option, click the vacant color under the **Custom** controls to open the **Colors** dialog. In the **Custom** tab of this dialog box, enter the **Red**, **Green** and **Blue** values to define your favorite color. Here, let us make the color(R:177, G:237, B:254). Click **OK** to accept the setting and close the dialog.

11. Click on the Y Axis, and click on the **Axis Scale** button in the Mini Toolbar to open the dialog. In the **Axis Scale - Y** dialog, set the following axis scale specifications:

12. Double click on the Title of Left Axis, and edit the title to **Discharge [ft\(^{3}\)/sec]**:
13. Click on the Y Axis, and click on the **Axis dialog** button in the Mini Toolbar, then select **Grid Lines**... In the dialog, enable the **Major Grid Lines** and set their styles as below, and click **OK**.

14. Double-click on the X Axis to open a **Axes** dialog box. On the **Title** tab, check the **Show** check box, and change the X axis title to **Month**.
15. Go to Scale tab, and select Vertical, under Minor Ticks section set Count =0. Click OK to save the settings and close the dialog.

16. Select View: Show: Frame menu to add the frame to this graph.

17. The legend can be deleted if desired by selecting it and pressing the delete key.

18. Right-click the layer and select Add/Modify Layer Title from the menu that appears. Enter the text **Water Discharge at Station 120011** in the edit box. Existing layer titles and axes titles can be modified by double clicking on them till the text cursor appears.

6.11.3 Grouped Box Chart with Color Indexed Data Points

- Box Plot
- Box Plot Improvements in Origin
- Easier Way to Control Grouped Bar Plot Colors in Origin 2016
6.11.3.1 Summary

Origin can be used to create grouped box plots from raw data with data points and distribution curves.

Minimum Origin Version Required: 2015 SR0

6.11.3.2 What you will learn

This tutorial will demonstrate how to:
Tutorials for Origin 2024b

- Create a grouped box plot from raw data
- Add a data plot with indexed symbol color
- Add and customize a distribution curve
- Customize the table-axes

6.11.3.3 Steps

6.11.3.3.1 Creating the Box Plot from Raw Data

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select Box Charts from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Box Charts - Grouped Box Chart with Color Indexed Data Points".

   ![Image of Learning Center with Box Charts selected]

   Note: This tutorial is associated with the folder Grouped Box with Index Color DataPoint of the "Tutorial Data" project: <Origin EXE Folder> \Samples\Tutorial Data.opj.

2. Activate the workbook Book11. Highlight col(C) - col(H), select Plot > Categorical: Grouped Box Charts - Raw Data.

3. In the opened Plotting: plotgboxraw dialog, set the Group Number to 2, the 1st Group Row to Comments and the 2nd Group Row to Long Name. This will create a box chart with the column data arranged in three groups of two, with X axis row names derived from the Comments and the Long Names.
Graphing

4. Click the OK button. The grouped box chart from raw data is created with two grouping levels as shown below:
5. Click on the box, and in the popup mini toolbar, click the **Box Type** button to select **Box[Right] + Data [Left]**.

6. To add distribution curves into the graph, double click the plot to open the **Plot Details** dialog. Expand the **Layer1** option on the left panel and select the first plot under it.

7. To add a Distribution Curve, on the **Distribution** tab, set **Curve Type** to **Normal**. Go back to **Data** tab, set **Bins Alignment** to **Right** to orient the curve.
8. Click the **OK** button. The data points and distribution curves will appear on the graph as shown below:

![Graph showing data points and distribution curves]

### 6.11.3.3.2 Customizing the Boxes and Statistical Markers

1. Double click on any one of the boxes to re-open the **Plot Details** dialog.

2. On the **Group** tab set both **Border Color** and **Box Color** to increment **By One** so each box in subgroup has a different color.

3. Click the **button** on the **Details** section of **Border Color**. In the **Increment Editor** dialog that opens, click the first color and change it to be **Red**. Change the second color to **Gray**. Click OK.

4. For **Box Color** row, set **Increment** to **By One** and **Subgroup** to **Within Subgroup**. Click the **button** on the **Details** section of the **Box Color** to open the **Increment Editor** dialog. Click the + button under **Custom** branch to open **Colors** dialog to define a custom color. Set RGB values in **Red**, **Green**, **Blue** boxes on bottom right to be **255**, **51** and **51**, and click **OK** to close dialog.
5. Do the same for the 2nd color. Set Define RGB value to be 143, 143 and 143, and click OK to close dialog. Then click OK to close Increment Editor dialog and apply settings.

6. This step is to customize the descriptive statistic markers whether to show on the plot such as the 99%, 1%, Max and Min marks.

   Go to the Percentile tab, and set the Edge Color to White and click Apply button. Since background of the graph is also white, Max, Min, 99%, 1% will look like disappeared in graph.

On Percentile tab, users can also hide a Marker by setting the Type as None (the last shape) in the dropdown list.
7. On the **Lines** tab set the **Color** for the **Caps** to Gray and **Median Line** to White. Click **OK**. The plot should appear as shown below:

6.11.3.3 Customizing Data Symbols and Distribution Curves

1. Double click any box in the graph to open the **Plot Details** dialog.

2. On the **Symbol** tab. Set the **Size** to 5, the **Shape** to 2 Circle and the **Interior** to Open.

3. Click the **Edge Color** button, go to **By Points** sub-tab, under Color Options radio box, select **Col(B): "Machines"** under the **Indexing** dropdown list. The symbol's edge colors will be indexed to column B. All symbols with Machine value **A386** will be one color and the ones with **C334** will be a different color:
4. Reopen the **Color Chooser** again for **Edge Color**, the edge color has been indexed to Col(B), click the yellow pen after selected **Color List** to open the **Increment Editor** dialog. In this dialog, set the first two **Color Values** as **Blue** and **Dark Cyan**. Click OK button to close the editor and click Apply bottom to apply the symbol color.

5. To customize the distribution curve color, on the **Distribution** tab, set the Distribution Curve **Color** to **Gray**. Click **OK** to close the dialog.
6.11.3.3.4 Customizing the Axes

For grouped plots support multi-row tick label tables. The corresponding axis icons in the **Tick Labels** tab of **Axis dialog** starts from the last table row, e.g. **Bottom 1**, **Bottom 2**, ..., **Bottom N**. This means the first row from the bottom will correspond to **Bottom1** and so forth.

1. To move the tick label row with **SEG 1**, **SEG 2** and **SEG 3** to the top X axis, click on the labels in this row, and in the popup mini toolbar, click the **Move to Opposite** button to move this row to the top.
2. Click on axis labels in the bottom axis table, and in the popup mini toolbar, click on the Add Row button to select Count to add a new table row with Count information.
3. Click the bottom table row again, in the popup mini toolbar, click on Add Row button to add a "Mean" row. Now, there are 3 table rows at bottom axis.

4. Click the first bottom label row, and in the popup mini toolbar, set Fill Color to LT Gray; Click on the second bottom label row, set its color to Gray with the mini toolbar; Click on the third bottom label row to set its color to LT Gray; click on the top axis label row to set its color to LT Gray.
5. Double-click on a bottom table row to open the **Axis** dialog. With Ctrl key been pressed, select Bottom 1, Bottom 2, Bottom 3 in the left panel and go to **Table** sub-tab, clear the **Inside Border** box as below.
6. Click the **Apply** button. Select **Top 1** in the left panel and go to **Table** sub-tab, clear all boxes except the **Near Parallel Border** box. Click **OK** button.

7. Click on the bottom axis table to select all three rows, and in the popup mini toolbar, click **Show Table Row Title** button and then use the following button **Table Row Title at End** to put the title at the head of the rows.

8. Double-click on the axis labels of Y axis to open the Axis dialog again. For the Y Axis change to the following settings:
   - **Scale** tab (**Vertical** icon): Set **Increment** to **5000**
   - **Tick Labels** tab >> **Display** tab (**Left** icon): Set **Display** to **Scientific 10^3**

9. Click **OK** to close the dialog.

10. Select Y axis title **Range** and press the **Delete** key to remove it.

### 6.11.3.3.5 Updating the Legend Object

1. Right click the box chart legend and select **Legend: Box Chart Components...** to open the **Enhanced Box Legend: legendbox** dialog. Deselect all the components except for **Data**:
2. Click the **OK** button. The legend will show only the data symbols. Double click the legend text to go into in-place edit mode. Delete the first row of the legend. Select and drag to move the legend object to a better location.

3. To remove the black line around the legend, click the legend object, and in the popup mini toolbar, click **Frame** button to remove the frame.

### 6.11.4 Marginal Distribution Curve

- **Videos**
  - Data Filter
  - Adding, Grouping and Reordering Plots with Layer Contents
  - Group and Ungroup Plots in

- **OriginBlog**
  - Rug Plot
  - How to create 3D Stacked Histograms with their fitted Curves
6.11.4.1 Summary

Graphs in Origin are highly customizable. This tutorial will show how to customize the marginal histogram to display distribution curves instead of columns.

Minimum Origin Version Required: 2015 SR0

6.11.4.2 What you will learn

- Create marginal histogram
- Use filter lock to create plots with different filter conditions.
- Group plots manually

6.11.4.3 Steps to Use the Filter Lock

Origin9.1 includes a special feature that allows you to set up different data filters in a single source worksheet and to, for instance, graph data for each filter condition without destroying the previous plot. This is made possible by copying filtered data to a new sheet and placing a "filter lock" on the filtered data.

1. Import <Origin EXE Folder>\Samples\Statistics\automobile.dat to a new blank workbook.
2. Highlight col(A), right click and select Filter: Add or Remove Filter.
3. Click the filter icon in the column header and select Between....
4. In the Between dialog, set From to 1992, To to 1995 and press OK.
5. Highlight Col("Power") and Col("Weight"), right-click and select Copy Columns to....
6. In the colcopy dialog, enter 1992~1995!<new> in the Destination Columns text box as shown below and click OK.

7. In the newly created sheet, click the green lock in the Col(A) heading and select Worksheet Filters: Lock.

8. Go back to the "automobile" sheet and repeat steps 4~7 twice more with Col("Year")’s filter conditions set to 1996~1999 and 2000~2004, respectively. You need to type a sheet name in colcopy dialog manually.
6.11.4.4 Steps to Create a Plot with Marginal Distribution Curves

1. Go to sheet "1992~1995", highlight all columns and select **Plot > Statistical: Marginal Histograms**

2. Double-click any on any bar in the top histogram to open the **Plot Details** dialog. Go to the **Data** tab and set **Distribution Curve: Type** as **Normal**. This is for **Layer 2**.
3. Go to the **Pattern** tab and reproduce the settings shown below to hide bin bars.
4. Go to the **Line** tab and set **Color** to Black. Click **Apply** to see the changes.
5. Repeat steps 2~4 for Layer3 (right histogram).

6.11.4.5 Steps to Plot Grouped Marginal Distribution Curves
1. Select **Graph: Plot Setup** from menu.

   In order to show all three panels in **Plot Setup** dialog, please expand **Plot Type** panel by clicking and expand **Available Data** panel by clicking again.

   Please refer to **Plotting using Plot Setup** for more information.

2. Select **Layer 1** in lower panel. Set controls as shown below and click **Add**.
3. Add the “Power” histogram to layer2.

4. Add the “Weight” histogram to Layer3.

5. Repeat steps 2~4, to add 2000~2004 data to each layer. The plot list should look like the following.

6. Click **OK** to close the **Plot Setup** dialog box and rescale the graph.
6.11.4.6 Steps to Group the Plots

1. Right-click the layer icon at the upper-left corner of the graph window and select Layer Contents....

2. Highlight all three plots and click Group, then click OK.

3. Repeat step 2 for layer2 and layer3.

6.11.4.7 Steps to Further Customization
1. Double click the bottom axis to open the **Axis Dialog** for layer 1, then go to the **Scale** tab, and set the axis scale for the **Horizontal** (X axis) and **Vertical** (Y axis) as below respectively:
2. Click **OK** to close axis dialog. Double click on the graph to open the **Plot Details** dialog box and select the first dataplot in **layer 1** to go to **Group** tab. Set **Symbol Type** as **None** and duplicate the following settings:
3. Click **Ok** to close the dialog. Go to the **Symbol** tab and duplicate the following settings.

4. Go to **Layer 2, Data** tab and set the bin scale to be the same as the X scale, then click **Apply**.
5. Go to the **Group** tab for plots in Layer 2 and set the **Edit Mode** to **Independent** so that we can individually customize the plot styles, click **Apply**.

6. Go to the **Pattern** tab and hide bars for all three dataplots in Layer2 as what we did in **Steps to Create a Plot with Marginal Distribution Curves, Step3**.

7. Go to **Line** tab of the 1992~1995 data plot and set as below.
8. Repeat step 7 for the other two plots in Layer2 and set line color to the corresponding symbol color in Layer1.

9. Repeat steps 5~8 for Layer3, click OK to close Plot Details dialog and apply settings.

10. Activate Layer1 and select Graph: Legend: Data Plots from the menu.

11. Right click the legend object and click Properties..., set Background to Black Line, and font Size to be 18. Click OK.

12. Use Format: Page to open the Plot Details - Page Properties dialog, go to Legends/Titles tab and set as the following so that worksheet name will be used as legend text:

13. Drag and move the legend to a new position as needed. At this stage the graph should look like below:
6.11.4.8 Steps to Reposition the Graph Layers

1. Double click bottom axis to open Axis Dialog for layer 1, go to the Grids tab, hold Ctrl key to multiple select Vertical and Horizontal icon and set the following:
2. Click OK to close dialog. Open the **Axis Dialog** for layer 2. Go to the **Line and Ticks** tab, make sure **Bottom** axis icon is selected and clear the **Show Line and Ticks** check box to hide the bottom axis line. Do the same for the axis line of **Left** in layer 3.

3. Open the **Layer Management** dialog box, highlight Layer2 then go to the **Size/Position** tab, select **Move** and set **Top** to be -35. Click **Apply**.
4. Set **Left** for Layer3 to be 102. Click **Apply**. Then click **OK** to close the dialog box.

6.11.5 Grouped Box Plot

In Origin, a grouped box chart can be created from either indexed data or raw data. The indexed data is arranged as one data column and one or more group columns, while the raw data is arranged as multiple data columns grouped according to the column label row(s).

Once a grouped box plot has been created there are many options to customize the box plots and the axes. The customization options are the same for grouped box plots created from raw data as well as those created using indexed data.
6.11.5.2 What You Will Learn

This tutorial will show you how to:

- Create a grouped box plot from indexed data
- Create a grouped box plot from raw data
- Customize the box plot using the Plot Details dialog
- Customize the table-style axis tick labels

6.11.5.3 Steps

6.11.5.3.1 Create Grouped Box Plot from Indexed Data

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select Box Charts from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Box Charts - Grouped Box Chart with Color Indexed Data Points".
Note: This tutorial is associated with the folder Grouped Box Plot and Axis Tick Table of the "Tutorial Data" project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

2. In the workbook Book10, the data in the CC.MI-Index worksheet is indexed data. Column E is the data column and columns C and D can be used as grouping columns. Highlight column E and select Plot > Categorical : Grouped Box Charts - Indexed Data to open the plot_gboxindexed dialog.

3. In this dialog, click the triangle button at the top of Group Column(s) box to select columns C and D.
4. Click **OK** to create a grouped box plot. The plot will resemble the image below. A new output sheet will be added into the workbook too.
For another short tutorial on creating grouped box plots from indexed data, see Example 2.

6.11.3.2 Customization by Plot Details Dialog

1. Activate the graph window created from the indexed data. Select and delete the legend object.

2. Select Format:Plot to open the Plot Details dialog. To customize Symbol style, select the Outliers tab and set the following:

<table>
<thead>
<tr>
<th>Group</th>
<th>Pattern</th>
<th>Spacing</th>
<th>Panel</th>
<th>Box</th>
<th>Distribution</th>
<th>Percentile</th>
<th>Outliers</th>
<th>Lines</th>
<th>Connect Lines</th>
</tr>
</thead>
</table>

   - **Outliers**
     - **Shape**: [Shape Options]
     - **Size**: 5
     - **Edge Color**: [Color Options] Dark Gray
     - **Fill Color**: [Color Options]
       - **Transparency**: 0%
       - **Follow Line Transparency**

   - **Extreme Values**
     - **Shape**: [Shape Options] Auto
     - **Size**: Auto
     - **Edge Color**: [Color Options] Auto
     - **Fill Color**: [Color Options]
       - **Transparency**: 0%
       - **Follow Outliers Transparency**

3. On the Spacing tab change Gap Between Subgroups (in %) to 5. On the Lines tab change the line colors as shown below:
4. On the Percentile tab in order to set the Max/99%/1%/Min to none, select the last option in the symbol map. Set the rest of the options as shown below:

```
   Group  Pattern  Spacing  Panel  Box  Distribution  Percentile  Outliers  Lines  Connect Lines

| Whisker    |        |        |        |        |        |        |        |        |        |
| Caps Length| 0      |        |        |        |        |        |        |        |        |
| Caps       |        |        |        |        |        |        |        |        |        |
| Median Line|        |        |        |        |        |        |        |        |        |
| Mean Line  |        |        |        |        |        |        |        |        |        |
| Transparency| 0   |        |        |        |        |        |        |        |        |
| Extended Line|  None|        |        |        |        |        |        |        |        |
| Extra Length (%)| 3 |        |        |        |        |        |        |        |        |
```

5. On the Group tab, for the Border Color row, set the Increment as By One and Subgroup as Within Subgroup.
6. Next, click the ... button on the right end of the Details column to open the Increment Editor. Click the first color to expand the color chooser, then click the last vacant color under Custom control to open the Colors dialog. In the dialog that opens, you can define a custom color by entering the HSL values (Hue=0, Sat=240, Lum=180). OK to close the dialog. Follow the same procedure for the second color in the Increment Editor dialog with the settings Hue=160, Sat=240, Lum=164. OK out of the Increment Editor:

7. In regard to the Box Color, select the first two colors of current color list to the ones we just defined at the previous step, and then select By One for Increment cell and Within Subgroup for Subgroup cell:
8. Click **OK** to apply all the previous settings and close the **Plot Details** dialog. Click on a box, and in the popup mini toolbar, click the Smaller Gap button thrice to reduce the gap between subgroups.
Finally, the graph should resemble the image below:

![Graph Image]

6.11.5.3.3 Customization by Axis Dialog

Continue with the graph from the previous section.

1. Click on the bottom table row of the X axis, in the popup mini toolbar, click **Move to Opposite** button to move it to the top axis.

![Mini Toolbar Image]

2. Click on the tick labels of bottom table row to set the font size to 22. And, click the tick labels of top axis to change the font size to 24 using the mini toolbar.

![Font Size Adjustments Image]
3. Double-click on the bottom axis to open the Axis dialog. With **Bottom 1** selected in the left panel, go to the **Table** sub-tab of **Tick Labels** tab to set the table format as below:

4. Select **Top 1** in left panel, go to the **Table** sub-tab of **Tick Labels** tab to set the table format as below:
5. Click the **Left** icon (for Y axis) and change the display format for the Y tick labels:

6. Click Apply button. To turn on major and minor grid lines, go to the **Grids** tab and set as following for X(**Vertical**) and Y(**Horizontal**) grids respectively:
7. **Click OK** to apply the settings and close the **Axis** dialog. The final graph should appear as shown below:
You can click to select table labels and nudge them using the arrow keys on your keyboard.

### 6.11.6 Add multiple fitted curves in a Histogram

#### 6.11.6.1 Summary

Origin allows you to fit the peaks from the result of frequency count. Also, fitted curves can be added into the new layer in the Histogram.

#### 6.11.6.2 What you will learn

- Plotting the Histogram
- Using Frequency Count to do statistics
- Using Multiple Peak Fit tool to find peaks and do fitting
- Adding new layers

#### 6.11.6.3 Steps

Copy and paste the sample data into Origin and set the column as Y (Highlight the column and choose **Column: Set As: Y** from the Origin menu). Plot this data as a Histogram by clicking **Plot > Basic 2D: Histogram** from the menu.
6.11.6.3.1 Frequency Count

1. Highlight the sample data, then open the Frequency Count dialog by selecting Statistics: Descriptive Statistics: Frequency Count.
2. Click OK to finish. A new result sheet will be generated.

6.11.6.3.2 Fit peaks

1. Select Col(Counts) in FreqCounts1 sheet and then open the Multiple Peak Fit dialog from Analysis: Peak and Baseline: Multiple Peak Fit.
2. In the dialog that opens, choose Gaussian for Peak Function and click OK.
3. A graph window is generated automatically for you to pick peaks from the graph. Double click at the peak center to pick up a peak. Pick two peaks one by one this way.
Note: you can single click at the peak center and then use Left and Right arrow keys on the keyboard to slightly adjust the center. Once done, press Enter key to confirm.

4. We need to fix the baseline at $Y = 0$. To do this, click **Open NLFit** button to open **Nonlinear Curve Fit** dialog. Go to Parameters tab. Set **Value** of parameter $y0$ to 0 and check **Fixed** checkbox. Click **Fit** button to perform the fitting.

If your baseline is complicated, or if you would like Origin to auto find peaks by specified method, please use **Peak Analyzer** (open from **Analysis: Peaks and Baseline: Peak Analyzer**). Note that **Peak Analyzer** provides powerful controls appropriate not just in two cases mentioned.

5. Two sheets **nlfitpeaks1** and **nlfitpeaksCurve1** are added to the source workbook containing the fitting report and the fitted curve data.

### 6.11.6.3.3 Add the fitted curves

1. Activate the Histogram graph and add a layer by selecting **Insert: New Layer(Axes): Right-Y** from the main menu.
2. Double click the **Layer2** icon to open the **Layer Content** dialog.
3. Hold **Ctrl** key to select col("Fit Peak 1") and col("Fit Peak 2") in sheet **nlfitpeaksCurve1** in the left panel, click the triangle button next to **A** button and select Line from the fly-out menu, and then click **-** button to add it to the right panel.
4. Click OK. Two fitted curves had been added to the Histogram.
5. Double-click the graph to open the **Plot Details** dialog. Select **RightY** from the left panel, then open the **Link Axes Scales** tab in the right panel and select **Straight(1 to 1)** for both **X Axis Link** and **Y axis Link**. Click OK to close the dialog.
6. The fitted curves are added into the Histogram with the proper scale. The following is the result graph, with the right Y-axis removed.

6.11.6.3.4 Sample Data

<table>
<thead>
<tr>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.631</td>
</tr>
<tr>
<td>0.642</td>
</tr>
<tr>
<td>0.652</td>
</tr>
<tr>
<td>0.662</td>
</tr>
<tr>
<td>0.669</td>
</tr>
<tr>
<td>0.676</td>
</tr>
<tr>
<td>0.677</td>
</tr>
<tr>
<td>0.69</td>
</tr>
<tr>
<td>0.691</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>0.696</td>
</tr>
<tr>
<td>0.697</td>
</tr>
<tr>
<td>0.699</td>
</tr>
<tr>
<td>0.699</td>
</tr>
<tr>
<td>0.699</td>
</tr>
<tr>
<td>0.7</td>
</tr>
<tr>
<td>0.7</td>
</tr>
<tr>
<td>0.7</td>
</tr>
<tr>
<td>0.708</td>
</tr>
<tr>
<td>0.712</td>
</tr>
<tr>
<td>0.718</td>
</tr>
<tr>
<td>0.731</td>
</tr>
<tr>
<td>0.744</td>
</tr>
<tr>
<td>0.749</td>
</tr>
<tr>
<td>0.751</td>
</tr>
<tr>
<td>0.752</td>
</tr>
<tr>
<td>0.753</td>
</tr>
<tr>
<td>0.758</td>
</tr>
<tr>
<td>0.758</td>
</tr>
<tr>
<td>0.758</td>
</tr>
<tr>
<td>0.775</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>0.776</td>
</tr>
<tr>
<td>0.776</td>
</tr>
<tr>
<td>0.776</td>
</tr>
<tr>
<td>0.776</td>
</tr>
<tr>
<td>0.777</td>
</tr>
<tr>
<td>0.778</td>
</tr>
<tr>
<td>0.779</td>
</tr>
<tr>
<td>0.78</td>
</tr>
<tr>
<td>0.78</td>
</tr>
<tr>
<td>0.78</td>
</tr>
<tr>
<td>0.781</td>
</tr>
<tr>
<td>0.784</td>
</tr>
<tr>
<td>0.784</td>
</tr>
<tr>
<td>0.784</td>
</tr>
<tr>
<td>0.785</td>
</tr>
<tr>
<td>0.785</td>
</tr>
<tr>
<td>0.785</td>
</tr>
<tr>
<td>0.789</td>
</tr>
<tr>
<td>0.789</td>
</tr>
<tr>
<td>0.789</td>
</tr>
<tr>
<td>0.791</td>
</tr>
<tr>
<td>0.794</td>
</tr>
</tbody>
</table>
6.11.7 Weibull Probability Plot

6.11.7.1 Summary

The probability plot shows a graph with observed cumulative percentage on X axis and expected cumulative percentage on Y axis. The Weibull probability plot is used to test whether or not a dataset follows Weibull distribution. And its X scale type and Y scale type are Log10 and Double Log Reciprocal respectively. If all the scatter points are close to the reference line, we can say that the dataset follows the Weibull distribution.
6.11.7.2 What you will learn

- How to create a Weibull probability plot
- How to add the fill area between the percentiles lines

6.11.7.3 Steps

You can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Statistical Graphs and search "weibull")

1. Download the data from here. Drag and drop the downloaded txt file into the active worksheet. Highlight column A and right-click to select Set As: Y from the context menu.
2. Keep this column highlighted, select Plot > Statistical : Probability Plot from the Origin main menu to open the plot_prob dialog. In this dialog, change Distribution to Weibull and then click the OK button.
3. Double-click on the Lower Percentiles line to open the Plot Details dialog. Go to the Line tab, set Color to Red, Transparency to 80%, then check Fill Area Under Curve check box and select Fill to next
**data plot - One Color** in the below drop-down list.

4. Go to **Pattern** tab, set **Fill Color** to **Red**. And make sure the **Follow line transparency** is checked.
5. Go to the **Line** tab of Upper Percentiles line set **Color** to **Red**, **Transparency** to **80%**. Click **OK** to apply the setting and close the dialog.
6. Click on the X axis on the graph, and in the popup mini toolbar, click the Axis Scale button to open the Axis Scale dialog to change the scale to be from 10 to 100, and set the Tick Increment to 20.

7. In the Axis Scale dialog, switch to Vertical axis, and change scale from 1 to 99.99. Click OK to apply the setting and close the dialog.
6.11.8 Q-Q Plot

The Q-Q plot is a graphic method that tests whether or not a dataset follows a given distribution. The Q-Q plot has independent values on the X axis, and dependent values on the Y axis. If all the plotted points are close to the reference line, then we conclude that the dataset follows the given distribution.
6.11.8.2 What You Will Learn

- How to create a Q-Q plot
- How to mask a suspected outlier in the source data and recalculate the Q-Q plot

6.11.8.3 Create a Q-Q Plot

You can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Statistical Graphs)

1. Click the button to import the Q-Q plot.dat file under <Origin EXE folder>/Samples/Graphing path.
2. In the QQplot workbook, activate the Q-Q plot worksheet, highlight column B, right click, and from the context menu, select Plot > Statistical: Q-Q Plot. In the Plotting:plot_prob dialog, make sure that...
the **Score Method** drop-down is set to **Benard**. Click **OK**.

3. Double-click on the Lower Percentiles line to open the **Plot Details** dialog. Go to the **Line** tab, set **Color** to **Red**, **Transparency** to **80%**, then check **Fill Area Under Curve** check box and select **Fill to next**
**Graphing**

Data plot - One Color in the below drop-down list.

4. Go to Pattern tab, set Fill Color to Red. And make sure the Follow line transparency is checked.
5. Go to the **Line** tab of Upper Percentiles line set **Color** to **Red**, **Transparency** to **80%**. Click **OK** to apply the setting and close the dialog.

Your graph should look as shown below.
6.11.8.4 Mask a Suspected Outlier

1. Click on the green lock icon to make sure the **Recalculate Mode** is **Auto**.

![Recalculate Mode: Auto](image)

2. Click on the **Data Reader** tool and click to select the suspected data point in the **Q-Q Plot**.

![Data Reader](image)
The **Data Info** window shows the value of the outlier point.
3. Activate the **Q-Q plot** worksheet and highlight column B.

![QQ plot worksheet](image)

4. From the Menu Bar, click on **Window:Command Window** and at the prompt, enter the script shown below.

   ```
   colmask cond:eq val=x;
   ```

5. The outlier point will be shown in red in the **Q-Q plot** worksheet, and it will not be included in the graph.
Tutorials for Origin 2024b

Normal Q-Q Plot of Weight.

mu = 58.97922  sigma = 9.78098
6.11.9 Scatter Matrix

6.11.9.1 Summary

A scatter matrix consists of several pair-wise scatter plots of variables presented in a matrix format. It can be used to determine whether the variables are correlated and whether the correlation is positive or negative. This tutorial will show you how to create a Scatter Matrix plot.

6.11.9.2 What you will learn

- How to create a Scatter Matrix plot with a histogram
- How to customize Scatter Matrix plot
- How to set a grouping range for showing the color index
- How to specify to hide scatter plots on the bottom/top of the diagonal
6.11.9.3 Steps

6.11.9.3.1 Creating Scatter Matrix plot

1. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Statistics subfolder and find the file Fisher's Iris Data.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Highlight columns (A) to (D) but not col(E), and select Plot > Statistical: Scatter Matrix from the main menu.

3. In the dialog, select Histogram from the Show in Diagonal Cells drop-down list, and select Alternate from Show Tick and Label drop-down list.

![Scatter Matrix plot dialog box](image)
4. Click **OK** to close the dialog. The **PlotData1** sheet for the scatter matrix plot is generated in the same workbook as the original data. It contains the data for the different graphs in the scatter matrix and can be accessed by clicking on the second tab labelled **PlotData1** at the bottom of the workbook. The graph should appear as below:

![Scatter Matrix](image)

You have the option of performing a linear fit on each scatter plot and calculating adjusted R-squared and, additionally, Pearson's correlation coefficient (Pearson's r). Beginning with Origin 2019, these statistics are outputted to a sheet in the active book and named as **ScatterMatrixStatsN**.

Label each plot in the scatter matrix with Adj. R-Square and/or Pearson's r values by checking the boxes under **Additional Statistics**.
6.11.9.3.2 Customizing Scatter Matrix plot

There are multiple layers in the Scatter Matrix graph. This section will explain how to customize the background color, the type and color of the data plots and the axis tick labels of the scatter matrix. Starting with Origin 2016, by default, if you change the plot style or axis setting of one layer, all other layers will follow (for independent editing, see the tip at the end of this section).

1. Double click on the scatter data to open the Plot Details dialog. To change the symbol color click on the Symbol Color drop-down menu and select a color from the Individual Color option. Specify the type
and color of the symbol as shown in the following image.

2. To custom the pattern style of the histogram, go to the plot level under Layer1 and select the **Pattern** tab. Set the **Border Color** to Red, **Fill Color** to None and **Pattern** to Medium as shown in the following image. Click **OK** button.
This change will be applied to all scatter data plots in this graph.

3. To change the background color of the entire window, select **Format: Page** to open the **Plot Details** dialog. This dialog can also be accessed by double-clicking inside the Scatter Matrix window. In the **Display** tab, click on the **Color** drop-down and click on an empty color well beneath **Custom**. This opens the **Colors** dialog box where you can define custom colors.
4. In the **Colors** dialog, specify the color as Red=235, Green=235, Blue=255 and click **OK**.

5. To change the background color of the scatter plot layers without changing the background color of the histograms or the rest of the graph, double-click on a scatter plot to open the Plot Details dialog. Click the **Background** tab, and set **Color** to **White**.
Then click **OK** in the dialog. This change will be applied to all layers with scatter data plots.
6. Double-click on any tick label in the graph to open the **Axis** dialog for that layer. Go to the **Tick Labels** tab, then the **Format** tab, specify **Size** to **36** for the **Top** axis. Click **Apply**.

7. Click the **Apply To...** button to open the **Apply To** dialog, set the following to apply the previous customization of tick label size to all the other axes in this window. Click **OK**, then **OK** to close the **Plot**.
Details dialog box.
8. The graph will appear as shown below:

![Graph Image]

### 6.11.9.3.3 Add Grouping Range

Currently, our scatter plots show pair-wise comparisons of variables Sepal Length, Sepal Width, etc. What is not apparent from our scatter plots is that measurements were made on three species of iris. Since all scatter points look the same, we cannot distinguish between species. What we will do is to use the Species column in our original worksheet -- the column that we left out when making the graph -- to color each scatter point so that we can see the effect of species in our pairwise comparisons.

1. To add species information to our plot, click on the green lock icon on the upper-left corner of the graph window. Select **Change Parameters** to bring up the **Plotting: plot_matrix** dialog.

2. Click the triangular button beside **Grouping Range** and choose **E(Y): Species**, then click **OK**.

3. Click the **OK** button in the **Plotting: plot_matrix** dialog. The graph will appear as shown below:
6.11.9.3.4 Customizing Matrix Display

One Scatter Matrix display option is to hide half of the scatter plots (since they merely repeat the same information shown by the other half of the scatter plots).

1. To hide the layers below the diagonal in the Scatter Matrix graph, click on the green lock icon on the upper-left corner. Select Change Parameters to bring up the Plotting: plot_matrix dialog.

2. Under the Matrix Profile branch of the dialog:
   - Select Upper Triangular from the Matrix Display drop-down list
   - Select All from Show Tick and Label drop-down list
   - Enter 2 in the Gap (in % of Page Dimension) text box
6.12 Polar

6.12.1 Polar

- Polar Contour
- Polar Plot with Error Bar
- Cropped Polar Plot with Custom Orientation
- Polar Graph with Custom Radial Axes
- Polar Graph with Multiple Layers
- Polar Graph with Columns
- Polar Graph with Custom Angular Scale

6.12.2 Polar Contour
6.12.2.1 Summary

This tutorial will show you how to create a Polar Contour graph from both XYZ worksheet data and matrix data.

6.12.2.2 What will you learn

- Create a Polar Contour graph from both XYZ data and matrix data
- Customize the graph using the Plot Details dialog box

6.12.2.3 Steps

6.12.2.3.1 Plot Polar Contour from XYZ data

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select Polar Charts from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Polar Chart - Polar Contour".

Note: This tutorial is associated with the folder Polar Contour of the "Tutorial Data" project: <Origin EXE Folder>\Samples\Tutorial Data.opj.
2. Activate the first worksheet of the workbook **Temperature and Location** containing the temperature and location data and select column C. Select **Plot > Contour : Polar Contour theta(X) r(Y)** from the menu to create a polar contour graph. The graph should look like this:

![Polar Contour Graph](image)

3. Next, we will customize the contour graph using the Mini Toolbars. Click on the contour plot, and in the pop up mini toolbar, click the **Flip Colormap** button ![Flip Colormap Button](image) to reverse the color order of the colormap.

![Flip Colormap Button](image)

4. Click on the angular axis (the circular arc edge of the polar), and in the popup Mini Toolbar, click the **Axis Scale** button ![Axis Scale Button](image) to open **Axis Scale** dialog. In this dialog, with **Angular Axis** selected, set **Tick**
Increment to 60; with Radial Axis selected, set From and To to 0 and 7, Tick Increment to 2.

5. Next, let us open the Axis dialog to do further customization for the axes and axes labels. Double-click on the Radial axis to open the Axis dialog. Go to Tick Labels tab. Pressing Ctrl key and select both Radial - Outer 1 and Radial - Outer 2 in the left panel. In the right panel, go to Display tab, select Tick-indexed dataset in Type drop-down list, then select [Book2]Sheet2!A"Latitude" from the Dataset Name drop-down list.
Select **Angular - Outer** in the left panel. In the right panel, go to **Display** tab, select **Tick-indexed dataset** in **Type** drop-down list and then select **[Book2]Sheet2!B"Longitude"** from the **Dataset Name** drop-down list.
6. Click **Apply** button. Go to **Grids** tab, and make sure **Radial** is selected in the left panel. Edit the dialog box settings as in the following image. Click **OK** to close the **Axis** dialog box.

7. Double-click on the **Color Scale** to open the **Color Scale Control** dialog box and edit settings as follows:
   - In the **Labels** page, set font size to **20**.
In the **Layout** page, uncheck **Reverse Order** check box, and set **Color Bar Thickness** to **100**.
In the **Title** page, enter \((\ell+{o}\ell F)\) in the **Title**, which is supposed to be displayed as \(\ell^\circ F\) as the unit for temperature. And set the **Position** to **Bottom**.

In the **Line and Ticks** page, uncheck **Show Line and Ticks on Right** and **Show Border** check box. Then Click **OK** to save the setting and close the dialog.

**Note:** The text used for **Title** is \((\ell+{o}\ell F)\), which is supposed to be displayed as \(\ell^\circ F\) as the unit for temperature.
8. Add the graph title **Temperature Contour Map**, axis title **Latitude** to the graph. The graph should look like this:

![Temperature Contour Map](image)

**6.12.2.3.2 Plot Polar Contour from Matrix data**

1. Select **Help: Learning Center** menu or press **F11** key to open Learning Center. Select **Graph Sample** tab and then select **Polar Charts** from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Polar Chart - Polar Contour from Matrix".
Note: This tutorial is associated with the folder Polar Contour of the "Tutorial Data" project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

2. Activate MBook1. Select Plot > Contour: Polar Contour theta(X) r(Y) from the menu or click the Polar Contour theta(X) r(Y) button on the 3D and Contour Graphs toolbar.

3. Double click the axes to open the Axis dialog, we also can customize the Radial Axes and Angular Axes for this polar graph.
Go to **Show** tab, keep pressing **Ctrl** key to select both **Radial - Outer 1** and **Radial - Outer 2** in the left panel, uncheck **Show** check box in right panel to hide these two axes. Click **Apply** button.

Click **Add a radial axis** button to add a inner radial axis. Choose this **Radial - Inner Axis 1** in the left panel. From the **Angle At** drop-down list, select **End Angle** and set **Flow Direction** to **Negative**.
Choose **Angular - Outer** in the left panel, in the **Axes Start at (deg.)** box, enter **-30**. Click **OK** to save settings and close the dialog.
4. Click on the contour area, and in the popup Mini Toolbar, click the Set Levels button to open the Set Levels dialog to do settings as below:

5. Click the right edge of this sector to select the graph layer as below. Drag and drop the sector up to the center of the graph window.

6. Double-click on the **Color Scale** object to open the **Color Scale Control** dialog.
   - In the **Levels** page, check the **Hide Head Level** and **Hide Tail Level** check box.
In the **Layout** page, uncheck **Reverse Order** and set **Color Bar Thickness** to 400.

In the **Title** page, uncheck **Show** check box.
In the **Line and Ticks** page, uncheck **Show Line and Ticks on Right** and **Show Border**. Click **OK** to save settings and close the dialog.
8. Click on the Color Scale object and use the anchor points to resize it from vertical direction. The resulting graph should look like this:

Polar contour graphs from matrix data support filling color to contour lines or to the matrix grid. For more information, see these two topics:

- Customizing Polar Contour Graphs from Matrix Data
- Color Fill Control Group

### 6.12.3 Polar Plot with Error Bar

#### Videos

- Adding Error Bars to a Graph
- Plot Data with Different Y Plus and Minus Error Bars
- Plot X and Y Error Bars
- Polar Axis Dialog

#### OriginBlog

6.12.3.1 Summary
This tutorial will demonstrate how to create a Polar graph with error bars:

6.12.3.2 What you will learn

This tutorial will teach you how to:

- Create a Polar graph with error bars
- Customize the graph using the Plot Details and Axis dialogs

6.12.3.3 Steps

1. Import the data file PolarPlotwithErrorBar.dat under <Origin EXE Folder>\Samples\Graphing\ path (Minimum Origin Version: 2015 SR0), or you can download this data file directly and import into Origin.
2. Hover your cursor over col(C) till it appears as a downward pointing arrow and click to highlight column C. Right-clicking produces a menu where this column can be set as Y error.
3. In order to plot the Polar graph of the data with error bars highlight all the columns. In the main menu select Plot > Specialized : Polar theta(X) r(Y) or click the Polar theta(X) r(Y) button on the 2D Graphs toolbar.
4. Double-click inside the plot to open the **Plot Details** dialog. In the **Error Bar** tab change the **Color** to Magenta and remove the negative error bars by deselecting the **Minus** box as shown below:

![Plot Details dialog](image)

5. If the left panel of **Plot Details** is hidden, click the button with the two arrows on the bottom left of the dialog box. The left panel presents a tree-view display of the layer and data the user is modifying. It also displays a **Plot Type** list at the bottom. Use the **Plot Type** list to change the plot from **Line** to
**Scatter.** This will change the tabs on the right panel and add a Symbol tab. In the Symbol tab, change the symbol style, color, and transparency as shown below. To select the symbol color, use the Individual Color option in the Symbol Color button. Click OK to close the dialog.

6. The next step is to modify the radial axes grid lines. These are the circular grid lines between the inner and outer angular axes. Double-click the vertical axis on the left side of the graph, (i.e. the Radial Axis) to open the Axis dialog. In the Grids page, choose Radial on the left panel. Change the Major Grids Line Style to Dash, and then clear the Minor Grids Show check box as shown below:
7. Use the same procedure to modify the angular axes grid lines, the grid lines that radiate out from near the center of the plot to the edges. In the Grids page, choose Angular on the left panel. Change the Major Grids Line Style to Dash, set Start at to Radial Start, and then clear the Minor Grids Show check box. OK to save changes.
8. The completed polar plot should appear as shown below:
6.12.4 Cropped Polar Plot with Custom Orientation

6.12.4.1 Summary

This tutorial will demonstrate how to create a cropped polar graph:
This graph shows a polar scatter plot with a radian scale. The graph axes orientation is customized and the graph is also cropped to show a specific portion of it.

Minimum Origin Version Required: 2015 SR0

6.12.4.2 What You Will Learn

This tutorial will show you how to:

- How to create a polar graph with radial axes
- How to customize the polar graph, such as rotate a polar graph and display tick labels as quarters
- How to crop a polar graph

6.12.4.3 Steps

This tutorial is associated with the sample graph project "Cropped Polar Plot with Custom Orientation". You can open this project in Learning Center:

- Select Help: Learning Center menu or press F11 key to open Learning Center.
- Search and open the sample Polar Charts - Cropped Polar Plot with Custom Orientation under Graph Samples panel.

6.12.4.3.1 Create a Polar Graph and Customize the Axes
Activate the workbook **Cropped Polar Plot with Custom Orientation**. Highlight all the columns in Sheet 1 and choose **Plot > Specialized: Symbol Θ r** from the main menu to create a polar graph:

![Graph1](image)

6.12.4.3.1.1 Customize Axes in Axis Dialog

1. As the angular axes uses Degrees as Unit by default. We have to customize **Angular Axes**:
   - Double-click on the axis to open the **Axis Dialog**. Go to **Scale** tab and choose **Angular** in the left panel. Expand **Units Definition** node and set **Units** to **Radians** from the drop-down list. Change the **Value** option under **Major Ticks** to **0.25**, **Count** under **Minor Ticks** to be **9**.
To change the orientation of the plot, go to the Show tab and make sure the Angular - Outer is selected in the left panel. Set Direction to Counter Clock-Wise and the Axis Start at(deg) to 270 as shown below:
Go to **Tick Labels** tab, set **Display** to **Custom**, **Custom Format** to 
#/#.  

- Click **Apply** button to apply these settings.

2. Let's customize the **Radial Axes** scale. Go to the **Scale** node and choose the **Radial** in the left panel. Change the **To** value to 5.01 (the 0.01 will show the last tick), **Count** option under **Minor Ticks** to 0.
3. Then, we are going to add a **Inner Radial Axis**
   - In the **Show** tab, click on the **Add a radial axis** button on the top of the left panel. Then the **Radial - Inner Axis 1** is added in the left panel.
   - To change the orientation of the new inner axis from vertical to horizontal, under **Axis Position** section, set the **Reference** as **Clock Dial** and the **Clocks** option as **3 O’Clock**. Select the **Negative** radio button to shift the tick labels to the opposite side of the axis:
To add tick labels on Inner Axis 1, go to Tick Label tab, under Display subtab and select Tick-indexed string from the Type drop-down. Type 0A Lv1 Lv2 Lv3 Lv4 in the Display edit box.

- Go to the Format subtab and change the tick label format as below:
1. Go to Special Ticks, set Axis Begin and Axis End to Hide.

2. Click Apply to apply these settings.

4. Go to Grids tab, set grid lines of Radial and Angular axis as below:
Click OK button to apply these settings.

5. Drag-and-drop two outer radial axes to the position of % of Radius = \(-40\).
6.12.4.3.1.2 Customize Scatter Plot with Mini Toolbar

We are going to customize the scatter plot with mini toolbar.

1. Click on one data point, in the popup mini toolbar, set the symbol shape.
2. Click on the error bar, in the popup mini toolbar, only show the plus Y error bars and set its color.
6.12.4.3.2  Crop the Polar Graph

In **Axis** dialog, there is a button **Crop...** at the bottom. Clicking it will open a dialog which allows you to magnify and emphasize any particular section of the polar plot.
6.12.4.3.2.1 Select the Region You Want to Crop

Before cropping the polar graph, you can use the Rectangle tool to obtain the size and location data of the area of interest.

1. Click the toolbar button Rectangle Tool and then draw a rectangle on the graph.
2. In order to see the graph clearly when adjusting the size of the rectangle, click on the rectangle, in the popup mini toolbar, click **Transparency** button to set **Transparency** to 60%.
3. Adjust the size and position of the rectangle. Once the rectangular area is ready, double-click it to open the **Object Properties** dialog box to get size and position data for the portion beneath the rectangle.
6.12.4.3.2.2 Crop the Graph

1. Double-click on any axis to open the **Axis Dialog** again. Click on the **Crop...** button to open the **Miscellaneous** dialog. Check the **Enable** box and enter the size and position values you gotten from the rectangle object.
2. Click **OK** to exit this mini dialog. And click **OK** button to close the **Axis** dialog. The graph will now appear as shown below:

![Graph Image]

3. As you can see, the area beneath the rectangle has been cropped out. Click on the rectangle object and delete it. Finally, you will get the graph below:
6.12.5 Polar Graph with Custom Radial Axes

6.12.5.1 Summary

Origin's polar axis dialog allows for flexible customization of both angular and radial axes.
6.12.5.2 What You Will Learn

This tutorial will show you how to:

- create a polar graph
- hide angular axis
- customize radial axis

6.12.5.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

6.12.5.3.1 Create a Polar without Angular Axis

1. Open the Tutorial Data.opj file and browse to the Custom Radial Axis folder and activate workbook Book1E.
2. Highlight column B and select Plot > Specialized : Polar theta(X) r(Y) to generate a polar graph.
3. Select the legend object and delete it.
4. To hide the Outer axis (the outer circle) of the polar graph, double-click on any axis to open the **Axis** dialog. Go to **Show** tab, select **Angular -Outer** in the left panel, and clear **Show** check box.

5. To hide all angular grid lines, go to **Grids** tab and make sure **Angular** is selected in the left panel. Clear the **Show** check boxes under **Major Grid Lines** and **Minor Grid Lines** section.
6. Go to Scale tab and select Radial in the left panel. Set the axis scale as shown below:
7. Go to the **Grids** tab and set as below:
6.12.5.3.2 Add Radial Axis on each Major Tick

1. To show radial axis on each major tick position of angular axis, click the 'Radial Axes Configuration' button to open the dialog. In the dialog, check the Major Ticks option under the Axes Inside Polar section.
2. To hide axis titles, go to **Title** tab and choose **Radial - Major Axes** in the left panel. Uncheck the **Show** check box. Click **Apply** button.
3. There are 4 0’s show in center of polar. To hide them, go to the Special Ticks tab. Select Hide from the Axis Begin drop-down list.

Click OK to close the dialog.

When radial axis is set to show on each major ticks, if you go to Scale tab of Radial and change major ticks, the radial axis will show in new major tick positions.
6.12.5.3.3 Use Configuration Dialog to Customize Radial Axis

Origin supports two kinds of radial axes. One is the frame border kind of axis around the polar graph. The other is inner axis from center of polar outwards.

1. Continue with the graph from the previous section, click on the Radial Axes Configuration button on the top of left panel. In Radial Axes Configuration dialog, under Axes Inside Polar branch, set Angles List as below, and click OK to close dialog.

2. Click Apply button. Four four radial inner axes show in the left panel.

3. Go to Title tab, select Radial - Inner Axis1 in the left panel. Then check Use Same Options for All Radial Axes check box and clear the Show check box to hide all the titles. Then this setting will be applied to four radial axes.
4. Go to Tick labels node and check Use Same Options for All Radial Axes. Under Format subtab, set Rotate(dge.) to be 0.
5. Go to the Special Ticks tab, and click Use Same Options for All Radial Axes check box. Set Axis Begin to Hide.

6. Go to Show tab, press Shift key to select Radial - Inner Axis 3 and Radial - Inner Axis 4 two axes, change Flow Direction to Negative under Axis Position section.
7. Go to **Tick labels** tab, enter a minus sign(-) in the **Prefix** edit box under the **Display** subtab.
8. Click **OK** button.
6.12.5.4  Further Customization

9. To change the line plot color to red and a little thicker, select the line plot and on Style toolbar, set Line/Boder Color as red, and set Line/Border Width to 1.5.

10. To add an equation to this graph as graph title, right-click on the graph and select Add/Modify Layer Title, then enter \( r = \exp(q \cdot \cot \left( \frac{79.5p}{180} \right)) \) into the edit box.

11. Origin supports rich text. So highlight \( q \) in the text and click the button on Style toolbar to turn it into \( \theta \). Also turn \( p \) into \( \pi \). The text will look as below.

\[ r = \exp(\theta \cdot \cot \left( \frac{79.5\pi}{180} \right)) \]

12. To add shadow to the text and make the font bigger, right-click on the title and click Properties... to open the Object Properties dialog. In the Text tab, set font size to 26, and go to Frame tab to change Frame to Shadow. Click OK to save the setting.

13. Drag the equation to the desired position. The graph should look like the one in Summary.

6.12.6 Polar Graph with Multiple Layers

6.12.6.1 Summary

The multi-layered graph allows the placement of several polar plots with different ranges on one graph page. This graph is generated by first creating 3 independent polar graphs, and then using the merge graph function to combine the three graph pages into one three-layer polar graph.
Minimum Origin Version Required: 2015 SR0

6.12.6.2 What You Will Learn

This tutorial will show you how to:

- Customize the Angular axis and Radial axis.
- Duplicate a graph with new data.
- Create multi-layered polar graph.
- Create one legend for the whole page.

6.12.6.3 Steps

This tutorial is associated with the Tutorial Data.opj file under the <Origin EXE Folder>\Samples\ path.

6.12.6.3.1 Create a Polar Graph for the Measured Data

1. Open the Tutorial Data.opj file and browse to the folder Polar Graph with Multiple Layers. Double-click the workbook Book26 to open the workbook window.
2. Highlight Column A and Column B and select **Plot > Specialized: Polar θ(X) r(Y)** from the main menu to create the polar graph.

3. Double-click on any tick label of the Angular axis to open the dialog. Go to the **Scale** tab for Angular axis. Set the **Scale** of the Angular Axes as **From 60 To 150**. Set the **Value** for increments under **Major Ticks** as **30**. Click the **Apply** button to see the changes on the graph.
4. Go to **Tick Labels** tab and make sure **Angular - Outer** is selected in the left panel. Under **Display** subtab, type `(176)` in the **Suffix** text box to add the degree symbol to the Angular tick labels. For more details of supported text formatting commands, please refer to the [escape sequences](#) page.
5. Click the **New Configuration...** button to open the **Radial Axes Configuration** dialog.
   - Check the **Axes Inside Polar** box and configure it as shown below:
     1. Set the **Angles List** as **Custom**.
     2. Set the **Value** text box as **60 150** to place an axis at 60 degrees and one at 150 degrees.
   - Set the **Axes Outside Polar** options as shown below:
     1. Select **Upper** from the **Right** option drop-down to place an axis at the upper right of the layer frame.
     2. Set **%s of Radius** as **0**.
6. Click **OK** to apply the settings.

7. Go to **Scale** tab, and select **Radial** in the left panel. Set radial axis **From** as 2 and **To** as 6. Change the increment **Value** for the **Major Ticks** to 1.
8. Go to **Tick Labels** tab and select **Radial - Inner 2** in the left panel. Uncheck **Show** check box to hide the tick labels for this axis.
9. Go to **Title** tab and select **Radial - Outer 1** in the left panel. Uncheck **Show** check box to hide the title of the outside polar axis. Click the **OK** button.

![Radial Axis - Layer 1](image)

10. Double-click the plot to open the **Plot Details** dialog. In the left panel of the **Plot Details** dialog, click the **Graph** page to go to the page level of this dialog. In the **Legends/Titles** tab, deselect the check box **Indicate Active Dataset**, so that the red box around the legend symbol will be hidden.

11. Expand the **Layer** node on the left panel and select the graph under it. On the **Line** tab in the right panel, change **Width** to 4 and **Color** to **Blue**.

![Plot Details - Plot Properties](image)
Graphing

12. Click the **OK** button to apply customizations to the first polar graph.

![Graph3](image_url)

**6.12.6.3.2  Duplicate a Polar Graph with the Calculated Data**

1. Right-click the header of the polar graph to open the shortcut menu. Select **Batch Plotting...** to open the batch plotting dialog. Select **Column** from **Batch Plot with** dropdown list. Select the column...
**C:Calculated** and click **OK** to duplicate a polar graph with data from Column C.

2. Since the data range in Column C is quite different from Column B, the **Reminder Message** window will pop up, asking whether to rescale the axes of the new graph to show all data. Leave the **Yes** radio button selected and click **OK**.

3. Follow steps 3 from the last section to set the scale of the Angular Axes. Set **From** as **240** and **To** as **360** and the increment of the **Major Ticks** to **15**.

4. On the **Scale** tab, choose **Radial** in the left panel and then set **From** as **2** and **To** as **6** and the increment of the **Major Ticks** as **1**.
5. Go to **Show** tab
   - Choose **Radial - Inner 1** in the left panel. Under **Axis Position** section, set the **Value (Degrees)** as 240 to move the first inside polar axis to 240 degrees.
   - Choose **Radial - Inner 2** in the left panel. Set the **Value (Degrees)** as 360.
   - Choose **Radial - Outer 3** in the left panel. Select **Left-Lower** in **Axis at** drop-down list to move the outside axis to the lower left of the layer frame.

Click the **OK** button to finish customizing the axes.

6. Double click the plot to open the **Plot Details** dialog. Change the line **Color** to **Red** and **Width** to **4** in the **Line** tab. Click **OK**.

![Graph4 - Copy of Graph3](image)

### 6.12.6.3.3 Create a Polar Graph to Show Full Range Grids

1. Open the workbook **Book26**.
2. Select Column D and click the **Polar theta(X) r(Y)** button in the **2D Toolbar** to create an empty polar graph.
3. Repeat steps 3 in the **Create the Polar graph for the Measured data** section to set the scale of the Angular Axes as **From 0 To 360** and the increment **Value** of the Major Ticks as **30**.
4. Go to **Show** tab, select **Angular - Outer** on the left panel and uncheck **show** box. Then select **Angular - Inner** on the left panel and check **Show** box.
5. Go to **Tick Labels** tab, select **Angular - Inner** in the left panel, and uncheck the **Show** check box to hide the tick labels of the inner Angular axis.
6. Go to **Grids** tab, make sure **Angular** is selected in the left panel. Uncheck the **Show** option in the **Major Grid Lines** and the **Minor Grid Lines** sections.

7. Go to **Scale** tab, select **Radial** in the left panel, and change the scale **From 2 To 6** and set the increment **Value** of the **Major Ticks** as 1.

8. Go to **Show** tab, select **Radial - Outer 1**, and check **Use Same Options for All Radial Axes**. This will apply the settings on this page to **Radial - Outer 2** axis as well. And then uncheck **Show** check box. Click the **OK** button.

### 6.12.6.3.4 Create the Multi-layered Graph with One Legend

1. With a graph window activated, select **Graph: Merge Graph Window** from the main menu.

2. Set the **Merge** option as **Specified** and make sure only **Graph1, Graph2** and **Graph3** (the three new graphs just created) are selected in the **Graphs** text box.

3. In the **Arrange Settings** section set both **Number of Rows** and **Number of Columns** to 1 to overlay the three graphs.

4. Check the box next to **Link Source Graphs**.

5. In the **Page Setup** section, set both **Width** and **Height** to 15.
Graphing

6. The preview of the graph can be seen in the right panel.
7. Keep the rest of the default settings and click **OK**.
8. Right-click the legend and select **Legend: Update Legend** from the shortcut menu, to open the dialog.
9. Set the **Update Mode** to **Reconstruct** to create a new legend.
10. Set the **Legend** to **One Legend for Whole Page** to create only one legend for this multi-layered graph.
11. Set the **Layer Order** as **Descending** to place the Layer 2 legend above the Layer 1 legend.

12. Set the **Auto Legend Translation Mode** as **@LA: Long Name** to use the Long Name data for the legend. Click **OK**.

13. Right-click on the new legend and select **Properties...** to open the dialog.
14. Delete the first line in the lower text box.
15. On the **Frame** tab, set Frame to **None**. Click **OK**.
16. Drag the legend to the center of the inner Angular axis.

17. Use the **Font Size** text box to change the size of the fonts on this graph. Drag the tick labels to move them to an appropriate position.
18. Right-click one of the inner radial axis titles (**Calculated** or **Measured**) and select **Properties...** from the shortcut menu.
19. In the **Object Properties** dialog that opens, in the **Frame** tab, choose the **None** from **Frame** drop-down list. This clears the grid lines and other background from behind the axis title making it easier to read. Click **OK**.
20. Repeat the same operation for the other inner radial axis title.

21. The final graph should appear as shown below:
6.12.7 Polar Graph with Columns

**Videos**
- Polar Axis Dialog
- Add Color Scale in Graph

**OriginBlog**
- Radial Stacked Bar

6.12.7.1 Summary
By default, Origin polar graphs are line plots. Note, however, that you can convert an existing polar line plot to column/bars.

6.12.7.2 What You Will Learn

This tutorial will show you how to:

- plot polar graphs with columns
- control the column width using a dataset
- customize the polar axes

6.12.7.3 Steps

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select Polar Charts from the "Category" drop-down list. Double-click on the graph sample below to open the sample "Polar Chart - Polar Column with Transparency".
2. Activate the workbook "Book18". Highlight column B and select **Plot > Specialized: Polar theta(X) r(Y)** to create a line plot in the polar coordinate system. Click on the legend object and delete it from the graph.

**Note:** This tutorial is associated with the folder **Column and Stack Column** of the "Tutorial Data" project: `<Origin EXE Folder>\Samples\Tutorial Data.opj`. 
3. Click on the line plot, and in the popup mini toolbar, click **Change Plot to** button to change the line plot as a column plot.

4. Click on the column, and in the popup mini toolbar, click **Fill Color** button to expand the Color Chooser. In Color Chooser, select **By Points** sub-tab, set **Color** to **Color Mapping:Col(D)**. This will map
column colors in the plot using the row value in column D of the worksheet.

5. Double-click on the column to open the **Plot Details** dialog.

   - Go to **Pattern** tab, set the **Transparency** in this tab to 70%, and **Width** of border to 2:

   ![Plot Details dialog](image)

   - Go to the **Spacing** tab, select **Col(C):"Size"** from the **Width(in %)** drop-down menu and type in 8 as **Scaling Factor**. This causes values in column C to determine the width of the columns in the plot.
Go to Colormap tab, click Level head. Set the level from 0 to 1 and Increment to 0.2 in the Set Levels dialog.

6. Click OK to close the Plot Details dialog.

7. Now we will customize the graph Angular Axes.
   - Double-click on an axis (Angular or Radial) to open the Axis dialog. Go to the Scale tab under the Angular tree node and set the Value under Major Ticks to 45, and set the Count under Minor Ticks to 2.
   - Go to Format tab under Tick Labels tab of Angular -Outer tree node. Check Bold check-box.
   - Go to Grids tab under Angular tree node. Change Style of Major Grid Lines to Dash.
   - Go to Line and Ticks tab under Angular -Outer tree node. Change Thickness of Line to 1.5.
8. In the **Axis** dialog, we also can customize the **Radial Axes** for this polar graph.

   - Click on the **Radial Axes Configuration** button on the right-top of this dialog to open the dialog. In the dialog, choose **0 90 180 270** under the **Angles List** drop-down list.

   ![Radial Axes Configuration dialog](image)

   - Go to the **Scale** tab under the **Radial** tree node. Set scale from **0** to **1**.
   - Go to the **Format** tab under **Tick Labels** tab, and then
     - select the **Radial - Inner1**, change **Size** to **12**, check **Bold** box, and set **Rotate (deg.)** to **0**.
     - select the **Radial - Inner2**, change **Size** to **12**, and check **Bold** box.
     - select both **Radial - Inner3** and **Radial - Inner4**, then uncheck **Show**.
   - Go to the **Display** tab under **Tick Labels** tab of **Radial - Inner1** tree node. Choose **Custom** in **Display** drop-down list, and enter **.2* in Custom Format** text box.
   - Go to the **Title** tab and highlight all radial axes node. Uncheck **Show** check box.
Go to the **Grids** tab under **Radial** tree node. Uncheck **Show** check box under **Minor Grid Lines**. Click **OK** to save the setting and close the dialog.

Go to **Line and Ticks** tab, select all radial axes. Change **Thickness** of **Line** to **1.5**. And set **Style** to **In & Out**, **Length** to **5** for both **Major Ticks** and **Minor Ticks**.

Go to **Special Ticks** tab of **Radial - Inner 1**, then set **Axis Begin** value to **Show**, **Axis End** value to **Hide**. Choose **Radial-Inner 2**, set both **Axis Begin** and **Axis End** value to **Hide**. Click **OK** to apply the setting and close the dialog.
9. Select **Insert: Color Scale** to add the color scale legend. To customize the color scale legend, click on the color scale, and in the popup mini toolbar,

- Click **Show Head and Tail Levels** button to hide the head and tail level.
- Click **Decimal Places** button to select 1 from the drop-down list to set the decimal place of the labels to be 1.
- Click **Separate Layout** button to show the color blocks separately.

10. Click on the Enable/Disable Anti-Aliasing button. This polar column plot should look something like this:
6.12.8 Polar Graph with Custom Angular Scale

Normally, the polar angular axis unit reads in degrees, radians or gradians. However, Origin's polar graph also supports use of custom units.
Minimum Origin Version Required: 2018b

6.12.8.2 What You Will Learn

This tutorial will show you how to:

- use a dataset to control symbol size and color in a polar graph.
- use a custom unit for the angular axes.
- display tick labels as quarters.
- add and custom the bubble scale

6.12.8.3 Steps

You can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Polar Graphs)

1. Highlight column B and select Plot > Specialized :Symbol theta r to create a symbol plot in polar coordinate system.
2. Double-click on any axis to open the Axis dialog. Go to the Scale tab and select Angular in the left panel. In this right panel, expand Units Definition node, and choose Radians as Units. Make sure the scale
from 0 to 2 PI. Then change the Value of increment to 0.25.
3. Go to the **Show** tab for **Angular-Outer** axis, then change the **Direction** to **Clockwise** and set **Rotate (deg.)** to **90**.
4. Go to the **Scale** tab and select 'Radial' in the left panel. Then set the scale from 0 to 1.2, and change the **Value** of increment to 0.4.

5. Go to **Tick Lables** tab for the **Angular- Outer** axis. Open **Display** subtab, set **Display** to **Custom** and enter \# \# /4 as **Custom Format** to show the tick labels as fractions.

6. Select **Radial- Outer 1** axis. Choose **Format** subpage, and check the **Bold** check box. Then click the **Apply To...** button. In the pop-up dialog, make sure **Apply From** is **Outer 1** and **Apply to** is **All Axes**, then check the **Bold** under the **Tick Labels**. Click **OK**.
In Axis dialog, click OK to apply settings and close the Axis dialog.

7. Double-click on the line plot to open the Plot Details dialog, in the Symbol tab, recreate the following settings, in the sequence shown in the screenshot:
Click OK to apply the settings and close the Plot Details dialog.

8. Select Bubble Scale in the Insert main menu to add a bubble scale in this graph. Click the bubble scale, and in the popup mini toolbar, click Layout button to select Nested Layout form the drop-down list.
9. Click the scale again, and in the popup mini toolbar, click the **Bubble Style** button to remove the fill color for the bubbles.

10. Click the scale again, and in the popup mini toolbar, click **Decimal Places** to set it to be 1.

11. Double-click on the bubble scale to open the **Bubble Scale Control** dialog. Go to the **Levels** page, set the level from 0 to 1, and change the **Value** of increment to 0.2.

12. Go to **Layout** page, change the **Label Offset from Symbol Center** to 150. Check the **Show Leader Line** check box, then expand the node to check the **Auto Reosition to Avoid Overlapping** check box. Click **OK** to apply the setting and close the dialog.
Manually move the legend object and Radial axis, and click the **Enable Anti-Aliasing** button.
Tutorials for Origin 2024b

To smooth the graph. The final graph should look like this:

6.13 3D Graphs

6.13.1 3D Graphs

- 3D Pie Chart
- 3D Vector
- 3D Scatter Plot with Line Projections of Core Drilling Locations
- 3D Bar and Symbol
- Creating Intersecting Surface Plots from Worksheets
- Colormap from Second Matrix
- Color Map Surface Graph
- Parametric Surface with Colormap from Data
- Stacked 3D Surface Plots
- Multiple Surfaces in Same Layer
- 3D Scatter with Colormap
6.13.2 3D Pie Chart

**Summary**

Origin's 3D Pie Chart gives you complete control over the look of the plot. Set the thickness of the pie slice, displacement, view angle, and size and rotation of the chart. You can even choose to explode the view of one or more pie slices.
6.13.2.2 What you will learn

- Create a 3D pie chart and change the plot colors.
- Modify the pie chart view angle.
- Explode the view of pie slices.
- Label pie slices, add leader lines and drag to re-position labels.

6.13.2.3 Steps

You can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Statistical Graphs)

1. Import the data \Samples\Graphing\3D Pie Chart.dat into worksheet, and rename the column long name as Demographic and Percent.
2. Highlight the 2nd column and create a 3D Pie Chart by clicking Plot > Basic 2D: 3D Color Pie Chart.
3. Double-click the pie chart to bring up the Plot Details dialog. On the Pattern tab, in the Fill group, click the Color drop-down and then on the By Points tab of the Color Chooser, click on the Color List drop-down.
4. Choose the **System Color List**, then move the **Increment from** slider to the right one color position, then click **Apply**.

5. Click the Pie Geometry tab and duplicate the following settings:
6. Click on the **Labels** tab and in the **Position** group, clear the **Associate with Wedge** check box. Enable Show Leader Line if Offset Exceeds (%) and enter an offset of 2.

7. Click **OK** to close Plot Details. Drag the graph legend to the left side of the pie. Drag wedge labels to reposition them, noting that the leader line follows the label. Your graph should now look something like this:
6.13.3 3D Vector

6.13.3.1 Summary

Origin can plot 3D Vectors from two different data structures: \texttt{XYZ XYZ} and \texttt{XYZ dXdYdZ}.
\texttt{XYZ dXdYdZ} defines the tail and head data for the vector, while \texttt{XYZ dXdYdZ} provides the vector's tail data and the distance between tail and head projections on X, Y, and Z axes.

6.13.3.2 What you will learn

- Create a 3D Vector from \texttt{XYZ dXdYdZ} worksheet data.
- Customize the 3D Vector

6.13.3.3 Steps

This tutorial is associated with \texttt{<Origin EXE Folder>\Samples\Tutorial Data.opj}.
Also, you can refer to this graph in Learning Center. (Select \textbf{Help: Learning Center} menu or press \textbf{F11} key, and then open \textbf{Graph Sample: 3D Symbol Bar and Wall})
1. Open Tutorial Data.opj and browse to the 3D Vector folder in Project Explorer (PE).
2. Select workbook Book2. Click in the upper left corner of the worksheet to select all data.

3. On the main menu, select Plot > 3D : 3D Vector XYZ dXdYdZ. This will create a 3D Vector graph with our built-in template.

4. Double-click on the vector plot to open the Plot Details dialog box. Ensure that the Original vector plot has been selected in the left panel of the dialog box. Select the 3D Vector tab.
   - In the 3D Vector tab of Plot Details dialog box, set the parameters as shown in the following graph. Click the Color button and select Dark Green from the menu.
Click OK to apply these settings and close the dialog box.

5. Go to **Lighting** tab in **Format: Layer** dialog, Set the lighting attribute follows graph below:
6. Rotate the graph to a proper perspective. The final graph should look something like this:
6.13.43D Scatter Plot with Line Projections of Core Drilling Locations

6.13.4.1 Summary

This tutorial will demonstrate how to create a 3D scatter plot and show the projections of the plots.
Minimum Origin Version Required: Origin 2015 SR0

6.13.4.2 Steps

This tutorial is associated with the Tutorial Data.opj file under <Origin EXE Folder>\{Samples\}.

1. Open the Tutorial Data.opj file and browse to the folder 3D Scatter with Line Projections, activate the workbook 3DScatterPlot.

2. Activate the The_First_Curve_of_3D_Scatter worksheet. The column designation for the three columns is already set as XYZ so you could directly create a 3D scatter plot. Highlight column C and select Plot > 3D: 3D Scatter to create the plot.

3. Activate The_SECOND_Curve_of_3D_Scatter worksheet. Highlight column C. Move the mouse cursor to the right edge of the selection area until the shape of the cursor changes to . Hold down the left mouse button and drag the highlighted data into the newly created graph window. The resulting graph should appear as shown below:
4. Double-click on the Z axis to open the **Axis** dialog, go to the **Scale** tab with Z icon on left panel selected and reverse the Z axis by exchanging **From** and **To** values.
5. Click **OK** to close dialog. Select **Format: Layer** from the main menu to open the **Plot Details** dialog. Alternatively you can double-click on the plot to bring up the dialog. If the left panel is not visible, use the button on the bottom left of the dialog box to open it up. Expand the **Layer1** node. Choose the first plot and select **All Together** from the **Edit Dependencies** page. This applies the same settings to the original data and all the projections.

6. Expand the first plot node and select **Original** and **XY/XY/YZ Projection** check box.

7. Set the dialog options to those shown in the screenshot below. To set the color, click on the **Color** button and choose the desired option from the **Individual Color** drop down. Since the **All Together** radio button was selected in the previous step, these settings automatically apply to the projections as well.

8. Select the **Symbol** tab and change the **Shape** to **Cube**:
9. In a similar fashion, select the second plot and set the dialog options to match those in the screenshots below:
10. The final graph should appear as shown below:

6.13.53D Bar and Symbol
6.13.5.1 Summary

This graph is a combination of a 3D bar plot showing the changes in HPI (Home Price Index) and a 3D scatter plot showing the Unemployment Rate. The data is of several Census Divisions during different years. Colormapping is introduced to both plots based on the Z values.

Minimum Origin Version Required: Origin 2015 SR0

6.13.5.2 What you will learn

This tutorial will show you how to:

- Plot a 3D bar graph.
- Add a scatter plot to a 3D bar graph.

6.13.5.3 Steps

1. Open the **Home Price Index Changes & Unemployment Rate.opj** file by selecting **File: Open** and navigate to `<origin exe folder> \Samples\Graphing`
2. Activate book **Home Price Index Changes & Unemployment Rate**, highlight columns A(X), B(Y), and C(Z), and then select **Plot > 3D : 3D Bars** to plot a 3D bar graph.

3. Right-click on the layer icon and choose **Plot Setup** from the context menu. In the **Plot Setup** dialog, set columns A, B, and G1 as X, Y, and Z respectively. Then click the **Add** button to add this plot to the current
layer. After that, click the **OK** button to close the **Plot Setup** dialog.

4. Double-click on the plot to open the **Plot Details** dialog. In this dialog, select the second plot in the left panel and set the **Plot Type** as **3D Scatter/Trajectory/Vector**.
In order to show all three panels in Plot Setup dialog, please expand Plot Type panel by clicking and expand Available Data panel by clicking again.

Please refer to Plotting using Plot Setup for more information.

5. Select Original in the left panel, then go to the Symbol tab in the right panel, select Col("Unemployment rate") for both Size and Color, and set the Scaling Factor of size as 2.
6. Go to the **Colormap** tab, set **Level** and **Fill** as shown below.
7. Go to the **Label** tab, check the Enable check box, set **Label From** as Col(F) and **Position** as above.

8. Go to the **Numeric Format** tab, select **Decimal Places** and set it to 0.
9. Select **Layer1** in the left panel. In the right panel, go to the **Planes** tab, uncheck **YZ** and **ZX**, select **At Position** for the **Position** dropdown list and enter 0 for the **Percent/Value** blank box.
10. Go to the **Axis** tab in the right panel, do settings as below:

![Plot Details - Layer Properties](image)

11. Select the first plot under Layer1 in the left panel, go to the **Pattern** tab, use Col("Changes in HPI") as the colormapping for both bar border and shape fill.

![Plot Details - Plot Properties](image)
12. Go to the **Outline** tab, set the **Width (in %)** to 30 as below.

![Outline tab setting](image)

13. Go to the **Numeric Format** tab, select **Decimal Places** and set it to 0.

![Numeric Format tab setting](image)

14. Go to the **Colormap** tab, click **Level...** header to open the **Set Levels** dialog. Do settings as below.

![Colormap tab setting](image)
15. Click OK button to close the **Set Levels** dialog. Click **Fill...** and select the **Pumpkin Patch** as the palette. Click OK to close the Fill dialog.

16. Click the **OK** button to close the **Plot Details** dialog.

17. With the graph window active, select **Insert: Color Scale** from the main menu to add a color scale for the first plot. Double-click on the color scale to open the **Color Scale Control** dialog. In this dialog, apply settings below.

18. Click OK button to close the **Color Scale Control** dialog. Then right-click the layer icon to activate the other plot from the context menu, then select **Insert: Color Scale** from the main menu to add another
color scale. Double-click on this color scale to open the **Color Scale Control** dialog. In this dialog, do the settings as the previous step does.

19. Add titles **Changes in HPI** and **Unemployment Rate** for these two color scales. Finally, you will get the graph given below.

![Graph showing changes in HPI and Unemployment Rate](image)

6.13.5.4 **Controlling the Categorical Values**

1. In the following steps, we want to customize the order of values shown in the graph but not change the source data. Right click on window title of source data book, select View: Categories, a new column label named **Categories** will be added to the head of the worksheet. Double click the "unsorted" to open the **Categories** dialog:

![Categories dialog](image)
2. Uncheck the `<auto>` checkbox, then you can specify the order of the items by using buttons based on the order of census division shown in graph below:

3. Double click the Categories cell of column B,"Unsorted", to open the **Categories** dialog. Select **Ascending** in the **Sort** list, click **OK** to close the dialog.
4. The 3D bar graph will be updated automatically with the new order of Categorical data.
6.13.6 Creating Intersecting Surface Plots from Worksheets

6.13.6.1 Summary

Many plot types, such as 3D Surface, 3D Bars, and Contour, can be created from data contained in a matrix object or from data arranged in a block of cells in a worksheet. The latter arrangement is referred to as a Virtual Matrix. Whereas a typical matrix object only supports a linear mapping of X and Y coordinates, a virtual matrix supports nonlinear mapping as well. In this tutorial, we show you how to create intersecting color map surface plots from virtual matrix data.

Minimum Origin Version Required: Origin 2015 SR0

6.13.6.2 What you will learn

This tutorial will show you how to:

- Create a Color Map Surface plot using virtual matrix data from a worksheet
- Add one surface graph to another to create intersecting surface plots
- Set transparency

6.13.6.3 Steps

6.13.6.3.1 Create Surface Plots from Virtual Matrix Data

This section will demonstrate how to create surface plots from data in a worksheet.

1. Start a new project.
2. Click the Import Multiple ASCII button on the Standard toolbar.
3. In the dialog that opens, navigate to the |Samples\Graphing folder and select both VSurface 1.dat and VSurface 2.dat by holding down the Ctrl key and clicking Add File(s)
4. Select the **Show Options Dialog** check box.

5. Press the **OK** button.
6. In the impASC dialog, modify the settings according to the following image, so that the two data files will be imported as two worksheets with name VSurface1 and VSurface2 in one workbook:
7. Click **OK** to import these two data files.

The data has X coordinate values in the top row and Y coordinate values in the first column. Note that the X coordinates have nonlinear spacing.

8. With the "VSurface 1" sheet active, hover the cursor over the cell in the top left corner of the worksheet till it appears as a slanting black arrow and click to highlight.

9. Select the menu item **Plot > 3D :3D Colormap Surface** to open the **plotvm** dialog.

**Note:** This dialog opens every time a 3D or Contour plot menu item is invoked with a group of worksheet cells selected. The dialog allows you to define where the X and the Y coordinate values are located.
10. In this dialog, adjust the settings as shown in the image below:

- **Data Layout**: Select "X across columns".
- **Virtual Matrix Name**: Enter "VM1".
11. Click **OK** to generate a Color Map Surface plot and a virtual matrix as shown below:
12. Repeat the last step to plot another Color Map Surface plot using data from the VSurface 2 worksheet. This time **VSurface 2** will be automatically used as Z title in the **plotvm** dialog.

6.13.6.3.2 Add Another Surface Plot to Layer

This section will demonstrate how to add a surface plot to a graph layer that already contains another surface plot.

1. Activate Graph1, right-click on the Layer 1 icon on the top left corner of the graph and select **Layer Contents** from the context menu.
2. In the **Layer Contents** dialog that opens, select **VSurface2** from the Available Data panel on the left and add it to the Layer Contents box on the right using the arrow that points to the right in the center of the dialog box (The arrow below it can be used to shift selected items from Layer Contents to Available Data).
3. Click **OK** to add the second surface, the graph will now appear as shown below:

![Graph1](image)

Note the two surfaces are displayed with proper intersection.

---

**6.13.6.3.3 Set Surface Transparency**

The next step is to set the transparency of the second surface so that parts of the first surface are visible in this intersection plot.

1. Double click on the second colormap surface to open the **Plot Details** dialog.
2. In the **Surface** tab, move the **Transparency** slider to 40% and click **Apply**, then **OK**.

The completed graph should appear as the image shown below:
6.13.7 Colormap from Second Matrix

Videos

- Introduction to Matrix
- Contour Plots and Color Mapping
- Plot 3D or Contour Graph from Virtual Matrix
- Convert Worksheet to Matrix to Plot 3D Surface
- Video Animation

OriginBlog

- Graphing an Island as a 3D Surface Plot
- Creating a 3D Surface Plot with Profile Lines
- How to create a 3D Surface Plot Animation

6.13.7.1 Summary

Origin can represent four-dimensional data by color-mapping a surface plot using a second matrix.

Minimum Origin Version Required: Origin 2015 SR0
6.13.7.2 **What you will learn**

- Create a Color Fill Surface from a matrix.
- Color map a surface plot using a second matrix.
- Customize color map levels and palette.
- Control lighting on the graph *(From Origin 9 SR0)*

6.13.7.3 **Steps**

This tutorial is associated with the **Tutorial Data** project: `<Origin EXE Folder>\Samples\Tutorial Data.opj`.

1. Open the **Tutorial Data** project and browse to folder **Surface with Colormap from Another Matrix** in **Project Explorer**.
2. Active the **MBook1D** matrix, You should see two image thumbnails above the matrix data, just under the title bar. (If you do not see image thumbnails, right-click on the matrix title bar and select **Show Image Thumbnails**.) Select image thumbnail 1."
3. On the main menu, select **Plot > 3D : 3D Color Fill Surface** to generate a surface plot.

![Graph1](image_url)

4. Double click on the plot to open the **Plot Details** dialog. In the left panel, select **(MBook1D)MSheet1**. In the right panel, select the **Fill** tab. Choose **Coutour Fill from Matrix**. and select **Mat(2)** for front surface.
5. Go to Colormap/Contours tab, click the Level... title to open the Set Levels dialog. In this dialog, click Find Min/Max button and set the #Major Levels and #Minor Levels as 10 and 9. Click OK button to close the dialog.

6. Click the Fill... title to open the Fill dialog. select Load Palette and then click Select Palette button to select Rainbow palette. Click OK button to close this dialog.
7. Check the **Enable Contours** check box. And then click **Line...** to open the **Contour Lines** dialog. In this dialog, check the **Show on Major Levels Only** check box and set the **Line Properties** as below. Click OK button to close the dialog.
8. Go to the Mesh tab, uncheck the Enable box to disable the mesh lines.

9. Select Layer1 in the left panel, go to Lighting tab in the right panel. Select Directional under Mode. Set Horizontal and Vertical as 124 and 40, and change the color of Diffuse as LT Gray and Specular as Gray. Then set the Shininess as 37.
10. Go to the **Planes** tab, set the color as **Gray** and select **Front Corner** for the Cube drop-down menu.

11. Go to **Axis** tab and do settings as below. Click **OK** button to close this dialog.
12. Keep the graph window active. Select **Insert: Color Scale** to add a new color scale in the graph window.

13. Double-click anywhere on the color scale to open the Color Scale Control dialog box. Select **Layout** in the left panel, change **Color bar thickness** to 150 and check the **Reverse Order** check box.
14. Select **Labels** in the left panel, set the **Font Size** to **14** in the right panel as below:
Click **OK** to close the **Color Scale Control** dialog box.

15. Double-click the X, Y and Z axis title and enter "X distance", "Y distance" and "Height". Add a text object "Pressure( psi )" above the color scale.

16. Your final graph should look like this:

6.13.8 Color Map Surface Graph

---

**Videos**

- Introduction to Matrix
- Contour Plots and Color Mapping
- Plot 3D or Contour Graph from Virtual Matrix
- Convert Worksheet to Matrix to Plot 3D Surface

**OriginBlog**

- Graphing an Island as a 3D Surface Plot
- Creating a 3D Surface Plot with Profile Lines
6.13.8.1 Summary

This tutorial will show you how to create a 3D color map surface.

6.13.8.2 What will you learn

This tutorial will show you how to

- Create a 3D color map surface graph
- Customize the 3D surface graph

6.13.8.3 Steps

1. Select Help:Learning Center menu to open Learning Center dialog. Select Graph Sample item in the left panel and then select Waterfall Plots for Samples in drop-down list. Double-click on the thumbnail below to open the sample 3D Surface Plots - Surface Graph profiling Differences in Body Heat Transfer.
Note: This tutorial is associated with this Graph Galley page.
2. Highlight **HFT data** matrix and select **Plot > 3D : 3D Colormap Surface with Projection** to create a 3D graph.

![3D graph image]

3. Choose **Format: Plot** to go to the plot level of the **Plot Details** dialog.

4. Select the surface plot, go to the Mesh tab, uncheck the **Enable** box to turn off the mesh lines. Go to **Colormap/Contours** tab, click Line title to open the **Contour Lines** dialog. In this dialog, uncheck **Show on Major Levels Only** and select **Hide All** to hide all contour lines.

![Contour Lines dialog image]
5. Select the projection plot in the left panel, go to Surface tab, Enter 0 as the following image shows to put the projection to the bottom of the graph.

![Surface tab](image)

6. Go to the Mesh tab, uncheck the Enable box to disable the mesh lines. Go to Colormap/Contours tab, hide all contour lines like the step4 does.

7. Click Layer 1 in the left panel, and then in the right panel select the Lighting tab. Change the setting as following to enable lighting effect:

![Lighting tab](image)

Then Click OK to close the dialog.
8. Finally, change axis titles and add a graph title as the following graph.

![Graph of Full-body Warming System](image)

### 6.13.9 Parametric Surface with Colormap from Data

#### Videos
- Introduction to Matrix
- 3D OpenGL Graphs
- New 3D Parametric Function Plot
- Plot 3D or Contour Graph from Virtual Matrix
- Convert Worksheet to Matrix to Plot 3D Surface

#### OriginBlog
- Graphing an Island as a 3D Surface Plot
- Creating a 3D Surface Plot with Profile Lines
- Contour Plot on Cylindrical Coordinate
- Overlay Locations on a 3D Map

#### 6.13.9.1 Summary

This tutorial demonstrates how to create a 3D sphere using the data from three matrices. It also shows how the surface is filled to display the surface temperature contour using the data from a different matrix.
What you will learn

This tutorial will show you how to:

- Create a parametric surface from matrix data
- Set contour fill from another matrix
- Customize the 3D parametric surface plot

Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: 3D Function Plots)

1. Open Tutorial Data.opj and browse to the Parametric Surface with Colormap from Data folder in Project Explorer (PE).

2. Activate the matrix FUNCA:1/4, and highlight the data. Click the button on the 3D and Contour Graph toolbar to create a colormap surface as shown below. You can also create this colormap surface by selecting Plot > 3D: 3D Colormap Surface in the main menu.
3. Double click on the plot to bring up the Plot Details dialog. In the Surface tab check the Parametric Surface box and set X Matrix, Y Matrix as Mat(2), Mat(3) respectively.
Click **OK** to close the dialog.

4. In order to display the complete colormap surface in the axes area use the rescale button in the **Graph** toolbar. The colormap surface should appear as shown below:

5. Double click on the plot to open **Plot Details** dialog. This dialog box is used to customize the surface. In the **Fill** tab Front Surface section deselect the box before **Self** and set **Contour fill from matrix** as **Mat(4)**. Click **Apply**.
6. Activate the **Colormap / Contours** tab. Click the **Level** heading to open the **Set Levels** dialog. Click **Find Min/Max** and set **Major Levels**, **Minor Levels** as 16, 8 respectively. Click **OK**.

7. Click **Fill** to open the **Fill** dialog. This dialog is used to customize the color scale. The **Load Palette** option allows the user to select from a list of possible palettes. Set **Load Palette** as **Temperature**. Click **OK**.
8. Click on the **Mesh** tab. Set **Line Width** as **0.05** by clicking on the font box and typing the value instead of using the drop down menu. Set **Line Color** in the Front section as **LT Gray**. Click **Apply**.
9. In the **Numeric Formats** tab choose the **Decimal Places radio** button and set its value as **0**.

   ![Numeric Formats Tab]

   Click **OK** to apply the settings and close the **Plot Details** dialog. The graph should appear as shown below:

10. The next step is to modify the axes. Double click on the Z axis to open the **Axis** Dialog. Go to the **Scale** tab, select **Z** icon. Set the value of **From** and **To** as **-400** and **400** respectively.
11. Go to the **Title** tab, hold **Ctrl** key and click to select **X**, **Y** and **Z** together. Deselect the **Show** check box to hide the axis title for all axes and click **OK** to close the dialog.

12. Double click on the XY Plane to open **Plot Details - Layer Properties**. In order to hide the axes, in the **Display** tab, deselect the **X Axes**, **Y Axes**, **Z Axes** boxes under the Show Elements section.
13. To hide the YZ and ZX planes, click on the **Planes** tab, and deselect the boxes before **YZ**, **ZX**. Set the **Color** of the remaining **XY** plane as **LT Gray**. Click **OK** to close the dialog.
14. The next step is to customize the color scale. Double click on it to open the **Color Scale Control** dialog, go to the **Labels** node and set the Font as **Verdana**.

15. Go to the **Line and Ticks** node and hide the border and ticks:

16. Click **OK** to apply the setting and close the dialog. Select and drag to move the color scale object to the desired location.
17. Right click on the white area of the graph layer to bring up a context menu and choose *Add/Modify Layer Title*. Click else where to deselect the text box, then right-click on it and select *Properties...* from the shortcut menu to open the *Object Properties* dialog. Set the font as *Verdana* and type **Surface Temperature (°C)** in the content table. Click *OK*.

![Object Properties Dialog](image)

18. Click on the graph layer within the 3D frame (not the data plot), and click the *Rotate* button as shown in the image below, to activate the rotation mode. Other ways to rotate the 3D plot include using the red rotate button in the *Tools* toolbar, the various buttons in the *3D Rotation* toolbar or by selecting in the plot, pressing the *R* key and using the cursor.
Rotate the plot to get a better view. The graph should resemble the image shown below:
6.13.10  Stacked 3D Surface Plots

This tutorial shows how to create stacked 3D colormap surfaces from different matrix objects. The surfaces in the plot display the topology before and after volcanic eruption:

Minimum Origin Version Required: Origin 2015 SR0
6.13.10.2 What you will learn

This tutorial will show you how to:

- Create stacked 3D colormap surfaces.
- Customize axes display and layer properties.
- Resize and rotate a 3D plot.

6.13.10.3 Steps

6.13.10.3.1 Create Multiple Colormap Surfaces

1. Select Help: Learning Center menu or press F11 key to open Learning Center. Select Graph Sample tab and then select 3D Surface Plots from the "Category" drop-down list. Double-click on the graph sample below to open the sample "3D Surface Plots - Stacked 3D Surface Plots".

![Learning Center](image)

Note: This tutorial is associated with the folder Stacked 3D Surface Plots of the "Tutorial Data" project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

2. Activate the matrixbook Mbook1 which contains two matrix objects, then click Plot > 3D: Multiple Colormap Surfaces to create two 3D surfaces from these two matrix objects as shown below:
3. Double-click on the plot to open the **Plot Details** dialog. If the left panel is not open the use the arrow button on the bottom left of the dialogue. There are two surfaces under the **Layer1** node on the left panel. To shift the "After eruption" surface in Z axis, activate the second plot under **Layer1** on the left panel, and in the right panel, select the **Surface** tab. Check the **Shift in Z by percent of scale range** box, and enter **70** in the text box.

4. In the **Fill** tab Front Surface section, deselect the **Self** box to fill contour by the same matrix object (Mat "Before") as the other surface used.
5. Select the **Colormap / Contours** tab. Click **Level..** to bring up the **Set Levels** dialog. Set the parameters as shown in the following graph and click **OK**.

Then uncheck the **Enable Contours** checkbox to hide the contour lines. Click **OK**.
6. In the Mesh tab deselect the Enable box to disable the mesh line.
7. Repeat steps 5 to 6 for the first plot under the Layer1 node.

8. In this project the two surfaces use the same matrix as contour fill, so they can share one color scale. To customize the color scale, double click on the color scale to open the Color Scale Control dialog. Check the Reverse Order box and set Color bar thickness as 100. Click OK.
6.13.10.3.2 Customize Axes Display

The next step is to change the axes scale and tick labels' format in the Axes dialog. To open this dialog, select **Format: Axes: X Axis**...

1. Change the settings on the **Scale** tab:
   - Set scale from **558000** to **566500** for the X Axis (click **X** icon), from **5108200** to **5121800** for the Y Axis (click **Y** icon), and from **0** to **10000** for the Z axis (click **Z** icon).
   - For the X axis, set **Type of Major Ticks** as **By Counts** and set **Count** as **5**. For the Y and Z axis, set **Type of Major Ticks** as **By Increment** and set **Value** as **2000**. To hide all the minor ticks, set **Count of Minor Ticks** as **0** for all axes.

2. Customize the **Tick labels**:
   - First, ensure that the **Use Only One Axis for For Each Direction** is enabled in the top of the **Axis** dialog.
   - Go to the **Tick Labels** tab, hold **Ctrl** key to select **X**, **Y** and **Z** icons together so they will be customized together. Select **Custom** for **Display** and select **P*3** from the drop down list of **Custom Format** to show the tick label as base-10 scientific notation with 3 significant digits. Click **OK**. For more information about the options in this drop down list, please refer to **Custom Display Format**.
6.13.10.3.3 Customize Layer Properties

1. Double click on the blank space outside the plots or click **Format: Layer...** from the menu to open the **Plot Details - Layer Properties** dialog.

2. Activate the **Miscellaneous** tab on the right panel. Check the box before **Enable** in the **Clipping** section, which will clip the image outside the axes area according to the settings in the **Clipping** section.

3. In the **Planes** tab set **Color** as **LT Gray** for all planes. Select **Front Corner** from the drop-down list in the **Cube** section to show the cube's border.
4. Select the **Lighting** tab. In the **Mode** section, choose **Directional** to enable lighting mode. Set **Light Color** as shown in the following graph. Click **OK**.

6.13.10.3.4 *Resize and rotate the plot*

1. Click on the cube (not the data plot) to activate the 3D toolbar. Click the Resize button, a 3D Cartesian coordinate will show up. Place the cursor on Y axis, which will then be highlighted, at this moment drag-and drop the Y axis to stretch the plot in Y axis direction. Do the same to X direction and Z direction.
2. Click the rotate button to activate rotation mode. A sphere will be displayed at the center of the plot. Rotate the plot to get a better view.

The 3D toolbar allows you to resize and rotate the plot freely. However, you can also achieve the same view as Graph1 in this sample project by setting the value in the **Axis** tab of the **Layer Properties** dialog as shown in the following graph.

<table>
<thead>
<tr>
<th>Axis</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>70.2</td>
</tr>
<tr>
<td>Azimuth</td>
<td>32.4</td>
</tr>
<tr>
<td>Y</td>
<td>125</td>
</tr>
<tr>
<td>Inclination</td>
<td>39.5</td>
</tr>
<tr>
<td>Z</td>
<td>98.5</td>
</tr>
<tr>
<td>Roll</td>
<td>359.6</td>
</tr>
</tbody>
</table>

**Link Axis Length to Scale (isometric)**: Off

**Orientation of Labels & Titles & Ticks**: All in Axes Plane

6.13.11 **Multiple Surfaces in Same Layer**

**Videos**
- Introduction to Matrix
- 3D OpenGL Graphs
- Resize and Rotate 3D Graph
- Plot 3D or Contour Graph from Virtual Matrix

**OriginBlog**
- Graphing an Island as a 3D Surface Plot
- Creating a 3D Surface Plot with Profile Lines
6.13.11.1 Summary

The four stacked surfaces shown below were created from the same matrix. The first layer from the top is a wire frame, the second layer is a flattened contour line plot, the third layer is a color filled surface with lighting effect, and the bottom layer is a flattened color filled contour plot.

Minimum Origin Version Required: Origin 2015 SR0

6.13.11.2 What You Will Learn

This tutorial will show you how to:

- Add multiple surface plots to a single graph layer
- Explore ways in which you can customize surface plots

6.13.11.3 Steps

6.13.11.3.1 Create a Graph with Multiple Surfaces

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: 3D Surface)
1. Open **Tutorial Data.opj** and browse to the **Multiple Surfaces in Same Layer** folder in **Project Explorer** (PE).

2. Select the **MBook8** worksheet and highlight all that data. From the Main Menu select **Plot > 3D : 3D Colormap Surface**. The graph window should appear as shown below:

![Graph Example](image)

3. With the new graph window active choose **Graph: Layer Contents**…. In the **Layer Contents - Layer 1** dialog box, select the **MBook8** matrix in the left panel and click the **Add plot button** (the right-pointing arrow in the center of the dialog) three times. Click **OK**. This will add the same MBook8 data to the graph layer four times. Note that at this point there only a single plot, the following steps will change that.
4. Double-click on the plot to open the **Plot Details - Plot Properties** dialog box. Select the first plot in the left-hand panel and in the **Surface** tab check the **Flat** box, check **Shift in Z by percent...** and enter 0 in the accompanying text box. Select the second plot, leave **Flat** unchecked, check **Shift in Z...** and enter 23. Select the third plot, check **Flat**, check **Shift in Z...** enter 65. Select the fourth plot, leave **Flat** unchecked, check **Shift in Z...** and enter 82. Click **OK**.

5. Double-click on the Z axis, and in the **Axes Dialog** box, go to the **Scale** tab, make sure Z axis icon is selected and set From to 0, and To to 900.

6. Go to the **Tick Labels** tab, hold Ctrl key to select X and Y icons together. In the **Display** tab, for **Divide by Factor**, enter 100000.
7. Go to the **Title** tab, select the **X** icon and enter **X Coordinate/ 10\+(5) meter** as the text for X title. Select the **Y** icon and enter **Y Coordinate/ 10\+(5) meter** as title text.
8. Go to the **Grids** tab, hold **Ctrl** key to select **X**, **Y** and **Z** icons together. Under **Major Grid Lines** clear the **Show** check box to hide the grid lines for all axes.

9. Click the **OK** button. The graph should now display four separate surfaces as shown below:
6.13.11.3.2 Customize the flattened color filled contour plot

1. Double-click on "Surface 1" to open the Plot Details dialog. Select the Colormap/Contours tab and click on the Fill... header to open the Fill dialog. In the Fill dialog, select Load Palette then click Select Palette and select the Reef palette. Click OK to close the Fill dialog.

2. In the Colormap/Contours tab, clear the Enable Contours check box.
3. Select the **Mesh** tab and clear the **Enable** check box.

4. Click **Apply** to update your graph.

**6.13.11.3 Customizing the color filled surface**

1. Select the second data set (do not clear the accompanying check box), click the **Fill** tab, select **Fill piece by piece** and choose **Dark Yellow** from the drop-down.
2. Select the **Colormap/Contours** tab and clear the **Enable Contours** check box.

3. Select the **Mesh** tab and clear the **Enable** check box.

4. Click **Apply** to update your graph.

**6.13.11.3.4 Customize a flattened contour line plot**

1. Select the third data set, click the **Fill** tab and clear the **Enable** check box.
2. Select the Colormap/Contours tab click on the Line... header to open the Contour Lines dialog. In this dialog, select the Link Line to Colormap Color checkbox. Click OK to close the Contour Lines dialog.

3. Select the Mesh tab and set the Line Width to 1. In the Major Minor Lines section, choose the settings shown below and in the Line Color section select the Use Colormap check box.
4. Click **Apply** to update your graph.

6.13.11.3.5 **Customize a wireframe surface**

1. Select the fourth data set, click the **Fill** tab and clear the **Enable** check box.

2. Select the **Colormap/Contours** tab and clear the **Enable Contours** check box.
3. Select the **Mesh** tab and set the **Line Width** to 1. In the **Major Minor Lines** section, choose the settings shown below and in the **Line Color** section set **Major Line Color** to **Black**.

![Mesh tab settings](image)

4. Select **Layer1** in the left panel. In the **Lighting** tab choose **Directional** for **Mode** and set the **Direction** group controls as shown below:

![Lighting tab settings](image)
5. Select the **Planes** tab. Specify the colors of the **YZ** and **ZX** planes as shown below (a custom color approximating "eggshell" for **YZ** and LT Gray for **ZX** works well).

6. Click **OK** to update your graph.

7. Rotate the 3D graph if you want to. Your graph should resemble the image shown below.
6.13.12 3D Scatter with Colormap

This tutorial will demonstrate how to create a 3D scatter plot with Z colormap from XYZ data in a worksheet, set scatter size proportional to the data in a specified column, and create projections of the data on all three axis planes.
6.13.12.2 What you will learn

This tutorial will show you how to:

- Generate a 3D scatter plot with Z colormap
- Set the symbol size proportional to data in a specified column
- Add and customize the scatter projections on axis planes

6.13.12.3 Steps

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opju. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: 3D Symbol Bar and Wall)

1. Open Tutorial Data.opju and browse to the 3D Scatter with Colormap folder in Project Explorer (PE).
2. Activate the workbook A3DScatter, and highlight col(C). Select Plot > 3D: 3D Scatter to generate a scatter plot.

3. A Reminder Message window like the one shown below will pop up, stating that the graph might not be correctly displayed if the OpenGL version is less than 2.1. The OpenGL version of your video card is listed on the Reminder Message window. Click OK to close the window.
4. Double click on the plot to open the **Plot Detail** dialog. If the left panel is not expanded use the button on the bottom left of the dialog to expand it. Expand the **Layer1** option and select the **Original** level, this contains the original data. This dialog box is where the 3D scatter is customized.

5. In the **Symbol** tab, set **Shape** as **Sphere**. In order to use the sphere sizes to show the differences of Engine Displacement, select **Size** as **Col(E): "Engine Displacement"**), and set **Scaling Factor** as **0.005**. Type manually into the edit box instead of using the drop down menu. For **Color**, click the drop-down menu, then choose the **By Points** tab of the Color Chooser. Click on **Color Mapping** and choose **Col(C): "Power"** to introduce a Z-value colormap. Set **Transparency** to **25%**.
6. Select the Colormap tab. Click the Level... title to open the Set Levels dialog. Set From as 30. Select Increment, and set it as 15. Set # Minor Levels as 9. Click OK.

7. Click the Fill... title to open the Fill dialog. Select Limited Mixing. Click the default color of From and then click the square box under Custom section in the color setting panel to open the Colors dialog. In the Colors dialog, set the Red, Green and Blue option in the bottom right as 74, 74, 255. Do the same thing for To color and set the Red, Green and Blue option as 255, 100, 255. Click OK.
8. Click on the fill color of <30 level to open the Fill dialog. Set Fill Color as None. Click OK. Repeat the this step to set fill color of >168 level as None. This will ensure that there is no color for levels above and below the specified range.

9. The next step is to add the data projections. In the left panel of the Plot Details dialog, select the option above Original, and select the Fully Independent radio button. This will ensure that when the
10. To customize the colors of the projections, in the **XY Projection** level **Symbol** tab, set its color as **Olive** (the 12th common color). Set the symbol color of **ZX Projection** and **YZ Projection** as **Red** (the second common color) and **Orange** (the 15th common color) respectively. Click **OK**.

11. In order to remove the grid lines, double click on the X axis to open the **Axes** dialog. Select the **Grids** tab on the right panel, hold the CTRL key and select Y and Z axes to customize the settings together, then deselect the **Show** box under **Major Grid Lines** to hide the major grid lines of all axes.
12. The next step is to change the scale for the axes. On the Scale tab for each axis set the following; for X Axis, change the From, To value and the increment Value of major ticks to 5, 30, 5 respectively, and then check the Reverse check box; for Y Axis, to 5, 40 and 10, and then check the Reverse check box; and for Z Axis, to 20, 180 and 20. Click OK.

13. To designate the color for the background of the entire window, open the Plot Details dialog again. In the left panel, select the Graph. Select the Display tab. Set Color as LT Gray. Click OK.

14. Delete the legend object created by default, we are going to add a color scale legend instead.
15. In order to add a color scale legend, click the **Add Color Scale** button in the **Add Object to Graph** toolbar. Double click on the color scale to bring up the **Color Scale Control** dialog. Set the color scale format according to the screenshots below:
16. Right click on the page layer to bring out the context menu. Select **Add/Modify Layer Title** and type **Symbol Size proportional to Engine Displacement** in the text box that appears as the layer title.

17. The graph should appear as shown below. Rotate to explore all sides:
6.13.13 3D Bar on Flatten Surface

This graph is a combination of a flattened 3D surface of US Map with state divisions and 3D bars representing the city populations, the bars locate the longitude and latitude of the cities.
6.13.13.1 What you will learn

This tutorial will show you how to:

- Plot a flattened 3D surface.
- Add a 3D bar graph to an existing 3D surface graph.

6.13.13.2 Steps

This tutorial is associated with the Tutorial Data project: \<Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data project and browse to folder 3D Bar on Flat Surface in Project Explorer.
2. Activate **MBook1E**, select **Plot> 3D : 3D Colormap Surface** from the main menu. A graph window will be generated.

3. Double-click on the graph to open the **Plot Details** dialog. In the Surface tab, check **Flat** and **Shift in Z**, set the **Z offset** to 0 and the **Transparency** to 50.
4. Go to the Colormap/Contours tab, click on the Level... header to open the Set Levels dialog. In this dialog, set the Major Levels to 8, Minor Levels to 0.

5. Click the OK button to close this dialog. Click on the Fill... header to open the Fill dialog. In the Fill dialog, select Load Palette, click Select Palette button to select Thermometer palette and uncheck the Link to Palette check box.
6. Click **OK** button to close the Fill dialog. Click the fill cell of last level and set its color as White.
7. Uncheck the **Enable Contours** in the **Colormap/Contours** tab.

8. Go to **Mesh** tab, uncheck the **Enable** check box.

9. Select **Layer1** in the left panel, go to the **Planes** tab in the right panel. Uncheck the **XY**, **YZ**, and **ZX** check boxes.
10. Click **OK** to close the **Plot Details** dialog. Right-click on the layer icon and choose **Plot Setup** from the menu. In the **Plot Setup** dialog, choose **Worksheets in Folder** for Available Data, **3D-Bars** as Plot Type and **USMetropolitan** as the data source sheet. Set Longitude, Latitude, and Population as X, Y, Z respectively. Click **Add** to add the 3D bar graph to the current layer.

![Plot Setup dialog](image)

In order to show all three panels in **Plot Setup** dialog, please expand **Plot Type** panel by clicking ▲ and expand **Available Data** panel by clicking ▲ again.

Please refer to [Plotting using Plot Setup](#) for more information.

11. Click **OK** to close the **Plot Setup** dialog. Select **Graph: Rescale to Show All** to rescale the graph.
12. Double-click on the 3D bar graph to open the **Plot Details** dialog. In the **Pattern** tab, set the color of **Border** and **Fill** as red, and set **Gradient Fill** as shown below.

13. Click **OK** to close the **Plot Details** dialog. On the graph window, right-click on the layer icon and select **Layer Contents...** from the context menu to open the **Layer Content** dialog. In this dialog, select **Worksheets in Folder** for the top-left drop-down list, add col(C) and Col(D) in Sheet **Label** as a 3D bar graph and a 3D scatter respectively to the current layer.
14. Click OK to close the Layer Content dialog. Double-click on the 3D bar graph to open the Plot Details dialog. Select the third plot in the left panel, and go to the Pattern tab, apply the settings given below.

15. Go to the Outline tab, set the Width(in%) to 15 as below.

16. Select the forth plot in the left panel, go to the Label tab and apply the settings below.
17. Finally, you will get the graph shown below.

6.13.14 3D Surface with Point Label

6.13.14.1 Summary

This tutorial will demonstrate how to add a 3D Scatter to a 3D Surface and include labels as shown below:
Minimum Origin Version Required: Origin 2015 SR0

6.13.14.2 What you will learn

This tutorial will teach you how to:

- Create the 3D Surface with side walls
- Add a 3D scatter to the 3D Surface and include labels
- Change the label position in 3D graphs
- Add a line to connect the symbol and the label

6.13.14.3 Steps

6.13.14.3.1 Create the 3D Surface with side walls:

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: 3D Surface)

1. Open Tutorial Data.opj and browse to the 3D Surface with Point Label folder in Project Explorer (PE).
2. Activate MBook4, and highlight everything. Select Plot > 3D : 3D Colormap Surface from the main menu. A 3D Colormap graph will be generated as shown below:
3. Select **Format: Axes: Z Axis...** in the menu to open the **Axes** dialog. (Or double-click one of the axes on the graph). Set Z axis scale **From: -500** and **To: 8000**. Click **OK**.
4. Select **Format: Plot** in the menu to open the **Plot Details** dialog. (Or double click anywhere on the graph). If the left panel is not expanded use the button on the bottom left of the dialog to expand it and select the first option under **Layer1**. In order to create and customize side walls, in the **Side Walls** tab, check the **Enable** box. Change the color of X and Y side walls to **Gray** and **LT Gray**.
5. To adjust the color scale, in the **Colormap/Contour** tab, click on the **Fill** column header to open the dialog. Select the **Limited Mixing** option, and set **From**: Blue and **To**: Green as shown below. Click the **OK** button to close the **Fill** dialog.
6. In the **Mesh** tab, select color of **Major Minor Lines** as **Black** and select apply **Apply**.

7. The next step is to add and customize the lighting effect. In the same **Plot Details** dialog, expand the left panel and select **Layer 1**. In the **Lighting** tab, choose the **Directional** Mode, enter **279** and **-3** in the **Horizontal** and **Vertical** boxes respectively. Set the **Ambient** color to **LT Yellow**.
8. To adjust the planes, in the **Planes** tab deselect the **YZ** and **ZX** boxes to hide the two planes in the graph. Click the **OK** button.
6.13.14.3.2 Add the 3D scatter in the 3D Surface with labels:

1. In order to add symbols in the desired position on the 3D graph, select **Graph: Layer Contents** from the main menu to open the **Layer Contents** dialog (Or double click on the layer icon on the top left of the graph). In the dialog that appears, select **Worksheet in Folder** from the drop-down on the top left.
2. Click on the Plot Type button shown below to specify 3D Scatter/ Trajectory/ Vector as the plot type:

![Plot Type Button]

3. To shift components from the left panel to the right panel, holding down the Ctrl key, select two Height columns in the left panel and click on the Add plot button. This will add the two columns to Layer1. Click the OK button.

![Add plot Button]

Use the Rotate Tool button on the Tools toolbar or hold down the R key and use the mouse to rotate the graph. You can find two red symbols are added to the 3D surface and the graph will appear as shown below:

![Graph with Rotate Tool]
4. To add labels and leader lines to the two symbols, double click on either one to open the **Plot Details** dialog. Make sure the left panel of the **Plot Details** dialog box is expanded and displaying **Original** under the **Position1** plot-level. In the **Label** tab check the **Enable** box. In the **Label From** drop-down list, select `col("Label")` as the label source. Specify the **Offset**, **Position** and **Leader Line** for the label as shown in the image below:
5. In the left panel, click on Original under the Position2 plot-level. In the Label tab repeat the above step making the selections given below.
Click on the **OK** Button. Labels and Lead Lines should now appear on the graph.

---

### 6.13.15  3D Scatter Plots with Confidence Ellipsoids

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>- <a href="#">Origin 3D OpenGL Graphs</a></td>
<td></td>
</tr>
<tr>
<td>- <a href="#">Set Symbol Color and Shape by Other Column</a></td>
<td></td>
</tr>
<tr>
<td>- <a href="#">Customize the Legend</a></td>
<td></td>
</tr>
</tbody>
</table>

#### 6.13.15.1 Summary

This tutorial will show you how to create a 3D Scatter plot, with symbol color indexed to values in a worksheet column. Then using OriginLab’s free **3D Confidence Ellipsoid** app, you will draw a confidence ellipse around each point cluster.
Minimum Origin Version Required: Origin 2016 SR0

6.13.15.2 What you will learn

- How to create the 3D Scatter plot with symbol color indexing.
- How to add a free OriginLab App to your Apps Gallery and use the App to add confidence ellipsoids to your 3D Scatter plot.

6.13.15.3 Steps

6.13.15.3.1 Create the 3D Scatter plot with color index

1. Select Help: Learning Center menu or press the F11 key to open Learning Center. Select the Graph Sample tab and then select 3D Scatter Ribbon and Wall Graphs from the "Category" drop-down list. Double-click on the graph sample below to open the sample "3D Scatter Ribbon and Wall Graphs - 3D Confidence Ellipsoid for 3D Scatter".
2. Highlight columns A(X), B(Y) and C(Z) and click **Plot > 3D: 3D Scatter** to plot a 3D Scatter graph.
3. Double-click on the graph to open the **Plot Details** dialog, select **Original** under the plot level in the left panel, then in the right panel select **Symbol** tab, change **Color** to **By Points** and set **Color Options** to **Indexing : Col(E) : "Species"**. Choose a color list (the default list is fine).
4. Right-click on the graph legend and select **Legend: Reconstruct Legend** in the context menu. The 3D Scatter graph will be generated as shown below:
5. To ensure that the legend is not overwritten during the next steps, select **Format: Page** in the menu to open the **Plot Details** dialog. Go to **Legends/ Titles** tab and set **Legend Update Mode** to **None**.

![Plot Details dialog](image)

6.13.15.3.2 Add transparent confidence ellipsoids to the 3D scatter graph

1. Press F10 to open the App Center, click the **Search** tab to the left, set **Category** to **All** and search for "ellipsoid". Download and Install the **3D Confidence Ellipsoid** App (for more information, see this OriginLab File Exchange page: [3D Confidence Ellipsoid](http://example.com)).

2. Once installed, you will see the **3D Confidential Ellipsoid** icon will be listed in the Apps Gallery:

![3D Confidential Ellipsoid icon](image)

3. Activate the graph and click this **3D Confidential Ellipsoid** button in the Apps Gallery. This will open the **Plot 3D Confidence Ellipsoid** dialog. Accept the default settings and click **OK**. Semi-transparent ellipsoids are added to each plot cluster, according to the color of each cluster.
The final graph should appear as shown below:

6.13.16 Convert Data from Spherical Coordinate to XYZ and Make a 3D Plot

- Plot 3D or Contour Graph from Virtual Matrix
- Plot Stacked Contour Plots in a Cylinder Coordinates
6.13.16.1 Summary

In this tutorial, we will look at what is involved in creating the 3D graph with spherical coordinate data, as well as using X-Function sph2cart to convert data in a workbook or matrix from spherical coordinate to Cartesian coordinates.

It is important to go over the Converting Algorithm for sph2cart, and notice that Origin use $\phi$ as the elevation and $\theta$ as the azimuth in the transform formula.

\[
x = r \cdot \cos(\phi) \cdot \cos(\theta);
\]
\[
y = r \cdot \cos(\phi) \cdot \sin(\theta);
\]
\[
z = r \cdot \sin(\phi);
\]

6.13.16.2 What will you learn

- Convert data in a worksheet (virtual matrix) from spherical coordinate to Cartesian coordinates and make a 3D surface plot.
- Convert data in a matrix object from spherical coordinate to Cartesian coordinates and make a 3D surface plot.
- Convert data in three matrix objects from spherical coordinate to Cartesian coordinate and make a discrete 3D surface plot.
- Convert data in a worksheet(XYZ) from spherical coordinate to Cartesian coordinate(XYZ) and make a 3D space curve.

6.13.16.3 Steps

6.13.16.3.1 3D Surface plot with colormap for data in virtual matrix

Origin can create surface plot with data in virtual matrix (spherical coordinate) and add colormap for it. The following steps introduce the plot of a ellipsoid with colormap surface.

This tutorial is associated with <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data.opj and browse to the folder: Spherical Coordinates.

2. Open the virtual matrix data ellipsoid in tutorial data, the structure of the virtual matrix is shown in graph below:
In this example, the azimuth $\theta$ is from 0 to 360, and the elevation $\phi$ is from -90 to 90. The unit used for angle is degree.

3. Open the Script Window, type in code below and run:

```
sph2cart -d;
```

Setting the `sph2cart` dialog follows graph below, then click **OK**. Three new matrix objects will be created which are corresponded to XYZ.
4. Then add an extra matrix object “4” after the matrix Z in Matrix Layer to act as the colormap.
5. Copy the data in colormap matrix in Spherical Coordinates folder, paste the data to the new added matrix object.

6. Now, you will plot the Matrix into a 3D surface, click on the thumbnail of matrix object "Z" to activate it, click Plot > 3D : 3D Colormap Surface to plot a 3D surface.

Double click the surface to open the Plot Details dialog. Set the Parametric Surface in dialog follows graph below, and click OK to apply the settings.
7. Click CTRL+R to rescale the axis, double click the axis to open the Axis dialog, change to scale for XYZ axis from -1.2 to 1.2, click OK to close the dialog.
You graph may looks like this:
8. Next we will apply the colormap to the ellipsoid, double-click the surface to open the **Plot Details** dialog, go to the **Fill** tab, change the **Contour fill from matrix** into Mat(4).
Go to the **Colormap/Contours** tab, you can click the table head to open the **Set Levels**, **Fill** and **Contour Lines** dialog. Set the **Level** by **Find Min/Max**, click **OK** to apply, and set **Fill** by load palette "Maple", click **OK**, then select "Hide All" to hide all lines, click **Apply** to apply the settings.

Go to the **Mesh** tab, deselect the **Enable** checkbox to close the mesh line, click **OK** to close the dialog.

10. the finished graph is similar to this:
The azimuth and elevation can be unevenly spaced in \((r, \theta, \varphi)\) space.

### 6.13.16.3.2 Convert data in a matrix object and make a 3D surface plot

1. Origin can construct a \(R(\theta, \varphi)\) surface function under spherical coordinates. The azimuth, elevation and radius are placed in the same matrix. Before set matrix values form a spherical coordinates equation, you can refer to \texttt{sph2cart} for the transforming relations and definition of azimuth and elevation in our system.

2. Create a new a matrix, and select \textbf{Matrix: Set Dimension and Labels} in main menu. Set the Dimension \(100 \times 100\), and map Column to X by \((0, 2\pi)\), map Column to Y by \((-\frac{\pi}{2}, \frac{\pi}{2})\). X and Y are the Angle Data, where X is the azimuth which is across columns and Y is the elevation.

In this example, the azimuth \(\theta\) is from 0 to \(2\pi\), and the elevation \(\phi\) is from \(-\frac{\pi}{2}\) to \(\frac{\pi}{2}\). The unit used for angle is radian.
3. Select **Matrix: Set Values** in main menu. The formula entered in the Set Values dialog should be:

\[
\text{abs}(\sqrt{0.5} \times 0.25 \times (15/\pi)^{0.5} \times \sin(\pi/2 - y) \times \sin(\pi/2 - y) \times (\sin(2x) - \cos(2x)))
\]

We set the matrix values by using spherical harmonics, \( Y_{lm} \) is a specific set of spherical harmonics, and the linear combinations of \( Y_{lm} \) corresponded to the d-orbitals of the hydrogen atom (i.e. \( d_{xy} \)).

\[
|d_{xy}| = \left| \sqrt{1/2} (Y_{2}^{-2} - Y_{2}^{2}) \right| \quad (1)
\]

\( Y_{2}^{2} \) and \( Y_{2}^{-2} \) in function (1) are:

\[
Y_{2}^{2} = \frac{1}{4} \sqrt{\frac{15}{\pi}} \sin^2\left(\frac{\pi}{2} - \varphi\right) \cos(2\theta)
\]

\[
Y_{2}^{-2} = \frac{1}{4} \sqrt{\frac{15}{\pi}} \sin^2\left(\frac{\pi}{2} - \varphi\right) \sin(2\theta)
\]
4. Next you can convert the matrix from spherical coordinates to Cartesian by using X-Function `sph2cart`. Select `Window: Script Window` in main menu, then enter the script below and click `Enter` to execute:

```
sph2cart -d
```

Set the sp2cart dialog follows graph below, the single matrix object is used as input data:
After clicking OK, the results will be created in a new Matrix Sheet (MSheet2).

5. Now, you will plot the Matrix into a 3D surface. With Matrix object $Z$ in MSheet2 active,

select **Plot > 3D : 3D Colormap Surface** in main menu.

6. Double click the surface to open the **Plot Details** dialog, set the parametric surface follows graph below, and click **OK**.
7. Click CTRL+R to rescale the axis, double click the axis to open the **Axis** dialog, change to scale for XYZ axis from -0.5 to 0.5, set the vvalue for **Major Ticks** to 0.2, click **OK** to close the dialog.
8. The graph created is similar to this:
9. Double click the surface to open the **Plot Properties**. Go to the **Colormap/Contours** tab, click the Level/Fill/Line button and set the dialogs separately.
Then go to the Mesh tab, deselect the Auto checkbox for Transparency and change the value to about 70%.

![Graphing interface with transparency settings highlighted]
You can refer to **Parametric Surface** tutorial for details about colormap setting. The finished Graph are shown below:

![Graph Image]

### 6.13.16.3.3 Convert data in three matrix objects and make a 3D surface plot

Origin can construct a $R(\theta, \varphi)$ surface function under spherical coordinates. The azimuth, elevation and radius are placed in the different matrix. The following steps shows how to construct multiple surfaces by using three matrix and use `sph2cart` to convert them into XYZ space.

1. Create a new matrix. Set the Matrix Dimension $98 \times 33$ in **Matrix Dimension and Labels** dialog, then click **OK**.

2. Click the D button on the right corner of the matrix and click **Add** to add another two matrix objects in MatrixBook.
3. The azimuth will be put into the first matrix object. With the first matrix object active (Click the D button and switch between 1/2/3), click **Matrix: Set Values** in main menu. The matrix values for azimuth will be set in this way:

<table>
<thead>
<tr>
<th>Column(j)</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 32</td>
<td>(0, 2π)</td>
</tr>
<tr>
<td>34 to 65</td>
<td>(0, 2π)</td>
</tr>
<tr>
<td>66 to 98</td>
<td>(0, 2π)</td>
</tr>
</tbody>
</table>

4. Set the Matrix value use the expression below:

\[(j==33||j==66)?1/0:(\pi/32*j*(j<33)+\pi/32*(j-33)*(j>33&&j<66)+\pi/32*(j-66)*(j>66))\]

The value from 0 to \(2\pi\) loop 3 times, and the Column (33), Column (66) should be missing values.
5. The elevation will be put into the second matrix object (select matrix 2 in graph in step 2). Set the values for elevation by using expression:

\[ \frac{\pi}{32}(i-17) \]

6. The radius (expression below) will be put into the third matrix object.

\[
Col(i, j) = \begin{cases} 
1 & \text{if } i \in [1, 32] \\
0.7 & \text{if } i \in [33, 65] \\
0.4 & \text{if } i \in [66, 98]
\end{cases}
\]

The way for setting the values for radius is also piecewise, you can refer to the step 3, 4, 5 and use the set value code below:

\[ 1*(j<33)+0.7*(j>33 && j<66)+0.4*(j>66) \]

7. After setting values for three matrix, you can convert the data to XYZ space by using `sph2cart`. Open the Script Window, type in code below and run:

```
sph2cart -d;
```

Setting the `sph2cart` dialog follows graph below, then click OK. Three new matrix for XYZ will be created.
8. Create 3D surface graph by using XYZ matrix object created in new matrix layer. The steps are very similar to steps 5, 6, 7, 8 in above section Convert data in a matrix object and make a 3D surface plot.

The finished Graph is showed below:
6.13.16.3.4 Convert data in three columns and make a 3D space curve

Origin can create 3D space curve with unevenly spaced data in XYZ column (spherical coordinates). The following steps introduce the plot of a non-isometric spiral with a sphere shape.

1. Create a new workbook with three columns X, Y and Z. Set values from $\frac{\pi}{100}$ to $20\pi$ for X column by Fill Column With: A set of Numbers
Set value for Y column by **Set Column Values**

\[
\text{Col(B)} = \frac{\pi}{2} \sin\left(\frac{\text{wcol(1)}}{40}\right)
\]

Set value for Z column by **Set Column Values** and set as constant value “4”

In this example, the X, Y, Z are corresponded to Azimuth, Elevation, Radius, respectively.

2. Open the Script Window, type in code below and run:

   `sph2cart -d;`

   Setting the sph2cart dialog follows graph below, then click **OK**. Three new columns for XYZ will be created.
3. Plot the new XYZ with **Plot > 3D : 3D Scatter**. Set Symbol size to 0 and connect Symbols with line, click **OK**.
4. Further adjust the scales and the perspective view, the finished graph is similar to graph below:
With new created XYZ data, you can plot a 3D surface plot as well by selecting **Plot > 3D** : **3D Colormap Surface** with XYZ columns highlighted.

The azimuth and elevation in X and Y can be evenly or unevenly spaced in \((r, \theta, \varphi)\) space.

### 6.13.17  Stack Flattened Surfaces with Certain Z Offset

6.13.17.1  **Summary**
This tutorial will show you how to plot multiple image objects as a stacked flattened surface with Z offset.

6.13.17.2 What will you learn

- How to import multiple images into Origin as the matrix objects.
- How to plot image objects as a 3D Stacked Surfaces in a graph layer.
- How to position the flattened images on Z axis.

6.13.17.3 Steps

1. Create a new a matrix and select Data: Import from File: Image to Matrix to import myocyte1~myocyte8 under the \Sample\Image Processing and Analysis folder. In the ImpImage dialog, keep Mult-File (except 1st) Import Mode as Start New Objects.
2. Click the OK button to import the files to matrix as matrix objects.
3. Right-click on the first object to select **Properties** context menu to open Matrix Properties dialog. Enter 5, 14, 29, 42, 57, 71, 85 and 97 seperately in **Comment** box for each object by clicking **Next>>** button to browse the objects. Click **Apply** button and **OK** button to close the dialog.
4. Select **Plot > 3D : 3D Stacked Surfaces** from the main menu to plot a stacked flattened surface graph.
5. Double-click on the plot to open **Plot Details** dialog, go to **Colormap/Contours** tab, click **Fill** header to open the **Fill** dialog and select **GrayScale** palette.
6. Click **OK** button to close the dialog. Disable Speed Mode by clicking the button. You will get the following graph.
6.13.18 3D Ternary Colormap Surface with Contour Lines Projection

In this tutorial, a 3D ternary surface with Z colormap and its projection with contour lines are generated from XYZZ worksheet data.
Minimum Origin Version Required: Origin 2015 SR0

6.13.18.2 What you will learn

This tutorial will show you how to:

- Generate a 3D ternary surface plot with Z colormap.
- Project color-mapped contour lines onto the XYZ axis plane.

6.13.18.3 Steps

6.13.18.3.1 Creating 3D ternary surface

This tutorial is associated with the Tutorial Data project: <Origin EXE Folder>\Samples\Tutorial Data.opj.

1. Open the Tutorial Data project and browse to folder 3D Ternary Surface.
2. Activate the worksheet Ternary Surface in Book1F, and highlight col(C) and col(D). Select Plot > 3D :3D Ternary Colormap Surface to generate a colormap surface.
3. We will modify the plot to show the edges of the 3D prism. Double-click on the plot to open the Plot Details dialog box. Highlight Layer1 in the left panel (take care not to clear the check mark beside the Layer1 icon). Go to the Plane tab, set Prism to Whole Prism and enable Plane Border.
4. Expand the **Layer1** node, highlight the dataplot icon and click the **Fill** tab. Check **Enable** box and select **Colormap**. Check the box beside **Fill back surface** and set color as **LT Gray**.

5. Click the **Colormap / Contours** tab. Click the **Level** heading and in the **Set Level** dialog box, set controls as follows, then click **OK** to close the dialog box.
6. To add contour lines on the ternary surface, check the box next to **Enable Contours**.

7. To customize the contour lines, click the **Line** heading to open the **Contour Lines** dialog. Under **Line Properties**, check the box before **Color** and **Style** and set the Color as **Dark Gray** and Style as **Short Dash**, then click **OK**.
Graphing

8. Go to the Mesh tab, clear the Enable box, then click the OK button.

9. To customize the scale and the major ticks of the X/Y/Z axes, click on a graph axis to open the Axis Dialog box. Expand the X, Y and Z nodes, then press CTRL while selecting Scale for the X, Y and Z axes. Set Major Ticks > Value to 0.2.
10. Expand the Zh axis node and select **Scale**. Duplicate the scale range and the **Major Ticks > Value** settings as shown below.

11. Click **OK** to close the **Axis Dialog** box.
6.13.18.3.2 Creating projection with contour lines

1. With the graph page active, select **Graph: Layer Contents** from the main menu to open the Layer Contents dialog. Select **Worksheets in Folder** from the drop-down.

2. To add another ternary surface to the graph, press CTRL and in the left panel, select the datasets **XC** and **CRC299** of sheet "Ternary Surface", then click the **Add plot** button to add them to the right panel. Click **OK**.

3. Double-click on the plot to bring up the **Plot Details** dialog box. Under **Layer1**, click on the second plot, then click on the **Surface** tab. Under **Display**, choose **Flat** and **Shift in Z by percent of scale range, 0 = bottom, 100 = top**.

4. On the **Colormap / Contours** tab, select **Enable Contours**. Click the **Line** heading and edit the **Contours Lines** dialog box settings as in the following image and then click **OK**.
5. On the **Colormap / Contours** tab, click the **Level** heading and in the **Set Level** dialog box, set **# Major Levels** to 20 and **# of Minor Levels** to 5. Click **OK** to close the dialog box.

6. Go to **Fill** tab and clear the **Enable** box.

7. On the **Mesh** tab, clear the **Enable** box. Click **OK** to close the dialog box.

8. To change the grid lines on the axis planes dashed lines, double click the axis to bring up the **Axis Dialog** box. In the left panel, expand the **X** node and select **Grids**. Press **Select Others** to choose grids for all the axis planes. Customize the **Major Grid Lines** section as follows:
9. Rotate the plot by dragging a hotspot (hint: click once inside the graph frame - but not on the plot -- to activate the move/resize/rotate functions). Alternately, you can use the tools on the 3D Rotation toolbar.
6.14 Plot Functions with Parameters Defined in a Worksheet

Videos

- New 3D Parametric Function Plot
- Set Column Values
- Worksheet Set Column Values to Reference Other Info
- Use Spreadsheet Notation to Set Column Values

OriginBlog

- Using LabTalk to generate and plot Fibonacci sequences
- Animating 2D Plots Using Labtalk and a Series of Coefficients
- Contour Plot on Cylindrical Coordinate

6.14.1 Summary

Origin can plot functions. It also can plot functions with parameters defined in a worksheet. The function graph can be updated automatically as the parameters in the worksheet change.
6.14.2 What you will learn

This tutorial will show you how to:

- Define variables from a worksheet in the Set Values dialog box.
- Plot a function graph with parameters.
- Update a graph automatically when parameters are changed.

6.14.3 Steps

Let us use this function as an example: \( y = p_0 + p_1 x + p_2 x^2 \)

1. Set up a worksheet with three parameters \( p_0, p_1, p_2 \) stored in Column A, Column B, Column C as shown below.
2. Click on the **Add New Columns** button on the **Standard** toolbar to add a new column to the worksheet.

![Add New Columns button on Standard toolbar]

3. Highlight Column D and then select **Column: Set Column Values**. Select **Auto** from the **Recalculate** drop-down. Type the script shown below to define the parameters in the **Before Formula Scripts** edit box. Click the **OK** button to close the dialog box.

![Set Column Values dialog box]

Note that there is a green lock icon on the top right corner of Column D which indicates that the Recalculate Mode is **Auto**.
4. Select **Plot>Function Plot: New 2D Plot** menu to open the **Create 2D Function Plot** dialog.

5. In this dialog, set the options as follows and click the **OK** button to close the dialog box.

Then you get this function plot.
6. The function graph can be updated automatically when the parameters in the first row of the worksheet change. Change the value in the first row of Column 2 from 2 to 5. Click outside this cell to finish editing.

The function graph updates to reflect this change.
The script used in the Before Formula Scripts edit box of the Set Values dialog box is:

```plaintext
p0 = col(1)[1]; //Specify Column A for p0.
p1 = col(2)[1]; //Specify Column B for p1.
p2 = col(3)[1]; //Specify Column C for p2.
```

The function in the F1(x) edit box of the Plot Details dialog box is as follows:

```plaintext
p0 + p1*x + p2*x^2
```
6.15.1 Summary

Windrose graphs are used to present wind speed data and wind direction data collected over time at a particular location. This tutorial will demonstrate how to create windrose graphs from both raw and indexed data:

![Windrose graphs](image)

6.15.2 What will you learn

This tutorial will show you how to:

- Create a windrose graph from binned data
- Customize the direction tick labels on the windrose graph
- Create a windrose graph from raw data

6.15.3 Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opj`. Also, you can refer to this graph in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Specialized Graphs)

6.15.3.1 Part 1: Create a Windrose Graph from Binned Data

1. Open Tutorial Data.opj and browse to the Wind Rose folder in Project Explorer (PE).
   (If you don't have the project file, please import the sample data from here).
2. Activate the Book6E workbook. Highlight all worksheet columns and click the Wind Rose - Binned Data button on the 2D Graphs toolbar as shown below or select Plot: Specialized: Wind Rose-Binned Data.
Graphing

3. Double-click on the radial axis on the polar to open the **Axis** dialog. With **Radial - Inner 1** selected, go to **Show** tab, uncheck **Show** check box to turn off the inner radial axis.

Select **Radial - Outer 2** in the left panel, check **Show** check box to turn on the outer axis.
4. Click on any bar in the graph, and in the popup mini toolbar, click the Fill Color button under the Group tab to expand the Color Chooser. In the Color Chooser, under the By Plots sub-tab, select...
or click the color list or color palette in the you desired to apply the bar colors.

5. Click on the Text Tool button \( \text{T} \) to add a Text object as graph title. And enter Sample of Wind Rose (Binned Data) in that Text object.
6.15.3.2 Part 2: Create a Windrose from Raw Data

1. Go to the project folder Statistical and Specialized Graphs: Specialized: Wind Rose and activate the Book7E workbook, Raw Data worksheet. (If you don't have the project file, please import the sample data from here).

2. Highlight columns A & B. Click the Wind Rose - Raw Data button on the 2D Graphs toolbar as shown below or select Plot: Specialized: WindRose - Raw Data from the main menu.
In the dialog opened, do the settings below and click OK button to create the wind rose graph:

3. Do the same operations as the step 3 in the Part 1 to move the radial axis to the left-bottom. And, go to **Tick Labels** tab for **Radial Outer 2** to remove the Suffix "%" for the radial axis tick labels.
4. Do the same operations as the step 4 in the Part 1 to change the fill color for the stacked bars. The final graph should resemble the image shown below:

![Graph Image]

6.15.4 Sample Data

6.15.4.1 Binned Data

To import Binned Data to a worksheet, copy the Binned Data 1 (including the heading) and select File: Import Wizard. Select the Clipboard checkbox in the DataSource group and click the Finish button to import the data into Origin.

![Import Wizard - Source]

<table>
<thead>
<tr>
<th>Direction</th>
<th>0-4</th>
<th>4-8</th>
<th>8-12</th>
<th>12-16</th>
<th>16-20</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.5</td>
<td>3.125</td>
<td>3.125</td>
<td>3.125</td>
<td>6.25</td>
<td>0</td>
</tr>
</tbody>
</table>

### 6.15.4.2 Raw Data

To import **Raw Data** to worksheet, you can copy the **Raw Data** (including the heading) and then select **File: Import Wizard**. Select the **Clipboard** checkbox in **DataSource** group and then click **Finish** button to import the data into Origin.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>45</td>
<td>0</td>
<td>3.125</td>
<td>3.125</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>67.5</td>
<td>0</td>
<td>6.25</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>90</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3.125</td>
</tr>
<tr>
<td>112.5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>135</td>
<td>3.125</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3.125</td>
</tr>
<tr>
<td>157.5</td>
<td>0</td>
<td>0</td>
<td>9.375</td>
<td>3.125</td>
<td>0</td>
</tr>
<tr>
<td>180</td>
<td>3.125</td>
<td>3.125</td>
<td>0</td>
<td>3.125</td>
<td>3.125</td>
</tr>
<tr>
<td>202.5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>225</td>
<td>0</td>
<td>0</td>
<td>3.125</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>247.5</td>
<td>0</td>
<td>3.125</td>
<td>0</td>
<td>3.125</td>
<td>3.125</td>
</tr>
<tr>
<td>270</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3.125</td>
</tr>
<tr>
<td>292.5</td>
<td>0</td>
<td>6.25</td>
<td>3.125</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>315</td>
<td>0</td>
<td>0</td>
<td>3.125</td>
<td>3.125</td>
<td>0</td>
</tr>
<tr>
<td>337.5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>360</td>
<td>0</td>
<td>6.25</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>382.5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Direction</td>
<td>Speed</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>311.5</td>
<td>12.75</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>142.7</td>
<td>11.18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>161.6</td>
<td>5.9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>277.3</td>
<td>8.24</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>155.3</td>
<td>13.46</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40.8</td>
<td>8.57</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43.4</td>
<td>4.38</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3</td>
<td>10.91</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>78.8</td>
<td>18.72</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>237.8</td>
<td>16.22</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>114.6</td>
<td>0.88</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>12.05</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>290.5</td>
<td>4.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-----</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>174.1</td>
<td>3.29</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>267.6</td>
<td>16.64</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>5.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>213.9</td>
<td>8.04</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>134.8</td>
<td>17.26</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>137.6</td>
<td>11.87</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46.1</td>
<td>5.48</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.5</td>
<td>13.47</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>311.2</td>
<td>10.17</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>154.4</td>
<td>11.17</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>176.2</td>
<td>18.91</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>348.1</td>
<td>4.11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>225.2</td>
<td>6.65</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>236.4</td>
<td>12.87</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.7</td>
<td>1.07</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>278.9</td>
<td>4.36</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>356.5</td>
<td>5.01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58.9</td>
<td>7.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.16.2D Vector Graph

6.16.1 Summary

A vector plot is a multidimensional graph used in industries such as meteorology, aviation, research, and construction that illustrate flow patterns (e.g. of wind, water, magnetic fields, etc.). Both direction and magnitude are represented in a vector graph. Origin includes two types of vector plots:

1. **Vector XYAM** - takes a starting XY location for the vector tail (by default), an angle and a magnitude.
2. **Vector XYXY** - takes two XY positions and connects them with a vector.

6.16.2 What you will learn

This tutorial will show you how to:

- Use Two data organizing mode to plot a vector graph.
Graphing

- Use Plot Setup to assign plot data

### 6.16.3 Steps

This tutorial is associated with `<Origin EXE Folder>\Samples\Tutorial Data.opju`. Also, you can refer to these graphs in Learning Center. (Select Help: Learning Center menu or press F11 key, and then open Graph Sample: Specialized Graphs)

To create a vector plot, you need four data columns, and to organize your data into two modes:

#### 6.16.3.1 Vector XYAM

XYAM stands for X, Y, Angle and Magnitude. Vectors will start from point (X, Y), and rotate a specified angle. The following example uses XYAM data mode to create a vector graph.

1. Open Tutorial Data.opju and browse to the 2D Vector folder in Project Explorer (PE).
2. Activate the data worksheet Book8E. Without highlighting any columns, select Plot: Specialized: Vector XYAM from the main menu to open the Plot Setup dialog. Assign columns A, B, D, C to X, Y, A, M as shown below, then click OK to plot the graph.
In order to show all three panels in Plot Setup dialog, please expand Plot Type panel by clicking and expand Available Data panel by clicking again.

Please refer to Plotting using Plot Setup for more information.

3. Select Format:Plot... to pull up the plot level of the Plot Details dialog. In the Vector tab change the Magnitude Multiplier drop-down list to 75. Click the OK button to close Plot Details dialog.

4. Click Left axis and click the Show Opposite Axis button in the Mini Toolbar. Click Bottom axis, and click the Show Opposite Axis button in the Mini Toolbar.

5. Click Right Axis and click the Show Tick Lables button in the Mini Toolbar. Click Top Axis and click the Show Tick Lables button in the Mini Toolbar.

6. Click Right Axis, then click the Tick Style button and select Out in the Mini Toolbar. Click Top Axis and click the Tick Style button and select Out in the Mini Toolbar.

7. Right click on the legend box to bring up the context menu. Select Properties... to open the Object Properties dialog. Type \( I(1) \) Field Strength in the text box and click OK.

8. Use Text Tool button, and add title: Spot Write Effectiveness in this graph.

6.16.3.2 Vector XYXY

Another data organizing mode is XYXY; where the first X, Y is the vector starting point, while the last X, Y is the ending point.

To create such a vector graph,
1. Activate workbook **Book9E** under the 2D Vector folder. Click C column, and then click **Set as X** button in the Mini toolbar.

2. Highlight all of the four data columns in it, and select **Plot: Specialized: Vector XYXY** from the main menu.

### 6.17 Piper Diagram

#### Videos

- Combining Metadata in Legend
- Customize the Legend

#### OriginBlog

- Zooming into a Section of a Ternary Plot by Setting Axis Scales

### 6.17.1 Summary

Piper diagram (or Trilinear diagram) is used as an effective graphical representation of chemistry in water samples in hydro-geological studies. The percentage values of six ion groups are considered in the plot, they are calcium, magnesium and sodium plus potassium cations, and sulfate, chloride and carbonate plus hydrogen carbonate anions.

The cations and anions are shown by two separate ternary plots and both are then projected onto a rhomb. In Origin they are plotted as a three layer graph.
6.17.2 What will you learn

This tutorial will show you how to:

- create a piper plot from percentage data
- customize the gap between ternary and rhomb in piper graph
- add data labels in the piper plot

6.17.3 Steps

1. Start a new workbook and select Data: Connect to File: Text/CSV to import the file Piper.dat under <Origin EXE Folder>\Samples\Graphing path.

2. In the imported worksheet, column A is the Sample ID. Column B through G are the percentage values for the six ion groups in the order of Ca, Mg, Na+K, Cl, SO4, and CO3+HCO3. Column H is the amount of total dissolved solids in water. The percentage for cation groups is relative to the total amount of cations and that of anion groups is calculated by the same manner.
Note: We have some built-in workbook templates to help you convert data from different units (MEq/mgL/PPM) to percentage (open from File:New:From Template:). For details, please refer to this help file.

3. Highlight column B through G and select Plot > Specialized : Piper from the top menu to open the plotpiper dialog.

4. Select column A for Sample ID and column H for Total Dissolved Solids.

Note: You can select an existing piper diagram as the Output Graph and add the selected new data into this piper diagram.

5. Click OK to generate the piper plot:
Sample ID and TDS are optional when plotting piper diagram. If Sample ID is specified, symbol color and shape will be controlled by it. If TDS is specified, open circle in the rhomb (Layer 1) will show and the size will be controlled by it. Also Piper diagram shows each sample in legend.

6.17.4 More Customization Steps

The following steps can further customize the graph to be exactly the same as the image in Summary.

1. To change the gap between the ternary plots and the rhomb, double click the bottom left ternary to open the Plot Details dialog. On the left panel, select Layer 2. On Size tab, change the Left value to be 130, so that the distance between the top vertex of rhomb and the top vertex of the ternary in Layer 2 will be 130% of the side length of rhomb. Click Apply button.
2. To change the symbol color or shape increment list, select the 1st plot under **Layer 1** node on the left panel. Then select **Symbol** tab > **Symbol Color** > **By Points** to customize the color list, or **Shape List** tab to customize shape list.

3. To add **Sample ID** as data label in the rhomb, Select 1st data plot under **Layer 1** node on the left panel. Go to **Label** tab and set as follows:
To add data labels to two ternaries in the graph, please select plot under **Layer2** and **Layer3** nodes in the **Plot Details** dialog and do the same.

4. The 2nd data plot under **Layer1** node in the **Plot Details** dialog is the open circle for TDS. Select the data plot on left panel and select the **Symbol** tab. You can see the Size of the open circle is controlled by \text{Col(H)}. The Scaling Factor is auto determined to get a proper display. Change the **Scaling Factor** to \text{0.03} to see the change.

5. By default Sample ID shows in legend. To show sampling location's information in legend, right click on the legend and select **Legend:Point by Point...** to open the **Update Legend Point by Point** dialog. Select **Custom** for the **Label Form** drop-down list and then select \text{wcol(1): wcol(9)} from the menu. \text{wcol(9)} refers to the 9th's column in worksheet, which is the Sampling Location column.

![Update Legend Point by Point dialog](image)

**6.18 Waterfall**
6.18.1 Waterfall

- 2D Waterfall
- 3D Waterfall

6.18.2 2D Waterfall

6.18.2.1 Summary

Origin's Waterfall plot uses a dataset stored in a parameter row to set the Z offset and create a color map with Y or Z values.

6.18.2.2 What you will learn

This tutorial will demonstrate how to:

- Create a 2D Waterfall color map with Y or Z values
- Customize colormap levels and palette

6.18.2.3 Steps

6.18.2.3.1 Create Waterfall with Y Colormap

1. Open the sample project "Waterfall Plots - Waterfall with Y Colormap" under category "Waterfall" in Learning Center (pressing F1 to open it).
2. Select the **Waterfall with Y Colormap** window to activate it. Click in the upper left corner of the worksheet to select all data.

3. Right-click and select **Plot > 3D : Y Color Mapped 3D Waterfall** to create a Waterfall with Y color mapping. (Alternatively, select the **Y Color Mapped Waterfall** button from the 2D Graphs toolbar.) A graph resembling the image below will appear:
Note that the values stored in the user-defined parameter row **Frequency (Hz)** have been automatically picked up as **Z Value Source**. Confirm this by double-clicking the plot to open the **Plot Details** dialog box and selecting **Layer1** in the left panel. Select the **Miscellaneous** tab and observe that the **Z Value Source** is set to **Frequency (Hz)**.
4. With the **Plot Details** dialog box still open, in the left panel, select the first line plot under Layer1. Select the **Colormap** tab in the right panel. Click on the **Level...** column header to open the **Set Levels** dialog box. Set levels as shown below:

Click **OK** to close the Set Levels dialog box.

5. Click on the **Fill...** column header to open the **Fill** dialog box. Select **Load Palette**, and choose the **Rainbow** palette from the palette list. Click **OK** button to close the **Fill** dialog box.
6. Click on Z axis, on the popup mini toolbar, click button Axis Scale to open the Axis Scale dialog box. Set From, To and Increment as below.

Click OK to apply these settings and close the Plot Details dialog box.
7. Click Y axes, on the popup mini toolbar, click button **Show Opposite Axis** to show the Y axis on the other side.
Click **OK** to apply changes and close the dialog box. The final graph should look like this:
6.18.2.3.2  Create Waterfall with Z Colormap

1. Open the sample project "Waterfall Plots - Waterfall with Z Colormap" under category "Waterfall" in Learning Center (pressing F1 to open it).
2. Select the **Waterfall with Z Colormap** window to activate. Click in the upper left corner of the worksheet to select all data.

3. On the main menu, click **Plot**, then point to **3D**, and then select **Z Color Mapped 3D Waterfall** to create a Waterfall with Z color mapping. (Alternatively, select the **Z Color Mapped Waterfall** button from the 2D Graphs toolbar.)
4. Double-click the plot to open the Plot Details dialog box. In the left panel, select the first line plot under Layer1. Select the **Colormap** tab in the right panel. Click the **Level...** column header to open the Set Levels dialog box. Set **Major Levels** to 10.
Click **OK** to close the Set Levels dialog box.

5. Click the **Fill…** column header to open the Fill dialog box. Select **Limited Mixing** and set the **From** color to **red** and the **To** color to **blue**. Click **OK** to apply these settings and close the dialog box. Click **OK** to close the Plot Details dialog box.
6. Click on Z axis, on the popup mini toolbar, click button **Axis Scale** to open the **Axis Scale** dialog box. Set **From**, **To** and **Increment** as below.
7. Click **Y** axes, on the popup mini toolbar, click button **Show Opposite Axis** to show the Y axis on the other side.
Your final graph should look like this:
6.18.3 3D Waterfall

Origin features an OpenGL-supported 3D waterfall graph. The 3D waterfall is a specific type of 3D wall graph with a wall width = 0. You can rotate, resize, stretch and skew the graph as with other Origin 3D graphs.
6.18.3.2 What you will learn

This tutorial will show you how to:

1. Plot a 3D waterfall graph
2. Add a plane at the specified position in the graph
3. Skew the 3D waterfall graph

6.18.3.3 Steps

1. Select Help:Learning Center menu to open Learning Center dialog. Select Graph Sample item in the left panel and then select Waterfall Plots for Samples in drop-down list. Double-click on the thumbnail
Graphing

below to open the sample Waterfall Plots - 3D Waterfall.

2. Activate workbook Book41, highlight all columns to select Plot > 3D : 3D Waterfall from the main menu to plot a 3D waterfall graph.

3. Select Format:Layer from the menu to open the Plot Details dialog box. Go to the Planes tab, check the box to add an XY plane to the graph, uncheck the Enable check box in the Plane Border group,
then set the remaining controls as shown in the following image:

4. Click the arrow icon to the left of Layer1 to show all plots in the layer. Select the first plot in the layer (take care not to clear the check box next to the dataset icon), then click the Pattern tab and set the Fill Color as LT Gray.

5. Click OK to close the dialog box. Double-click on a graph axis to open the Axis dialog box. Clear the Use Only One Axis For Each Direction check box. Go to the Scale tab and select Z axis icon in the left panel and set From and To to 0.8 and 3.2, and set the increment value of MajorTicks to 0.2.
Go to the Tick Labels tab, make sure Top - Z icon is selected and clear the Show check box to hide the tick labels on top Z axis.
6. Go to the **Line and Ticks** tab, make sure **Top - Z** icon is selected and set **Major Ticks** and **Minor Ticks** to **None**.

7. Click **OK** to close the dialog. Click on the cube to activate the five red graphical editing icons. Click on the fourth button - the **Skew** button - and drag the X/Y hotspots to skew the graph in X/Y direction so that it
Graphing

6.19 Open-High-Low-Close-Volume Stock Chart

**Videos**
- Skip Weekends and Holidays in Financial Plots
- Multiple Axis Reference Line and Recession Bars

**OriginBlog**
- How to Create a Timeline in Origin 2015
- Create Calendar Chart Using Graph Maker App
- Using LabTalk to generate and plot Fibonacci sequences

6.19.1 Summary

This tutorial will show you how to create a stock chart to display open, high, low, and close prices, along with trading volume.
6.19.2 What you will learn

- Create a stock chart with open, high, low, and close prices, and trading volume
- Set axis Scale Type to skip market-closed days
- Set format for tick labels (Multi-Line label)
- Categorize the volume columns according to their weekday by filling different colors
- Create the Legend to annotate the columns with different fill colors

6.19.3 Steps

You can refer to this graph in Origin Central. (Select Help: Origin Central menu or press F11 key, and then open Graph Sample: Financial Plots)

1. Highlight Col(C)~Col(G) in the worksheet, and then choose Plot > Specialized: OHLC-Volume to create a graph.
2. Double click on the bottom X axis of Layer2 to open the **X Axis** dialog. Switch to the **Scale** tab. You can see the **Type** is set to **Discrete** by default. This is why the X axis skips all weekends and holidays automatically.

3. Change the axis rang **From 3/3/2001 To 5/7/2001**. Under the **Major Ticks** branch, make sure **Type** is set to **By Increment**. Type **1week** for **Value**. Under the **Minor Ticks** branch, make sure **Type** is set to **By Counts**. Type **5** for **Count**. Click **Apply** button. You can see weekend and holidays are skipped.
Tutorials for Origin 2024b

clearer.

4. To show bottom axis label as multiple lines, switch to the Tick Label tab. Activate the Display sub-tab. Select Custom Display for Display drop-down list. Enter the text below in Custom Display text box.

```
hhtt MMMdd  --------- yyyy
```
5. Go to **Format** sub-tab, set Font Size to 10 and check **Wrap Text** check box.
6. Click **Apply** button.

7. Go back to **Scale** tab, select **Vertical** icon at the left panel, then set **From** and **To** to 0 and 120M. Click **Apply** button.

8. Select 1 under the **Layer** drop-down list which locates at the left-bottom corner of the dialog to switch to **Layer 1**. Then with **Vertical** icon still chose, set **From** and **To** to 12 and 22. Click **OK** button to close the
Double-click on the column plot at Layer 2 to open the Plot Details dialog. In the Pattern tab, expand the Fill Color drop-down list, go to By Points sub-tab, under the Index list, select Col(B): "Week Day".
then select **D01 Pumpkin Patch** under **Color List**. Click OK button to close this dialog.

10. With Layer 2 activated, select **Graph: Legend : Categorical Values** menu. In the dialog opened, keep the default settings, click **OK** button. A legend will be added onto graph. Select the legend to show up the legend border, press the **Ctrl** key to drag the legend border to make the legend items arranged in one line.

11. Resize and re-position the legend box. The Final graph should appear as shown below:
7 Data Management

7.1 Data Management

- Working with Multi-Sheet Workbooks
- Adding Objects to Worksheet

7.2 Working with Multi-Sheet Workbooks

### Videos

- Introduction to the Origin Workbook
- Save Workbook as an OGWU vs Analysis Template
- Add Graph to Worksheet
- Add Graph to Workbook
- Insert Graphs
- Creating Batch Reports using Origin Analysis Template and Microsoft Word

### OriginBlog

- Using Metadata in Worksheet in Calculation – Part 2: Page.Info

#### 7.2.1 Summary

Origin workbooks are similar to spreadsheets and can have multiple worksheets. Multi-sheet workbooks allow for better organization and higher information density.

#### 7.2.2 What you will learn

This tutorial will teach you how to:

- Add and arrange worksheets.
- Handle metadata.
- Split the worksheet into Panels using Dividers.

#### 7.2.3 Steps

7.2.3.1 Adding and Arranging Worksheets
1. Click the **New Project** button on the **Standard Toolbar**.

2. Right-click on the **Sheet1** tab and choose **Name and Notes**. For **Short Name** enter **Subjects** (Note that the sheet has **Short Name** and a **Long Name** and you can display either on the tab by right-clicking on the tab and choosing **Sheet Name to Show**. Note, too, that you can change the tab display name -- whether **Long** or **Short** -- by simply double-clicking on the tab and typing in the new name).

3. Click on the **Add Sheet** button and a second sheet, named **Sheet1**, will be added to the book.

4. Double-click on the new **Sheet1** tab and enter **2nd Test** in the text box that appears. (Alternately, right-click and use the the **Name and Notes** option again.)

5. Right-click on the **2nd Test** name and choose **Insert**. A new sheet, named **Sheet1**, is inserted between **Subjects** and **2nd Test**. Rename the new sheet **1st Test**.

6. Left-click and hold down the mouse button on the **1st Test** sheet name, drag the mouse over the Origin Workspace and release. The **1st Test** sheet will now appear in its own workbook.

7. Select **Window: Tile Vertically** to arrange the workbooks side by side as shown below:

8. Drag **2nd Test** to the second workbook. This will move the **2nd Test** sheet from the original workbook to the new workbook as shown below:
9. Click the **Save** button. The **Save As** dialog will open since the project is yet to be saved. Save this in the User Files Folder as **Multi-Sheet Workbooks.opj**

**Note:** It is also possible to drag and drop sheets within the workbook to change the order. Right-click on any sheet name and note these additional options: **Duplicate Without Data, Duplicate, Delete** and **Navigate**.

### 7.2.3.2 Handling Metadata

#### 7.2.3.2.1 Add Metadata to the Worksheet

1. Click the **New Project** button on the **Standard Toolbar**.
2. Select **Format: Worksheet** from the Origin menu (Alternatively press **F4** or double-click on the gray area to the right of the columns). The **Worksheet Properties** dialog opens:
3. On the View tab, click the Edit Column Label Rows button. The Column Label Rows dialog opens.

4. Right-click on the table and select Add User-Defined Parameter. Scroll down to note that a UserDefined label has been added. The Show box is checked by default.

5. Double-click on the UserDefined text (or single-click and press F2), and change the UserDefined text to Wavelength (nm).

6. Click in the box to the left of Wavelength (nm) and drag it to the top of the list, dropping it above Long Name. This will change the order of the rows as shown below:
7. Click **OK** to close the Column Label Rows dialog.

8. Select the **Format** tab in the **Worksheet Properties** dialog, and choose **LongName** from the **Apply To** drop-down. Check the **Rich Text** box.

9. Click **OK** to close the **Worksheet Properties** dialog box.

10. Highlight the **Comments** row and click the **Merge Cells** button on the **Style Toolbar** to create a row with one cell.

11. Enter the values shown below in the Columns A and B header region (**Wavelength** to **Comments**). 
   (Note: Once the Rich Text box is checked for specified cells, double-clicking in the cells to edit them will activate the format buttons shown below):
7.2.3.2.2 View Metadata in the Workbook Organizer

1. Click on the New Folder button. Start with an empty worksheet. Select Help: Open Folder: Sample Folder... to open the "Samples" folder. In this folder, open the Import and Export subfolder and find the file S15-125-03.dat. Drag-and-drop this file into the empty worksheet to import it.

2. Click on the Show/Hide Organizer button. The Worksheet Organizer will appear at the bottom of the worksheet.

3. Expand the Imported Files branch and view the stored metadata.
7.2.3.3 Splitting Worksheets into Panels using Dividers

7.2.3.3.1 Split from Menu

1. Activate the worksheet and highlight a cell.
2. Select **Window: Split** from the Origin menu.
3. The worksheet or matrixsheet will be divided into 4 panels by a horizontal and vertical Divider at the highlighted cell. To move the Divider to a new location, drag it to the desired row or column.
4. Select **Window: Remove Split** from the Origin menu to hide the split pointers.
   
   (Note: This process is the same for worksheets and matrixsheets).

7.2.3.3.2 Split by Dragging the Divider
1. Point the cursor to the bottom right of the sheet at the end of the vertical scroll bar (for a horizontal Divider) or at the right end of the horizontal scroll bar (for a vertical Divider) as shown below:

2. When the pointer changes to a split pointer, drag it to the desired position. A horizontal or vertical Divider will be created.

A worksheet with horizontal and vertical Dividers is shown below:

### 7.3 Adding Objects to Worksheet

#### 7.3.1 Summary
Both worksheet header rows and data cells can contain embedded objects, linked objects as well as formatted text. In addition, floating graphs can be added to the worksheet like Excel.

**Note:** Beginning with Origin 2018, any inserted graph, whether it be a an editable graph, a graph inserted as a linked or static picture, an image inserted from file, or a sparkline, will generate a pop-up preview when you hover on the containing worksheet cell.

### 7.3.2 What you will learn

- How to insert various objects into a worksheet cell.
- How to add floating graph to worksheet.

### 7.3.3 Steps

#### 7.3.3.1 Inserting Objects in Cells

1. Start with a New Project by clicking on the **New Project** button.
2. Click on the **Import Wizard** button. In the **Import Wizard - Source** page, browse to select `S15-125-03.dat` file in Origin's `Sample\Import and Export` folder. Click on the Finish button to complete the importing.
3. Highlight columns **A(X)** and **B(Y)**, choose **Plot > 2D: Scatter: Scatter** from the menu or click on the **Scatter Plot** button to create a graph.

![Graph Image]

4. Return to the workbook and select the **Column: Add New Columns...** from the menu or click on the **Add New Columns** button to add 3 columns.
5. Expand the workbook so you can see all 7 columns.
6. In the row **1** of **E(Y)**, type **New Features** and press Enter.
7. Select cell **E1**, and then click the **Bold** button on the **Format Toolbar**.
8. Click the **Font Color** button on the **Format Toolbar** and pick **Yellow** as the color.
9. Click the **Fill Color** button on the **Style Toolbar** and pick **Blue** as the color.
10. Select the range **E1 to F1**, click the **Merge cells** button.
11. Right-click on cell $G1$ and choose **Insert Arrow: Left** from the context menu to insert an arrow to the cell.

12. Select the range $E2$ to $G12$, click the **Merge cells** button.

13. Right-click on the cell and choose **Insert Graph**.

14. In the **Insert Graph** dialog, type **Graph1** in the large Graphs box or click on the **Browse** button to select Graph1.

15. Click **OK** to close this dialog.

16. Right-click on cell $E13$ to choose **Insert Images from Files** from the context menu.

17. Click the **Browse** button and change the **Files of Type** to Bitmap (*.bmp).

18. In the Origin User File Folder, select the **Userdef.BMP**, click **Add File(s)** button and then click **OK** button.

19. Click **OK** button to close the **InserImg** dialog.

20. Right-click on cell $F13$ to choose **Insert Notes**.

21. Double-click on cell $F13$. Modify the text and then close the **Notes** window. A note will be saved in the cell.

22. Right-click in $E14$ and choose **Insert Sparklines** to open the **InsertSparklines** dialog.

23. In the dialog, click the **Data Columns** fly-out button to choose **C(Y)**. Uncheck **Long Name in 1st Column** check box.
24. Click **OK** to close the dialog. A sparkline will appear in the cell.

25. Click on cell **E15** and type: [http://www.originlab.com](http://www.originlab.com) and press Enter.

26. Click on the text in **E15** which opens your web browser to the OriginLab web site.

27. Click on cell **E16** to choose **Insert Variables** from the context menu. The **Insert Variable** dialog opens.

28. With the worksheet **Book1** is selected in the right panel, go to the **Info** tab, expand the **USER.VARIABLES** branch, select **SAMPLE** and then click on the **Insert** button. A variable will be inserted to the cell.
29. Double-click on the cell **E16**, the text will change to a variable string.
Data Management

The Graph, Notes and Sparklines in the above lesson are all examples of embedded objects (the Insert Graph could be either Embedded or Linked.) Embedded objects present a visual of a hidden external object that can be opened by double-clicking. Changes to the object can be made and then the object window can be closed and the source worksheet cell is updated.

7.3.3.2 Adding floating Graph to worksheet

1. Continue the above project. Highlight Col(D) in Book1 to plot a line graph.

2. In Book1, right-click the empty area or title of the book to select Add Graph:Graph1 from the context menu. The graph is added to the sheet. Note: Origin pre-loads the last-created graph to the Add Graph shortcut command. If you only see the shortcut Add Graph (no named graph following the shortcut command), clicking Add Graph will open the Graph Browser. In the Graph Browser, select your graph and click OK to insert the graph and return to the worksheet.

3. Left-click and hold down the mouse button on the graph and drag it to reposition it on the worksheet.
<table>
<thead>
<tr>
<th></th>
<th>A(t)</th>
<th>B(t)</th>
<th>C(t)</th>
<th>D(t)</th>
<th>E(t)</th>
<th>F(t)</th>
<th>G(t)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.01</td>
<td>40.1</td>
<td>60.6</td>
<td>101.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.02</td>
<td>40.2</td>
<td>61.3</td>
<td>100.9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.03</td>
<td>40.2</td>
<td>61.9</td>
<td>100.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.04</td>
<td>40.1</td>
<td>62.5</td>
<td>100.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0.05</td>
<td>40.2</td>
<td>63.1</td>
<td>100.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0.06</td>
<td>39.6</td>
<td>63.7</td>
<td>101.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0.07</td>
<td>39.7</td>
<td>64.3</td>
<td>100.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>0.08</td>
<td>39.9</td>
<td>64.8</td>
<td>102</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>0.09</td>
<td>39.9</td>
<td>65.4</td>
<td>101.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>0.1</td>
<td>39.4</td>
<td>65.9</td>
<td>101.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>0.11</td>
<td>39.3</td>
<td>66.5</td>
<td>101.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0.12</td>
<td>39.8</td>
<td>67</td>
<td>100.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>0.13</td>
<td>39.8</td>
<td>67.6</td>
<td>101.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>0.14</td>
<td>39.1</td>
<td>68.1</td>
<td>101.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>0.15</td>
<td>38</td>
<td>68.6</td>
<td>100.4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>0.16</td>
<td>38.9</td>
<td>69.1</td>
<td>101.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>0.17</td>
<td>39.1</td>
<td>69.6</td>
<td>100.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>0.18</td>
<td>39</td>
<td>70.1</td>
<td>101.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>0.19</td>
<td>38.5</td>
<td>70.5</td>
<td>100.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>0.2</td>
<td>39.2</td>
<td>71</td>
<td>101.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>0.21</td>
<td>38.7</td>
<td>71.5</td>
<td>101.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>0.22</td>
<td>39</td>
<td>71.9</td>
<td>101.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>0.23</td>
<td>36.3</td>
<td>72.4</td>
<td>101.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>0.24</td>
<td>38.3</td>
<td>72.0</td>
<td>101.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>0.25</td>
<td>38.6</td>
<td>73.3</td>
<td>100.6</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8  Data Exploration

8.1  Data Exploration

- Data Reader Tool
- Use Data Cursor to Show the Difference between the Data

8.2  Data Reader Tool

8.2.1  Summary

The Data Reader is an exploratory tool that uses the Data Info window to display information about a selected data point in a graph. Essentially anything that is contained in the worksheet, in association with a plotted data point, can be shown in the Data Info window. This includes coordinate values, column headers, or even cell-embedded images. In addition, you can customize the window to display numeric values using a custom format (e.g. date-time, Lat/Lon, etc.), or to change window background color, add a window title, etc.

Minimum Origin Version Required: Origin 2019

Beginning with Origin 2019, you can read data point coordinates in a 2D graph by hovering on the data point. This Data Point Tooltip is highly customizable, mimicking Data Info window functionality. For more information, see Data Point Tooltips.
8.2.2 What you will learn

This tutorial will demonstrate how to:

- Use the **Data Info** window to view information for a selected data point in the graph.
- Customize **Data Info** window content, to include the display of images (Tutorial 1).
- Customize **Data Info** window content, to display numeric data using custom formatting (Tutorial 2).

8.2.3 Tutorial 1: Basic Usage

1. Select **File: Open...** to open the `Alkanes.opj` in the `<Origin Folder>\Samples\Data Exploration` folder.
2. Highlight Column D in Book1 Sheet1, and select **Plot > 2D: Scatter: Scatter** to create a new graph.
3. Click the **Data Reader** button from the **Tools** toolbar, and click on the **Isobutane** data point on the new graph.
   The **Data Info** window showing the X and Y coordinates of the data point selected will appear.

![Data Info window showing Isobutane data point](image)

4. Right-click on the **Data Info** window, and select **Preferences** from the context menu to open the **Data Info Report Settings** dialog.
5. To remove the book and sheet name from the Data Info window, set the Report Title drop-down to None.

6. In the center portion of the dialog, remove the X coordinate by clicking on <X>, then clicking the Remove button. Do the same for the Y coordinate (<Y>).

7. In the upper-left corner of the dialog, click the X Data button, then the Y Data button to add the X and Y data source. Note the use of dataset Long Names in the Preview.

8. All source worksheet columns that can be added to the Data Info window are listed in the left panel. Highlight the B, C, E, G, and H columns and add them to the center panel by clicking the Select button. Note that at this point, the Preview shows that our window has two columns.

9. Click the Add Column button to add a third column to our table. Click the pencil icon above the third column and in the Column Settings dialog, set Type = Single Cell and Source = J "Ball and stick model". Set Column Width = 20 and click OK. Click the pencil icon above the first and second columns and set
Column Width = 15 and 20, respectively.

10. Click the Font button to open the Tooltip Font dialog. Set Minimum Font Size and Maximum Font Size to 10 and 16 respectively. This will for text to automatically resize as the Data Info window is resized. Note that this limits the resizing of the Data Info table, as well. Set the Font Color to Royal and click OK. Click the Background button, set Background = White and click OK.

11. Click on the Theme button and select Save to <Graph> in the fly-out menu. This ensures that your Data Info dialog settings will be saved to the active graph, then click OK to close the Data Info Report Settings dialog.
12. Resize the Data Info window by dragging a window corner. Note that the font size range that we specified previously, set limits on window resizing.

Drag a window corner to resize the display

8.2.4 Tutorial 2: Custom Numeric Display Format

In this tutorial, we'll learn how to apply a custom display format to numeric data shown in the Data Info window.

1. Press F11 to open the Learning Center, click the Graph Samples tab and search on the phrase "Google Map Temperature". Double click on the sample to open this project file containing the following map of the continental US with a contour plot overlay of mean January temperatures.
2. Double-click on the map + contour plot to open the **Plot Details** dialog box. Click on the **Colormap/Contours** tab and enable **Show Data Points** and click **OK**. What you are now seeing are the US cities where the January temperature data in the map overlay, were recorded. Enlarge the size of the window so that you can get a comfortable view of all scatter points.

3. Pick the **Data Reader** tool from the Tools toolbar (hint: it is on a split button with the **Data Cursor** and the **Data Highlighter**), then click on one of the scatter points on the map. The Data Info window should open and look something like the following image.

   ![Data Info - US Temps in January](image)

   The information, as reported, is not very user-friendly so we will customize the **Data Info** window to report more useful information.

4. Double-click on the Data Info window to open the **Data Info Report Settings** dialog box. Under the **Name** column in the center panel, click on and remove -- one by one -- the `<X>`, `<Y>` and `<Z>` coordinates from the center panel, using the **Remove** button.

5. Now click the **XData**, **YData** and **ZData** buttons in the upper-left corner of the dialog to move the X, Y and Z source data, labeled with the column **Long Name**, to the center panel. You can see the result by looking at the **Preview** to the right side of the dialog box.

   ![Data Info Report Settings](image)

   Currently, our **Data Info** displays two columns, one with column Long Names (`Longitude`, `Latitude`, `January`) and a second column with the numeric data associated with `Longitude`, `Latitude`, `January`. What
we will do is to apply formatting to these numbers so that they do not simply display as generic decimal numbers.

6. Click the Add Column button to add a third column to the Data Info table, then click the pencil icon in the newly-added column to open the Column Settings dialog box. Set the Type drop-down list to Numeric Display Format and click OK.

7. Click into the first cell below the Numeric Display Format heading and you will see a list control that you can click to show a list of custom formatting options. Firstly, note that this list is not exhaustive but contains suggestions for custom formats. Secondly, you can type directly into this box to specify a custom format.
8. In the first row list control, type the following (degrees-minutes east-west, with units before):

   
   DM EWB

9. In the second row list control, type the following (degrees-minutes north-south, with units before):

   
   DM NSB

10. In the third row list control, type the following (one decimal place + suffix string "deg F"):

    
    .1 "deg F"
11. Click the Add Column button to add a column to the Data Info table, then click the pencil icon in the newly-added column to open the Column Settings dialog box. Set the Type drop-down list to Single Cell, Source to A "City", Column Width to 30 and click OK.

12. Click the Save Theme button and choose Save to <Graph> to save the current Data Info window configuration to the graph window. Click OK to close the dialog box.

8.3 Use Data Cursor to Show the Difference between the Data

8.3.1 Summary

In Origin, the Cursor tool is used to measure the X and Y distance between two points. You can place cursor objects on the same curve or on different curves, then use the Data Info window to display the relative positions of the cursor objects.

Minimum Origin Version Required: Origin 2019

There is also a Distance Annotation tool for adding and labeling a double-arrow between two points on the graph.

8.3.2 What you will learn

This tutorial will show you how to:

- Customize the Data Info window
- Read relative positions of two data points

8.3.3 Steps

1. Start with a new worksheet.

2. Select File: Import: Multiple ASCII from the main menu. Go to the folder \Samples\Spectroscopy\Chromatography, select GPC Single Channel Chromatogram 1.dat and GPC
Single Channel Chromatogram 3.dat. Click Add Files, make sure that Show Options Dialog is selected, and click OK. This opens the ImpASC dialog box. In this dialog, set the Multi-File Import Mode to Start New Columns, check the Append Filename to Column Comment check box and uncheck the Include File Path when Appending Filename check box in the Re(Naming) Worksheet and Workbook branch. Click OK to import these two files into a worksheet.

3. Highlight all columns and right-click to select Set As: XY XY from the context menu. With all columns highlighted, choose Plot:Line:Line.
4. Press and hold the **Data Reader** button and select the **Data Cursor** from the list.

5. The **Data Info** window opens.

<table>
<thead>
<tr>
<th>Long Name</th>
<th>Data (Relative)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>0</td>
</tr>
<tr>
<td>Normalize</td>
<td>1.5924</td>
</tr>
</tbody>
</table>
6. Right-click on the **Data Info** window and select **Preferences...** from the shortcut menu. This opens the **Data Info Report Settings** dialog box.

7. Click the **Add Column** button three times to add a total of three columns to the **Preview** table.

8. Click the pencil icon above the first added column and change **Source** to **Data (Cursor 1)** and set **Column Width = 30**. Click **OK**.

9. Click the pencil icon above the second added column and change **Source** to **Data (Cursor 2)** and set **Column Width = 30**. Click **OK**.

10. Click the pencil icon above the third added column and change **Source** to **Relative (Cursor 2 - Cursor 1)** and set **Column Width = 40**. Click **OK**.

11. Click **OK** to close this dialog. The Data Info window will display three new columns.

11. Double-click on a data point in the graph to add the first cursor. Select the **Data Cursor** button again and add another cursor to the graph by double-clicking on the desired data point.
Note: After you add all the columns in the Data Info Report Settings dialog, you can save the settings as a Theme by clicking the Save Theme button and choosing an option from the popup menu. Note that you can save settings to the graph (maximum portability) or to a named Theme file (and subsequently applied to any graph window).

12. The Data Info window will be updated with the values of the two points and their relative values.

13. Right-click the Data Info window and select Copy All from the shortcut menu, then paste the table into a clean worksheet as shown below.
You can promote any worksheet row to the column label rows (header) area by right-clicking on the row and choosing one of the **Set As...** or **Append To...** options.
9 Importing Data

9.1 Importing Data

9.1.1 ASCII

- Single ASCII
- Import Wizard
- Importing Multiple Files into Workbooks Cloned from Active Workbook

9.1.2 Web Data

- Connect to Web Data by Copy Link Address

9.1.3 Database

- Import Data from a Database
- Import Data from a Database for Analysis
- SQL Editor for Database Analysis
- Update Database Importing By LabTalk Substitution
- Update Graph By Reimport Data From Database

9.1.4 Digitizer

- Digitizer Tool
- Enhanced Digitizer

9.2 Data Connector

9.2.1 Data Connector

- Connect to Web Data by Copy Link Address
9.2.2 Connect to Web Data by Copy Link Address

Videos

- Data Connectors
- An Introduction to the Maps Online App
- Google Map App
- Creating a 3D Bar on XY Plane using Maps Online App

OriginBlog

- Origin Web Data Connector in 2019b
- Importing JSON Data From a Web Service in Origin 2019
- COVID-19 Test Positivity Rates in Different US States
- COVID-19 Real Time Report from China
- COVID-19 Daily Update of World Situation Report of Confirmed Cases

9.2.2.1 Summary

Data Connectors are an ideal way to create a "live link" to data files that are periodically updated. Traditional file import requires the user to re-import data each time source data are modified. However, once a Connector is added to a workbook, it can automatically query the data source each time the project is opened, thus simplifying your data management tasks.

Menu > Data: Connect to Web

In this tutorial, we'll show you how to connect to "real-time" earthquake data on the United States Geological Survey (USGS) website, how to configure the connected project to automatically import data on open, and how to manage data caching so that you are assured of getting the most up-to-date data each time you open your project.

Minimum Origin Version Required: Origin 2021
9.2.2.2 What you will learn

- How to connect to a web-stored CSV file by copying the URL.
- How to use Origin's free Maps Online App to create a background image for geographic data.
- How to use the Plot Setup dialog with Data Connector-imported data, saving us the need to rearrange columns.
- How to save and reopen a project that uses a Web Connector (CSV).
- How to manipulate Origin's caching mechanism so that data are always refreshed on opening the project.

9.2.2.3 Connect to Web Data File by Copy Link Address

1. Start a new project. There should be one new workbook visible in the workspace.
2. Browse to this page on the USGS website: https://earthquake.usgs.gov/earthquakes/feed/v1.0/csv.php
3. In the right-hand column, you'll see under "Feeds", a list of links to CSV data files that are updated every minute.
4. Scroll down and under "Past 30 Days", right-click on "All Earthquakes" and choose Copy link address.
5. Return to Origin and with your workbook active, choose Data: Connect to Web.
6. Paste the link address you just copied into the URL box using CTRL + V and click OK.
7. Accept default settings in the CSV Import Options dialog box and click OK. The data from the USGS site are imported into the workbook. Note the green color of the Connector icon, indicating that the data connection is valid.

9.2.2.4 Plotting Connector-imported Data with Plot Setup

In this portion of the tutorial, we will use OriginLab's free Maps Online App to create a base-map for a scatter plot of latitude, longitude, magnitude and depth data.

Because of the "locked" nature of Data Connector-imported data, we cannot rearrange columns. By default, Origin requires that X data columns be to the left of Y data columns. But in our locked worksheet, the X data (longitude) are to the right of our Y data (latitude). The Plot Setup dialog box works nicely in this situation, as we can designate columns "on the fly" without having to move things around (and lose the "live" connection to our data). But first, we will get our free Maps Online App:

1. Press F10 to open the App Center. Click on the Search tab and with Category = All, enter "maps" into the search box. If the Maps Online App shows with a green checkmark beside it, you have already installed the App. If it displays the Download and Install icon, click the icon to install the App in your Origin software.
2. Click on the Apps Gallery (by default, docked to the right side of your workspace) and launch the Maps Online App. In the dialog box, click the Map drop-down and choose Nasa Earth Observations and set Layers to BlueMarbleNG.
3. Enter lat and long values into the North, South, East and West fields as shown below, then click OK. We now have a base-map for plotting our earthquake data.

NOTE: The Maps Online App queries a WMS server. These servers often change. If you find a broken service, try and locate an updated URL. Then, click the button beside the Map drop-down...
to open a text file. You can edit or add services (URLs) to the text file, making sure to follow the syntax used in the file, then save changes.

4. From the menu, choose **Graph: Plot Setup** (if not displayed, expand top and bottom panels of the dialog box). Set **Available Data** = *Worksheets in Folder* and you should see your *all-month* sheet in the top panel. Highlight the sheet in the top panel.

5. In the middle panel set **Plot Type** = **Scatter** and set **longitude** = **X** and **latitude** = **Y**, as shown. Now, click the **Add** button in the lower-right corner of the middle panel. Click **OK** to overlay the scatter plot of lat-ion data on your map.
6. Double-click on the plot to open Plot Details and recreate the settings show in the following screen-cap by setting these **Symbol tab controls**: Size = Col(E): "mag", **Scaling Factor** = 3, **Size Formula** = \((s-s1)/(s2-s1)\), **Symbol Color** = **By Points** set to Map:Col(D):"depth" (hint: edit your colormap on the **Colormap tab of Plot Details**). In summary, we are using **latitude and longitude** values to locate our scatter points on the map; we are using **mag** (magnitude) data to control symbol size and **depth** to control symbol color. Click **OK** to close the dialog.

![Symbol tab controls](image)

7. On the **Tools** toolbar, click the **Add Color Scale** button, then double-click on the color scale to open Color Scale Control dialog. On the **Levels** tab, **Hide Head Level** and **Hide Tail Level**. On the **Layout** tab, clear the **Reverse Order** box. On the **Title** tab, check the **Show** box. Click **OK** to close the dialog. You can also add a **Bubble Scale** to the map to show relative symbol sizes (since size is mapped to earthquake magnitude).

8. We can make a few cosmetic adjustments to our graph such as using **Print/Dimensions settings** to modify page size to more closely fit the aspect ratio of the map image. Additionally, we can **add axis titles**, and adjust fonts and font sizes using **Mini Toolbar** buttons.
If you hover on a plotted point in your graph, you will see a customizable data point tooltip. Carefully right-click on the tooltip, choose Preferences and you can modify the tooltip to display all of your plot variables -- latitude, longitude, magnitude and depth, in any order and in any numeric format -- as you mouse over your plot.

9.2.2.5 How to Manage Caching of Web Data

Data Connectors were conceived, in part, to facilitate import of very large data files. Connectors employ the strategy of not saving large file imports (> 500kB by default), thus saving on disk space. If you have a number of connected workbooks in your project file, you can selectively re-connect to files as needed, allowing you to import just the data that you need to access now.

In an effort to manage the number of times a connection is refreshed -- this takes time and can slow work, after all -- OriginLab developers added system variable @CFDT, which controls the length of time between Connector queries of source data. Data imported by Connect to Web is cached for a time period equal to the value of @CFDT seconds per 100kB of file size (e.g connected data in a 10MB file is cached for 900 * 100 = 90,000 sec or ~24 hr).

Additionally, there is a LabTalk command -- delete -web -- that will flush the cache on demand. For the purposes of our earthquake project, we would like to ensure that we are always getting the most up-to-date information, so we will make use of this.

In this portion of the exercise, we will configure our project so that:

- Data are automatically imported whenever the project is opened.
- The cache is flushed on project open so that we are certain of always having the most up-to-date information.
1. Choose **File: Save Project As**, give the file a name such as *USGS_Earthquake_All_30d.opju* and click **Save**.

2. Click on the worksheet’s Connector icon and choose **Auto Import > On Project Open**.

3. From the Origin menu, choose **View: Code Builder**. **Code Builder** is Origin’s integrated development environment (IDE) for developing LabTalk, Origin C and Python code. In the **Workspace** pane on the left side of the dialog, expand the **Project** branch and double-click on the **ProjectEvents.OGS** file. The file is loaded into Code Builder workspace. **ProjectEvents.OGS** is a special file that is saved with each Origin project and is used to store and execute LabTalk script at various event triggers such as upon opening of the project. We have already mentioned that we have a LabTalk command that can be used to flush the cached web data so we will customize **ProjectEvents.OGS** to run a simple line of script so that our web data are always refreshed on project open. Scroll up to the section **[AfterOpenDoc]**, add the following two lines of script, then click the **Save** button on the Code Builder toolbar.

   ```labtalk
   delete -web;
   type -b "The web cache has been cleared. Project data have been refreshed."
   ```

4. **ProjectEvents** should look something like this:

5. Choose **File: Save** to save your project, along with the contents of **ProjectEvents.OGS**.

6. Now, close your project, then using **File: Recent Projects**, click on your recently-saved-and-closed project. An attention message should open stating that the "web cache has been cleared. Project data have been refreshed." Subsequently, the worksheet should fill with data and the plot of earthquakes on the world map, should be regenerated.

### 9.3 ASCII

#### 9.3.1 ASCII

- **Single ASCII**
- **Import Wizard**
- **Importing Multiple Files into Workbooks Cloned from Active Workbook**
9.3.2 Single ASCII

The **Data: Connect to File: Text/CSV** menu allows you to automatically import a single ASCII file where the data columns are delimited orderly and it consists of few header lines (maybe just a short description for the file and then names and units for the columns).

### What you will learn

This tutorial will show you how to Import ASCII file by Data Connector.

### Steps

Select from Origin menu **Helio: Open Folder: Sample Folder** to open Windows Explorer to the Samples folder under Origin program folder (by default installed in the Program Files folder). Browse to the `\Import and Export` subfolder. Open the file `S15-125-03.dat` in Windows Notepad. You can see that this file includes header lines and data lines. For Single ASCII files, Origin's Data Connector can auto detect file header/subheader and extract this information to the worksheet headers, such as **Long Name**, **Units**, etc.
Note: Header lines are lines of text that are not part of the data and do not share the same delimiter formatting as the data. Subheader lines also are not part of the data, but share the same delimiter formatting and therefore correspond to particular columns of data.

To Import this file

1. Select **Data: Connect to File: Text/CSV** from the main menu. In the opened dialog, browse to folder \<Origin program folder>\Samples\Import and Export, and highlight the file S15-125-03.dat.

2. Double-click this file or click the **Open** button to open the **Import Options** dialog, in which you can view and specify the settings for how to import the file.

3. By default, Origin auto detects the main header, subheader, and data will be imported from subheader. In this example, Origin automatically sets the first line, Time Delta Temperature Magnetic Field Position as the column Long Name and the second line, (sec) (K) (Oe) (mm) as Units.
Change **Save file header to** to **Book organizer** to save the main header information to *info* tree of book organizer (open by right clicking on workbook title bar and select **Show Organizer**).
4. Click **OK** to accept these settings and import data into worksheet.

Please note that the imported data are protected by default and you cannot change it. You may see the hint below:

To enable data editing:

- Click the green icon on the upper-left corner of worksheet and choose **Disconnect Sheet** or **Remove the Data Connector** from context menu
9.3.3 Import Wizard

9.3.3.1 Summary

The **Import Wizard** allows you to import complicated ASCII files, extract variables from the import file name and header (for reuse in Origin), specify custom delimiters and date formats, or handle post-processing of your imported data using a custom LabTalk script. Moreover, you can save your custom settings to a filter (.oif) that can be used repeatedly to import the same or similarly-structured files.

9.3.3.2 What you will learn

This tutorial will show you how to use the **Import Wizard** to

- extract variables from both the file name and file headers
- save import settings and use them to import new data

9.3.3.3 Steps

1. Start with a new workbook. Select from menu **Data: Import From File: Import Wizard** to open the **Import Wizard** dialog. Click the browser button to the right of the **File** box. Browse to the folder \Samples\Import and Export and select the file S15-125-03.dat.
Note that an import filter of `VarsFromFileNameAndHeader.oif` is auto-selected for Import Filter> Import Filters for current Data Type. By default, if there is any import filter in the data folder, the filter will be auto-used to import the data. In this example, we will show you how to import this data step by step and create a similar filter. So we choose `<None>`. Click Next.

2. The Header Lines page enables you to easily customize the worksheet headers. The lower preview panel is especially helpful when you are importing a file with many lines of header like this example. Clear Auto determine header lines check box. To specify the main header lines, place the cursor on line 6 in the preview panel, and then click the button next to Main Header Lines: Fixed Number. Similarly, specify the Long Name and Unit line.
Click **Next**.

3. The **Variable Extraction** page allows you to extract variables from file name and file headers, which can be saved in page info, put into column header lines, or used in annotating a graph. Select **Specify location of variable names and values using delimiters**, **Add variables to page info** and **Create User Parameter rows for each variable**.
4. The **Variable Extraction by Delimiter** page allows you to extract variable names and values from file metadata using specified delimiters. This information is then used to create worksheet User-defined Parameter rows and is also then available for use in text objects, etc.

To extract data, go to the **Variable** group and set fields or enter text, as shown in the table below this image. Note that:

- There are two radio buttons -- **Enter variable name** and **Extract variable name from file** -- and that a slightly different set of controls is exposed, depending on which radio is chosen.
- The controls are a mix of text boxes and drop-down lists and for drop-down lists, you should be able to select the correct entry from the drop-down list.
Note that after each Line of table data is set in the dialog, you must click the Add button before starting on the next Line.

<table>
<thead>
<tr>
<th>Line</th>
<th>Delimiter</th>
<th>enter</th>
<th>Value</th>
<th>Enter variable name</th>
<th>Line</th>
<th>Delimiter</th>
<th>Extract variable name from file</th>
</tr>
</thead>
<tbody>
<tr>
<td>FN04</td>
<td>Other</td>
<td>-</td>
<td>S15</td>
<td>SampleID</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FN04</td>
<td>Other</td>
<td>-</td>
<td>125</td>
<td>BatchNo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FN04</td>
<td>Other</td>
<td>-</td>
<td>03</td>
<td>RunNo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H002</td>
<td>Colon</td>
<td></td>
<td>1000</td>
<td></td>
<td></td>
<td></td>
<td>No. of points</td>
</tr>
<tr>
<td>H004</td>
<td>Colon</td>
<td></td>
<td>Measured</td>
<td></td>
<td></td>
<td></td>
<td>12/01/2004</td>
</tr>
</tbody>
</table>
This example shows how **Line = H006** controls should be set:

When you have added all lines from the above table, click **Next**.

5. On the File Name Options page, select **worksheet with variable** checkbox and choose **RunType** from the combo box drop-down list to rename the worksheet by variable RunType. Also select **Rename Long Name for Book only** and **Append file name to column comments**.
Click Next

6. On the Data Columns page, select Tab for Column Separator > Delimiter, and from the drop-down list, choose (XY) for the Column Designations. Click Apply button to preview the data columns in the bottom panel.
7. Click **Next** twice to go to the **Save Filters** page. To use these settings again, you can save this import procedure as a filter. Select the **Save filter** check box and type a filter name in the **Filter file name** text box (MyFilter in this example).
Click **Finish** to import the data.
8. Open **Import Wizard** dialog again. This time, select file `<Origin installation folder>\Samples\Import and Export\S21-235-07.dat`. You can select **MyFilter** filter just saved from **Import Filters for current Type**.

Click **Finish** button directly. The settings in **MyFilter** will be used to import the file.

### 9.3.4 Importing Multiple Files into Workbooks Cloned from Active Workbook
9.3.4.1 Summary

Origin provides an easy way to "clone" import and analysis operations in the active workbook. This powerful feature allows you to process a group of files quickly with no more than a few button clicks.

This feature is implemented for most of Origin’s supported import file types, e.g., ASCII, CSV, Excel, and will work with the older X-Function based routines (Data: Import From File) or the newer Data Connectors (Data: Connect to File). This tutorial makes use of the newer Connector technology but the methods are essentially the same for the older X-Function based import routines.

9.3.4.2 What you will learn

This tutorial will show you how to:

- Create a prototype workbook.
- Clone the workbook by importing and analyzing a group of similar data files.

9.3.4.3 Import Multiple ASCII Files into Cloned Workbooks

9.3.4.3.1 Create a Prototype Workbook

In this example we will import a file, make a scatter plot and perform a linear fit on the data, and embed the graph with fit results in our workbook.

1. Start a new project. From the menu, choose Data: Connect to File: Text/CSV.
2. Browse to the <Origin Installation Path>\Samples\Curve Fitting\ folder and select Sensor01.dat.
3. Accept default settings in the CSV Import Options dialog, and click OK. The data file is connected to the worksheet.
4. In the worksheet, click on the column B header to select the column, then click the Scatter button.
5. Highlight column B (Sensor Output) and choose Plot: 2D: Scatter : Scatter to plot a scatter graph.
6. Double-click on X axis to open the Axis dialog. Click on the Scale tab, press the CTRL key and choose both Horizontal and Vertical in the left panel. Set Rescale = Auto and click OK.
7. Choose Analysis: Fitting: Linear Fit menu to open Linear Fit dialog. Set Recalculate = Auto (optional -- see tip below) and click OK to perform the fit. Answer No to the Reminder Message and click OK.
8. Right-click in gray area to the right side of the **Sensor01** worksheet and choose **Add Graph:**[Graph1]. The Scatter plot with linear fit curve will show as a floating graph on **Sensor01**.

In step 7., you were asked to set the **Recalculate** mode to **Auto**. Beginning with Origin 2018b, this step is not necessary as cloned imports automatically trigger recalculation. If you were using earlier versions of Origin with the ASCII import dialog box, you could invoke the same behavior by putting the following line of script into the **Script after Each File Imported** box (under the Scripts branch) of the ASCII dialog box.

```
run -p au;
```

### 9.3.4.3.2 Import Multiple Files and Perform Analysis by Cloning the Workbook

In this portion of the tutorial, we will "clone" all of the operations associated with Book1, including graphing and performing a linear fit, by importing more Sensor data files.

1. With Book1 active, click the **Clone Import** button on the **Import** toolbar.
2. Browse, again, to the Curve Fitting folder and use the SHIFT or CTRL keys to select files Sensor02.dat ... Sensor07.dat, click **Add File(s)** and then **OK**. All files are processed and the resulting graph and fit curve are embedded as a floating graph on each worksheet.

---

### 9.4 Database

#### 9.4.1 Database

- [Import Data from a Database](#)
- [Import Data from a Database for Analysis](#)
- [SQL Editor for Database Analysis](#)
- [Update Database Importing By LabTalk Substitution](#)
- [Update Graph By Reimport Data From Database](#)

#### 9.4.2 Import Data from a Database

9.4.2.1 **Summary**
The database used in this tutorial has been set up on Microsoft Azure.

This tutorial shows how to build the connection to a SQL server and extract desired data from specified tables using Origin's SQL Editor, define LabTalk variable in SQL script for easy modification, and save connect or connection & query for future use.

The procedure is based on Origin 2023b.

9.4.2.2  What you will learn

This tutorial will show you how to:

- Import data from database.
- Reimport data.
- LabTalk support in the SQL Editor.

9.4.2.3  Steps

9.4.2.3.1 Import data using SQL Editor

1. Start a new worksheet. Select from menu Data: Connect to Database: New.... In the Database Connector dialog, select ODBC driver and click OK.
2. Create the connection to a sample database. Specify the server information, including the log-in user name and password with the settings below:

```plaintext
Server Driver=SQL Server;
Server=olab.DATABASE.windows.net;
Port=1433;
USER Name=Olabts;
Password=Origin2023;
```
3. Click the **Test** button to make sure the connection is successful.

If it fails to connect to the database, go to this page to download and install the latest ODBC SQL driver.

4. Click the **Database** button to the right of the Database entry and make sure database **sample1** shows. Click the **OK** button to open the **SQL Editor** dialog.
5. All tables in the database are listed in the left panel.

Select menu File: Show Connection String, the connection string will show at the Message panel below. Alternatively, you can use this connection string in step 2 to create the connection.

```
Driver={SQL Server};Server=olab.DATABASE.windows.net;Port=1433;DATABASE=sample1;Uid=Ol abts;Pwd=Origin2023;
```

6. Select File: Save Connection As... to save the data source file as MyDataSource.ods.

7. Now we are going to extract data from the **Product** table to construct the product list. You can write SQL script from scratch. Double click node on left panel will help you add the table and field name in the editor. Create the query following the video below or copy the following SQL script in the right panel.

```
SELECT Name, ListPrice, SellStartDate, SellEndDate, ThumbNailPhoto FROM SalesLT.Product
```
8. Click the **Preview the result data** button to preview the data. Select **File: Save Connection and Query As...** from menu to save the connection and query as **MyQuery.odq**. In the future, you can load the connection settings and the query script from menu **Data: Connect to database: MyQuery.odq.**
10. Click the **OK** button to import the data. Once imported, the worksheet is connected to the database, and a yellow icon will appear at the top-left of the worksheet.

9.4.2.3.2 Reimport from Database

After the data is imported, the connection and the query are automatically saved in the data connector. You can click the **Database Connector** and select **Import** to import the data from the database again. Try the following steps.

1. Click , and select **Unlock Imported Data**.
2. Delete or make change to some data in the worksheet.
3. Click and select **Import**. The data should be back.
4. To modify the query, with the worksheet active, click and choose **SQL Editor**.
5. To setup a new SQL Query for same database, do one of the following
   - Duplicate the workbook (**Window: Duplicate** menu). In new book, click and choose SQL Editor to edit the query.
   - Start a new workbook. Choose **Data: Connect to DataBase** menu. All saved and ODS and ODQ files are listed here.
6. Choose MyQuery.ODQ. The DataBase Editor dialog will open with the saved SQL query. Click **OK** button to import.
By default, the imported data are not saved with the project (OPJU file) since big database can make OPJU file huge. If you do want to save the data with the project, click [ ] and uncheck \textit{Exclude Imported When Saving}. Then save the project.

\textbf{9.4.2.3.3 LabTalk Support in SQL Editor}

Now let’s make changes to the SQL query to only retrieve the products with a unit price of less than $10. This section will show you how to define a Labtalk numeric variable of the price in the condition so it’s easier to change the query in the future.

1. Click [ ] and choose SQL Editor
2. To add a Labtalk numeric variable, select \texttt{Query: LabTalk...} to open the LabTalk Support Setting dialog.

   ![LabTalk Support Settings](image)

3. Check the \texttt{Enable LabTalk (%,$) substitution} checkbox.
4. Type the script below to define a LabTalk numeric variable \texttt{priceToCompare}.

   \begin{verbatim}
   double priceToCompare = 10;
   \end{verbatim}
5. In the **Before Query Script** box, click **OK**.

6. At the end of SQL Script on the right panel, add

   ```sql
   WHERE ListPrice < $(priceToCompare)
   ```

7. Click the **Preview** button to preview the SQL query string with LabTalk variable substituted in the SQL Editor box.

8. Click **OK** to import these data.

9. From now on, you only need to change the `priceToCompare` value in **LabTalk Support Settings** dialog. No need to change the SQL Query.

1688
9.4.3 Import Data from a Database for Analysis

9.4.3.1 Summary

The database used in this tutorial has been set up on Microsoft Azure.

This tutorial shows how to import data from database into Origin worksheet by using SQL Editor. And then perform some operations on the data, such as filter, statistics, etc., to get the desired results for the graphing.

The procedure is based on Origin 2023b.

9.4.3.2 What you will learn

This tutorial will show you how to:

- Import two SQL queries of same database into two sheets of a workbook data using SQL Editor.
- Apply data filter to the worksheet data.
- Perform descriptive statistics on columns.
- Make graphs such as column plot, etc.

9.4.3.3 Steps

9.4.3.3.1 Import Data from Database

1. Start a new project. Choose Data: Connect to Database: New... menu or click clicking the Open SQL Editor button on the Database Access toolbar.

2. Choose Connection string radio button and click OK. Paste the Connection String below.

   Driver={SQL Server}; Server=olab.DATABASE.windows.net; Port=1433;
   DATABASE=sample1; Uid=Olabts; Pwd=Origin2023;

3. If you are using ODBC Drive 18 for SQL Server, use

   Driver={ODBC Driver 18 FOR SQL Server}; Server=olab.DATABASE.windows.net;
Tutorials for Origin 2024b

```
Port=1433;
DATABASE=sample1; Uid=Olabts; Pwd=Origin2023;
```

4. Click the **Test** button to test if the connection is fine. If fine, click the **OK** button to connection to the database.

5. From the left panel, double click on the *SalesLT.Product* node. **select * from SalesLT.Product** will show on right

6. Click the **Preview the result data** button to view the data in the bottom panel.

7. Click the **OK** button to import the data to the active worksheet.
8. To import data based on another SQL query from the same database to new sheet, right click the sheet tab and choose **Duplicate Sheet without Data**

9. On Sheet2, click ![SQL Editor](image) and choose SQL Editor...

10. Select **Query: LabTalk...** menu to open the **LabTalk Support Settings** dialog. Check the **Enable LabTalk (%, $) Substitution** checkbox, and put the following script to the text box.

    ```labtalk
    int cate=1;
    ```

11. The dialog will look like this.
12. Click **OK** to go back SQL Editor. Then put the following SQL script to the top right panel. This SQL will query two columns from the database, one is the product’s category name, the other is the total of LineTotal for each category in Parent Category 1.

```sql
SELECT SalesLT.ProductCategory.Name, SUM(SALEANDPRODUCT.LineTotal) AS LineTotal
FROM

(SELECT SALEINFO.LineTotal, PRODUCTINFO.ProductCategoryID
FROM

(SELECT SalesLT.SalesOrderHeader.OrderDate,
SalesLT.SalesOrderDetail.LineTotal, SalesLT.SalesOrderDetail.ProductID
FROM SalesLT.SalesOrderHeader

INNER JOIN SalesLT.SalesOrderDetail
ON SalesLT.SalesOrderHeader.SalesOrderID = SalesLT.SalesOrderDetail.SalesOrderID) AS SALEINFO

INNER JOIN

(SELECT SalesLT.Product.ProductID,
```

13. Click **OK** to go back SQL Editor. Then put the following SQL script to the top right panel. This SQL will query two columns from the database, one is the product’s category name, the other is the total of LineTotal for each category in Parent Category 1.
importing data

```
FROM SalesLT.Product) AS PRODUCTINFO
ON SALEINFO.ProductID=PRODUCTINFO.ProductID) AS SALEANDPRODUCT

INNER JOIN SalesLT.ProductCategory

ON
SALEANDPRODUCT.ProductCategoryID=SalesLT.ProductCategory.ProductCategoryID

WHERE SalesLT.ProductCategory.ParentProductCategoryID = $(cate)

GROUP BY SalesLT.ProductCategory.Name

ORDER BY LineTotal
```

14. Click the last button to view the SQL query script with substituted variable. Click Preview the result data button to view the data in the bottom panel.
15. Before closing the dialog, choose File: Save Connection and Query as .... Save it as LineTotal_by_parentCategory.ODQ.

16. Click the **OK** button. Query result shows on Sheet2

![Sheet2](image)

**9.4.3.3.2 Data Filter and Statistics**

1. Instead of using SUM(), INNER JOIN, GROUP BY to get Statistics. We can first do simple query and import the columns we are interested. Then using Origin's filter and statistics, etc. to get desired result and graphing.


3. Choose Data: Connect to Database: menu and pick LineTotal_by_parentCategory.ODQ.

4. Replace the right with the following Query, which just inner join multiple tables and query 3 columns: Category Name, ParentCategoryID and LineTotal.

```sql
SELECT SalesLT.ProductCategory.Name, SalesLT.ProductCategory.ParentProductCategoryID, SalesLT.SalesOrderDetail.LineTotal
FROM SalesLT.SalesOrderDetail
INNER JOIN SalesLT.Product
ON SalesLT.SalesOrderDetail.productID = SalesLT.Product.ProductID
INNER JOIN SalesLT.ProductCategory
ON SalesLT.Product.ProductCategoryID = SalesLT.ProductCategory.ProductCategoryID
ORDER BY SalesLT.ProductCategory.ProductCategoryID
```
5. Select column B (long name is ParentProductCategoryID), and then add a data filter to this column by clicking the **Add/Remove data filter** button on the **Worksheet Data** toolbar.

6. Then there will be a filter icon on the top left corner of the column header. Click on it, and then select **Equals...** from the context menu.

7. There will be a dialog open, just keep the default **Value** to be 0 and click **OK** button.

8. Select column C (LineTotal), then select menu **Statistics: Descriptive Statistics: Statistics on Columns** to open the **Statistics on Columns** dialog.
9. In the open dialog, set **Grouping Range** to be column B. You can just click the triangle button to select column P from list on the right.

10. Go to the **Plots** tab, check **Box Charts** checkbox.

11. Click **OK** button to get the results.
12. It's very easy to change filter condition and get updated statistics. E.g. go back to Sheet1. Double click on =1 and change to =2

13. Go to DescStatsOnCol1 sheet. The Recalculation lock turned yellow, meaning input changed. Click on it and choose Recalculate. Now the LineTotal of all products in parentCategoryID=2 shows.
You can click the Recalculation lock and set Recalculation Mode to Auto. When source data changes or filter changes, the statistics result will be updated automatically.

**9.4.3.3 Radar Plot**

1. **Statistics on Columns** tool also generates a flat result sheet which we can use to do further analysis or graphing.

2. Go to **DescStatsQuantities1** sheet.

3. Highlight column F (Sum) and select **Plot: Specialized: Radar** menu to make a radar plot.
4. Go back to DescStatsQuantities1 sheet and add filter on column B (Name) and exclude **Mountain Frames**, **Road Frames** and **Touring Frames**. Rescale the Axis to see more details of products with smaller sum of LineTotal values.
### SQL Editor for Database Analysis

#### Summary

The database used in this tutorial has been set up on Microsoft Azure.

This tutorial shows how to import data from database using SQL Editor, perform common operations such as column filtering and pivot table, and then use pivot table result to plot graph. Finally put graph in workbook so everything is inclusive that the workbook can be saved as an analysis template for future use.

The procedure is based on Origin 2023b.

#### What you will learn

This tutorial will show you how to:

- Use SQL Editor to import data from database
- Add column filter to only show products of interest.
- Create a pivot table for sum of LineTotal of different products in different States.
- Plot column graph to visualize the result.
- Insert the graph into the worksheet and save such self-contained workbook as analysis template.
- Load the analysis template and reimport data.

#### Steps

##### 9.4.4.3.1 Import Data from Database

1. Start a new project. Choose **Data: Connect to Database: New...** menu or click clicking the **Open SQL Editor** button on the **Database Access** toolbar.

2. Choose **Connection cting** radio button and click OK. Paste the Connection String below.

   ```
   Driver={SQL Server}; Server=olab.DATABASE.windows.net; Port=1433;
   DATABASE=sample1; Uid=Olabts; Pwd=Origin2023;
   ```

3. If you are using ODBC Drive 18 for SQL Server, use
4. Click the **OK** button to connection to the database.
5. Copy and paste the following query into the SQL Editor text box. The query shows data for the year 2003:

```
SELECT SalesLT.SalesOrderDetail.LineTotal,
       SalesLT.ProductCategory.Name,
       SalesLT.ProductCategory.ParentProductCategoryID,
       SalesLT.Address.StateProvince,
       SalesLT.Address.CountryRegion
FROM SalesLT.SalesOrderDetail
INNER JOIN SalesLT.Product
ON SalesLT.SalesOrderDetail.ProductID = SalesLT.Product.ProductID
INNER JOIN SalesLT.ProductCategory
ON SalesLT.ProductCategory.ProductCategoryID = SalesLT.Product.ProductCategoryID
INNER JOIN SalesLT.SalesOrderHeader
ON SalesLT.SalesOrderHeader.SalesOrderID = SalesLT.SalesOrderDetail.SalesOrderID
INNER JOIN SalesLT.CustomerAddress
ON SalesLT.CustomerAddress.CustomerID = SalesLT.SalesOrderHeader.CustomerID
INNER JOIN SalesLT.Address
```
6. Click the **OK** button to import data to workbook. By default the SQL is saved together with worksheet.

7. The icon on the top left of the workbook indicates the sheet contains an SQL query.

### 9.4.4.3.2 Filter Data

1. Origin has a data filter feature similar to Excel. We can use this feature to choose specific data for graphing and analysis without removing the rest of the data.

2. Select column C (ParentProductCategoryID) and column E (CountryRegion) and then click the **Add/Remove data filter** button on the **Worksheet Data** toolbar to add a filter on them.
3. Click the funnel icon on column E. From the list that appears, uncheck *United Kingdom* and click **OK**.

4. If a reminder message about hidden data appears, select the **Yes** radio button and click **OK**.

5. Click the funnel icon on column C, it shows Equals, Less than, .... numeric filter menus since the `ParentProductCategoryID` are treated as numbers.

6. Choose **Equals...** and enter **1** as Value. Click **OK**.

7. Now the worksheet only shows the sales of various Bikes in USA.
9.4.4.3 Create Pivot Table and Plot Column Graph

1. We can create a pivot table to see total sales of each bike type in different states.
2. With nothing selected in worksheet, select Restructure > Pivot Table
3. In the dialog that opens set Recalculation Mode to Auto. This will make the pivot table manipulation update if the data is re-imported from the SQL Editor.
4. Set the Row Source as Name.
5. Set the Column Source as StateProvince (the column with the filter on it).
6. In order to see the Total Sales, set the Summarize by option as Sum, and set the Pivot Table Data Source option that appears as LineTotal.
7. Click **OK**. A new worksheet is created named *Pivot1*. Rename it as *Summary*

8. Now highlight the pivoted data and click on the **Column Plot** button to create a column plot.
### Customize Graph and Create Analysis Template

The California Sales are much higher than other states, making it hard to see Utah sales column. Also we can customize the color and pattern of column/bars to make it more appealing.

1. Single click on any California bar. On the mini toolbar that shows, go to Single tab and click Plot on Right Y so California bars will be plotted against a right Y axis.
2. Double click the right Y axis title and set it as \%(1Y, @LC), which means use 1st Y plot’s Comments info. as Axis title. The right Y axis title will become California.

3. Double click the left Y axis title and set it as Others.

4. Double click on any Y Axis to open the Axis dialog.

5. Select both Left and Right on the left panel. On Scale tab, set the Rescale dropdown to Fixed From - Auto To.

6. Select Horizontal on the left panel. On Scale tab, set the Rescale dropdown to Auto.

7. Go to Tick Labels tab, Select both Left and Right on the left panel and set Display as Engineering:1k. Click OK.
8. Customize fill colors and patterns of columns, legend, horizontal tick labels, etc. e.g.

9.4.4.3.5 Add Graph in Worksheet and Save Analysis Template
1. Right click on Summary sheet tab and choose **Add Graph as Sheet:**[Graph1] to add the graph as a separate sheet in workbook.

2. If you need to customize the graph further, double click it to bring up the independent graph window again to customize. And then click the return button on graph window title to bring it back to worksheet.

3. Now workbook is self-contained with everything: database connection, data filtering, analysis (pivot table) and graph.

4. Choose **File: Save Workbook as Analysis Template...** and name it **LineTotal_By_State**

---

**9.4.4.3.6 Change Query and Re-import Data to Automatically Update Analysis**

1. Go to **File: Recent Books** menu to load the **LineTotal_by_State** you just saved. This will open a blank analysis template workbook.
2. Go to **Sheet1**. Click on the ![import](image) and click **Import** or click the **Import Data** button to reimport from database.

3. **Summary** sheet and **Graph1** sheet are both updated as well.

4. In the new workbook, click the funnel on column C and change check 2 only.
5. You can also click on the SQL Editor to modify the Query as well.

- You may need to manually reapply filter after reimport new data from Database, or choose Worksheet: Worksheet Script... menu. Check After Import checkbox and enter script `wks.runfilter()` so that everytime after import new data, all filters will auto apply.

- By default when you save project file (OPJU), the imported database data is excluded so that the OPJU file size will not be huge. But you can click on the and uncheck Exclude imported when saving so that data is kept with OPJU file.

- Or keep Exclude imported when saving checked but instead, click on and check Auto Import so that everytime the database data will auto import when reopen the OPJU file.

### 9.4.5 Update Database Importing By LabTalk Substitution

#### 9.4.5.1 Summary
The database used in this tutorial has been set up on Microsoft Azure.

This tutorial shows how to import data from database into Origin worksheet with defined LabTalk variable in SQL and plot a column graph from the imported data. Then modify the LabTalk variable and reimport database. The procedure is based on Origin 2023b.

9.4.5.2 What you will learn

This tutorial will show you how to:

- Import data using SQL Editor.
- Use LabTalk substitution in SQL statement.
- Make column plot.
- Update database importing by LabTalk substitution.

9.4.5.3 Steps

9.4.5.3.1 Import Data from Database

1. Start a new project. Choose Data: Connect to Database: New... menu or click clicking the Open SQL Editor button on the Database Access toolbar.

2. Choose Connection ctring radio button and click OK. Paste the Connection String below.

3. If you are using ODBC Drive 18 for SQL Server, use

   Driver={ODBC Driver 18 FOR SQL Server}; Server=olab.DATABASE.windows.net; Port=1433;

   DATABASE=sample1; Uid=Olabts; Pwd=Origin2023;
4. Click the OK button to connect to the database.
5. Copy and paste the following query into the SQL Editor text box. The query shows total sale of each product by specified company name.

```sql
SELECT SalesLT.ProductCategory.Name AS ProductName,
SUM(SalesLT.SalesOrderDetail.LineTotal) AS '%(company$)'
FROM SalesLT.SalesOrderDetail
INNER JOIN SalesLT.Product
ON SalesLT.Product.ProductID = SalesLT.SalesOrderDetail.ProductID
INNER JOIN SalesLT.SalesOrderHeader
ON SalesLT.SalesOrderHeader.SalesOrderID = SalesLT.SalesOrderDetail.SalesOrderID
INNER JOIN SalesLT.ProductCategory
ON SalesLT.Product.ProductCategoryID = SalesLT.ProductCategory.ProductCategoryID
INNER JOIN SalesLT.Customer
ON SalesLT.Customer.CustomerID = SalesLT.SalesOrderHeader.CustomerID
WHERE SalesLT.Customer.CompanyName LIKE '%(company$)'
GROUP BY SalesLT.ProductCategory.Name
```

6. To add a Labtalk string variable company, select Query: LabTalk... to open the LabTalk Support Setting dialog.
7. Check the **Enable LabTalk (%,$) substitution** checkbox.

8. Type the script below to define a LabTalk string variable **company**.

```
string company$ = "Professional Sales and Service";
```

9. in the **Before Query Script** box. Click **OK**.

10. 

11. Click the button to preview the SQL query string with LabTalk variable substituted in the SQL Editor box.
12. Click the **OK** button to import data to workbook. By default the SQL is saved together with worksheet.

13. The icon on the top left of the workbook indicates the sheet contains an SQL query.
9.4.5.3.2 Plot a Column Graph

1. Highlight column B and plot a column graph.
2. Turn on frame and grid. Turn off ticks and remove axis title. Rotate tick labels.
3. Click in white area within layer frame to select the layer and click Auto Rescale mini toolbar button so axis will auto rescale if new data comes in.
4. Click close upper edge of white space on graph and choose Add Page title mini toolbar button.
5. Enter %(1, @LA). This is the substitution to show 1st plot’s column long name.
6. Click on %(1, @LA) and click the Link to Substitution mini toolbar button to turn it on.
7. The long name of column B will be used as page title. We will get this final graph.
9.4.5.3.3 Update Database Importing By LabTalk Substitution

There may be multiple places in SQL with company info. The benefit of using LabTalk variable is that user only needs to change variable in LabTalk Support Settings dialog. All places with such variable will be substituted on execution.

1. Activate the worksheet with data from database above. Click Open SQL Editor button and SQL Editor opens again, with the saved settings.

2. Select menu Query: LabTalk to open LabTalk Support Settings dialog. Now, change to

```
string company$ = "Riding Cycles";
```

3. Click OK to go back to SQL Editor. Click OK to import to workbook. Graph will auto update.
But you will need to open the SQL Editor dialog everytime to change the variable values which is not convenient. A nicer way is to modify the LabTalk Support Settings to use global variables. Then we can modify the global variables outside SQL Editor and reimport.

1. Let's activate worksheet again and click to open SQL Editor.
2. Choose Query: LabTalk... menu and modify the LabTalk Support Settings as follows.

```plaintext
string company$ = ""; // For the first company substitution

if(exist(thecompany$, 18) == 18) // if thecompany$ exists
{
    company$ = thecompany$; // if yes, assign to company$
}
else
```
3. Click OK button to close the SQL Editor dialog.

4. Make sure the worksheet with database is the active window.
5. Select Window: Script Window menu to open Script Window.
6. Paste the following into Script window. Highlight all and press ENTER keyboard to run the commands.

```labtalk
string thecompany$ = "Action Bicycle Specialists"; // define global string variable thecompany$
dbimport; // import data from database
```

7. The data in worksheet and graph are updated.
Note:

1. "global" means the LabTalk variables can be "seen" and used by SQL Editor for the substitutions. Variables created without declaration (only allowed for types double, string, and dataset), e.g. e.g. `name$ = "Smith"` become Project variables and are saved with the Origin Project file.

2. The last `dbimport` LabTalk command is the same as clicking the **Import data** button on **Database Access** toolbar.

3. Use `string company$ = "%Supplies";` to find companies ending with **Supplies**. After substitution, the SQL will be like `WHERE SalesLT.Customer.CompanyName LIKE '%Supplies'`

### 9.4.6 Update Graph By Reimport Data From Database

#### 9.4.6.1 Summary

The database used in this tutorial has been set up on Microsoft Azure.

This tutorial is a continuation of previous Tutorial **Update Database Importing By LabTalk Substitution**. It shows how to add a button on graph with LabTalk script to open a **GetN dialog** to enter company name and reimport database based on the new company name and get updated graph.

The procedure is based on Origin 2023b.
9.4.6.2 What you will learn

This tutorial will show you how to:

- Add a button on the graph with script.
- How to create a simple dialog to get new input.

9.4.6.3 Steps

9.4.6.3.1 Add Button to Run LabTalk Script

1. Right click at bottom-right corner of the graph1 created by the previous Tutorial Update Database Importing By LabTalk Substitution. Choose Add Text.... And type Modify... to create a text label.

2. Right click on the text Update and choose Properties... context menu to open Text Object dialog. Go to Programming tab. Note: In versions before Origin 2017, choose Programming Control... from the menu to open the Programming Control dialog.

3. Set Script, Run After to Button Up, and put the following script to the bottom text box. Click OK.

```
string thecompany$="Professional Sales and Service"; //set first company name

//The following 3 lines create a dialog to assign new thecompany$ string value
getN

(Company Name) thecompany$ //(Company Name) will be edit box label in dialog

(Which Company to Analyze); //this is dialog title

dbimport iw:=[book1]sheet1!; //reimport data of new company from database to Sheet1 of Book1
```
4. The text object turns into a button

5. The text object turns into a button

6. Use Button to Modify the Import
1. Click the Modify... button and enter new company name **Riding Cycles**

   ![Image of company selection dialog]

   **Which Company to Analyze**

<table>
<thead>
<tr>
<th>Company Name</th>
<th>Riding Cycles</th>
</tr>
</thead>
</table>

   ![Image of company selection dialog]

   ![Image of company selection dialog]

   ![Image of company selection dialog]

2. Click **OK**. Data will be reimported into sheet1 of Book1 and the graph will be auto updated.

3. To see all company names and total number of orders. Right click Sheet1 tab and choose **Duplicate Without Data** to create Sheet2.

   ![Image of Sheet2 with data]

   Click the **SQL Editor** on Sheet2 and choose **SQL Editor**.

   Modify the Query to be

   ```sql
   SELECT SalesLT.Customer.CompanyName, 
   SUM(SalesLT.SalesOrderDetail.OrderQty) AS OrderCounts
   ```
FROM SalesLT.Customer

INNER JOIN SalesLT.SalesOrderHeader

ON SalesLT.SalesOrderHeader.CustomerID = SalesLT.Customer.CustomerID

INNER JOIN SalesLT.SalesOrderDetail

ON SalesLT.SalesOrderHeader.SalesOrderID = SalesLT.SalesOrderDetail.SalesOrderID

GROUP BY SalesLT.Customer.CompanyName

ORDER BY SUM(SalesLT.SalesOrderDetail.OrderQty) DESC

4. Click OK. All company names and total order numbers show so user can easily refer to this sheet when modifying to another company name to reimport.

9.5 Digitizer

9.5.1 Digitizer

- Digitizer Tool
9.5.2 Digitizer Tool

9.5.2.1 Summary

The Digitizer helps you to capture data from images of graphs. You can import image files of graphs into Origin and digitize data points one by one.

9.5.2.2 What you will learn

- How to capture data from images of graphs using the Digitizer Tool.
- How to modify the position of the picked points
- How to delete the extra points

9.5.2.3 Steps

9.5.2.3.1 Capture data points

1. Select Tools: Digitizer... from the main menu to open the Digitizer dialog.

2. Click the Import button on the dialog box toolbar, and select the Digitizer_image.png under <Origin EXE folder>\Samples\Import and Export\ path. The image is imported. Note that there are two pairs of XY axes showing in the image; one red and one blue.
3. Click on the **Rotate Image** button (dialog box toolbar), and click the button << to slightly rotate the image in the counter-clockwise direction. Note that the rotation increment can be specified in << >> **Increment (degree)** the text box.
When the graph axes in the image are aligned along the bottom/top and left/right edges, click once more on the Rotate Image button, to leave Rotation mode.

4. Click on the Edit Axes button in the dialog. Using your mouse, drag the two pairs of axis lines so that they coincide with minimum and maximum axis values. Note that when a line is selected, its corresponding row in the Digitizer dialog is also selected. Enter the appropriate coordinate value (0, 8, -20, 120) in the Axis Value column.
After locating the axes, click the **Manually Pick Points** button. Move the cursor sequentially over the points in the phosphorus plot (filled symbol), double-clicking on each point (or single-click and press Enter). The **GetPoints** dialog displays coordinate values, while the Data Display window shows image pixel values.
6. When you have added all points for the phosphorus plot, click the **Done** button.

![Digitize1 - Digitizer_image.png](image)

7. Click on the **Go to Data** button to show the resulting worksheet which contains the values of picked data points.

![DigiData](image)

<table>
<thead>
<tr>
<th>A(X)</th>
<th>B(Y)</th>
<th>C(L)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.99465</td>
<td>4.33741</td>
<td></td>
</tr>
</tbody>
</table>

8. Click on the **Go to Image** button to return to the original image. Click on the **New Line** button to start digitizing the second plot (potassium = open symbol). Note that two new columns of data points are created in the result worksheet.

![Digitizer_image.png](image)
9. Click on the **Manually Pick Points** button to get the points for the second plot, repeating the procedures followed in steps 5 and 6.

10. Click on the **Go to Data** button and two datasets result shows in the worksheet.

11. Click on the **Go to Image** button. This takes you to your imported image file. Click on the **Go to Graph** button and note that this opens a graph window containing plots of your digitized data points.
12. When you close the Digitizer dialog, a Digitizer... button appears on the image. Clicking on the button, you can reopen the Digitizer dialog.

9.5.2.3.2 Move and delete the picked points

Following the steps in the above section, you will easy to get the points from the image. But if the picked points are on the incorrect position or extra, as point A and B in the below image, you can modify or
delete them.

1. To modify the position of point A, click on it and move the cursor to the correct position. Or you can use Arrow keys to move the selected point.

2. To delete the point B, click to select it and right-click to choose Delete in the context menu. Or you can press Delete key to delete the selected point.
9.5.3 Enhanced Digitizer

The Enhanced Digitizer supports auto tracing and digitizing in 2D Cartesian, polar and ternary coordinate systems.

**NOTE**: The Enhanced Digitizer is built into Origin 2015 SR0 and later versions. If you are running Origin 9.1, the Enhanced Digitizer is available as an add-on tool from the OriginLab File Exchange. The Enhanced Digitizer is not supported by versions prior to Origin 9.1 SR1.

9.5.3.2 What You Will Learn

This tutorial will show you how to:

- Set axes in the image.
- Manually and automatically capture data points.
- Set axes for polar and ternary coordinate systems.

9.5.3.3 Steps

9.5.3.3.1 Import Image and Clear Gridlines

1. Select the **Digitize Image** button on the **Standard** toolbar.
2. Browse to the folder `<Origin EXE Folder>`\`Samples\Import and Export` and open `TwoPeaks.bmp`. There are three line plots in the image: the black plot is the baseline and the red and blue plots are spectra.

3. In the Digitizer dialog, there are hints at the bottom of the Axes tab to guide you through each step.
4. Select **Image:Remove Cartesian Gridlines** to remove the gridlines. You can also choose **Image: Rotate...** and **Image: Clear Background** menus to rotate the image and clear background noise and color fills.

### 9.5.3.3.2 Edit Axes

Before capturing data points, you need to setup axes on the image so that there is a reference for calculating the XY coordinates of the data points that will be captured later.

1. Click the **Edit Axes** button or make sure it is pressed.
2. Four lines will appear framing the image. Drag each line so that it lines up at a location where you know the axis values and enter the axis value in the corresponding row in the Digitizer dialog.

   Use the Zoom and Pan button on the **Tools** toolbar or hold down **A** and use the mouse wheel to zoom in and pan the image. Then fine tune the line location. Press **Ctrl+W** to restore the original image size.
3. After editing Axes, you can right click and save Axes settings in order to load them in the future for similar images.

### 9.5.3.3 Capture Data Points

Besides the **Manually Pick Data Points** method, the Enhanced Digitizer provides four automatic digitizing methods to capture data points. They are all under the **Digitize** menu and have corresponding buttons.

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually Pick Points</td>
<td><img src="image1.png" alt="Icon" /></td>
<td>Double click on every spot you want to capture a point.</td>
</tr>
<tr>
<td>Auto Trace Line By Points</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Double click on a curve on the image and data points will automatically be captured along the curve.</td>
</tr>
</tbody>
</table>
### Tutorials for Origin 2024b

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Pick Points By Grids</strong></td>
<td>Drag a rectangle on a desired area of the image and data points will be captured where ever the gridlines in rectangle intersect with the image curve.</td>
</tr>
<tr>
<td><strong>Area Auto Trace</strong></td>
<td>This is a hybrid of the previous two methods. Drag a rectangle on a desired area of the image. Data points will automatically be captured along the curve.</td>
</tr>
<tr>
<td><strong>Boundary-Limited Area Auto Trace</strong></td>
<td>Similar to the Auto Trace Area button except that points are created only within the selected area.</td>
</tr>
</tbody>
</table>

#### 9.5.3.3.3.1 Manually Pick Points

Let’s manually capture some points on the red line.

1. **Click the Manually Pick Points button.**

   ![Digitizer dialog](image)

2. Double click on the red curve to pick a point.

   The Magnifier window on the Data tab of the Digitizer dialog provides a blown up view of where the cursor is. You can also use the Zoom and Pan tool mentioned in the Edit Axes section to zoom and pan the image to pick points more precisely.

3. Pick several more points and click the Done button. The Number of Points on Line 1 of the Data tab shows the number of points that were captured for Line 1.
If you want to move or delete a captured point, click the captured point in the image to select it. Use the arrow keys on the keyboard to move the point or press the **Delete** key to delete it.

You can click the **Manually Pick Points** button again to pick more points for line 1.

9.5.3.3.3.2 Auto Trace Line by Points

Multiple digitizing methods can be used on same line as long as the line is highlighted on the **Data** tab of the Digitizer dialog. Let's pick more red points for Line 1 using the **Auto Trace Line by Points** method.

1. Click the **Auto Trace Line by Points** button.
2. Double-click on red points to the left side of the peak and the right side of the peak. Every time you double click a point, Origin auto traces to find more points along the curve. Click the **Done** button.

![Graph showing a peak with red points on both sides.](image_url)

3. There are in total 122 points captured on the red line.

<table>
<thead>
<tr>
<th>Line</th>
<th>Number of Points</th>
<th>Pixel Reduction Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>122</td>
<td>&lt;auto&gt;</td>
</tr>
</tbody>
</table>

4. Click the **Go to Data** button to see the results in a worksheet.

![Worksheet showing X, Y, and L columns.](image_url)
9.5.3.3.3 Auto Pick Points by Grids

Next let's use the **Auto Pick by Grids** method to digitize the black baseline.

1. Activate the image window.
2. Click the **New Line** button. The **Data** tab will start a new row for Line 2.
   
   Note: All plots in this image use the same XY axis so we don't need to edit the axes again. However, in case you have images with multiple axes, you can setup a new axis for each new line of data.
3. Select the **Auto Pick Points by Grids** button.
4. Click and drag to create a rectangle on a portion of the black baseline as shown below:
Some points on the red and blue lines are captured as well.

5. To remove unwanted points, click the **Delete Points** button.
6. Drag a rectangle box over the unwanted points and release the mouse button to delete them.

With this method, only 57 points are captured.
7. If you are not satisfied with the result, click the **Delete Line** button to delete Line 2 on the Data tab of the Digitizer dialog and click the **New Line** button to start over.

You can use the **Settings: Digitize Settings...** menu to customize the grids density.

9.5.3.3.3.4 Area Auto Trace/Boundary-Limited Area Auto Trace

Let's use these two methods to digitize the blue line.

1. Click the **New Line** button.
2. Click the **Area Auto Trace** button.
3. Click and drag a rectangle over some part of the blue curve. Points will be auto created along the blue curve beyond the rectangle.

4. Select the **Boundary-Limited Area Auto Trace** button.
5. Click and drag a rectangle over some part of the blue curve. Points will be auto created only within the rectangle you drew. Unlike in the **Auto Pick Points by Grids** method, the **Boundary-Limited Area**
Auto Trace method creates more points than just where the curve intersects with the grids.

6. Click the Reorder Points button to set the captured points in order.

7. Click the Set Label button.

8. Click on the selected peak point of blue line and press the Enter key.

9. Enter Blue Peak in the dialog to add a label to the peak of the blue line.

10. To add another label on the peak of the digitized red line, click the Set Label button again to release it first.

11. Select Line 1 to show digitized red points on the Image. Repeat the same process, this time set the label as Red Peak.
12. Select the **Go To Data** button. You can see the Labels added are in corresponding Label rows.

<table>
<thead>
<tr>
<th></th>
<th>A(X1)</th>
<th>B(Y1)</th>
<th>C(L1)</th>
<th>D(X2)</th>
<th>E(Y2)</th>
<th>F(L2)</th>
<th>G(X3)</th>
<th>H(Y3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Name</td>
<td>PickedDat</td>
<td>PickedDat</td>
<td>PickedDat</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Data for the Red Curve</td>
<td>Data for the black Curve</td>
<td>Data for the Blue Curve</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F(x)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Type</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
<td>Linear Scale</td>
</tr>
<tr>
<td>19</td>
<td>18.75201</td>
<td>0.59941</td>
<td>19.26297</td>
<td>0.12288</td>
<td>16.70818</td>
<td>0.29722</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>18.92233</td>
<td>0.71564</td>
<td>20.96617</td>
<td>0.11126</td>
<td>17.73009</td>
<td>0.26235</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>18.92233</td>
<td>0.77376</td>
<td>22.66936</td>
<td>0.09963</td>
<td>18.92233</td>
<td>0.24492</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>19.09255</td>
<td>0.83187</td>
<td>24.37256</td>
<td>0.08801</td>
<td>20.45521</td>
<td>0.2333</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>19.09205</td>
<td>1.00021</td>
<td>20.07576</td>
<td>0.08801</td>
<td>22.1584</td>
<td>0.22167</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>19.26297</td>
<td>0.9481</td>
<td>27.77695</td>
<td>0.09963</td>
<td>23.0616</td>
<td>0.22167</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>19.26207</td>
<td>0.88998</td>
<td>29.48215</td>
<td>0.09963</td>
<td>25.5648</td>
<td>0.21586</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>19.43329</td>
<td>1.12244</td>
<td>31.18534</td>
<td>0.10545</td>
<td>27.25799</td>
<td>0.23911</td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>19.43329</td>
<td>1.06433</td>
<td>32.88854</td>
<td>0.12689</td>
<td>28.97119</td>
<td>0.26816</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>19.60361</td>
<td>1.29578</td>
<td>34.59174</td>
<td>0.14031</td>
<td>29.93111</td>
<td>0.29141</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>19.60361</td>
<td>1.25029</td>
<td>36.29493</td>
<td>0.14613</td>
<td>30.8447</td>
<td>0.33209</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>19.60361</td>
<td>1.18055</td>
<td>37.99813</td>
<td>0.12869</td>
<td>31.35566</td>
<td>0.38439</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

13. With the image window active, click the **Go To Graph** button.

All the curves resulting from the picked points will show in one graph window.
14. You can save the project with the Digitizer in it. When you open the project in the future, there will be a Digitizer... button on the image and you can click it to continue Digitizing.

9.5.3.3.4 Set Axes for Polar and Ternary Plots

The following section only explains how to define axes for images with polar or ternary coordinate systems using the Enhanced Digitizer. Once the axes are defined the same methods outlined above can be used to digitize the image.

9.5.3.3.4.1 Polar Coordinates

1. Click the Import button in the Digitizer dialog.
2. Browse to the `<Origin EXE Folder>\Samples\Import and Export folder` and select **PolarCoordinate.bmp**. The data plots in this image are in the polar coordinate system.

3. By default the Digitzer uses the Cartesian Coordinate system. Select **Axes:Polar Coordinate...** menu to open the **Polar Coordinate Settings** dialog box.

4. We can accept the default orientation and theta unit and click **OK**. Two line objects with anchor points show on the image.
To set the axes for polar coordinates, we need to make sure each line object follows the same radius line, i.e. $P_1$ & $P_2$, or $P_3$&$P_4$ need to be at the same angle.
5. Drag each line's anchor points to known positions. Note: You can press the `Space` key to make the cursor bigger so that it is easier to locate the desired position.

6. Enter the corresponding **Theta** and **Radius** values on the Axes tab of the Digitizer.

![Ternary Coordinate Diagram]

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Theta</th>
<th>Radius</th>
<th>Image Pixel</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>(355, 247)</td>
</tr>
<tr>
<td>P2</td>
<td>0</td>
<td>20</td>
<td></td>
<td>(512, 247)</td>
</tr>
<tr>
<td>P3</td>
<td>90</td>
<td>5</td>
<td></td>
<td>(301, 194)</td>
</tr>
<tr>
<td>P4</td>
<td>90</td>
<td>20</td>
<td></td>
<td>(301, 37)</td>
</tr>
</tbody>
</table>

9.5.3.3.4.2 Ternary Coordinate

1. Click the Import button in the Digitizer dialog.
2. Browse to the `<Origin EXE Folder>\Samples\Import and Export folder` and select **TernaryCoordinate.bmp**. The data plots in this image are in the ternary coordinate system.
3. Select **Axes: Ternary Coordinate...** to open the **Ternary Coordinate Settings** dialog.

4. Specify the **Axes Orientation** and **Range of Variables** (i.e. whether the ternary plot is normalized to 0 - 1 or 0 - 100). For this example, accept the default settings and click **OK**. Three anchor points are added to the image.

5. Drag these three points to the three vertices of the ternary plot.
6. Similarly to the polar coordinate anchor point control, the row of selected anchor points in the graph will be highlighted on the Axes tab:

![Axes Tab Image]

7. The Axes Values of each point are X Y Z respectively. The X, Y, Z values of P1 in the ternary image are 0 0 1 because P1 is at the end of the Z axis. Similarly P2 and P3 lie at the end of the X axis and the Y axis, so the X, Y, Z values should be 1 0 0 and 0 1 0 respectively. Logically therefore, P1, P2 and P3 can’t be same values.
10 Exporting and Presentation

10.1 Exporting and Presentation

10.1.1 Exporting

- Exporting Graphs

10.1.2 Presentation

- Pasting or Embedding Graphs in Other Applications
- Send Graphs to PowerPoint

10.2 Exporting

10.2.1 Exporting

- Exporting Graphs

10.2.2 Exporting Graphs

<table>
<thead>
<tr>
<th>Videos</th>
<th>OriginBlog</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Exporting Graphs</td>
<td></td>
</tr>
<tr>
<td>- Export or copy and paste a selected area of graph</td>
<td></td>
</tr>
<tr>
<td>- Exporting the Selected Region of a Graph</td>
<td></td>
</tr>
<tr>
<td>- Master Page</td>
<td></td>
</tr>
<tr>
<td>- Video Animation</td>
<td></td>
</tr>
<tr>
<td>- Merging and Exporting Embedded Graphs In Worksheet</td>
<td></td>
</tr>
<tr>
<td>- Introducing the LaTeX App</td>
<td></td>
</tr>
<tr>
<td>- How to run Origin periodically using Windows Task Scheduler</td>
<td></td>
</tr>
</tbody>
</table>

10.2.2.1 Summary

When you have completed your graphs for publication, exporting your final results is very easy with Origin. The graph export is highly customizable. You can specify the size of the image, the file format, and other advanced settings such as color format.
10.2.2.2 What you will learn

- How to export a graph and specify the settings.
- How to export specified graphs in the project.

10.2.2.3 Export a graph as an eps image

This tutorial is associated with the XYZ Contour project (C:\ProgramData\OriginLab\(version number)\Origin\Central\Graphing\Contour Plots - XYZ Contour.opju). You can also open Learning Center, select Contour Plots plot type and then double-click on the icon of XYZ Contour graph to open this project.

1. With the project opened, activate the graph window below.

![XYZ Contour](image)

2. Select File: Export Graphs : Open Dialog from the Origin menu to open the expGraph dialog.
3. Click the **Auto Preview** check box. Then the graph will auto preview the temporary copy in the right panel of the dialog.

4. Specify the following settings to export the graph:
   - Customize the **File Name** to **My Graph**.
   - Expanding the **Export Settings** node, select **Border** from the **Margin Control** drop-down list and type **3** in the **Clip Border Width** box.
   - Expanding the **Image Size** node, uncheck **Auto** check box for **Fit Width** and set width to **5**.
5. Click the triangle button to the right of the **Dialog Theme**. Select **Save As** from the shortcut menu. The **Theme Save as** dialog opens.

6. In the **Theme Save as** dialog, enter **My EPS Export** as Theme Name. And click OK.
7. Click the **OK** button in the **expGraph** dialog, then *My Graph.eps* is created in your **User File Folder**. And the graph path will display in the **Message Log**.

![Message Log](image)

8. Repeat export a graph using the setting from above, select the theme **My EPS Export** in the fly-out menu of the export graph tool directly.

![Fly-out menu](image)

Or

Click the right-sided triangle button to the right of the Dialog Theme in the **expGraph** dialog. From the shortcut menu, pick **My EPS Export**. The settings from that theme will then be loaded in the dialog.

![Shortcut menu](image)

In the last couple of steps, you saved your custom export settings as an external Theme file and learned to apply that Theme from the **expGraph** flyout menu. Beginning with **Origin 2021**, export settings are automatically saved with the graph on export. If you are are not exporting your graph immediately, you can save settings by clicking on the **Dialog Theme** flyout menu and choosing **Save to <Graph>**.
1. Open the sample project file **Column and Bar.opju** under the sample folder `<Origin EXE folder>\Samples\Graphing`.

2. In the **Project Explorer**, click on the folder "Column_Plot_with_Baseline_Y=0.5" and activate the graph window in it.

3. Select **File: Export Graphs** to open the **expGraph** dialog, in the dialog, select **Portable Network Graphics(*.png)** for **Image Type**.

4. Select **Specified** from the **Select Graph(s)** drop-down list. Click the **...** button to the right of the **Graph Page** edit box to open the **Graph Browser** dialog.

5. In the **Graph Browser** dialog, all the graphs in this project will list in the left panel of the dialog. Select **Graph8** in the left panel, then the preview panel will show a preview of the graph.
6. Click the button to add the selected graph to the right panel, or double-click selected graph in left panel to add to the right panel.

7. Then click OK button, the specified graphs will show in the Graph Page box. Expanding the Image Size node, select pixel from the Specify Size in drop-down list. And uncheck the Auto check box for Fit.
Width and set width to 600.

8. Click OK button in the expGraph dialog, then two images are created. And the graph path will display in the Message Log.

```
[5/23/2019 15:44:01 expGraph]
Graph4 is exported to C:\Users\shirley\Documents\OriginLab\User Files\My Graph.epc

[5/23/2019 16:02:53 expGraph]
Graph1 is exported to C:\Users\shirley\Documents\OriginLab\User Files\Column_Plot_with_Baseline_Y=0.5.png
Graph8 is exported to C:\Users\shirley\Documents\OriginLab\User Files\Column Width Set by Another Variable.png
```
10.3 Presentation

10.3.1 Presentation

- Pasting or Embedding Graphs in Other Applications
- Send Graphs to PowerPoint

10.3.2 Pasting or Embedding Graphs in Other Applications

10.3.2.1 Summary

It is possible to insert Origin graphs to other applications (e.g., Microsoft® PowerPoint/Excel/Word), either by object linking or embedding. Both linked and embedded graphs can be later edited with Origin.

The difference is that embedded graph is contained in the destination file while the linked graph is not. A linked graph can be dynamically updated if the source graph is changed.

OLE embedding is not supported by Origin’s Master Page feature. When exporting graphs containing master items to MS Office or other documents, you should insert the graph as an image. For more information, see Adding common elements to an MS Word or PowerPoint file.

10.3.2.2 What you will learn

This tutorial will show you:

- How to copy and paste the graph to Word as a linked graph.
- How to copy and paste the graph to Word as a embedded graph
- How to edit linked/embedded graphs after inserting to Word.
10.3.2.3 Steps

1. Launch Origin, open the OffsetY.opj project from `<Origin program folder>\Samples\Graphing`. This project contains a graph (Graph 1).

![Graph1](image)

2. With the graph window active, select **Edit: Copy Page**.

Another menu option **Copy Graph as Picture** are also available. You can select it to insert the graph into Word (or other applications) as a picture. Then, you are not allowed to edit it with Origin anymore.
3. Create a blank page in Microsoft® Word (Here, I am using Word 2010). In the **Home** tab, select **Paste Special...** under the **Paste** option.

4. In the **Paste Special** dialog, select the **Paste link** radio button and then choose **Origin Graph Object** in the **As** list. Click **OK** to close the dialog.

The graph will be inserted to current position a linked object.

5. Open the **Paste Special** dialog again similarly as the previous step.
6. This time, select the Paste radio button then choose **Origin Graph Object** in the As list. Click OK to close the dialog. The graph will be pasted again, but as an embedded object.

7. Go back to the OffsetY.opj file in Origin, double click on the olive dot plot in Graph 1, bring up the **Plot Details** dialog, change the symbol color to **Violet** and click OK to close the dialog.

8. Now switch to Word file we just created, right-click on the first graph (the linked one), and choose **Update Link** from the fly-out menu. The color of the dot plot in this graph will be changed to violet.

9. Right-click on the second graph (the embedded one), and choose **Graph Object: Edit** to reopen the graph in Origin. Note that the graph name is **Graph in Document1**, indicating that the graph is contained in the
10. In the **Graph in Document1**, change the color of olive dot plot to blue similar as previously, and close Origin. Note that the linked graph and the embedded graph looks different now.

### 10.3.3 Send Graphs to PowerPoint
10.3.3.1 Summary

This tutorial will show you how to send a selection of graphs to an existing PowerPoint file. You will insert graphs starting from a specified slide and also copy that slide style, logo, layout, etc. The user will not need to create a Slide Master in PowerPoint beforehand.

Minimum Origin Version Required: 2021b

**Note:** This tutorial can actually be worked in Origin 2018b and later. Instead of clicking on the Send Graphs to PowerPoint button to launch the dialog, open the Apps Gallery at the rights-side of your workspace and look for and open the Send Graphs to PowerPoint App. If you don't see this App in the Gallery, press F10 and search on “powerpoint.”

10.3.3.2 What you will learn

This tutorial will show you how to:

- Send specified graphs to existing PowerPoint file.

10.3.3.3 Steps

This tutorial is associated with the Column and Bar project: `<Origin EXE Folder>\Samples\Graphing\Column and Bar.opju` and the PPT file: `<Origin EXE Folder>\Samples\Import and Export\Column_Plots_in_Sample_OPJ.pptx`

We are going to send most graphs in **Column and Bar** project to the above PPT file which consists of four slides: 1st slide is title; 2nd slide is table of contents; 3rd slide is blank; 4th slide is End page. All the sent graphs will be inserted into this PPT file starting from the 3rd slide and using the same style as starting slide.

1. Open the sample project **Column and Bar**

2. Click the Send Graphs to PowerPoint button and open the dialog box.

3. Click the **Select Graphs** button and choose **Specified**. This opens the Graph Browser.
4. In this dialog, select **Active Folder (Recursive)** for the top-left drop-down list, and then select all graph listed in the left panel except **Graph 5B**, click the right arrow button to move them to right panel as below, then click **OK**:

5. Selected graphs are listed in the left-panel. Note that you can drag graph thumbnails to change their order.
6. Recreate the following dialog box settings:

7. Click the browse button beside the **Load File/Template**(optional) box and browse to and select `<Origin EXE Folder>\Samples\Import and Export\Column_Plots_in_Sample_OPJ.pptx`.

8. In the **Save File As**(optional) box, specify a path to save the new pptx file (your User Files Folder is a convenient location), then click the **Send** button.
9. PowerPoint will open momentarily, the slide set will be processed and the program will then close. You can browse to and open the PowerPoint file.

At the top of the Send Graphs to PowerPoint App dialog, there are two useful but easily-overlooked tabs. The "Save" tab has controls for naming and saving the current App dialog settings, as well as setting them as default. The "Settings" tab has controls for selecting and applying default settings (System Default Settings) or last used settings, or applying a named group of settings. Additionally, you can delete unneeded settings from this tab.
11 Programming

11.1 Programming

11.1.1 LabTalk

- Get Started with LabTalk
- LabTalk Language Fundamentals
- Range Notation in LabTalk
- Objects in LabTalk
- Use X-Function in LabTalk
- Debug LabTalk Script
- Graphing and Exporting with LabTalk
- Mathematical Analysis with LabTalk
- Curve Fitting and Batch Processing with LabTalk
- Peak Analysis with LabTalk
- Statistics with Labtalk
- Signal Processing with LabTalk
- Creating OPX for Custom Tools with Labtalk

- How to share Origin C based LabTalk Functions

11.1.2 Origin C

- Introduction to Origin C and Code Builder
- The Code Builder Workspace
- Adding New Origin C Functions to Origin
- Organizing and Accessing Origin C Functions
- Tutorial: Calculating Double Integral with NAG Functions From Origin C
- Tutorial: Calling NAG Functions From Origin C
- Accessing Internal Origin Objects by Origin C
- Create and Update Apps for Origin

11.1.3 X-Functions

- Command Window and X-Functions
11.2 LabTalk

11.2.1 LabTalk

This tutorial will show you how to share code with other users by distributing OPX files. In this example, only Origin C files are distributed. However, please note that OPX distribution can include any file types including (but not limited to) project files, templates and toolbars.

1. Create File Locations

   The Source Path for your files should be available on any computer your OPX is targeted for. The easiest way to do this is to make a subfolder of the Origin UFF. Any of the files and folders of the UFF

   - Introduction to X-Functions
   - How to Create a Wizard

11.2.2 How to share Origin C based LabTalk Functions

11.2.2.1 Introduction

11.2.2.2 Tutorial

The following procedure will show you how to distribute your Origin C code to other Origin users. In this example, we will be packaging an Origin-C function in a file (MyCode.c) in a folder (MyFunctions) under the User Files Folder (UFF).
can then be added to your OPX for distribution. So, create a subfolder named *MyFunctions* under the *UFF*.

2. Copy Files to the Source Path

Copy all the files to be packaged to the subfolder created in the last step. Here there is only a C file (*MyCode.c*). The function in this file is shown below.

```c
void get_data_from_wks()
{

    Worksheet wks = Project.ActiveLayer();

    if( !wks )
    {

        out_str("Please keep a worksheet active with data");

        return;
    }
}

    // The following settings to set range as whole worksheet,
    // index offset is 0, -1 means last row/column.
    // Change r1, c1, r2, c2 to specify worksheet sub range,
    // for example, r1 = 0, c1 = 1, r2 = -1, c2 = 2 to
    // select all rows from column 2 to column 3.

    int r1 = 0; // first row
    int c1 = 0; // first column
    int r2 = -1; // last row
```
int c2 = -1; // last column

// construct a data range object from worksheet all data
DataRange dr;

dr.Add("X", wks, r1, c1, r2, c2);

// get data from worksheet to vector by column one by one
matrix mData;

dr.GetData(mData); // get all data to matrix

for(int nColIndex = 0; nColIndex < mData.GetNumCols(); nColIndex++)
{
    vector vOneCol;

    mData.GetColumn(vOneCol, nColIndex);

    double min, max;

    vOneCol.GetMinMax(min, max);

    printf("Maximum value of %d column = %f\n", nColIndex+1, max);
}
}
3. Create a Package

Open the **Package Manager** by selecting **Tools: Package Manager**.... Then fill in the dialog as the following image shows.

- **Module Name** will appear as the name of the package for uninstall purposes.
- **Origin Version Required** means the minimum version of Origin required for this package. You want to enter the version number like 8.0988, and not like 8.0SR6.
- To force the Origin C source file to the System Folder Workspace, use the `run.addoc()` method in the **After Installation** branch of **LabTalk Script**. In this example, it looks like the following:

```labtalk
run.addoc(%MyFunctions\MyCode.c);
```

- Click the **Add Files** or the **Add Folder** button and browse to and add any files required. In this example, browse to the subfolder (`MyFunctions`) under the **UFF** and add the C file (`MyCode.c`). Then the path of the **UFF** will show as the source path, and the files will list in the lower panel.
4. Save the Package

Select the File: Save menu of this Package Manager dialog. In the pop-up Save As dialog, enter a name (in this example, can be MyCode) for this package, and then save it as an OPX file.

5. Distribute the Package

Send the saved OPX file to other users. The user who gets this package can drag and drop the OPX onto Origin to install it, and then the functions in the C file are available.

- Drag and drop MyCode.opx onto Origin to install it. After installation, the function get_data_from_wks defined in MyCode.c can be used as a LabTalk command.

```labtalk
get_data_from_wks;
```

### 11.3 Origin C

#### 11.3.1 Origin C

- Introduction to Origin C and Code Builder
- The Code Builder Workspace
- Adding New Origin C Functions to Origin
- Organizing and Accessing Origin C Functions
- Tutorial: Calculating Double Integral with NAG Functions From Origin C
- Tutorial: Calling NAG Functions From Origin C
- Accessing Internal Origin Objects by Origin C
- Create and Update Apps for Origin

#### 11.3.2 Introduction to Origin C and Code Builder

- Centralizing OriginC Files on a Network
11.3.2.1 **Summary**

**Origin C** supports a nearly-complete ANSI C language syntax as well as a subset of C++ features including internal and DLL-extended classes. In addition, Origin C is "Origin aware". This means that Origin objects such as worksheets and graphs are mapped to classes in Origin C, allowing direct manipulation of these objects and their properties from Origin C.

Origin C's integrated development environment (IDE) is called Code Builder. Code Builder provides standard tools for writing, compiling, and debugging your Origin C programs. Once an Origin C function is compiled and linked, the function can be called in various ways from the Origin or Code Builder workspaces.

To open Code Builder, click the button on the Origin Standard toolbar, or press ALT + 4 from the keyboard.

**Minimum Origin Version Required:** Origin 9

11.3.2.2 **What you will learn**

This tutorial will show you how to:

- Create an Origin C function.
- Debug and Run the Function.
- Run the Function Using the Custom Routine Button.

11.3.2.3 **Steps**

11.3.2.3.1 **Create an Origin C Function**

1. In Code Builder, start with a new workspace (**File: New Workspace...**). On the Code Builder **Standard** toolbar, click the **New** button to open the **New File** dialog.

2. Select **C File** to create a .c file. Type **Tutorial** in the **File Name** text box. In the **Location** text box, specify the **User Files Folder/OriginC** folder to save your source file. Make sure that the **Add to** **Workspace** box is checked. Click **OK**. A file named Tutorial.c is created and opened in the Code Builder workspace.
4. Copy and paste the following code beneath the line that reads "// start your functions here."

```cpp
void new_wks()
{
    Worksheet wks;
    wks.Create("Origin"); // create a Worksheet window with template - Origin

    vector& vecX = wks.Columns(0).GetDataObject();
    vector& vecY = wks.Columns(1).GetDataObject();

    vecX.Data(1, 10, 1);
    vecY.Data(0.1, 1, 0.1);
}
```
Programming

vector<string> vsLongName =
{
    "Index",
    "Data"
};

for (int nCol = 0; nCol < wks.GetNumCols(); ++nCol)
{
    Column col (wks, nCol);
    col.SetLongName(vsLongName[nCol]);
}

5. This new_wks function will create a worksheet using the Origin template. It fills the first column with numbers from 1 to 10, incrementing by 1. The second column is filled with numbers from 0.1 to 1, incrementing by 0.1. Lastly, it sets the Long Names of the first and second columns as Index and Data, respectively.

6. Click the Save button  

Mini-Tutorial: Find more examples of the usage of GetDataObject and use a bookmark to quickly navigate to a marked line.

1. Click line 33 and click the Toggle Bookmark button 
2. Select GetDataObject() in line 37 and click the Find in files button 
3. In the Find in Files dialog box, set In files/file types as *.c,*.cpp and In folder as <program folder>\OriginC. Check all the boxes in this dialog and click the Find button.
4. In the Find Results window, double-click any line containing GetDataObject(). This opens the file containing this string and jumps to the related section.
5. To back to the line marked in step1 activate the Bookmarks window. Double click
the bookmark added in step 1 of this mini-tutorial and the cursor jumps to line 33 in the Tutorial.c file.

**Origin 2015 provides some useful tools:**

- **Quick open files**
  Prss SHIFT + ALT + O or select **Tools: Quick Open Files** to open the **Quick Open Files** dialog.

- **Switch between .h and .c/.cpp file**
  When open a .h file, press CTRL + ALT + O to open the corresponding .c or .cpp file, and vice versa.

- **Find symbols**
  Press SHIFT + ALT + S or select **Tools: Find Symbols** to open the **Find Symbols** dialog.

### 11.3.2.3.2 Debug and Run the Function

1. On the Code Builder **Standard** toolbar, click the **Build** button. This compiles the new \_wks function and performs linking (Please make sure the **Tutorial.c** file is active).

2. Click the space just to the left of lines 34, 35, 37, 50. A red ball icon will be placed at the beginning of each line, indicating that you added breakpoints to these lines. These breakpoints are listed in the **Breakpoints** window.

3. In the **Breakpoints** window, clear the box before **tutorial.c, line 35** to disable this breakpoint. Note that the breakpoint icon before line 35 becomes a hollow circle icon.
To delete a breakpoint, you can click on the breakpoint icon before the corresponding line, or right-click on the breakpoint in the Breakpoints window, and select Delete Breakpoint.

4. Right-click on the breakpoint of line 37. Select When Hit... to open a dialog. Check the box before Print a message. In the text box under Print a message:, append the text test code runs to here. Click OK to finish. Note that this breakpoint's icon is now a diamond.

5. Right click on the breakpoint at line 50. Select Condition... to open a dialog. Enable Condition and type nCol==1 in the text box. Click OK.

6. To run this code, type the function name new_wks in the upper panel of the LabTalk Console window.
7. Press ENTER. A yellow arrow will appear upon the first breakpoint icon, indicating which line of code is executed to.

8. Press F8 to continue debugging the code. You will see the yellow arrow icon moving to the line 50.

9. In the **Command & Results** window, the message added in the breakpoint of line 37 is printed in the lower panel.

![Command & Results](image)

10. Activate the **Variables** window. The variable names are listed in the first column and their values are listed in the second column. Check the value of `nCol`.

![Variables](image)

11. Press F5 to run over all codes, the yellow arrow will disappear.

12. Return to the Origin workspace. You can see that a workbook is created as in the following image.

![Workbook](image)
11.3.2.3.3 Run the Function Using the Custom Routine Button

1. Hold the CTRL + SHIFT keys and click the **Custom Routine** button. It will open the Custom.ogs file in Code Builder.

2. With the cursor at line 11, click the **Comment** button to comment out line 11.

3. Type the following code at lines 12 and 13.

   ```plaintext
   Run.LoadOC(%OriginC\Tutorial.c); // %Y is user file folder
   new_wks();
   ```

4. This code will load the **Tutorial.c** file we added in the previous section and run the **new_wks()** function.

5. Press the **Save** button.

6. Return to the Origin workspace. Click the **Custom Routine** button. A new worksheet will be created and filled with data as it was in the previous section.
11.3.3 The Code Builder Workspace

11.3.3.1 Summary

In this tutorial, we will create a workspace in the Code Builder of Origin, add a source file with a new function, then build, test and save the workspace file. Also, we will configure the appearance of the Code Builder.

Minimum Origin Version Required: Origin 2016 SR0

11.3.3.2 What you will learn

This tutorial will show you how to:

- Build a Workspace File
- Build Workspace Folders
- Build on Startup
- Configure Code Builder Interface
- Create an App Using Apps folder in Workspace
- Use Hot Key to speed up your work

11.3.3.3 The Workspace File

A workspace is a collection of files that can be opened by a single menu option (File: Open Workspace...) in Origin's Code Builder. Any text file can be a part of the collection. They do not necessarily have to be source code files; they could be notes, for example.

All files opened in the Multiple Document Window by a workspace can be edited and saved individually. In addition to files being opened in the Multiple Document Window, source code files can be added to the Workspace Window with the File: Add to Workspace menu option.
By including source code files in the Workspace Window, you can build individual or multiple files with the appropriate menu option or toolbar button. Header files can be referenced within source files and do not need to be loaded in the Workspace Window or even open in the Multiple Document Window.

Since you can save a workspace with a new name, you can have multiple workspace files. However, only one workspace file can be opened at a time.

To create a workspace:

1. On the Standard toolbar, click the Code Builder button.
2. From the Code Builder menu, select File: New Workspace. This creates a new workspace with the default name of "Untitled.ocw".
3. From the Code Builder menu, select File: New. This opens the New File dialog.
4. Choose C File, and type foo in the File Name text box. The Add to Workspace and Fill with Default Contents check boxes should be selected. You may accept the default Location. Click OK.
5. In FOO.C, starting below the line that says "\start your functions here", type the following:

```c
void bar()
{
    printf("Hello World!\n");
}
```

6. Click the Build button (or use the hotkey Shift+F8). Origin automatically saves the source file and compiles and links the function.

7. From the Origin menu choose Window: Script Window.

8. To test our new function, type:

   ```c
   bar
   ```

9. Press ENTER

   Origin responds by typing **Hello World!**

**10. From the Code Builder menu, choose File: Save Workspace As....**

The figure shows the foo.ocw workspace file containing a single source file, foo.c, in the Multiple Document Window. The file has been added to the Workspace Window. The Output Window shows that the file has been compiled. The source file contains a single function "bar()" which is listed in the tree structure of the...
workspace.

11.3.3.4 Workspace Folders

The Code Builder workspace has six subfolders: Apps, Project, System, Temporary, User [AutoLoad] and User. Files added by user, such as foo.c that you just added, are placed in the User subfolder. Origin, itself, uses Origin C for many analysis routines. When these routines are accessed, the Origin C source files are loaded into either the System subfolder or the Temporary subfolder in the Workspace. The Project subfolder is reserved for files that are saved and loaded with the Origin project. This aspect of attaching a file to the project is described in a separate tutorial.

11.3.3.5 Build on Startup

If you right click on the Origin C Workspace folder, the shortcut menu has a Build on Startup option. When this option is checked, the last workspace you saved will be loaded when you restart Origin. All source files in the Workspace will be built and all functions in the source files will be available for immediate use.

For information on building individual source files on startup by including information in the ORIGIN.INI file, please view Build on Startup.

This concludes the tutorial on the Code Builder Workspace.

11.3.3.6 Configure Code Builder Interface

User can configure code builder interface including the fonts and colors, the brackets color, the icons size and so on.
1. Open **Options** dialog in **Code Builder** by select **Preference: Options** in main menu. Go to the **Fonts and Colors** tab, change the **Theme** to **Dark**. An interface with dark background and light font is obtained. You can further adjust the font size or type in this dialog.

2. In **Options** dialog, go to the (Text Editor) **General** tab, change the properties for **Enable Multiple Colored Brackets** to **True** and click **OK**. The nested "()" in code will be shown in multiple colors.
3. Open **Customize** dialog in Origin's main interface by select **View: Toolbars** in main menu. Go to the **Options** tab and check on **Use Large Icons** box, then you can get large icons for buttons in Toolbars (note that this setting may not work well on your system depending on your display settings). Close the **Customize** dialog box.
4. You can control the show or hide of each panel by selecting or unselecting them from View in Code Builder menu, the selected panel will be shown in Code Builder.

11.3.3.7 Create an App Using Apps folder in Workspace

To create an App package, you need to combine the use of Apps folder in Code Builder workspace and the Package Manager. Following steps will show you how to create the package for an App.

2. Make sure **Workspace** window is open, if not you can select menu **View: Workspace** to open it. Right click on the **Apps** folder in **Origin C Workspace** and select **New** to add a new folder.

3. Right click on the newly added folder **Untitled** and select **Rename** to name the folder as "MyApp".

4. Right click on **MyApp** folder and select **Add Files...** to open **Add Files to Workspace** dialog. Browse to select all prepared files and click **Open** button to add them to current folder.

5. Right click **MyApp** folder to select **Generate** and you will be directed to the **Package Manager**.
6. You can find the added files in the lower panel of **Package Manager**. Now you can input some basic information about *MyApp* under **Package** node as shown below. To make the App display as an icon in **App Gallery**, you need to prepare a 32*32 (in pixels) bmp image and input its name with extension in **Icon** edit box. Then you can input some LabTalk script in **Launch Script** field to tell Origin what to do when launching the App.
7. Select **File: Save** to save the package as an OPX file. Later you can drag and drop this OPX file into Origin workspace to install this App.

11.3.3.8 Frequently Used Hot Keys

The **Hotkey** in Code Builder make the coding work efficiency. The following parts introduce the useful hotkey one by one.

Firstly, please download the **zip file**, extract it and then browse to the |Origin C Examples|Programming Guide|Practical Examples| subfolder to add **AccessMatrix. c** by right-clicking the user folder and select "Add Files"

- **Ctrl+F2 and F2**

  **Ctrl+F2** add a Toggle Bookmark at the specific line. You can use hotkey **F2** to go to next Toggle Bookmark.

  ```
  57 58 59 60 61
  62 63 64 65 66 67 68
  //set and get Matrix data by vector
  vector vDataRad; //declare a new vecto
  int nRows, nCols;
  
  nCols = MatData.GetNumCols(); //get the M
  nRows = MatData.GetNumRows();
  
  for(int ii = 0; ii < nRows * nCols; ii++)
  {
  vDataRad.Add(ran());
  vDataRad[ii] *= 10;
  ```

- **Ctrl+F3 and F3**

  **Ctrl+F3** highlight all the select word ("MatData") in code. You can use hotkey **F3** to go to the next highlighted "MatData".
• Ctrl+]  
This hotkey help you to go to matching brace in the code.

• F9  
This hotkey add a Toggle Breakpoints at the specific line.

• Ctrl+/ and Ctrl + Shift + /  
This hotkey Ctrl+/ comment the selected lines, while Ctrl + Shift + / uncomment them.

• Ctrl+Alt+O  
After constructing the *.c and *.h files with the same name, you can use hotkey Ctrl+Alt+O to switch between them.
11.3.4 Adding New Origin C Functions to Origin

11.3.4.1 Summary

Functions written in Origin C are accessible from various locations within the Origin interface, such as the Script Window, provided they meet the following criteria: the function should return either void (as in the previous tutorial), double, string, or vectors of type double or string. Variables passed to the function from Origin should be of type double or string, or vectors of these types. Functions that do not meet these criteria are not callable from the Origin interface, but can be called within other Origin C functions. Note that although an Origin C function that accepts and returns type int can be called from the Origin interface, the data may be truncated since the interface only supports type double.

In this tutorial, you will be introduced to writing a math function that returns computed values. We will first create a function that returns type double to Origin, and then we will create a function that returns vectors of type double.

Minimum Origin Version Required: Origin 8.0 SR0

11.3.4.2 What you will learn

How to add a new function and how to run this function in the Script Window.

11.3.4.3 Steps

2. Enter the following code:

```c
#include <Origin.h>
#include "test.h"
int Main()
{
    layer S1:
    S1.a1 = 500.;
    S1.a2 = 2.;
    S1.a3 = 7.;
    S1.aw = 1.3;
    S1.f1 = 23.24;
    S1.f2 = 0.5;
    return 0;
}
```

```c
struct layer{
    double a1;
    double a2;
    double a3;
    double aw;
    double f1;
    double f2;
};
```

```c
double myfunc1(double x, double a)
{
    return sin( a * x);
}
```
3. Click the Build button to compile the function.

This function can now be called from the Origin interface, in places such as the Script Window.

4. Go to the Script Window, and type in the following lines, pressing ENTER at the end of each line:

```
3. Click the Build button to compile the function.

This function can now be called from the Origin interface, in places such as the Script Window.

4. Go to the Script Window, and type in the following lines, pressing ENTER at the end of each line:

```

```
y = myfunc1(2, 3)

y =
```

You can also use worksheet cells instead of absolute numbers:

5. Make a worksheet active, enter a number in the first row of column A. Then type the following into the Script Window and press ENTER:

```
col(B)[1] = myfunc1(col(A)[1], 3)
```

Note that a function such as myfunc1, that accepts and returns type double, can also be used to perform vector operations.

6. Fill rows 1 through 10 of Column A with numbers, and type the following into the Script Window:

```
col(B) = myfunc1(col(A), 3)
```

In the above example, Origin calls the myfunc1 function for each row of column A. For performing vector operations as above, it is more efficient to write functions that accept and return vectors.

7. Go back to Code Builder and add the following function to the same file, and compile the file by clicking the Build button.

```
vector<double> myfunc2(vector<double> vecIn, double a)
{
    vector<double> vecOut;
    vecOut = sin( a * vecIn );
    return vecOut;
}
```

8. Go back to the Origin interface, fill Column A with some new numbers, and type the following into the Script Window:

\[ \text{col}(B) = \text{myfunc2}(\text{col}(A), 3) \]

The function myfunc2 is called only once for computing the entire column.

Note that you can use such functions in other places such as the "Set Column Values" dialog. The Auto Update feature of "Set Column Values" can be enabled by checking the appropriate check box in this dialog. As long as the Origin C function is compiled and ready to be called from Origin, any changes to the source column will result in an update of the destination column.

### 11.3.5 Organizing and Accessing Origin C Functions

#### 11.3.5.1 Summary

Techniques for using your Origin C functions.

Minimum Origin Version Required: Origin 8.0 SR0

#### 11.3.5.2 What you will learn

This tutorial will show you how to:

- Save your Origin C Function with your Project
- Associate your Programs with Visual Objects
- Load and Compile your Origin C Function from script

#### 11.3.5.3 Saving your Origin C Function with your Project

One way to load and compile your Origin C function is to save the Origin C file as an attachment to your Origin Project (*.OPJ) file. When a project file is opened, all files attached to it are separated out and stored in a temporary folder. In addition, any Origin C file that was attached is also automatically loaded into the Code Builder workspace, and compiled. The function is then ready to be called upon opening the Origin Project file.

2. On the Standard Toolbar, click the Code Builder button.
3. From the Code Builder menu, select File: New. This opens the New File dialog box.
4. In the top list-box, select C File.
5. In the File Name text box, type: Test. Keep the Add to Workspace check box selected. Click OK. The file Test.c is added to the workspace.
6. Select and copy the following function, and paste it into the Test.c file. Be sure to paste the text below the line that reads "//start your functions here."

```c
void Plot_Data(string strTemplate, string strData)
{
}
```
// Create a graph window from a Template

GraphPage gp;

BOOL bOK = gp.Create(strTemplate, CREATE_VISIBLE);

if( !bOK )
    return;

// Attach the first layer (0) to a GraphLayer object

GraphLayer gl = gp.Layers(0);

//Attach a dataset to a Curve object

Curve crv(strData);

// Add the Curve to the graph layer

int nPlot = gl.AddPlot(crv);

if(nPlot >= 0)
{
    // Set plot color to Green(2)
    gl.DataPlots(nPlot).SetColor(2, TRUE);

    // Rescale this graph layer
    gl.Rescale();
}

The `Plot_Data` function takes two arguments: (1) the template name and (2) the name of a Y dataset to include (plot) in the layer.

7. Click the **Build** button to compile and link the file.

8. Drag-and-drop the file `Test.c` from the User subfolder branch of the Workspace tree, to the Project subfolder. (*Hint:* You may need to first expand the User subfolder branch to display the `Test.c` entry prior to dragging the file).

9. Go back to the Origin interface and save the project by clicking the **Save** button on the Standard Toolbar. Give the project the name `Test.OPJ`, and save it in a location of your choosing.

10. The Origin C file, `Test.c`, is now saved with the Project. To verify this, close the project, and go back to Code Builder. You will see that there are no entries under the Project subfolder of the Workspace tree. Now go back to Origin interface and reopen the project. Go to Code builder and verify that `Test.c` is now listed under the Project subfolder (*Hint:* you may need to expand the Project subfolder branch to see the `Test.c` entry).

11.3.5.4 **Associating your Programs with Visual Objects**

You will now learn how to create a button on a worksheet and program the button to call the Origin C function in the `Test.c` file that you saved with the project.

1. Open the `Test.OPJ` project that you saved under step 9 (*previous section*).
2. Highlight the A(X) and B(Y) columns, right-click and select **Fill Columns With: Row Numbers**.
3. From the menu, select **Format: Worksheet** to open the **Worksheet Properties** dialog box.
4. In the **Size** tab, **Worksheet Measurement** branch, set the **Gap from Top** to 40 and click **OK** to close the dialog.
The worksheet now has sufficient space above the column headings to add a text label.

Right-click in the area directly above the two columns and choose **Add Text**.

5. At the cursor, type: **Plot Data**.

6. Click once outside the text label to deselect it.

7. Right-click on the text label and choose **Programming Control** to open the **Programming Control** dialog box. (**Hint:** Please choose **Label Control** in Origin 7.5)

8. From the **Script, Run After** drop-down list, choose **Button Up**.

9. Type the following script in the text box at the bottom of the dialog box:

```plaintext
Plot_Data("scatter","book1_b");
```

10. Click **OK**.

Your text label will now look like a button.
11. Click the **Plot Data** button on your worksheet.

12. The Plot_Data function in your Test.c file is called, and a scatter plot is created.

**Notes:** The script behind the button assumes that you have data in column B(Y) of the Data1 worksheet and that there is an associated X data set.

11.3.5.5 **Loading and Compiling your Origin C Function from Script**

In this tutorial we learned how to save an Origin C function along with the project file and then access the function from the Origin interface. Saving an Origin C file with a project limits access to functions within that file to only that project. When a new project is opened, the functions are not available any more.

To access functions in an Origin C file that is saved on disk, the file can be programmatically loaded and compiled using LabTalk script. The script command for performing the programmatic load and compile is `run.LoadOC`. Refer to the LabTalk Help files (Help: Programming: Labtalk) for more information on using this command.

This concludes the **Origin C Functions** tutorial.

**11.3.6 Tutorial: Calculating Double Integral with NAG Functions From Origin C**

11.3.6.1 **Summary**

Origin/OriginPro includes the complete NAG Mark 9 numerical library. This library provides multiple method for numerical integration. All functions are accessible from Origin C. In this tutorial, you will call NAG functions to perform the double integration. Note that an infinite NAG integrator is used here.

11.3.6.2 **What you will learn**

This tutorial will show you how to:
Call NAG functions in Origin C
Solve definite double Integral using the NAG integration routine

Example and Steps

To calculate the double integration. You need to call function in NAG library category D01 Quadrature. This category provides functions for the numerical evaluation of definite integrals in one or more dimensions. Two functions with different algorithm are available for double integral, which is nag_multid_quad_adapt_1 and nag_multid_quad_monte_carlo_1. In this tutorial, you will learn to use them to solve the integral formula below:

\[ \int_0^1 \int_0^1 xy(x + y)\,dx\,dy \]

You are recommended to read the relevant tutorial Calling NAG Functions From Origin C, to study how to run and test the code below for calculation. Then you can copy and paste the code into new created .c file in Code Builder and run the compile and build process. Below is the Origin C code with comments:

Using nag_multid_quad_monte_carlo_1

```c
#include <Origin.h>

#include <OC_nag.h>

#define MAXCLS 20000  //maximum number of integrand evaluations to be allowed

double NAG_CALL f(Integer ndim, double x[], Nag_User *comm)
{
    return x[0]*x[1]*(x[0]+x[1]);  //define the function formula
}

int multid_quad_monte_carlo()
{
    Integer exit_status = 0, k, maxcls = MAXCLS, mincls;
    Integer ndim = 2;  // the number of dimensions of the integral
```
NagError fail;

Nag_MCM Method method;

Nag_Start cont;

Nag_User comm;

double a[2], b[2], acc, *comm_arr, eps, finest;

comm_arr= NULL;

if (ndim < 1){
    printf("Invalid ndim.\n");

    exit_status = -1;

    return exit_status;
}

for (k = 0; k < ndim; k++){
    a[k] = 0.0;  // the lower limits of integration

    b[k] = 1.0;  // the upper limits of integration
}

eps = 0.01;  // the relative accuracy required

mincls = 1000; // minimum number of integrand evaluations to be allowed

method = Nag_ManyIterations;

cont = Nag_Cold;
/ * nag_multid_quad_monte_carlo_1 (d01xbc).
  * Multi-dimensional quadrature, using Monte Carlo method,
  * thread-safe
  */

nag_multid_quad_monte_carlo_1(ndim, f, method, cont, a, b, &mincls, maxcls, eps,
&finest, &acc, &comm_arr, &comm, &fail);

if (fail.code == NE_NOERROR || fail.code == NE_QUAD_MAX_INTEGRAND_EVAL){
  if (fail.code == NE_QUAD_MAX_INTEGRAND_EVAL){

    printf("Error from nag_multid_quad_monte_carlo_1
(d01xbc).\n%s\n", fail.message);

    exit_status = 2;

  }

  //output the calculation results

  printf("Requested accuracy = %7.2e\n", eps);

  printf("Estimated value = %7.5f\n", finest);

  printf("Estimated accuracy = %7.2e\n", acc);

  printf("Number of evaluations = %6d\n", mincls);

}
else{

  printf("Error from nag_multid_quad_monte_carlo_1
(d01xbc).\n%s\n", fail.message);

exit_status = 1;
}

/* Free memory allocated internally */
if (comm_arr)
    NAG_FREE(comm_arr);

return exit_status;
}

Then you can call the functions in LabTalk Console. The results will be like this:

Requested accuracy = 1.00e-002

Estimated value = 0.33326

Estimated accuracy = 2.23e-004

Number of evaluations = 1552

11.3.6.3.2 Using nag_multid_quad_adapt_1

#include <OC_nag.h>

#include <Origin.h>

#define NDIM 2    //the number of dimensions of the integral
#define MAXPTS 1000*NDIM    //maximum number of integrand evaluations to be allowed

double NAG_CALL f(Integer n, double x[], Nag_User *comm)
{
    return x[0]*x[1]*(x[0]+x[1]);    //define the function formula
```c
int multid_quad_adapt()
{
    Integer exit_status = 0;
    Integer ndim = NDIM;
    Integer maxpts = MAXPTS;

    double a[2], b[2];
    Integer k;
    double finval;
    Integer minpts;
    double acc, eps;
    Nag_User comm;
    NagError fail;

    for (k = 0; k < 2; k++)
    {
        a[k] = 0.0; //the lower limits of integration
        b[k] = 1.0; //the upper limits of integration
    }
    eps = 0.001;
}
```
minpts = 0;

nag_multid_quad_adapt_1(ndim, f, a, b, &minpts, maxpts, eps, &finval,&acc, &comm, &fail);

if (fail.code != NE_NOERROR & fail.code != NE_QUAD_MAX_INTEGRAND_EVAL)
{
    printf("Error from nag_multid_quad_monte_carlo_1 (d01xbc).\n%s\n",fail.message);
    exit_status = 1;
    return exit_status;
}

//output the calculation results
printf("Requested accuracy = %7.2e\n", eps);
printf("Estimated value = %7.5f\n", finval);
printf("Estimated accuracy = %7.2e\n", acc);
return 0;
}

Then you can call the functions in LabTalk Console. The results will be like this:

Requested accuracy = 1.00e-003

Estimated value = 0.33333

Estimated accuracy = 3.33e-016

11.3.7 Tutorial: Calling NAG Functions From Origin C
11.3.7.1 Summary

Calling a NAG function from an Origin C function is very much like calling any other Origin C function. You must familiarize yourself with the desired NAG function to gain an understanding of what parameters the function requires to be passed as arguments and what parameters the function returns. Once familiar with the function, you must develop code that follows the function's requirements.

The NAG header file containing the function's prototype must be included, required parameters must be correctly declared, sized, and initialized, and the function call must follow the function's prototype as described in header file. The objective of this tutorial is to demonstrate how to call a NAG function from an Origin C function.

Minimum Origin Version Required: Origin 8.1 SR1

11.3.7.2 What you will learn

This tutorial will show you how to:

- Understand NAG functions
- Get Ready to Debug Sample Code
- Include the NAG Header
- How to See the Declaration of NAG Function
- How to Get NAG Error Code
- How to Use Function Pointer

11.3.7.3 Understand NAG Functions

The primary resource for understanding NAG functions is NAG library. The library also can be found in Origin C Reference. For example, d01sjc NAG function:

2. Select Quadrature (d01) category and then select nag_1d_quad_gen_1 (d01sjc) function.
3. The selected page is one PDF file. Study the nag_1d_quad_gen_1 function as needed to understand the description of the function, the function's prototype, and the description of all arguments. Sample data and an example program calling the function are also often included.

Secondary resource for understanding the Origin C NAG functions is Examples book. From the Origin menu select Help:Programming:OriginC, expand Examples book, expand Analysis book, choose Accessing NAG Functions, there are some examples to show how to call NAG functions in Origin C.

11.3.7.4 Get Ready to Debug Sample Code

The best way to understand how to write an Origin C function that calls a NAG function is to step through an example function in Debug mode. Follow the steps below to set up Origin and Code Builder to execute such a sample Origin C function in Debug mode.

1. From the Code Builder menu, select File: New. This opens the New File dialog box.
2. In the **File Name** text box, type: **TestNAG**, Keep **Add to Workspace** checkbox is checked. Click **OK**. The file TestNAG.c is added to the workspace.

3. Select and copy the following function, and paste it into the TestNAG.c file. Be sure to paste the text below the line that reads "// Include your own header files here."

```c
#include <OC_nag.h>

// Start your functions here.

//NAG_CALL denotes proper calling convention. You may treat it like a function pointer

//and define your own integrand

static double NAG_CALL f_callback_ex(double x, Nag_User *comm)
{
    int *use_comm = (int *)comm->p;

    return (x*sin(x*30.0)/sqrt(1.0-x*x/(PI*PI*4.0)));
}

void nag_d01sjc_ex()
{
    double a = 0.0;

    double b = PI * 2.0; // integration interval
```
double epsabs, abserr, epsrel, result;

// you may use epsabs and epsrel and this quantity to enhance your desired precision

// when not enough precision encountered

epsabs = 0.0;

epsrel = 0.0001;

// The max number of sub-intervals needed to evaluate the function in the integral

// The more difficult the integrand the larger max_num_subint should be

// For most problems 200 to 500 is adequate and recommended

int max_num_subint = 200;

Nag_QuadProgress qp;

NagError fail;

Nag_User comm;

static int use_comm[1] = {1};

comm.p = (Pointer)&use_comm;

//Note:nag_1d_quad_gen (d01ajc) has been replaced by nag_1d_quad_gen_1 (d01sjc) at Mark 25

d01sjc(f_callback_ex, a, b, epsabs, epsrel, max_num_subint,&result, &abserr, &qp, &comm, &fail);
// For the error other than the following three errors which are due to bad
// or allocation failure  NE_INT_ARG_LT  NE_BAD_PARAM   NE_ALLOC_FAIL
// You will need to free the memory allocation before calling the
// integration routine again to
// avoid memory leakage

if (fail.code != NE_INT_ARG_LT && fail.code != NE_BAD_PARAM && fail.code !=
NE_ALLOC_FAIL)
{
    NAG_FREE(qp.sub_int_beg_pts);
    NAG_FREE(qp.sub_int_end_pts);
    NAG_FREE(qp.sub_int_result);
    NAG_FREE(qp.sub_int_error);
}

printf("%10.6f", result);

11.3.7.5 Include the NAG Header

#include <OC_nag.h>

This header file containing all the header files of NAG functions, and all type define and error code define. So just include this one function should be enough.

11.3.7.6 How to See the Declaration of NAG Function
See the declaration of NAG functions from the header file:

1. Activate TestNAG.c file that created in above section, move scoll bar to find out include <OC_nag.h> line.
2. Right click anywhere in the line and select Open "OC_nag.h". This opens the NAG header file.
3. Move scoll bar to find out include <NAG_MARK25\oc_nag_all.h> line, and also right click to select Open "NAG_MARK25\oc_nag_all.h". This opens the header file containing all nag headers at Mark25.
4. In the Search combo box type nagd01.h and press ENTER button to find out this line. Function d01sjc belongs to d01 category, so the header file name should be nagd01.h.
5. Right click anywhere of this line to choose Open "nagd01.h". This opens the header file including the prototype of the functions.
6. In the Search combo box, type d01sjc and press ENTER button to go to the declaration of this function.

To see the declaration of functions from NAG PDF:

- NAG PDF Online
- NAG PDF Files

11.3.7.7 How to Get NAG Error Code

1. Reactivate the TestNAG.c window in Code Builder. In this file, the NagError variable fail is defined and passed as last argument to function d01sjc.
2. NAG function returns error code into NagError variable code item. In this example, can access NAG error code by fail.code.

How to know what error codes will be got:

4. In Chapters of NAG C Library table, choose d01 to enter Quadrature page, select d01sjc in the table of this category to open the PDF help of this NAG function.
5. Drag scall bar to page down to 6 Error Indicators and Warnings part, there list all error codes for this function and the related description. Can directly use these error codes in Origin C if included correct header file (include <OC_nag.h>, this header containing all NAG headers), for example NE_INT_ARG_LT, NE_BAD_PARAM, NE_ALLOC_FAIL used in TestNAG.c file.

11.3.7.8 How to Use Function Pointer

1. Open nagd01.h file from Origin program path \OriginC\system\NAG_MARK25 folder.
2. In this file, find out the declaration of d01sjc function. The first argument type of this function is NAG_D01SJC_FUN.
3. Double-click NAG_D01SJC_FUN to high-light it. From menu choose Edit: Find in Files to open Find in Files dialog. Set settings same as the following picture, click Find button.
4. Searching result display in Output window. Double click nag_types.h line to go to this file, `typedef NAG_D01_TS_FUN NAG_D01SJC_FUN` line, you can find the define of NAG_D01_TS_FUN nearby.
5. The define of NAG_D01_TS_FUN is

\[
\text{typedef double } (\text{NAG_CALL } \star \text{ NAG_D01_TS_FUN}) (\text{double}, \text{Nag_User } \star \text{ comm});
\]

6. User defined function should keep the same return type and argument list as this define. And `NAG_CALL` denotes proper calling convention and it should be used in your own function.
7. Activate TestNAG.c file. There is a function named `f_callback_ex` and it used as function pointer in `d01sjc` as the first argument.

```c
double NAG_CALL f_callback_ex(double x, Nag_User *comm)
{
    int *use_comm = (int *)comm->p;
    return (x*sin(x*30.0)/sqrt(1.0-x*x/(PI*PI*4.0)));}
```

### 11.3.8 Accessing Internal Origin Objects by Origin C

#### 11.3.8.1 Summary

Internal Origin objects (such as Project Explorer folders, Origin windows (pages), layers, plots, graphic objects, data sets, etc.) are accessed using Origin C classes. To access or programmatically control an internal Origin object, you must attach it to an Origin C object.

To attach something to an internal Origin object you must first "find" it using the properties, methods, and collections of a container class. Common container classes include the Project, Folder, Page, GraphPage, Layer, GraphLayer, Worksheet, MatrixLayer, and Collection classes. Once found, an internal Origin object can easily be attached to an Origin C object of the appropriate type.

The internal Origin object is then programmatically controlled by manipulating the class methods and properties of the attached Origin C object. The objective of this tutorial is to demonstrate how to find particular
internal Origin objects, attach things to those objects, and access the objects by manipulating the methods and properties of the attached Origin C objects.

Minimum Origin Version Required: Origin 8.1 SR1

11.3.8.2 What you will learn

This tutorial will show you how to:

- Access Worksheet Related Objects
- Access Graph Related Objects

11.3.8.3 Accessing Worksheet Related Objects

Familiarity with the Origin C Project class (Project.h), the Collection class (Collection.h), and the Folder class (Folder.h), is valuable when attempting to understand how to find particular internal Origin Objects. Users may find it helpful to preview these classes in the Origin C Reference: Classes book of Origin C Help or in the above header files located in the ..\Origin\OriginC\system subfolder.

To begin this tutorial:

1. Download [this zip file](#), extract it.
2. On the Standard toolbar, click the New Project button.
3. On the Standard toolbar, click the Code Builder button.
5. On the Code Builder menu, click the Open button.
6. Open the unzipped folder created at step 1, browse to the \Origin C Examples\Programming Guide\Introduction to Accessing Origin Objects folder in the Origin software directory, select AccessWorksheetObjectsTutorial.c, check the Add to Workspace check box and click Open.
7. On the Code Builder toolbar, click the Rebuild All button. This compiles and links the file.
8. On the Code Builder View menu, verify that the LabTalk Console (Command & Results) and the Local Variables windows are visible (the corresponding menu items should be checked).
9. From the Code Builder menu, select Tools: Customize. Select the Toolbars tab and make sure that the Debug toolbar check box is selected.
11. Near the top of the file, locate and click on the line:

```c
PageBase pb;
```

You can position the cursor anywhere on the line.


A brown circle is displayed in the gray margin to the left of the above line indicating that a Debug breakpoint has been set for that line.
12. In the Code Builder workspace, activate the LabTalk Console (Command & Results window) and type in the following:

```
AccessWorksheetObjectsTutorial
```

13. Press **ENTER** to execute the function.

14. On the **Debug** toolbar, press the **Step Into** button.

15. Press the **Step Into** button repeatedly, stopping to read the comments for each statement. Periodically stop and resize and/or reposition the Local Variables window to view the current run-time value of each variable.
11.3.8.4 Accessing Graph Related Objects

1. Return to the Origin workspace and, on the Standard toolbar, click the Open button.
2. Locate the unzipped folder you created at step 1 of above section in this page. Browse to the Origin C Examples\Programming Guide\Introduction to Accessing Origin Objects subfolder, select AccessGraphObjectsTutorial.OPJ, and click Open. You may be prompted to save changes to an untitled project. Click No and a worksheet and graph should open.
3. From the Code Builder menu, select File: New Workspace. Click No when prompted to save workspace changes.
4. In Code Builder, click the Open button.
5. Locate the unzipped folder again. Browse to the Origin C Examples\Programming Guide\Introduction to Accessing Origin Objects subfolder, select AccessGraphObjectsTutorial.c, select the Add to Workspace check box, and click Open.
6. Click the Rebuild All button to compile and link the file.
7. On the Code Builder View menu, verify that the LabTalk Console (Command & Results) and the Local Variables windows are visible (the corresponding menu items should be checked).
8. From the Code Builder menu, select Tools: Customize. Select the Toolbars tab and make sure that the Debug toolbar check box is selected.

9. In the Code Builder workspace, activate AccessGraphObjectsTutorial.c.

10. Near the top of the file locate and click on the line:

    ```
GraphPage gp;
    ```

You can position the cursor anywhere on the line.


A brown circle is displayed in the gray margin to the left of the above line indicating that a Debug breakpoint has been set for that line.

12. Activate the LabTalk Console (Command & Results window) in Code Builder and type the following:

    ```
AccessGraphObjectsTutorial
    ```

13. Press ENTER to execute the function.

14. On the Debug toolbar, press the Step Into button repeatedly, stopping to read the comments for each statement.

    Periodically stop and resize and/or reposition the Local Variables window to view the current run-time value of each variable.

This concludes the Internal Origin Objects tutorial.

### 11.3.9 Create and Update Apps for Origin

#### 11.3.9.1 Summary

Apps are custom applications for Origin that perform specific graphing and/or analysis tasks. Origin users can browse for Apps and download and install them from the File Exchange area of the OriginLab website. Origin users can also create Apps and share with other on File Exchange. This tutorial provides the guidelines for making an App and detailed steps to build, upload and modify an App.

#### 11.3.9.2 What you will learn

This tutorial will show you how to:

- Build an App
- Upload an App to File Exchange Website
- Modify an App and Submit for Approval
11.3.9.3 App Files Specifications

The following files are supported/needed for Apps:

Icon files

Icon file (Required)
This should be a png file with size of 32*32 in pixels. This icon will be displayed in the **Apps Gallery** window in Origin.

Small icon file (Optional)
This should be a bmp file with size of 16*16 in pixels, and 16 color (4 Bits). It will be available from **View: Toolbars: Apps button group** in Origin. It can be used as a button, by adding to a toolbar.

Programming files

X-Function, *.ogs, *.c, *.h and DLL files are supported. Note that X-Function file name should not be the same as *.c file name if both exist.

Other files

Any other files such as documentation (*.chm, *.pdf), image files, sample data, etc, can be included.

11.3.9.4 Building an App

1. Locate the **Apps** folder under the **AppData** area of your Origin installation. You can enter the following command in Command/Script Window to locate this folder:

   ```bash
   %@A=; // The output can be, e.g., C:UsersXXXAppDataLocalOriginLabApps
   ```

2. Open the folder in the path found in step1, create a subfolder in this location. Note that the subfolder name will be used as your App name. Place all your files for the App in this subfolder.

3. Start Origin and click **Code Builder** button in Origin main interface.

4. In **Code Builder** window, right click on the **Apps** folder in the left **Workspace** panel. Select **Add Existing Folder** from the shortcut menu and browse to add the folder created in step 2. Expand the folder in Workspace panel. All files in the folder will be listed. Note that if you have no existing App folder, you can choose **New** from the shortcut menu to create a new sub-folder in Apps folder. If you right click on a file, you can choose to remove the file. Right click on the folder, and you can add more files, even files not located in current folder.
5. Right click on the newly created App folder in Code Builder’s Workspace panel, and choose Generate from the shortcut menu. It will open the Package Manager dialog.

6. In Package Manager dialog, do the following:

- **Package branch:**
  - **Name**
  
    Do not change the Name field, otherwise the folder name will also be changed.
  
  **Description**
  
    Input descriptions of the App in this field. The descriptions will be shown in the file exchange web’s Summary section.
  
  **Version**
  
    Set current App version. You can use two decimal digits, e.g. 1.11.
  
  **Origin Version Required**
  
    Set the required Origin version. For Origin 2016, you should type 9.3 instead of 2016.

- **App branch:**
  - **Icon**
  
    Set it to file name for icon to be displayed in Apps Gallery window.
  
    **Icon (Small)**
  
    Set it to file name for small icon used in toolbar.
  
    **Launch Script**
LabTalk script to run after you click the App icon. If you want to open an X-Function dialog, you can write your script such as: xfname -d; You can also have your script point to a section in ogs file, and run that section, e.g. run.section(%foldername\gsname,sectionname).

Enable by Window

Specify the active window type(s) for which the App should be enabled. e.g. for Latex App, Graph window should be active.

While it would be rare to do so, you can specify that your App be enabled for Notes windows by expanding the Enable by LabTalk Expression node and beside LabTalk Expression, type the following:

note.active=1

- **LabTalk Script branch:**

  Specify LabTalk script for before, after installation and before uninstalling.
7. When settings are done in **Package Manager**, click **File: Save** from the menu. The .opx file will be saved. The opx name can be different from the folder name. The opx file for an App is ready now. You can simply drag-and-drop the file onto Origin to install. Note that you may need to run Origin **not as administrator** to be able to drop the file onto Origin.

### 11.3.9.4.1 Uploading App to File Exchange Website

When the App package file is ready, you can upload it to File Exchange website to share with the public. To do it, follow the steps below:

1. Go to **File Exchange Website**, click **Submit a file** on the bottom right to open **Submit File** page. Select **File Type** as **App** and fill in other needed information, **File Category**, **Created using Origin**; etc. Note the information contained in the App package will be automatically extracted, such as, **Minimum Origin Version Required**, **Title**, **Summary**.
2. Upload the App OPX package file, screenshot image, click **Submit** button to submit your App and create a File Exchange tool page for it.
3. You can then download the OPX file from the web page you have created, and drag-and-drop onto Origin to test it. A package ID will be assigned to the opx during the download process.
4. You can continue editing the web page for your App. Once finished, you can click **Update** button to update the web page.
5. When you are ready to publish your App, press the **Request Approval** button on the bottom of **Update** form. You will be notified by OriginLab through email when your App has been approved. The approval status is also shown on the **Update File** page as indicated by **OriginLab Tested**, **OriginLab Approved** checkboxes.
6. Once your App got approved, it will be automatically shown on the **Tools: Apps on file Exchange** menu list.

### 11.3.9.4.2 Modifying an App

**Modify App Settings**

1. Select **Tools: Package Manager** from Origin menu. Select **Tools: Browse Installed Package** in **Package Manager** dialog’s menu. Select the App and click **Open** button.
2. You can change the settings in the dialog. If your files in the folder are modified, you can click **Repack Files** button.
3. Click **File: Save** to save the App OPX package.

**Add, Remove or Change Files in App Folder**

When you need to add files, remove files or change file names in App folder, you can perform these operations by right clicking on the App folder in the **Workspace** panel on **Code Builder** and selecting corresponding option from the shortcut menu. When done, click **Generate** from the shortcut menu to regenerate the App package.

Note that when removing files or changing file names, original files should be kept in the App folder under path `C:\Users\XXX\AppData\Local\OriginLab\Apps` even if they are not being used, otherwise old settings in the opx will not be kept in **Package Manager** dialog when you click **Generate** button.

**Upload Modified OPX to File Exchange Page**

Log in Origin website, go to the File Exchange page you have created for your App and upload the updated OPX file to the File Exchange page. Update the web page as needed, including notes on what has been done.
updated in current App version. Users would know this update from menu **Tools: Apps on File Exchange:** *YourApp (installed)* as indicated by the asterisk symbol * if this App was previously installed.

Request Approval from OriginLab

Click the **Request Approval** button in the File Exchange webpage of your App and wait for OriginLab to notify you.

**11.4 X-Functions**

**11.4.1 X-Functions**

- [Command Window and X-Functions](#)
- [Introduction to X-Functions](#)
- [How to Create a Wizard](#)

**11.4.2 Command Window and X-Functions**

11.4.2.1 **Summary**

Many of Origin’s analysis tools and other data processing tools have been implemented using X-Functions. The Command Window provides a convenient way to run these functions.

Another important use for the Command Window is to send LabTalk script commands to Origin. Script commands can range from simple math and data operations, to user-created X-Functions or Origin C functions.

Minimum Origin Version Required: Origin 8.0 SR6

11.4.2.2 **What you will learn**

This tutorial will introduce you to the Command Window and show you how to:

- Perform simple calculation
- Access worksheet cells/columns
- Access X-Functions

11.4.2.3 **Command Window**

The Command Window consists of two panels: the **Command Panel** and **History Panel**: 
The Command Window is normally located at the bottom right corner of the screen, but if it is not visible, you can access it by pressing `Alt+3` or by selecting View: Command Window.

When typing in the Command Panel, the Auto Complete support allows you to choose among X-Function script commands and OGS files in the current working folder. The command and OGS file name will be respectively preceded by Xf and LT. You can move up and down the list using the arrow keys; pressing Enter selects the item. After your selection, press the space bar and the Auto Complete now shows you the available options for the command.

11.4.2.4 Examples

11.4.2.4.1 Perform Calculations

The Command Window can be used as a calculator or to access any of Origin's mathematical functions. See the examples below.

11.4.2.4.1.1 Single Line

One of the more basic uses for the Command Window is as an interface to perform simple calculations. For example, type the following:

```
2+2=
```

Press ENTER. Origin returns

```
2+2=4
```

11.4.2.4.1.2 Multiple Lines

If you are typing multiple lines of scripts, first edit it in Code Builder (View: Code Builder) or any text editor, such as Windows Notepad, ending each line with a semi-colon, and then Copy + Paste the script in the Command Window, and press ENTER to execute. For example, paste the following script in the Command Window and ENTER:

```
sum = 0;
```

```plaintext
loop(ii, 1, 10)
{
    sum += ii;
}
sum =
```

Origin returns:

**SUM=55**

### 11.4.2.4.1.3 Functions

Any mathematical function, built-in as well as user-created, can be executed from the Command Window. For example, type:

\[
\ln(10) =
\]

Origin returns natural logarithm value of 10.

### 11.4.2.4.2 Access Worksheet Values

You can also use the Script Window to read and write worksheet values, or to perform math operations on datasets.

1. Enter the following data into a fresh worksheet:
2. To return the value in the first cell of the second column, type the following:

```
cell(1,2) =
```

3. Press ENTER. Origin returns:

```
CELL(1,2) = 6
```

You can also use the column name and row number to reference cell values.

4. Type the following:

```
col(B)[1] =
```

5. Press ENTER. Origin returns:

```
COL(B)[1] = 6
```

**Notes:** In addition to using the column name, you can also use the dataset name. In LabTalk, the syntax for naming datasets is `worksheetName_columnName`. So, for example, `Book1_A[1]` would return the first element of column A in worksheet Data1. Also, if the worksheet that you are referencing is the active window, you can use the LabTalk string variable `%H`, in place of the worksheet name. For example, `%H_A[1].

To subtract the value in row 1 of column A, from all the values in column B...

6. Type the following:

```
col(B) = col(B) - col(A)[1]
```

7. Press ENTER. Your worksheet now reads:
Let's use what we have learned about executing multiple lines of script in the Script window. We will multiply every value in a column of data by some constant b.

8. Type the following:

   \[ b=3; \]

   Press **CTRL+ENTER**. Recall that this gives us a carriage return without executing the command.

9. Now type:

   \[ \text{col(A)}=\text{col(A)}*b; \]

   Again, Press **CTRL+ENTER**.

10. Choose **Edit** from the Script window's menu bar. **Script Execution** should have a check mark next to it; if not, single-click on the menu item to place a check mark there.

11. Now, select the two lines of script that you just entered into the Script window and press **ENTER**.

Your worksheet now reads:
Notes: The following C notation is also supported:

\[
\begin{align*}
   & b=3; \\
   & \text{col}(A)*=b;
\end{align*}
\]

You can also use linear interpolation or extrapolation on a specified X dataset to find the corresponding interpolated or extrapolated value in a Y dataset. This requires using a new notation with parentheses ( ) instead of brackets [ ].

In this example, book1_b is a Y dataset and (4) is a value in an X dataset (book1_a) for which you want to find a corresponding, interpolated Y value.

12. Type the following:

\[
\text{book1}_b(4) =
\]

13. Press ENTER. Origin returns:

\[
\text{BOOK1}_B(4)=5.333333
\]

This is a line plot of our simple worksheet data. You can see that our interpolated Y value – the one corresponding to X = 4 – is 5.333333.

14. If the columns you work with are in different worksheet/workbook, you should use the range variables to represent the worksheet columns. For example, this script calculates the sine value on Book1 column A, and puts the result in Book2 column A (You must have Book2 before hitting Enter):
11.4.2.4.3 Access X-Functions

Origin 8 provides a large collection of X-Functions for performing a wide variety of data processing tasks. Of this collection, many of the X-Functions are accessible from LabTalk script. The functions accessible from script provide a powerful environment for users to create custom script code for their routine tasks.

X-Functions that are accessible from script can be listed in the Command Window, and you can also obtain help on the command syntax as well as make use of auto completion of commands for such functions.

X-Functions accept data range string or range variable for specifying source and destination data for the operation. For example, the smooth X-Function under signal processing can be accessed from the Command Window as follows:

1. Import the file \Samples\Signal Processing\Signal with Shot Noise.dat.
2. In the Command Window, type the following:
3. When you press **ENTER**, the result will append to the source worksheet.

4. For help in using this smooth **smooth X-Function**, you can type

   ```
   help smooth
   ```

5. to open the corresponding Help.

**11.4.3 Introduction to X-Functions**

**11.4.3.1 Summary**

X-Functions provide a structured programming environment that offers a framework for building Origin tools. Different from the simple GetN box, creating tools by using X-Functions allows the user to focus on the actual data processing code and not have to worry about codes for the user interface.

Most of the dialogs/functions in Origin 8 are X-Functions, and many of them can be run from both menu and command line mode. The flexibility of running X-Functions makes them an attractive approach to customizing Origin

Minimum Origin Version Required: Origin 8.0 SR0

**11.4.3.2 What you will learn**

- How to create an X-Function
• How to make the X-Function script accessible
• How to use the X-Function in dialog mode

11.4.3.3 Create an X-Function

1. Select **Tools: X-Function Builder** or press **F10** to open the **X-Function Builder** dialog
2. Set **Name**, **Label** and **Data** of the 1st variable as **ix**, **Source** and **<active>**
3. Right click in the list panel and select **Add Variables** from the context menu.
4. Set **Name**, **Label**, **Input/Output** and **Data** of the 2nd variable as **ox**, **Destination**, **Output** and **<new>**

5. Select **File:Save** to save the x-function as **vcopy**

6. Click to open **Code Builder**
7. Add the following codes in the **vcopy** function in code builder

```cpp
void vcopy(const vector& ix, vector& ox)
{

    if (!ix || !ox)
        XF_THROW(CER_NO_DATA);

    ox = ix;
```
11.4.3.4 Making the X-Function Script Accessible

1. Click the Return to Dialog button in Code Builder
2. In the X-Function Builder, save your changes
3. Open the X-Function in Tree View by clicking
4. Open the Usage Context branch. Make sure the Labtalk check box is selected
5. Save the x-function and close the X-Function Dialog
6. Fill column(A) with row numbers in the active worksheet (Highlight column(A), right-click and select Fill Column with: Row Numbers)
7. Type the following script in the command window, Column(A) will be copied to Column(B)
   
   vcopy col(a) col(b)

11.4.3.5 Using the X-Function in Dialog Mode

1. Open the X-Function Dialog and open VCOPY.OXF in Tree View
2. Open the Usage Context branch
3. Open the **Menus** branch, make sure **Simple GetNBox** is selected from the **Auto GetN Dialog** list box.

![X-Function Builder](image)

4. Save the x-function and close the **X-Function Dialog**.

5. Type following script in the command window, **Dialog of VCOPY.OXF** will be opened:

   vcopy -d
11.4.4 How to Create a Wizard

11.4.4.1 Summary

A wizard is a graphical user interface that includes a series of dialogs to direct a user to complete a mission step by step. A wizard makes a complex task easier to perform. Origin provides several classes in Origin C for users to develop a wizard. The dialog for each step in the wizard can be created using an X-Function.

In this example, the wizard will perform a normality test and then a one-sample t-test for data in a column. The normality test’s result can be shared in one-sample t-test.

**Note:** This tutorial requires the Develop Kit.

Minimum Origin Version Required: Origin 8.1SR0

11.4.4.2 What you will learn

- How to create an X-Function.
- How to share a variable or a DataRange in different steps.
- How to call an X-Function in OriginC.
- How to create a wizard.

11.4.4.3 Create four X-Functions

1. Select **Tools: X-Function Builder** or press **F10** to open **X-Function Builder dialog**
2. Add the variables as follows and save the X-Function as "StatTest" in the User Files folder, User Files\X-Functions\Statistics\Hypothesis Testing.

![X-Function Builder - Statistics\Hypothesis Testing: StatTest](image1)

```
Name | Label                | Input/Output | Data Type | Data | Control | Option String
-----|----------------------|--------------|-----------|------|---------|-----------------|
wk's | Source Page          | Input        | Worksheet | <active> |         |                 |
tn   | Theme Name           | Input        | string    |      |         |                 |
tt   | Theme Tree           | Input        | TreeNode  |      |         |                 |
tio  | Input Output Tree    | Input        | TreeNode  |      |         |                 |
script | Script Mode         | Input        | int       |      |         | 0               |
```

3. Click the New X-Function Wizard button. Add the variables as follows and save the X-Function as "StatTestWizGoal" in the User Files folder, User Files\X-Functions\Statistics\Hypothesis Testing.

![X-Function Builder - Statistics\Hypothesis Testing: StatTest](image2)

```
Name | Label | Input/Output | Data Type | Data   | Control | Option String
-----|-------|--------------|-----------|--------|---------|-----------------|
goal | Goal  | Input        | int      | <active> | Both|Only t-test | P:0              |
input | Input | Input        | Range     | <active> |         |                 |
VFCCorePointer | Input | int         |           |        |         | V:0,T:1          |
```


4. Click the **New X-Function Wizard** button. Add the variables as follows and save the X-Function as "NormalityTest" in the User Files folder, User Files\X-Functions\Statistics\Hypothesis Testing.

![X-Function Builder - NormalityTest](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Label</th>
<th>Input/Output</th>
<th>Data Type</th>
<th>Data</th>
<th>Control</th>
<th>Option String</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>Type</td>
<td>Input</td>
<td>int</td>
<td>Shapiro-Wilk, Kolmogorov</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nXFCorePointer</td>
<td>Input</td>
<td>int</td>
<td>(unassigned)</td>
<td>V:0;T:1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>stat</td>
<td>Statistics</td>
<td>Output</td>
<td>double</td>
<td>G:Output;U:n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>df</td>
<td>Degrees of Fre</td>
<td>Output</td>
<td>double</td>
<td>U:n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>prob</td>
<td>P-value</td>
<td>Output</td>
<td>double</td>
<td>G;U:n</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Click the **New X-Function Wizard** button. Add the variables as follows and save the X-Function as "OnetTest" in the User Files folder, User Files\X-Functions\Statistics\Hypothesis Testing.

![X-Function Builder - OnetTest](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Label</th>
<th>Input/Output</th>
<th>Data Type</th>
<th>Data</th>
<th>Control</th>
<th>Option String</th>
</tr>
</thead>
<tbody>
<tr>
<td>prob</td>
<td>Prob of Normality Test</td>
<td>Output</td>
<td>double</td>
<td>(unassigned)</td>
<td>U:n</td>
<td></td>
</tr>
<tr>
<td>mean</td>
<td>Test Mean</td>
<td>int</td>
<td>double</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>null</td>
<td>Null Hypothesis</td>
<td>Input</td>
<td>string</td>
<td>Mean=0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tail</td>
<td>Alternate Hypothesis</td>
<td>int</td>
<td>int</td>
<td>0</td>
<td>0</td>
<td>Mea</td>
</tr>
<tr>
<td>siglevel</td>
<td>Significance Level</td>
<td>Input</td>
<td>double</td>
<td>0.05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nXFCorePointer</td>
<td>Input</td>
<td>int</td>
<td>(unassigned)</td>
<td>V:0;T:1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>stat</td>
<td>Statistic</td>
<td>Output</td>
<td>double</td>
<td>G:Output;U:n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>df</td>
<td>Degrees of Freedom</td>
<td>Output</td>
<td>double</td>
<td>U:n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tprob</td>
<td>P-value</td>
<td>Output</td>
<td>double</td>
<td>U:n</td>
<td></td>
<td></td>
</tr>
<tr>
<td>lcl</td>
<td>Lower Confidence Limit</td>
<td>Output</td>
<td>double</td>
<td>(unassigned)</td>
<td>U:n</td>
<td></td>
</tr>
<tr>
<td>ucl</td>
<td>Upper Confidence Limit</td>
<td>Output</td>
<td>double</td>
<td>(unassigned)</td>
<td>G;U:n</td>
<td></td>
</tr>
</tbody>
</table>
Note that the X-Functions **NormalityTest** and **OnetTest** have the same variable "prob", which is a shared variable and will be declared in the source file.

### 11.4.4.4 Update X-Function's Property in Tree View

1. Open the X-Function **StatTest**. Click the **TreeView** button to open the Tree View. Make the following settings in the Tree View.

   ![Tree View screenshot](image)

   - **Name**: StatTest
   - **Description**: Stat Test
   - **Auto Compile Dependent Files**: Checked
   - **Usage Context**
     - Labtalk
     - Worksheet Selection
     - Graphic Object Events
     - Theme
     - Menus
     - Windows
     - Graph
     - Worksheet
   - **Main Menus**: Selected

2. Click the **Save OXF file** button to save the X-Function.

3. Open the X-Function **StatTestWizGoal**, **NormalityTest** and **OnetTest** respectively in X-Function Builder.

   Click the **TreeView** button and type "Select Wizard Goal", "Normality Test" and "One-Sample t-test" in the **Description** edit box of each X-Function's Tree View, which will be shown in the dialogs.

### 11.4.4.5 Create Files for the Wizard

- Click the **Code Builder** button on the **Standard** toolbar. In Code Builder, click the **New** button. In the **New File** dialog, select **H File**, click the **Browse** button, and select the User Files folder, **User Files\OriginC** as the new header file's **Location**. Then type StatTestWiz in the **File Name** edit box. Click **OK** to close the dialog.

Add the following script to StatTestWiz.h file.

```c
#ifndef __STAT_TEST_WIZ_H__
```
#define __STAT_TEST_WIZ_H__

#include <..\OriginLab\XFiz.h>
#include <..\OriginLab\XCore.h>
#include <..\OriginLab\XFWizard_utils.h>

class StatTestWizCore : public XCore
{

public:

    StatTestWizCore();

public:

    void ChangeGoal(int nGoal);
    DataRange GetRange();

    int nStep;

protected:

};

int stat_test_run_wiz_nodlg(LPCSTR lpcszThemeName = NULL, const XFizTheme *pXFizTheme
= NULL, const XFWizInputOutputRange *pXFWizIO = NULL, DWORD dwOPUID = 0); 

int stat_test_open_wiz_dlg(LPCSTR lpcszThemeName = NULL, const XFWizTheme
= NULL, const XFWizInputOutputRange *pXFWizIO = NULL, DWORD dwOPUID = 0); 

#abif //__STAT_TEST_WIZ_H__

Click the **Save** button to save StatTestWiz.h file. 

- Repeat the same operation to create a new **C File**, StatTestWiz.c. 

Add the following script to StatTestWiz.c file. 

///include *.OriginLab\XFizManager.h*

#include <.\OriginLab\WizOperation.h>

#include <.\OriginLab\XFizNavigation.h>

#include <.\OriginLab\XFizScript.h>

#include <.\OriginLab\XFizDlg.h>

///include "StatTestWiz.h"
enum 
{
    GOAL_ALL = 0,
    GOAL_SIMPLE,
};

//Names of three X-Functions
#define STR_STEP_GOAL  "StatTestWizGoal"
#define STR_STEP_Normal "NormalityTest"
#define STR_STEP_TTest "OnetTest"

//Names of steps shown in the wizard.
#define STR_LABEL_STEP_GOAL  "Goal"
#define STR_LABEL_STEP_Normal "Normality Test"
#define STR_LABEL_STEP_TTest "One-Sample t-test"

//Class StatTestWizTheme
class StatTestWizTheme : public XFWizTheme
{
public:
    StatTestWizTheme();
// Name of the variable prob shared by X-Functions NormalityTest and OnetTest

#define STR_GETN_VAR_SHARED_NProb "prob"

StatTestWizTheme::StatTestWizTheme()
:XFWizTheme()
{
    m_saSharedList.Add(STR_GETN_VAR_SHARED_NProb); // Add the shared variable
}

class StatTestWizInputOutputRange : public XFWizInputOutputRange
{

};

// Class StatTestWizManager

#define STR_CLASS_NAME_TEST "StatTestWiz"

#define TEST_VERSION_NUMBER 1.0
class StatTestWizManager : public XFWizManager
{

public:

    StatTestWizManager(LPCSTR lpcszThemeName = NULL, const XFWizTheme *pXFwizTheme = NULL, const XFWizInputOutputRange *pXFwizIO = NULL, DWORD dwUIDOp = 0);

protected:

    virtual double GetVersion() { return TEST_VERSION_NUMBER; }
    virtual XFCore* CreateXFCore() { return new StatTestWizCore; }
    virtual XFWizTheme* CreateXFWizTheme() { return new StatTestWizTheme; }
    virtual XFWizInputOutputRange* CreateXFWizInputOutputRange()
    { return new StatTestWizInputOutputRange; }
    virtual string GetClassName() { return STR_CLASS_NAME_TEST; }

};

StatTestWizManager::StatTestWizManager(LPCSTR lpcszThemeName, const XFWizTheme *pXFwizTheme, const XFWizInputOutputRange *pXFwizIO, DWORD dwUIDOp)
: XFWizManager(lpcszThemeName, pXFwizTheme, pXFwizIO, dwUIDOp)
{
    StringArray saMapXFNames = {STR_STEP_GOAL, STR_STEP_Normal, STR_STEP_TTest};
    StringArray saMapXFLabels = {STR_LABEL_STEP_GOAL, STR_LABEL_STEP_Normal, STR_LABEL_STEP_TTest};
m_saMapXFNames = saMapXFNames;

m_saMapXFLabels = saMapXFLabels;

ASSERT(m_saMapXFNames.GetSize() == m_saMapXFLabels.GetSize());

StringArray saDefaultXFNames = {STR_STEP_GOAL, STR_STEP_Normal, STR_STEP_TTest};

m_saDefaultXFNames = saDefaultXFNames;

m_strRunDlgName = _L("Stat Test");

///////////////////////////////////////////////////////////////////////////////////

//Class StatTestWizCore

StatTestWizCore::StatTestWizCore()

:XFCore()

{

StringArray vsXFsRecalculateShown = {STR_STEP_GOAL};

m_vsXFsRecalculateShown = vsXFsRecalculateShown;

nStep = GOAL_ALL;

}

//Select steps in the Goal Step
void StatTestWizCore::ChangeGoal(int nGoal)
{
    XFwizNavigation *pXFwizNavg = (XFwizNavigation *)GetXFwizNavigation();

    ASSERT(pXFwizNavg);

    nStep = nGoal;

    if ( pXFwizNavg )
    {
        StringArray saXFNames;
        saXFNames.Add(STR_STEP_GOAL);

        switch (nGoal)
        {
        case GOAL_ALL:
            saXFNames.Add(STR_STEP_Normal);
            saXFNames.Add(STR_STEP_TTest);
            break;

        case GOAL_SIMPLE:
            saXFNames.Add(STR_STEP_TTest);
            break;
        }
    }
pXFWizNavg->SetSteps(saXFNames);

//Get input DataRange in the Goal Step.

DataRange StatTestWizCore::GetRange()
{
    XFWizInputOutputRange* pIORange = pXFWizNavg->GetXFWizInputOutputRange();

    DataRange drInput;

    if(!pIORange)
    {
        error_report("Fail to get io ranges!");
        return drInput;
    }

    Array<DataRange&> drs;

    //Get input DataRange.
    if(!pIORange->Get(&drs, STR_STEP_GOAL, true))
    {
        return;
    }
error_report("Fail to get range from WizCore!");

return drInput;

}

drInput = drs.GetAt(0);

return drInput;

}
```c
TEMPLATE_open_wiz dlg(StatTestWizManager, lpszThemeName, pXFWizTheme, pXFWizIO, dwOPUID)

int stat_test_run_wiz(UINT msg, const XFWizTheme *pXFWizTheme, const XFWizInputOutputRange *pXFWizIO, DWORD dwOPUID, int nExeMode)
{
    TEMPLATE_run_wiz(StatTestWizManager, msg, pXFWizTheme, pXFWizIO, dwOPUID, nExeMode)
}
```

Click the **Save** button to save StatTestWiz.c file.

Note that StatTestWiz.c should be compiled after the X-Function **StatTest** is compiled, since the included files in StatTestWiz.c are not yet in the workspace until the X-Function **StatTest** is compiled. In fact StatTestWiz.h is included in X-Function **StatTest**, so StatTestWiz.c will be compiled automatically when X-Function **StatTest** is compiled.

### 11.4.4.6 Add Script for X-Functions

#### 11.4.4.6.1 Script for X-Function StatTest

In the **X-Function Builder**, click the **Open** button and open the X-Function StatTest. Click the **Edit X-Function in Code Builder** and add the following script.

- Include header files

```c
#include <..\OriginLab\XFWiz.h>

#include <..\OriginLab\WizOperation.h>

#include <..\OriginLab\XFCore.h>

#include <..\OriginLab\XFWizNavigation.h>

#include <..\OriginLab\XFWizManager.h>

#include <..\OriginLab\XFWizScript.h>
```
Add the function body, which specifies the dialog mode.

```cpp
if (script )
    stat_test_run_wiz_nodlg(tn);
else
    stat_test_open_wiz_dlg(tn);
```

Add the function body, which determines not to show this dialog before the wizard is opened.

```cpp
nRet = XFEVT_PROCEED_NO_DLG;
```

Click Compile button to compile the file. Then click Return to Dialog button to return to X-Function Builder. In the X-Function Builder, click Save OXF file button to save the X-Function.

### 11.4.4.6.2 Script for X-Function StatTestWizGoal

Open the X-Function StatTestWizGoal. Click Edit X-Function in Code Builder button, add the following script.

- Include header files

```cpp
#include "StatTestWiz.h"
```
Add a static function _check_input()

This function is used to check whether the input DataRange is a single column.

```cpp
static bool _check_input(const TreeNode trGetN, string& strErr)
{
    TreeNode trRange = trGetN.input;
    DataRange drInput;

    drInput.Create(trRange.strVal);

    if( drInput.GetNumRanges() == 0 )
    {
        strErr = "Input can't be empty, and it should be a valid column.";
        return false;
    }

    else
    {
        if( drInput.GetNumRanges() == 1 )
        {
            Worksheet wksInput;
            int nC1, nC2;
            drInput.GetRange(wksInput, nC1, nC2);
            if( nC1 == nC2 )
```
Tutorials for Origin 2024b

```c
return true;

}

strErr = "Please select one column."
return false;
}
```

- **StatTestWizGoal_event1()**

Add the function body, which updates the dialog.

```c
StatTestWizCore* pstatwc = (StatTestWizCore*)get_xf_core_handler(trGetN);

ASSERT(pstatwc);

//Update the Wizard page.

if ( 0 == lstrcmp(lpcszNodeName, "goal") )

    pstatwc->ChangeGoal(trGetN.goal.nVal);

//Error message is shown at the bottom of the dialog,
//and OK button is disenbled for incorrect choice of DataRange.

bOKEnable = _check_input(trGetN, strErrMsg);

return false;
```
Click **Compile** button to compile the file. Then click **Return to Dialog** button to return to **X-Function Builder**, and click **Save OXF file** button to save the X-Function.

### 11.4.4.6.3 Script for X-Function NormalityTest

Open the X-Function **NormalityTest**. Click the **Edit X-Function in Code Builder** button and add the following script.

- Include header files

```cpp
#include "StatTestWiz.h"

#include <XFbase.h>
```

- Add a static function `_update_GUI()`

This function is used to update the dialog’s edit boxes for normality test result.

```cpp
static void _update_GUI(TreeNode& trGetN)
{
    vector vRes;

    vRes = _norm_test(trGetN.nXFCorePointer.nVal, trGetN.type.nVal);

    trGetN.stat.dVal = vRes[0];
    trGetN.df.dVal = vRes[1];
    trGetN.prob.dVal = vRes[2];
}
```

- Add a static function `_update_strErr()`

This function is used to update the string shown at the bottom of the dialog.

```cpp
static void _update_strErr(const TreeNode tr, string& strErr)
{
}
```
if (tr.prob.dVal >= 0.05 && tr.prob.dVal <= 1)

    strErr = "At the 0.05 level, the data was significantly drawn from a
            normally distributed population."

else if (tr.prob.dVal < 0.05 && tr.prob.dVal >= 0)

    strErr = "At the 0.05 level, the data was not significantly drawn from a
            normally distributed population."

else

    strErr = "There is not enough information to draw a conclusion."

}

Note that the string is divided into two lines shown in the page. It should be a command of one line in the
script.

- Add a static function _norm_test()

This function is used to perform Normality Test using related X-Functions.

```cpp
static vector _norm_test(const int nXFCorePointer, const int nType)
{
    StatTestWizCore* pstatwc = (StatTestWizCore*)get_xf_core_handler(nXFCorePointer);
    ASSERT(pstatwc);

    vector vRes(3);
    vRes[2] = -1;

    DataRange drInput;
    drInput = pstatwc->GetRange();

    if (!drInput )
```
return vRes;

vector<string> vsXFName = {"swtest","kstest","lillietest"};

XFBase xfNorm(vsXFName[nType]);

if( !xfNorm.SetArg("irng", drInput) )
{
    error_report("Failed to set argument image type");
    return vRes;
}

if( !xfNorm.SetArg("stat", vRes[0]) )
{
    error_report("Failed to set argument image type");
    return vRes;
}

if( !xfNorm.SetArg("df", vRes[1]) )
{
    error_report("Failed to set argument image type");
    return vRes;
}

if( !xfNorm.SetArg("prob", vRes[2]) )
{
    error_report("Failed to set argument image type");
}
return vRes;

}

if( !xfNorm.Evaluate() )
{
    error_report("Failed to evaluate the stats X-Function.");
    return vRes;
}

return vRes;


• NormalityTest()

Update the function body, which exports the result into a worksheet when the Next button is pressed.

DataRange drInput;

StatTestWizCore* pstatwc = (StatTestWizCore*)get_xf_core_handler(nXFCorePointer);

ASSERT(pstatwc);

drInput = pstatwc->GetRange();

if( !drInput )
    return;

string strBook, strSheet;

if(!drInput.GetBookSheet(strBook, strSheet))
{ 
    error_report("Workbook and worksheet names can't be obtained.");

    return;
}

WorksheetPage wpData(strBook);

int nLayer = wpData.AddLayer("Normality Test");

if(nLayer >= 0)
{

    Worksheet wksRes = wpData.Layers(nLayer);

    vector<string> vsTypeName = {"Shapiro-Wilk","Kolmogorov-
Smirnov","Lilliefors"];

    vector<string> vsNProb = {"Prob<W", "Prob>D", "Prob>D");

    vector<string> vsParaName = {"Statistic", "DF", "");

    vsParaName[2] = vsNProb[type];

    vector vRes;

    vRes = _norm_test(nXFCorePointer, type);

    wksRes.Columns(1).SetLongName(vsTypeName[type]);

    for(int ii=0; ii<3; ii++)


```{wksRes.SetCell(ii, 0, vsParaName[ii], false);
    wksRes.SetCell(ii, 1, vRes[ii]);
}
```

else
{
   
   error_report("New worksheet can't be created.");

}

• NormalityTest_event1()

Update the function body, which will update the results in the dialog as the method of normality test changes. Strings shown at the bottom of the dialog will also be updated.

```_update_GUI(trGetN);
_update_strErr(trGetN, strErrMsg);
```

```return true;
```

• NormalityTest_before_execute()

Update the function body, which will make the edit boxes for results grayed out, and show the result in the dialog.

```trGetN.stat.Enable = false;
trGetN.df.Enable = false;
trGetN.prob.Enable = false;
```

Click the Compile button to compile the file. Then click the Return to Dialog button to return to X-Function Builder, and click the Save OXF file button to save the X-Function.

11.4.4.6.4 Script for X-Function OnetTest
Open the X-Function **OnetTest**. Click the **Edit X-Function in Code Builder** button and add the following script.

- Include header files

```cpp
#include "StatTestWiz.h"
#include <XFbase.h>
```

- Define strings

```cpp
const vector<string> vsNull = {"Mean = ", "Mean <= ", "Mean >= "};
const vector<string> vsAlter = {"Mean <> ", "Mean > ", "Mean < "};
const vector<string> vsAcceptNull = {"Not significantly different from", "Not significantly greater than", "Not significantly less than"};
const vector<string> vsRejectNull = {"significantly different from", "significantly greater than", "significantly less than"};
const vector<string> vsProb = {"Prob>|t|", "Prob>t", "Prob<t"};
```

- Add a static function _update_null()

This function is used to update the **Null** edit box.

```cpp
static void _update_null(TreeNode& trGetN, bool bMean = false)
{
    string strNull;

    strNull = vsNull[trGetN.tail.nVal] + ftoa(trGetN.mean.dVal);

    trGetN.null.strVal = strNull;
```
if (bMean)
{
    string strAlter = vsAlter[0] + ftoa(trGetN.mean.dVal) + "|";
    strAlter = strAlter + vsAlter[1] + ftoa(trGetN.mean.dVal) + "|";
    strAlter = strAlter + vsAlter[1] + ftoa(trGetN.mean.dVal);

    trGetN.tail.SetAttribute(STR_COMBO_ATTRIB, strAlter);
}

• Add a static function _check_sig_level()

This function is used to check the Significance Level edit box value.

static bool _check_sig_level(TreeNode& trGetN, string& strErr)
{
    if (trGetN.siglevel.dVal > 0 && trGetN.siglevel.dVal < 1)
    {
        return true;
    }
    else
    {
        strErr = "Significance Level should be between 0 and 1.";
        return false;
    }
}
• Add a static function _update_strErr()

This function is used to define the string for the conclusion of t-test at the bottom based on P-value.

```c++
static void _update_strErr(const TreeNode tr, string& strErr)
{
    if(tr.tprob.dVal >= tr.siglevel.dVal && tr.tprob.dVal <= 1)
        strErr.Format("Null Hypothesis is %s. Alternative Hypothesis is %s. 
At the %s level, the population mean is %s the test mean(%s).", 
        vsNull[tr.tail.nVal], ftoa(tr.mean.dVal), vsAlter[tr.tail.nVal],
        ftoa(tr.mean.dVal),
        ftoa(tr.siglevel.dVal), vsAcceptNull[tr.tail.nVal], ftoa(tr.mean.dVal));
    else if(tr.tprob.dVal < tr.siglevel.dVal && tr.tprob.dVal >= 0)
        strErr.Format("Null Hypothesis is %s. Alternative Hypothesis is %s. 
At the %s level, the population mean is %s the test mean(%s).", 
        vsNull[tr.tail.nVal], ftoa(tr.mean.dVal), vsAlter[tr.tail.nVal],
        ftoa(tr.mean.dVal),
        ftoa(tr.siglevel.dVal), vsRejectNull[tr.tail.nVal], ftoa(tr.mean.dVal));
    else
        strErr = "There is not enough information to draw a conclusion.";
}
```

Note that the command is divided into several lines shown in the page. It should be a command of one line in the script.

• Add a static function _update_GUI()

This function is used to update edit boxes for results in the dialog.
static void _update_GUI(TreeNode& trGetN)
{
    vector vRes;

    vRes = _one_sample_t_test(trGetN.nXFCorePointer.nVal, trGetN.mean.dVal, 
        trGetN.tail.dVal, trGetN.siglevel.dVal);

    trGetN.stat.dVal = vRes[0];
    trGetN.df.dVal = vRes[1];
    trGetN.tprob.dVal = vRes[2];
    trGetN.lcl.dVal = vRes[4];
    trGetN.ucl.dVal = vRes[5];
}

• Add a static function _one_sample_t_test()

This function is used to perform One-Sample t-Test using an X-Function.

static vector _one_sample_t_test(const int nXFCorePointer, const double dMean, 
    const int nTail, const double dSiglevel)
{
    DataRange drInput;

    StatTestWizCore* pstatwc = (StatTestWizCore*)get_xf_core_handler(nXFCorePointer);

    ASSERT(pstatwc);

    vector vRes(6);

    vRes[2] = -1;
drInput = pstatwc->GetRange();

if( !drInput )

    return vRes;

vRes[3] = 100 - 100*dSiglevel;

XFBase xfTTest("ttest1");

if( !xfTTest.SetArg("irng", drInput) )
{

    error_report("Failed to set argument irng");

    return vRes;
}

if( !xfTTest.SetArg("mean", dMean) )
{

    error_report("Failed to set argument mean");

    return vRes;
}

if( !xfTTest.SetArg("tail", nTail) )
{

    error_report("Failed to set argument tail");

    return vRes;
}
if( !xfTTest.SetArg("alpha", dSiglevel) )
{
    error_report("Failed to set argument alpha");
    return vRes;
}

if( !xfTTest.SetArg("stat", vRes[0]) )
{
    error_report("Failed to set argument stat");
    return vRes;
}

if( !xfTTest.SetArg("df", vRes[1]) )
{
    error_report("Failed to set argument df");
    return vRes;
}

if( !xfTTest.SetArg("prob", vRes[2]) )
{
    error_report("Failed to set argument prob");
    return vRes;
}

if( !xfTTest.SetArg("lcl", vRes[4]) )
{  
    error_report("Failed to set argument lcl");  
    return vRes;  
}
}

if( !xfTTest.SetArg("ucl", vRes[5]) )
{
    error_report("Failed to set argument ucl");  
    return vRes;  
}

if( !xfTTest.Evaluate() )
{
    error_report("Failed to evaluate the ttest1 X-Function.");  
    return vRes;  
}

return vRes;

- OnetTest()

Update the function body, which exports the result into a worksheet when the **Finish** button is pressed.

DataRange drInput;

StatTestWizCore* pstatwc = (StatTestWizCore*)get_xf_core_handler(nXFCorePointer);
ASSERT(pstatwc);

drInput = pstatwc->GetRange();

if( !drInput )
    return ;

string strBook, strSheet;

if(!drInput.GetBookSheet(strBook, strSheet))
{
    error_report("Workbook and worksheet names can't be obtained.");
    return;
}
WorksheetPage wpData(strBook);

int nLayer = wpData.AddLayer("One-Sample t-test");

if(nLayer >= 0)
{
    Worksheet wksRes = wpData.Layers(nLayer);

    vector<string> vsParaName = {"t Statistic", "DF", ",", "Conf. Levels in \%", "Lower Limits", "Lower Limits");
    vsParaName[2] = vsProb[tail];
vector vRes;

tRes = _one_sample_t_test(nXFCorePointer, mean, tail, siglevel);

wksRes.SetSize(-1, 4);

wksRes.Columns(0).SetLongName("Test Statistics");

string strNull = "Null Hypothesis is " + vsNull[tail] + ftoa(mean);

wksRes.Columns(1).SetLongName(strNull);

wksRes.Columns(3).SetLongName("Confidence Intervals for Mean");

for(int ii=0; ii<3; ii++)
{
    wksRes.SetCell(ii, 0, vsParaName[ii], false);
    wksRes.SetCell(ii, 1, vRes[ii]);

    wksRes.SetCell(ii, 2, vsParaName[ii + 3], false);
    wksRes.SetCell(ii, 3, vRes[ii + 3]);
}

} else
{
    error_report("New worksheet can't be created.");
}
• OnetTest_event1()

Update the function body, which will update results and show a conclusion at the bottom of the dialog according to the result. As settings change in the dialog, the Null edit box will be updated as the mean and hypothesis change, and the Significance Level edit box’s value is checked.

```c
if ( 0 == lstrcmp(lpcszNodeName, "mean") )
    _update_null(trGetN, true);

if ( 0 == lstrcmp(lpcszNodeName, "tail") )
    _update_null(trGetN);

if ( 0 == lstrcmp(lpcszNodeName, "siglevel") )
    bOKEnable = _check_sig_level(trGetN, strErrMsg);
```

```c
_update_GUI(trGetN);
_update_strErr(trGetN, strErrMsg);
```

```c
return false;
```

• OnetTest_before_execute()

Update the function body, to show/hide or disable the controls in the dialog.

```c
StatTestWizCore* pstatwc =
(StatTestWizCore*)get_xf_core_handler(trGetN.nXFCorePointer.nVal);

ASSERT(pstatwc);

trGetN.prob.Show = 1 - pstatwc->nStep;

trGetN.prob.Enable = false;

trGetN.null.Enable = false;
```
Click the Compile button to compile the file. Then click the Return to Dialog button to return to the X-Function Builder. Click the Save OXF file button to save the X-Function.

Close Origin. Then start Origin and you will notice that a new item Stat Test is added to Origin's menu Statistics: Hypothesis Testing.

11.4.4.7 How to Use the Wizard

The following example shows how to use the wizard.

1. Select a column in the worksheet.
2. Select **Statistics: Hypothesis Testing: Stat Test** from the Origin menu or type the command "StatTest-d" in the command window. The **Stat Test** wizard dialog will open.
3. Click the **Next** button. The **Normality Test** dialog is opened. The result is shown in the **Output** branch. A conclusion is drawn at the bottom of the dialog.

4. Click the **Next** button. The **One-Sample t-test** dialog is opened. The result is shown in the **Output** branch. A conclusion is drawn at the bottom of the dialog. Previous step's result of normality test is shown at the top. You can also change the setting in the dialog, and notice the result changes.
Null Hypothesis is $\text{Mean} = 0$.
Alternative Hypothesis is $\text{Mean} \neq 0$.
At the 0.05 level, the population mean is not significantly different from the test mean(0).
### Stat Test

#### Goal
- Normality Test
- One-Sample t-test
- Finish

#### One-Sample t-test

**Result**

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degrees of Freedom</td>
<td>31</td>
</tr>
<tr>
<td>P-value</td>
<td>0.14269</td>
</tr>
<tr>
<td>Lower Confidence Limit</td>
<td>9.6201</td>
</tr>
<tr>
<td>Upper Confidence Limit</td>
<td>0.09386</td>
</tr>
</tbody>
</table>

**Null Hypothesis** is Mean = 0.
**Alternative Hypothesis** is Mean ≠ 0.
At the 0.05 level, the population mean is **not significantly different from the test mean**.
5. Click the **Finish** button to end the wizard. Two worksheets for results are created.
Index

A
Accessing Internal Origin Objects by Origin C … 1910
Add multiple fitted curves in a Histogram … 1365
Adding a Data Plot to Existing Graph … 869
Adding New Origin C Functions to Origin … 1892
Adding Objects to Worksheet … 1722
Analysis Template … 38
Analysis Templates … 606
Analysis Themes … 619
ANOVA … 619
Apps in Origin … 691
ASCII … 1755
Axis … 922

B
Bar and Scatter Plot with Error Bar … 1093
Basic 2D Plotting … 847
Basic 3D Plotting … 853
Batch Peak Analysis Using Theme with Script Before Each Process … 493
Batch Processing … 623
Batch Processing Grouped Datasets Using Analysis Template with Multi-Data Sheets … 638
Batch Processing Multiple Datasets … 623
Batch Processing Multiple Files using Analysis Template … 626
Batch Processing with Summary Report in External Excel File … 629
Batch Processing with Word Template for Reporting … 630
Box Plot … 1308

C
Categorical Values Ordering and Sharing … 599
Cluster Analysis … 770
Cluster Gadget … 100
Coherence and Correlation … 452
Color Map Surface Graph … 1539
Colormap from Second Matrix … 1531
Column Graph with Error Bars … 1098
Column, Bar and Pie … 1084
Combine Quick Peaks Gadget with Peak Analyzer 497
Command Window and X-Functions … 1920
Complicated Fill Area … 989
Contour … 1218
Contour Graph with XY Data Points and Z Labels1247
Contour Plot with Vector Overlay … 1251
Contour Plots and Color Mapping … 1229
Convert Data from Spherical Coordinate to XYZ and Make a 3D Plot … 1618
Convolution … 431
Copy and Apply a Plot Format to Another Plot … 987
COX Model Estimator … 751
Tutorials for Origin 2024b

Create and Subtract Baseline with Peak Analyzer 483
Create and Update Apps for Origin .................. 1914
Create Heatmap with Virtual Matrix and Colormap Bar Plot ........................................... 1265
Creating a Custom Report Sheet ......................... 614
Creating a Graph ........................................... 822
Creating Analysis Templates using Set Column Value .................................................................. 609
Creating and Using Analysis Templates ............... 606
Creating Intersecting Surface Plots from Worksheets ................................................................. 1522
Cross Tabulation ............................................. 658
Curve Fitting .................................................... 28, 158
Curve Intersection Gadget ................................ 86

D
Data Analysis ..................................................... 67
Data Exploration .............................................. 1731
Data Filter ......................................................... 573
Data Management ............................................ 1715
Data Manipulation ............................................ 535
Data Reader Tool ............................................. 1731
Data Reduction ................................................. 559
Data Selection ................................................... 11
Database ........................................................ 1771
Decimation and Signal Envelope .......................... 460
Descriptive Statistics ........................................ 646
Digitizer ............................................................ 1821
Digitizer Tool ................................................... 1821
Discriminant Analysis ........................................ 780
Distribution Fit .................................................. 672
Distribution Fit with the Probability Density Function and Cumulative Distribution Function .... 317
Double Y .......................................................... 1151

E
Energy-Level Structure of the Er3+ Ion in A YAG Crystal ......................................................... 1191
Enhanced Digitizer ............................................ 1829
Error Bars with Fill Area .................................... 883
Exporting .......................................................... 1849
Exporting and Presentation ................................. 1849
Exporting Graphs ............................................. 1849

F
FFT ................................................................. 386
FFT Filter ......................................................... 393
Fill Partial Area between Function Curves ............. 999
Fit Curve Through Certain Points ....................... 309
Fit Function with Non-constant Background .......... 300
Fit Multiple Datasets by Fitting One and then Using Those Fit Parameters for Other Datasets .... 366
Fit Surface with User Defined Function ................. 230
Fitting Complex Function .................................. 288
Fitting Integral Function with a Sharp Peak .......... 320
Fitting Integral Function with parametric limit using NAG Library ........................................... 258
Fitting One Dataset as a Function of Other Datasets ................................................................. 237
Fitting with a Piecewise Linear Function ............... 324
Fitting with an Ordinary Differential Equation ....... 329
Fitting with Convolution ..................................... 291
Fitting with Convolution of Two Functions .......... 339
Fitting with Integral using LabTalk Function ......... 272
Fitting with Integral using NAG Library ............... 265
Fitting With Multiple Independent Variables ......... 240
Fitting with NAG Special Function ....................... 254
Fitting with Piecewise Functions ....................... 307
Fitting with Summation .................................... 284
Fitting with Two Integrals using LabTalk Function 279
Flattened Colormap Surfaces with Increasing Z Offset ......................................................... 1643

G
Gadgets ........................................................... 26, 71
Getting Started ................................................. 1
Global Fit for Different Functions with Shared Parameters ..................................................... 208
Global Fitting with Parameter Sharing ................. 203
Global Vertical Cursor ....................................... 71
Graph Template and Theme ............................... 987
Graph Templates and Batch Plotting .................. 5
Graphing ......................................................... 809
Grouped Box Chart with Color Indexed Data Points 1318
Grouped Box Plot ............................................. 1352
Grouped Column with Error Bars and Data Labels 1112
Grouped Stacked Column .............................. 1124
How to Create a Wizard ................................. 1931
How to share Origin C based LabTalk Functions 1870
Hypothesis Tests ............................................ 681
IIR Filter ......................................................... 416
Implicit Fitting with Three Variables ............... 374
Import Data from a Database ......................... 1772
Import Data from a Database for Analysis ........ 1781
Import Wizard ................................................ 1759
Importing Data ............................................... 1747
Importing Multiple Files into Workbooks Cloned from Active Workbook .............. 1768
Integrate Gadget ............................................. 79
Integrating Peaks .......................................... 508
Interpolate Gadget .......................................... 97
Introduction to Origin C and Code Builder .... 1874
Introduction to X-Functions .......................... 1927
Kaplan-Meier Estimator .................................. 744
Kaplan-Meier Estimator .................................. 744
LabTalk .......................................................... 1870
Layers .......................................................... 946
Line and Symbol ............................................ 988
Line Graph with Masked Data ....................... 1044
Linear and Polynomial Fitting ....................... 160
Linear Fit for Kinetic Models ......................... 165
Linear Fitting and Outlier Removal ................ 160
Lock Filter with Analysis ............................... 578
Marginal Distribution Curve ......................... 1334
Mark out a segment of plot with different plot style 890
Merge and Arrange Graphs ............................. 15
Merging and Arranging Graphs ...................... 15
Micro-Raman spectroscopy of complex nanostructured mineral systems .......... 1027
Modifying Derived Parameters in Build-in Functions 360
Multi Layer Graph Customization ................. 980
Multi-Axis and Multi-Panel ......................... 1151
Multi-line-plot with Special Position Annotation Line ........................................ 1035
Multiple Axis Breaks .................................... 922
Multiple Axis Plot .......................................... 1183
Multiple Layers with Linked Axis ................. 961
Multiple Surfaces in Same Layer .................. 1565
Multivariate Analysis .................................... 759
My First Graph .............................................. 1
Nonlinear Curve Fit Tool .............................. 177
Nonlinear Fitting ............................................ 176
Nonlinear fitting using Orthogonal Distance Regression ....................................... 382
Nonlinear Fitting with System Function .......... 192
Nonlinear Multiple Variables Fitting ............. 356
Non-parametric Statistics Overview ............ 731
Nonparametric Tests ...................................... 731
One Way ANOVA ......................................... 692
One-Way Repeated Measures ANOVA ........... 699
Open-High-Low-Close-Volume Stock Chart ...... 1705
Organizing and Accessing Origin C Functions .... 1894
Origin C ......................................................... 1874
Origin GUI ...................................................... 47
Overview of Customization ......................... 894
Panel Graph with Inset Plots of High-resolution Electron Energy-loss Spectra ........ 1202
Parameter Initialization for Rational Functions .... 346
Parameters Initialization using LabTalk in NLFit ... 214
Parametric Surface with Colormap from Data .... 1544
Tutorials for Origin 2024b

Partial Correlation Coefficient ............................................. 678
Partial Least Squares ........................................................... 791
Pasting or Embedding Graphs in Other Applications .......................... 1857
Peak Analysis ........................................................................ 32, 482
Peak Finding ........................................................................... 503
Peak Fitting ............................................................................ 515
Peak Fitting with Baseline ......................................................... 515
Peak Fitting with Preset Peak Parameters ..................................... 522
Peak Integration ....................................................................... 508
Picking and Marking Peaks ....................................................... 504
Piper Diagram ........................................................................... 1678
Pivot Table .............................................................................. 588
Plot from User Defined Graph Template ....................................... 863
Plot Functions with Parameters Defined in a Worksheet .................... 1659
Plotting .................................................................................... 813
Plotting Overlapping Data and Setting Transparency ......................... 917
Polar ....................................................................................... 1403
Polar Contour ............................................................................ 1403
Polar Crop ................................................................................. 1427
Polar Graph with Columns and Stack Columns .................................. 1473
Polar Graph with Custom Angular Scale ........................................ 1482
Polar Graph with Custom Radial Axes ........................................... 1444
Polar Graph with Multiple Layers ................................................ 1457
Polar Plot with Error Bar ................................................................ 1420
Power and Sample Size ............................................................. 800
Presentation ............................................................................. 1857
Principal Component Analysis .................................................... 759
Programming ............................................................................ 1869
Publishing Graphs ..................................................................... 20
Q-Q Plot .................................................................................... 1379
Quick Fit Gadget ........................................................................ 113
Quick Peaks Gadget .................................................................... 125
Quick Sigmoidal Fit Gadget ........................................................ 131
Quoting Built-in Functions in Your New Function ......................... 296

R
Rise Time .................................................................................. 467
Rise Time Gadget ....................................................................... 90
ROC curve ............................................................................... 805

S
Scatter Matrix .......................................................................... 1390
Scatter Plot of Decay and Recovery Curves .................................... 1016
Send Graphs to PowerPoint ....................................................... 1863
Set Column/Cell Values ............................................................ 536
Setting Column Values .............................................................. 536
Setting the Fix, Share Status or Bounds for Multiple Peak Parameters Simultaneously ......................................................... 530
Signal Processing ...................................................................... 385
Single ASCII ............................................................................ 1755
Smart Peak Labels with Leader Line ........................................... 877
Smoothing ............................................................................... 399
Sound Processing ...................................................................... 473
SQL Editor for Database Analysis ............................................... 1793
Stack Column Plot with Different Positive and Negative Y Scale ......................... 1138
Stack Column With Labels ......................................................... 1104
Stack Lines by Y Offsets ............................................................. 1168
Stacked 3D Surface Plots ........................................................... 1557
Statistics ................................................................................. 35, 645, 1308
STFT (Short-Time Fourier Transform) ........................................... 409
Surface Fitting with Multiple Peaks ............................................. 353
Survival Analysis ...................................................................... 743
Symbol Plot with Color Transparency .......................................... 1050
Symbol Plot with Size and Colormap from Other Columns ............... 1064

T
Ternary Contour ........................................................................ 1242
The Code Builder Workspace ..................................................... 1882
Three-Way ANOVA ................................................................... 723
Transparent Parametric Surfaces combined with Scatter Plot ............... 1613
Tutorial
Calculating Double Integral with NAG Functions From Origin C .................. 1898
Calling NAG Functions From Origin C ............ 1904
Two Way ANOVA ........................................... 705
Two Way Repeated Measures ANOVA ............ 712
Two-Way Mixed-Design ANOVA .................. 718

U
Update Database Importing By LabTalk Substitution ........................................... 1805
Update Graph By Reimport Data From Database 1815
Use Data Cursor to Show the Difference between the Data ........................................... 1740
Use Script to Search for Baseline Anchor Points in Peak Analyzer ................................. 490
User Defined Fitting Function .................. 221
User Defined Fitting Function using GNU Scientific Library ........................................... 243
User Interface ........................................... 47
User-Defined Arbitrary Tick Positions .......... 935
Using Multiple Gadgets .......................... 143

V
Variable Column Width ................................. 1145
Vertical 2 Panel Line ................................... 1175
Video Tutorials ........................................... 45

W
Waterfall ................................................... 1684
Wavelet ..................................................... 434
Weibull Fit .................................................. 755
Weibull Probability Plot .............................. 1372
Windrose Graph ......................................... 1664
Working with Multi-Sheet Workbooks ........... 1715
Worksheet Data Operations ........................ 553
Worksheet Query ........................................... 553

X
X-Functions .............................................. 1919
XYZ Contour ............................................. 1219